
Viz Artist

User’s Guide
3.6





Copyright © 2014 Vizrt. All rights reserved.

No part of this software, documentation or publication may be reproduced, transcribed, stored in a
retrieval system, translated into any language, computer language, or transmitted in any form or by
any means, electronically, mechanically, magnetically, optically, chemically, photocopied, manually,
or otherwise, without prior written permission from Vizrt.

Vizrt specifically retains title to all Vizrt software. This software is supplied under a license
agreement and may only be installed, used or copied in accordance to that agreement.

Disclaimer

Vizrt provides this publication “as is” without warranty of any kind, either expressed or implied.

This publication may contain technical inaccuracies or typographical errors. While every precaution
has been taken in the preparation of this document to ensure that it contains accurate and up-to-
date information, the publisher and author assume no responsibility for errors or omissions. Nor
is any liability assumed for damages resulting from the use of the information contained in this
document.

Vizrt’s policy is one of continual development, so the content of this document is periodically
subject to be modified without notice. These changes will be incorporated in new editions of the
publication. Vizrt may make improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time.

Vizrt may have patents or pending patent applications covering subject matters in this document.
The furnishing of this document does not give you any license to these patents.

Technical Support

For technical support and the latest news of upgrades, documentation, and related products, visit
the Vizrt web site at www.vizrt.com.

Last Updated

08.12.2014

http://www.vizrt.com




Table of Contents

1 Introduction.................................................................................................27

1.1 Document Structure............................................................................27

1.2 Related Documents.............................................................................28

1.3 Customer Feedback and Suggestions..................................................... 29

1.4 Customer Support Request...................................................................29

1.4.1 Before Submitting a Support Request........................................... 30

1.4.2 Submitting a Support Request.................................................... 30

1.4.3 Viz Log Files............................................................................ 32

2 Workbench Description..................................................................................35

2.1 Main Window.....................................................................................35

2.1.1 Dual Monitor Configuration.........................................................36

2.2 Main Menu........................................................................................ 37

2.2.1 Main Menu Left........................................................................ 37

2.2.2 Main Menu Right...................................................................... 40

2.3 Scene Editor......................................................................................42

2.3.1 Layer Manager.........................................................................43

2.3.2 Scene Editor Buttons.................................................................44

2.4 Working with the Scene Editor.............................................................. 48

2.4.1 Scene Editor Functions.............................................................. 48

2.4.2 Scene Editor Context Menu........................................................ 52

2.5 Scene Editor Views............................................................................. 55

2.6 Keyboard and Mouse Shortcuts............................................................. 56

2.6.1 Application Controls and Shortcuts...............................................57

2.6.2 Integer/Float Controls................................................................57

2.6.3 General Server Tree Shortcuts.....................................................58

2.6.4 General Server Element Area Shortcuts........................................ 58

2.6.5 Server View Shortcuts............................................................... 58

2.6.6 Built-in View Shortcuts.............................................................. 59

2.6.7 General Scene Tree Shortcuts..................................................... 60

2.6.8 Scene Tree Basic View Controls and Shortcuts................................60

2.6.9 Scene Tree Sort View Shortcuts...................................................61

2.6.10 Scene Editor General Shortcuts................................................. 62

2.6.11 Scene Editor Camera Controls and Shortcuts................................62

2.6.12 Scene Editor Orthogonal View Controls and Shortcuts.................... 63



2.6.13 Scene Editor Animation Controls and Shortcuts.............................63

2.6.14 General Stage Tree Shortcuts....................................................64

2.6.15 Stage Controls and Shortcuts....................................................64

2.6.16 Import File Shortcuts............................................................... 66

2.6.17 Import Archive Shortcuts..........................................................66

2.6.18 On Air Shortcuts.....................................................................67

2.6.19 Polygon Plugin Editor Shortcuts................................................. 67

2.6.20 Script Editor Shortcuts.............................................................68

3 Scene Tree Knowledge and Skills.....................................................................69

3.1 Opening a Scene................................................................................69

3.2 Scene Tree........................................................................................ 70

3.3 Scene Tree Tabs................................................................................. 71

3.3.1 Basic Tab................................................................................ 71

3.3.2 Sort Tab..................................................................................72

3.3.3 Search Tab.............................................................................. 73

3.4 Favorites Bar..................................................................................... 75

3.5 Containers........................................................................................ 77

3.5.1 Container Icons........................................................................77

3.5.2 Container Context Menu............................................................ 78

3.5.3 Container Editor.......................................................................81

3.5.4 Adding Containers.................................................................... 81

3.5.5 Copy Containers.......................................................................82

3.5.6 Move Containers...................................................................... 82

3.5.7 Renaming Containers................................................................ 83

3.5.8 Editing Container Properties....................................................... 84

3.5.9 Deleting Containers.................................................................. 84

3.5.10 Merging Containers................................................................. 84

3.5.11 Grouping Containers................................................................86

3.6 Modifying Container Items....................................................................87

3.6.1 Manipulating Properties............................................................. 88

3.6.2 Editing Properties in the Scene Editor...........................................89

3.6.3 Transformation Editor................................................................ 89

3.6.4 Copying Properties....................................................................92

3.6.5 Geometry Editor.......................................................................92

3.6.6 Text Editor.............................................................................. 94

3.6.7 Texture Editor........................................................................ 101

3.6.8 Plugin Editor..........................................................................106



3.6.9 Material Editor....................................................................... 106

4 Manage Work and Viz Graphics Hub...............................................................109

4.1 Viz Graphic Hub............................................................................... 109

4.2 Server Area..................................................................................... 110

4.2.1 Server Tree Bar...................................................................... 111

4.2.2 Server Tree Menu................................................................... 111

4.3 Folder Tree...................................................................................... 112

4.3.1 Folders................................................................................. 112

4.4 What are Elements........................................................................... 116

4.4.1 Scenes................................................................................. 117

4.4.2 Objects.................................................................................117

4.4.3 Materials...............................................................................118

4.4.4 Materials Advanced.................................................................119

4.4.5 Images................................................................................. 119

4.4.6 Fonts....................................................................................120

4.4.7 Audio Clips............................................................................120

4.5 Element Area...................................................................................121

4.5.1 Element List.......................................................................... 121

4.5.2 Element Context Menu............................................................ 124

4.5.3 Content Switcher....................................................................125

4.5.4 Server Menu..........................................................................127

4.5.5 Properties Panel..................................................................... 129

4.6 Working with Elements...................................................................... 131

4.6.1 Common Element Procedures................................................... 132

4.6.2 Active Elements..................................................................... 135

4.6.3 Linked Elements.....................................................................136

4.6.4 Referenced Elements...............................................................137

4.6.5 Working with Scene Elements................................................... 138

4.6.6 Working with Object Elements...................................................140

4.6.7 Working with Material Elements.................................................140

4.6.8 Working with Material Advanced Elements...................................141

4.6.9 Working with Image Elements................................................... 143

4.6.10 Working with Fontstyle Elements..............................................144

4.6.11 Working with Audio (Clips) Elements.........................................146

4.7 Assign Keywords to Elements..............................................................148

4.8 Image Editor....................................................................................154

4.8.1 General Image Information....................................................... 155



4.8.2 Apply and Preview Effects........................................................ 158

4.9 Fontstyle Editor................................................................................158

4.9.1 Available Modifiers..................................................................160

4.9.2 Working with Modifiers............................................................ 161

4.9.3 Preview Menu........................................................................ 165

4.9.4 Fontstyle Viewer.....................................................................166

4.10 Material Editor................................................................................166

4.10.1 Create a Material.................................................................. 167

4.10.2 Material Color Properties and Schemes......................................168

4.11 Element Search.............................................................................. 170

4.11.1 Search Panel........................................................................171

4.11.2 Search Parameters Area.........................................................172

4.11.3 Search Menu........................................................................173

4.11.4 Property Search....................................................................174

4.11.5 Reference Search..................................................................175

4.11.6 Keyword Search....................................................................179

4.11.7 Directory Search...................................................................180

4.11.8 Combination Search.............................................................. 181

4.11.9 Search Result Area................................................................182

4.12 SmartView Search...........................................................................183

4.12.1 Search String Syntax............................................................. 184

4.12.2 SmartView Searches..............................................................185

4.12.3 File Sets..............................................................................187

4.13 Built Ins........................................................................................ 188

4.13.1 Plugin Context Menu............................................................. 189

4.13.2 View and Search for Plugins....................................................190

4.13.3 Add Plugins to a Containers.................................................... 191

5 Global Tasks.............................................................................................. 195

5.1 Scene Settings.................................................................................195

5.1.1 Global Settings.......................................................................196

5.1.2 Video................................................................................... 199

5.1.3 Rendering............................................................................. 200

5.1.4 Plugin...................................................................................206

5.1.5 Script................................................................................... 208

5.1.6 Clipper................................................................................. 208

5.1.7 HDR (High Dynamic Range)......................................................209

5.1.8 Virtual Set.............................................................................210



5.2 Implementing Video.......................................................................... 210

5.2.1 Methodological Considerations.................................................. 212

5.2.2 Clip Playback Use Cases.......................................................... 212

5.2.3 Implementing Video Through an External Feed............................. 214

5.2.4 Implementing Video Through a Video Clip....................................220

5.2.5 Keying Mode for Video.............................................................231

5.2.6 Keying Mode Parameters..........................................................233

5.2.7 Seamless Input Channel Switcher.............................................. 236

5.2.8 Supported Codecs...................................................................237

5.2.9 Targa Codecs......................................................................... 237

5.2.10 Matrox Codecs..................................................................... 237

5.2.11 Quicktime Codecs................................................................. 317

5.3 Importing........................................................................................ 319

5.3.1 Import Display....................................................................... 319

5.3.2 Supported Files for Import........................................................320

5.3.3 Importing Files....................................................................... 321

5.3.4 Importing Archives..................................................................323

5.4 Archiving.........................................................................................328

5.4.1 Creating an Archive................................................................ 329

5.5 Deploy............................................................................................330

5.6 Post Rendering.................................................................................332

5.6.1 Post Rendering Screen.............................................................332

5.6.2 Post Rendering a Scene........................................................... 333

5.6.3 Post Rendering Templates........................................................ 336

5.6.4 Post Rendering Plugins............................................................ 338

5.6.5 Advanced Issues with Video Codecs........................................... 341

5.6.6 Post Rendering to Targa playable Clips........................................341

6 Lights.......................................................................................................343

6.1 Working with Light............................................................................343

6.1.1 Light Editor........................................................................... 343

6.1.2 Track Objects with Light...........................................................347

6.1.3 Change the Light Source Parameters in Orthogonal View................ 349

6.1.4 Copy Properties from one Light Source to another......................... 349

6.1.5 Light Source Animation............................................................349

7 Animation Stage.........................................................................................351

7.1 Stage Tree Area............................................................................... 352

7.1.1 Stage Tree.............................................................................353



7.1.2 Stage Tree Bar....................................................................... 353

7.1.3 Stage Tree Menu.................................................................... 354

7.2 Stage Editor.................................................................................... 357

7.2.1 Stage Editor Menu.................................................................. 357

7.2.2 Stage Editor Bar.....................................................................357

7.3 Timeline Editor.................................................................................359

7.4 Timeline Marker............................................................................... 360

7.5 Director Control Panel....................................................................... 362

7.6 Director Editor................................................................................. 363

7.7 Actor Editor..................................................................................... 364

7.8 Channel Editor................................................................................. 364

7.8.1 Common Channel Editor Properties............................................ 365

7.8.2 Position Channel Editor Properties..............................................365

7.8.3 Action Channel Editor Properties................................................367

7.9 Dopesheet Editor..............................................................................367

7.10 Spline Editor.................................................................................. 370

7.10.1 Editing Handles.................................................................... 372

7.10.2 Position in the Spline Editor.................................................... 372

7.10.3 Rotation in the Spline Editor................................................... 372

7.10.4 Scale in the Spline Editor....................................................... 373

7.10.5 Material in the Spline Editor....................................................373

7.10.6 Additional Best Practices for the Spline Editor.............................373

7.11 Stage Object Editor......................................................................... 374

7.12 Key frame Editor.............................................................................375

7.12.1 Common Key Frame Editor Properties....................................... 375

7.12.2 Locked vs Unlocked Key frames............................................... 376

7.12.3 Action Key Frame Editor Properties........................................... 377

7.12.4 Working with Position Key frames.............................................378

7.12.5 Working with Rotation Key frames............................................ 379

7.12.6 Working with Scale Key frames................................................380

7.12.7 Animating Material Key frames................................................ 381

7.12.8 Working with Clip Key frames..................................................381

7.13 Event Editor...................................................................................382

8 Creating Animations....................................................................................385

8.1 Working with Directors in the Stage Tree...............................................385

8.2 Working with Directors in the Dopesheet Editor...................................... 387

8.3 Working with Events in a Director........................................................388



8.4 Working with Actors in the Stage Tree.................................................. 391

8.5 Working with Actors in the Dopesheet Editor..........................................393

8.6 Working with Channels in the Stage Tree...............................................394

8.7 Working with Channels in the Dopesheet Editor......................................397

8.8 Working with Action Channels in the Stage Tree......................................397

8.9 Working with Action Channels in the Dopesheet Editor.............................400

8.10 Working with Key Frames................................................................. 401

8.10.1 Reversing the Order of Selected Key frames...............................404

8.11 Basic Animation Functions................................................................ 404

8.12 Creating a Basic Animation...............................................................408

8.13 Creating an Advanced Animation....................................................... 410

8.14 Further Advanced Animation Topics.................................................... 413

8.14.1 Animating Channels.............................................................. 414

8.14.2 Path Control.........................................................................417

8.14.3 Spline Control...................................................................... 418

8.14.4 Animating Audio................................................................... 419

8.14.5 Animating Cameras............................................................... 420

8.14.6 Animating Light.................................................................... 421

8.14.7 Merging Animations...............................................................421

8.14.8 Multi Select Animation........................................................... 421

8.15 Creating an Over the Shoulder Scene................................................. 422

9 Cameras................................................................................................... 435

9.1 Camera Editor..................................................................................435

9.1.1 Left Panel Parameters..............................................................436

9.1.2 Right Panel Parameters............................................................437

9.2 Stereoscopy Best Practices.................................................................446

9.3 Stereoscopic Output Using Shutter Glasses............................................446

9.4 Changing Camera Parameters in Orthogonal Views................................. 448

9.5 Tracking Objects with a Camera.......................................................... 448

9.6 Receiving Tracking Data from a Real Camera......................................... 450

9.7 Copying Properties from one Camera to another.....................................450

9.8 Camera Selection............................................................................. 451

9.9 Camera Animation............................................................................ 451

10 Configuring Viz.........................................................................................453

10.1 Working with the Configuration..........................................................454

10.2 Audio Settings................................................................................455

10.3 Authentication................................................................................460



10.3.1 Authentication Properties........................................................461

10.3.2 Authentication Panel Procedures.............................................. 462

10.4 Camera.........................................................................................465

10.4.1 EVS Epsio Tracking................................................................466

10.5 Communication.............................................................................. 467

10.6 Clock Formats................................................................................ 470

10.7 Database.......................................................................................470

10.8 Font Options.................................................................................. 473

10.9 Global Input...................................................................................474

10.10 Import 3D Options.........................................................................475

10.11 Image File Name Convert............................................................... 476

10.12 Local Settings...............................................................................476

10.13 Maps...........................................................................................477

10.14 Matrox........................................................................................ 479

10.14.1 General............................................................................. 479

10.14.2 VideoOut........................................................................... 480

10.14.3 VideoIn..............................................................................482

10.14.4 ClipIn................................................................................ 486

10.14.5 ClipOut..............................................................................488

10.15 Memory Management.................................................................... 488

10.16 Path Aliases................................................................................. 489

10.17 Output Format.............................................................................. 490

10.18 Plugins........................................................................................ 492

10.19 Render Options.............................................................................493

10.20 Scene Default Values..................................................................... 496

10.21 Spaceball.....................................................................................497

10.22 User Interface...............................................................................498

10.22.1 Various..............................................................................499

10.22.2 Colors............................................................................... 502

10.22.3 Shortcuts...........................................................................505

10.23 Video Board................................................................................. 505

10.23.1 Video Board Properties......................................................... 506

10.23.2 Select Multiple Directories.....................................................507

10.24 Video Clip.................................................................................... 508

10.25 Video Input.................................................................................. 508

10.26 Video Output................................................................................510

10.26.1 Video Output Editor............................................................. 510



10.27 Viz Artist 2.x................................................................................ 511

10.28 Viz License Information.................................................................. 512

11 Geometry Plugins..................................................................................... 513

11.1 Default..........................................................................................513

11.1.1 2D Line...............................................................................514

11.1.2 2D Patch............................................................................. 515

11.1.3 2D Ribbon........................................................................... 518

11.1.4 Alpha Map........................................................................... 522

11.1.5 Arrow..................................................................................524

11.1.6 Circle..................................................................................525

11.1.7 Cog Wheel...........................................................................526

11.1.8 Cone.................................................................................. 527

11.1.9 Connector............................................................................528

11.1.10 Cube.................................................................................529

11.1.11 Cylinder.............................................................................531

11.1.12 Cylinder3...........................................................................532

11.1.13 Dexter...............................................................................533

11.1.14 DisplacementMap................................................................546

11.1.15 Eclipse.............................................................................. 548

11.1.16 Fade Rectangle................................................................... 550

11.1.17 Filecard............................................................................. 551

11.1.18 Graph............................................................................... 552

11.1.19 Graph2D............................................................................553

11.1.20 Icosahedron....................................................................... 555

11.1.21 Image FX...........................................................................556

11.1.22 Noggi................................................................................562

11.1.23 Pointer.............................................................................. 563

11.1.24 Polygon............................................................................. 565

11.1.25 Rectangle.......................................................................... 569

11.1.26 Ring..................................................................................571

11.1.27 Roll...................................................................................572

11.1.28 Soft Clip Draw Pixels............................................................573

11.1.29 Sphere.............................................................................. 575

11.1.30 Spline Path.........................................................................575

11.1.31 Spline Strip........................................................................ 577

11.1.32 Spring............................................................................... 579

11.1.33 Torus.................................................................................580



11.1.34 Trio Scroll...........................................................................581

11.1.35 Wall.................................................................................. 583

11.1.36 Wave................................................................................ 584

11.2 PixelFX Plugins............................................................................... 585

11.2.1 pxLensEnergyBolt................................................................. 586

11.2.2 Lens Flare Geometries........................................................... 587

11.2.3 pxLensRays..........................................................................588

11.3 Primitives...................................................................................... 588

11.3.1 N Quad............................................................................... 588

11.4 RealFX Plugins................................................................................590

11.4.1 Cloth.................................................................................. 591

11.4.2 RFxSmoke........................................................................... 593

11.5 Ticker........................................................................................... 597

11.5.1 Scroller............................................................................... 597

11.6 Vizual Data Tools............................................................................ 601

11.6.1 Overview.............................................................................601

11.6.2 Area Chart...........................................................................602

11.6.3 Bar Chart............................................................................ 605

11.6.4 Line Chart........................................................................... 608

11.6.5 Pie Chart.............................................................................610

11.6.6 Scatter Chart....................................................................... 612

11.6.7 Stock Chart..........................................................................615

12 Container Plugins......................................................................................619

12.1 Arrange.........................................................................................620

12.1.1 Circle Arrange...................................................................... 620

12.1.2 Grid Arrange........................................................................ 621

12.1.3 Time Displacement................................................................623

12.2 Container...................................................................................... 625

12.2.1 BoundingBox........................................................................626

12.2.2 Cobra................................................................................. 626

12.2.3 Coco...................................................................................627

12.2.4 Colin...................................................................................628

12.2.5 Cora................................................................................... 630

12.2.6 Corena................................................................................631

12.2.7 Toggle.................................................................................632

12.3 Container FX..................................................................................635

12.3.1 Common Container FX Properties.............................................636



12.3.2 Container FX 2D Follow..........................................................637

12.3.3 Container FX Alpha............................................................... 638

12.3.4 Container FX Arrange............................................................ 639

12.3.5 Container FX Color................................................................ 640

12.3.6 Container FX Explode............................................................ 640

12.3.7 Container FX Jitter Alpha........................................................ 641

12.3.8 Container FX Jitter Color.........................................................642

12.3.9 Container FX Jitter Position..................................................... 643

12.3.10 Container FX Jitter Scale.......................................................644

12.3.11 Container FX Plus Plus......................................................... 644

12.3.12 Container FX Rotate.............................................................645

12.3.13 Container FX Scale.............................................................. 646

12.4 Control..........................................................................................647

12.4.1 Common Control Plugin Properties............................................648

12.4.2 Apply Shared Memory............................................................648

12.4.3 Control Action...................................................................... 651

12.4.4 Control Action Table.............................................................. 652

12.4.5 Control Audio....................................................................... 653

12.4.6 Control Bars.........................................................................653

12.4.7 Control Chart....................................................................... 654

12.4.8 Control Clip..........................................................................655

12.4.9 Control Clock....................................................................... 656

12.4.10 Control Condition................................................................ 656

12.4.11 Control Container................................................................ 657

12.4.12 Control Data Action............................................................. 658

12.4.13 Control Datapool................................................................. 658

12.4.14 Control DP Object................................................................659

12.4.15 Control FeedView................................................................ 659

12.4.16 Control Geom..................................................................... 660

12.4.17 Control Hide in Range.......................................................... 661

12.4.18 Control Hide on Empty......................................................... 661

12.4.19 Control Image.....................................................................662

12.4.20 Control Keyframe................................................................ 663

12.4.21 Control List........................................................................ 664

12.4.22 Control Map....................................................................... 666

12.4.23 Control Material.................................................................. 667

12.4.24 Control Num.......................................................................667



12.4.25 Control Object.................................................................... 668

12.4.26 Control Omo.......................................................................670

12.4.27 Control Parameter............................................................... 671

12.4.28 Control Pie......................................................................... 672

12.4.29 Control Scaling................................................................... 674

12.4.30 Control Sign Container......................................................... 674

12.4.31 Control SoftClip...................................................................675

12.4.32 Control Stoppoint................................................................ 676

12.4.33 Control Text........................................................................676

12.4.34 Control Targa Alpha............................................................. 677

12.4.35 Control Targa Clip................................................................678

12.4.36 Control Video......................................................................678

12.4.37 Control World..................................................................... 680

12.4.38 Placeholder........................................................................ 680

12.5 Default..........................................................................................681

12.5.1 Trio Scroll Element................................................................ 681

12.6 Global...........................................................................................682

12.6.1 Alpha..................................................................................682

12.6.2 Audio..................................................................................683

12.6.3 Clipper................................................................................685

12.6.4 Expert.................................................................................688

12.6.5 Extrude...............................................................................690

12.6.6 Glow...................................................................................691

12.6.7 HDR................................................................................... 692

12.6.8 Key.................................................................................... 692

12.6.9 Look-At............................................................................... 693

12.6.10 Mask Source and Mask Target................................................694

12.6.11 Lighting.............................................................................697

12.6.12 Z-Sort............................................................................... 698

12.6.13 Projector Source and Projector Target...................................... 701

12.6.14 Script................................................................................702

12.6.15 Shadow Caster and Shadow Receiver...................................... 704

12.6.16 Synchronized Properties....................................................... 707

12.6.17 Video Clip.......................................................................... 707

12.6.18 Window Mask..................................................................... 708

12.7 MPS..............................................................................................709

12.7.1 ExposeToVizkyAPI..................................................................709



12.8 MultiTouchComp............................................................................. 712

12.8.1 Plugin Event and Notification System........................................713

12.8.2 MtTelestrator Plugin...............................................................713

12.8.3 MtButton Plugin....................................................................715

12.8.4 Mt2D Control Plugin.............................................................. 720

12.8.5 Mt3D Control Plugin.............................................................. 724

12.8.6 MtNavigator Plugin................................................................727

12.9 PixelFX..........................................................................................730

12.9.1 pxLensMulti......................................................................... 730

12.10 Presenter.....................................................................................731

12.10.1 Bar................................................................................... 731

12.10.2 Bar Value...........................................................................732

12.10.3 Bar Values......................................................................... 734

12.10.4 Pie Slice............................................................................ 735

12.10.5 Pie Values..........................................................................736

12.11 pxColorWorks............................................................................... 737

12.11.1 PixelFX plugins................................................................... 737

12.11.2 pxAddSubtract.................................................................... 738

12.11.3 pxBlackAndWhite................................................................ 738

12.11.4 pxBrightContrast................................................................. 739

12.11.5 pxColorMatch..................................................................... 739

12.11.6 pxGamma..........................................................................739

12.11.7 pxHueRotate...................................................................... 739

12.11.8 pxMask............................................................................. 739

12.11.9 pxSaturation.......................................................................740

12.11.10 pxStack........................................................................... 740

12.11.11 pxTint..............................................................................741

12.12 RealFX........................................................................................ 741

12.12.1 RFxColliderSrc.................................................................... 742

12.12.2 RFxColliderTgt.................................................................... 743

12.12.3 RFxLatLong........................................................................ 743

12.12.4 RFxMagnet.........................................................................744

12.12.5 RFxTurb............................................................................. 744

12.12.6 RFxVortex.......................................................................... 744

12.13 Script Plugins............................................................................... 745

12.14 SplineFX...................................................................................... 745

12.14.1 2D Follow.......................................................................... 745



12.15 Text............................................................................................ 746

12.15.1 Mark Text...........................................................................746

12.16 TextFX.........................................................................................747

12.16.1 Common Text FX Properties...................................................748

12.16.2 Convert Case......................................................................749

12.16.3 Text FX Alpha..................................................................... 750

12.16.4 Text FX Arrange.................................................................. 750

12.16.5 Text FX Color......................................................................751

12.16.6 Text FX Color Per Vertex....................................................... 752

12.16.7 Text FX Emoticons............................................................... 753

12.16.8 Text FX Explode.................................................................. 753

12.16.9 Text FX Jitter Alpha..............................................................755

12.16.10 Text FX Jitter Position..........................................................755

12.16.11 Text FX Jitter Scale.............................................................756

12.16.12 Text FX Plus Plus............................................................... 757

12.16.13 Text FX Rotate.................................................................. 759

12.16.14 Text FX Scale....................................................................759

12.16.15 Text FX Size......................................................................760

12.16.16 Text FX Slide.....................................................................761

12.16.17 Text FX Vertex Explode....................................................... 762

12.16.18 Text FX Write.................................................................... 762

12.17 Texture........................................................................................764

12.17.1 Grabbit..............................................................................764

12.17.2 GraffitiTex.......................................................................... 771

12.17.3 Image Clip......................................................................... 773

12.17.4 LightBlur............................................................................776

12.17.5 MoViz................................................................................777

12.17.6 Noise................................................................................ 781

12.17.7 Soft Clip............................................................................ 782

12.18 Ticker..........................................................................................784

12.18.1 Scroller Action.................................................................... 784

12.19 Time........................................................................................... 787

12.19.1 Analog Watch..................................................................... 787

12.20 Tools........................................................................................... 788

12.20.1 Advanced Counter...............................................................789

12.20.2 Autofollow..........................................................................790

12.20.3 Autorotate......................................................................... 792



12.20.4 Bounding Actions................................................................ 793

12.20.5 Clock Rotation.................................................................... 794

12.20.6 Cloner............................................................................... 794

12.20.7 Colorize.............................................................................796

12.20.8 Counter............................................................................. 798

12.20.9 DVE Follow.........................................................................798

12.20.10 Heartbeat.........................................................................799

12.20.11 Image Link....................................................................... 800

12.20.12 Jack................................................................................ 801

12.20.13 Level Of Detail (LOD)......................................................... 803

12.20.14 Magnify........................................................................... 805

12.20.15 Match It...........................................................................806

12.20.16 Max Size..........................................................................806

12.20.17 Max Size Lines.................................................................. 807

12.20.18 Object Zoom.....................................................................808

12.20.19 Omo................................................................................809

12.20.20 Pablo...............................................................................810

12.20.21 Parliament........................................................................810

12.20.22 Rotations Order.................................................................811

12.20.23 Slide Show....................................................................... 812

12.20.24 System Time.................................................................... 813

12.20.25 Temo...............................................................................813

12.20.26 TextBG.............................................................................814

12.20.27 Text Link.......................................................................... 816

12.20.28 Text Parameters................................................................ 817

12.20.29 VCF Parameter..................................................................818

12.21 Transformation..............................................................................819

12.21.1 Justifier..............................................................................820

12.22 Vizual Data Tools...........................................................................820

12.22.1 Data Fit............................................................................. 821

12.22.2 Data Import....................................................................... 823

12.22.3 Data Label......................................................................... 825

12.22.4 Data Storage......................................................................828

13 Shader Plugins......................................................................................... 831

13.1 Default..........................................................................................831

13.2 Effects.......................................................................................... 831

13.2.1 Chroma Keyer...................................................................... 832



13.2.2 Fluid...................................................................................834

13.2.3 Frame Mask......................................................................... 835

13.2.4 Image Mask......................................................................... 835

13.2.5 Soft Mask............................................................................ 836

13.2.6 Water Shader....................................................................... 837

13.3 Filter.............................................................................................838

13.3.1 Blend Image........................................................................ 839

13.3.2 Blur....................................................................................840

13.3.3 Color Balance.......................................................................841

13.3.4 Radial Blur...........................................................................842

13.3.5 Sepia..................................................................................842

13.3.6 Sharpen.............................................................................. 843

13.4 Material........................................................................................ 844

13.4.1 Anisotropic Light...................................................................844

13.4.2 Bump Map...........................................................................844

13.4.3 Cartoon...............................................................................846

13.4.4 Gooch.................................................................................846

13.4.5 Normal Map......................................................................... 847

13.4.6 Simple Bump Map.................................................................848

13.5 PixelFX..........................................................................................849

13.5.1 Common Properties............................................................... 850

13.5.2 pxBCubic.............................................................................850

13.5.3 pxCCBase............................................................................850

13.5.4 pxEqualize...........................................................................850

13.5.5 pxGradient.......................................................................... 850

13.5.6 pxInvert.............................................................................. 851

13.5.7 pxLensDistort....................................................................... 852

13.5.8 pxMotionBlur........................................................................852

13.5.9 pxNoise...............................................................................852

13.5.10 pxPixelate..........................................................................853

13.5.11 pxPosterize........................................................................ 853

13.5.12 pxRecolor.......................................................................... 853

13.5.13 pxRipple............................................................................ 854

13.5.14 pxSparkle.......................................................................... 854

13.5.15 pxTurbDissolve and pxTurbWipe............................................. 855

13.5.16 pxTurbulence......................................................................855

13.5.17 pxTwirl.............................................................................. 855



13.5.18 pxWaves............................................................................856

13.6 PixelFXLenseFlare............................................................................856

13.7 RealFX.......................................................................................... 856

13.7.1 RFx2DSphere....................................................................... 858

13.7.2 RFxClouds........................................................................... 858

13.7.3 RFxFlame............................................................................ 858

13.8 RTT Advanced Materials................................................................... 858

13.8.1 Anisotropic Light Shader.........................................................861

13.8.2 Brushed Metal Shader............................................................863

13.8.3 Bump Shader....................................................................... 864

13.8.4 Bump Optimized Shader.........................................................866

13.8.5 Fabric Shader.......................................................................869

13.8.6 Glass Shader........................................................................870

13.8.7 Gooch Shader...................................................................... 871

13.8.8 Lacquered Surfaces Shader.....................................................873

13.8.9 Metal Reflection Shader......................................................... 874

13.8.10 Microstructure Shader.......................................................... 875

13.8.11 Monitor Shader................................................................... 876

13.8.12 Velvet Shader.....................................................................877

13.9 Texture......................................................................................... 878

13.9.1 Drop Shadow....................................................................... 878

13.9.2 Emboss...............................................................................879

13.9.3 MultiTexture......................................................................... 879

14 Scene Plugins...........................................................................................881

14.1 Default..........................................................................................881

14.1.1 VCF.................................................................................... 881

14.2 Image...........................................................................................883

14.2.1 Background Clip................................................................... 883

14.3 Libero........................................................................................... 885

14.3.1 EVSControl Plug-in................................................................ 885

14.3.2 Properties............................................................................885

14.3.3 Example Scenes................................................................... 887

14.4 Lineup.......................................................................................... 887

14.4.1 Tree Status.......................................................................... 887

14.5 MultiTouchComp............................................................................. 887

14.5.1 MtSensor Plugin....................................................................888

14.6 Script Plugins................................................................................. 889



14.7 Texture......................................................................................... 889

14.7.1 Graffiti................................................................................ 889

14.8 Tools.............................................................................................891

14.8.1 Level Of Detail (LOD) Manager................................................ 891

15 Texture Sources........................................................................................ 893

15.1 Default..........................................................................................893

15.1.1 Clip Channel........................................................................ 893

15.1.2 Dynamic Scene.................................................................... 894

15.1.3 Dynamic Texture...................................................................896

15.1.4 Live....................................................................................896

15.1.5 Stream................................................................................897

15.1.6 Viewport Tile........................................................................900

16 On Air Mode............................................................................................ 903

16.1 Director Control Panel......................................................................904

16.2 Control Buttons.............................................................................. 904

16.3 On Air Editor Buttons.......................................................................904

16.4 Performance.................................................................................. 905

16.4.1 Performance Analyzer............................................................ 905

16.4.2 Performance Bar...................................................................906

16.5 On Air Information.......................................................................... 907

16.6 License Information.........................................................................908

17 Transition Logic........................................................................................ 909

17.1 Standalone versus Transition Logic Scene Design.................................. 910

17.2 Toggle Layer.................................................................................. 910

17.3 State Transition Animation................................................................ 911

17.3.1 Defining States.....................................................................911

17.3.2 Identifying States..................................................................913

17.4 Cross Animation............................................................................. 914

17.5 Geometry Animation........................................................................915

17.6 Background Scene.......................................................................... 915

17.7 Foreground Scene........................................................................... 916

17.8 Tutorial......................................................................................... 917

17.8.1 Creating a Project................................................................. 917

17.8.2 Creating a Background Scene..................................................917

17.8.3 Creating a Foreground Scene.................................................. 920

18 Scripting................................................................................................. 923

18.1 How Programming Works..................................................................923



18.2 Program Structure...........................................................................924

18.3 Variables....................................................................................... 924

18.3.1 Basic Data Types.................................................................. 925

18.4 Procedures.....................................................................................927

18.4.1 Sub-routines........................................................................ 927

18.4.2 Functions.............................................................................928

18.5 Operators...................................................................................... 928

18.6 Conditions..................................................................................... 930

18.7 Loops........................................................................................... 931

18.7.1 Condition-controlled Loops......................................................931

18.7.2 Count-controlled Loops...........................................................931

18.8 Script Editor...................................................................................932

18.9 Creating and Running Scripts............................................................ 933

18.10 Creating Script-based Plugins.......................................................... 935

18.11 Controlling 3D Stereoscopic Clip Playback.......................................... 935

18.12 Program Examples........................................................................ 936

18.12.1 Initializing Scripts................................................................ 937

18.12.2 Calculating Values............................................................... 937

18.12.3 Registering Parameters.........................................................943

18.12.4 Registering Parameters and Moving Objects............................. 944

18.12.5 Mouse Events I (Set)............................................................946

18.12.6 Mouse Events II (Start).........................................................946

18.12.7 Mouse Events III (Start, Stop and Reverse)............................... 947

18.12.8 Mouse Events IV (Grow and Shrink)........................................ 948

18.12.9 Mouse Events V (Advanced).................................................. 949

18.12.10 Planets............................................................................ 956

18.12.11 Tetris...............................................................................960

18.12.12 Clip Channel..................................................................... 972

18.12.13 Clip Channel - Stereo......................................................... 998

19 Scripting Data Types and Procedures.......................................................... 1003

19.1 Callback Procedures...................................................................... 1003

19.2 Data Sharing................................................................................1007

19.2.1 Receiving Notification on Map Changes................................... 1009

19.2.2 VizCommunication.Map........................................................ 1010

19.2.3 Accessing Maps via the TCP or UDP Interface............................1011

19.2.4 Accessing Maps through the Command Interface.......................1011

19.2.5 Accessing Maps from Within Plugins........................................1011



19.3 Data Types and Procedures............................................................. 1012

19.3.1 Alpha................................................................................1012

19.3.2 Array[Type]........................................................................ 1014

19.3.3 Base.................................................................................1015

19.3.4 BezierHandle......................................................................1016

19.3.5 Boolean.............................................................................1018

19.3.6 Camera............................................................................. 1018

19.3.7 Center.............................................................................. 1020

19.3.8 Channel.............................................................................1021

19.3.9 ClipChannel........................................................................1023

19.3.10 Color...............................................................................1026

19.3.11 Container.........................................................................1027

19.3.12 DateTime......................................................................... 1035

19.3.13 Director........................................................................... 1035

19.3.14 Double............................................................................ 1039

19.3.15 Expert............................................................................. 1039

19.3.16 Geometry.........................................................................1041

19.3.17 Grid................................................................................ 1044

19.3.18 Image............................................................................. 1046

19.3.19 InfoText........................................................................... 1047

19.3.20 Integer............................................................................ 1049

19.3.21 Key.................................................................................1049

19.3.22 Key frame........................................................................ 1051

19.3.23 Light............................................................................... 1053

19.3.24 Material........................................................................... 1055

19.3.25 Matrix............................................................................. 1057

19.3.26 PluginInstance.................................................................. 1058

19.3.27 Position........................................................................... 1061

19.3.28 Rotation...........................................................................1063

19.3.29 Scaling............................................................................ 1064

19.3.30 Scene..............................................................................1066

19.3.31 Script.............................................................................. 1069

19.3.32 ScriptSettings................................................................... 1069

19.3.33 SharedMemory..................................................................1070

19.3.34 Stage.............................................................................. 1072

19.3.35 String..............................................................................1074

19.3.36 StringMap........................................................................ 1076



19.3.37 System............................................................................1076

19.3.38 Texture............................................................................ 1083

19.3.39 Timecode.........................................................................1085

19.3.40 Uuid................................................................................1087

19.3.41 Variant............................................................................ 1087

19.3.42 Vertex............................................................................. 1087

19.3.43 VizCommunication............................................................. 1089

19.3.44 Global Procedures..............................................................1090

20 Shared Memory (SHM)............................................................................. 1099

20.1 External Data Input....................................................................... 1099

20.1.1 TCP Protocol.......................................................................1100

20.1.2 UDP Protocol...................................................................... 1101

20.1.3 Plugin API.......................................................................... 1102

20.1.4 Command Interface............................................................. 1103

20.2 Internal Data (Interactive Scene)......................................................1104

20.3 Synchronization............................................................................ 1104

20.3.1 TCP and UDP Synchronization................................................1105

20.3.2 External Control Synchronization............................................1106

20.3.3 Command Synchronization....................................................1106

20.4 Snapshot..................................................................................... 1107

21 Working with FBX Files.............................................................................1109

21.1 Scene Graph Traversal................................................................... 1109

21.2 Transformations............................................................................ 1110

21.2.1 Avoid Transformations Being Baked........................................ 1110

21.2.2 Avoid Transformations Being Combined................................... 1111

21.3 Exporting FBX Files from 3ds Max and Maya.......................................1112

21.3.1 Units.................................................................................1112

21.3.2 Materials........................................................................... 1113

21.3.3 Other Materials...................................................................1114

21.3.4 Textures............................................................................ 1114

21.3.5 Camera............................................................................. 1114

21.3.6 Lights............................................................................... 1114

21.3.7 Spotlights.......................................................................... 1115

22 Glossary................................................................................................1117





Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 27

1 Introduction

This guide will help you to understand the Viz Artist user interface, and how to perform
certain tasks.

The term Viz is used for the programs installed and run on the computer. This is used
as a general reference for all modes of the program:

• Viz Artist

• Viz Engine

• Viz Config

What mode of program that can run is determined from the hardware dongle that is
attached to the actual machine (the different modes and the hardware dongle are
detailed in this User Guide).

This chapter contains information on the following topics:

• Document Structure

• Related Documents

• Customer Feedback and Suggestions

• Customer Support Request

1.1 Document Structure
This section describes the structure and content of the chapters of this User Guide.

• Section 1 Introduction

This chapter gives details on related documentation and how to contact Vizrt for
Customer support. Details are also given for Customers to provide feedback on their
Vizrt product.

• Section 2 Workbench Description

This chapter introduces Viz Artist and its basic concepts. It gives an overview of the
Main Window and Main Menu in Viz Artist, and also a description of the Scene Editor
and the Scene Editor Views that show a Scene from different camera angles.

• Section 3 Scene Tree Knowledge and Skills

This chapter describes the Viz scene tree, and shows the Scene Tree Knowledge and
Skills needed to be familiar with the scene tree and how it operates.

• Section 4 Manage Work and Viz Graphics Hub

This chapter describes briefly the Viz Graphic Hub, and how to manage Elements
and the work flow of Elements.

• Section 5 Global Tasks

This chapter describes how to perform Global tasks, such as working with the Scene
Settings, Implementing Video, Importing, Archiving and Deploy of graphics to video
clips and/or still images.

• Section 6 Lights

This chapter describes how to work with Lights.

• Section 7 Animation Stage
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• Section 8 Creating Animations

These chapters describe how to work with the Animation Stage when Creating
Animations.

• Section 9 Cameras

This chapter describes how to work with Cameras in scenes used in 2D and 3D
(stereoscopy) broadcast production.

• Section 10 Configuring Viz

This chapter describes all the configuration properties and parameters, and how to
use them when Configuring Viz Artist and Viz Engine.

• Section 11 Geometry Plugins

• Section 12 Container Plugins

• Section 13 Shader Plugins

• Section 14 Scene Plugins

• Section 15 Texture Sources

These chapters describe all the built-in plugins. Most of the plugin sections also
have small procedures with illustrations that help to get started with a scene design.

• Section 16 On Air Mode

This chapter describes the On Air Mode that is used to test and analyze the
performance of Viz scenes.

• Section 17 Transition Logic

The chapter describes the core aspects of Transition Logic scene design with a
small tutorial at the end to help you get started with your amazing transition logic
designs.

• Section 18 Scripting

• Section 19 Scripting Data Types and Procedures

These chapters describe the Viz scripting language, how to use it and the available
data types and procedures.

• Section 20 Shared Memory (SHM)

This chapter describes how to work with Shared Memory. Some use cases are
described to give a better understanding of Shared Memory and its functionality.

• Section 21 Working with FBX Files

This chapter describes how to work with other 3D design software and how to
import and work with FBX files in Viz Artist.

• Section 22 Glossary

The chapter gives an extensive description of keywords and acronyms referenced
throughout the document, with simple and to the point explanations.

1.2 Related Documents
• Viz Artist Script reference: Contains information on how to create scripts for a

scene.

• Viz Engine Administrator’s Guide: Contains information on how to install the Viz
Engine software and supported hardware.

• Viz Engine Plugin SDK reference: Contains information on how to create a
customized Viz plugin.
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1.3 Customer Feedback and Suggestions
We encourage suggestions and feedback about our products and documentation. To
give feedback and, or suggestions, please identify your local Vizrt customer support
team at www.vizrt.com.

1. Go to www.vizrt.com.

2. Click on Contact (1).

3. The Vizrt office which is nearest to your location will be shown (2), or select from
the list of Vizrt offices.

4. Click on ‘Contact’.

5. Complete the required details in the window that opens.

Note: If this message is for Customer Support, and their is a Support Contract in
place, then click on the ‘For support requests, please visit our support portal’ link
in the message window.

6. Click on CONTACT ME.

A Vizrt representative will contact you as soon as possible.

1.4 Customer Support Request
Support Requests are supported by Vizrt if Customers have a valid Service Agreement
in operation. Customers who do not have a Service Agreement and would like to set up
a Service Agreement should contact their regional sales representative (see Customer
Feedback and Suggestions).
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When submitting a Support Request relevant and correct information should be given
to Vizrt Support, to make sure that Vizrt Support can give the quickest and best
solution to your Support Request.

This section contains information on the following topics:

• Before Submitting a Support Request

• Submitting a Support Request

• Viz Log Files

1.4.1 Before Submitting a Support Request

Before a Support Request is submitted make sure that you:

Read:

• The relevant User Guide or Guides

• The release notes

and Check:

• That the system is configured correctly

• That you have the specified hardware, tested and recommended versions

Always refer to your Vizrt Service Level Agreement document.

1.4.2 Submitting a Support Request

When completing a Support Request, add as much information as possible.

This section contains information on the following topics:

• Content of a Support Request

• To Submit a Support Request

Content of a Support Request

The report should contain information about these topics:

• Problem description: Include a good description of what the problem is and how
to reproduce it. Remember to use simple English.

• Screen shots and illustrations: Use to simplify the message.

• System log files: Send the system log files (see Viz Log Files).

• System dump files: Send the system dump files from the crash (e.g. Viz Artist
program folder <Viz install directory>).

Note: Check: If the operating system is Windows 7 and up, dump files can be
stored at: <userdir>\AppData\Local\VirtualStore\<Viz install directory> (check
user rights).

• System Config file: Send the system config file (e.g. Viz Artist program folder <Viz
install directory>).
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Note: If the operating system is Windows 7 and up, the config file can be stored
at: <userdir>\AppData\Local\VirtualStore\<install_directory> (check user rights).

• Software configuration: Add exact versions of software (-build) used.

• Hardware configuration: Add exact versions of hardware used.

• System setup: Describe differences in the installation, if any, from the
recommended setup.

• System Network: Add a description of how the network, bandwidth, routers, and
switches are configured.

Always refer to your Vizrt Service Level Agreement document.

To Submit a Support Request

1. Go to Vizrt.com.

2. Click on Support (1).

3. Click on Report a case (2).

4. Click on LOG IN (3).

5. Login to the Customer and Partner portal.
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6. Click on Report a Case (4).

7. In the online form complete the required minimum information (shown by a red
asterisk):

• Contact: Your name

• Account: Your account

• Product: The product the support request refers to.

• Case Type: The type of support request required

8. Click SAVE.

9. In the saved Support Case that opens, complete the various text boxes and upload
any required documents, files, etc. (see Content of a Support Request).

Note: The entered text or uploaded documents / files are automatically added.

To track the status of open support tickets, login to the Customer and Partner portal.
Add information or communicate about the cases directly with the support team.

1.4.3 Viz Log Files

The location of Viz log files is shown in the Viz Configuration, Local Settings.

Log Directory

1. Check the Log Directory path (1) for the Viz Log files location.

2. If the path is empty the log files will be located in the Viz Artist program folder
<viz install directory>.

Note: Check: If the operating system is Windows 7 and up, log files can be stored
at: <userdir>\AppData\Local\VirtualStore\<install_directory> (Check user rights).

Viz Render Log

• Name: VizRender_<timestamp>.log
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• Purpose: Information on current status of the engine

Viz Trace Log

• Name: VizTrace_<timestamp>.vlog

• Purpose: Command trace that facilitates playback for error reproduction, contains
at most the last 500 commands

Viz Gui Log

• Name: VizGui _<version>.log

• Purpose: Information on Viz Gui errors

Viz Shaders Log

• Name: VizShaders.log

• Purpose: Information on shader compilation

Viz Console Log

• Name: Viz_<timestamp>.log

• Purpose: Log console output to a file when the engine is started without console (-
C option)

Viz Gui Connection Log

This Log is created if ‘Write GH Connection Log’ is active (see Local Settings).

• Name: VizGuiConnection<timestamp>.log

• Purpose: Information on the Viz Graphic Hub database connection
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2 Workbench Description

This Section gives a Workbench Description (overview) of Viz Artist and its main panels.

This section contains information on the following topics:

• Main Window

• Main Menu

• Scene Editor

• Working with the Scene Editor

• Scene Editor Views

• Keyboard and Mouse Shortcuts

2.1 Main Window
After a successful login, the Main window shows.

At the top of the Main window is the Main Menu bar. Below the Main menu bar is the
display area. The content of the display area changes according to selections made in
the Main menu.

At system startup the area is divided into four panels:

Fig Item Panel Description

1 Server Area From the Server area it is possible to control Elements,
such as Materials, Images, and Fonts which are located
in the Viz Graphic Hub.

2 Properties Properties for Containers (Container contents), Cameras,
Lights and Scene Settings are controlled from the
Property panel, where size, position and other settings
are modified, if required.

3 Scene Editor A visualization of the Scene is shown in the Scene Editor
panel.
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Fig Item Panel Description

4 Scene Tree Elements, in the Viz Graphic Hub database, can
be added to the Scene Tree, which is the logical
visualization of a Scene. The Scene Tree is built up of
Containers, which can hold items such as Materials or
Plugins.

Note: The panel areas can be resized.

2.1.1 Dual Monitor Configuration

Viz Artist can be configured to work on two monitors (see User Interface). The screen
options are:

• Mosaic Horizontal or Mosaic Vertical

• Dual Screen

Mosaic Horizontal or Mosaic Vertical

Horizontal: The Server, Properties and Scene Tree panels show on the left monitor and
the Scene Editor shows on the right monitor.

Vertical: The Server, Properties and Scene Tree panels show on the top monitor and
the Scene Editor panel shows on the bottom monitor.

In both Horizontal and Vertical view the monitor which shows the Scene Editor panel
can be set to show either, (O) Reset size to screen size or (R) Set size to output aspect
(1).

Note: Mosaic Horizontal and Mosaic Vertical are only available with NIVIDA
graphics cards, under Windows 7 and up.

Mosaic Horizontal
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Mosaic Vertical

Dual Screen

Dual Screen

The Scene Editor panel opens in a new window, and the elements cannot be dragged
to the Scene Editor panel.

2.2 Main Menu
The buttons in the Main menu make it possible to change the view of the Display area.

This section contains information on the following topics:

• Main Menu Left

• Main Menu Right

2.2.1 Main Menu Left

This section contains information on the following topics:

• VizBoldServer Button

• VizBoldBuilt Ins Button

• VizBoldControl Button
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• VizBoldViews Button

• VizBoldTree Button

• VizBoldStage Button

• VizBoldServer/Stage Button

• VizBold+Tree/Stage Button

Server Button

From the Server area it is possible to control the database elements, such as Scenes,
Materials, and Images. The elements in the database, which is common for all users
connected to the database, can be added to the scene. Server is the default view that
appears at system startup.

For more information see the Manage Work and Viz Graphics Hub, Server Menu, and
Server Tree Menu sections.

Shows the following panels:

• Server (top left)

• Scene Tree (bottom left)

• Property (top right)

• Scene Editor (bottom right).

Built Ins Button

From the Plugins area it is possible to control the built in plugins such as Geometries,
Container, Shader, Texture and Scene plugins. The features vary according to which
plugin packages that are licensed and installed on each machine.

For more information see Built Ins, Scene Editor, Image Editor, and Plugin sections.

Shows the following panels:

• Plugins (top left)

• Scene Tree (bottom left)

• Property (top right)

• Scene Editor (bottom right).

Control Button

The Control area shows the Control Objects and Control Channels.

Shows the following panels:

• Controls (top left)

• Scene Tree (bottom left)

• Property (top right)

• Scene Editor (bottom right)

Views Button

The Views area shows three configurable camera views, in addition to the one in the
Scene Editor area. The additional camera views make it possible to monitor the scene
from up to four various angles simultaneously.
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For more information see the Scene Editor Views section.

Shows the following panels:

• Views (left)

• Property (top right)

• Scene Editor (bottom right)

Tree Button

The Tree view is similar to the Server view, but without the database appearance. This
option is practical when the scene tree is complex and holds many containers. If the
scene tree is still not big enough in the regular Tree view, it is possible to click the
Zoom Out button above the scene tree. This will shrink the size of all the containers, so
that even more containers fit in.

For more information see the Scene Tree Knowledge and Skills chapter.

Shows the following panels:

• Scene Tree (left)

• Property (top right)

• Scene Editor (bottom right)

Stage Button

From the Stage it is possible to control the animations in the scene. The Stage shows
the timeline from animation start (left side) to stop (right side).

For more information see the Animation Stage and Creating Animations chapters.

Shows the following panels:

• Stage (top)

• Scene Tree (bottom left)

• Scene Editor (bottom right)

Server/Stage Button

The Server/Stage view is similar to the regular Stage view, but here the scene tree has
been replaced with the database content.

Shows the following panels:

• Stage (top)

• Server (bottom left)

• Scene Editor (bottom right)

+Tree/Stage Button

The +Tree/Stage view is only available on machines with a screen resolution of
1600x1200 or higher, and shows both the database content and the scene tree.

Shows the following panels:

• Stage (top)

• Server (bottom left)
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• Scene Tree (bottom center)

• Scene Editor (bottom right)

2.2.2 Main Menu Right

This section contains information on the following topics:

• VizBoldImport Button

• VizBoldArchive Button

• VizBoldDeploy Button

• VizBoldConfig Button

• VizBoldPost Button

• VizBoldOn Air Button

• Information, Minimize and Close Buttons

Import Button

Click to open the Import panels. Use these panels to transfer archives and various files
into the database. For more information see the Importing section.

Archive Button

Click to open the Archive panels. Use these panels to create an archive of multiple
database elements into a single file, which is then located on the hard drive. For more
information see the Archiving section.

Deploy Button

Click to open the Deploy panels (available when Deploy is enabled in the Viz
Configuration, see the Configuring Viz chapter). Use these panels to copy Elements,
with all their necessary data, from one server to another. For more information see the
Deploy section.

Config Button

Click to open the Viz Configuration panel. Use this panel to change system options and
functionality. For more information see the Configuring Viz chapter.

The content of the Viz Configuration panel changes with different platform types. An
installation on a machine that contains a video board will run the software in Video
mode, a machine with no video board will run the software in Standard PC mode. To
find the platform type select the License Information button (see Main Menu Right).

Alternatively, the Configuration can be launched as a separate application from Start
-> All Programs -> Vizrt -> Viz 3 -> Config. Note that after altering the configuration
settings, the system should be restarted for the changes to take effect.

Post Button

Opens the Post Rendering panel. From this panel it is possible to export image chains or
Scene clips. For more information see the Post Rendering section.
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On Air Button

Opens the On Air panel. This panel switches the application from the modelling tool
to a plain rendering engine. The application waits for control commands through its
communication port, or it can be controlled manually from the control buttons when Viz
is set in On Air Mode.

By default, the port number is set to 6100. The port number and other communication
settings can be modified from the Communication section in the Configuring Viz
chapter.

Information, Minimize and Close Buttons

•  Documentation Button: Opens the Viz Artist Users Guide.

•  Message Box Button: Opens the Message window. This window shows server
warnings, and chat messages can be sent/received to/from other users connected to
the database.

•  Show Commands Button: Opens the Viz Engine Console window. This window
shows the commands that are used for the communication between the user
interface and the rendering Viz Engine. The console window is mainly used for
debugging purposes.

Tip: Use keyboard shortcut <Alt+C> to open the Viz Engine Console window.

•  License Information: Opens the License Information window. This window
shows the status of the current license such as license expiration date, platform
type (Standard PC or Video), licensed plugin packages, Viz version number, etc. This
is also where the license can be renewed. For details on how to renew the license
see the Viz Engine User’s Guide.

•  Minimize Button: Minimizes the Viz Artist window.

•  Close Button: Opens the Quit or Restart menu. In the Quit or Restart menu click
on the drop down arrow to open the shut down menu.

Tip: Use the keyboard shortcut <double-Esc>, or <Alt+F4> to close Viz Artist.
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2.3 Scene Editor

The Scene Editor has a set of useful functions that lets the designer see how the
graphics will look when keyed, seen from a different angle in virtual sets, positioned on-
screen, performance of the scene and more.

At the left side of the Scene Editor is a vertical bar. This bar makes it possible to show
additional information in the Scene Editor, as well as providing more options while
working.

This section contains information on the following topics:

• Layer Manager

• Scene Editor Buttons

See Also

• Working with the Scene Editor

• Scene Editor General Shortcuts

• Scene Editor Camera Controls and Shortcuts

• Scene Editor Orthogonal View Controls and Shortcuts

• Scene Editor Animation Controls and Shortcuts



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 43

2.3.1 Layer Manager

All scenes are, by default, designed to run in the main layer, but can be played out in
the front and back layer as well. The layer manager can be used to test combinations
of scenes in the three layers (front, main and back).

A scene set in the main Layer can be edited in the Scene Tree and the Scene Editor
panel. Scenes set in the Front or Back Layer can be edited in the Scene Tree and
the Scene Editor panel by a double click (opens the scene in the scene tree) on the
relevant Scene (see also Context Menu).

Picking in the Scene Editor is done on the loaded layer. The Grid Toolbar also works for
the current layer.

You can also set the same scene to the front and back layer, creating what is known as
self layer(s). This will allow you to link the scenes and adjust the camera settings for
the front layer. When saving a scene, any self layer settings will be preserved.

 The three small indicators show which layer is active in the scene tree, and are
referred to as traffic lights.

Context Menu

• Open <scene>: Opens the scene for editing.

• Set Inactive/Active: Enables you to show the layer or not.
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• Reset layer: Removes the scene from the layer (the same as drag and drop into
the bin).

• Database Search: Opens the location of the scene.

To add scenes to the layer manager

• Simply drag and drop the scenes onto the layer placeholder(s).

See Also

• Scene Editor Buttons

• Working with the Scene Editor

• Timeline Editor

2.3.2 Scene Editor Buttons

Click the Scene Editor buttons once to enable the features, click them again to disable.

• Snap: Takes a snapshot of the current content in the Scene Editor. For more
information, see the Snapshot section.

• KP: Activates the preview of the key signal.

• N: Shows the normal vertices. For example, it is practical to use this feature when
the lighting is not reflected in the desired manner. Enabling this feature shows the
vertices as purple handles. These handles makes it easier to predict how the light
will be reflected.

• E: Enables the handling of interactive script/plugin events. Interactive scripts and
plugins are those related to mouse or keyboard actions.

• TA: Shows the title area as the outline of a light blue rectangle in the Scene Editor.

Tip: The size of the title area can be defined under the Rendering scene settings.

• SA: Shows the safe area as the outline of a green rectangle in the Scene Editor.

Tip: The size of the safe area can be defined under the Rendering scene settings.

• Key: Shows what the key output will look like.

Note: Scene editing is disabled while Key is shown.

• W: Renders the scene in wire frame mode.

• BB: Enables the bounding box visualization for the selected container.

• P: Shows the Performance bar .

• Grid: Opens the Grid Toolbar .

This section also contains information on the following topics and procedures:

• Snapshot

• To take a snapshot

• Performance bar
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• To view the performance bar in the Scene Editor

• To view all performance bar indicators

• Grid Toolbar

• To enable the Grid toolbar

Snapshot

A snapshot can be taken of the current content in the Scene Editor.

When clicking the Snap button, the Server view will automatically be selected from
the main menu, and the database content will appear. The image will be placed in the
folder/project that was last visited.

To take a snapshot

1. Click the Snap button to create an RGB image, or

2. Press the Shift key and click the Snap button to create an RGBA image.

3. In the Snapshot dialog box that appears, enter the name, size, and format for
the image.

4. Click Ok to save the image to the database.

Note: An RGBA image will use the key information as alpha.

Note: To save the image in another folder/project, select the destination, and then
click the Snap button again.

Performance bar

The Performance Bar can, in addition to being shown in On Air Mode, be shown at the
bottom of the Scene Editor. The performance bar gives an idea of the performance
(frames per second) the Scene is rendering in. Each indicator shows how many
microseconds each rendering step takes:

• CUR (Current): Shows how many frames per second the scene will render at in On
Air mode. The number should be above 50 (PAL) or 60 (NTSC), according to the rate
that has been specified in the Output Format section.

• MAX (Maximum): Shows how many frames per second the scene can render
at without waiting for vertical retrace. The higher the maximum value, the more
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performance is left. If the maximum value is reduced to below 50 or 60, the scene is
not rendering in real-time.

• Blue bar: Shows the number of frames used

• Green bar: Shows the number of frames available

They are also linked to the bars with different colors.

To view the performance bar in the Scene Editor

• Click the Scene Editor’s P button.

To view all performance bar indicators

• Middle-click the P button to show all performance indicators:

• VER (Vertices): Shows the number of vectors in the scene.

• TET (AllocTexSize): Shows the total allocated size of texture memory.

• TEC (TexSize): Shows the size of the currently used texture memory.

• ANI (Animation): Shows how many microseconds all active directors and
animation channels take. This indicator is linked to the yellow bar.

• MAT (Matrix): Transforms each container in the scene into world coordinate space.
This indicator is linked to the cyan bar.

• Z&C (Z-Sort): Refers to Z-sort and Culling, and sorts all containers for correct
transparency drawing and determines if containers are visible in the current camera
view. This indicator is linked to the pink bar.

• VID (Video): Shows how many microseconds video input (live video texture) and
video output take. De-interlaced video inputs take longer time than progressive
and interlaced. The only way to improve this value is to use a faster system. This
indicator is linked to the red bar.

• REN (Rendering): Shows how many microseconds it takes to render all objects on
the screen. A faster graphics card will improve this value. This indicator is linked to
the blue bar.

• PLU (Plugin): Indicates how much time in microseconds all active plugins spend in
each render cycle. This indicator is linked to the orange bar.

• SCR (Script): Shows the consumed time in microseconds from all active scripts.
This indicator is linked to the dark green bar.

• CUR (Current): Shows how many frames per second the scene will render at in On
Air mode. The number should be above 50 (PAL) or 60 (NTSC), according to the rate
that has been specified in the Output Format section.

• MAX (Maximum): Shows how many frames per second the scene can render
at without waiting for vertical retrace. The higher the maximum value, the more
performance is left. If the maximum value is reduced to below 50 or 60, the scene is
not rendering in real-time.

Grid Toolbar
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The Grid toolbar can be shown in the lower part of the Scene Editor. Grids are used to
align containers.

• Plane Type: Shows which plane the grid should lie in:

• Off: Indicates that the grid is switched off.

• Align X/Y: Aligns the grid to the X/Y-plane.

• Align X/Z: Aligns the grid to the X/Z-plane.

• Align Y/Z: Aligns the grid to the Y/Z-plane.

• Free Grid: Makes it possible to use a free grid (for example aligned to a object).

• Select Grid: Sets a predefined grid. 9 grids can be selected and manually
configured as presets for the scene.

• Show/Hide Grid: Shows or hides the grid in the Scene Editor.

• Home: Sets the grid back to its default position.

• Snap to Grid: If this button is enabled, and the position of a container is modified
by dragging it around in the Scene Editor, the position of the object will be snapped
to the grid (i.e. the center of the X and Y axis).

• Align Object on Plane: To align the axes of a container to the corresponding axes
of the grid, first enable this option and next left-click the container you want to align
and drag it around. As long as this option is switched on, the container will move
only along the plane if you drag it around in the Scene Editor.

• Move Object to Plane: If you select a container and next click this icon, the
container will be moved so its center is on the plane.

• Size: Defines the raster size of the grid.

• Change Color of Grid: Changes the color of the grid.

The following three buttons are only available if the grid type is set to Free Grid:

• Picking On/Off: Aligns the grid to the object. Enable picking and click the object to
align the grid. The grid will be aligned to the vertex you click on.

• Move Grid to Object: Moves the grid so the center of the selected container will
be on it.

• Free Plane Value Editor: Switches the free plane value editor on and off. In this
editor you can adjust the grid’s plane.

To enable the Grid toolbar

• Click the Scene Editor’s Grid button.

See Also

• Layer Manager

• Working with the Scene Editor

• Timeline Editor
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2.4 Working with the Scene Editor
Some transformation parameters of a Container or Containers in a Scene can be edited
in the Scene Editor. Furthermore you can switch some properties of a container ON and
OFF.

This section contains information of the following topics:

• Scene Editor Functions

• Scene Editor Context Menu

See Also

• Scene Editor General Shortcuts

• Scene Editor Camera Controls and Shortcuts

• Scene Editor Orthogonal View Controls and Shortcuts

• Scene Editor Animation Controls and Shortcuts

2.4.1 Scene Editor Functions

This section contains information of the following topics:

• To select/deselect an object

• To copy an object

• To move an object

• To move an object on its Z axis

• To select multiple objects

• To deselect multiple objects

• To add properties to multi selected objects

• To move multi selected objects
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• To move multi selected objects on their Z axis

To select/deselect an object

1. Left-click on an object, to select that object.

Note: This is done on a per pixel basis.

• A bounding box shows which object has been selected (if the Bounding Box
option is enabled, see Scene Editor Buttons).

• The selected object’s Container is highlighted in the Scene Tree

• Click on the Transformation editor in the Properties panel to show to the
transformation properties.

2. Press Space or click in an empty space to deselect an object.

To copy an object

1. Hold the Ctrl key down and click and hold the left mouse button

2. Drag and drop the object to the new location.

To move an object

1. Left-click on an object, to select that object.

2. Keep the left button pressed and move the object within the Scene Editor.

3. Release the left button

To move an object on its Z axis
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1. Left-click on an object, to select that object.

2. Keep the left button pressed and press the right button. Hold both buttons down.

3. Move the mouse to the left or right to move selected object in its Z axis.

Multiple objects selected

When multiple objects are selected in the Scene Editor, the Transformation editor, in
the Properties Panel, will show the editable properties for all selected objects.

All selected objects will be included in one bounding box (if the Bounding Box option
is enabled, see Scene Editor Buttons). The selected object’s Containers are also
highlighted in the Scene Tree.

Note: When more than one object is selected the Group coordinate system will
show and a bounding box will cover all selected objects. When Local and World is
selected a bounding box for each selected object will show.

To select multiple objects

1. Hold the <Ctrl> key and click on each object to select, as required, or

2. Click in an empty space in the Scene Editor and drag around the required objects
to select.

To deselect multiple objects

1. Press the SPACE bar, or

2. Click in an empty space on the Scene Editor.

Note: Toggle the SPACE bar to select or deselect multiple objects
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To add properties to multi selected objects

1. Multi select the required objects.

2. From the Server Area select the required Element.

3. Drag the Element to one of the selected objects.

4. All selected objects will take on the property.

To move multi selected objects

1. Select the required objects (see how To select multiple objects)

2. Left-click one of the objects to be moved and move the multi selected objects
within the Scene Editor.

3. Release the left button.

To move multi selected objects on their Z axis

1. Select the required objects (see how To select multiple objects)

2. Left-click on one of the multi selected objects.

3. Keep the left button pressed and press the right button. Hold both buttons down.

4. Move the mouse to the left or right to move selected objects in its Z axis.
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2.4.2 Scene Editor Context Menu

In the Scene Editor right-click and hold to open a context menu:

Note: The context menu selection is available on a single Container or multiple
Containers.

• Position: Switches into the position mode.

• Rotation: Switches into the rotation mode.

• Scale: Switches into scale mode.

• Center: Switches into center editing mode.

• Space: Switches between coordinate systems:

• Parent/Group: Refers to changes that can be made to the Container or Containers
in its Parent or Group coordinate system.

• Local: Refers to changes that can be made to the container in its local coordinate
system.

• World: Refers to changes that can be made to containers in their world coordinate
system.

Note: Multi selected objects: When more than one object is selected Group will
show and a bounding box will cover all selected objects. When Local and World is
selected a bounding box for each selected object will show.

• Properties (only applicable if a Container is selected):

• Hide/Show: Hide or show the Container in the Scene Editor.

• Lock/Unlock: Lock and unlock the container. When locked the Container cannot be
modified in the Scene Editor.

• Transformation: Opens the transformation editor for the Container.

• Normal vectors: Toggle the display of the normal vectors at the bottom of the
properties you will find a list of all properties applied to the container with the
possibility to switch them on and off.

• Material: Select enlighted or colored.
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• Any other properties of the container can set to on and off (except materials).

• Animation: Shows the animation path of when Working with Position Key frames
(only applicable if a container is selected and it has an animation defined).

This section contains information of the following topics:

• To select an option from the context menu

• To change an object’s position

• To rotate an object

• To scale an object

• To move the axis center of an object

To select an option from the context menu

1. Right-click and hold.

2. Move the cursor to the option you want to select

3. Release to select.

To change an object’s position

1. Select an object.

2. Right-click the object and select position from the context menu.

3. Grab and drag a handle.

The container will follow the movement along the axes shown in the selected camera
view. During this operation a status window is shown, giving you information about the
position.
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To rotate an object

1. Right-click to open the context menu.

2. Select rotation.

3. Drag the handles side ways to rotate on all the axes.

To scale an object

1. Right-click to open the context menu

2. Select scale.

3. Drag the handles to scale the object.
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To move the axis center of an object

1. Right-click to open the context menu

2. Select center.

This will show the axis of the selected container with handles on their ends.

3. Grab one of the handles and change the center position by dragging them around
the Scene Editor.

See Also

• Layer Manager

• Timeline Editor

2.5 Scene Editor Views

By clicking the Views button in the Main Menu, three extra Scene Editor views open on
the left side of the main Scene Editor.
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These are a good aid for getting an overview of the objects in the scene and visualize
their position in relation to lights and cameras. They have, in principle, the same
functionality as the main Scene Editor and let you do the same operations on objects
as you would in the main Scene Editor. As well as the main Scene Editor, the side views
may be set to view through one of the 16 editable cameras or through one of the six
predefined orthogonal views. Setting them to one of the predefined orthogonal views
allows you to change position and direction of lights and cameras.

If you set the Scene Editor to show one of the predefined orthogonal side views there
are some special shortcuts that may be used to pan and zoom:

• Pan: By clicking the left button in the background (not the objects).

• Zoom in (Z) and out (X): Zoom in or out by holding down the Z or X keys and
draw a rectangle with the left button pressed, or press the Z or X keys multiple to
zoom in or out in a stationary position.

In the six predefined orthogonal views, the currently selected camera, and in addition
all cameras that have been given the status Vis or inf, will show as symbols. By
clicking on them in the side views, their focus will be set in the main Scene Editor and
handles for editing position and direction will be visible (drag the handles to change
position and direction).

The same is the case with lights. The light source currently selected and those which
have the Vis status as ON, will be visible as symbols. Their position and direction can
be edited with the cursor.

See Also

• Working with Light

• Cameras

2.6 Keyboard and Mouse Shortcuts
When a keyboard shortcut is used, always make sure that the keyboard ‘Caps Lock’ is
set to Off, unless otherwise stated.

This section contains information on the following topics:

• Application Controls and Shortcuts

• Integer/Float Controls

• General Server Tree Shortcuts

• General Server Element Area Shortcuts

• Server View Shortcuts

• Built-in View Shortcuts

• General Scene Tree Shortcuts

• Scene Tree Basic View Controls and Shortcuts

• Scene Tree Sort View Shortcuts

• Scene Editor General Shortcuts

• Scene Editor Camera Controls and Shortcuts

• Scene Editor Orthogonal View Controls and Shortcuts

• Scene Editor Animation Controls and Shortcuts

• General Stage Tree Shortcuts
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• Stage Controls and Shortcuts

• Import File Shortcuts

• Import Archive Shortcuts

• On Air Shortcuts

• Import File Shortcuts

• Script Editor Shortcuts

2.6.1 Application Controls and Shortcuts

Function Key and/or Mouse

Display Context Menu Right mouse button click

Quit Viz Artist Double-Esc

Alt+Q

Alt+F4

Show/Hide Viz Command Console Alt+C

Show Video Output Configuration
Window

Alt+V

Show Performance Analyzer Window Ctrl+Right mouse click on Quit button

Quit Viz Engine Double-Esc

Alt+Q

Alt+F4

2.6.2 Integer/Float Controls

Function Key and/or Mouse

Increase/Decrease very large steps
(100)

Shift+Alt, or

Hold left mouse button and move

Increase/Decrease large steps (10) Alt, or

Hold left mouse button and move

Increase/Decrease normal steps (1) Hold left mouse button and move

Increase/Decrease small steps (0.1) Ctrl, or

Hold left mouse button and move

Increase/Decrease very small steps
(0.01)

Shift+Ctrl

Hold left mouse button and move

Reset whole group Double click one of the Rs (Reset Button)
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2.6.3 General Server Tree Shortcuts

Function Key and/or Mouse

Jump to top of tree Home

Jump to bottom of tree End

Move a page down in the tree pgdown

Move a page up in the tree pgup

Scroll up the tree Cursor up

Scroll down the tree Cursor down

Open or close the selected tree Return, or the numeric keyboard Return

Delete a folder Delete (after confirmation)

2.6.4 General Server Element Area Shortcuts

Function Key and/or Mouse

Jump to Top Element Home

Jump to Last Element End

Move a page down pgdown

Move a page up pgup

Scroll up the Element list Cursor up

Scroll down the Element list Cursor down

Scroll left in the Element list Cursor left

Scroll right in the Element list Cursor right

Open or close the selected tree Return, or the numeric keyboard Return

Delete an item Delete (after confirmation)

2.6.5 Server View Shortcuts

Function Key and/or Mouse

Open Graphics Hub Search Window Ctrl+F

Switch to Scenes Ctrl+1

Switch to Geometries Ctrl+2

Switch to Materials Ctrl+3
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Function Key and/or Mouse

Switch to Advanced Materials Ctrl+4

Switch to Images Ctrl+5

Switch to Fonts Ctrl+6

Switch to Audio Files Ctrl+7

Switch to All Ctrl+8

Switch to Auto Selection Ctrl+9

Show/Hide Properties of a File Ctrl+P

Toggle Detail View Ctrl+Y

Create new Material or new Scene Ctrl+A

This works only in Material or Scene View.

Copy File(s) Ctrl+C

Cut File(s) Ctrl+X

Paste File(s) Ctrl+V

This will create a link. File will not be duplicated.

Paste File(s) Ctrl+Shift+V

This will duplicate the file(s).

Export Ctrl+E

This works only in Image View.

Rename File F2

Duplicate Selected File(s) Ctrl+Left mouse button click and drag

Link File(s) to a different Folder/
Project

Alt+Left mouse button click and drag

Multidrop Hold left mouse button and move; middle mouse
button click

2.6.6 Built-in View Shortcuts

Function Key and/or Mouse

Jump to plugin which starts with a
given letter

Press the first letter of the plugin name.

Jump to Default folder for a
category of plugins

Double-click the plugin folder tab.

Scroll up the plugin list Cursor up
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Function Key and/or Mouse

Scroll down the plugin list Cursor down

Scroll left in the plugin list Cursor left

Scroll right in the plugin list Cursor right

2.6.7 General Scene Tree Shortcuts

Function

Switch to Basic View Ctrl+1

Switch to Sort View Ctrl+2

Switch to Search View Ctrl+F

Show Scene Log Window Ctrl+4

Show Scene Information Window Ctrl+5

Refresh Ctrl+A

Use shortcut <Ctrl-Shift-A> to switch autograb focus with the Property Editor

Function Key and/or Mouse

Go to Top Container Home

Go to Last Container End

Go to top of page pgdown

Go to bottom of page pgup

Scroll up the Container list Cursor up

Scroll down the Container list Cursor down

Open or close the Container tree Return, or the numeric keyboard Return

2.6.8 Scene Tree Basic View Controls and Shortcuts

Function Key and/or Mouse

Insert New Container Ctrl+Insert

The new Container will be created above the first
selected Container.

Delete Selected Container(s) Ctrl+Delete

Open Tree Ctrl+O

Collapse Tree Ctrl+I
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Function Key and/or Mouse

Lock Selected Container(s) Ctrl+L

Unlock Selected Containers(s) Ctrl+Shift+L

Group Selected Container(s) Ctrl+G

Ungroup Selected Container(s) Ctrl+Shift+G

Hide Selected Container(s) Ctrl+H

Show Selected Container(s) Ctrl+Shift+H

Undo Ctrl+Z

Redo Ctrl+Y

Save the Scene Ctrl+S

Copy Selected Container(s) Ctrl+Left mouse click on container name and
drag

Copy Selected Container(s) to
Clipboard

Ctrl+C

Paste Containers from Clipboard Ctrl+V

They will be created one hierarchical level
underneath selected container.

Cut Selected Container(s) Ctrl+X

Move Selected Container(s) Left mouse click on container name and drag

Move Selected Container and retain
transformation properties

Alt+Left mouse click on container name and
drag

Copy Properties of Container Left mouse click on container Properties and
drag

Merge Group Ctrl+M

Split Container Ctrl+Shift+M

2.6.9 Scene Tree Sort View Shortcuts

Function Key and/or Mouse

Sort by Vertices Ctrl+Q

Sort by Render Time Ctrl+W

Sort by Texture Size Ctrl+E

Toggle Unique for Texture Size Ctrl+T
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2.6.10 Scene Editor General Shortcuts

Function Key and/or Mouse

Multi select Containers Ctrl+Left-click

Deselect Container or Containers SPACE, or

Left-click

Deselect one of multiple selected
Containers

Ctrl+Left-click

Delete container Ctrl+Delete, or

Backspace

Copy container(s) Ctrl+Left-click and drag

Move Container on the z axis Hold left and right button down

Toggle bounding box on/off B

Select next container in tree Cursor down

Select previous container in tree Cursor up

Select next container down in tree
hierarchy

Cursor right

Select parent container Cursor left

Switch additional performance
information on

Middle mouse click on “P”

Create Snapshot in RGBA Shift

Right mouse click on “Snap”

Add new Key frame in Stage of
selected container

Return

Enable expansive Z-Sort mode s

2.6.11 Scene Editor Camera Controls and Shortcuts

Function Key and/or Mouse

Switch Camera from 1 to 10 1 - 0

Switch to Front Camera Numeric Keypad Home

Switch to Back Camera Numeric Keypad Ins

Switch to Top Camera Numeric Keypad 8

Switch to Bottom Camera Numeric Keypad 2

Switch to Left Camera Numeric Keypad 4
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Function Key and/or Mouse

Switch to Right Camera Numeric Keypad 6

Change Position of Camera in X P+Left mouse button click and drag (left-right)

Change Position of Camera in y P+Middle mouse button click and drag (up-
down)

Change Position of Camera in z P+Right mouse button click and drag (up-down)

Zoom Camera U+Left mouse button click and drag (left-right)

Pan Camera I+Left mouse button click and drag (left-right)

Tilt Camera I+Middle mouse button click and drag (up-down)

Twist Camera I+Right mouse button click and drag (left-right)

Orbit in X (Rotate Camera around
Selected Object in X)

O+Middle mouse button click and drag (up-
down)

Orbit in y (Rotate Camera around
Selected Object in y)

O+Left mouse button click and drag (left-right)

Orbit in z (Rotate Camera around
Selected Object in z)

O+Middle mouse button click and drag (left-
right)

Orient Camera against Selected
Container

T

Reset Camera Transformation R

2.6.12 Scene Editor Orthogonal View Controls and Shortcuts

Function Key and/or Mouse

Pan Left mouse button click and drag on background

Rubberband Zoom In Z+Left mouse button click and drag

Rubberband Zoom Out X+Left mouse button click and drag

2.6.13 Scene Editor Animation Controls and Shortcuts

Function Key and/or Mouse

Reset handle of selected Key frame
in animation path

D

Manipulate single handle Ctrl+Left mouse button click handle and drag

Mirror Handles Shift+Left mouse button click handle and drag

Insert unlocked path point Ins+Left mouse click on path
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2.6.14 General Stage Tree Shortcuts

Function Key and/or Mouse

Show Obj. Editor Ctrl+1

Dopesheet View Ctrl+2

Spline View Ctrl+F

Dope/Spline View Ctrl+4

Jump to Top Container Home

Jump to Last Container End

Move a page down in the tree pgdown

Move a page up in the tree pgup

Scroll up the tree Cursor up

Scroll down the tree Cursor down

Jump to an item with a given letter Select the first letter of the name.

Open or close the selected tree Return, or the numeric keyboard Return

2.6.15 Stage Controls and Shortcuts

Function Key and/or Mouse

Start/Continue Animation Forward Enter

Start Animation Backwards Shift+Enter

Set Timeline Marker/Value to Start Ctrl+Home

Set Timeline Marker/Value to End Ctrl+End

Set View to Start Home

Set View to End End

Move Timeline Marker/Value in large
steps (5)

Left/Right Cursor

Move Timeline Marker/Value in small
steps (1)

Ctrl+Left/Right Cursor

Animation View (without Spline
View)

Ctrl+2, or

Shift+PageUp

Spline View (with Animation View) Ctrl+3, or

Shift+PageDown

Animation/Spline View Ctrl+4
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Function Key and/or Mouse

Delete Selected Key frame(s) Delete

Pan View Middle mouse click and drag

Zoom Time Axis In Z, Y+Mouse wheel

Zoom Time Axis Out X+Mouse wheel

Zoom Time Axis to Selected Channel Shift+Z, Shift+Y

Zoom Time Axis to whole Animation Shift+X

Zoom Spline View In A

Zoom Spline View Out S

Zoom Spline View to whole Spline Shift+A

Zoom Time Axis and Spline View
to view all key frames of selected
Channel

Shift+Q

Zoom Time and Value Axis to View
All Key frames

Shift+W

Zoom Time Axis In/Out Z+Middle mouse click and drag

Zoom Value Axis in Spline Editor In/
Out

A+Middle mouse click and drag

Copy Selected Key frame C+Left mouse click and drag

Bring View to Timeline M

Reverse the Order of Selected Key
frames

Ctrl+R

Snap to Grid on/off Ctrl+G

Set Time Axis to Seconds Ctrl+8

Set Time Axis to Frames Ctrl+9

Set Time Axis to Fields Ctrl+0

Move Timeline Marker to nearest Key
frame

J

Scale a Portion of Selected Director T+Left mouse click on Director Bar

This shows a region where key frames can be
scaled.

Rubberband Selection S+Left mouse click and drag

Zoom in onto specific region Z+Left mouse click and drag
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Function Key and/or Mouse

Insert a new Stop Point S+Left mouse click on Director Bar

View Spline 1 Ctrl+Z

View Spline 2 (if available) Ctrl+X

View Spline 3 (if available) Ctrl+C

Jump to next Key frame Tab

Jump to previous Key frame Shift+Tab

Escape from moving a Key frame Esc

2.6.16 Import File Shortcuts

Function Key and/or Mouse

Select Fonts for import Ctrl+1

Select Images for import Ctrl+2

Select Objects for import Ctrl+3

Select Scenes for import Ctrl+4

Select Audio for import Ctrl+5

Select Archives for import Ctrl+6

2.6.17 Import Archive Shortcuts

Function Key and/or Mouse

View Scenes for import Ctrl+1

View Objects for import Ctrl+2

View Materials for import Ctrl+3

View for Materials Advanced for
import

Ctrl+4

View Image for import Ctrl+5

View fonts for import Ctrl+6

View Video Clips for import Ctrl+7

View All files Ctrl+8

Entry Point View Ctril+7

Folder View Ctrl+8
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2.6.18 On Air Shortcuts

Function Key and/or Mouse

Return to Server View Esc

Hide Render View Hold Shift+Backspace

See Also

• On Air Mode

2.6.19 Polygon Plugin Editor Shortcuts

Function Key and/or Mouse

Reset Viewport Offset Home

Pan Middle mouse click and drag

Zoom In/Out Mouse wheel

Rubberband Zoom In Shift+Left mouse click and drag

Zoom In z

Zoom Out X

Set Zoom 1 Ctrl+Home, or

Ctrl+Z

Set Zoom 1 to 9 Shift+Ctrl+1 to 9

Sharpen Edge of Selected Point(s) Esc

Delete Selected Point(s) Delete

Show/Hide Bounding Box SPACE

Invert Screen Colors B

Insert New Point on Spline Insert+Left mouse click on Spline

Show Handles only on Selected
Point On/Off

a

Create New Spline Insert+Left mouse click

Close/Open Selected Spline C

Set/Hide Anchor at Cursor Position Ctrl+A, or

Double click middle mouse button

Enable/Disable Spline Info i

Switch between Curve and Straight
Lines

l
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Function Key and/or Mouse

Split Spline at Cursor S, Shift+Mouseover

Switch to Cutting Mode Shift+S

Merge Left Double click left mouse button

Move Active Spline Alt+Left mouse click and drag

Make Spline Active and Move Shift+Click and drag middle mouse button

Cursor must be inside Bounding Box

Copy Ctrl+C

Cut Ctrl+X

Paste Ctrl+V

Scale Spline Click and drag left mouse button on Bounding
Box handle

Rotate Spline Click and drag left mouse button next to vertex
of Bounding Box handle

2.6.20 Script Editor Shortcuts

Function Key and/or Mouse

Copy Ctrl-C

Cut Ctrl-X

Paste Ctrl-V, Shift-Insert

Search for Search String F3

Search for Selected Text F4

Comment F5

Uncomment F6

Increase Indent Tab

Decrease Indent Shift-Tab

Undo Ctrl-z
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3 Scene Tree Knowledge and Skills

Scenes are root Elements that hold other Elements. Created Scenes are stored in
the Graphic Hub database and are available through the Server area. For general
information about Scenes and procedures on how to create, import, rename, and delete
Scenes, see Working with Scene Elements.

This section contains information on the following topics:

• Opening a Scene

• Scene Tree

• Scene Tree Tabs

• Favorites Bar

• Containers

• Modifying Container Items

3.1 Opening a Scene

To open a Scene in the database

1. Select Server from the Main Menu Left.

2. In the Server Tree, select the folder or project where the Scene is.

3. Open the Scene:

• Double-click the Scene to open it, or

• Drag the Scene to the Scene Tree area, or

• Drag the Scene to the renderer window.

The content of the Scene will be shown as Containers in the Scene Tree, and visualized
in the renderer window.

Note: Image Editor or Scenes are marked with a Keyhole icon  .

Tip: If the folder or project’s path is unknown, search for the Scene in the
SmartView Search function under the <Username>s View tab in the Server area
(see Content Switcher).

Tip: The Status bar in the lower left part of the Main Window (between the Close
and Undo buttons) shows the name and path of the current Scene. Click on the
path to select the Scene in the Server area.
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3.2 Scene Tree

The Scene Tree is the logical visualization of all the Elements in a Scene. The tree
consists of Containers that hold properties. The Elements can be Geometries, Images,
Materials, Texts, Transparency functions, Key functions, and many more.

To build a Scene drag Elements, like Images or Geometries (Built-In plugins), to the
Scene Tree (it is also possible to drag them directly to the Scene Editor).

The Containers in the Scene Tree are organized in a hierarchy and grouped in logical
divisions. Containers and Groups are explained in more detail in the following
paragraphs.

This section contains information on the following topics and procedures:

• To view the Scene Tree

To view the Scene Tree

The Scene Tree is available when these buttons in the Main Menu are clicked on:

• Server

• Built Ins

• Control

• Tree

• Stage

• +Tree/Stage

See Also

• Scene Tree Tabs

• Favorites Bar

• Containers

• Grouping Containers

• General Scene Tree Shortcuts

• Scene Tree Basic View Controls and Shortcuts

• Scene Tree Sort View Shortcuts
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3.3 Scene Tree Tabs

At the top of the Scene Tree area are the Scene Tree tabs. These tabs change the way
the Scene Tree is shown.

• Basic: Shows an overview of all the Containers in the Scene (see Basic Tab ).

• Sort: Sorts the Elements in the Scene Tree based upon criteria that are set in the
Display area (see Sort Tab ).

• Search: Search Elements in the Scene Tree (see   Search TabVizCursiv  ).

•  Scene Log: Shows if an error occurs. Opens the Log window, which gives
information about the loading process of the Scene, such as errors, for example if a
plugin is not found. Click on it to open the Scene Log.

• If the log window is closed, but not cleared, the exclamation mark icon will show in
gray. It will show red again if another fault occurs.

•  Scene Info: Opens the Scene Information window, which gives information about
the Scene entered by the designer. Shows orange if information is available.

This section contains information on the following topics:

• Basic Tab

• Sort Tab

• Search Tab

3.3.1 Basic Tab

If the Basic tab is clicked, all Containers are shown in the tree hierarchy (see Basic Tab
Display).

•  Show/Hide Favorites: Show or hide the Favorites Bar .

•  Lock/Unlock: Enable or disable the ability to modify the transformation of a
Container in the Scene Editor. Double click to lock or unlock all Containers.

•  Show/Hide: Show or hide a Container in the Scene Editor, and eventually in the
final rendered output. Double click to show or hide all Containers.

•  Expand/Collapse: Expand or collapse the Scene Tree.

•   Start/Stop: Start (compiles) or stop all Container scripts.

•  Zoom In/Zoom Out: Zoom in (larger Containers) or Zoom out (smaller
Containers) on the Container tree. Zoom out applies smaller icons to the Containers.
This gives a better overview, especially in complex Scenes.
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•  Group/Ungroup: Create a new group (see Grouping Containers), and places
the selected Containers as Sub-Containers. The Ungroup button moves the Sub-
Containers up one level.

•  Merge/Split: Merge the selected Containers to one compound object, or split
an existing compound object. For more information, see Merging Containers .

•  Create Group: Create a new empty group at the top of the Scene Tree. Drag
the icon to place a new group at a specific place in the Scene Tree. For more
information, see Adding Root or Sub-Containers .

•  Colorize: Apply a color to the selected Container or Containers. Text can be
added to the colors to make them more descriptive. Text for scene specific colors
can be modified in the Scene Settings editor (see Global Settings). Text for global
colors can be modified in the Configuration’s User Interface section.

•  Refresh: Refresh the Scene Tree. Use this button if scripts have been deployed
to change the Scene Tree.

Basic Tab Display

3.3.2 Sort Tab

If the Sort tab is clicked, the Elements in the Scene Tree can be sorted based on various
criteria (see Sort Tab Display). A sorted Scene Tree makes it possible to analyze the
Scene and optimize the performance.

•  Show/Hide Favorites: Show or hide the Favorites Bar .

•  Vector: Sort the Scene Tree by the number of vectors the Containers (which
have Geometries) have. The Container with most vectors is shown on top.

•  Render Time: Sort the Scene Tree by the time it takes to render the Containers.
Each Container is shown with the percentage of total time the Scene takes to be
rendered. The Container with the highest percentage is shown on top.
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•  Sort by Colors: Facilitate filtering only a few colorized Containers that should be
subject to change.

•  Texture Size: Sort the Scene Tree by the size of the Container texture. The
Container with the largest texture size is shown on top.

•  Unique: Show unique group objects with the same Texture only once. This option
is only available if the Containers are sorted by Texture size (click the Texture Size
button).

•  Refresh: Refresh the Scene Tree.

•  The input box, on the right, defines the number of search results shown. Click
R to set to default number of search results (20).

Sort Tab Display

3.3.3 Search Tab

If the Search tab is clicked, the Elements in the Scene Tree can be searched, based on
various search criteria.

The different buttons are used to search for specific properties of the Scene (see
Search Options) or highlight the search results (see Show Search Results). Search
results are highlighted in the Scene Tree, and the number of search results are shown
(see Show Search Results).

Example: If a plugin (for example Extrude) is dragged to the Dragsite for
Properties, a click on the Show all button will highlight all occurrences of that
plugin in the Scene Tree.
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Search Options

• Name: Search for Containers with a specified name. Type the search string in the
Name field (1).

Click on the drop arrow (2) to show extended search parameters. Options are to search
for Parameter, Values and Plugin names within the Scene (see To do an extended
search).

Tip: Wildcards (for example *, ? and [ ]) may be used (see Wildcard Text
Description).

Note: When the extended parameters option is active, all other search options,
apart from Name, are inactive.

•  Dragsite for Properties: Drag an Element from the Server area, from a
Container in the Scene Tree or from the Favorites Bar to search for its occurrence
within the Scene.

•  Hidden: Search for all hidden Containers.

•  Locked: Search for all locked Containers.

•  Inactive Properties: Search for Containers that contain properties that are set to
inactive.

•  Color: Searches for all Containers with the assigned color tile (see Container
Context Menu ).

Show Search Results

•  Show Next: Show the next result.

•  Show Previous: Show the previous result.

•  Show First: Show the first result.

•  Show Last: Show the last result.

•  Show All: Show all results.

•  Search Results: Shows how many results were found

Tip: To show all results is especially practical to do a scene cleanup.

Tip: If a specific plugin is no longer to be used in a Scene, make a search for the
plugin and select Show All to highlight all the results. Drag one of the highlighted
plugins to the trash can (all the highlighted plugins will be deleted from the
Scene).
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Tip: If Show all search results is selected, the transformation properties can be
changed for all highlighted Containers.

Tip: If Show all search results is selected, a plugin or an element (except a
Scene) can be added to all the highlighted Containers (drag a plugin or an
element to one of the highlighted Containers).

Tip: Click the show next or previous buttons to change individual Container
properties (see Container Editor).

To do an extended search

1. Go to the Scene Tree and click Search.

2. Click drop arrow to show the extended search options (1).

3. Enter a search criteria. The search criteria can be a combination of Parameter,
Value and Plugin name. Below are some examples:

• Parameter: tesselation, width, *show*

• Value: 20, *10.0*

• Plugin: *rect*

4. Press <Enter>.

5. Use the Show Search ResultsVizBold buttons to navigate the Scene Tree.

Tip: Use the label names in the plugin editors as a search criteria. If there is no
hit, use the asterisk (*) symbol.

Search Tab Display

3.4 Favorites Bar

For quicker access to Elements that are used often, add Elements to the Favorites bar
(see To add an Element as a favorite). To open the Favorites bar click on the Star icon
(1) at the top of the Scene Tree area.
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All Elements, except Scenes and Audio files, can be added as favorites. Geometry,
Container and Shader plugins can also be added to the favorites. Favorites are saved
as part of the user settings to the database.

Tip: To view more favorites, use the scroll bar or resize the favorites display, as
required.

Click on the buttons below the Favorites bar (2) to show or not show favorite Elements
from the categories detailed here:

• O: Geometry Objects

• M: Materials

• MA: Materials Advanced

• I: Images

• F: Fonts

• GP: Geometry plugins

• CP: Container plugins

• SH: Shader plugins

Elements can also be fast selected. Click on an Element button with:

• Ctrl+Click: Selects all

• Shift+Click: Deselects all

• Alt+Click: Only show the clicked type

This section also contains information on the following procedures:

• To add an Element as a favorite

• To remove an Element as a favorite

• To remove an Element as a favorite

To add an Element as a favorite

1. Right-click the Element in the Server or Built Ins area.

2. Select Add as Favorite...,

or

1. Click on the Star icon to open the Favorites bar (see Favorites Bar).

2. Drag an Element from the Server or Built Ins area to the Favorites bar.

Note: Elements can also be added as favorites from the search results window,
after a Graphic Hub database search (see Importing).

To remove an Element as a favorite

1. Right-click the Element in the Server or Built Ins area.

2. Select Delete from Favorites...,

or
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1. Click on the Star icon to open the Favorites bar (see Favorites Bar).

2. Drag an Element from the Favorites bar to the trash can.

To add a favorite Element to a Container

1. Select the target Container(s).

2. Drag the required Element from the Favorites bar to the target Container

Note: If more than one Container is selected the Element will populate all
selected Containers.

3.5 Containers
A Container combines a set of Elements and properties to one block used in the Scene.

This section contains information on these topics:

• Container Icons

• Container Context Menu

• Container Editor

• Adding Containers

• Copy Containers

• Move Containers

• Renaming Containers

• Editing Container Properties

• Deleting Containers

• Merging Containers

• Grouping Containers

See Also

• Modifying Container Items

3.5.1 Container Icons

 Every Container is shown with a name and three basic icons:

•  Show/Hide: Shows if the Container and all its Sub-Containers are visible/
invisible in the Scene Editor. Click the icon to change the state.

•  Locked/Unlocked: Shows if the Container is locked so that properties
cannot be manipulated in the Scene Editor, or unlocked so that properties can be
manipulated. Click the icon to change the state.

Example: An unlocked element can be resized and repositioned in the Scene
Editor.

•  Transformation Editor: Opens the Transformation Editor in the Container view.
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A Container that has Sub-Containers is marked with a black arrow to the left of the
Container.

•  Collapse/Expand: If the arrow points to the right, the Container is collapsed
and the Sub-Containers are not displayed in the Scene Tree. If the arrow points
downwards, the Container is expanded and the Sub-Containers are displayed in the
Scene Tree. Click the icon to change the state.

The following icons are only available if the respective elements are applied to the
Container.

Note: Materials and geometries can be dragged from a Container to the Database
area. This will create new independent instances of these elements in the
database. Dragging an image from a Container to the Database area will only
create a linked element.

•  Object: Shows the geometry held by the Container (e.g. a merged or imported
object). The thumbnail icon reflects the object.

•  Material: Shows that a material has been applied to the Container. The color of
the icon reflects the color of the material and its properties. If there is no material
icon, a standard white base color is used for the Container. Click the icon to open
the material editor (see Working with Material Elements and Material Editor).

Note: A Sub-Container can inherit color from a parent Container.

•  Image: Shows that an image has been applied to the Container. The thumbnail
on the icon reflects the image. There are two ways to apply an image to a Container.
If the Container holds geometry, the image is used for texturing the geometry. Click
the icon to open the Image Editor.

•  Font: Shows that a font has been applied to the Container. Click the icon to open
the Text Editor.

The following icons are only available if the respective plugins are applied to the
Container:

•  Geometry: Shows the geometry held by the Container. The icon reflects the
built-in Geometry Plugins, in this example a cone object.

•  Containers: Shows that the Container holds a Container function. The icon
reflects the Container Plugins, in this example an alpha object.

•  Animation: Shows that the Container contains animated elements. For more
information, see Creating Animations .

3.5.2 Container Context Menu

A right-click on a Container in the Scene Tree opens a Container context menu.

This section contains information on these topics:

• Right-click on a Container name

• Right-click on a Container Property

• Right-click on a Container Texture Property
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Right-click on a Container name

Do a right-click on the Container name, to show these context menu options
(dependant on the Container contents):

• Add Info Text: Makes it possible to add text-based information on a Container. Also
available as a plugin by clicking Built-ins and then double-clicking the Container
Plugins tab.

• Add Material: Adds a Material to the selected Container. See also Working with
Material Elements.

• Rename: Makes it possible to change the name of the selected Container.

• Delete Container [name]: Deletes the selected Container.

• Show/Hide Container [name]: Indicates if the selected Container and all its Sub-
Containers are visible/invisible in the Scene Editor.

• Lock/Unlock Container [name]: Disables or enables the ability to modify the
transformation of the selected Container in the Scene Editor.

• Create Sub Container: Creates a new empty Sub-Container for the selected
Container.

• Merge Container [name]: Merges the selected Container and all its Sub-
Containers into one compound object, or extracts an already merged object. For
more information, see Merging Containers .

• Merge Container [name] to Sub Container: Merges the selected Container(s)
and all the respective Sub-Containers into one compound object and creates a new
sub director for the merged animation.

• Merge Container [name] w/ Actions & Events to Sub Director: Merges the
selected Container(s) and all the respective Sub-Containers into one compound
object, including actions and events and creates a new sub director for the merged
animation.

• Merge Container [name] w/ Actions & Events to Sub Container: Merges the
selected Container(s) and all the respective Sub-Containers into one compound
object, including actions and events.

• Merge to Material Advanced: Merges multiple objects to one, creating advanced
material(s) (see Working with Material Advanced Elements).
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• Change Color: Makes it possible to apply a color to the selected Container.
Colorized Containers make the Scene Tree more organized. For example, all font
Containers can be colored red, while all Containers that hold images can be colored
blue. Four active colors are configured by default. Color can also be applied from
the Favorites Bar. See also how to configure the Colors in the User Interface
configuration section.

Right-click on a Container Property

Do a right-click on a Container property to show these additional menu options:

• Delete [property]: Deletes the property from the Container.

• Tree Search for [property]: Selects the Search Tab, and searches the Scene Tree
for instances of this property.

• Database Search for [property]: Searches for the property in the database, and
shows the result in the Server area.

Note: This menu option is only available for images.

• Reference Search for [property]: Searches for the property in the Viz Graphic
Hub database, and shows the result in the Search window (see Reference Search).

Note: This menu option is only available for images.

Right-click on a Container Texture Property

Do a right-click on a Container Texture property (containing video), to show these
additional menu options:

• Delete [property]: Deletes the property from the Container.

• Tree Search for [property]: Selects the Search Tab, and searches the Scene Tree
for instances of this property.

• Show settings of [property]: Opens the Video tab of the Scene Settings in the
Property panel.
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3.5.3 Container Editor

When a Container is highlighted in the Scene Tree a list of all properties and plugins
added to that Container shows alongside the editor area. This list then creates an
editor menu for a Scene’s Container. All properties and plugins are shown as buttons
that open their editors when pressed:

• Transformation Editor

• Geometry Editor

• Text Editor

• Texture Editor

• Plugin Editor

• Material Editor

Some editors like the Transformation Editor enable properties for one or multiple
selected Containers to be set. Other editors have the option to enable or disable
certain properties (see Manipulating Properties).

3.5.4 Adding Containers

Containers can be added to the Scene by dragging an element onto the Scene Tree,
Scene Editor or Property Editor.

By dragging an element to the Scene Editor, the Container will be added at the top of
the Scene Tree. Also note that elements can be added to a Scene by dragging them
from the result window after a database search.

By selecting multiple elements from the Server area and dragging them onto the Scene
Tree, all of them will be added.

Adding Root or Sub-Containers

Elements that are dragged onto the Scene Tree can be positioned in various ways, and
create either root or Sub-Containers.

•  Sub-Container: Dropping an element at the right side of a Container in the
Scene Tree will create a Sub-Container.
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•  Root Container Below/Above Dropping the element at the left side of a
Container in the Scene Tree will create a root Container at the same hierarchy level,
either below or above the selected Container.

Adding Empty Containers

 Clicking the Create Group button (Ctrl+Insert) will add an empty Container above
the selected Container. If a Container is not selected it will add the new Container to
the root level. The Create Group button is only available if Basic is selected from the
Scene Tree menu.

To add an empty Container

• Click the Create Group button from the Display area.

To add a Container at a specific location in the Scene Tree

• Drag the Create Group icon and place it as a above or below of an existing
Container, or as a Sub-Container.

3.5.5 Copy Containers

To copy a Container within a Scene

• Hold <Ctrl> and drag the Container to its new position, or

• Use <Ctrl+C> and <Ctrl+V> to copy and paste the Container.

• Copied Containers will be placed as Sub-Container of the selected Container.

Note: When copying a Container with Sub-Containers, all Sub-Containers are
copied as part of the same operation.

To copy multiple Containers at once

• Hold Ctrl and the left mouse button and drag the Containers to their new position,
and then click the right mouse button to release.

3.5.6 Move Containers

To move a Container within a Scene

• Drag it to the new position, or

• Use <Ctrl+X> and <Ctrl+V> to cut and paste the Container(s) to the new position.

To retain transformation properties while moving a Container within a Scene

Pressing the <Alt> button while moving a Container (or group of Containers) within
the Scene will retain the transformation properties. This lets a Container, which is part
of a Group, to be moved to another group while the absolute transformation of the
Container will not change, although the parent Containers (Groups) have different
transformations.
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For example:

1. Group 1: The Group position is X 100.0 and Y 100.0. The Container position is X
0.0 and Y 0.0.

2. Group 2: The Group position is X 0.0 and Y 0.0.

When a Container is moved from Group 1 to Group 2, while pressing the <Alt> button,
the moved Container will inherit its former Group’s position values (i.e. X 100.0 and Y
100.0), so its absolute transformation stays the same.

Moving it back, while holding the <Alt> button, its transformation properties will be
readjusted. Meaning, if you adjust the moved Container’s position X to 200.0, before
moving it back to its original Group, its position X will be 100.0 and position Y 0.0 after
the move.

1. Add two group Containers to the Scene Tree

2. Rename the groups to Group 1 and Group 2

3. Open Group 1’s transformation editor and set Position X and Y to 100.0

4. Add a geometry (e.g. Cylinder) as a Sub-Container of Group 1

5. Add material to the Cylinder

6. Press and hold the <Alt> button and place the Cylinder as a Sub-Container of
Group 2

• When the Container is moved a letter R will show in the drag and drop window.

7. Release the <Alt> button

8. Open the Cylinder Container’s transformation editor and set Position X to 200.0

9. Press and hold the <Alt> button and place the Cylinder as a Sub-Container of
Group 1 and check that the transformation properties are:

• Group 1: Position X 100.0 and Y 100.0

• Cylinder: Position X 100.0 and Y 0.0

3.5.7 Renaming Containers

To rename a Container

• Double-click the Container name, or

• Right-click a Container. Click on Rename in the Container context menu.

To rename multiple Containers

• Use the Corena plugin.
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3.5.8 Editing Container Properties

To edit the properties of a Container

• Select the Container in the Scene Tree, or in the Scene Editor. Its editor will then
show in the Properties area (see Modifying Container Items).

To copy a property from one Container to another

• Drag the property from the source Container to the target Container, or use the
context menu.

3.5.9 Deleting Containers

To delete a Container from a Scene

1. Drag it onto the trash can, or

2. Right-click the Container, and in the context menu select Delete Container
[Name], or

3. Use the shortcut keys Ctrl+Delete.

Note: If deleting a parent Container, all Sub-Containers will be deleted too.

3.5.10 Merging Containers

Containers can be merged into compound objects and saved as reusable components
to the Viz Graphic Hub database. Any animations will also be merged and added to the
new compound object’s Container.

A saved compound object can be used in other Scenes and will per default have an
active reference between the stored object and all Scenes where it has been used.
Through use of stored objects with active references, changes can be applied to many
Scenes at once, which will typically be a meaningful way to work when designing a set
of Scenes that share many design elements.

Note: The geometry of a compound object cannot be edited. A compound object
must be split for the geometry to be edited again.
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Note: Splitting a referenced compound object disables the reference.

Sometimes, when opening a Scene with merged objects, a message displaying “Old
merge style, convert to new merge style” appears. This is a well-known Autofollow
plugin in combination with merged objects issue.

In merged objects the ordering of Containers is reversed which leads to broken
autofollow functionality (for first and next reference modes); hence, this merge-style
conversion corrects the ordering. Designers that worked around this problem in their
Scenes do not need to convert; hence, the conversion is not automated.

This behavior is not backward compatible because older versions assume reversed sort
order. Ungrouping and grouping with older Viz versions on new Scenes will not solve
this issue.

To overcome this issue it is recommended to update all Viz Artist and Viz Engine
versions to the official 3.2.2 release and later by opening the Scene and converting it
to the new merge style.

To merge Containers into a Compound Object

1. Select a Container which contains Sub-Containers.

2. Merge the Container with all its Sub-Containers:

• Click the Merge button, or

• Press <Ctrl+M>,

• or right-click the Container and select Merge Container [Name] from the context
menu.

Note: The Merge button is only available if Basic is selected from the Scene Tree
menu.

To split a merged Compound Object

1. Select a merged Container.

2. Split the Container:
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• Click the Split button, or

• Press <Ctrl+Shift+M>, or

• Right-click the merged Container and select Split Container [Name] from the
context menu,

Note: The Split button is only available if Basic is selected from the Scene Tree
menu.

To save a compound object to Viz Graphic Hub

1. Select and right-click a Container (with or without Sub-Containers), and from the
appearing context menu select Merge Container [name].

2. Drag the compound object’s icon from the property editor or Scene Tree and drop
it onto a folder/project in the Server Area.

3. Type a descriptive name for the object in the appearing dialog box, and click Ok.
The object will now be visible in under the Server Objects tab.

Tip: Any animations or scripts used within the object will be kept when saving.

Note: Make sure to drag only the object icon, not the whole Container.

See Also

• Grouping Containers

• User Interface section for setting default merge and split behaviors

3.5.11 Grouping Containers

The Containers in the Scene Tree can be organized in a hierarchy and grouped in
logical divisions. The hierarchy depth is practically unlimited. Grouping Containers
can be compared to creating a parent/child hierarchy. Such a hierarchy provides a
better overview, especially in complex Scenes, and is very practical since changing the
properties of the group (for example adding a new material) also applies the changes
to all the Sub-Containers.

Note: Changing the properties of one of the Sub-Containers (for example adding a
material) will override the settings for this particular Sub-Container.

Moving one group is also much easier than moving a lot of single Containers.

A parent Container, that has Sub-Containers, is marked with a black arrow to the left

of the Container. If the arrow points to the right  , the Container is collapsed and the

Sub-Containers are not displayed in the Scene Tree. If the arrow points downwards  ,
the Container is expanded and the next level of Sub-Containers are displayed.

Any Container can basically be used as parent, although group Containers (that hold
transformation only) are best suited.

This section also contains information on the following procedures:

• To group existing Containers
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• To ungroup Containers

• To detach a single Container from a group

To group existing Containers

•  Select the Containers that should be grouped, and click the Group (<Ctrl+G>)
button from the Display area. This will add an empty group Container one level
higher than the original Containers.

Note: The Group button is only available if Basic is selected from the Scene Tree
menu.

To ungroup Containers

•  Select the parent Container, and click the Ungroup (<Ctrl+Shift+G>) button
from the Display area.

Note: The Ungroup button is only available if Basic is selected from the Scene
Tree menu. Also, tree structure further down in the hierarchy will remain.

To detach a single Container from a group

• Drag it from the group and place it somewhere in the Scene Tree.

See Also

• Adding Empty Containers

3.6 Modifying Container Items
When a Container is selected in the Scene Tree, the selected Container property, for
example the transformation properties, can be modified in the Properties panel.

Elements that are stored in the Viz Graphic Hub database can be added to Scenes:

• Object or Fontstyle Elements will create a new Container using the element as
geometry.

• Materials and Audio clips can only be applied to existing Containers.

• Images can be added as geometry of a Container, or applied on an existing
Container as a texture.

• Geometry plugins can also be added to the Scene.

This section contains information on the following topics:

• Manipulating Properties

• Transformation Editor

• Copying Properties

• Geometry Editor

• Text Editor

• Texture Editor
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• Plugin Editor

• Material Editor

3.6.1 Manipulating Properties

There are a few operations that apply to all Container properties.

Note: Container properties are Elements and Plugins which have been applied to
a Container.

This section contains information on the following procedures:

• VizBoldTo Replace a Property applied to a Container

• VizBoldTo Remove a Property from a Container

• VizBoldTo Save Properties in the Database

• VizBoldTo Enable/Disable Properties in a Container

To Replace a Property applied to a Container

• Drag the new Element or Plugin to the Container.

To Remove a Property from a Container

• Drag the property from the Container to the trash can, or

• Drag the property from the Property editor to the trash can, or

• Right-click the Container property in the Scene Tree, and select Delete <Name of
the Property>.

Note: Every Container must contain transformation properties, so the
transformation property can not be removed.

To Save Properties in the Database

If a scene specific property has been created, and it is likely that the property should
be reused in another scene, it is possible to save the property in the database.

• Drag the property from the Container to the desired folder/project in the Server
area.

To Enable/Disable Properties in a Container

Note: Element properties are automatically enabled when added to a Container.

This is a practical tool when multiple items are applied to a Container.

• Click the switch next to the icon representing the item in the Property editor.

See Also

• Containers
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3.6.2 Editing Properties in the Scene Editor

Some transformation parameters can be changed directly in the Scene Editor through
the manipulation of handles (see Scene Editor Context Menu).

3.6.3 Transformation Editor

Every Container in a Scene contains transformation properties. The transformation
editor holds information about the most basic properties of a Container, such as
position and rotation.

 The transformation editor is also able To stick transformation properties to the
Container view. This feature allows Position, Rotation, Scaling and Axis Center
parameters to stick to the Container view while opening other editors. This enables
designers to adjust transformation properties while working on other objects (e.g. text,
geometry).

This section contains information on the following topic and procedures:

• Transformation Principles

• Transformation Editor Properties

• To open the transformation editor

• To stick transformation properties to the Container view

Transformation Principles

Containers can be manipulated in several contexts:

• Parent/Group: Refers to changes that can be made to the Container or Containers
in its Parent or Group coordinate system.

Note: Multi selected objects: When more than one object is selected Group will
show and a bounding box will cover all selected objects.

• Local: Refers to changes that can be made to the Container in its local coordinate
system.

• World: Refers to changes that can be made to Containers in their world coordinate
system.

• Absolute: Refers to changes that can be made to Containers in absolute values.

• Relative: Refers to changes that can be made to Containers relative to current
values.
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Transformation Editor Properties

• Position: Sets the position of the object along the X, Y, and Z axis.

• CC (Center Camera): Centers the Container to the camera.

• Rotation: Rotates the object according to the X, Y, and Z axes. With the bounding
box option enabled, the rotation axes will be visible as three lines; X is red, Y is
green, and Z is blue. To rotate in steps of 45 degrees, use the buttons labeled 45
and +45.

• FC (Face Camera): Changes the rotation in such a way that the object faces the
camera.

• Scaling: Before changing the scale values of the Container, make sure to set the
preferred kind of scaling:

• S (Single): Scales each axis by itself.

• L (Locked): Scales all axes at once, so that X, Y, and Z have the same value.

• P (Proportional): Scales all axes at once, so that the values remain proportional.

• Screen Position: Sets the screen position along the X and Y axis for images and
some objects by specifying pixels instead of the regular positioning that does not
use pixels as input values. The Screen Position option is only available if the image/
object faces the camera. To achieve this, click the Face Camera button. When
changing the Screen Position values, the values for the regular positioning will be
changed too. The screen position can be set to left, center, or right by clicking L,
C, or R, or bottom, center, or top by clicking B, C, or T. The screen positioning is
performed based on the current Z value for the Container and camera view. If you
for instance enter the screen position values X=0 and Y=0, that will place the object
in the upper left corner. Thereafter the Z position will be changed, and the object
will not align the viewport corner anymore. Then the pixel values must be set to
zero again to reposition the image/object.

• Align to Px (Pixel): When using the normal positioning editor to position an image/
object that is facing the camera head on, it can occur that the image/object is off by
fractions of a pixel. This can happen because of rounding errors in the screen size
and face camera functions. This can produce visual artifacts in some cases on some
graphics cards. When the image/object is not aligned to the screen pixels, Align to
Px button turns red. Clicking the button adjusts the image/object to be moved to the
nearest matching whole pixel.

• Axis  Center: Sets the axis origin of the object. The rotation axis of the object will
be visible in the Scene Editor if the Bounding Box option is enabled.
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• The origin can be set to left, center, or right on the object’s X axis by clicking L,
C, or R.

• The origin can be set to bottom, center, or top on the object’s Y axis by clicking
B, C, or T.

• The origin can be set to back, center, or front on the object’s Z axis by clicking B,
C, or F.

• When a group is selected but certain Containers in it are not visible, clicking
C with the mouse’s middle button will define the axis center only for those
Containers in the group which are visible.

• Screen Size: Makes it possible to scale an object/image based on pixels. The
Screen Size option is only available if the object/image faces the camera. To achieve
this, click the Face Camera button.

• Screen: Scales the object/image to the size of the output format.

• Image: Scales the image to the original pixel value.

• Additional information on the selected Container

• Clicking the Expand button displays this information to the right of the
transformation editor. This information includes parent Containers plus all visible
child Containers.

• Width, Height, and Depth: Shows the real size of the object in units (not pixels).

• Containers: Shows the number of Containers that are selected. If the selected
Container holds Sub-Containers, all Sub-Containers are counted in addition to the
main Container. A Container that holds geometry is counted as two.

• Vertices: Shows the number of vertices that are rendered within the selected
Container, including the vertices in all Sub-Containers.

• Primitives: Shows the number of primitives in the Container including the
primitives in all Sub-Containers.

• Docking: Clicking the docking button keeps a compact version of the
transformation editor always open while you work with additional editors.

To open the transformation editor

1. Click the Transformation icon on the Container, or

2. Select the Container from the Scene Tree, and then click the icon located on the
left side of the Property panel.

To stick transformation properties to the Container view

•  Click the button next to the transformation editor button in the Container view.

Multiple Select
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This feature lets you move a group of Containers to a new position, which is
determined by parameters of one selected Container in the group. All Containers keep
their relative position to the selected Container.

All changes made in the Transformation editor will be on each Container selected:

• An ‘M’ (multi) will show with the mouse pointer when inside the Transformation
editor.

• The selected Container and its position in the group is shown (1/3, 2/3).

In the Container Editor use the Up / Down arrows to scroll through the selected
Containers, or click on the Container name to show a context menu. Change the
parameters, as required, for the selected Container.

3.6.4 Copying Properties

If a Container has certain settings, for example position or rotation, and another
Container in the Scene should have identical settings, it is possible to drag
transformation properties from one Container to the other.

The distribution of transformation properties can be done with position, rotation,
scaling, and axis center.

To copy properties from one Container to another

1. Open the Transformation Editor of the source Container.

2. Select the Container in the Scene Tree that should be given new properties.

3. Drag the property that should be distributed onto the target Container, by
either transferring the whole property (drag the property name label) or just a sub
property (drag the X, Y, or Z label).

Note: If copying properties are done correctly, an icon with the property name will
be displayed while dragging it.

3.6.5 Geometry Editor

An object holds information about its geometry. When adding an object to a Scene, a
new Container will be created using the object as geometry. Objects that have been
created with external 3D programs and imported into Viz Artist can be modified in the
Geometry editor.

Note: Face Orientation and Shading are only applicable if the reference is
deactivated.

This section contains information on the following topic and procedure:

• Object Properties

• To open the Geometry editor
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Object Properties

• Object: Shows a thumbnail of the object, and also the object name. By clicking the
thumbnail, the object will be selected in the database. Be aware that this can only
be done when the reference to the database is active.

• Face Orientation: After importing objects that have been created by external 3D
programs, it might happen that the polygons face orientation is wrong. By clicking
the Flip button, the polygons are set correctly.

• Shading: Imported polygon objects normally use shading for creating a smooth
surface on the object, which is set together by a planar polygon mesh. The shading
value in the Geometry editor sets a threshold between which edges are to be
smoothed by shading and which are to be kept as sharp edges. All edges with
an angle smaller than the defined value are smoothed by shading. Shading in
Viz Artist is performed in the following way: A shade value is produced at each
vertex of the polygonal mesh representing the surface of the object. This is done
by creating a surface normal on each polygonal facet. The surface normal at each
vertex is created by averaging the surface normals for the surrounding facets. The
shade at each vertex can then be calculated. Once the shade at the vertices of the
polygonal mesh are known, the shade at points interior to the polygonal facets are
interpolated from the values at the vertices. This technique makes curved surfaces
look “smooth shaded” even though based on a representation of planar facets.
The interpolation of shade values is incorporated into the polygon scan conversion
routine. Hence an increase in realism is obtained at far less performance cost than
carrying out a pixel-by-pixel shading calculation over the whole original surface.
Shading may be set to Flat, which means that all shading is disabled, or Smooth,
which enables the Edge Angle option. After adjusting the Edge Angle, make sure to
click the Rebuild button for the changes to take effect.

• Reference: If using an imported or compound object in a Scene, there is a
reference between the object in the Scene and the object in the database. If
changes are applied to the object in the Scene, the object in the database including
any Scenes where this object is used with an established reference, will reflect those
changes, as it is the same object.

• Deactivate: To create a unique copy of the object for the Scene, the reference link
must be deactivated. Changes that are applied to a deactivated object do not lead
to changes in the original object in the database.

• Re-establish: Reactivates the reference and overwrites the object in the Scene
with the object in the database. An active reference is practical when creating a
set of Scenes with the same object. If for instance all the Scenes should have the
same background and the background element is created as an object with active
references, changes can easily be applied to all the Scenes that use that object.

• Update: Reactivates the reference and overwrites the object in the database with
the object in the Scene.

• Status: Shows the current status of the reference.
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Note: The reference is automatically deactivated if splitting the object. If the
object is split, it must first be merged before the Re-establish and Update
operations can be performed.

To open the Geometry editor

• Click the icon representing the object either on the Container or in the Properties
editor.

See Also

• Adding Containers

• Working with Object Elements

3.6.6 Text Editor

 In the Text editor, text can be added to the Scene and the visualization of the Scene
specific text can be modified by altering properties and adding special effects.

At the top of the Text editor is an input box. The characters in this input box are shown
in the Scene Editor. By default, the text equals the font name.

The Text editor contains five panels. Click the tabs at the top of the Text editor to open
the respective panels.

More advanced modifications can be done in the Fontstyle Editor . The modifications
in the Fontstyle editor applies to all instances of the font, not just the one used in this
scene.

This section contains information on the following procedures and topics:

• To open the Text editor

• Basic Tab

• Shadow Tab

• Clock Tab

• Characters Tab

• Special Tab
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• Special Fonts

To open the Text editor

• Click the icon representing the text either on the Container or in the Properties
editor.

Note: After dragging a font onto the scene, the Text editor will automatically
open, and a new Container will be created using the font as geometry.

Basic Tab

Click the Basic tab in the Text editor to open the Basic panel.

At the top of the Basic panel is the default preview of the text that is being visualized in
the scene. It also shows the name of the font.

•  Click the arrow to open a list of all available fonts created from the same base
font. To use another font, select it from the list. To use a totally different font in the
scene, drag the new font from the Server area onto the visualization of the text.

•  Horizontal Justification: Sets the text justification to left, center, or right.

•  Character Orientation: Makes it possible to define a character, typically a
decimal separator like comma, and justify the text aligned after this character. Enter
the justification character in the small input box to the right of the button.

•  Vertical Justification: Sets the vertical justification on the top of the
whole text block, below the first line, center of the middle line in the text block and
at the bottom of the text block.

• Type

• Geometry: Geometry type fonts are rendered as polygons.

• Texture: Texture creates the font as a texture instead of a polygon. This can to
some degree create a poorer look, but it reduces the number of polygons in the
scene. The texture resources will of course get an increased demand, so to render
the fonts as texture is a trade off between polygon and texture performance. For
half height mode rendering, texture fonts are normally the better choice.

• Quality: Sets the quality of the font to either Normal or High. The quality of a
texture font can be changed in the Fontstyle Editor .
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Note: The Quality option is only applicable if the font type is set to Geometry.

• Sharpen: Makes it possible to sharpen the text.

Note: The Sharpen option is only applicable if the font type is set to Texture.

• Detail Sets the level of detail, or tessellation of the font, to either automatic level
or one out of six fixed settings. The fonts are rendered as polygons, so by switching
to wireframe mode, the difference becomes obvious as the detail level changes.
One is the highest level of detail, six is the lowest. If setting a fixed level of detail,
the automatic level will be overwritten and rendered with the same level of detail
independent of the font size.

Note: The Detail option is only applicable if the font type is set to Geometry.

• Pos. Spacing: Local kerning of the font style. Clicking the left button will decrease
the position spacing between characters. Clicking the right button will increase the
position spacing between characters. Fonts can be permanently modified using the
Fontstyle Editor.

• Tracking: Changes the tracking between all characters by the same amount.
Clicking the Fixed button changes the text from true type to one where each
character uses the same space.

Note: To change the kerning between two individual characters only, place the
cursor between those characters, and then use ARROW UP/DOWN while holding
<Alt> to increase/decrease the kerning. Press <Alt> and <Shift> to increase the
size of the steps.

• Leading: Modifies the distance between the text lines.

• Word Spacing: Changes the size of the blanks between the words in the text.

• Anisotropic: Sets the quality of textures applied to the surfaces of 3D objects
when drawn at a sharp angle. Choose either to let the application determine the
anisotropic filtering settings (Off), or select from a number of available settings.
Higher values gives better image quality at the expense of some performance.

•  IME: See Special Fonts.

Shadow Tab
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Click the Shadow tab in the Text editor to open the Shadow panel.

From the Shadow panel, shadow can be added to the text. Click the small switch left of
the font visualization to enable text shadowing. Be aware that all the modifiers that are
applied to the text in the Fontstyle editor are applied to the shadow too.

• Lighted: Lights the font with the current light settings (see Working with Light).

• Alpha: Changes the alpha value of the shadow.

• Direction: Sets the direction of the shadow from 0 to 360°.

• Distance: Sets the distance between text and shadow.

• Z-Offset: Sets the displacement of the shadow on the Z axis.

• Color: Sets the color of the shadow.

Note: The Color option is only applicable if the color modifier has not been
applied to the font.

• Type: Sets the shadow type to either geometry or texture.

• Quality: Sets the quality of the font to either Normal or High.

Note: The Quality option is only applicable if the font type is set to Geometry.

• Sharpen: Makes it possible to sharpen the shadow.

Note: The Sharpen option is only applicable if the font type is set to Texture.

• Anisotropic: Sets the quality of textures applied to the surfaces of 3D objects when
drawn at a sharp angle (see Basic Tab ).

Clock Tab
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Click the Clock tab in the Text editor to open the Clock panel.

In the Clock panel, the display of a clock can be inserted and edited. Click the small
switch in the upper left corner of the panel to enable the clock. The clock will be added
to the text string, if any, at the place where the cursor is.

• Clock: Sets the ID of the clock. Up to ten different clock IDs can be used in a scene.
Clocks with the same ID are linked together, which means they are synchronized
and all start when starting one of them. This makes it possible to for example
display different time zones.

• Time: Defines the starting time in seconds. If the clock for example should start to
count at 2 minutes, the Time should be set to 120.

• Limit: Click the Limit button to enable the Limit option, which makes it possible to
set a maximum count limit in seconds. If the clock for example should stop to count
at 2 minutes, the Limit should be set to 120.

Note: If counting down to 0, the Limit must be set to 0 seconds, or the clock will
continue to count below 0. If counting upwards starting at 0, make sure that the
Limit is not 0, as the clock will not count at all.

• Up and Down: Specifies if the clock should count upwards or perform a countdown.

• Start, Stop and Continue: Makes the clock start, stop and continue counting.

• Format: Sets the format of the clock display. More formats (20) can be pre-defined
in the configuration section under Clock Formats when Configuring Viz.

• H: Stands for hours.

• M: Stands for minutes.

• S: Stands for seconds.

• D: Stands for digits of a second. One digit shows a tenth of a second, the second
digit shows a hundredth of a second, the third digit shows a millisecond, and so on.

• User Defined: Select User Defined from the list to enable the User Defined text
box. In this box, type a non-standardized clock format. Make sure to add correct
separation characters.

• Fixed: Sets a fixed text box for each letter. The kerning of non-proportional fonts
vary for the various letters. For example, 1 has less kerning than 6. To avoid the
letters from “jumping” around while counting, the Fixed option can be enabled.



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 99

The Fixed value refers to the size of the text box around each letter. Note that the
problem with changeable kerning can be avoided by using a proportional font.

• Normal: Shows a normal main clock view.

• Count: Allows the creation of a “time count” version of a standard clock, which
counts a defined time lap in relation to one of the running clocks. For example, if a
clock is running, another Container with the same clock can be created. The state
of the second clock should be set to Count, and a time range defined. When clicking
the Start button under the Count section, the count clock will start counting the time
defined. It is related to the main clock, so if stopping the main clock, the count clock
will also stop. A typical use for this function is for counting penalty times in sport
graphics. In a sport game running on efficient time, a penalty count down should
stop when the main game time stops.

• No Sync: With this option enabled, the count clock will run with no second
synchronization to the main clock. It is almost impossible to start the count
clock exactly at a whole second, so the count clock will most likely run unevenly
compared to the main clock. This will in many cases not create the desired view.

• Sync Sec: The count clock synchronizes its view with the main clock.

• Loop: Loops the count clock within the defined count range.

• Up and Down: Specifies if the clock should count upwards or perform a countdown.

• Start, Stop and Continue: Makes the clock start, stop and continue counting.

• Init: Resets the clock’s counter.

• Offset: Enables an input box where the offset value in seconds can be entered. For
example, if the value is set to 20, after clicking the Start button, 20 seconds will
elapse before the clock starts running.

• Sys. Time: Uses the system time to set the time.

Characters Tab

Click the Characters tab in the Text editor to open the Characters panel.
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The Characters panel shows the character table in the fonts library. As an alternative
to using the keyboard, the symbols from the table can be dragged onto the input box
at the top of the Text editor. This is a helpful tool when using special characters that do
not exist on the keyboard, or is hard to find/use.

Special Tab

Click the Special tab in the Text editor to open the Special panel.

• ABC: Switches the text orientation from left to right, right to left, downwards, and
upwards.

• Text Box: Click the Text Box button to enable the Text Box option. The text box
defines the total size of the text, and appears as an orange outline in the Scene
Editor if enabling the Bounding Box option in the Scene Editor. Note that the Text
Box option is only available if the Text Orientation is set from left to right. Without
the text box, the text is displayed on one line. With the text box, the text can be
divided into multiple lines, and the text on each line automatically gets the selected
justification. Note that there is no hyphenation function. Only the text that fits within
the text box definition is shown in the Scene Editor.

• Width: Defines the width of the text box.

• Height: Defines the height of the text box.

• Underline: Click the Underline button to enable the Underline option, which makes
it possible to underline the text.

• Pos: Defines the position of the underline, from-20 to 20.

• Width: Defines the width of the underline, from 1 to 10.

Special Fonts

Special options apply for multibyte and geometry fonts:

• Multibyte: Click the  button to open a Script editor at the top of the Text editor.
The Script editor will replace the regular black input box. The Script editor makes it
possible to use complex script fonts.

Note: The IME tab is only available if the current font is of type multibyte (more
than 4 bytes).
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• Geometry: If adding a geometry font, the text will be treated like a compound
object created from characters. The text can be split to become a group of single
character objects (not text!). Splitting of text makes it possible to edit the properties
of single character objects.

Note: Be aware that it is a one way operation. It is not possible to merge
characters into text again, so by performing the splitting operation, the text
cannot be edited anymore.

See Also

• Adding Containers

• Working with Fontstyle Elements

• Fontstyle Editor

3.6.7 Texture Editor

To apply a texture to a Container drag a texture (e.g. an image) from the Server area to
a Container. In the Container an icon (a thumbnail of the texture) will show. If a texture
is dragged to the Scene Tree area it will create its own Container, Geometries can be
added later on, or the texture can be left as it is in the Scene.
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Tip: Modifications to the texture in the Texture editor only apply to the texture in
the selected Container.

This section contains information on the following topic and procedure:

• Texture Editor Properties

• To open the texture editor

Texture Editor Properties

• Image: Two textures can be used in one Container:

• Default Texture (1): Shows a thumbnail of the primary texture (the same
thumbnail that is shown on the Container). To change the texture drag another
texture to the drop zone. If only one texture is used the other functions in the Image
panel are inactive.

• Alpha Texture (2): Shows the thumbnail of a secondary (alpha) texture, if any. This
texture is used as an alpha channel for the Default texture. When two textures are
used the Image panel Alpha and Combine functions are active.

•  Alpha Buttons: When a second image is added the Alpha buttons are active.
The top button is the default button, the two images are shown as an alpha image.
Click the lower button to view the two images blended, use the slider to blend as
required.

•  Combine: When a second image is added, click this button to create a new single
image from the two images. The new image will be created in the currently open
folder in the Server area.

Tip: To save the new image in another folder, move to a different folder in the
Server area before the Combine button is clicked.

• Information: Shows the original width, height, and file size of the primary texture.
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Tip: To merge the two textures, click the little button between the textures. In the
dialog box that opens, select a name for the new texture, and then click the Ok
button. This will save the new texture to the database.

• Unit: Texture units take a texture and map them to a piece of geometry:

• 1-4: If the graphics card supports it, it is possible to have up to 4 available texture
units which can be used in parallel to do multi-texturing.

• Inheritable: Units can be inherited onto the textures of child Containers. Multiple
inherit is possible, but be sure to use different texture units for each texture that
should be inherited to not overwrite a unit.

• Mapping: The mapping option adjusts the way texture mapping is done:

• Vertex: Means that the texture mapping is done using the object texture, or UV,
coordinates. These coordinates index a texture image, and are interpolated across
the object to determine, at each of the object pixels, a texture image value. In most
cases on 3D objects, this will give the best looking result. The built-in geometry
plugins in Viz Artist have defined their texture coordinates. Imported objects can
have texture coordinates if they have been generated by an external 3D modelling
program. If for example adding a picture to a cube, all sides will look the same, and
the whole image will be displayed on each side.

• Linear: Is a “straight forward” mapping where the image so to say is laid over the
object directly on the frontal plane. The object is then moved through the image and
every pixel on the object inherits the pixel it “touches” on the image. On 3D objects,
this will cause a repetition of the pixels on the surfaces in the Z axis. If for example
adding a picture to a cube, the front and back side will look good, but the remaining
sides will be a repetition of the pixels laying on the edge of the front and the back
side.

• Reflection: Maps the texture as if it where a reflection from a surrounding object.
The reflection simulates that the texture image is an all-embracing object that casts
its reflection on the object. The object acts in a way like a mirror.

• Spherical: Spherically texture projection onto a geometry. The mapping position
and rotation can be adjusted with the corresponding parameters.

• Cylindrical: Cylindrical texture projection onto a geometry.

• Mapping Position: Sets the texture projection origin for Spherical and Cylindrical
mapping.

• Mapping Rotation: Sets the texture projection rotation for Spherical and
Cylindrical mapping.

Note: Mapping position and rotation are only available for Spherical and
Cylindrical mapping types.

• Cube: Cube texture projection onto a geometry. This option needs a vertical cross
cubemap which specifies how each of the 6 side projections should look like.

Note: To use the Cube mapping method for texture it is not possible to use the
same texture on another object with a different mapping method than Cube.

• Quality: The quality parameters specify a trade between rendering speed and
texture quality.

• Pixel: Shows the texture “as it is” with no smoothing and anti aliasing. It takes little
resources to render, but it can often create a poor visualization. This can be visible
as “toothed” lines and transitions, especially when close to the texture. A motion of
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either object or camera, especially in the Z axis, will create a “blurring motion” on
the texture, as the texture scales to fit the object.

• Linear: Performs a linear interpolation to smooth the texture when being magnified
or shrunk. The texture looks good, but some distortions can be visible when the
textured object is animated further away on the Z axis. As the object then gets
smaller and smaller, the shrinking and interpolation of the texture creates a lot of
“noise” on the texture. As a consequence, the linear quality is appropriate when the
objects that have the texture do not change their size much.

• Mipmap: Performs a linear interpolation to smooth the texture. In addition, it
offers a solution to the problem that appears on the two other qualities when the
object is being moved away along the Z axis or shrunk. To avoid the “noise” that
we see when a texture constantly scales to try to fit onto a shrinking/magnifying,
the mipmap quality creates a set of prefiltered images in a decreasing scale down
to almost on pixel. These are used as the object scales up and down and a more
static look of the texture is thereby achieved. Mipmap quality absorbs more memory
performance than the two other qualities.

Note: The following quality options are only available for the Mipmap quality.

• Blur: Makes the image blurry. The blur filter can be set to either Smooth, which
blurs the image smoothly, or Mosaic, which makes the blur look like tiles.

• Sharpen: This option is useful when the rendering window is scaled to half height
mode.

• Anisotropic Filter: The Anisotropic Filter can be set to either Off or 2-16x.
Anisotropic filtering is used, when textured objects need to be rendered in z-
direction, where textures usually get blurred.

• Environment: The environment parameters specify the way the texture RGBA
information is combined with the object RGBA information.

• Blend: Blends the RGBA parameters of texture and object.

• Decal: Uses only the RGBA information of the texture and disregards the RGBA of
the object.

• Modulate: Uses the RGBA information of the texture and enables in addition use of
lighting on the textured object.

• Add: Adds source unit 1 and source unit 2 together.

• Add Signed: Adds source unit 1 and source unit 2 then subtracts 0.5.

• Interpolate: Linear interpolation between source unit 1 and source unit 2.

• Blend Factor: Defines in interpolation mode how much of source unit 1 and unit 2
is used (0.0%: shows current unit, 100%: shows source unit).

• Source Unit: Sets the second source unit for interpolation mode (can be all other
units together or just a specific unit).

Note: Blend Factor and Source Unit environment options are only available for
the Interpolated environment.

• Wrap: Wraps the object by repeating or clamping (no repeat – the texture’s edge
color is used to fill the rest of the object) the texture onto the object’s surface. This
setting comes into operation if the texture mapping cannot fill the whole object (e.g.
the texture was scaled below 0.0).

• Repeat: Means that the whole texture is repeated over again to fill out the object.

• Clamp: Means that the pixels on the end of the image are repeated to fill out the
object.
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• Compression: Texture compression can be used to save texture memory on the
graphics card.

• None: No compression.

• DXT1: Compresses to an RGB image. This format has a 6:1 compression ratio (DXT1
does not store alpha).

• DXT3: Compresses to an RGBA image with a 4:1 compression ratio.

• DXT5: Compresses to an alternative RGBA image that treats the alpha channel
different than DXT3 (alpha looks smoother). DXT5 has the same compression ratio
as DXT3.

• Position: Defines the position of the texture relative to the one stored in the
picture.

• Rotation: Defines the rotation of the texture relative to the one stored in the
picture.

• Center: Shifts the center of the image.

• Scaling: Scales the image that is used as texture. Before changing the scale values
of the image, make sure to set the preferred kind of scaling:

• Single: Scales each axis by itself.

• Locked: Scales all axes at once, so that X, Y, and Z have the same value.

• Proportional: Scales all axes at once, so that the values remain proportional.

• Stereo Mode: Select the correct stereo mode for the inserted image:

• None: No Stereo mode.

• Config: Images are drawn as set in the config file (see Camera, in Configuring Viz).

• Over Under Left Top or Over Under Right Top: Two images are stored, one over
(top) and the other under (bottom), left or right eye (top) first. The image height
will be halved, providing half resolution.

• Side by Side Left or Side by Side Right:  Two images are stored, side by
side, left or right eye first. The image width will be halved, providing half
resolution.

To open the texture editor

• Click the icon representing the texture either on the Container or in the Properties
editor.

See Also

• Adding Containers

• Working with Image Elements

• Image Editor
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3.6.8 Plugin Editor

When a Geometry, Container or Shader Plugin is added to a Container its properties will
be available in the Properties Panel. Each Plugin may or may not have properties that
can be modified.

 Click on the information icon to show details about the selected plugin, if available.
Additional information may also be available in the plugin section of this User Guide,
see these Plugin sections for more information:

• Geometry Plugins

• Container Plugins

• Shader Plugins

3.6.9 Material Editor

When a Material has been added to a Container, the Container-specific Material can be
modified in the Material Editor that opens in the Properties panel. Only the Container-
specific Material will be modified, the original Material in the Graphic Hub database will
not be affected (see Working with Material Elements).

This section contains information on the following procedures:

• To modify a Scene Specific Material

• To save the Container Material

To modify a Scene Specific Material

1. Click the Material icon in the Container (1) or Properties panel (2). The Properties
panel Material Editor (3) is shown.
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2. Adjust the Material Color Properties and Schemes as necessary.

To save the Container Material

1. Move the modified Material to the Server Area:

• Drag the material icon from the Container to the Server area, or

• Drag the material icon from the Properties area to the Server area, or

• Click in the Material properties panel and drag the material icon to the Server
area

2. Enter a name for the material.

3. Click OK.

See Also

• Material Editor

• Working with Light

• Common Element Procedures
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4 Manage Work and Viz Graphics Hub

This section contains information on the following topics:

• Viz Graphic Hub

• Server Area

• Folder Tree

• What are Elements

• Element Area

• Working with Elements

• Assign Keywords to Elements

• Image Editor

• Fontstyle Editor

• Material Editor

• Element Search

• SmartView Search

• Built Ins

4.1 Viz Graphic Hub
Viz Graphics Hub is the database solution where all Viz Artist Elements are stored.
Elements can be either:

• Scenes

• Objects

• Images

• Materials

• Materials Advanced

• Fonts

• Audio Clips

To start Viz Artist successfully, the user must log in to a running Viz Graphic Hub.

The database can either be a local instance, where only one user can log in. Such a
database can be installed on the computer where Viz Artist is used. In a multi user
environment, the database is installed and run on a centralized server, providing
shared access to various users at the same time.

The individual items are stored in the Viz Graphic Hub data directory as file objects.
The database itself manages the items in terms of properties and Universally Unique
Identifiers (UUIDs).

Clients can work with and organize items through the Viz Artist GUI in a logical folder
structure provided by the database. Although each item can be listed and linked in
more than one folder, it will be in the database only once.

See Also
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• What are Elements

• Viz Graphics Hub User’s Guide

4.2 Server Area

The Server area shows an overview of all available Elements in the Viz Graphics Hub
(GH) database. The Server area is divided in two:

• Folder Tree (1): Shows the logical tree of folders in the GH database.

• What are Elements (2): Shows the Elements in the selected folder.

Tip: To resize the two areas, drag the vertical separator.

To show the Server area

• Click Server in the Main menu.

This will show the server area together with the scene tree and Scene Editor.

or

• Click Server/Stage in the Main menu.

This will show the server area together with the Stage and Scene Editor.

or

• Click +Tree/Stage in the Main menu.

This will show the server area together with the stage, scene tree, and Scene Editor.
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4.2.1 Server Tree Bar

The Server Tree bar consists of various buttons that make it possible to create folders
and modify the appearance of the Server Tree. It is located at the top left side of the
Server area.

The Tree bar contains the following options:

•  Expand: Expands the currently selected branch and all its sub-branches (see
To expand or collapse a folder branch).

•  Collapse: Collapses the currently selected branch and all its sub-branches
(see To collapse a folder branch including all its sub-branches).

•  Add New Project (folder): Makes it possible to add a new project folder to
the Server Tree (see To create a new Folder).

•   Add New Folder (regular): Makes it possible to add a new regular folder to
the Server Tree (see To create a new Folder).

•  Restrict to Current Project Folder: Restricts to working project folder by
narrowing down the server view so that only the selected project folder with its sub-
folders are shown.

Note: This option is only available if a project is selected in the Server Tree.

•  Show All Project Folders: If the tree is narrowed down to only one project
folder, the tree is expanded to show all folders.

•  Refresh: Refreshes the Server Tree and adds updates.

4.2.2 Server Tree Menu

Right-click a folder in the Server Tree to open the Server Tree context menu.

• Rename: Change the name of the selected folder (see To rename a Folder).

• Delete: Deletes the selected folder (see To delete a Folder).

• Create Sub Project...: Create a sub-project folder under the currently selected
project folder (see To create a new Folder).
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Note: It is not possible to add a sub-project folder to a regular folder (see
Folders).

• Create Sub Folder...: Create a sub-folder under the currently selected folder (see
To create a new Folder)

• Add as Bookmark...: Adds the selected folder to the list of bookmarks (see To
Bookmark a folder). Bookmarks are added to the Server Tree menu at the bottom.
Click a bookmark in the list to open the corresponding folder

• Delete from Bookmarks...: Deletes the selected folder from the list of bookmarks
(see To delete a folder bookmark)

• Switch Folder Type Highlighting <On/Off>: Set highlighting of folders to ON or
OFF. For example, if a folder (and sub-folders) contain a Scene it will be highlighted
when the Scene tab is selected. The default setting of this feature can be set in the
Viz Configuration (see User Interface).

• <Bookmark(s)>: Show a list of all current bookmarked folders. Click on a folder
bookmark to go to that folder.

4.3 Folder Tree
The Server area folder tree shows a structured storage of Elements, and is located at
the left side of the Server area.

Viz Artist can be configured to highlight only the folders in the tree that contain a
selected Element type (see Folder Type Highlighting in User Interface). The labels
of folders, and their sub-folders, that contain none of the selected Element type are
grayed out.

Right-click on any folder in the Server Tree to open the Server Tree Menu .

This section contains information on the following topics:

• Folders

• What are Elements

• Server Tree Menu

4.3.1 Folders

The Server Tree can contain two types of folders:

• Regular folders

• Project folders
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The difference between a regular folder and a project folder is that by defining a
working project, the tree can be collapsed so that only the currently selected project
and its sub-folders and sub-projects folders are shown.

Both types of folders can be dragged around after being added to the Server Tree.

Folder Position in the Server Tree

The position in the Server Tree where a moved or new folder is placed depends on
where in the Server Tree they are dragged and released.

• Release the Add New <Folder/Project> button (1) on the left side will create a
folder at the same level as the folder highlighted (2).

• Release the Add New <Folder/Project> button on the right side will create a sub-
folder, of the folder highlighted (3).

This section contains information on the following topics:

• To create a new Folder

• To rename a Folder

• To move a Folder

• To delete a Folder

• To expand or collapse a folder branch

• To expand a folder branch including all its sub-branches

• To collapse a folder branch including all its sub-branches

• To Bookmark a folder

• To delete a folder bookmark

To create a new Folder

Use to create new Regular folders or new Project folders.

Note: A new project folder can not be created in a folder.

Note: Special characters, such as space, are not allowed in folder names.

1. In the Server Tree Bar, drag the Add New <Folder/Project> button, to the

Server Tree  .
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2. Create a new folder in the required position in the Server Tree (see Folder Position
in the Server Tree):

• Folder level: Drop the Button over a current folder, on the left side of the
Server Tree.

• Folder Sub level: Drop the Button on a current folder, on the right side of
the Server Tree.

3. In the dialog box that opens, type a descriptive name for the folder.

4. Click the Ok button.

or

1. Click a folder in the Server Tree.

2. In the Server Tree Bar, click the Add New <Folder/Project> button.

3. In the dialog box that opens, type a descriptive name for the new folder type.

4. Click the Ok button.

Note: If the selected folder is a regular folder and a new project folder is to be
created, the new project folder will be created at the next available place up in the
Server Tree.

or

1. Right-click a folder in the Server Tree.

2. In the Server Tree Menu that opens, select:

• Create Sub Folder..., or

• Create Sub Project...

Note: Create Sub Project will be only available if a project folder can be created in
that position.

3. In the dialog box that opens, type a descriptive name for the new Sub-folder type.

4. Click the Ok button.

To rename a Folder

1. Select the folder to be renamed.

2. Open the rename text box:

• Right-click a folder in the Server Tree. In the Server Tree Menu that opens, click
on Rename, or

• Press <F2>.

3. In the text box that opens, type a new descriptive name

4. Press <Enter>.

To move a Folder

1. Drag a folder to its new location.

2. Drop the folder, at its new location, to the left or the right of the Sever area Tree
(see Folder Position in the Server Tree).
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Note: A project folder can not be moved to a folder or a sub-folder.

Note: If a project or folder can not be dragged and dropped, check the
Allow Folder Move settings (see the Global configuration settings of the Viz
Configuration Database section).

To delete a Folder

1. Right-click a folder in the Server Tree.

2. In the Server Tree Menu that opens, select Delete.

3. Click Yes to confirm.

Note: If the folder is added as a bookmark, the bookmark will also be deleted (see
To Bookmark a folder).

or

1. Drag a folder to the Trash Can  .

2. Click Yes to confirm.

To expand or collapse a folder branch

• Click the Expand or Collapse icon to the left of the folder name  , or

• Double click a folder.

To expand a folder branch including all its sub-branches

1. Select a folder in the Server Tree  .

2. Click the Expand button in the Server Tree Bar.

To collapse a folder branch including all its sub-branches

1. Select a folder in the Server Tree  .

2. Click the Collapse button in the Server Tree Bar.

To collapse all folder branches

• Double-click the Collapse button in the Server Tree Bar  .

To Bookmark a folder
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For User convenience folders can be bookmarked to make it easier to find often used
folders. Bookmarked folders are added to the Server Tree menu (1). Click a bookmark
in the list to open the corresponding folder.

1. Right-click a folder in the Server Tree.

2. In the Server Tree Menu that opens, select Add as Bookmark...

To delete a folder bookmark

1. Right-click a folder in the Server Tree.

2. In the Server Tree Menu that opens, select Delete from Bookmarks...

4.4 What are Elements
Elements are items that are used to build up a Scene. Elements can also be complete
Scenes.

The Server Area shows the Elements that are available for the folder selected in the
Server Folder Tree.

This section contains information on the following topics:

• Scenes

• Objects

• Materials

• Materials Advanced

• Images

• Fonts

• Audio Clips
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4.4.1 Scenes

Scenes are root Elements that hold other Elements. Scenes are stored in the Viz
Graphic Hub database and are available through the Server area.

If a Scene is opened, the Scene Tree area shows the logical visualization of all the
objects within the Scene. The Scene Tree consists of Containers that hold Elements and
properties, organized in a hierarchy and grouped in logical divisions. The Elements and
properties can be Geometries, Images, Materials, Fonts, transparency functions, key
functions, and many more (see What are Elements and Built Ins).

See Also

• Working with Scene Elements

• Common Element Procedures

• Built Ins

4.4.2 Objects

An object Element holds information about geometry. Objects are stored in the Graphic
Hub database and are available through the Server Area.

Objects can be created in Viz Artist or imported from an external modelling program
(see Importing).
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Viz Artist also has a set of Objects that are built-in Geometry Plugins. These geometries
are common plugins that can be used in Scenes.

An Object can be added to a Scene as a standalone Container or as a Geometry
property of a Container. Drag the object from the Element List (or Favorites Bar) to
the Scene Tree, Scene Editor or add to a Container in the Scene Tree (see Adding
Containers ).

See Also

• Working with Object Elements

• Properties panel Geometry Editor

• Common Element Procedures

• Built Ins

4.4.3 Materials

Materials hold colors, customized colors and light effects which can be applied to
objects in a Scene.

The Materials icon (1) in the Element area shows the current state of the Material.
The color for a lit object is shown on the sphere within the icon, while the three parts
around the sphere show the plain color for an object that is not lit.

When a Material has been added to a Scene, the Scene-specific Material can be
modified in the Material editor that opens in the Properties panel. Only the Scene
specific Material will be modified, the original Material in the Graphic Hub database will
not be affected (see Working with Material Elements).

See Also

• Working with Material Elements

• Properties panel Material Editor

• Material Editor
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• Common Element Procedures

• Lights

4.4.4 Materials Advanced

An Material Advanced is an Element that can combine a Shader plugin, an Image and
a Material Element. A combination minimum of two items are required to create the
Materials Advanced.

The Materials Advanced Element is stored in the Graphic Hub database and are
available in the Server area Element List.

To add a Material Advanced as a Container item, drag the Material Advanced from the
Element List (or Favorites Bar) to a Container in the Scene Tree.

See Also

• Working with Material Advanced Elements

• Common Element Procedures

• Built Ins

4.4.5 Images

Viz Artist supports still images in formats TIFF, BMP, SGI, JPG, TGA, PSD, XPM, HDR,
PNG. The Images are stored in the GH database and are available through the Server
area.

An Image can be added to a Scene as a standalone Container, or as a Container item.
Drag the Image from the Element List (or Favorites Bar) to the Scene Tree, Scene Editor
or add to a Container in the Scene Tree (see Adding Containers ).

See Also
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• Working with Image Elements

• Common Element Procedures

• Properties panel Texture Editor

• Image Editor

4.4.6 Fonts

Fonts are complete character sets within a unique style. The Fonts are stored in the
Graphic Hub database and are available through the Server area.

A Fontstyle can be added to a Scene as a standalone Container or as a Container item.
Drag the Fontstyle from the Element List (or Favorites Bar) to the Scene Tree, Scene
Editor or add to a Container in the Scene Tree (see Adding Containers).

See Also

• Working with Fontstyle Elements

• Common Element Procedures

• Properties panel Text Editor

• Fontstyle Editor

4.4.7 Audio Clips

Viz Artist supports Audio clips in formats WAVE, MP3, and Vorbis (ogg), which are stored
in the GH database and are available through the Server area.
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The Audio clips can be added to Scenes and, or to the animation of a Scene. See:

• To add an Audio clip to a Scene

• Animating Audio

See Also

• Working with Audio (Clips) Elements

• Common Element Procedures

4.5 Element Area

The Element area shows the Elements that are available for the folder selected in the
Server Tree.

This section contains information on the following topics:

• Element List

• Element Context Menu

• Content Switcher

• Server Menu

• Properties Panel

4.5.1 Element List

The Element list shows all Elements in the selected folder.

This section contains information on the following procedures:

• Default View

• Details View

• To show Elements with details

• To show Elements details with or without icons

• To show the Properties Panel

• To sort Elements
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Default View

Elements are, by default, shown with a thumbnail and their name, and sorted
alphabetically. To show additional information about the Elements see To show
Elements with details and To show the Properties Panel . Right-click an item in the
Element List to open the Element Context Menu .

Tip: Holding the pointer over a thumbnail will show the whole Element name as a
tool tip.

Details View

The Elements in the list can be shown with information about their owner and creation
date.

To show Elements with details

• Click on Detail from the Server Menu, or

• Hold the pointer over the Server area and press the keyboard shortcut <Ctrl+Y>.

To show Elements details with or without icons

• When in Detail view toggle click the I (1) in the Elements list header to view
Elements icons or not. When no icon is selected the Element name shows.
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Element properties

The Properties Panel will show detailed information about file, links, keywords, and
history for the selected Element in the list.

To show the Properties Panel

• Select Show Properties from the Server Menu, or

• Hold the pointer over the Server area and press the keyboard shortcut <Ctrl+P>, or

• Right-click an Element in the Element List. In the menu that opens, select Show
Properties...

See Also

• Properties Panel

To sort Elements

Elements can be sorted in Default View or Details View. Click on a column heading to:

• Name (1): Sort Elements by name.

• Date (2): Sort Elements by the last date and time when the Element was modified.

• Owner (3): Sort the Elements by name of the Element owner.

To sort the Element list, click on either the Name, Date or Owner columns. Click on the
arrow (shows when a column is clicked on) to sort ascending or descending
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Note: By default Elements are sorted alphabetically by name.

4.5.2 Element Context Menu

Right-click an Element in the Element List to its context menu, which contains the
following options:

• Rename: Change the name of the selected Element (see To rename an Element).

• Delete: Delete the selected Element (see To delete an Element).

• Delete with all references: Delete the selected Element and all its referenced
Elements. Referenced Elements are not deleted if they are referenced by other
Elements.

• Duplicate: Creates an independent copy of the selected Element. The copy will be
placed in the same folder as the original Element (see To create an Element copy in
a new folder).

• Verify/Restore: Locates, verifies and attempts to correct a corrupted Element.

• Switch to Small/Large Icons: Toggles between small or large Element icons in the
Element List.

• Create New [Element]: Create a new Element:

• In the dialog box that opens, type a descriptive name.

• Click the Ok button.

Note: The ‘Create new’ option is only available for Scenes and Materials.

• Add as Favorite...: Adds the selected Element to the Favorites Bar in the Scene
Tree area.

Note: It is not possible to add Scenes or Audio Elements as favorites.

• Delete from Favorites: Deletes the selected Element from the Favorites Bar .

• Check Out: Checks out the selected Element, so that only the user that checks out
the file can modify it (see To check out Elements ).
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Tip: Other users can see the name of the user that has checked out the file from
the Properties Panel .

• Check In: Checks in the selected Element, so that all users can modify it (see To
check in Elements).

Note: The check in option is only available for Elements that have been checked
out.

• Show Properties...: Shows the Properties Panel at the bottom of the Element area,
with the File Info tab selected.

• Show Folder Links...: Shows the Properties Panel at the bottom of the Element
area, with the Links tab selected.

Note: The folder links option is only available for Elements that are linked (see To
create a linked Element ).

• Show Keywords...: Shows the Properties Panel at the bottom of the Element area,
with the Keywords tab selected.

• Show History...: Shows the Properties Panel at the bottom of the Element area,
with the History tab selected.

• Close Properties: Closes the Properties Panel .

• Search Reference...: Opens the Search window and searches the database for
other Elements which are referenced to the selected Element (see Reference Search
).

Note: It is not possible to perform a reference search for materials, as materials
are not referenced. Material information is held inside the Scene.

• Export...: Selected Image and Audio clip Elements can be exported (see To export
an Image(s) and To export an Audio clip).

Note: This option is only available for images and audio.

• Export as XML...: Export an XML representation of a Scene and other objects into
an XML file. XML files can be used to compare two versions of a Scene using a file
comparison utility (aka diff tool).

• Deploy...:  Deploy an Element, with all its necessary data, from one server to
another. For example, if a Scene is deployed, all items referenced by the Scene
(Images, Objects, etc.), will also be deployed (see To deploy selected Elements and
To deploy single Elements).

Note: Available when Deploy is enabled and a valid Deploy server is entered in
the Viz Configuration (see Deploy in the Database panel of Configuring Viz ).

4.5.3 Content Switcher

Folders can contain various types of Elements.
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To view only a selected type of Element, contained in a folder, click an Element type
tab from the Content Switcher (1). If the All tab is selected all Elements in the selected
folder, regardless of type, will be shown.

• S: Shows only Scene Elements.

• O: Shows only Object Elements

• M: Shows only Material Elements

• MA: Shows only Material Advanced Elements

• I: Shows only Image Elements

• F: Shows only Fontstyle Elements

• A: Shows only Audio Elements

• All: Shows all Element types

• Auto: Shows the Element type with the most instances in the selected folder. For
example, if there are five materials in a folder, but only one instance of each of the
other Element types, the materials will be shown in the Element List.

• <Username>s View: Personalized view to enter and save free text searches for
later use (see SmartView Search).

See Also

• Working with Elements

This section contains information on the following topics:

• Content Switcher Menu

• Element Type History

• To show the Element Type History list

• To show the Element type last used folder

Content Switcher Menu

A right-click on one of the tabs in the Content Switcher opens the Content Switcher
menu. At the bottom of the menu, below the command separator, is a list of hot folders
for the selected Element type. Hot folders are Element specific favorite folders that the
User often uses. Selecting a hot folder in the list will open the corresponding folder and
switch to the selected Element type.

The Content switcher menu contains the following options:

• Mark as Hot Folder...: Adds the currently selected folder to the list of favorites.
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Note: Each Element type has a separate list of Hot Folders.

• Unmark as Hot Folder...: Removes the currently selected folder from the list of
favorites.

Element Type History

The Element type history shows an overview of previously used folders and is saved
independent of Element type. Each Element type has a separate history list, which can
contain up to 20 hits.

Note: A folder is added to the History list when an Element has been dragged,
regardless if the Element was actually used in a scene.

To show the Element Type History list

1. Hold the pointer over one of the tabs in the Content Switcher.

2. Press and hold <Ctrl>, and right-click.

3. Move through the list and click to show the selected folder.

Note: The Element list is shown in last used order.

To show the Element type last used folder

1. Hold the pointer over one of the tabs in the Content Switcher.

2. Press and hold <Ctrl>, and left-click.

3. The content of the last used folder for this Element type will be shown.

4.5.4 Server Menu

At the top of the Server area is the Server menu.
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Server menu

• Search: Opens the Search window (see Element Search).

• Cut: Cuts the currently selected Element, so that it can be pasted in another folder
(see To move an Element to a new folder).

• Copy: Copies the currently selected Element, so that it can be pasted in another
folder (see To create an Element copy in a new folder).

• Paste-Link: Pastes a copied Element as a linked file. Since the new Element is
linked, the Element thumbnail will contain a Link icon in the lower left corner (see
Linked Elements).

• Paste-Dup: Pastes a copied Element as an independent file (see To create an
Element copy in a new folder).

• Show Properties: Shows the Properties Panel at the bottom of the Element area,
with the File Info tab selected (see To show the Properties Panel).

• Detail: By default, Elements are presented in the Element list with thumbnail
and name. By selecting the Detail option, additional information about owner and
creation date is shown (see To show Elements with details ).

• Create: Makes it possible to add a new Element (see Working with Elements ).

Note: The create option is only available for Scenes and Materials.

• Export: Makes it possible to export an Element (see To export an Image(s) and To
export an Audio clip).

Note: The export option is only available for Images and Audio elements.

• Export as XML: Export an XML representation of a Scene and other objects
into a file. XML files can be used to compare two versions of a Scene using a file
comparison utility.

• Check Out Files: Checks out the selected Elements, so that only the User who
checked out the files can modify them (see To check out Elements ).
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Tip: Other users can see the name of the user that has checked out the files from
the Properties Panel .

• Check In Files: Checks in the selected Elements, so that all Users can modify them
(see To check in Elements).

Note: The check in option is only available for Elements that have been checked
out.

• Reconnect: Re-establishes the connection to Viz Graphic Hub.

See Also

• Lights

• General Server Tree Shortcuts

4.5.5 Properties Panel

The Properties panel shows detailed information about the selected Element in the
Element List. It is shown below the Element list.

File Info Tab

The File Info tab shows various information about the selected Element:

• UUID: Shows the universally unique Element identifier.

• Path/Name: Shows the path to where the Element is located and the name of the
Element.

• Type: Shows the Element type, for example Fontstyle, Image, or Material.

• Creation Date/Time: Shows the date and time when the Element was created.

• Owner: Shows the name of the user that owns the Element.

• Modification Date/Time: Shows the date and time when the Element was last
modified.

• Checksum: Shows the file’s checksum in case you need to check its validity.

• File size: Shows the size of the Element file.

• Checked Out By: If the Element has been checked out, it shows the name of the
User who did the checkout operation (see Active Elements ).

• Locked By: If the Element has been locked, it shows the name of the user that has
performed the lock operation (see Active Elements).



Viz Artist User’s Guide

Page 130 Copyright © 2014 Vizrt

Links Tab

The Links tab shows the links that are assigned to the selected Element:

• Path: Shows the path to where the linked Elements are located.

• Link Name: Shows the names of the linked Elements.

Tip: Click one of the links to select the folder where the linked file is placed, and
to show the Element in the Element List.

Keywords Tab

The Keywords tab shows the keywords that are assigned to the selected Element.
Keywords can be assigned, for example, when an Element is imported to Viz Artist (see
Assign Keywords to Elements ).

Note: If multiple Elements have been selected, and some keywords are grayed
out, the gray keywords are assigned to at least one of the selected Elements, but
not all.

History Tab

The History tab shows the history of the selected Element:

• Date: Shows the date and time when the Element was created or modified.

• User: Shows the name of the user that created or modified the Element.
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• Changes: Shows the operation that was performed on the Element, for example if
the document was created.

• SysID: Shows the Viz Artist license number on the machine that performed the
operation.

• Module: Shows the name of the application that changed the data.

• Source: Shows the source of the data. For example, the archive name for an
imported object or the name of the Graphic Hub from where it was copied.

This section contains information on the following topics:

• To show the Properties panel

• To show the Properties panel with a selected tab open

• To close the Properties panel

To show the Properties panel

• Select Show Properties from the Server Menu, or

• Hold the pointer over the Server area and press the keyboard shortcut <Ctrl+P>, or

• Right-click an Element in the Element List. In the menu that opens, select Show
Properties...

To show the Properties panel with a selected tab open

• Right-click an Element in the Element List. In the menu that opens, select either:

• Show Properties...

• Show Folder Links...

• Show Keywords...

• Show History...

Note: The Show Folder Links... option is only available for Elements that are
linked (see Linked Elements ).

To close the Properties panel

• Right-click in the Element List. In the menu that opens, click on Close
[Properties], or

• Click the Close icon in the upper right corner of the Properties Panel, or

• Un-tick Show Properties in the Server Menu.

4.6 Working with Elements
This section contains information on the following topics:

• Common Element Procedures

• Active Elements

• Linked Elements

• Referenced Elements

• Working with Scene Elements

• Working with Object Elements
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• Working with Material Elements

• Working with Material Advanced Elements

• Working with Image Elements

• Working with Fontstyle Elements

• Working with Audio (Clips) Elements

4.6.1 Common Element Procedures

These are procedures which are common to all Element types.

This section contains information on the following topics:

• To view Elements in a folder

• To rename an Element

• To delete an Element

• To delete an Element with all references

• To create an Element copy in a new folder

• To create an Element copy in the same folder

• To move an Element to a new folder

• To create a linked Element

To view Elements in a folder

1. Open the element panel from the Content Switcher:

Element Tab Keystroke (hold the pointer over the Server area)

Scenes S <Ctrl+1>

Objects O <Ctrl+2>

Materials M <Ctrl+3>

Materials Advance MA <Ctrl+4>

Images I <Ctrl+5>

Fonts F <Ctrl+6>

Audio Clips A <Ctrl+7>

2. Select a folder in the Server Tree.

Note: Select All in the Content Switcher to view all Element types in the folder
selected.

To rename an Element

1. Select the Element to be renamed.

2. Open the rename text field:

• Right-click the Element and select Rename from the context menu, or
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• Press <F2>.

3. In the text field that shows, type a new descriptive name.

4. Press <Enter>.

Note: Special characters, such as space, are not allowed in Element names.

Note: If renaming a linked Element, only the name of the selected Element will
change, not the linked one (see Linked Elements).

To delete an Element

1. Select the Element to be deleted.

2. Delete the Element:

• Drag the Element to the trash can, or

• Right-click the Element and select Delete from the context menu, or

• Press <Delete>.

3. Click on Yes to confirm.

Tip: To delete multiple Elements select the Elements to be deleted and drag to
the Trash Can.

Note: If deleting a linked Element, only the link to the folder will be removed. The
Element itself will remain in the database (see Linked Elements).

Note: Referenced Elements cannot be deleted. Referenced Elements are used by
other Elements.

To delete an Element with all references

Deletes the selected Element and all its referenced Elements. Referenced Elements are
not deleted if they are referenced by other Elements.

Note: Referenced elements are deleted if they are referenced to ONLY the
selected Element. If they are also referenced to others, then they will not be
deleted.

1. Locate the Element to be deleted.

2. Right-click the Element and select Delete with all references from the context
menu.

3. Click on Yes to confirm.

To create an Element copy in a new folder

Use this procedure to create an independent copy of an Element(s) in a new folder:
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Note: To select more than one Element press and hold <Ctrl> and click on each
required Element or press and hold <Shift> to select a range or Elements.

1. Select the Element(s) to be copied.

2. Press <Ctrl> and drag the Element(s) to the target folder.

or

1. Select the Element(s) to be copied.

2. Select Copy from the Server Menu or <Ctrl+C>.

3. Open the folder where the target Element(s) are to go.

4. Select Paste-Dup from the Server Menu or <Ctrl+Shift+V>

To create an Element copy in the same folder

Use this procedure to create an independent copy of an Element in the same folder:

1. Right-click the source Element.

2. In the context menu that shows, select Duplicate.

3. In the dialog box that opens, type a descriptive name for the new Element.

4. Click the Ok button.

or

1. Select the Element(s) to be copied.

2. Select Copy from the Server Menu or <Ctrl+C>.

3. Select Paste-Dup. from the Server Menu or <Ctrl+Shift+V>

4. In the dialog box that opens, type a descriptive name for the new Element.

5. Click the Ok button.

To move an Element to a new folder

Note: To select more than one Element press and hold <Ctrl> and click on each
required Element.

• Drag the Element or Elements from the Element List onto the target folder in the
Server Tree.

or

1. Select the source Element(s).

2. Select Cut from the Server Menu, or <Ctrl+X>

3. Open the folder where the target Element(s) are to go.

4. Select Paste-Dup. from the Server Menu, or <Ctrl+Shift+V>.

To create a linked Element

1. Select the source Element.

2. Press <Alt> and drag the Element to the target folder.

or
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1. Select the source Element.

2. Select Copy from the Server Menu.

3. Select the folder where the target Element is to go.

4. Select Paste-Link from the Server Menu, or <Ctrl+V>.

See Also

• Working with Elements

• Active Elements

• Linked Elements

• Referenced Elements

• Importing

4.6.2 Active Elements

Elements that are in currently work are Active Elements. These Active Elements are
locked or checked out.

An Active Element has a small icon in the lower left corner of the thumbnail in the
Element List which changes to show different states:

•  Locked: If a user connected to the database opens an Element, the Element will
be locked for all other users and marked with the keyhole icon. A locked Element
means that the Element can be opened and viewed by all users, but only modified
or saved by the user that has locked it. The Element will be unlocked when the user
closes the Element or disconnects from the database (see To lock an Element).

•  Checked Out: If a user, connected to the database, checks out an Element, the
Element will be locked for all other users and marked with the stop icon. A checked
out Element means that the Element can be opened and viewed by all users, but
only modified and saved by the user that has checked it out. To cancel the check
out, the Element must be checked in (see To check out Elements and To check in
Elements).

Note: The Element will stay checked out (locked) even if the user closes the
Element or disconnects from the database.

•   Locked and Checked Out: For a locked and checked out Element, the icon
represents a combined keyhole, stop sign (see To lock and check out Elements).

This section contains information on the following procedures:

• To lock an Element

• To check out Elements

• To check in Elements

• To lock and check out Elements
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To lock an Element

• An Element is automatically locked when a user opens the Element. It is not
possible to perform this operation manually.

To check out Elements

1. Select the Element or Elements.

2. Check out the Elements:

• Right-click an Element and click on Check Out in the context menu (one
Element only), or

• Hold the pointer over the Server area and use the keyboard shortcut <Ctrl
+O>, or

• Select Check Out Files... from the Server Menu.

To check in Elements

1. Select the Element or Elements.

2. Check in the Elements:

• Right-click the Element and click Check In from the context menu (one
Element only), or

• Press the keyboard shortcut <Ctrl+I> while holding the pointer over the Server
area, or

• Select Check In Files... from the Server Menu.

To lock and check out Elements

• An Element is automatically locked when a user opens the Element. It is not
possible to do this operation manually (see To check out Elements).

See Also

• Working with Elements

• Common Element Procedures

• Linked Elements

• Referenced Elements

• Importing

4.6.3 Linked Elements

Every Element in the database is shown in one or more folders.

A linked Element has a small link icon attached to the lower left corner of the thumbnail
in the Element List. A linked Element will show, logically, in multiple folders, although
only one Element is physically saved in the Graphic Hub database.

To view the UUID of the linked Element, open the Properties Panel and select the File
Info tab. The UUID of the one saved Element is the same for all linked Elements, while
information such as path, and name may vary.
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If modifying the Element in one of the folders, for example cropping an image, all the
linked items will reflect these changes.

To create a linked Element see To create a linked Element.

See Also

• Working with Elements

• Active Elements

• Referenced Elements

• Importing

4.6.4 Referenced Elements

A referenced Element is an Element which is connected to and used by another
Element, by a reference only.

Some Elements are, or can be, made up of other Elements, i.e. Object Elements. An
Object Element can be made up of other Elements. These other Elements are not
physically part of the Object Element, but are used by reference.

Because the Object Element uses another Element as part of its output, any changes to
the referenced Element will result in changes the Object Element itself.

The Element which is referenced cannot be modified without a warning message. If the
referenced Element is modified then the Element which is referencing that Element will
be modified too - it will look and act differently.

A referenced Element cannot be deleted. The Element which holds the reference has to
be deleted before the referenced Element can be deleted from Viz Graphic Hub.

An Element can reference many other Elements.

See Also

• Working with Elements

• Common Element Procedures
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• Active Elements

• Linked Elements

• Reference Search

• Importing

4.6.5 Working with Scene Elements

This section contains information on the following topics:

• To create a new Scene

• To import a Scene

• To save a Scene

• To save a Scene with a new name

• Scene Save as... panel Context Menu

• To undo/redo operations in a Scene

To create a new Scene

Note: This will create an empty new Scene. Add containers as required, in the
Scene Tree

1. Open the Scene tab (see To view Elements in a folder).

2. Select the folder where the new Scene should go.

3. Open the Create New Scene panel:

• Right-click in the Element List. and select Create new Scene, or

• Open the Server Menu and select Create..., or

• Hold the pointer over the Server area and press <Ctrl+A>.

4. In the Create New Scene panel enter a text string for the new Scene.

5. Click on OK.

To import a Scene

• For information about how to import a Scene (or an Archive) from a hard disk or
network share to the database see Importing .

To save a Scene
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• Click the Save button in the lower left corner of the window, or

• Hold the pointer over the Scene Tree area and press the keyboard shortcut <Ctrl
+S>.

To save a Scene with a new name

1. Click the Save As button in the lower left corner of the window.

2. In the Scene Save As... dialog box that opens, type a descriptive name in the
Scene Name text box.

3. Click the Ok button to confirm.

Scene Save as... panel Context Menu

Right-click in the Scene Save as panel to open its context menu. Select from:

• Rename: Rename the selected folder

• Delete: Delete the selected folder

• Create Sub Project: Create a new sub Project folder in the selected Project folder

• Create Sub Folder: Create a new sub folder in the selected folder

• Add to Bookmark: Add selected folder to Bookmarks

• Delete from Bookmark: Delete selected folder from Bookmarks

• Switch Folder Highlighting OFF/ON: Set highlighting of folders to ON or OFF. For
example, if a folder (and sub-folders) contain a Scene it will be highlighted when the
Scene tab is selected. This feature can also be set in the Viz Configuration (see User
Interface).
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• <Bookmark(s)>: Click on a bookmarked folder to select that folder

To undo/redo operations in a Scene

• Click the Undo/Redo button in the lower right corner of the Scene Tree panel, or

• Hold the pointer over the Scene Tree panel and press the keyboard shortcut <Ctrl
+Z/Y>.

Tip: Holding the pointer over the Undo/Redo buttons will show a text in the
status bar describing the action that is about to be performed. Also, operations
can be undone/redone although the scene has been saved. However, this is not
possible after the scene has been closed and reopened.

See Also

• Common Element Procedures

4.6.6 Working with Object Elements

An Object can be added to a Scene as a standalone Container or as a Geometry
property of a Container.

This section contains information on the following topics:

• To add an Object to a Container

To add an Object to a Container

• Drag the object from the Element List (or Favorites Bar) to either:

• The Scene Tree

• The Scene Editor (creates a new Container)

• Or add to a Container in the Scene Tree (see Adding Containers ).

See Also

• What are Objects

• Common Element Procedures

• Properties panel Geometry Editor

• Geometry Plugins

• Importing Objects

4.6.7 Working with Material Elements

When a Material has been added to a Container, the Container specific Material can
be modified in a Material Editor that opens in the Properties panel. Only the Container
specific Material will be modified, the original Material in the Graphic Hub database will
not be affected.

To create a new Material in the Graphic Hub database, see Material Editor.

See Also

• Material Editor
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• Working with Light

• Common Element Procedures

4.6.8 Working with Material Advanced Elements

This section contains information on the following procedures:

• To create a Material Advanced

• To edit a Material Advanced

To create a Material Advanced

1. From the Element List drag a Material and /or an Image to a Container in the
Scene Tree.

2. From the Built Ins drag a Shader to the same Container in the Scene Tree (if
required).

Note: A combination of at least two items (Material, Shader or Image) must
be applied to create a Material Advanced.

3. Right-click the Container in the Scene Tree.

4. Click Merge to Material Advanced.

The Material, Shader, and Image icons in the Container will then be merged into
one combined Material Advanced icon.

5. Select the project or folder where the Material Advanced should be placed (1).
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6. Drag the Material Advanced icon from the Container in the Scene Tree to the
Element List (2).

7. In the dialog box that opens, type a descriptive name for the Material Advanced.

Note: Special characters, such as space, are not allowed in Element names.

8. Click the Ok button.

To edit a Material Advanced

1. Select the project or folder where the existing Material Advanced is placed.

2. Drag the Material Advanced to a Container in the Scene Tree.

3. Right-click the Material Advanced icon on the Container.

4. In the context menu click Split Material Advanced. The Material Advanced icon
on the Container will then be replaced by separate icons for any Material, Shader,
or Image that the Material Advanced consists of.

5. Apply new items or modify the Material, Shader, or Image settings.

6. Right-click the Container in the Scene Tree.

7. In the context menu click Merge to Material Advanced. The Material, Shader,
and Image icons in the Container will merged into one combined Material
Advanced icon.

8. Select the project or folder where the Material Advanced should be placed (1).

9. Drag the Material Advanced icon from the Container in the Scene Tree to the
Element List (2).

10. In the dialog box that opens, type a descriptive name for the Material Advanced.

Note: Special characters, such as space, are not allowed in Element names.

11. Click the Ok button.
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See Also

• Common Element Procedures

• Materials Advanced

• Materials

• Built Ins

4.6.9 Working with Image Elements

This section contains information on the following procedures:

• To add an Image to the Graphic Hub Database

• To edit an image

• To export an Image(s)

To add an Image to the Graphic Hub Database

• Import Images: Images can be imported from a hard disk or a network share to
the GH database (see Importing), or

Tip: Multiple images can be imported at once.

• Create a Snapshot: Images can be created through taking a snapshot of the
Scene Editor (see Snapshot), or

• Image Editor: In the Server Tree open an Image in the Image Editor (double-click
the Image), modify (if required) and select Save as...

To edit an image

1. Double click the image to open the Image Editor.

2. In the Image Editor that opens, define the new settings.

3. Click the Save button.

To export an Image(s)

An image or multiple images can be exported.

1. Select the image(s) to be exported.

2. Open the Select Export Directory panel:

• Select Export... from the Server Menu, or (when only one image is selected)
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• Right-click the image to be exported. In the menu that opens, select Export...

3. In the Select Export Directory panel, select the folder where the image should
be exported to.

4. Select an image format for export.

Tip: When an RGB image with alpha is exported, an RGBA image will be
created.

5. Click the Ok button.

Note: The name of the exported image will be equal to the name of the original
image.

See Also

• Common Element Procedures

• Properties panel Texture Editor

• Image Editor

4.6.10 Working with Fontstyle Elements

This section contains information on the following procedures:

• To import a Font

• To edit a Fontstyle

• To create a Fontstyle

• To show/hide blur or outline Fontstyles

To import a Font
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• For information about how to import a font from a hard disk or network share to the
database see Importing.

To edit a Fontstyle

1. Double-click the Fontstyle to open the Fontstyle Editor.

2. If the Fontstyle is referenced in more than one Scene, a Conformation Panel
will open. Click Yes to confirm. Click No to cancel (see Reference Search and
Referenced Elements).

3. In the Fontstyle Editor define the new settings.

4. Click the Save button.

See Also

• Referenced Elements

To create a Fontstyle

Note: A new Fontstyle will be based on a font which already exists.

1. Double-click the Fontstyle to open the Fontstyle Editor.

2. If the Fontstyle is referenced in more than one Scene, a Conformation Panel will
open. Click Yes to confirm. Click No to cancel (see Reference Search ).

3. In the Fontstyle Editor, define the new settings.

4. Click the Save As button.

5. In the Save As... panel, type a descriptive name for the new Fontstyle in the text
box.

6. Click the Ok button.

To show/hide blur or outline Fontstyles

• Right-click a Fontstyle and select either:

• Show/Hide “-Blur-” Fonts, or

• Show/Hide “-Outline-” Fonts

See Also

• Common Element Procedures

• Properties panel Text Editor

• Fontstyle Editor
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• Importing Fontstyles

4.6.11 Working with Audio (Clips) Elements

This section contains information on the following procedures:

• To add an Audio clip to a Scene

• To import an Audio Clip

• To export an Audio clip

To add an Audio clip to a Scene

1. Add the Audio plugin (Container Plugins > Global) to a Container (see Built Ins).

2. In the Main Menu Left click on Stage.

3. Drag the Container to the Stage Tree Area.

4. In the Stage Tree right-click the Container Actor (1)

5. Click Audio > Clip (2)

6. Click on the Audio Clip Channel (3) in the Stage Editor, to open the Key Frame
panel (if not open).

7. In the Key Frame panel add an Audio Clip:

1. Click DB Clip (4).

2. Click on Server/Stage in the Main Menu Left.
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3. Select an Audio Clip from the Server Tree panel

4. Drag to the Clip drop box (5).

Tip: Also, to add an Audio Clip, click File (5) and n the Clip line (6), click the
ellipsis (...) to select an Audio clip to use.

See Also

• Animating Audio

To import an Audio Clip

• For information about how to import an audio clip (or an archive) from a hard disk or
a network share to the database see Importing.

To export an Audio clip

1. Open the Select Export Directory panel:

• Click on an Audio clip or Audio clips and select Export... from the Server Menu,
or



Viz Artist User’s Guide

Page 148 Copyright © 2014 Vizrt

• Right-click the Audio clip to be exported. In the menu that opens, select
Export...

2. In the Select Export Directory panel, select the folder where the Audio clips should
be exported to.

3. Click the Ok button.

Note: The name of the exported Audio clips will be equal to the name of the
original Audio clips.

See Also

• Common Element Procedures

4.7 Assign Keywords to Elements
Keywords are used to tag Elements in the Graphic Hub database. New keywords can be
added in the Import Display, and when files are imported to the Graphic Hub database.
Keywords can be assigned to an Element, up to 20 keywords may be assigned to one
Element.

There are four ways to assign keywords. Each method starts from a different workflow
point.

This section contains the following procedures:

• To create keywords for Elements

• To assign Keywords from the Search panel

• To assign Keywords from the Keyword panel

• To assign a Keyword while importing

• To assign Keywords from the Property Editor

• To remove a Keyword from an Element
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• To delete a Keyword

To create keywords for Elements

1. Select Import from the Main Menu Right.

Note: The Keywords panel shows when either Fonts, Images, Objects, Scenes
or Audio is selected to import in the Import Menu.

2. In the Keywords panel, type a descriptive keyword in the text box (1).

3. Click the Add button (2).

Note: The new keyword is saved and will show in the Keyword list.

To assign Keywords from the Search panel

1. Select Server from the Main Menu Left.

2. Open the Search panel:

• In the Server menu, click Search, or

• Hold the pointer over the Server area and press the keyboard shortcut <Ctrl
+F>.

3. In the Search panel that opens, click Keywords (2).

4. Search for a Keyword or Keywords (1):

• To search for all Keywords type * (an asterisk) in the text box, and press
<Enter>, or

• To search for a specific Keyword type the name of the Keyword in the text box,
and press <Enter>.
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5. Drag one or more Keywords from the Search panel to an Element or selected
Elements in the Element List.

6. Click Yes to confirm.

Note: To view assigned Keywords on an Element, right-click an Element and click
on Show Keywords... from the context menu.

Tip: Keywords can be assigned to multiple Elements at once. To do so, first select
the Elements in the Element List, and then select the keywords in the Search
window. Next, drag the keywords onto the Elements. In the dialog box that opens,
confirm the assign operation.

To assign Keywords from the Keyword panel

Note: This procedure assumes that there is at least one Element in the Server
area.

1. Select Import from the Main Menu Right.

2. In the Keywords panel search for a Keyword or Keywords (1):

• To search for all Keywords, type * (an asterisk) in the text box, and press
<Enter>, or

• To search for a specific Keyword, type the name of the Keyword in the text box,
and press <Enter>.

3. Select a Keyword(s) (2).

4. Drag the selected keywords to the Element or selected Elements in the Server
area.

5. Click Yes to confirm.

Tip: If the list of Keywords, in the left panel, is long, scroll and tick the required
Keywords so that they show in the right panel. From the generated Keyword list in
the right panel, highlight them all and drag to the Element.
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To assign a Keyword while importing

1. Select Import from the Main Menu Right.

2. In the Import panel, select the file or files to be imported.

3. Search for a Keyword or Keywords (1):

• To search for all Keywords, type * (an asterisk) in the text box, and press
<Enter>, or

• To search for a specific Keyword, type the name of the Keyword in the text box,
and press <Enter>.

4. Select a Keyword or Keywords (2):

• Click in the [ ] (to the left of each Keyword) to select a Keyword (the selected
Keywords show in the right side panel), or

• Click on one or more keywords and drag to the right side panel.

5. Drag the selected Elements to their location in the Server area.

Note: To view assigned Keywords on an Element, right-click an Element, in the
Server area, and click on Show Keywords... from the context menu.

To assign Keywords from the Property Editor

Note: The source and destination Element must be in the same folder.

1. In the Server area, right-click the source Element.
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2. Select Show Keywords...

3. In the Keywords tab click the desired Keywords, and drag to the required Element
in the Server Area.

Note: When more than one source Element is selected, and they all have
a common keyword, only that common keyword will show in the Keywords
panel.

4. Click Yes to confirm.

To remove a Keyword from an Element

1. In the Server area, right-click the Element with the Keyword to be deleted.
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2. Click Show Keywords...

3. Click the Keyword(s) to be deleted.

4. Drag to the Trash Can.

5. Click Yes to confirm.

To delete a Keyword

1. Select Import from the Main Menu Right.
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Note: The Keywords panel is not available if Archives to Import is selected in
the Import file dropdown menu.

2. In the Keywords panel search for a Keyword(s) (1):

• To search for all Keywords, type * (an asterisk) in the text box, and press
<Enter>, or

• To search for a specific Keyword, type the name of the Keyword in the text box,
and press <Enter>.

3. Select a Keyword(s) (2), and drag to the Trash Can.

4. Click Yes to confirm.

Note: Keywords can only be removed from Viz Graphic Hub if they are not
assigned to any files.

4.8 Image Editor
The Image Editor makes it possible to modify Image Elements in the Graphic Hub
database. Individual editors are also available for Materials (Material Editor) and
Fontstyles (Fontstyle Editor).

The modifications that can be done in the Image editor are similar to the ones in other
image editing software.

The Image Editor consists of:

• Image General Information (1)

• Effect Modifications (2)

• Effect Preview (3)
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• Main Image Area (4)

• Effects (5)

To open an image in the Image editor

• Double-click the image in the Server Area to open the image in the Image editor.

If an image is referenced in a Scene, a dialog box will show to confirm the action or not
(see Referenced Elements).

Note: An Element that is opened in an editor, is locked in the database (see
Active Elements).

This section contains information on the following topics:

• General Image Information

• Image Effects

• Apply and Preview Effects

4.8.1 General Image Information

The upper left corner of the Image editor shows general information about the image:

• Name: Shows the image name.

• Size: Shows the image size in pixels.

• Format: Shows the image format (RGBA, RGB, or Alpha).

Click the format buttons to view the image various formats, if available.

Note: All images are treated as RGB or alpha format. An imported image that
has alpha can be viewed as either RGB or alpha. Modifications to an image are
automatically applied to the RGB or alpha information.

Image Effects
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The following effects can be applied to an image. To view the effect properties and see
changes made, see Apply and Preview Effects:

• Alpha: Makes the image transparent.

Note: This option only applies for alpha format images.

• Blur: Creates a blurred image.

• Charcoal: Creates a posterized, smudged effect by redrawing the image. Major
edges are boldly drawn, while mid tones are sketched using a diagonal stroke.

• Radius: The smaller the radius the more details will be seen.

• Sigma: Effects the sharpness of the image.

• Color Gamma: Adjusts the color tones of the image.

• Contrast/Hue: Adjusts the brightness, saturation, and hue settings for the image.

• Convert Format: Changes the format of the image to one of the following:

• RGB

• RGBA

• Alpha

• Luminance

• Luminance Alpha

Note: The current format is grayed out.

Crop and add effects in Image editor
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• Crop and Add: The image can be cropped according to the values in the input
boxes. The values can be entered manually, or the standard TV format buttons can
be used.

• Left: Crops the image the specified number of pixels from the left side of the
image border.

• Right: Crops the image the specified number of pixels from the right side of the
image border.

• Top: Crops the image the specified number of pixels from the top of the image
border.

• Bottom: Crops the image the specified number of pixels from the bottom of the
image border.

• PAL Analog: Crops the image to a resolution of 768x576 pixels.

• PAL Digital: Crops or adds the image to a resolution of 720x576 pixels.

• NTSC Analog: Crops or adds the image to a resolution of 640x486 pixels.

• NTSC Digital: Crops or adds the image to a resolution of 720x486 pixels.

• Edge: The Edge filter searches for borders between different colors and detects
contours of objects:

• Radius: A low value results in black, high-contrasted image with thin edges. A
high value results in thick edges with low contrast and many colors in dark areas.

• Emboss: Makes the color at a given location of the filtered image correspond to the
rate of color change at that location in the original image.

• Angle: Defines the direction of the embossment.

• Value: Defines amount of effect.

• Flip:

• Flip Vertical: Flips the image upside down. To flip it back to its original settings,
click the button again.

• Flip Horizontal: Flips the image horizontally as if seen in reverse/through a
mirror. To flip it back to its original settings, click the button again.

• Gaussian Blur: The visual effect of this blurring technique is a smooth blur
resembling that of viewing the image through a translucent screen. It adds low
frequency detail and can produce a hazy effect to the image.

• Range: Affects the blur spread (not much visible since same effect may be
achieved by configuring ‘value’ parameter)

• Blur Value: Amount of blur

• Gamma: Gamma measures the brightness of mid tone values produced by a device
(often a monitor). A higher gamma value yields an overall darker image.

• Invert: Inverts the colors of an image. When inverting an image, the brightness
value of each pixel in the channels is converted to the inverse value on the 256-step
color values scale.

Example: A pixel in a positive image with a value of 255 is changed to 0, and a
pixel with a value of 5 to 250.

• Postarize: Effects the saturation of the image

• Level (%): Amount of the effect, at high values image becomes completely
black and white

• Quantize Colors: Reduces the number of colors in the image.
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• Rotate: Rotates the image according to the specified number of degrees.

• Scale: Scales the image based on either size (percent) or width/height (pixels).

• Solarize: Blends a negative and positive image, similar to exposing a photographic
print briefly to light during production.

• Spread Pix: Creates a dissolving effect for the image pixels

• Stretch: Stretches the image based on either width/height in pixels or percent.

• Swirl: Swirls the image more sharply in the center than at the edges. Specifying the
degree produces a swirl pattern.

• Wave: Creates an undulating pattern on the image, like ripples on the surface of a
pond.

• Amplitude: Defines the height of the waves.

• Wavelength: Defines the width of the waves, the distance from one wave crest
to the next.

4.8.2 Apply and Preview Effects

Various effects can be selected from the Image Effects. The selected effect can then
be modified in the Effect Modification area (1) and the result viewed in the main image
area, or previewed (2).

The Effect Modification area has two common buttons, which apply to most effect
settings:

• Preview: Shows a preview of the changes in the image preview area (2).

• Apply: Applies the changes to the image.

Note: Some effect modifications apply directly to the image in the main image
area.

To apply an effect to an Image

1. Select an effect from the Image Effects list.

2. Make modifications to the effect as required in the Effect Modification area. In
most cases use the Preview area to view the effect on the image.

3. Add other effects as required.

4. Click Save or Save as...

4.9 Fontstyle Editor
The Fontstyle Editor makes it possible to modify Fontstyle Elements in the Graphic
Hub database. Individual editors are also available for Materials (Material Editor) and
Images (Image Editor).
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Viz Artist uses Fontstyles to show text in Scenes. When a Font is imported into the
Graphic Hub database, Viz Artist imports the base font and creates up to eight different
Fontstyles:

• One Fontstyle which looks like the base font (1)

• Up to four Fontstyles in different blur levels (2)

• Up to three Fontstyles using only the outline of the base font (3)

Tip: The number of blur levels and outlines for each Fontstyle can be defined from
the Font Options section of the Configuration.

Tip: The Outline and Blurred Fontstyles can be hidden or shown in the Server Area
(see To show/hide blur or outline Fontstyles).

Fontstyle editor imported Fontstyles can be modified through the use of Modifiers. For
example, a Fontstyle can be modified to reflect a corporate identity.

As Viz Artist uses an open interface for the plugins used as modifiers, almost any
modifications can be applied to a Fontstyle. New Fontstyles can be created based on
existing Fontstyles through the Save As... operation.

The Fontstyle editor consists of:

• Available Modifiers (1)

• Properties of previewed text (2)

• Preview of the modifications (3)

• Modifier parameters (4)

Note: The properties help to illustrate how the modifications will look like in a
Scene. Changes made on the right side of the editor, for example kerning and
material, will not be saved with the Fontstyle. However, there is one exception
from this rule. If the kerning between two fixed characters are modified, this is
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saved with the Fontstyle. To create a kerning between two fixed characters, use
the keyboard shortcuts <Alt+LEFT ARROW>/<Alt+RIGHT ARROW>.

To open a Fontstyle in the Fontstyle editor

• Double-click the Fontstyle in the Server Area to open it in the Fontstyle editor.

If a Fontstyle is referenced in a Scene, a dialog box will show to confirm the action or
not (see Referenced Elements).

Note: An Element that is opened in an editor, is locked in the database (see
Active Elements).

This section contains information on the following topics:

• Available Modifiers

• Modifiers

• Modifier Parameters

• Preview Menu

• Fontstyle Viewer

• Fontstyle Viewer Menu

• Fontstyle Viewer Bar

• To open a Fontstyle in the Fontstyle editor

4.9.1 Available Modifiers

The available modifiers selected in from the Pool menu, which is positioned at the top
left of the Fontstyle editor.

• Font: Show all the Fontstyles in the database.

• Material: Show all the Materials in the database.

• Image: Not available

• Modifier: Show all available modifiers that can be applied to the Fontstyle.

Modifiers

Modifiers are used to change either the texture or the geometry of a Fontstyle, or both.
A fixed set of modifiers come with a standard Viz Artist installation, but the system
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provides an open connection, so that additional modifiers can be obtained or created
and added as plugins.

A modifier that is applied to a Fontstyle is automatically enabled. An enabled modifier
implies that modifications will be reflected in the preview area. When adding multiple
modifiers, the overview in the preview area can get confusing, and it may be necessary
to disable one or more modifiers.

Modifier Parameters

The Modifier parameters menu is positioned in the middle left part of the Fontstyle
editor.

• Modifier: Shows the properties for the modifier that is selected.

• Global Settings: Shows various properties for the Fontstyle.

• Font Default Style: Defines the font default style. Options are Geometry or
Texture.

• Shadow Default Style: Defines the shadow default style. Options are
Geometry or Texture.

• Texture Quality: Defines the quality of the texture. Options are Low, Normal, or
High.

Note: The texture quality cannot be changed in a text editor.

4.9.2 Working with Modifiers

This section contains information on the following procedures and topics:

• To add a modifier to a Fontstyle

• To edit a modifier

• To enable/disable a modifier

• To remove a modifier from a Fontstyle

• Blur

• Color Per Vertex

• Contour Bold

• Extrude
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• Italic

• Outline

• Preview Menu

• Fontstyle Viewer

• Fontstyle Viewer Menu

• Fontstyle Viewer Bar

To add a modifier to a Fontstyle

1. Select Modifier from the Available Modifiers.

2. Drag the modifier from the list of available modifiers (top left) to the Modifier bar
(bottom left, above the Trash Can).

3. Click the Save button.

To edit a modifier

1. Select the modifier in the Modifier bar (bottom left, above the Trash Can).

2. Define the values for the modifier.

3. Click the Save button.

To enable/disable a modifier

• Click the property switch next to the modifier icon in the Modifier bar  .

To remove a modifier from a Fontstyle

1. Drag the modifier from the Modifier bar to the Trash Can.

2. Click the Save button.

Blur

 Use the Blur modifier to blur a Fontstyle in texture mode.

• Level: Sets the blur level.

• White Level: Sets the white level in the blur effect.

Color Per Vertex

 Use the Color Per Vertex modifier to change the color of Fontstyles by applying it to
the vertices.

The circles in the Color Per Vertex modifier represent the four corners of the Fontstyle
text:

• Click a circle to edit its color values.

• Click on a line that connects two circles to select both circles
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• Hold <Ctrl> and click to select multiple circles.

• Colors can also be dragged from one circle to another.

• Color Level: Defines how much color should be applied.

• Color Box:

• Local: Applies the color to the vertices of every single character.

• Max BB: Applies the color to the vertices of the bounding box.

• Z Active: If the Extrude modifier is used in addition to Color Per Vertex, the colors
can be changed both in the front and back. If no such modifier is applied, only the
colors in the front can be edited.

• Use Alpha: Show where the color should include. For example if Alpha is enabled
and the bottom right alpha is set to 0 the characters will fade out the bottom right.

• Debug: Draws the actual color points to see and understand how color changes
effect the characters.

Contour Bold

 Use the Contour Bold modifier to change the bold level of Fontstyles, which makes it
appear thicker or thinner.

• Bold Level: Defines the bold level of a Fontstyle. The higher the value, the bolder
the Fontstyle.

Extrude

 Use the Extrude modifier to extrude a 2D Fontstyle in the Z-axis, resulting in a 3D
Fontstyle with front, back, and sides.
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An extrusion can be explained simply as sweeping the 2D Fontstyle through space
along its Z-axis. The sweeping path the outline of the Fontstyle follows during this
process is used to create a surface.

The nine icons marked with different bevel types are used to set the type of bevel on
the Fontstyle.

• Extrusion Depth: Defines the depth of the extrusion along the Z-axis.

• Bevel Size: Defines the size of the bevel.

• Shading Angle: Defines the angle of the shading function. To remove unevenness,
increase the shading angle.

• Bevel Detail: Defines the degree of bevel detail. The lower the value, the more
detailed the bevel is constructed and the smaller tilings it is constructed from.

Note: The Bevel Detail option is only available for certain bevel types.

• Backface: Enables or disables visualization of the backface.

• Active/Inactive: If colors are set to Active, the front, back, and side colors of the
Fontstyle can be applied.

Italic

 Use the Italic modifier to create a cursive appearance of a Fontstyle.

• Level: Defines the cursive level of a Fontstyle. The higher the value, the more tilted
is the text.

• Debug: Draws the actual color points to see and understand how color changes
effect the characters.

Outline
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 Use the Outline modifier to create an outline of a Fontstyle.

• Outline Level: Defines the width of the outline level. The higher the value, the
bolder the outline of a Fontstyle.

• Debug: Draws the actual color points to see and understand how color changes
effect the characters.

4.9.3 Preview Menu

The Preview menu is positioned at the top right of the Fontstyle editor.

Note: Only the applied modifiers will be saved with the Fontstyle, not the settings
described here. These settings are only used to give an overview of how the
Fontstyle will look like when being used.

• Text Properties: To preview how the Fontstyle will look like with different settings,
for example kerning, orientation, and content, select Text Properties from the
Preview menu and modify the properties. For more information, see Text Editor .

• Text Material: To preview how a Material would look if used on the Fontstyle, select
Text Material from the Preview menu. In the Material Editor that opens, select a
color (see Working with Material Elements ).

Tip: To use a Material already from the database, select Material from the
Available Modifiers in the Pool menu, select a Material and drag to the color icon in
the Material Editor of the Fontstyle.

• Scene Background: To preview how a background color would look like if used
together with the Fontstyle, select Scene Background from the Preview menu,
and then select a color. The scene background feature provides a better contrast,
especially for drop shadows.
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4.9.4 Fontstyle Viewer

To visualize how the Fontstyle will look like when being used in scenes, the Fontstyle
viewer in the lower right part of the Fontstyle editor shows a preview of the Fontstyle.

Additionally to the customizable text in the Fontstyle viewer, the two words Texture
and Geometry will be displayed. These words show the modifications performed to
Texture and/or Geometry applied by the modifiers, without reflecting the changes in
the properties. For example, if kerning is applied to the customizable text, this will not
be reflected in the Texture or Geometry texts.

The customizable text reflects either the Texture or Geometry text type, which is
selected in the Global Settings, available from the Modifier Parameters.

Fontstyle Viewer Menu

Right-clicking the Fontstyle Viewer opens a menu, similar to the menu in the Scene
Editor, see Working with the Scene Editor .

Fontstyle Viewer Bar

At the left side of the Fontstyle Viewer is the Fontstyle Viewer bar. The bar contains the
following icons:

• R: Resets the position, rotation, and scaling for the three Elements in the Fontstyle
viewer.

• SG: Shows/hides text with geometry style.

• ST: Shows/hides text with texture style.

• L: Enables/disables additional light.

• W: Switches on/off wire frame mode.

• BB: Switches on/off the bounding box visualization.

4.10 Material Editor
The Material editor is used to create and modify materials with customized colors and
Lights effects.

The icon in the upper right corner of the Materials Editor (1) shows the current state
of the Material. The color for a lit object is shown on the sphere within the icon, while
the three parts around the sphere show the plain color for an object that is not lit.
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For information about the various effects and types of lights that can be applied to a
material, see Working with Light.

When a Material has been added to a Container, the Container-specific Material can be
modified in the Material Editor that opens in the Properties panel. Only the Container-
specific Material will be modified, the original Material in the Graphic Hub database will
not be affected (see Working with Material Elements).

This section contains information on the following topics:

• Create a Material

• Material Color Properties and Schemes

See Also

• Lights

• Working with Material Elements

4.10.1 Create a Material

To create a new Material and save it, use the procedure detailed below:

To create a new Material

1. Click Server.

2. Click the M (Materials) tab.

3. Right-click and select Create new material.

4. Enter a name for the new Material

5. Click OK.

6. In the Server area double-click the new Material to open the Material Editor.



Viz Artist User’s Guide

Page 168 Copyright © 2014 Vizrt

7. Adjust the Material Color Properties and Schemes as necessary.

8. Save any changes:

• Save: Saves the material in the Viz Graphic Hub.

• Save As: Creates a new Material in the Viz Graphic Hub. In the Save As dialog
box that opens, type a name for the Material and select a destination folder.

• Close: Closes the Material editor without saving the changes.

4.10.2 Material Color Properties and Schemes

This section contains information on the following topics:

• Material Color Properties

• Material Base Color

• To change a Material Color

Material Color Properties

• Shininess The shininess defines how spread out the highlighted area is. The
lower the value, the more spread out the shine; the higher the value, the more
focused the shine on a single point. However, if Specular is black (all values 0) then
shininess does not have any visible effect.

• Alpha The alpha value can be set directly on a material to adjust the level of
transparency.

Viz Artist uses schemes to describe the colors of a material.

• Ambient The area which is not directly lit by any light source. Ambient light
surrounds the object and the color looks the same on every side. Since the light
does not come from any direction, but instead from “all” directions, the color/light
spreads evenly over the object.

• Diffuse The object’s “core color” observed under “normal” lightening conditions.
Shows the color of an object when illuminated by a directional light source. It
spreads evenly over the object. Light normally has some level of diffusion.
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• Specular Shows the color that appears when light comes from a particular direction
and bounces back from the surface in a mirrored direction. The specular color is
in fact the direct reflection of a directional light source. This is the typical effect of
shiny metal and plastic. Specular color can be understood as a kind of shininess
color.

• Emission Emissive color is produced by an object’s natural glow. The object itself is
the light source illuminating the color. The emissive color is unaffected by any other
light sources and does not produce any light for other objects in the scene.

Material Base Color

If the Material icon in the Property area (1) is disabled it causes the object’s base color
to be shown. This is a color without any shading and it is not influenced by light, which
means that it is visible even if there are no active light sources.

Its initial color is created through a conversion of the material RGB components, but
the values can be modified afterwards.

Material Enabled and Disabled

To change a Material Color

1. In the color selection area (1) select RGB or HSV.
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2. In the color selection area, click a color bar, or the color circle, and drag to change
the color.

Tip: For RGB only: Right-click on the color sliders and drag to lock all three sliders,
so that all values can be changed at once.

or

1. Click on the eye dropper icon in the color field.

2. Move the cursor to pick a color from anywhere on the screen.

3. Click to accept the new color.

or

• Click a numeric input box and enter a color numeric value.

Tip: Click and hold in the input box and drag left or right to adjust the value.

Tip: Click in the input box and use the up and down arrow keys to adjust the value
by a factor of 1. Press and hold the <Alt> key and use the up and down arrow
keys to adjust the value by a factor of 10.

4.11 Element Search

Elements can be searched based on various criteria. Four Search editors are located in
the upper part of the Search window. Searches can be based on four different criteria:

• Property Search

• Reference Search

• Keyword Search

• Directory Search

• Combination Search

Tip: Up to three search criteria can be combined in one search request. The
search will be performed using a logical AND of the selected criteria

This section contains information on the following topics:

• Search Panel

• Search Parameters Area

• Search Menu

• Property Search

• Reference Search

• Property Search

• Reference Search

• Keyword Search
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• Directory Search

• Combination Search

• Search Result Area

• Search String Syntax

See Also

• Working with Elements

4.11.1 Search Panel

The Search window is divided in two areas:

• Search Parameters Area (1)

• Search Result Area (2)

To open the search panel

1. Click Server in the Main Menu Right.

2. Open the Search panel:

• In the Server Menu, click Search, or
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• Hold the mouse pointer over the Server Area and use <Ctrl+F>.

See Also

• Search Parameters Area

• Property Search

• Reference Search

• Keyword Search

• Directory Search

• Combination Search

• Search Result Area

4.11.2 Search Parameters Area

The Search parameters area is positioned at the top of the Search panel.

• Search (1): Click to start a search.

•  Close All Editors (2): Close all search editors.

•  New Search (3): Clear all settings to start a new search.

See Also
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• Search Panel

• Property Search

• Reference Search

• Keyword Search

• Directory Search

• Combination Search

• Search Result Area

4.11.3 Search Menu

The Search menu is positioned at the top of the Search parameters area. Select an
Element type from the menu to narrow the Element search. If, for example, ‘Image’ is
selected, only search hits that are Images will be listed. Clicking ‘All’ on the menu will
not narrow down the search, but show hits from all Element types. ‘All’ is selected by
default.

See Also

• Search Panel

• Search Parameters Area

• Property Search

• Reference Search

• Keyword Search

• Directory Search

• Combination Search

• Search Result Area
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4.11.4 Property Search

This editor searches the database for Elements based on the property values entered.

•  Properties Reset: Clear the settings in the Properties editor to start a new search.

•  Close Property Search: Close the Properties editor.

• Name: Search for Elements with a specified name.

• Click the asterisk to search with an asterisk wildcard at the start and end of the
text string. With the asterisk disabled, only the exact search string is used.

• Creation Date: Search for Elements that were created in a specified time period.

• Modification Date: Search for Elements that were created in a specified time period.

Note: The creation and modification dates can be set to; Today, 1 day, 1 week, 2
weeks, 1 month, or Older.

• Owner: Search for Elements that were created by a specified user.

• User: Search for Elements that were last modified by a specified user.

Wildcard Text Description

If the full Name is not known then text Wildcards can be used to make a search:

• *: Match any characters. For example "Element*"

• ?: Match any single character. For example "El?me?t"

• [ ]: Match a range or a list of characters:

• "Elem[b-g]nt", or

• "Elem[shje]nt".

See Also

• Search Panel

• Search Parameters Area

• Search Menu

• Reference Search

• Keyword Search
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• Directory Search

• Combination Search

• Search Result Area

4.11.5 Reference Search

Note: All graphic Elements stored in Viz Graphic Hub have a Universally Unique ID
(UUID). To view an Element’s UUID see the Properties Panel.

Any Element can reference to any other Element in Viz Graphic Hub (see Referenced
Elements). To find out where any given Viz Graphic Hub Element is used, use search by
Reference.

Search by reference can be used to search for:

• Which objects use the selected object(s)

• Which objects are used in the selected object(s)

This section contains information on the following topics and procedures:

• Reference Search Menu

• To search for all referenced Elements on one Element

• To search for all referenced Elements on two or more Element(s)

• To delete an Element from a search by reference

• To search all references on one Element (context menu)

Reference Search Menu

Note: It is possible to add multiple Elements to the References editor.
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•  Searches for Elements (Objects) which reference to the selected Elements
(Objects), for example, Images, Geometries, Fonts, etc.

•  Searches for Elements (Objects) which are referenced by the selected Elements
(Objects), for example, Images, Geometries, Fonts, etc.

•  Performs a logical AND search of the Elements that are added. The result must be
in all searched Elements.

•  Performs a logical OR search of the Elements that are added. The result must be
at least one of the searched Elements.

•  Clears the settings in the References editor, so that a new search can be
performed.

•  Closes the References editor.

To search for all referenced Elements on one Element

1. Open the Search panel:

• Click on Search... in the Server Area drop down menu, or

• With the mouse pointer over the Server Area, press <Ctrl+F>

2. Click on References in the Search Panel (2)

3. Select an Element in the Server Area (1).

4. Drag the Element to the search area.

5. Select to search by:

•  Which objects use the selected object(s)

•  Which objects are used in the selected object(s)

6. Click on the Search button (3).

To search for all referenced Elements on two or more Element(s)
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A Reference search can also be completed on more than one Element or Element type.

1. Open the Search panel:

• Click on Search... in the Server Area drop down menu, or

• With the mouse pointer over the Server Area, press <Ctrl+F>

2. Click on References in the Search Panel (2)

3. Select Element(s) in the Server Area (1).

Note: Select from all available Element types, except Materials.

4. Drag the Element(s) to the search area.

5. Specify the search criteria:

•  Search only for references common to all selected Elements

•  Search for references in all selected Elements

6. Select to search by:

•  Which objects use the selected object(s)

•  Which objects are used in the selected object(s)

7. Click on the Search button (3).
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To search all references on one Element (context menu)

1. Click on the Element.

2. Do a right-click on the Element to open its context menu.

3. Click Search Reference...

4. The Search Panel opens and shows any Elements which reference the selected
Element.

To delete an Element from a search by reference

1. In the Search Panel right-click the element to be removed.

2. Select Delete from Reference Search.

See Also

• Search Panel

• Search Parameters Area

• Search Menu

• Property Search

• Keyword Search
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• Directory Search

• Combination Search

• Search Result Area

4.11.6 Keyword Search

This editor searches the database for Elements based on keywords.

•  Do a logical AND search of the keywords that are added. The result must be in all
searched Elements.

•  Do a logical OR search of the keywords that are added. The result must be in at
least one of the searched Elements.

•  Clear the settings in the Keywords editor, to start a new search.

•  Close the Keywords editor.

Tip: Keywords can be assigned to Elements from the Search window. To do so,
select the keywords by highlighting them, and then drag them onto an element in
the Server area. For more information, see Working with Elements .

To search for a keyword

1. Type the keyword in the input box.

2. Press <Enter>.

3. Put the required Keyword in the bottom panel:

• Click and drag the desired keyword to the bottom panel, or

• Click inside the parentheses ([ ]), to the left of the required keyword.

4. Click the Search button. The keyword search is based on the keywords that have
been moved into the bottom panel.

See Also

• Search Panel

• Search Parameters Area

• Search Menu

• Property Search
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• Reference Search

• Directory Search

• Combination Search

• Search Result Area

4.11.7 Directory Search

The directory search editor narrows down a search to a selected folder.

•  Expands the currently selected branch and all its sub-branches.

Note: A branch that can be expanded has a Plus icon to the left of the folder
name.

Tip: A branch can also be expanded by clicking the Plus icon  to the left of the
folder name, but this will not expand the sub-branches.

•  Collapses the currently selected branch and all its sub-branches.

Note: A branch that can be collapsed has a Minus icon to the left of the folder
name.

Tip: A branch can also be collapsed by clicking the Minus icon  to the left of the
folder name.

•  Refreshes the tree.

•  Searches for Elements in the selected folder, and recursively in all sub-folders.
When disabled, the search is performed in the selected folder only.

•  Closes the Directories editor.
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To search for Elements in Directories

1. Click on the Directories button.

2. Select a folder from the tree.

3. Click the Search button.

Note: If no other search criteria has been entered, when the Search button is
clicked the search will show all Elements in the selected folder (including sub-
folders).

4.11.8 Combination Search

With a Combination search, searches can be further refined.

A combination search uses up to three search parameters to search the Graphic Hub
database. Select from:

• Property Search

• Reference Search

• Keyword Search

• Directory Search

Click on each required search parameter in the Search Panel.

In the example above, the search will be for files that contain the word Text which is in
the Vizrt project folder and sub-folders, and also has a keywords image and lighter
assigned.

See Also

• Search Panel

• Search Parameters Area

• Search Menu

• Property Search

• Reference Search

• Keyword Search

• Search Result Area
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4.11.9 Search Result Area

The Result area is positioned at the bottom of the Search window and shows all search
results.

Note: A double-click an Element in the Result area will also select the Element in
the Server area.

To use searched Elements

Note: To select more than one Element press and hold <Ctrl> and click on each
required Element.

Note: The search panel will stay in the foreground until it is closed.

Click on an Element(s) in the Results panel and drag directly to various areas where the
Element can be used, i.e.:

• The Scene Tree, or

• The Favorites Bar , or

• The Scene Editor, or

• The Container Editor

IMPORTANT! Be careful when moving a linked element, as the element will be
moved from the first folder found to the new destination.

To copy elements

1. Click on an Element(s) in the Results panel

2. Press <Ctrl> and drag the Element(s) from the Result area to the target folder in
the Server area.

To create a folder link

1. Click on an Element(s) in the Results panel.

2. Press <Alt> and drag the Element(s) from the Result area to the target folder in
the Server area.

Result Menu
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The Result area menu is positioned at the top of the Result area and it defines the
appearance of the search results.

• Detail: By default, Elements are presented in the Result list with thumbnail and
Element name. A vertical list shows, with the additional information of date of
creation and user name of element owner.

Note: Click on the ‘I’ column to enable or disable thumbnails.

Thumbnails enabled

• Show Properties: Shows the Properties Panel at the right side of the Result area,
with the File Info tab selected.

• Keep Result: Keeps the current results in the Result list, while a new search is
done. The results from the new search will be added to the list.

• Clear Result List: Clears the Result list.

4.12 SmartView Search

Note: This feature is only available with Viz Graphic Hub version 2.2 and up.

A more comprehensive search can be done with the SmartView feature. A SmartView
search includes any or all of the following:

• File names

• Folder names

• File owners

• File UUID (if enabled in Viz Graphic Hub)

• File type (Geometry, Fontstyle, Images, etc.)
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• Assigned keywords

In the Entries column (1) SmartView Search text strings can be saved to use again,
and the results of a Smart Search can be saved in File Sets which are a collection of
Elements saved under an assigned name:

•  Saved SmartView Searches

•  File Sets

The SmartView search results are shown in the Server area (2). From the Server area:

• Objects can be dragged directly to where they are needed.

• Double-click on folders to view sub-folders and contents.

• Right-click an object and select Jump to Server View to change the Entries column
into the Viz Graphic Hub hierarchy. The object is then seen in its home directory.

This section contains information on the following topics:

• Search String Syntax

• SmartView Searches

• File Sets

See Also

• Element Search

4.12.1 Search String Syntax

SmartView search string syntax is very similar to Google search string syntax.

Example: jessi scene -project -folder

In the above example, the search will be conducted on any file names, file owners,
UUIDs file types, and keywords that include the string jessi and scene. This search
excludes project folders and folders, plus any of the other searched items that include
the words project and folder.

Example: francesca -image -geom
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In the above example, the search will be conducted on any file names, file owners,
UUIDs, file types and keywords that include the string francesca. This search excludes
images and geometries, plus any of the other searched items that include the words
image and geom.

Search String Builder Buttons

The SmartView search user interface includes a number of buttons that help build
search strings.

Click the Expand button (1), to show the builder search buttons. Click on a button to
show or not show a builder search option:

• Scenes

• Objects

• Materials

• Mat. Adv. (Materials Advanced)

• Images

• Fonts

• Audio

• Project

• Folder

Builder search buttons can also be fast selected. Click on an builder search button with:

• <Ctrl+Click>: Selects all

• <Shift+Click>: Deselects all

• <Alt+Click>: Only show the clicked builder search button

The buttons selected will refine the SmartView search for those particular items.

See Also

• SmartView Searches

• File Sets

4.12.2 SmartView Searches

To use the SmartView search use the procedures detailed below:

• To do a SmartView search

• To save a SmartView search

• To use a saved SmartView search string

• To view previous SmartView searches

To do a SmartView search
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1. Click Server.

2. Click the <Username>s View tab.

3. In the Free Text field, enter a search string (see Search String Syntax and Search
String Builder Buttons).

4. Click the Go button or press <Enter>.

To save a SmartView search

1. Drag the Free Text icon into the Entries column to the left of the SmartView area.

2. When prompted, give the search string a name and press <Enter>.

To use a saved SmartView search string

1. Click on a saved search in the Entries column. The saved search is entered in the
Free Text field.

2. Click on Go.

or

• Double click a saved search string the Entries column. The saved search is entered
in the Free Text field and search beings automatically.

To view previous SmartView searches

• Click the arrow to the right of the Free Text field to view all SmartView searches
since Viz Artist was launched.

See Also

• Search String Syntax
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• File Sets

4.12.3 File Sets

File sets are a collection of objects saved under an assigned name. File sets are unique
to each user on each instance of Viz Graphic Hub. Placing objects and folders in a file
set does not move them from their location in Viz Graphic Hub hierarchy; rather it just
makes them all accessible from the SmartView tab.

This section contains information on the following topics:

• To save a SmartView file set

• To add files to a SmartView file set

• To remove files from a SmartView file set

• To add an empty SmartView file set

• Entries Column Context Menu

To save a SmartView file set

1. Select all desired objects from a search result and drag them into the Entries
column.

2. When prompted, enter a name for the file set

3. Click on OK.

To add files to a SmartView file set

• Select all desired objects from a search result and drag them into the target file set
in the Entries column.

To remove files from a SmartView file set

1. In the Entries column, click the relevant SmartView file set.

2. In the result area, select the desired objects

3. Remove the selected results from the SmartView file set:
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• Drag the objects to the Trash Can, or

• Right-click the objects and select Delete from SmartView list.

To add an empty SmartView file set

1. Do a right-click in the Entries column.

2. Select Add...

3. Enter a name for the new Smart Search file set.

4. Click OK.

Entries Column Context Menu

Highlight a Saved search or a file set and right-click to open a context menu.

• Rename: Rename the highlighted Saved search or file set.

• Delete: Delete the highlighted Saved search or file set.

• Add...: Add a new File Set.

4.13 Built Ins
In Built Ins there are a standard set of Viz Artist installation plugins.

Most plugins can be added to Containers, except, for example, Scene plugins. Because
Viz Artist uses an open interface for the plugins, new geometries can either be
obtained or created and then installed with Viz Artist. Also, most plugins have a
properties editor.

When a plugin is applied to a Container, in the Scene Tree, a plugin icon will show in
the target Container (see Container Icons).

The Built-Ins button on the Main Menu Left gives access to the various plugins:

• Geometry Plugins

• Container Plugins

• Shader Plugins

• Scene Plugins

• Texture Sources

This section contains information on the following procedures:
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• Plugin Context Menu

• View and Search for Plugins

• Add Plugins to a Containers

4.13.1 Plugin Context Menu

A right-click on a plugin icon to open the plugin context menu.

This section contains information on the following procedures:

• Geometry, Container and Shader Menu

• Scene Menu

• Texture Source Menu

Geometry, Container and Shader Menu

• Add to Container(s): Add the selected plugin to a Container(s)

• Add as Favorite: Add the selected Texture to the Favorites Bar.

• Delete from Favorites: Delete the selected Texture from the Favorites Bar.

Scene Menu

• Add to Scene: Add the selected plugin to a Scene

• Remove from Scene: Remove the selected plugin from a Scene

Texture Source Menu

• Add <Texture name> as Texture: Add the selected source to the Scene
(automatically added to a Container and switched to Texture in the Video editor (see
Scene Settings).

• Add <Texture name> as DVE: Add the selected source as DVE.

• Show settings of <Texture name>: Show the settings in the Video editor (see
Scene Settings).
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• Add as Favorite: Add the selected source to the Favorites Bar.

• Delete from Favorites: Delete the selected source from the Favorites Bar.

4.13.2 View and Search for Plugins

This section contains information on the following procedures:

• To view plugins

• Add Plugins to a Containers

• Plugin Context Menu

To view plugins

1. Click Built Ins on the Main Menu Left.

2. Select the appropriate plugin category, either:

• From the drop-down menu that shows above the plugins view, or

• Click on of the tabs (e.g. GP, CP and so on).

Tip: Click the All folder in left panel shows all plugins, without any categorization.

Tip: Press a letter on the keyboard to jump to a plugin which starts with that
letter.

Tip: Double-click a folder tab to go to the Default folder for that plugin category.

Tip: All plugins can be dragged straight into the Scene Tree (except Scene
plugins).

To search for a Plugin

1. Click on Built Ins (1).

2. Open the plugin search panel:

• Click on the Built Ins drop down menu and click on Search... (2), or

• Press <Ctrl+F>.

3. In the plugin search panel enter a text search string (3).
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4. Click on Go (4), or press <Enter>.

Note: The searched plugins have the same Add and Context menu functions as
the plugin icons in the plugin tabs (see Built Ins).

Note: The plugin can be dragged to a Container in the Properties Panel.

Note: Only some Container plugins will drag to the Scene Editor, when they will
the target object becomes active when the icon is moved over the object

Note: When a Texture Source or a Geometry plugin is added to the Scene Editor
a Container is created in the Scene Tree for the Texture source or the Geometry
plugin.

4.13.3 Add Plugins to a Containers

Most plugins can be dragged to a target Container(s) in the Scene Tree (1), the
Properties Panel (2) or the Scene Editor (3). Each plugin also has a context menu where
a plugin can also be added to a Scene.



Viz Artist User’s Guide

Page 192 Copyright © 2014 Vizrt

This section contains information on the following procedures:

• To add a Geometry plugin

• To add a Container plugin

• To add a Shader

• To add a Scene plugin

• To add a Texture Source as a texture

• To add a Texture Source as DVE

• To add a plugin to Multiple Containers

• To add a plugin to Favorites

• To open a Plugin Properties Editor

To add a Geometry plugin

1. Drag the Geometry plugin icon to either:

• A Container or multi selected Containers

• The Scene Tree area (creates its own container)

• The Scene Editor area

• The Container Editor area

or

1. Highlight the target Container(s)

2. Right-click the plugin icon and select Add to Container(s) from the Plugin
Context Menu

Note: A Container can only contain one Geometry plugin at a time. If a new
Geometry plugin is added the fist one will be removed from the Container.

To add a Container plugin

1. Drag the Container plugin icon to either:

• A Container or multi selected Containers

• An object in the Scene Editor (only some container plugins will do this, when
they will the object becomes active when the icon is moved over the object.

• The Container Editor area

or

1. Highlight the target Container(s)

2. Right-click the plugin icon and select Add to Container(s) from the Plugin
Context Menu

To add a Shader

1. Drag the icon to either:

• A Container or multi selected Containers

• An object in the Scene Editor

• The Container Editor area
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or

1. Highlight the target Container(s)

2. Right-click the plugin icon and select Add to Container(s) from the Plugin
Context Menu

Note: A Container can only contain one Shader at a time. If a new Shader is
added the fist one will be removed from the Container.

To add a Scene plugin

1. Open the Plugin tab in Scene Settings:

• Click on Scene Settings -> Plugin

2. Drag the Scene Plugin icon to the Scene drop area.

or

1. Right-click the icon to open the Plugin Context Menu.

2. Click on Add to Scene...

To add a Texture Source as a texture

1. Drag the icon to either:

• A Container or multi selected Containers.

• The Scene tree (creates its own container).

• The Scene Editor (this will create a new container for the Texture source).

• An object in the Scene Editor.

• The Container Editor area

or

1. Right-click the Texture Source icon to open the Plugin Context Menu.

2. Select Add <Texture Source name> as texture.

3. A new container will be created for the new Texture source, in the Scene Tree

To add a Texture Source as DVE

• Drag the Texture Source to a Container(s) in the Scene Tree

or

• Drag the Texture Source to the Scene Tree (a new Container will be created)

or

1. Right-click the icon to open the Plugin Context Menu.

2. Select Add <Texture Source name> as DVE.

To add a plugin to Multiple Containers

1. Highlight the required Containers.

2. Click and drag the plugin icon to a highlighted Container
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3. Release the plugin icon.

or

1. Click and drag a plugin icon.

2. Hold the plugin icon over a Container.

3. Continue to hold the left-click and do a right-click to drop the plugin icon on the
Container.

4. Continue to hold the left-click and repeat for each required Container

To add a plugin to Favorites

1. Right-click the icon to open the Plugin Context Menu.

2. Click Add as favorite...

Note: Plugins can also be added as a Favorite from the search panel (To search for
a Plugin).

To open a Plugin Properties Editor

• Click on the plugin icon, in the Container or the in the Properties Editor.

See Also

• Built-in View Shortcuts
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5 Global Tasks

This section contains information on the following topics:

• Scene Settings

• Implementing Video

• Importing

• Archiving

• Deploy

• Post Rendering

5.1 Scene Settings
To open the Scene Settings editor, select the Scene Settings tab in the Property panel.
The Scene Settings editor makes it possible to modify the global parameters for the
scene.

There are various types of scene settings. Click the tabs at the top of the Scene
Settings editor to open the respective panels:

• Global Settings

• Video

• Rendering

• Plugin

• Script

• Clipper

• HDR (High Dynamic Range)

• Virtual Set

See Also
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• Implementing Video

5.1.1 Global Settings

This section contains information on the following topics and procedures:

• Global Settings Properties

• Working with Images

• To add an image

• To remove an image

• To view an image’s source project or folder

• To show/hide an image in the Scene Editor

Global Settings Properties

In the Global Settings panel the basic parameters for the scene can be modified:

• Key: Defines how the alpha key signal should be generated. The default is Overlay.

• Virtual Set: This option is relevant only in combination with the Virtual Set
solution. This mode switches from Overlay to Full Screen when the control mode
of the current camera switches from Remote to Editor (see Camera Editor). On
a Virtual Set, to perform a camera flight with the virtual camera when the real
camera is stationary, the graphics must be switched to Full Screen to avoid a
situation whereby the virtual and the real camera have different position values.
When switching the camera from Remote to Editor to perform the flight, the
keyed graphics automatically switches from Overlay to Full Screen.

• Full Screen: Ouputs non-transparent key signal.

• Over lay: Sets as key signal only those containers that have a Key function
attached. Only containers in the scene tree with a Key function attached are
rendered into the key signal.

• Auto Key: This is the preferred mode for overlay graphics. The key signal is
automatically generated from the containers in the scene tree and it does not
require the application of Key functions to the container. This function provides
you with a worry-free overlay.
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• Background Image: This option is only applicable if a background image with
an alpha layer is added. The alpha values of the background image are used as a
key signal and containers with a Key function attached will be rendered on top.

• Key Render Mode:

• Config: Renders the key according to the settings in the Config file.

• Single Pass: Uses one rendering step. Use this for all new scenes and for
scenes imported from version 2.8, as it is much faster.

• Double Pass: Uses two rendering steps. Use for backward compatibility in
scenes created in Viz Artist versions 3.0 to 3.3.

• Background Color: Sets the color of the background. For information about how to
select a color (see Material Color Properties and Schemes).

• Background Image: Makes it possible to use an image as the scene background.

• Foreground Image: Makes it possible to use an image in the scene foreground,
which means right behind the camera pane. If the image in the foreground has no
alpha, then only the image will be displayed. If the image has alpha, the scene will
be displayed through the image.

• Preview Image: Makes it possible to add a fixed layout to the scene. This
visualizes how the total preview (camera picture and/or graphics) will look like. To
set the image as global default, click the Set Default button.

Tip: It is possible to drag results from a database search onto the background,
foreground, and preview image drop zones.

• Stereo Mode: Select the correct stereo mode for the inserted image:

• None: No Stereo mode.

• Config: Images are drawn as set in the config file (see Camera, in Configuring
Viz).

• Over Under Left Top or Over Under Right Top: Two images are stored, one
over (top) and the other under (bottom), left or right eye (top) first. The
image height will be halved, providing half resolution.

• Side by Side Left or Side by Side Right:  Two images are stored, side by
side, left or right eye first. The image width will be halved, providing
half resolution.

• Mask  Invert: Makes it possible to set one or more of the mask layers in the scene
to be inverted. With no mask inverted, the mask cuts out a hole where it covers the
mask target object. With mask invert enabled, the mask target is only visible where
the mask covers it.
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Mask Not Inverted

Mask Inverted

• Shadows: Enables or disables the shadow function in the scene. The shadow
function uses two layers from the mask function. With shadows enabled, there are
only six layers available for the mask function (see Mask Source and Mask Target).
In a scene where more than six mask layers are needed, shadows can be disabled.
Note that only very complex mask configurations need more than six layers.

• Tree Color Text: Makes it possible to add text to the scene tree colors that are
available in the Favorites area. Note that this text is scene specific. Adding text to
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the global scene tree Colors can be done in the Configuration. To create customized
colors for the scene tree, see Favorites Bar.

Working with Images

The following procedures demonstrate what you can do with images in the background,
foreground and preview.

To add an image

1. Click Server.

2. Click the I tab for Images (1).

3. Drag the required image onto the drop zone (2).

A thumbnail of the image will then be shown in the drop zone button. Dragging a new
image onto the drop zone will automatically replace the old image.

To remove an image

• Drag the image from the drop zone onto the trash can.

To view an image’s source project or folder

• Click the image on the drop zone.

The project or folder it is placed in is visible. If the image is linked, the first project or
folder will be selected.

To show/hide an image in the Scene Editor

• Click the Active/Inactive button next to the drop zone (3).

If the image has a different aspect ratio than the screen resolution, the image will be
stretched to fit.

5.1.2 Video

This section contains information on the following topics:

• Video Properties
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Video Properties

• Target:

• Inactive: Video is not active.

• DVE: Set the Video Stream as DVE (see Methodological Considerations)

• Texture: Set the Video Stream as a Texture (see Methodological Considerations)

• Audio: Set the Audio volume

• Keying Mode  (see  Keying Mode for VideoVizBold ):

• Linear: No chroma keying

• Chroma: Uses the internal chroma keyer

• M-Zone: Uses the multi-zone keyer

• Libero: Uses the Viz Libero keyer

• Invert: Only works with Chroma and Libero

• URL: Enter the URL of the Stream to be shown (Video Stream only):

• Load:  Click to load the video Stream

• Clear: Click to remove the video Stream.

See Also

• Implementing Video

5.1.3 Rendering

In the Rendering panel, basic rendering parameters can be modified.

This section contains information on the following topics and procedures:

• Rendering Properties

• To design graphics with a user defined aspect ratio
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Rendering Properties

• Culling Enables/disables a culling function for the scene. The culling function is
a performance saving function. With culling enabled, objects whose bounding
box is outside the camera view are not rendered. This is of great importance to
performance in large scenes and virtual sets. Normally the culling function should
be Active.

• Screen Area

• Safe Area: Sets the size of the Safe area X and Y values in percent of the screen
resolution. Single click the R button on the X or Y to reset the clicked value to its
default value. Double-click the R button to reset both values to default values.
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• Title Area: Sets the size of the Title area X and Y values in percent of the screen
resolution. Single click the R button on the X or Y to reset the clicked value to its
default value. Double-click the R button to reset both values to default values.

• Auto Key Plane Makes it possible to define the X, Y and Z Position that serves as a
threshold between objects with and without key. Click the Active/Inactive button to
enable the settings. The position can be set according to a tracking device carried
by a person on the set, or it can be controlled by an operator. The auto key position
decides which objects or parts of objects in the scene that are to be part of the key
signal. Only objects positioned between the auto key position and the camera will
be rendered with the key signal. A typical setup for a Virtual Set would be that the
scene background is put into a separate channel of the external keyer. The objects
of the background do not have a key function attached. The objects that are meant
to be in front of the person on the set are placed in another channel/layer of the
external keyer and have a key function attached. If the person on the set moves
against the camera, the auto key function disables the key function of those objects
that now are placed behind the person, thereby moving them into the background
layer of the external keyer. To learn more about this, see the separate Virtual Set
documentation.

• Half Height This option can be set to Active or Inactive. Active means that Viz
Artist will render fields instead of full frames. Normally the system renders 50 or
60 full height frames and produce twice the amount of pixels needed. This is done
to achieve better quality. If picking every second line of a full height frame and
send it to the output, it will look better. Anti aliasing, texture filtering works “better”
if rendering full height. So when Viz Artist renders half height, the quality will be
reduced a little bit, especially on some textures, but it nearly renders twice as fast,
because the pixel fill is half the size.

• Depth of Field emulates the behavior of a real camera where objects further away
from the focal plane appear blurred and objects close to the focal plane appear
sharp. The respective parameters can be set in the camera settings under the
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Camera’s Focus settings (see VizBoldFocus: Focus settings are enabled if the Depth
of Field parameter is set to Active (see Rendering).).

• Flicker filter Makes it possible to change the level of the flicker filter from Off and
up to Level 3. The flicker filter is used to remove/reduce flickering from a scene. If a
flicker filter is applied and the scene still flickers, try using the next level.

• Gamma Makes it possible to set a gamma value for the renderer.

• Camera Clipping Plane Sets the range of the virtual camera. Near sets the close
range while Far defines the far range. Only containers within this range will be
rendered.

Note: The camera range is where the Zbuffer is within. So if Zbuffer problems
arise, they may be solved by editing the camera clipping plane settings.

• Camera Aspect: Sets the camera aspect.

• Config makes the camera aspect equal to the settings in the Output Format
panel of the configuration.

• 4:3, 16:9 Horizontal and 16:9 Vertical makes the camera aspect independent
of the aspect for the rest of the scene.

• User enables the user to set a user defined camera aspect ratio. When building
a scene with a customized aspect ratio for a Viz Video Wall set the user-defined
camera aspect to the same value as the Aspect in the Config’s Output Format
’s User Defined value for Aspect (which is set dynamically based on the other
values). When building a scene with a customized aspect ratio for other e.g.
handheld/mobile devices or online publishing set the Render Options ’ Keep
Editing Aspect parameter to Editor as this will not have an affect on the On-Air or
Viz Engine output. See also To design graphics with a user defined aspect ratio.

Viz Configuration Output Format

• Keep Orthog. Frustum: When active, takes the original frustum stored and
does not allow its recomputation after changes have been made to the camera
parameters in the orthogonal mode.
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• Depth Function: Specifies the function used to compare each incoming pixel depth
value with the depth value present in the depth buffer. Equal: passes if the incoming
depth value is equal to the stored depth value. Less or Equal: passes if the incoming
depth value is less than or equal to the stored depth value.

Note: The Depth Function setting is OpenGL-specific.

• Text Bounding Box Style: Tight means that the bounding box is drawn tight
around all text used in this scene. This means just the height of the actual text
used. When set to Full Height, the bounding box is higher: Viz Artist calculates the
bounding box for characters that need some space underneath (e.g. the letter ‘g’)
and for characters that need more space above (e.g. a parenthesis) even if these
characters are not used in the text of the scene. Max. Size is for scenes imported
from version 2.8 so that the various plugins which depend on font bounding boxes
are compatible in version 3.5, such as Max Size and Autofollow; it also includes a
small trailing space between the letter and the bounding box. Legacy produces the
exact same bounding box as version 2.8.

Note: The Full Height setting does not work for special characters like the ‘Ä’
which is even higher in some fonts. There is a special config setting for this:

Viz Configuration Font Options

• Ringing Filter Reduces the ringing artifacts on the SDI output and applies only
to SD formats. The ringing filter can be switched off with the config setting under
Render Options; set Force Ringing Filter Off to Active.
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Viz Configuration Force Ringing Filter Off

Note: The default ringing filter is located in the config Scene Default Values.

Viz Configuration default Ringing Filter

• Output Region: Becomes inactive if you design a Half or Quarter Edition scene. To
revert to a full screen scene, click Full.

• Half Edition: If you have a full Viz Artist license, but want to design a scene for
another license that has only a Half Edition, select which portion of the scene you
want to design your scene in. Your options are:

• Left

• Right

• Top
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• Bottom

• Bottom Left

• Bottom Right

• Bottom Top

• Quarter Edition: If you have a full Viz Artist license, but want to design a scene for
another license that has only a Quarter Edition, select which portion of the scene
you want to design your scene in. Your options are:

• Left

• Right

• Top

• Bottom

• Middle Left

• Middle Right

• Middle Top

• Middle Bottom

To design graphics with a user defined aspect ratio

1. Start Viz Artist.

2. Click the Config button to open the configuration (see Configuring Viz).

3. If you plan to render graphics in many different aspects (e.g. still images for online
publishing) you should select the Render Options section and set Keep Editing
Aspect to Editor.

• This will ensure your graphics are rendered according to the scene’s configured
camera aspect (and not be affected by the Output Format aspect)

4. In the Output Format section set the format that best fits your screen’s resolution
and aspect (e.g. 16:9) and close Viz Artist.

• Viz Artist is resolution independent and its workspace is optimized for
designing in 16:9 and 4:3 aspects.

• When designing graphics with a user defined aspect, only set the Output
Format to size the aspect of your Scene Editor and adjust the camera aspect
further to define it according to your scene’s required and final aspect.

5. Start Viz Artist.

6. Click the Server button.

7. From the Properties Panel click the Scene Settings tab.

8. Under the Rendering tab set Camera Aspect to User.

9. Enter your aspect ratio in the field beside the User field.

• To calculate your aspect ratio simply divide width with height (e.g.
1600:900=1.778)

See Also

• Scene Editor Camera Controls and Shortcuts

5.1.4 Plugin

In the Plugin panel, plugins can be applied to the Scene. Scene plugins are “global”
functions that have influence on the whole scene. They are mainly used when external
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programs are interfaced with Viz Artist. Viz Artist uses an open interface for plugins.
New plugins can either be obtained or written by yourself and then installed into Viz
Artist.

Installed Scene Plugins can be found under Built Ins in the Main Menu. In Built Ins select
Scene Plugins in the pull-down menu or click on the SP tab in the Element Area.

For a detailed list and description of the plugins delivered with Viz Artist see Scene
Plugins .

The area for the plugins is divided in two sections:

• Plugins applied to a Scene, as icons (1)

• Plugin editor (2 (opens when the plugin is highlighted)).

This section contains information on the following topics and procedures:

• To add a Scene Plugin

• To edit a Scene plugin properties

• To show Scene plugin information

• To enable/disable a Scene plugin

• To Remove a Scene Plugin

To add a Scene Plugin

1. Click Built Ins.

2. Select Scene Plugins. Browse for the plugin to apply to the Scene.

3. Put the plugin in the Scene Settings Plugin area:

• Drag the selected Scene Plugin to the Plugin drop zone, or

• Right-click on the Scene plugin icon and select Add to Scene...

To edit a Scene plugin properties

1. In the Scene Setting’s Plugin area, select the plugin.

2. Edit the plugin’s properties in the editor to the right.

To show Scene plugin information
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1. In the Scene Setting’s Plugin area, select the plugin.

2. In the plugin editor, click the info icon.

To enable/disable a Scene plugin

• In the Scene Setting’s Plugin area, click on the enable/disable switch in the icon.

For greater convenience Viz Artist allows you to enable or disable the plugins already
applied to the scene. This will help you not to loose the overview when adjusting the
plugin properties to the values you need.

Note: After you add a plugin to the scene, it will automatically be enabled.

To Remove a Scene Plugin

• Drag the plugin onto the trash can, or

• Right-click on the plugin (in the Scene Plugin tab) and select Remove from Scene.

5.1.5 Script

In the Script panel, scripts can be added to the scene. For more information on
scripting see the Script Editor section.

5.1.6 Clipper

In the Clipper panel, settings for scenes that have the Clipper plugin attached can be
modified.

The Clipper plugin is an alternative to the mask function; the clipper works in 3D and
the mask in 2D. Objects using the clipper plugin, when placed behind the clipper plane,
will be masked/clipped. If an object is only partially behind a clipper plane, only the
part of the object that is behind the plane will be clipped out since the clipping is done
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in true 3D space. The plugin uses the OpenGL clipping planes that supports up to six
planes.

This section contains the following topics:

• Clipper Properties

Clipper Properties

• Number: Shows the clipper plane number, from 1 to 6.

• State: Makes it possible to switch the selected clipper plane On or Off.

• Position: Makes it possible to modify the position of the clipper plane along the X,
Y, and Z axis.

• Rotation: Makes it possible to modify the rotation along the X and Y axis.

• Reverse: If this option is set to Off, everything in front of the clipper plane is shown.
If it is set to On, everything behind the clipper plane is shown. Tracking Objects with
Clipper Plane

• Tracking Object: A clipper plane can be set up to track containers regarding
position and rotation. Tracking position means that the position of the clipper plane
will be in the center of the container, and tracking rotation means that the clipper
plane will rotate if the object rotates. This is especially useful when animating a
scene.

See Also

• Creating Animations

• Clipper

5.1.7 HDR (High Dynamic Range)

Enables High Dynamic Range Rendering/Imaging for the selected container. This
improves the contrast of the generated scene in a much more realistic way.

• High Dynamic Range (Active/Inactive): Enables HDR lighting instead of the
default OpenGL lighting on Containers tagged for HDR lighting. To tag Containers for
HDR lighting the HDR plugin must be placed in a Container to enable HDR lighting
on the respective container and its sub-tree.

• Diffuse Map: This is a HDR Cube map (must be a vertical cross and should have
been imported from an EXR file). It defines the diffuse light map.

• Reflection Map:  Same as Diffuse map but for the reflection part of the
lighting.

• Rotation: Rotate the environment map with the set parameters.

Note: Diffuse map and reflection map together form the ‘environment map’.
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• Exposition: Controls the brightness of the maps (similar to the exposure time of an
ordinary camera).

• Background (Active/Inactive):  Draws the Reflection map as background.

See Also

• HDR

5.1.8 Virtual Set

The Virtual Set panel is only available if the Virtual Set option is installed. This panel
makes it possible to set up and save configuration for virtual sets. For information
about the parameters, see the separate Virtual Set documentation.

5.2 Implementing Video
Video implementation in Viz Artist depends on the machine and video board
configuration. There are also two general approaches:

• Implementing Video Through an External Feed or

• Implementing Video Through a Video Clip.

Additionally, video can be implemented in Viz Artist in one of two ways:

• DVE (Digital Video Effect): This is a feature of specific video boards (e.g. Targa and
Matrox, but not DVS).

• Texture level: The video is part of the graphics.

Before video can be implemented, the Video Output and Video Input configuration
settings must be configured. These settings determine the frame rate (PAL/NTSC) of
the entire video system. See the Viz Engine documentation for details.

These video cards are supported:

• Matrox

• DVS

• Targa

There are a few varieties of Matrox cards (X.mio, X.mio2 and X.mio2 Plus) which mainly
differ in the number of possible video inputs and outputs (X.mio2/44). DSX/LE2 in does
not have any input, codec support or compositor. Furthermore, for X.mio, X.mio2 and
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X.mio2 Plus Matrox cards video inputs and clip channels can be disabled in the Matrox
configuration.

IMPORTANT! The most basic rule for working with the video version of Viz Engine
is to always have a valid genlock attached to the video board, no matter which
board is installed. Without the correct genlock setup there is no guarantee that
the Engine will function correctly. See Video Output.

Video parameters are modified in Viz Artist in the Scene Setting’s Video Tab.

In the left panel, there are three columns, showing all available input channels.

• TS: Channel’s internal name.

Note: This is the same name as in the command interface.

• Channel: Corresponding to the Texture icon names.

• Target: The channel’s state:

• Background (BG) and Foreground (FG) graphics: Active or Inactive.

• Input channels: Inactive, DVE or Texture.

Clicking on a channel in the left panel opens its editor, in the right panel.

This section also contains information on the topics:

• Methodological Considerations

• Clip Playback Use Cases

• Implementing Video Through an External Feed

• Implementing Video Through a Video Clip

• Keying Mode for Video

• Keying Mode Parameters

• Seamless Input Channel Switcher
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5.2.1 Methodological Considerations

When using DVE, the graphics scene and the channel are composited on the video card
(Matrox X.mio or Targa). An SDI monitor is needed to show the channel when using
DVE mode. When using DVE, there is a limited set of 2D control options available in
the design and animation of the Viz Artist scene (position, size, crop and alpha). Please
take into consideration that chroma keying is not supported for channels set to DVE.

If more control of the video is needed, for example, to map the video onto a 3D object
in a scene, then Texture mode can be used. The video would then have the same
control parameters as an image in Viz Artist. However, the video may now affect
rendering performance, since it needs to composite the video into the render window.

5.2.2 Clip Playback Use Cases

This section contains information on the following common clip playback use cases:

• Playing Overlay Clips - Not Full Screen

• Clip with Audio - Not Full Screen

• Clip with Audio - Full Screen

• Clip with Audio - Full Screen - 3D Space Transformation

Playing Overlay Clips - Not Full Screen

Playing a clip which is not full screen in size, like a spinning logo, an insert snipe or a
special effect without audio. These are known as overlay clips.

To play overlay clips it is recommended that you use the Soft Clip clip player. Even
though Softclip can play clips up to HD 1080, it should be mainly used for overlay
clip playback. For full screen playback there is a more efficient clip player available in
Viz. The advantage of the Softclip clip player is that it can play clips in any pixel size,
aspect ratio or frame rate. Softclip is based on the VFW (Video for Windows) AVI clip
playback workflow on Windows.

Soft Clip is able to play all installed VFW (Video For Windows/AVI) codecs on your
computer. There are dozens of codecs available, each with its own advantages and
drawbacks. There is no general rule which codec to use (see Supported Codecs),
but it is recommended that you use the different types of Matrox codecs (depending
on whether the alpha channel is necessary or not), avi uncompressed or the freely
available HuffYuv codec. Softclip supports RGBA playback if the codec is able
to store the alpha channel; avi uncompressed supports alpha, also the Matrox
Mpg2iFrame&alpha codec and the HuffYuv codec, just to mention a few.

A typical use case for the Softclip player would be:

• The playback of a spinning looping logo with alpha channel. The size of this clip
could be around 350x350 pixels.

• The playback of an explosion overlay clip with alpha. The size is around 500x500
pixels.

• The playback of a snipe/insert with alpha. The size is around 600x150 pixels.

Note: The Softclip player is not intended for full screen playback!

Clip with Audio - Not Full Screen
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Playing a clip with audio which is not full screen in size, like a strap of an advertiser, a
3D object transition or an effect or a reveal of an element only.

To play clips which need audio but do not need to be played back in full screen mode,
you should use MoViz. Moviz is very similar to Soft Clip, with the main difference
being that it supports audio. Moviz is based on the directX clip playback workflow on
Windows, meaning it uses a different library and codec filters than the Softclip plugin. If
you install a VFW codec for avi playback like for Softclip, it is not guaranteed that your
clip will also play in Moviz, since Moviz is directX-based. In general it is very helpful to
install the free package of the main concept codecs, since with this package you get
dozens of ffdshow filters for directX for free and this will raise the compatibility with
which you will be able to play regular avi files via Moviz. To use the full potential of
Moviz you should encode your clips whit ffd instead of avi. If you want to render clips
into ffd as an example from Adobe After Effects, there will be a new section showing up
in the render section named ffd, besides Quicktime and Video for Windows, TGA single
frames and others. In the ffd settings you can select the necessary format, like dv, mpg
and many others.

A typical use case for the Moviz player would be:

• The playback of a insert advertiser with audio on the bottom of your screen. The
size of this clip would be something around 720x150 pixels.

• The playback of a “clip universe”: the animated Viz camera is flying through space
and passes clips.

Note: The Moviz player is not intended for full screen playback!

Clip with Audio - Full Screen

Playing a clip with audio in full screen mode, but only using it as a background in my
Viz scene. The clip does not need to be rotated in 3D space.

To play full screen background clips it is recommended that you use the Matrox clip
channels. The dimensions and frame rate of these clips must be either HD 1080, HD
720, PAL or NTSC. Any free pixel size, aspect ratio or frame rate is not supported on the
Matrox channels.

If the clip is 2D, meaning there is no transformation/rotation in 3D space needed, then
you should set your Matrox clip channel to DVE. In DVE mode you get the maximal clip
quality achievable.

When using DVE mode, don't forget to apply a key function to your Viz Elements or
switch the renderer to autokey, otherwise they will not appear in front of the clip. See
Keying Mode for Video.

If you want to use an alpha channel on this clip, use the Matrox Mpg2iFrame&alpha
codec and configure your clip channels in the Viz Config correctly (activate alpha).
Also here it is recommended that you use the Matrox AVI codecs, but the Clip channels
support many more formats than just the Matrox codecs (see Supported Codecs).

A typical use case for the DVE setting would be:

• The playback of a clip at it's best quality, with or without any overlaying graphics.

Note: Using the Matrox clip channels for playback is the most efficient clip
playback for full screen clips!
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Clip with Audio - Full Screen - 3D Space Transformation

Playing a clip with audio in full screen mode and transforming it in 3D space.

To play full screen clips it is recommended that you use the Matrox clip channels. The
dimensions and frame rate of these clips must be either HD 1080, HD 720, PAL or
NTSC. Any free pixel size, aspect ratio or frame rate is not supported on the Matrox
channels.

To be able to transform the clip in 3D space you must set the clip channel to Texture.
Compared to DVE mode, the clip is slightly more blurred, but this is essential to avoid
noise on the clip texture when moved or rotated in 3D space.

If you want to use an alpha channel on this clip, use the Matrox Mpg2iFrame&alpha
codec and configure your clip channels in the Viz Config correctly (activate alpha).
Also here it is recommended that you use the Matrox AVI codecs, but the Clip channels
support many more formats than just the Matrox codecs. See Supported Codecs.

A typical use case for the Texture setting would be:

• The playback of a clip in 3D space with transformations on rotation, scaling and
position.

• The playback of a clip on a 3D object.

Note: Using the Matrox clip channels for playback is the most efficient clip
playback for full screen clips!

5.2.3 Implementing Video Through an External Feed

External video is implemented as follows:

• External Live Video Through DVE

• External Live Video Through Texture

• External Video Stream Through Texture

External Live Video Through DVE

This section covers the following procedures:

• To implement external video (DVE (Matrox))

• To implement external video (DVE (DVS))

• To implement external video (DVE (Targa))

Note: Implementing external video through DVE does not have any impact on
rendering performance, since it is handled solely on the board.

To implement external video (DVE (Matrox))

1. Click Config and configure the alpha in Video Input.

Tip: w/Alpha Enable this setting when you need use external video with alpha.
Two of the video inputs to the Matrox board are combined to be the fill and key.
Input A and B will be combined and input C and D will be combined, respectively.
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2. Save and restart Viz Artist.

3. Click Server.

4. In the right panel select the Scene Settings tab and click the Video tab.

5. In the left panel of the Video parameters, click Live 1.

6. In the right panel of the Video parameters, in the Target row, click the DVE button.
You can now adjust the parameters in the DVE control panel:

• Position

• Size

• Crop

• Alpha: For each layer, you can adjust the level of opacity, where 100% is fully
opaque and 0% is fully transparent.

• Priority: Assigns the position of each layer in the layer stack, where 0 is the
bottom-most layer, and 100 is the top-most layer.

Note: BG Graphics are always the lowest in the stack, even below zero, and FG
graphics are assigned a default of 100. As such, you cannot assign a priority to BG
Graphics.

The Scene Editor displays a blue rectangle, showing that the input channel is correctly
configured.

To implement external video (DVE (DVS))

Note: In DVS, DVE is simulated through the software.

1. Click Built Ins.

2. In the drop-down menu underneath, select Texture Sources.
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3. Drag and drop the Video1 plugin into the scene tree.

• You can now do to the video anything you would do with a texture.

To implement external video (DVE (Targa))

1. Click Server.

2. In the right panel select the Scene Settings tab and click the Video tab.

3. In the left panel of the Video parameters, click Input 1.

4. In the right panel of the Video parameters, in the Target row, click the DVE button.
You can now adjust the parameters in the DVE control panel.

• Position

• Size

• Crop

• Alpha: For each layer, you can adjust the level of opacity, where 100% is fully
opaque and 0% is fully transparent.

• Priority: Assigns the position of each layer in the layer stack, where 0 is the
bottom-most layer, and 100 is the top-most layer.

Note: BG Graphics are always the lowest in the stack, even below zero, and FG
graphics are assigned a default of 100. As such, you cannot assign a priority to BG
Graphics.



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 217

The Scene Editor displays a blue rectangle, showing that the input channel is correctly
configured.

5. In the right panel of the Video settings, in the Alpha row, select either:

• RGB: The input is taken as-is, meaning, it is used as fill.

• RGBA: Both inputs of the Targa are combined to one signal having fill and key.

Now the layer is part of the compositing on the video hardware.

External Live Video Through Texture

This section covers the following procedures:

• To implement external video (Texture (Matrox))

• To implement external video (Texture (DVS))

• To implement external video (Texture (Targa))

Note: Other than implementing external video through DVE, implementing
through texture does have an impact on rendering performance, since the video
stream needs to be transferred to the graphics board.

To implement external video (Texture (Matrox))

1. Click Config and configure the alpha in Video Input.

Tip: w/Alpha Enable this setting when you need use external video with alpha.
Two of the video inputs to the Matrox board are combined to be the fill and key.
Input A and B will be combined and input C and D will be combined, respectively.

2. Save and restart Viz Artist.

3. Click Server.

4. In the right panel select the Scene Settings tab and click the Video tab.

5. In the left panel of the Video parameters, click Input 1.

6. In the right panel of the Video parameters, in the Target row, click the Texture
button.

7. Select the keying mode:

• Linear No chroma keying.

• Chroma Uses the internal chroma keyer.

• M-Zone Uses the multi-zone keyer.

• Libero: Uses the Viz Libero keyer
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• Invert Only works with Chroma and Libero.

• You can now do to the video anything you would do with a texture.

Tip: If you drag the Video1 plugin straight into the scene tree, the Texture button
will be active by default.

To implement external video (Texture (DVS))

1. Click Built Ins.

2. Select Texture Sources.

3. Drag and drop the Video1 Texture Source to the Scene Tree.

• You can now do to the video anything you would do with a texture.

Tip: If you drag the Video1 plugin straight into the scene tree, the Texture button
will be active by default.

To implement external video (Texture (Targa))

1. Click Server.

2. In the right panel select the Scene Settings tab and click the Video tab.

3. In the left panel of the Video parameters, click Input 1.
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4. In the right panel of the Video parameters, in the Target row, click the Texture
button.

5. Select the keying mode:

• Linear No chroma keying.

• Chroma Uses the internal chroma keyer.

• M-Zone Uses the multi-zone keyer.

• Invert Only works with Chroma.

• You can now do to the video anything you would do with a texture.

Tip: If you drag the Video1 plugin straight into the scene tree, the Texture button
will be active by default.

External Video Stream Through Texture

To use Video Stream through Texture, make sure that the Stream channel is active (see
Video Input).

This section covers the following procedures:

• To Implement a Video Stream (Texture)

• To Remove a Video Stream

Note: Video stream operates only with Texture. Implementing a Video Stream,
through texture, will have an impact on rendering performance, because the video
stream needs to be transferred to the graphics board.

To Implement a Video Stream (Texture)

1. Click Built-Ins.

2. Click the Texture Sources tab.

3. Drag a Stream texture source to the Scene Tree or a Container in the Scene Tree.

4. Click on the Stream texture icon in the Container to show the Stream Container
editor in the Properties panel. Edit as required (see Stream in Texture Sources).

5. Click on the Scene Settings tab in the Properties panel.

6. Click on the Video tab.

7. Click on the required Stream, in the left panel.

8. Select Texture from the Target bar.

9. Adjust the Video settings as required (see Video).

10. Enter the URL of the stream and click on Load.
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Note: To load a new Video Stream, enter the new URL in the URL box. This will
automatically clear the old Video Stream.

To Remove a Video Stream

1. Click on the Clear button.

5.2.4 Implementing Video Through a Video Clip

Depending on sizes and formats, using clips will affect Viz Engine rendering
performance. Hence, clip playback should be used sparingly.

When building the scene in Viz Artist that will support clip playback, there are three
possible plugins you can optionally use:

• Image Clip

• MoViz

• Soft Clip

Consider the following general guidelines when deciding on a specific method to use
for playing back video clips:

• If no 3D effects or animation control - and only limited 2D effects - on the clips are
needed, use the Clip Channel through DVE.

• Full screen (e.g. background) clips should be done by the Clip Channel through DVE.

• If video must be mapped onto a texture in the scene or requires minor adjustments,
use Clip Channel through Texture.

• Non-standard image format/resolution/codec, use SoftClip or MoViz plugins.

• If more than two small clips are required, use SoftClip or MoViz plugins.

• For low resolution and short animations use the ImageClip plugin.

See Also

• Clip Playback Use Cases

You should always test the performance of the different solutions and work with the
solution that gives the best quality versus performance ratio. Performance testing
should always take place on a machine with the same specifications as those used for
production playout.

Note: Reading and decompressing a clip impacts system performance both with
DVE and texture.
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Video Clip Storage

All Viz Artist and Viz Engine machines, as well as Vizrt clients (with preview - e.g. Viz
Trio or Viz Weather), should come prepared with a pre-mapped video (V:\) drive. This
drive is configured for faster access and speeds. This is where all video clips should be
stored. It is not recommended to store video clips on the C:\ drive, as this is where the
operating system is installed.

Viz One integrates with Viz Artist for the purposes of implementing clips for playout. For
setup information, see the Viz Engine Administrator’s Guide and Viz One Deployment
Guide.

Dual Channel and Trio Media Box configuration

When more than one directory path is selected, for example, D:\AEClips; D:\DecoClips,
etc., in the Clip Name box change the file path to ‘<clip_root>’. The file name is then
searched for, in the selected directories (selected in the Configuration), one after the
other, for stored video clips with the same name.

Example: Search for a video clip named ‘next_tuesday.avi’ in V:\AEClips\AFL
\Promos. In the Clip Name box change ‘V:\AEClips\AFL\Promos’ to ‘<clip_root>’
The filename shown in Viz Artist should be <clip_root>\next_tuesday.avi.

Video clips are implemented as follows:

• Video Clip Through DVE

• Video Clip Through Texture

Video Clip Through DVE

This section covers the following procedures:

• To implement a video clip (DVE (Targa))

• To implement a video clip (DVE (Matrox))

• To implement a video clip (DVE (DVS))

To implement a video clip (DVE (Targa))

1. In the right panel select the Scene Settings tab and click the Video tab.

2. In the left panel of the Video settings, select Clip Channel 1.

3. In the right panel of the Video settings, in the Target row, click the DVE button.
You can now adjust the parameters in the DVE control panel.

• Position

• Size

• Cropping

• Alpha For each layer, you can adjust the level of opacity, where 100% is fully
opaque and 0% is fully transparent.
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• Priority Assigns the position of each layer in the layer stack, where 0 is the
bottom-most layer, and 100 is the top-most layer.

Note: BG Graphics are always the lowest in the stack, even below zero, and FG
graphics are assigned a default of 100. As such, you cannot assign a priority to BG
Graphics.

4. In the Clip Name line, click the ellipsis (...) to select a video clip to import.

IMPORTANT! Make sure that the clip selected has the same resolution as the
channel in question.

IMPORTANT! Make sure that the Targa board supports the codec (see Targa
Codecs).

Note: For Dual Channel and Trio OneBox set up see Dual Channel and Trio Media
Box configuration.

5. In the right panel of the Video settings, in the Alpha row, select either RGB or
RGBA.

• RGB The clip is taken as-is, meaning, it is used as fill.

• RGBA You need to implement two clips; the first is the fill, and second is the
key clip. If you only implement one clip, the key will be created dynamically
and be fully opaque. The naming convention is that the alpha/key clip must
have the same name with an attached _key before the file extension, this
means if the main/fill clip is named example.dif, the alpha/key clip must be
named as follows: example_key.dif.

6. In the Clip Control row, click the Play button to test your video clip.

To implement a video clip (DVE (Matrox))

1. Click Config and configure the alpha in Video Input.
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Tip: w/Alpha Enable this setting when you need play clips with alpha. You
will therefore either need two clips, or one clip that contains both the fill
and key. If you only implement one clip containing the fill (without a key),
the key will be created dynamically and be fully opaque. For the naming
convention for two clips, the alpha/key clip must have the same name
with an attached _key before the file extension, this means if the main/fill
clip is named example.dif, the alpha/key clip must be named as follows:
example_key.dif. Check also the Supported Codecs.

2. Save and restart Viz Artist.

3. Click Server.

4. In the Properties panel select the Scene Settings tab and click the Video tab.

5. In the left panel of the Video settings, select Clip1.

6. In the right panel of the Video settings, in the Target row, click the DVE button and
adjust the parameters in the DVE control panel.

• Position

• Size

• Alpha: For each layer, you can adjust the level of opacity, where 100% is fully
opaque and 0% is fully transparent.

• Priority: Assigns the position of each layer in the layer stack, where 0 is the
bottom-most layer, and 100 is the top-most layer.

• Crop

Note: BG Graphics are always the lowest in the stack, even below zero, and
FG graphics are assigned a default of 100. As such, you cannot assign a
priority to BG Graphics.

7. In the Clip Name line, click the ellipsis (...) to select a video clip to import.

IMPORTANT! Make sure that the video clip selected has the same resolution
as the channel in question.
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IMPORTANT! Make sure that the correct container and codec is selected.
Check the Supported Codecs.

IMPORTANT! For Dual Channel and Trio OneBox set up see Dual Channel
and Trio Media Box configuration.

8. Configure the playback as follows:

• Autorun: Off means that as soon as the clip is loaded, the first frame is
presented. On means that as soon as the clip is loaded, it begins playing.

• Loop Mode: Off means that the clip will play only once. On means that the
clip will play in a loop.

• Reverse Field: Off means that when backward playback is used (speed is
negative), the fields in interlaced mode are played out as-is. On means the first
as second fields in interlaced mode are swapped.

• Upscale Luma: Off means that the key will be used as-is. On means that the
key information will be upscaled from 16-235 to 0-255.

• Repeat Mode: None means the playout of black frames when the clip is in an
erroneous state. Field means that the first field of the last frame will be played
out when the clip is paused. Frame means that the last frame will be played
out when the clip is paused.

• Speed: Controls playback speed. 1.0 is the normal speed. Values between 0
and 1.0 are forward playback in slow motion. Values above 1.0 are forward
playback in fast motion. Likewise, values between 0 and -1.0 are reverse
playback in slow motion. Values less than -1.0 are reverse playback in fast
motion.

9. In the Clip Control row, click the Play button to test your video clip.

A green ‘traffic light’ indicates that the clip has been loaded successfully. A grey ‘traffic
light’ indicates that no clip has been loaded. A red ‘traffic light’ indicates that there was
an error during the clip loading process.

Clicking the expand button displays addition information. If the clip loaded successfully,
clip details are shown. If the clip did not load successfully, additional error indications
are shown.

To implement a video clip (DVE (DVS))

1. If you intend to have audio, you must first enable it by modifying the Viz
configuration file. Close Viz Artist and in Windows Explorer, browse to C:\Program
Files\Vizrt\Viz3 and open the VIZ- <computer name> .cfg file in the text
editor of your choice.

2. Ensure that the EnableDirectShowAudio flag = 1.

3. Ensure that the clip_load_wouldnt_block flag = 0.

4. Save and close the config file and restart Viz Artist.

5. In the left panel of the Video settings, select Clip Channel 1.

6. In the right panel of the Video settings, in the Target row, click the DVE button.
You can now adjust the parameters in the DVE control panel.

• Position

• Size
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• Cropping

• Alpha For each layer, you can adjust the level of opacity, where 100% is fully
opaque and 0% is fully transparent.

• Priority Assigns the position of each layer in the layer stack, where 0 is the
bottom-most layer, and 100 is the top-most layer.

7. In the right panel select Scene Settings tab and click the Video tab.

Note: BG Graphics are always the lowest in the stack, even below zero, and
FG graphics are assigned a default of 100. As such, you cannot assign a
priority to BG Graphics.

8. In the Clip Name line, click the ellipsis (...) to select a video clip to import.
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IMPORTANT! Make sure that the selected video format works in Windows
Media Player. To use Matrox codecs, see Advanced Issues with Video Codecs.

Note: For Dual Channel and Trio OneBox set up see Dual Channel and Trio
Media Box configuration.

9. In the Clip Control row, click the Play button to test your video clip.

Video Clip Through Texture

This section covers the following procedures:

• To implement a video clip (Texture (Targa))

• To implement a video clip (Texture (Matrox))

• To implement a video clip (Texture (DVS))

To implement a video clip (Texture (Targa))

1. In the right panel select the Scene Settings tab and click the Video tab.

2. In the left panel of the Video settings, select Clip Channel 1.

3. In the right panel of the Video settings, in the Target row, click the Texture
button.

4. In the Clip Name line, click the ellipsis (...) to select a video clip to import.

IMPORTANT! Make sure that the clip selected has the same resolution as
the channel in question.

IMPORTANT! Make sure that the Targa board supports the selected codec
(see Targa Codecs).

Note: For Dual Channel and Trio OneBox set up see Dual Channel and Trio
Media Box configuration.
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Note: BG Graphics are always the lowest in the stack, even below zero, and
FG graphics are assigned a default of 100. As such, you cannot assign a
priority to BG Graphics.

5. In the Clip Control row, click the Play button to test your video clip.

You can now do to the video anything you would do with a texture.

To implement a video clip (Texture (Matrox))

1. Click Config and configure the alpha in Video Input.

Tip: w/Alpha Enable this setting when you need play clips with alpha. You
will therefore either need two clips, or one clip that contains both the fill
and key. If you only implement one clip containing the fill (without a key),
the key will be created dynamically and be fully opaque. For the naming
convention for two clips, the alpha/key clip must have the same name
with an attached _key before the file extension, this means if the main/fill
clip is named example.dif, the alpha/key clip must be named as follows:
example_key.dif. Also check the Supported Codecs.

2. Save and restart Viz Artist.

3. Click Server.

4. In the right panel select the Scene Settings tab and click the Video tab.

5. In the left panel of the Video settings, select Clip Channel 1.

6. In the right panel of the Video settings, in the Target row, click the Texture
button.

7. In the Clip Name line, click the ellipsis (...) to select a video clip to import.

IMPORTANT! Make sure that the clip selected has the same resolution as
the channel in question.

IMPORTANT! Make sure that the correct container and codec is selected
(see the Supported Codecs).
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Note: For Dual Channel and Trio OneBox set up see Dual Channel and Trio
Media Box configuration.

Note: BG Graphics are always the lowest in the stack, even below zero, and
FG graphics are assigned a default of 100. As such, you cannot assign a
priority to BG Graphics.

8. In the Clip Control row, click the Play button to test your video clip.

A green ‘traffic light’ indicates that the clip has been loaded successfully. A grey ‘traffic
light’ indicates that no clip has been loaded. A red ‘traffic light’ indicates that there was
an error during the clip loading process.

Clicking the expand button displays addition information. If the clip loaded successfully,
clip details are shown. If the clip did not load successfully, additional error indications
are shown.

Once loaded you can do to the video anything you would do with a texture.

To implement a video clip (Texture (DVS))

1. If you intend to have audio, you must first enable it by modifying the Viz
configuration file. Close Viz Artist and in Windows Explorer, browse to C:\Program
Files\Vizrt\Viz3 and open the VIZ- <computer name> .cfg file in the text
editor of your choice.

2. Ensure that the EnableDirectShowAudio flag = 1.

3. Ensure that the clip_load_wouldnt_block flag = 0.

4. Save and close the config file and restart Viz Artist.

5. Click Built Ins.

6. In the drop-down menu underneath, select Texture Sources.
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7. Drag and drop the Clip Channel 1 plugin into the scene tree.

8. In the right panel select Scene Settings tab and click the Video tab.

9. In the left panel of the Video settings, select Clip Channel 1.

10. In the Clip Name line, click the ellipsis (...) to select a video clip to import.

IMPORTANT! Make sure that the selected video format works in Windows
Media Player.

Note: For Dual Channel and Trio OneBox set up see Dual Channel and Trio
Media Box configuration.

11. In the Clip Control row, click the Play button to test your video clip.
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You can now do to the video anything you would do with a texture.

Clip Animation in the Stage

You can also implement video as part of an animation. This is useful when clips are
required to interact with animation.

Before you can animate a clip, it must first be implemented in one of the following
ways:

• Video Clip Through DVE

• Video Clip Through Texture

To animate a clip

1. In the main menu, click Stage.

2. In the far left upper panel, click the new director button, marked by a D.

3. Right-click the Scene that appears below, and from the context menus, select
VideoCodec1 (or VideoCodec2, depending on the desired channel) and then
select Clip.

4. In the Key frame that appears to the right, click the dark blue area that is in the
same row as the Clip in the director.

The director’s editor appears at the far right.

5. In the director’s editor, click the ellipsis (...) and browse and select the desired
video clip for the animation.

Note: This does not necessarily have to be the clip enabled in the previous
procedures. It can be any video clip that Viz Artist can play.
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IMPORTANT! If there is a conflict, the last clip selected, whether in the
Stage or the Scene Settings, will be the one to play, with overriding effect.

6. Configure the director’s settings as follows:

• Name of Key frame

• Time is the start time

• End time

• Duration is the interval between the start and end times

• Clip is the clip path and name

• Before Start defines what should happen before the clip starts to play within
the animation. If the button is disabled, it shows the in-frame. If the button is
enabled, it shows black until the animation gets to the clip.

• After End defines what should happen after the animation leaves the clip
key frame. If the button is disabled, it shows the out-frame. If the button is
enabled, it shows black.

• Clip In defines at what time within the clip it should start playing.

• Clip Out defines at what time within the clip it should begin to loop (until the
animation ends).

5.2.5 Keying Mode for Video

There are four types of keying modes built into Viz Artist:

• VizBoldLinear Key

• VizBoldChroma Key

• VizBoldM-zone Key

• VizBoldLibero Key

This section contains information on the following topics and procedures:

• VizBoldLinear Key

• VizBoldChroma Key

• VizBoldM-zone Key

• VizBoldLibero Key

• To Open Keying mode Parameters
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See Also

• Keying Mode Parameters

• Best Practices for Configuring the Keyer

Linear Key

Linear key is standard keying technique in Viz, and can be used for most applications.
This is a logical key (enabled by the Key plugin):

• If a video or clip channel is applied to an object it is treated the same way as if it
would be a static image.

• If it is used as a background image it is the first element to be drawn and all objects
in the scene are drawn on top of it regardless of the key settings in the global
section of scene settings.

• If it is set as the foreground image it will be the last element to be drawn and all
other objects will only be visible in the parts of the screen where the key/alpha of
the video is not 100% (opaque)

Chroma Key

Chroma key is mostly used with a virtual studio.

In chroma keying mode the key/alpha channel for the video source is generated for
each field or frame. When used in a virtual studio, the video source should be dragged
into the foreground image. This way Elements in the scenes without a key will be drawn
first followed by the video source and last Elements with key information. This drawing
order allows for semi transparent objects to be drawn in front of the talent.

The chroma keyer can also be used to cutout people or objects which were filmed
in front of a blue or green screen for head shots or product placement. For sports
applications where only one color needs to be keyed out the chroma keyer can also be
used.

Note: Each input channel has a freely configurable chroma keyer.

M-zone Key

M-zone key is often used in outdoor sporting events broadcasts.

The multi zone keyer prepares the input video to be keyable by the chroma keyer
plugins in the scene tree. It is typically used in sports productions where more than
one color needs to be keyed out. The video source needs to be dragged into the
background image in global settings. An unlimited number of plugins can be created in
the scene, each keying out a different color.

Libero Key

If Viz Libero Clips are to be played, the Keyer must be set to Libero. This way the
chroma key settings from the Viz Libero Clip will be used. Make sure that the clip
comes with the .cid (Camera ID), .trk (for tracking data) and .col file (chroma key
settings).

To Open Keying mode Parameters

1. Click Built Ins.
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2. Click the Texture Sources tab.

3. In the Properties panel click the Scene Settings tab

4. Click the Global Settings tab.

5. Select a video source and drag it onto the Background Image or Foreground
Image drop-zone.

6. Click the Video tab.

7. In the Keying Mode row, click the relevant button to enable the keying method.
Options are:

• Linear

• Chroma key

• M-zone key

• Libero key

Note: For the M-zone key, you must drag and drop the Chroma Key plugin
onto the container holding the video texture in the scene tree.

8. In the Keying Mode row, click the arrow to open up the Keying Mode parameters.

Note: When in DVE mode, only the Linear keying mode is available.

5.2.6 Keying Mode Parameters

The Keying mode parameters are split into panels:

• U-color / V-color

• VizBoldColor Correction

• Restore Dark Colors / Shadows

• VizBoldRestore Bright Colors

• VizBoldSample X and Y

• Best Practices for Configuring the Keyer

See Also

• Keying Mode for Video
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U-color / V-color

U-Color and V-Color: These two parameters set the background color in the YUV color
space. The point set by these two parameters is the reference for the next parameters,
which determine the colors to remove. All colors between the point defined by the U/V-
Color and the Inner UV-Radius will be removed completely and for all colors between
the Inner UV-Radius and the Outer UV-Radius the transparency will be set to a
value between 0% and 100%.

Color Correction

With Color Correction blue or green colors can be removed completely from the image.
This is especially helpful to remove chroma bleed.

• Off: Color Correction is not in use.

• Blue: The parameters for the two neighboring colors (Cyan, Magenta) are active.

• Green: The neighboring colors are Yellow and Cyan.

High values for all these parameters will mean that nearly all tones of this color will
remain unchanged. Low values signify that this tone will be removed completely from
the image.
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Restore Dark Colors / Shadows

Active or Inactive

With the Restore Dark Colors option all pixels with a luminance lower than complete
restoration to the key/alpha will be making the pixel 100% opaque. A pixel with a
luminance between Complete Restoration to and Zero Restoration from: the key
value is interpolated between 0 and 100%. This key is compared with the results of
the chroma key and the higher value will be used. The key value of a pixel where the
luminance is higher than Zero Restoration from will remain unchanged. Gain can be
used to darken dark colors even more if it is set below 1.0. This is useful in a virtual
studio where the set design uses dark colors in the shadow seen through the camera
is lighter in color than the floor. Darkening the shadow will make the final composition
more believable. Gain is only applied to pixels with luminance between 0 and Zero
Restoration To.

Restore Bright Colors

With the Restore Bright Colors option all pixels with a luminance higher than
complete restoration to the key/alpha will be making the pixel 100% opaque. For a
pixel with a luminance between Complete Restoration to and Zero Restoration
from the key value is interpolated between 0 and 100%. This key is compared with the
results of the chroma key and the higher value will be used. The key value of a pixel
where the luminance is lower than Zero Restoration from will remain unchanged. Gain
can be used to make bright colors appear even brighter. Gain is only applied to pixels
with a luminance between 1 and Zero Restoration To.

Sample X and Y

The previous configuration functions give a starting point, but you will still need to
adopt some parameters to increase results. Set the Sample-X /-Y coordinates and the
Sample Width / Height. These parameters define a section of the background in the
video-input. Press the button Sample Now to start the self-configuration.

Best Practices for Configuring the Keyer

• Take advantage of the self-configuration

Before you start to play with the different parameters, let the system configure by
itself. Select a section of the image, which contains in best case all color tones, you
want to key. If you have no foreground objects, you can set the whole input video as
section for the self-configuration.

• Modify the keying color

Put your real foreground objects into the scene. Mostly your objects will still have a
blue edge after the self-configuration. To eliminate it, increase the Outer and Inner UV-
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Radius. When increasing the Inner UV-Radius have a look at opaque foreground objects
in the video. It is perfectly configured if it cuts off also a little bit of the object. Have a
look at tiny things, like hair or transparent objects and modify the Outer UV-Radius to
get a smooth fade out at the edges of these objects.

• Desaturate the blue/green edges

Up till now you have probably had tiny edges around people or objects which are close
to the background color. If you enable color correction by setting it to blue or green, the
color will be replaced.

• Add highlights and shadows

By modifying the add highlights and add shadows, borders of objects will appear, that
you have keyed before by setting the inner and outer radius.

• Play around with it

You can either try to improve the keyer by increasing or decreasing the values, or you
just play around with it.

5.2.7 Seamless Input Channel Switcher

In short this feature works as a software-enabled video and audio crossbar (a co-
ordinated switching system). In earlier versions of Viz Engine every Viz Engine video
channel was bound to one physical video in channel. The usage of another physical
input was only possible if you changed the setting in the configuration. With seamless
input channel switching you can change this binding seamlessly even during play out.
It is also possible to use more inputs than the number of licensed channels, e.g. if your
video card is equipped with an X.RIO card. However, you can only use the number of
licensed channels simultaneously. At the moment the switching is only possible using
commands.

Note: Seamless switching is relevant for X.mio, X.mio2 and X.RIO.

The initial setting is defined by the configuration. During run time you can change the
used video input channel by sending the following commands to Viz Engine.

This section contains information on the following commands:

• Changing the input channel

• Checking the input channel

• Releasing the input channel

• Getting the free physical inputs

Changing the input channel

The following command sets Viz Engine’s video channel 1 to use physical input B as
its source. If used during play out, the change happens at the next frame. If you try to
lease an invalid channel or a channel that is currently used by another Viz Engine input,
you will get Invalid as a result.

RENDERER*VIDEO*VIDEOIN*1*LEASE SET B

Checking the input channel
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The following command checks which physical input is currently mapped to Viz
Engine’s channel 2.

RENDERER*VIDEO*VIDEOIN*2*LEASE GET

Releasing the input channel

The following command releases the currently captured physical input channel.

RENDERER*VIDEO*VIDEOIN*1*LEASE RELEASE

Getting the free physical inputs

The following command lists the free physical inputs as a comma separated list (e.g. A,
C, E, F).

RENDERER*VIDEO*VIDEOIN*3*FREE_DEVICES GET

5.2.8 Supported Codecs

The Matrox X.mio2 Plus 24/6000 card, which can play the SD codecs, except D10/
D12, is Vizrt’s standard card. This model can be upgraded to 8500 class by a license
upgrade.

Note: The 8500 class is only available for X.Mio2 and X.Mio2 Plus, not for X.Mio.
The 8000 class upgrade is available for X.Mio.

All codecs are implemented in the software.

The Matrox X.mio2 Plus 24/8500 card, including all SD codecs, except D10/D12, is
Vizrt’s standard card. This model can be upgraded to any higher model-class by a a
license upgrade.

The following codec types are supported:

• Targa Codecs

• Matrox Codecs

• Quicktime Codecs

5.2.9 Targa Codecs

The Targa card supports these codecs in the following formats:

• DV: DV25, DV50

• MPEG2 I frame, 4:2:2

• IMX D10

5.2.10 Matrox Codecs

Similar to the Pinnacle Targa 3200, the Matrox X.mio, X.mio2 and X.mio2 Plus cards
support a selection of different codecs for both SD and HD.

The Matrox codecs use the Matrox card itself as a kind of a licence dongle, therefore
certain codecs require certain card classes as follows (these classes apply to X.mio,
X.mio2 and X.mio2 Plus):
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• 6000 class (SD codecs only. No D10)

• 8000 class (Same as 6000 + HD codecs and D10, D12)

• 8500 class (Capable of Apple ProRes playback)

The Matrox card supports these codecs in the following formats:

IMPORTANT! Codec DNxHD: The use of codec DNxHD requires its own license,
issued by Vizrt.

• Playback

• PAL

• NTSC

• 720p50

• 720p60M

• 1080i25

• 1080i30M

• Recording

• PAL

• NTSC

• 720p50

• 720p60M

• 1080i25

• 1080i30M

PAL

Generic
Interleaved

.avi MPEG2-
IFrame422

720x576

alpha: no

bitrate: 10-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame4224

720x576

alpha: yes

bitrate: 10-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:0, Elemetary

alpha: no

bitrate: 1-15

PCM
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720x576 bitdepth: 8

VBI: N/A

timecode: N/A

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:0, Programm

720x576

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:0, Transport

720x576

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:2, Elemetary

720x576

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:2, Programm

720x576

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:2, Transport

720x576

alpha: no

bitrate: 5-50

bitdepth: 8

PCM

2 ch: 24 in 32bit;
48kHz
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VBI: N/A

timecode: N/A

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DV/DVCAM 4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUVU 4:2:2

720x576

alpha: no

bitrate: 160

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUAVUA 4:2:2:4

720x576

alpha: no

bitrate: 240

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz
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8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MJpeg Lossless

720x576

alpha: no

bitrate: VBR

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

XDCAM
(OP1a)

.mxf DVCAM 4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

4 ch: 16 in 16bit;
48kHz

XDCAM
(OP1a)

.mxf D10 (IMX) 4:2:2

720x608

alpha: no

bitrate: 30, 40, 50

bitdepth: 10

VBI: required

timecode:
required

AES3

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:0, Elemetary

720x576

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:0, Programm

720x576

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:0, Transport

720x576

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

PCM

2 ch: 24 in 32bit;
48kHz
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timecode: N/A 4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:2, Elemetary

720x576

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:2, Programm

720x576

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:2, Transport

720x576

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO
(OP1a)

.mxf DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO
(OP1a)

.mxf DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz
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8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Panasonic P2
(OP-Atom)

.mxf DVCAM 4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

Panasonic P2
(OP-Atom)

.mxf DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

Panasonic P2
(OP-Atom)

.mxf DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM .mov DVCAM 4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO .mov DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO .mov DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz
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H.246 .mov H.264/AVC

720x576

alpha: no

bitrate: VBR

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DV .dv DVCAM 4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

DV .dv DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

DV .dv DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

Generic
Separate

.avi MPEG2-
IFrame422

720x576

alpha: no

bitrate: 10-50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG2-
IFrame4224

720x576

alpha: yes

bitrate: 10-50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:0, Elemetary

720x576

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:0, Programm

720x576

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A
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timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:0, Transport

720x576

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:2, Elemetary

720x576

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:2, Programm

720x576

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:2, Transport

720x576

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi DV/DVCAM 4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi Uncompressed
YUVU 4:2:2

720x576

alpha: no

bitrate: 160

bitdepth: 8

VBI: N/A

timecode: N/A
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Generic
Separate

.avi Uncompressed
YUAVUA 4:2:2:4

720x576

alpha: no

bitrate: 240

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MJpeg Lossless

720x576

alpha: no

bitrate: VBR

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM .mov DVCAM 4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

DVCPRO .mov DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

DVCPRO .mov DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

H.246 .mov H.264/AVC

720x576

alpha: no

bitrate: VBR

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.wav PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Separate

_vbi.avi vbi

720x1-17

Start Line: 6

bitdepth: 10

VBI: YUYV422
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See Also

• Supported Codecs

NTSC

Generic
Interleaved

.avi MPEG2-
IFrame422

720x480

alpha: no

bitrate: 10-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame4224

720x480

alpha: yes

bitrate: 10-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:0, Elemetary

720x480

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:0, Programm

720x480

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:0, Transport

720x480

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz
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16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:2, Elemetary

720x480

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:2, Programm

720x480

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP SD
4:2:2, Transport

720x480

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DV/DVCAM 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz
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Generic
Interleaved

.avi DVCPRO 50 4:2:2

720x480

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUVU 4:2:2

720x480

alpha: no

bitrate: 160

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUAVUA 4:2:2:4

720x480

alpha: no

bitrate: 240

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MJpeg Lossless

720x480

alpha: no

bitrate: VBR

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

XDCAM
(OP1a)

.mxf DVCAM 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

4 ch: 16 in 16bit;
48kHz

XDCAM
(OP1a)

.mxf D10 (IMX) 4:2:2

720x512

alpha: no

bitrate: 30, 40, 50

bitdepth: 10

VBI: required

AES3

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz
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timecode:
required

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:0, Elemetary

720x480

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:0, Programm

720x480

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:0, Transport

720x480

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:2, Elemetary

720x480

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:2, Programm

720x480

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz
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Generic
MPEG-2
(OP1a)

.mxf MPEG-2 IBP SD
4:2:2, Transport

720x480

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO
(OP1a)

.mxf DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO
(OP1a)

.mxf DVCPRO 50 4:2:2

720x480

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Panasonic P2 .mxf DV/DVCAM 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

Panasonic P2 .mxf DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

Panasonic P2 .mxf DVCPRO 50 4:2:2

720x480

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM
(OP1a)

.mov DVCAM 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

PCM

2 ch: 24 in 32bit;
48kHz
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VBI: N/A

timecode: N/A

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO .mov DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO .mov DVCPRO 50 4:2:2

720x480

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

H.246 .mov H.264/AVC

720x480

alpha: no

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DV .dv DV/DVCAM 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

DV .dv DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

DV .dv DVCPRO 50 4:2:2

720x480

alpha: no

bitrate: 50

bitdepth: 8

PCM

2 ch: 16 in 16bit;
48kHz
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VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG2-
IFrame422

720x480

alpha: no

bitrate: 10-50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG2-
IFrame4224

720x480

alpha: yes

bitrate: 10-50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:0, Elemetary

720x480

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:0, Programm

720x480

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:0, Transport

720x480

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:2, Elemetary

720x480

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:2, Programm

720x480

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP SD
4:2:2, Transport

720x480

alpha: no

bitrate: 5-50

bitdepth: 8

VBI: N/A

timecode: N/A
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Generic
Separate

.avi DV/DVCAM 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi DVCPRO 50 4:2:2

720x480

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi Uncompressed
YUVU 4:2:2

720x480

alpha: no

bitrate: 160

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi Uncompressed
YUAVUA 4:2:2:4

720x480

alpha: no

bitrate: 240

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MJpeg Lossless

720x480

alpha: no

bitrate: VBR

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM
(OP1a)

.mov DVCAM 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

DVCPRO .mov DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

DVCPRO .mov DVCPRO 50 4:2:2

720x480

alpha: no

bitrate: 50
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bitdepth: 8

VBI: N/A

timecode: N/A

H.246 .mov H.264/AVC

720x486

alpha: no

bitrate: VBR

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.wav PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Separate

_vbi.avi vbi

720x1-16

Start Line: 7

bitdepth: 10

VBI: YUYV422

See Also

• Supported Codecs

720p50

Generic
Interleaved

.avi MPEG2-
IFrame422

1280x720

alpha: no

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame4224

1280x720

alpha: yes

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz
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Generic
Interleaved

.avi MPEG-2 IBP HD
4:2:0, Elemetary

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP HD
4:2:0, Program

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP HD
4:2:0, Transport

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP HD
4:2:2, Elemetary

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP HD
4:2:2, Program

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG-2 IBP HD
4:2:2, Transport

alpha: no

bitrate: 5-300

PCM
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1280x720 bitdepth: 8

VBI: N/A

timecode: N/A

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO .avi DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUVU 4:2:2

1280x720

alpha: no

bitrate: 700

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUAVUA 4:2:2:4

1280x720

alpha: no

bitrate: 1050

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

XDCAM
(OP1a)

.mxf XDCAM
HD, IBP HD
4:2:0,Elementary

1280x720

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

4 ch: 16 in 16bit;
48kHz

XDCAM
(OP1a)

.mxf XDCAM HD,
IBP HD 4:2:0,
Program

1280x720

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

4 ch: 16 in 16bit;
48kHz
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XDCAM
(OP1a)

.mxf XDCAM HD,
IBP HD 4:2:0,
Transport

1280x720

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

4 ch: 16 in 16bit;
48kHz

XDCAM
(OP1a)

.mxf XDCAM HD422,
IBP HD 4:2:2,
Elementary

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

8 ch: 24 in 32bit;
48kHz

XDCAM
(OP1a)

.mxf XDCAM HD422,
IBP HD 4:2:2,
Program

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

8 ch: 24 in 32bit;
48kHz

XDCAM
(OP1a)

.mxf XDCAM HD422,
IBP HD 4:2:2,
Transport

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

8 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:0,
Elementary

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

4 ch: 16 in 16bit;
48kHz

8 ch: 16 in 16bit;
48kHz

16 ch: 16 in 16bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2, IBP HD
4:2:0, Program

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

4 ch: 16 in 16bit;
48kHz

8 ch: 16 in 16bit;
48kHz

16 ch: 16 in 16bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2, IBP HD
4:2:0, Transport

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

4 ch: 16 in 16bit;
48kHz

8 ch: 16 in 16bit;
48kHz
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16 ch: 16 in 16bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:2,
Elementary

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2, IBP HD
4:2:2, Program

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
MPEG-2
(OP1a)

.mxf MPEG-2, IBP HD
4:2:2, Transport

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO
(OP1a)

.mxf DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Panasonic P2
(OP-Atom)

.mxf AVCIntra Class
50

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

Panasonic P2
(OP-Atom)

.mxf AVCIntra Class
100

1280x720

alpha: no

bitrate: 100

bitdepth: 8
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VBI: N/A

timecode: N/A

Panasonic P2
(OP-Atom)

.mxf DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

AVC-Intra
(OP1a)

.mxf AVCIntra Class
50

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

AVC-Intra
(OP1a)

.mxf AVCIntra Class
100

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DNxHD 422
(OP-Atom)

.mxf DNxHD 145, 220,
220x

1280x720

alpha: no

bitrate: 100

bitdepth: 8, 10

VBI: N/A

timecode: N/A

DNxHD
(OP1a)

.mxf DNxHD 145, 220,
220x

1280x720

alpha: no

bitrate: 100

bitdepth: 8, 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DVCPRO
Quicktime

.mov DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz
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16 ch: 24 in 32bit;
48kHz

HDV .mov HDV

1280x720

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

XDCAM
(OP1a)

.mov XDCam EX

1280x720

alpha: no

bitrate: 25CBR,
35VBR

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

XDCAM
(OP1a)

.mov XDCam HD 422

1280x720

alpha: no

bitrate: 18-35

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DNxHD .mov DNxHD 4:2:2

1280x720

alpha: no

bitrate: 36, 145,
220

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

H.264 .mov H.264/AVC

1280x720

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz
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ProRes 422 .mov I-Frame 4:2:2

1280x720

alpha: no

bitrate: 147, 220

bitdepth: 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

ProRes 4444 .mov I-Frame 4:4:4:4

1280x720

alpha: yes

bitrate: VBR

bitdepth: 8, 10, 12

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

H.264 .mp4 XDCAM EX

1280x720

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

DV .dv DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

Generic
Separate

.avi MPEG2-
IFrame422

1280x720

alpha: no

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG2-
IFrame4224

1280x720

alpha: yes

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP HD
4:2:0, Elemetary

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8
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VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP HD
4:2:0, Program

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP HD
4:2:0, Transport

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP HD
4:2:2, Elemetary

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP HD
4:2:2, Program

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi MPEG-2 IBP HD
4:2:2, Transport

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

DVCPRO .avi DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi Uncompressed
YUVU 4:2:2

1280x720

alpha: no

bitrate: 700

bitdepth: 8

VBI: N/A

timecode: N/A

Generic
Separate

.avi Uncompressed
YUAVUA 4:2:2:4

1280x720

alpha: no

bitrate: 1050

bitdepth: 8

VBI: N/A

timecode: N/A
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DVCPRO
Quicktime

.mov DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

HDV .mov HDV

1280x720

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM
(OP1a)

.mov XDCam EX

1280x720

alpha: no

bitrate: 25CBR,
35VBR

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM
(OP1a)

.mov XDCam HD 422

1280x720

alpha: no

bitrate: 18-35

bitdepth: 8

VBI: N/A

timecode: N/A

DNxHD .mov DNxHD YUVU
4:2:2

1280x720

alpha: no

bitrate: 36, 145,
220

bitdepth: 8; 10

VBI: N/A

timecode: N/A

H.264 .mov H.264 YUVU
4:2:2

1280x720

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

ProRes 422 .mov I-Frame 4:2:2

1280x720

alpha: no

bitrate: 147, 220

bitdepth: 10

VBI: N/A

timecode: N/A

ProRes 4444 .mov I-Frame 4:4:4:4

1280x720

alpha: yes

bitrate: VBR

bitdepth: 8, 10, 12

VBI: N/A

timecode: N/A
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Generic
Separate

.wav PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Separate

_vbi.avi vbi

1280x1-19

Start Line: 7

bitdepth: 10

VBI: YUYV422

See Also

• Supported Codecs

720p60M

Name Container Codec /
Resolution

Audio

Generic Interleaved .avi MPEG2-
IFrame422

1280x720

alpha: no

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG2-
IFrame4224

1280x720

alpha: yes

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:0,
Elemetary

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz
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Name Container Codec /
Resolution

Audio

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:0,
Program

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:0,
Transport

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:2,
Elemetary

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:2,
Program

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:2,
Transport

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz
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Name Container Codec /
Resolution

Audio

DVCPRO .avi DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi Uncompressed
YUVU 4:2:2

1280x720

alpha: no

bitrate: 850

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi Uncompressed
YUAVUA
4:2:2:4

1280x720

alpha: no

bitrate: 1275

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD, IBP HD
4:2:0,Elementary

1280x720

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

XDCAM (OP1a) .mxf XDCAM HD,
IBP HD 4:2:0,
Program

1280x720

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

XDCAM (OP1a) .mxf XDCAM HD,
IBP HD 4:2:0,
Transport

1280x720

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD422, IBP

alpha: no

bitrate: 50

PCM
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Name Container Codec /
Resolution

Audio

HD 4:2:2,
Elementary

1280x720

bitdepth: 8

VBI: N/A

timecode: N/A

8 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD422, IBP
HD 4:2:2,
Program

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

8 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD422, IBP
HD 4:2:2,
Transport

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

8 ch: 24 in
32bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:0,
Elementary

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

8 ch: 16 in
16bit; 48kHz

16 ch: 16 in
16bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:0,
Program

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

8 ch: 16 in
16bit; 48kHz

16 ch: 16 in
16bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:0,
Transport

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

8 ch: 16 in
16bit; 48kHz

16 ch: 16 in
16bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:2,
Elementary

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

PCM

2 ch: 24 in
32bit; 48kHz
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Name Container Codec /
Resolution

Audio

timecode: N/A 4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:2,
Program

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:2,
Transport

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DVCPRO (OP1a) .mxf DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Panasonic P2 (OP-
Atom)

.mxf AVCIntra
Class 50

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

Panasonic P2 (OP-
Atom)

.mxf AVCIntra
Class 100

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A
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Name Container Codec /
Resolution

Audio

Panasonic P2 (OP-
Atom)

.mxf DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

AVC-Intra (OP1a) .mxf AVCIntra
Class 50

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

AVC-Intra (OP1a) .mxf AVCIntra
Class 100

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DNxHD 422 (OP-
Atom)

.mxf DNxHD 145,
220, 220x

1280x720

alpha: no

bitrate: 100

bitdepth: 8, 10

VBI: N/A

timecode: N/A

DNxHD (OP1a) .mxf DNxHD 145,
220, 220x

1280x720

alpha: no

bitrate: 100

bitdepth: 8, 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DVCPRO Quicktime .mov DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz
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Name Container Codec /
Resolution

Audio

16 ch: 24 in
32bit; 48kHz

HDV .mov HDV

1280x720

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mov XDCam EX

1280x720

alpha: no

bitrate: 25CBR,
35VBR

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mov XDCam HD
422

1280x720

alpha: no

bitrate: 18-35

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DNxHD .mov DNxHD 4:2:2

1280x720

alpha: no

bitrate: 36, 145,
220

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

H.264 .mov H.264/AVC

1280x720

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz



Viz Artist User’s Guide

Page 272 Copyright © 2014 Vizrt

Name Container Codec /
Resolution

Audio

16 ch: 24 in
32bit; 48kHz

ProRes 422 .mov I-Frame 4:2:2

1280x720

alpha: no

bitrate: 147, 220

bitdepth: 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

ProRes 4444 .mov I-Frame
4:4:4:4

1280x720

alpha: yes

bitrate: VBR

bitdepth: 8, 10,
12

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

H.264 .mp4 XDCAM EX

1280x720

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DV .dv DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

Generic Separate .avi MPEG2-
IFrame422

1280x720

alpha: no

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG2-
IFrame4224

1280x720

alpha: yes

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A
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Name Container Codec /
Resolution

Audio

Generic Separate .avi MPEG-2 IBP
HD 4:2:0,
Elemetary

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:0,
Program

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:0,
Transport

1280x720

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:2,
Elemetary

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:2,
Program

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:2,
Transport

1280x720

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

DVCPRO .avi DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi Uncompressed
YUVU 4:2:2

1280x720

alpha: no

bitrate: 850

bitdepth: 8

VBI: N/A

timecode: N/A
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Name Container Codec /
Resolution

Audio

Generic Separate .avi Uncompressed
YUAVUA
4:2:2:4

1280x720

alpha: no

bitrate: 1275

bitdepth: 8

VBI: N/A

timecode: N/A

DVCPRO Quicktime .mov DVCPRO HD

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

HDV .mov HDV

1280x720

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM (OP1a) .mov XDCam EX

1280x720

alpha: no

bitrate: 25CBR,
35VBR

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM (OP1a) .mov XDCam HD
422

1280x720

alpha: no

bitrate: 18-35

bitdepth: 8

VBI: N/A

timecode: N/A

DNxHD .mov DNxHD YUVU
4:2:2

1280x720

alpha: no

bitrate: 36, 145,
220

bitdepth: 8; 10

VBI: N/A

timecode: N/A

H.264 .mov H.264 YUVU
4:2:2

1280x720

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

ProRes 422 .mov I-Frame 4:2:2

1280x720

alpha: no

bitrate: 147, 220

bitdepth: 10

VBI: N/A
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Name Container Codec /
Resolution

Audio

timecode: N/A

ProRes 4444 .mov I-Frame
4:4:4:4

1280x720

alpha: yes

bitrate: VBR

bitdepth: 8, 10,
12

VBI: N/A

timecode: N/A

Generic Separate .wav PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Separate _vbi.avi vbi

1280x1-19

Start Line: 7

bitdepth: 10

VBI: YUYV422

See Also

• Supported Codecs

1080i25

Name Container Codec /
Resolution

Audio

Generic Interleaved .avi MPEG2-
IFrame422

1920x1080

alpha: no

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG2-
IFrame4224

1920x1080

alpha: yes

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz
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Name Container Codec /
Resolution

Audio

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:0,
Elemetary

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:0,
Program

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:0,
Transport

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:2,
Elemetary

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:2,
Program

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz
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Audio

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:2,
Transport

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DVCPRO .avi DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi Uncompressed
YUVU 4:2:2

1920x1080

alpha: no

bitrate: 800

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi Uncompressed
YUAVUA
4:2:2:4

1920x1080

alpha: no

bitrate: 1200

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD, IBP HD
4:2:0,Elementary

1440x1080

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz
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Name Container Codec /
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Audio

XDCAM (OP1a) .mxf XDCAM HD,
IBP HD 4:2:0,
Program

1440x1080

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

XDCAM (OP1a) .mxf XDCAM HD,
IBP HD 4:2:0,
Transport

1440x1080

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD422, IBP
HD 4:2:2,
Elementary

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

8 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD422, IBP HD
4:2:2, Program

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

8 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD422, IBP
HD 4:2:2,
Transport

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

8 ch: 24 in
32bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:0,
Elementary

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

8 ch: 16 in
16bit; 48kHz

16 ch: 16 in
16bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:0,
Program

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

8 ch: 16 in
16bit; 48kHz

16 ch: 16 in
16bit; 48kHz
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Name Container Codec /
Resolution

Audio

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:0,
Transport

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

8 ch: 16 in
16bit; 48kHz

16 ch: 16 in
16bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:2,
Elementary

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:2,
Program

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:2,
Transport

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DVCPRO (OP1a) .mxf DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz
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Audio

Panasonic P2 (OP-
Atom)

.mxf AVCIntra Class
50

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

Panasonic P2 (OP-
Atom)

.mxf AVCIntra Class
100

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

Panasonic P2 (OP-
Atom)

.mxf DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

AVC-Intra (OP1a) .mxf AVCIntra Class
50

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

AVC-Intra (OP1a) .mxf AVCIntra Class
100

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DNxHD 422 (OP-
Atom)

.mxf DNxHD 145,
220, 220x

1920x1080

alpha: no

bitrate: 100

bitdepth: 8, 10

VBI: N/A

timecode: N/A

DNxHD (OP1a) .mxf DNxHD 145,
220, 220x

1920x1080

alpha: no

bitrate: 100

bitdepth: 8, 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 281

Name Container Codec /
Resolution

Audio

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DVCPRO Quicktime .mov DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

HDV .mov HDV

1440x1080

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mov XDCam EX

1920x1080

alpha: no

bitrate: 25CBR,
35VBR

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mov XDCam HD

1440x1080

alpha: no

bitrate: 35

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mov XDCam HD
422

1920x1080

alpha: no

bitrate: 18-35

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz
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Audio

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DNxHD .mov DNxHD 4:2:2

1920x1080

alpha: no

bitrate: 36, 145,
220

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

H.264 .mov H.264/AVC

1920x1080

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

ProRes 422 .mov I-Frame 4:2:2

1280x720

alpha: no

bitrate: 147, 220

bitdepth: 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

ProRes 4444 .mov I-Frame
4:4:4:4

1280x720

alpha: yes

bitrate: VBR

bitdepth: 8, 10,
12

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

H.264 .mp4 XDCAM EX

1280x720

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz
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Audio

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DV .dv DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

Generic Separate .avi MPEG2-
IFrame422

1920x1080

alpha: no

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG2-
IFrame4224

1920x1080

alpha: yes

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:0,
Elemetary

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:0,
Program

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:0,
Transport

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:2,
Elemetary

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:2,
Program

alpha: no

bitrate: 5-300
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Audio

1920x1080 bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:2,
Transport

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

DVCPRO .avi DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi Uncompressed
YUVU 4:2:2

1920x1080

alpha: no

bitrate: 800

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi Uncompressed
YUAVUA
4:2:2:4

1920x1080

alpha: no

bitrate: 1200

bitdepth: 8

VBI: N/A

timecode: N/A

DVCPRO Quicktime .mov DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

HDV .mov HDV

1440x1080

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM (OP1a) .mov XDCam EX

1920x1080

alpha: no

bitrate: 25CBR,
35VBR

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM (OP1a) .mov XDCam HD

1440x1080

alpha: no

bitrate: 35
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Audio

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM (OP1a) .mov XDCam HD
422

1920x1080

alpha: no

bitrate: 18-35

bitdepth: 8

VBI: N/A

timecode: N/A

DNxHD .mov DNxHD YUVU
4:2:2

1920x1080

alpha: no

bitrate: 36, 145,
220

bitdepth: 8; 10

VBI: N/A

timecode: N/A

H.264 .mov H.264 YUVU
4:2:2

1920x1080

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

ProRes 422 .mov I-Frame 4:2:2

1280x720

alpha: no

bitrate: 147, 220

bitdepth: 10

VBI: N/A

timecode: N/A

ProRes 4444 .mov I-Frame
4:4:4:4

1280x720

alpha: yes

bitrate: VBR

bitdepth: 8, 10,
12

VBI: N/A

timecode: N/A

Generic Separate .wav PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Separate _vbi.avi vbi

1920x1-15

Start Line: 6

bitdepth: 10

VBI: YUYV422
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1080i30M

Name Container Codec /
Resolution

Audio

Generic Interleaved .avi MPEG2-
IFrame422

1920x1080

alpha: no

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG2-
IFrame4224

1920x1080

alpha: yes

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:0,
Elemetary

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:0,
Program

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:0,
Transport

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz
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Audio

timecode: N/A 8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:2,
Elemetary

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:2,
Program

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi MPEG-2 IBP
HD 4:2:2,
Transport

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DVCPRO .avi DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi Uncompressed
YUVU 4:2:2

1920x1080

alpha: no

bitrate: 950

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz
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Audio

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Interleaved .avi Uncompressed
YUAVUA
4:2:2:4

1920x1080

alpha: no

bitrate: 1425

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD, IBP HD
4:2:0,Elementary

1440x1080

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

XDCAM (OP1a) .mxf XDCAM HD,
IBP HD 4:2:0,
Program

1440x1080

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

XDCAM (OP1a) .mxf XDCAM HD,
IBP HD 4:2:0,
Transport

1440x1080

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD422, IBP
HD 4:2:2,
Elementary

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

8 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD422, IBP
HD 4:2:2,
Program

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

8 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mxf XDCAM
HD422, IBP
HD 4:2:2,
Transport

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

PCM

8 ch: 24 in
32bit; 48kHz
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Audio

timecode: N/A

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:0,
Elementary

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

8 ch: 16 in
16bit; 48kHz

16 ch: 16 in
16bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:0,
Program

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

8 ch: 16 in
16bit; 48kHz

16 ch: 16 in
16bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:0,
Transport

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

4 ch: 16 in
16bit; 48kHz

8 ch: 16 in
16bit; 48kHz

16 ch: 16 in
16bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:2,
Elementary

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:2,
Program

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz
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Audio

16 ch: 24 in
32bit; 48kHz

Generic MPEG-2
(OP1a)

.mxf MPEG-2, IBP
HD 4:2:2,
Transport

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DVCPRO (OP1a) .mxf DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Panasonic P2 (OP-
Atom)

.mxf AVCIntra Class
50

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

Panasonic P2 (OP-
Atom)

.mxf AVCIntra Class
100

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

Panasonic P2 (OP-
Atom)

.mxf DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

AVC-Intra (OP1a) .mxf AVCIntra Class
50

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz
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Audio

AVC-Intra (OP1a) .mxf AVCIntra Class
100

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DNxHD 422 (OP-
Atom)

.mxf DNxHD 145,
220, 220x

1920x1080

alpha: no

bitrate: 100

bitdepth: 8, 10

VBI: N/A

timecode: N/A

DNxHD (OP1a) .mxf DNxHD 145,
220, 220x

1920x1080

alpha: no

bitrate: 100

bitdepth: 8, 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DVCPRO Quicktime .mov DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

HDV .mov HDV

1440x1080

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mov XDCam EX

1920x1080

alpha: no

bitrate: 25CBR,
35VBR

bitdepth: 8

PCM

2 ch: 24 in
32bit; 48kHz
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Audio

VBI: N/A

timecode: N/A

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mov XDCam HD

1440x1080

alpha: no

bitrate: 35

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

XDCAM (OP1a) .mov XDCam HD
422

1920x1080

alpha: no

bitrate: 18-35

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DNxHD .mov DNxHD 4:2:2

1920x1080

alpha: no

bitrate: 36, 145,
220

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

H.264 .mov H.264/AVC

1920x1080

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

ProRes 422 .mov I-Frame 4:2:2

1280x720

alpha: no

bitrate: 147, 220

bitdepth: 10

VBI: N/A

PCM

2 ch: 24 in
32bit; 48kHz
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Audio

timecode: N/A 4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

ProRes 4444 .mov I-Frame
4:4:4:4

1280x720

alpha: yes

bitrate: VBR

bitdepth: 8, 10,
12

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

H.264 .mp4 XDCAM EX

1280x720

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

DV .dv DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in
16bit; 48kHz

Generic Separate .avi MPEG2-
IFrame422

1920x1080

alpha: no

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG2-
IFrame4224

1920x1080

alpha: yes

bitrate: 50-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:0,
Elemetary

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A
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Audio

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:0,
Program

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:0,
Transport

1920x1080

alpha: no

bitrate: 5-80

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:2,
Elemetary

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:2,
Program

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi MPEG-2 IBP
HD 4:2:2,
Transport

1920x1080

alpha: no

bitrate: 5-300

bitdepth: 8

VBI: N/A

timecode: N/A

DVCPRO .avi DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi Uncompressed
YUVU 4:2:2

1920x1080

alpha: no

bitrate: 950

bitdepth: 8

VBI: N/A

timecode: N/A

Generic Separate .avi Uncompressed
YUAVUA
4:2:2:4

1920x1080

alpha: no

bitrate: 1425

bitdepth: 8

VBI: N/A

timecode: N/A
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Audio

DVCPRO Quicktime .mov DVCPRO HD

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

HDV .mov HDV

1440x1080

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM (OP1a) .mov XDCam EX

1920x1080

alpha: no

bitrate: 25CBR,
35VBR

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM (OP1a) .mov XDCam HD

1440x1080

alpha: no

bitrate: 35

bitdepth: 8

VBI: N/A

timecode: N/A

XDCAM (OP1a) .mov XDCam HD
422

1920x1080

alpha: no

bitrate: 18-35

bitdepth: 8

VBI: N/A

timecode: N/A

DNxHD .mov DNxHD YUVU
4:2:2

1920x1080

alpha: no

bitrate: 36, 145,
220

bitdepth: 8; 10

VBI: N/A

timecode: N/A

H.264 .mov H.264 YUVU
4:2:2

1920x1080

alpha: no

bitrate: VBR

bitdepth: 8; 10

VBI: N/A

timecode: N/A

ProRes 422 .mov I-Frame 4:2:2

1280x720

alpha: no

bitrate: 147, 220

bitdepth: 10

VBI: N/A
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Audio

timecode: N/A

ProRes 4444 .mov I-Frame
4:4:4:4

1280x720

alpha: yes

bitrate: VBR

bitdepth: 8, 10,
12

VBI: N/A

timecode: N/A

Generic Separate .wav PCM

2 ch: 24 in
32bit; 48kHz

4 ch: 24 in
32bit; 48kHz

8 ch: 24 in
32bit; 48kHz

16 ch: 24 in
32bit; 48kHz

Generic Separate _vbi.avi vbi

1920x1-15

Start Line: 6

bitdepth: 10

VBI: YUYV422

See Also

• Supported Codecs

PAL

Name Container Codec /
Resolution

Audio

Generic
Interleaved

.avi DV/DVCAM
4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz
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Audio

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame422

720x576

alpha: no

bitrate: 10-50

bitdepth: 8-11

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame4224

720x576

alpha: yes

bitrate: 10-50

bitdepth: 8-11

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUVU 4:2:2

720x576

alpha: no

bitrate: 160

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz
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Audio

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUAVUA 4:2:2:4

720x576

alpha: no

bitrate: 240

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

P2_MXF .mxf DVCAM 4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: optional

audio: N/A

P2_MXF .mxf DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: optional

audio: N/A

P2_MXF .mxf DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: optional

audio: N/A

XDCAM_MXF .mxf DVCAM 4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: optional

audio: required

PCM

4 ch: 24 in 32bit;
48kHz

XDCAM_MXF .mxf D10 (IMX) 4:2:2

720x608

alpha: no

bitrate: 30, 40, 50

bitdepth: 10

VBI: required

timecode: optional

audio: required

PCM

4 ch: 24 in 24bit;
48kHz

8 ch: 16 in 16bit;
48kHz
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Audio

DVCPRO_MXF .mxf DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: optional

audio: required

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

DVCPRO_MXF .mxf DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: optional

audio: required

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

MATROX_MOV .mov DVCAM 4:2:0

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

MATROX_MOV .mov DVCPRO 4:1:1

720x576

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

MATROX_MOV .mov DVCPRO 50
4:2:2

720x576

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

QT_MOV .mov depending on
your QuickTime
installation

depending on
your QuickTime
installation

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz
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Audio

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

ASF, WMV .asf, .wmv Windows
MediaVideo9

alpha: no

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

Generic
Separate

.wav PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Separate

_vbi.avi vbi

720x2-34

bitdepth: 10

VBI: YUYV422

See Also

• Supported Codecs

NTSC

Name Container Codec /
Resolution

Audio

Generic
Interleaved

.avi DV/DVCAM
4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz
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Audio

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 50
4:2:2

720x480

alpha: no

bitrate: 1-15

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame422

720x480

alpha: no

bitrate: 10-50

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame4224

720x480

alpha: yes

bitrate: 10-50

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUVU 4:2:2

720x480

alpha: no

bitrate: 160

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz
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Audio

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUAVUA 4:2:2:4

720x480

alpha: no

bitrate: 240

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

P2_MXF .mxf DV/DVCAM
4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf DVCPRO 50
4:2:2

720x480

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

XDCAM_MXF .mxf DVCAM 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode:
optional

audio: required

PCM

4 ch: 24 in 32bit;
48kHz

XDCAM_MXF .mxf D10 (IMX) 4:2:2

720x512

alpha: no

bitrate: 30, 40,
50

PCM

4 ch: 24 in 32bit;
48kHz
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Audio

bitdepth: 10

VBI: required

timecode:
optional

audio: required

8 ch: 16 in 16bit;
48kHz

DVCPRO_MXF .mxf DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

audio: required

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

DVCPRO_MXF .mxf DVCPRO 50
4:2:2

720x480

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

audio: required

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

MATROX_MOV .mov DVCAM 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

MATROX_MOV .mov DVCPRO 4:1:1

720x480

alpha: no

bitrate: 25

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

MATROX_MOV .mov DVCPRO 50
4:2:2

720x480

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz
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Name Container Codec /
Resolution

Audio

QT_MOV .mov depending on
your QuickTime
installation

depending on
your QuickTime
installation

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

ASF, WMV .asf, .wmv Windows
MediaVideo9

alpha: no

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

Generic
Separate

.wav PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Separate

_vbi.avi vbi

720x2-32

bitdepth: 10

VBI: YUYV422

See Also

• Supported Codecs

720p50

Name Container Codec /
Resolution

Audio

Generic
Interleaved

.avi MPEG2-
IFrame422

1280x720

alpha: no

bitrate: 50-300

bitdepth: 8-11

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz
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Name Container Codec /
Resolution

Audio

Generic
Interleaved

.avi HD Offline

1280x720

alpha: no

bitrate: N/A

bitdepth: N/A

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame4224

1280x720

alpha: yes

bitrate: 50-300

bitdepth: 8-11

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 100/
D12

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUVU 4:2:2

1280x720

alpha: no

bitrate: 700

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUAVUA 4:2:2:4

alpha: no

bitrate: 1050

PCM
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Name Container Codec /
Resolution

Audio

1280x720 bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

P2_MXF .mxf DVCPRO 100/
D12

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: optional

audio: N/A

P2_MXF .mxf AVCIntra Class
50

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: optional

audio: N/A

P2_MXF .mxf AVCIntra Class
100

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: optional

audio: N/A

P2_MXF .mxf DNxHD 145,
220, 220x

1280x720

alpha: no

bitdepth: 8

VBI: N/A

timecode: optional

audio: N/A

XDCAM_MXF .mxf XDCAM HD422,
IBP HD 4:2:2

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode: optional

audio: required

PCM

8 ch: 24 in 32bit;
48kHz

DVCPRO_MXF .mxf DVCPRO 100/
D12

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

PCM

2 ch: 24 in 32bit;
48kHz
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Name Container Codec /
Resolution

Audio

timecode: optional

audio: required

4 ch: 24 in 32bit;
48kHz

MATROX_MOV .mov DVCPRO 100/
D12

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

QT_MOV .mov depending on
your QuickTime
installation

depending on
your QuickTime
installation

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

ASF, WMV .asf, .wmv Windows
MediaVideo9

alpha: no

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

Generic
Separate

.wav PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Separate

_vbi.avi vbi

1280x1-19

Start Line: 7

bitdepth: 10

VBI: YUYV422

See Also

• Supported Codecs

720p60M
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Name Container Codec /
Resolution

Audio

Generic
Interleaved

.avi MPEG2-
IFrame422

1280x720

alpha: no

bitrate: 50-300

bitdepth: 8-11

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi HD Offline

1280x720

alpha: no

bitrate: N/A

bitdepth: N/A

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame4224

1280x720

alpha: yes

bitrate: 50-300

bitdepth: 8-11

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 100/
D12

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUVU 4:2:2

alpha: no

bitrate: 850

PCM
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Name Container Codec /
Resolution

Audio

1280x720 bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUAVUA
4:2:2:4

1280x720

alpha: no

bitrate: 1275

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

P2_MXF .mxf DVCPRO 100/
D12

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf AVCIntra Class
50

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf AVCIntra Class
100

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf DNxHD 145,
220, 220x

alpha: no

bitdepth: 8

VBI: N/A
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Name Container Codec /
Resolution

Audio

1280x720 timecode:
optional

audio: N/A

XDCAM_MXF .mxf XDCAM
HD422, IBP HD
4:2:2

1280x720

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode:
optional

audio: required

PCM

8 ch: 24 in 32bit;
48kHz

DVCPRO_MXF .mxf DVCPRO 100/
D12

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode:
optional

audio: required

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

MATROX_MOV .mov DVCPRO 100/
D12

1280x720

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

QT_MOV .mov depending
on your
QuickTime
installation

depending on
your QuickTime
installation

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

ASF, WMV .asf, .wmv Windows
MediaVideo9

alpha: no

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

Generic
Separate

.wav PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 311

Name Container Codec /
Resolution

Audio

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Separate

_vbi.avi vbi

1280x1-19

Start Line: 7

bitdepth: 10

VBI: YUYV422

See Also

• Supported Codecs

1080i25

Name Container Codec /
Resolution

Audio

Generic
Interleaved

.avi MPEG2-
IFrame422

1920x1080

alpha: no

bitrate: 50-300

bitdepth: 8-11

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi HD Offline

1920x1080

alpha: no

bitrate: N/A

bitdepth: N/A

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame4224

1920x1080

alpha: yes

bitrate: 50-300

bitdepth: 8-11

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz
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Name Container Codec /
Resolution

Audio

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 100/
D12

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUVU 4:2:2

1920x1080

alpha: no

bitrate: 800

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUAVUA
4:2:2:4

1920x1080

alpha: no

bitrate: 1200

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

P2_MXF .mxf DVCPRO 100/
D12

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf AVCIntra Class
50

1920x1080

alpha: no

bitrate: 50

bitdepth: 8
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Name Container Codec /
Resolution

Audio

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf AVCIntra Class
100

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf DNxHD 145,
220, 220x

1280x720

alpha: no

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

XDCAM_MXF .mxf XDCAM
HD422, IBP HD
4:2:2

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode:
optional

audio: required

PCM

8 ch: 24 in 32bit;
48kHz

DVCPRO_MXF .mxf DVCPRO 100/
D12

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode:
optional

audio: required

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

MATROX_MOV .mov DVCPRO 100/
D12

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

QT_MOV .mov depending
on your
QuickTime
installation

depending on
your QuickTime
installation

PCM

2 ch: 24 in 32bit;
48kHz
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Name Container Codec /
Resolution

Audio

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

ASF, WMV .asf, .wmv Windows
MediaVideo9

alpha: no

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

Generic
Separate

.wav PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Separate

_vbi.avi vbi

1920x1-15

Start Line: 6

bitdepth: 10

VBI: YUYV422

See Also

• Supported Codecs

1080i30M

Name Container Codec /
Resolution

Audio

Generic
Interleaved

.avi MPEG2-
IFrame422

1920x1080

alpha: no

bitrate: 50-300

bitdepth: 8-11

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi HD Offline

1920x1080

alpha: no

bitrate: N/A

bitdepth: N/A

PCM

2 ch: 16 in 16bit;
48kHz
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Name Container Codec /
Resolution

Audio

VBI: N/A

timecode: N/A

audio: optional

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi MPEG2-
IFrame4224

1920x1080

alpha: yes

bitrate: 50-300

bitdepth: 8-11

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi DVCPRO 100/
D12

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUVU 4:2:2

1920x1080

alpha: no

bitrate: 950

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Interleaved

.avi Uncompressed
YUAVUA 4:2:2:4

1920x1080

alpha: no

bitrate: 1425

bitdepth: 8

VBI: N/A

timecode: N/A

PCM

2 ch: 16 in 16bit;
48kHz

2 ch: 24 in 32bit;
48kHz
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Name Container Codec /
Resolution

Audio

audio: optional 4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

P2_MXF .mxf DVCPRO 100/
D12

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf AVCIntra Class
50

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf AVCIntra Class
100

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

P2_MXF .mxf DNxHD 145,
220, 220x

1280x720

alpha: no

bitdepth: 8

VBI: N/A

timecode:
optional

audio: N/A

XDCAM_MXF .mxf XDCAM HD422,
IBP HD 4:2:2

1920x1080

alpha: no

bitrate: 50

bitdepth: 8

VBI: N/A

timecode:
optional

audio: required

PCM

8 ch: 24 in 32bit;
48kHz

DVCPRO_MXF .mxf DVCPRO 100/
D12

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

PCM

2 ch: 24 in 32bit;
48kHz
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Name Container Codec /
Resolution

Audio

VBI: N/A

timecode:
optional

audio: required

4 ch: 24 in 32bit;
48kHz

MATROX_MOV .mov DVCPRO 100/
D12

1920x1080

alpha: no

bitrate: 100

bitdepth: 8

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

QT_MOV .mov depending on
your QuickTime
installation

depending on
your QuickTime
installation

PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

ASF, WMV .asf, .wmv Windows
MediaVideo9

alpha: no

VBI: N/A

timecode: N/A

audio: optional

PCM

2 ch: 24 in 32bit;
48kHz

Generic
Separate

.wav PCM

2 ch: 24 in 32bit;
48kHz

4 ch: 24 in 32bit;
48kHz

8 ch: 24 in 32bit;
48kHz

16 ch: 24 in 32bit;
48kHz

Generic
Separate

_vbi.avi vbi

1920x1-15

Start Line: 6

bitdepth: 10

VBI: YUYV422

5.2.11 Quicktime Codecs

The Quicktime Writer Plugin supports these Quicktime codecs in the following formats:
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Note: Depending on additionally installed Quicktime codec there might be more
codecs available

Name Options

Animation alpha: optional

BMP alpha: no

Cinepak alpha: no

Component Video alpha: no

DV - PAL alpha: no

DV/DVCPRO - NTSC alpha: no

DVCPRO - PAL alpha: no

Graphics alpha: no

H.264 alpha: no

JPEG2k alpha: optional

MPEG-4 Video alpha: no

Motion JPEG A alpha: no

Motion JPEG B alpha: no

Uncompressed alpha: optional

PNG alpha: optional

Photo - JPEG alpha: no

Planar RGB alpha: optional

Sorenson Video alpha: no

Sorenson Video 3 alpha: no

TGA alpha: optional

TIFF alpha: optional

Video alpha: no

See Also

• Supported Codecs
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5.3 Importing
Viz Artist can import Fonts, Images, Objects, Scenes, Audio clips, and Archives from the
source disk and, or network drives.

Note: If Viz Artist is running in Viz Engine mode, the import is limited to only
import archives.

This section contains information on the following topics:

• Import Display

• Supported Files for Import

• Importing Files

• Importing Archives

5.3.1 Import Display

The Import display consists of two panels:

• Server view: Gives access to all folders and projects in the Viz Graphic Hub (1).

• Import area: Gives access to the source drives, where assets can be imported from
(2).

To open the Import panel

• Click the VizBoldImport Button from the Main Menu.
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Import Menu

The Import menu is positioned at the top of the Import panel. When an element type
is selected from the menu, only the assets of that particular type will be listed in the
directory tree.

5.3.2 Supported Files for Import

The following file formats are supported for import:

Fonts

Types Comments

Adobe Type1 fonts .pfb files

Adobe Type2 fonts

True type fonts (recommended, most common format)

Images

Formats Comments

.bw

.gif

.hdr

.png

.ppm

.psd Photoshop, Layers defined in the Photoshop file will be imported as
separate images into the database.

.rgb SGI’s

.rgba

.tex
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Formats Comments

.tga

.tif

.txc

.xpm

3D

Formats

3ds Max .3ds, .fbx

Autocad .dxf

Maya .fbx

Softimage .fbx

VRML 2.0

VRML including animation

Wavefront .obj

IMPORTANT! All objects to be imported into Viz Artist must be “polygon objects”.

Note: A range of products can export to FBX. For more, see Working with FBX
Files.

Materials and Texture Vertices

Formats

.obj

.3Ds

5.3.3 Importing Files

Use File Import to import:

• Fonts

• Images

• Objects

• Scenes

• Audio clips

This section contains information on the following topics and procedures:
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• Path Alias

• Browse for Files to Import

• Hold down the <Ctrl\> key and click on all required files to select multiple files.To
import Selected Files

See Also

• Assign Keywords to Elements

• Supported Files for Import

Path Alias

Using a path alias can help you streamline the import process. Defining Path Aliases
pre-configures file paths that you often use for import operations.

Browse for Files to Import

Use the import directory tree, on the right side of the Import Window, to browse the
directories on a disk:

• <Double-click> on a directory to show its sub directories

• <Click> on a directory to show the contents in the right window

• <Click> on a path alias to quickly jump to this directory

• Hold down the <Ctrl> key and click on all required files to select multiple files.To
import Selected Files

To Import Selected Files

1. Click Import.

2. Open the target project or folder in the Server view.

3. Select the type of file to import:

• Click on the Import Menu, and click on the type of file to import, or

• Press the keyboard shortcut (see Import File Shortcuts):

4. In the Import directory tree, search for the files to import (see Browse for Files to
Import).

5. Select the required file or files.

6. Images only. Select the import compression for the image or images. Click on
Import Compression. Options are:

• None
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• Select automatically: If the source image has an alpha channel, DXT5 will be
used. If the source image does not have an alpha channel, DXT1 will be used.

• DXT1: Works best on images without an alpha channel.

• DXT5: Works best on images with an alpha channel.

7. Drag the file or files to the target project or folder, in the Server Area

5.3.4 Importing Archives

An Archive is a single file that holds various types of Elements and remembers the
project or folder they where stored in.

Note: Archives created with Viz Artist 2.x must not be imported to Viz Artist 3.x in
this way. They need to be imported using the Viz GH Manager. See the separate
Viz Graphic Hub documentation.

This section contains information on the following topics:

• Path Alias

• Archive Content Appearance

• To import an entire archive to the root of Viz Graphic Hub

• To Import an Archive to a Specific Location in Viz Graphic Hub

• To Import Part of an Archive

• To search for import files

Path Alias

Using a path alias can help you streamline the import process. Defining Path Aliases
pre-configures file paths that you often use for import operations.

Archive Content Appearance

You can see differing aspects of an element’s composition by using the pull-down menu
in the preview panel.
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Entry Point View Will show you all Entry Points. An entry point is created for each
element or project or folder you add to an archive via drag and drop.

Folder View Will show you all the objects that are contained in the archive, including
referenced objects as well.

To import an entire archive to the root of Viz Graphic Hub

1. Click Import.

2. Select Archives to Import:

• Click on the Import Menu, and click on Archives to Import, or
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• Press <Ctrl+6>

3. In the Import tree, search for the Archive or Archives to import.

4. Select the required Archive or Archives (see Browse for Files to Import).

5. Click on Import Archive.

Note: Press the Show Content button to show the Archive’s content in the panel
below. The Show Content button can be deactivated for faster performance (some
Archives can take a long time to show).

To Import an Archive to a Specific Location in Viz Graphic Hub

1. Click Import.

2. Select Archives to Import:

• Click on the Import Menu, and click on Archives to Import, or
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• Press <Ctrl+6>

3. In the Import directory tree, search for the Archive or Archives to import (see
Browse for Files to Import).

4. Select the required Archive or Archives in the right side panel.

5. Drag the Archive or Archives to either the:

• the target Folder or Project in the Server View folder tree: The archive will
import

• The Server View element area

Tip: Press the Show Content button (1) to show the Archive’s content. The
Show Content button can be deactivated for faster performance (some
Archives can take a long time to show).

To Import Part of an Archive

1. Click Import.

2. Select Archives to Import:

• Click on the Import Menu, and click on Archives to Import, or
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• Press <Ctrl+6>

3. In the Import directory tree, search for the Archive or Archives to import (see
Browse for Files to Import).

4. Select the required Archive or Archives in the right side panel.

5. From the drop-down menu, select Entry Points View.

6. Select one of the following options:

• To import all entry point files from the archive, drag the File Entry Points file
folder and drop it in the left panel.

• To import a folder and its contents from the archive, drag the desired folder
from the folder entry points and drop it in the left panel.

• To import one or more files, drag and drop them into the left panel.

The archive is imported into the folder selected in the Viz Graphic Hub tree. All
reference files are included to guarantee full functionality.
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Note: To import projects or folders, the same procedure applies, with the
exception that you select Folder View from the pull-down menu, and drag and
drop the desired folder.

To search for import files

Search for files before or after the import for an Archive. Use this feature see if similar
or the same files are present in the system and to find the file’s location after import.

1. <Right-click> any of the Elements in the Archive.

2. Select Search for this file in current GH.

5.4 Archiving
Archiving a scene allows you to export it. To open the archive view, in the main menu,
click Archive. The archive view is displayed in the right panel.

• The pull-down menu is located just below the main menu.

• The left panel is the target area for folders you will archive.

• The right panel is the target area of source files to archive.

• In the bottom panel, there is the Path Aliases, which gives you quick access to
directories in your source disks. There is also the Comments area for assigning
comments to the archive you want to save.

• At the very bottom is the trash can, for removing files from archives. To the right,
there is a field to assign names to archives, with Browse and Save buttons.

Entry points represent the main objects in an archive. Other objects in the archive are
referenced and attached automatically to the archive.

Pull-down Menu
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At the top of the archive view there is a pull-down menu enabling you to switch the way
the content of your archive is shown.

• Scene to Font Only shows the Elements of the selected file type.

• All Shows Elements of all file types.

• Entry Point View Shows only entry points.

• Folder View Shows the folder hierarchy.

• Remove All Removes all Elements from the archive.

5.4.1 Creating an Archive

To create an archive

1. In the main menu, click Archive. The Archive view is shown.

2. From the Server side, drag folders into the Archive view’s left panel and files into
the right panel.

3. If required, enter a comment in the comments area.

Note: Comments can be a maximum of 255 characters.
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4. Either manually or by clicking the ellipsis button (...), enter a file path for the
archive.

5. After the file path, enter a file name for the archive.

6. Click the Save button.

IMPORTANT! When archiving a set of transition logic scenes in Viz Artist, the
archive will not include the geometry (GEOM) objects that are generated by
Viz Template Wizard when creating a template for the control applications. It is
therefore recommended to archive scenes intended for Viz Content Pilot by using
Viz Content Pilot or Viz Template Wizard. If Viz Artist is used, the objects can be
added manually.

5.5 Deploy
The Deploy panel makes it possible to copy Elements with all their necessary data from
one server to another. For example, if a Scene is deployed, all items referenced by the
Scene (Images, Fonts, etc.), will also be deployed.

Note: Available when Deploy is enabled and a valid Deploy server is entered in
the Viz Configuration (see Configuring Viz ).

•  Click to open an Element filter menu (1).

•  Shows information about the deploy action. Choose to close the Deploy
Information panel and keep messages or not. The icon will show orange when
information is added (2).

•  Click to start the deploy action (3).

•  Drag and drop unwanted Elements from the Deploy panel (4).

To deploy selected Elements

1. Click on the Deploy button.

2. Drag and drop all the required Elements from the Server Area to the Deploy Area.

3. Click the Deploy button.

4. Select from:

• Yes: Deploy each Element one at a time.
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• Yes to All: Deploy all Elements together.

• No: Cancel each Element one at a time.

• Cancel:  Cancel the deployment

5. After deployment or cancellation select to clear the deploy list or not.

Note: If the list is not cleared all the Elements will stay in the Deploy list until
required again. The list will automatically clear when Artist is restarted.

To deploy single Elements

1. Click on the Deploy button.

2. Right-click on the selected Element in the Server Area.

3. In the context menu select Deploy...

See Also

Element Context Menu

To delete Elements from the Deploy panel

1. Drag and drop an Element or selected Elements to the trash  .

Element context menu in the Deploy panel
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1. Right-click an Element to open its context menu.

2. Select ‘Search for this file in current GH’.

The Element will show in the Server area.

5.6 Post Rendering
Viz Artist scenes can be exported as video or image files. This process is called post
rendering.

Note: Post rendering is not possible with clips or live video feeds. However, you
can post render clips through the Soft Clip plugin if it is animated through the
stage.

This section contains information on the following topics:

• Post Rendering Screen

• Post Rendering a Scene

• Post Rendering Templates

• Post Rendering Plugins

• Advanced Issues with Video Codecs

• Post Rendering to Targa playable Clips

5.6.1 Post Rendering Screen

In the post render video you will find:

• Template (top far left)

• Post rendering setup (top left)

• Server area (bottom l eft)
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• Plugin property editor (top right)

• Output (bottom right)

• On the far left is the bar where all installed plugins are listed. Additional plugins can
be installed at any time.

• Main Layer shows the scene to be rendered. If you switch to post rendering, the
scene you currently worked on will be set as the main layer.

• Front Layer enables you to set a scene running in front of the main layer.

• Back Layer enables you to set a scene running behind the main layer.

• Offset allows you to set an offset for the main, front and back layer, so they will
start at different times.

• Stop is the number of seconds to pause during the scene’s animation stop points.
If there are stop points in the scene, these are normally lost in the post rendering
process, unless an interval is assigned here.

5.6.2 Post Rendering a Scene

To post render a scene

1. In the main menu, click Post.

2. If no scene is loaded by default, click one in the Server area and drag it onto Main
Layer target area.

3. Select a post rendering plugin, and drag it onto Clip Plugin target area. Your
default options are:

• JPEG

• PNG

• MOV

• TGA

• TIFF

• VideoRenderer

• MatroxFileWriter
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Note: Matrox File Writer requires a Matrox card to be installed.

Note: See Post Rendering Plugins section for additional Matrox File Writer
settings.

4. Optionally, set an Offset.

You can see the how the offset affects the scene in the post rendering area.

5. Optionally, set a Stop (in seconds).

This stops the post rendering after the assigned interval.

6. Select a frame format. Viz always renders 50 images per second for PAL or 60
for NTSC. Depending on the post rendering format, not all of them or not the full
frames are stored. Your options are:

• Full Frame will store 50 or 60 full height frames for each second of video. The
number depends on the video settings, PAL/50 or NTSC/60 frames, and the size
also changes with the video format (720x576 for PAL digital and 720x486 for
NTSC digital). Normally TV is 25 or 30 interleaved frames, but in this case the
post rendering produces twice the amount of pixels needed. An editing system
(or wherever you put the images you render) can throw away 50% of the pixels
and still produce a “normal” video stream.

• Fields Top/Fields Bottom will store 50 fields per second of video. It is the
same amount of data as interlaced top/bottom, but instead of shuffling the
data the post rendering process writes different files for each field.

• Interl. Top, Interl. Bottom will store 25 interlaced frames for each second
of video. Each frame consists of 2 fields (half size of PAL or NTSC for example
720x288). These two fields are combined line by line. Interlaced top means
that the first line of the first field is the first line in the interlaced frame.
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In interlaced bottom the first line of the second field is the first line in the
interlaced frame. This determines field dominance.

• Full Frame Skip will store every other full frame, resulting in 25 (or 30 for
NTSC) frames per second.

7. Select the color settings. Your options are:

• RGB creates RGB images. Here a pixel is represented by 3 bytes containing a
red, green and blue sample.

• RGBA is a red, green and blue sample, along with an additional color sample,
all in a single image. When displayed on top of other images, RGBA pixels
are blended with the background pixel according to the value of this alpha
component.

• RGB AAA For each image rendered, an RGB and an Alpha image are created.

Note: These settings are already fixed for the Matrox File Writer, see the Post
Rendering Plugins section.

8. In the Name field, assign a destination file path and name.

Note: When you drag the scene into the drop zone, path and filename are
automatically assigned. To keep another path that you have selected, click
the Keep Path button, which is the small rectangle to the right of the Name
field.

9. In the Duration field, set the number of frames to be rendered.

10. In the Width field, set a scaling value for the width.

11. In the Height field, set a scaling value for the height.

Note: Beside the Width and Height fields, there is a Lock button. Enabling
the lock allows you to scale height and width proportionately. Disabling the
lock allows you to scale height and width separately. The default setting is
locked.

12. Click the Record button  .

•  During the rendering process the stop button will be shown, which
would enable you to stop the rendering at any time. If you stop the rendering
process the file(s) already written will be kept.

See Also

• Post Rendering Plugins

• Advanced Issues with Video Codecs
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5.6.3 Post Rendering Templates

If you post render scenes often using the same settings, you can create templates that
will allow you to use the same settings each time. In the upper left portion of the Post
Rendering screen, there is a panel for saved templates.

Note: Post rendering templates are saved in the Viz Graphic Hub and not on the
local machine.

To save a post rendering template

1. Configure all the settings in the procedure To post render a scene.

2. In the Templates panel, click Save.

3. Enter a name for the template.

4. Click OK.

Saved templates appear in the Templates panel.
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To change a post rendering template

1. Double-click the post rendering template in the Templates panel.

2. Change the desired settings.

3. Click Save.

To load a post rendering template

• Double-click the post rendering template in the Templates panel.

To rename a post rendering template

1. In the Templates panel, right-click the template and select Rename.

2. Enter a new name and click OK.
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To delete a post rendering template

• In the Templates panel, right-click the template and select Delete <name>.

5.6.4 Post Rendering Plugins

Post rendering plugins define the format of the post rendered files. Out-of-the-box Viz
Artist already offers you a set of image and video rendering plugins:

• Image rendering plugins

• Video clip rendering plugins

Image rendering plugins

Image rendering plugins, such as JPEG, PNG, TGA and TIFF, will all create a single
image of every frame in your scene. The images will be named as you set in the Name
field in the post render setup, with incremental numbers.

Some of the plugins offer a Quality setting that allows you to set the quality level of the
jpeg images to be created.

Video clip rendering plugins

The video rendering plugins render a Scene to a Video clip. If the Video Renderer

or Quicktime Renderer plugin are used, a menu showing all installed video codecs
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will show.

• Available Codecs: List all available codecs.

• Codec Settings: Shows the available codec settings (if available).

• Codec Info: Shows information about the codec (if available).

• FPS: Set the frame rate per second.

• Flicker Filter: Set the Flicker filter rate.

Select the codec to be used and specify the parameters for Frame rate and Flicker
Filter. If the video codec allows, specify codec parameters.

The Matrox File Writer plugin is also a video rendering plugin that is available to
users with a Matrox board installed, and will render the Scene into a Matrox encoded
clip. It uses the Matrox video board to encode and write clips to file in real-time.

Note: The Video Output DVI out setting must be set to Inactive.
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When performing the procedure To post render a scene, note the following additional
settings for this plugin:

• Pipeline Size: The number of internal buffers in frames for the matrox framework
to operate. for SD+720p+1080i should be around one second (~25-30). It is
recommended that you leave the default values.

• TDIR Interval: Set the interval time, in seconds, to update the video file while it is
recorded. The value must be 1 or more (less than one will not activate the

• TDIR feature).

Note: TDIR (Time Delay Instant Replay): This feature allows video playback while
the video clip is being recorded. The new video file metadata is updated every one
second or more (dependant on the TDIR Interval value).

Note: TDIR is only supported on .avi, .p2.mxf, xdcam.mxf, xdcam_422.mxf, .mov,
and .wav containers. The MATROX_MOV .mov containers write a separate file
(<basename>.Ref<.extension>) that is updated to read the .mov file. This
reference file needs to be used while the file is growing. The QT_MOV containers
update the .mov file directly.CreateVideoFile: Set to On to create a fill clip.

• CreateKeyFile: Set to On to create a key file.

• CreateAudioFile: Not in use.

• CreateVbiFile: Not in use.

• CreateProxyFile: Set to On to specify a custom resolution copy of the clip. These
settings behave in a similar manner to the video file options and appear when this is
set to On.

• Video Resolution: Shows clip resolution information.

See Also

• Supported Codecs.
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5.6.5 Advanced Issues with Video Codecs

Many codecs have specific limitations and will only work on certain types of input. It is
not possible to list all things to be aware of, but here are some:

• 24bit uncompressed video is valid but rare. Some programs may have difficulty in
reading such files. Try creating an uncompressed video using RGBA to create a more
common 32bit uncompressed video.

• Not all codecs support both 24bit and 32bit video. You may need to change between
RGB and RGBA to get a specific codec to work.

• Some codecs will work with RGBA but will nevertheless store the video as 24bit.

• If you plan to use an RGBA video in a program that can handle alpha, you need
to make sure that you have KEYFunctions on containers you want to have visible.
Otherwise the alpha channel will be completely blank, thus making the whole video
totally transparent.

• Some codecs require a handle to the top level application window. The Viz Artist
plugin interface is unable to supply such a handle. As a result the configuration
windows of some of the codecs will fail to appear. Also, some codecs will crash
unless they get a handle.

• Files created in raw uncompressed mode looks weird in Windows Media Player. This
is some oddity of the Media Player. The AVI video file contains pure RGB data, but
the Media Player dithers it (often using only 16 colors) for some unknown reason.
As said, the video file is correct and you should be able to import it into other video
editing applications without any problems.

• To create Matrox clips, like DVCPROHD or MPEG I-Frame, you need to have VFW
codecs installed. Since May 14, 2010 Matrox has provided a free codec pack. The
installer is called VFWCodecs-1.0.exe. On machines with a Matrox board and
driver version 7.5 and higher, you do not need to install VFW-Codecs since they are
included in the driver. On machines with a Matrox board and drivers before version
7.5, there’s always a matching VFW-Codecs pack available with the driver. However
do not install VFWCodecs-1.0.exe or any non-matching VFW-Codecs pack on a
machine with a Matrox board and drivers already installed. The following codecs are
included in Matrox’s free codec pack:

• Matrox DV/DVCAM

• Matrox DVCPRO

• Matrox DVCPRO50

• Matrox DVCPRO HD

• Matrox MPEG-2 I-frame in SD and HD resolutions, with or without alpha

• Matrox Uncompressed in SD and HD resolutions, with or without alpha

• Matrox Offline HD

• Matrox M-JPEG and HDV (playback only)

5.6.6 Post Rendering to Targa playable Clips

It is possible to render scenes to Targa clips. The following configuration must be done
prior to the post rendering:

• The PinnacleDV25 or DVCPRO codec must be installed.

• The VideoRenderer plugin must be configured to use this codec.

After this is done, normal post rendering can be performed and the clips are directly
playable by one of the two clip channels on the Targa card. This can typically be used
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to save performance in scenes by post rendering background Elements to a clip file and
thereafter playing the clip file instead of the original background.

Separate Fill and Key Clip

This post rendering also works when rendering separate fill and key clips, for example
you can set up the Video Renderer plugin to create two separate clips, one for fill and
one for key.
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6 Lights

This section contains information on the following topics:

• Working with Light

See Also

• Material Editor

• Materials

6.1 Working with Light
A Light editor makes it possible to modify the light settings in a Scene. A Scene can
have up to eight active simultaneous light sources.

This section contains information on the following topics:

• Light Editor

• Track Objects with Light

• Change the Light Source Parameters in Orthogonal View

• Copy Properties from one Light Source to another

• Light Source Animation

6.1.1 Light Editor

The left panel (1) of the Light editor shows a list of all eight editable light sources. The
right panel (2) shows the parameters for the currently selected light source.

Left Panel

• Number: Shows the light source number, from 1 to 8.

• Type: Shows the light source type that is selected in the parameter panel.

• State: Set the light source On or Off.

• Vis: Set the visibility of the light source to ON or OFF:

• On: The light source can be seen in the Scene Editor panel. For example, if a spot
light is ON, it will be seen in the center of the light and the light cone.

• Off: The light source can not be seen in the output window.
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Note: A light source is only visible, in the Scene Editor, if the Bounding Box (BB
(see Scene Editor Buttons)) is set to ON, regardless of the Vis ON/OFF state.

Note: If the Bounding Box is set to ON, a light source which is set to ON and is
highlighted in the GUI (3) is always visible in the Scene Editor, regardless of the
Vis ON/OFF state.

See Also

• Scene Editor Views

Right Panel

• Type: There are three light source types:

• Local: The Local light source is a positional light. It is near or within the scene,
and the direction of its rays is taken into account in lighting calculations. Local
lights have a greater performance cost than directional lights, due to the additional
calculations. A real-life equivalent to a local light source is a light bulb. The Local
light source has properties for color and position.

• Spot: The Spot light source emits a cone of light. The only objects that are
illuminated are those within the cone. The Spot light source has properties for color,
position, rotation, and attenuation.

• Infinite: The Infinite light source is a directional light. It is considered to be an
infinite distance away from the objects in the scene. Because of the distance,
the rays of light are considered parallel by the time they reach the object. A real
life equivalent to an infinite light source is sunlight. The Infinite light source has
properties for color, position, and rotation. Infinite is selected by default.

• Color: Sets the light source color (see Material Color Properties and Schemes).

• Position: Sets the position of the light source along the X, Y, and Z axis.

• Rotation: Sets the values for Pan, Tilt, and Twist for Spot or Infinite light sources
(available when Infinite or Spot is selected in Type).

• Spot (available when Spot is selected in Type):

• Penumbra: Sets the concentration of the light (penumbra) within the light cone of
the Spot light source. When set to zero, the whole light cone has the same intensity.
If set greater than zero, the intensity decreases away from the centre.

• Cone Angle: Adjust the cone angle to adjust the shape of the light.
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IMPORTANT! A Material Element must be used to show light effects (see Working
with Material Elements).

This section contains information on the following topics:

• To apply light

To apply light

1. Click Built Ins.

2. Click the Geom Plugins tab.

3. Drag an object into the scene tree.

4. Click Server.

5. Click the M (Materials) tab.

6. Drag a Material to the Object in the Scene Tree.

7. Define a color for the material (see Material Color Properties and Schemes).

8. Click the Material button down in the material editor (1) to make the Material
active.

9. In the right panel select the Light tab to view the Light Editor. Light number 1 is
ON by default.

10. In the left panel, click any or all of the light sources in the State column to show
different light perspectives.
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No light

Light 1

Light 6

See Also

• Lighting Container Plugin
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6.1.2 Track Objects with Light

A light source can be set up to track containers regarding both position and direction.
Tracking position means that the position of the source will be in the center of the
container. Tracking direction means that the light source will look at the center of the
container, for example throughout an animation.

This section contains information on the following topics:

• To use a light source to track containers:

To use a light source to track containers:

1. In the scene tree create an object to track position and an object to track rotation.

2. In the right panel select the Light tab.

3. Drag the position object into the position drop zone and the rotation object into
the rotation drop zone.

4. In the right panel select the Container tab.
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5. Track the objects by adjusting the Position.

The following parameters can also be adjusted for tracking with light:

• Active/Inactive: By dragging a container to the drop zone, the light source
tracking is automatically activated. To inactivate the tracking, click the Active/
Inactive button.

• Reset: Disables the light source tracking.
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6.1.3 Change the Light Source Parameters in Orthogonal View

For a light source, position and direction can be set directly in the output area or the
side views by repositioning the light handles. To do this, the light must be activated
and selected in the Light editor, or alternatively the Vis option must be enabled for that
light source.

In the Scene Editor, a Local light source is visualized as a single point. Infinite and
Spot light sources are visualized as an orange line with three small squares, which
are the handles. In addition, a Spot light source has a “wireframe box” that shows
the attenuation or in other words, the scope of the light. The squares at the ends of
the light source slightly differ in size and color (when the light source is not selected).
Handle (1) shows the light source and handle (3) sets the direction and distance of the
light. Handle (2) moves the whole light source without altering the proportionality of
position and direction. Simply drag the handles around to change them.

6.1.4 Copy Properties from one Light Source to another

This section contains information on the following topics:

• To copy light source properties

To copy light source properties

1. In the right panel select the Light tab.

2. Adjust the source properties in the desired numbered light source.

3. Click the numbered source light and drag it onto the target light.

The target light will inherit all properties belonging to the source.

6.1.5 Light Source Animation

All light source parameters can be animated in the same way as all other animations:
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1. Set a value in the Light editor.

2. Add a Key frame.

3. Change the value.

4. Add a Key frame again.

Animations can also easily be created in one of the orthogonal views. There, the
light sources appear as symbols, and by repositioning them and adding key frames,
animation sequences are created. For more information, see Change the Light Source
Parameters in Orthogonal View .

More advanced light source animations are normally created with the light source
tracking feature, see Track Objects with Light .

For more general animation information, see Creating Animations .
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7 Animation Stage

The Stage is the interactive user interface for creating animations. This section
contains descriptive information on all the parts of the Stage.

• Stage Tree Area

• Stage Editor

• Timeline Editor

• Timeline Marker

• Director Control Panel

• Director Editor

• Actor Editor

• Channel Editor

• Dopesheet Editor

• Spline Editor

• Stage Object Editor

• Key frame Editor

• Event Editor

Stage view

The Stage is divided in two:

• The Stage Tree Area (1): Shows a representation of all animated elements in the
current scene.

• The Stage Editor (2): Shows the animated elements as bars along the timeline.
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Tip: To resize the two areas, drag the vertical separator.

To show the Stage

• From the main menu select Stage.

To Show the Stage together with the server area and Scene Editor

• From the main menu, select Server/Stage.

To show the Stage together with the scene tree, server area, and Scene Editor

• From the main menu, select +Tree/Stage.

Note: You must have a screen resolution with a width of greater than 1500 for this
feature to be enabled.

To resize the stage

1. Straddle the mouse pointer over the bottom edge of the stage.

The mouse pointer becomes a two-sided arrow.

2. Click on the border and drag up or down to resize.

See Also

• Scene Editor Animation Controls and Shortcuts

• Stage Controls and Shortcuts

7.1 Stage Tree Area
The Stage Tree area shows a representation of all animated elements in the current
scene.

This section contains information on the following topics:

• Stage Tree

• Stage Tree Bar

• Stage Tree Menu



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 353

7.1.1 Stage Tree

The stage tree shows an overview of all Directors, Actors, and Channels that are used
to create the animations in the current scene.

This section contains information on the these procedures:

• To expand a stage tree branch

• To expand all stage tree branches

• To collapse a stage tree branch

• To collapse all stage tree branches

To expand a stage tree branch

•  Click the Expand icon to the left of the branch name.

To expand all stage tree branches

• Click the Expand button in the Stage Tree Bar or press <Alt> and click the Expand
icon to the left of the branch name.

To collapse a stage tree branch

•  Click the Collapse icon to the left of the branch name.

To collapse all stage tree branches

• Click the Collapse button in the Stage Tree Bar.

7.1.2 Stage Tree Bar

The Stage Tree bar is located above the Stage Tree.

The Stage Tree bar contains the these options:

•  Expand: Expands all branches in the stage tree (see To expand a stage tree
branch).

•  Collapse: Collapses all branches in the stage tree (see To collapse a stage tree
branch).
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•  Zoom Out: Scales the Stage to provide a better overview of complex
animations.

•  Zoom In: Scales the Stage back to standard display.

•  Add New Director: Adds a new director to the stage tree. The icon can also be
dragged to add a new director on a specific position (see To create a director).

•   Add New Action: Adds a new action to a director (see To create an Action
Channel).

•   Jump to Next Animation: If an actor (container) has multiple animation
channels placed on various directors, the next channel in the stage tree will be
selected.

•  Jump to Previous Animation: If an actor (container) has multiple animation
channels placed on various directors, the previous channel in the stage tree will be
selected.

7.1.3 Stage Tree Menu

Directors

Right-click a Director to open a director context menu. For more information about
Directors, see Working with Directors in the Stage Tree.

• Rename: Click to rename the director, see To rename a director.

• Delete [Director]: Click to delete the director, see To delete a director.

• Scene/LIve 1/Live 2 [etc.]: Click to add a Scene or a Scene with an actor and a
editable parameter.

Actors
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Right-click an actor in the stage tree to open an actor context menu. For more
information about Actors see Working with Actors in the Stage Tree.

• Rename: Not available.

• Delete [Actor]: Deletes the actor (see To delete an actor).

• Transformation:

• Position: Creates a position channel for the actor, and automatically adds two
default key frames.

• Rotation: Creates a rotation channel for the actor, and automatically adds two
default key frames.

• Scaling: Creates a scaling channel for the actor, and automatically adds two
default key frames.

Note: If a transformation channel is disabled (grayed out), the channel is already
available for the actor in this director.

• Container:

• Active: Creates an active channel for the actor, and automatically adds two default
key frames. The active status can be modified in the Key frame Editor. If an active
Key frame is set to Value=Off, the whole actor (container) including all animations
will be hidden in the Scene Editor. The action remains hidden until another Key
frame appears in the timeline with Value=On.

• Material: Creates a material channel for the actor, and automatically adds two
default key frames. The material can be modified in the Key frame Editor. For more
information (see Working with Material Elements).

Note: The material option is only available if a material is added to the container.

• [Texture]: This option varies according to the element that is available on the
actor.

Example: If an image is added to the container, various texture options become
available. If a built-in geometry is added, for example a cube, various cube options
become available. If a font is added to the container, various text options become
available. For details about options for the various elements, see the respective
editor sections, for example Image Editor and Fontstyle Editor.

Channels
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Right-click a channel, in the stage tree, to open the channel context menu. For more
information about channels see Working with Channels in the Stage Tree.

• Rename: Not available.

• Delete [Channel]: Deletes a channel (see To delete a channel).

• Split/Unsplit Channel: View or close a Transformation Channel parameters.

Action Channels

Right-click an Action Channel, in the Stage Tree, to open the Action Channel context
menu. For more information see Working with Action Channels in the Stage Tree.

• Rename: Makes it possible to rename an Action Channel (see To rename an Action
Channel).

• Delete [Action Channel]: Deletes an action channel (see To delete an Action
Channel).

Scene Context Menu

Right-click a Scene, in the Stage Tree, to open the Scene context menu.

• Rename: Not available.

• Delete Scene: Deletes a Scene Channel inside the Stage.

• Scene: The Scene options refer to various Scene settings.
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• Live, Clip and Stream (Inputs): Select input parameters such as Alpha, Audio
etc.

See Also

• Working with Clip Key frames

7.2 Stage Editor
The Stage Editor area shows the animated elements as bars and splines along the
timeline.

This section contains information on the following topics:

• Stage Editor Menu

• Stage Editor Bar

See Also

• Timeline Editor

• Timeline Marker

• Spline Editor

• Stage Object Editor

7.2.1 Stage Editor Menu

Above the Stage Tree Area is a menu that defines the appearance of the Stage Editor.

• Show Obj. Editor: Enables/disables the Stage Object Editor at the right side of the
Stage (see To enable/disable the Stage Object Editor).

• Dopesheet View: Shows only the Dopesheet Editor.

• Spline View: Shows only the Spline Editor.

• Dope/Spline View: Shows both the Dopesheet Editor and Spline Editor.

7.2.2 Stage Editor Bar

The Stage Editor bar is located above the Dopesheet Editor/Spline Editor.

The Stage Editor bar contains the following options:

•  Add Key frame: Adds a Key frame at the current time/frame/field (see Working
with Key Frames).
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•   Delete Key frame: Deletes the selected Key frame (see To delete a Key frame).

•  Add Stop/Tag: Adds a stop/tag Event to the selected director at the current
time/frame/field (see To create a new Event).

•  Delete Stop/Tag: Deletes the selected stop/tag Event (see To delete an Event).

•  Linear Left and Right: Sets the left and right spline handles in the selected Key
frame to linear.

•  Smooth Left and Linear Right: Sets the spline handles in the selected Key
frame to smooth left and linear right.

•  Linear Left and Smooth Right: Sets the spline handles in the selected Key
frame to linear left and smooth right.

•  Smooth Left and Right: Sets the left and right spline handles in the selected
Key frame to smooth.

•  Handles Tangential: Sets the left and right spline handles in the selected Key
frame to tangential.

•  Search: Searches the name of a Key frame. The arrow buttons can be
used to search for the first, next, previous and last Key frame matching the search
criteria.

•  Zoom to Standard: Zooms the Dopesheet Editor and Spline Editor to standard
view.

•  Zoom to Whole Spline: Zooms the Dopesheet Editor and Spline Editor to fit the
animation timeline of the current director.

•  Show Spline 1, 2, or 3: Displays spline 1, 2, or 3 in the Spline Editor. The
splines refer to animations performed on various axes. If only one axis is animated,
only the spline 1 option is available.

Example: When animating a rotation, each spline describes the rotation around
one axis. Spline 1 shows the rotation around axis X, spline 2 shows axis Y, and
spline 3 shows axis Z.

•  Animate Timeline Marker: If enabled, the Timeline Marker moves along the
Dopesheet Editor and Spline Editor while playing the animation.

Tip: When computing performance should be reduced to a minimum, this option
should be disabled.

•  Show Info: If enabled, holding the pointer over an item in the Dopesheet or
Spline Editor, for example a Key frame, will show timeline information as a tool tip.

•  Seconds/Frames/Fields: Switches the time scaling between seconds,
frames, and fields. The time scaling is available in the bar separating the Dopesheet
and Spline Editor.

•   Show Grid: If enabled, shows a grid of vertical lines in the Dopesheet and
Spline Editor, making it easier to position items accurately along the timeline.

•  Snap to Grid: If enabled, shows the snap to grid feature in the Dopesheet and
Spline Editor. This feature shows vertical lines at the field interval defined in the
grid width option. By using this feature, key frames and other items can be dragged
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precisely along the timeline, as it is not possible to drop items between the grid
lines.

Example: If the snap to grid feature is enabled and the grid width is set to 10, it
is only possible to drag key frames to field 10, 20, 30, and so on. If a Key frame
should be placed at field 23 while the snap to grid feature is enabled, this must be
manually entered in the Key frame Editor.

•  Grid Width: Defines the width of the snap to grid in fields.

See Also

• Stage Controls and Shortcuts

7.3 Timeline Editor
The Timeline editor is located above the Scene Editor. It gives various options to control
animations.

•  Layer Indicator: The three vertical indicators show the current layer in the
Director Control Panel. The three layers are Front, Main and Back.

•  [Director]: Defines the selected (active) director and opens the Director
Control Panel.

Note: The settings in the Director Control Panel are not saved with the scene. If
only one director is selected, the button will be labelled with the director name.
If multiple directors are selected, the button will be labelled User Defined. If all
directors are selected, the button will be labelled All.

•  Lock Selection: When activated, the director(s) of the selected container in
the scene tree will be active in the stage. When deactivated, locks the selected
director(s) so that no matter where else you click in the scene tree, only the
selected director will be controlled by the buttons in the Timeline Editor.

•  Reverse: If enabled, the animation is played in reverse.

•  Go to Start: The timeline jumps to the start of the current director(s). See To
jump to start of an animation.

•  Start Animation: Plays the current director(s) in the current layer from the
beginning (see To play all animations in a director from the start of the timeline).

•   Stop Animation: Manually stops the currently playing animation at the
current point in the timeline. Right-clicking stops the currently selected director or
directors (see To stop an animation).

Note: The animation is automatically stopped when it reaches the end of the
timeline, or a stop point along the timeline. For more information (see Locked vs
Unlocked Key frames).
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•  Continue Animation: Continues the animation from where it was stopped (see
To continue an animation).

•  Go to End: Jumps to the end of the animation.

•  Key frame Previous: Jumps to the previous Key frame of the selected container
in the scene tree.

•  Timeline: The input box shows the current position on the timeline in
fields.

•  Jump to Next Timeline Position: Jump to the next position in the Timeline.

•  Key frame Next: Jumps to the next Key frame of the selected container in the
scene tree.

•  Set Key: Creates a Key frame at the defined timeline.

•  Lock Timeline Position: When activated, the timeline jumps automatically after a
Set Key operation by the defined Increment Value (see below). When deactivated,
the timeline does not jump after a Set Key operation.

•  Increment Value: The input box defines the step value (in fields) to be
incremented when creating a Key frame.

7.4 Timeline Marker
The timeline marker defines the current position along the time axis (X) in the
Dopesheet and Spline Editor. The timeline marker is shown as a thin red vertical line.

A separate timeline marker is created for each director in the stage tree. Dragging a
timeline marker shows the animation in the Scene Editor accordingly.

If the Show Info option is enabled in the Stage Editor Bar, a tool tip with information
about the current time and belonging director will appear when holding the pointer
over the timeline marker.

If the Animate Timeline Marker option is enabled in the Stage Editor Bar, the timeline
marker is animated in the Dopesheet while playing the animation.

This section contains information on the following procedures:

• To move the timeline marker

• To move the timeline marker five fields on the timeline

• To move the timeline marker one field on the timeline

To move the timeline marker

• Drag the timeline marker along the timeline in either the Dopesheet Editor or Spline
Editor
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or

• Click an empty area of the Dopesheet Editor or Spline Editor.

Note: In complex animations with many directors, channels, and actors, there
might not be an empty area to click. If this is the case, press <Alt> while clicking.

or

• In the Dopesheet Editor, enter the time (in fields) in the Timeline input box.

or

1. Enable the Stage Object Editor.

2. Select the director in the Stage Tree or Dopesheet Editor.

3. In the Director Editor that appears, enter the time (in fields) in the Timeline text
box.

or

• Drag the Timeline in the Scene Editor Timeline editor  .

To move the timeline marker five fields on the timeline

• Press the left or right arrow key on the keyboard.

To move the timeline marker one field on the timeline

There are three methods detailed to move the Timeline Marker:

• Press <Ctrl> and the left or right arrow key on the keyboard

or

• Press <Alt> and the left or right arrow key on the keyboard

or

• Press the Timeline up/down buttons in the Dopesheet Editor or Director Editor.

See Also

• To jump to start of an animation

• To jump to end of an animation
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7.5 Director Control Panel
Clicking the director option in the Timeline Editor opens the Director Control Panel.

The Director Control Panel lists all available Directors of the selected layer. To see all

layers (Front, Main and Back) click the expand icon  .

It is possible to select one or more directors in the list to play them individually. Note
that there are two sets of control buttons; one set for controlling individual directors in
the selected layer and one set for controlling the all directors in all layers.

• Front: Lists the directors belonging to the front layer scene.

• Main: Lists the directors belonging to the main scene.

• Back: Lists the directors belonging to the back layer scene. This button is only
enabled if a back layer has been defined in the Layer Manager.

• All: If activated, selects all directors in the list.

• Start Animation/Play Layer: Plays the current director(s) of all layers or the
selected layer from the beginning (see Basic Animation Functions).

• Stop Animation/Stop Layer: Clicking manually stops the currently playing
animation at the current point on the timeline for all layers or the selected layer.
Right-clicking stops only the selected directors (see Basic Animation Functions).

Note: The animation is automatically stopped when it reaches the end of the
timeline, or a stop point along the timeline (see Locked vs Unlocked Key frames).

• Continue Animation/Continue Layer: Clicking manually continues the animation
of all layers or the selected layer to the next point on the timeline.

• [numbers]: You can save up to 10 combinations of selected directors per layer by
selecting them and dragging them onto one of the numbers. Afterward, when you
click a number, the combination of saved directors is then selected. Note that these
selections are on a per-layer basis and also cannot be saved.

• F, M, B: Enables the layers that should be controlled using the Play Stop and
Continue Layer buttons.

See Also

• Director Editor

• Working with Directors in the Stage Tree

• Working with Directors in the Dopesheet Editor



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 363

7.6 Director Editor
The Director editor shows details about the selected director.

• Name: Defines the name of the director. See To rename a director.

• Offset: Sets the offset in fields for the whole director from the start of the timeline.
This is the easiest way to shift all animations within the director. See To delay
animations in a director using offsets.

• Timeline: Defines the timeline of the director in fields (each director has a separate
timeline). Changing the value in this box will move the Timeline Marker in the
Timeline Editor, and the other way around.

• Reverse: If enabled, the animations in this director will run backwards. For more
information (see To play an animation in reverse).

• Auto Start: If enabled, the animation will start automatically when it is loaded from
the database.

• Use System Time: This function plays seamless looping directors, if you have
multiple scenes with the same background animation. As an example, if you have
multiple scenes for elections but each of the scenes has the same background
animation/director and you set the Use System Time to Active for this director, it
will play the background without dropouts or breaking the loop while loading the
other scenes, as long as they have the same director where the system time is
activated.

•  Go to Start: Jumps to the start of the timeline (see To jump to start of an
animation).

•  Start Animation: Starts the animation from the beginning (see Basic
Animation Functions).

•  Stop Animation: Manually stops the animation at the current timeline (see To
stop an animation).

• The animation is automatically stopped when it reaches the end of the timeline, or a
stop point along the timeline (see Locked vs Unlocked Key frames).

•  Continue Animation: Continues the animation after it has been stopped (see
To continue an animation).

To enable the director editor

1. Perform the procedure To enable/disable the Stage Object Editor.

2. Click a director in the Stage Tree or in the Dopesheet Editor.

See Also
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• Director Control Panel

• Working with Directors in the Stage Tree

• Working with Directors in the Dopesheet Editor

• Stage Controls and Shortcuts

7.7 Actor Editor
The Actor editor shows details about the selected actor.

• Offset: Sets the offset in fields for the whole actor from the start of the timeline.
This is the easiest way to shift all animations within the actor.

To enable the actor editor

1. Perform the procedure To enable/disable the Stage Object Editor.

2. Click an actor in the Stage Tree or in the Dopesheet Editor.

See Also

• Working with Actors in the Stage Tree

• Working with Actors in the Dopesheet Editor

7.8 Channel Editor
The Channel editor shows details about the selected Channel.

This section contains information on the following topics:

• To Enable the Channel editor

• Common Channel Editor Properties

• Position Channel Editor Properties

• Action Channel Editor Properties

See Also

• Working with Channels in the Stage Tree

• Working with Channels in the Dopesheet Editor

To Enable the Channel editor

1. Do the procedure: To enable/disable the Stage Object Editor.

2. Click a Channel in the Stage Tree or in the Dopesheet Editor
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7.8.1 Common Channel Editor Properties

IN:

•  Swing In: Enables swing in.

•  Loop In: Enables loop in.

•  Number of Swings/Loops: Defines the number of swings/loops in.

•  Infinite: Sets number of swings/loops in to infinite (from the start of the
animation).

OUT:

•  Swing Out: Enables swing out.

•  Loop Out: Enables loop out.

•  Number of Swings/Loops: Defines the number of swings/loops out.

•  Infinite: Sets the number of swings/loops out to infinite (animation never ends).

7.8.2 Position Channel Editor Properties

The Position Channel editor has, in addition, these extra parameters that can be
edited:

• Closed Path: When activated, the animation path with go from the last Key frame
to the first. When deactivated, the animation path will remain open.

• Auto Rearrange: By default, this setting is enabled, ensuring that the order of the
key frames in the dopesheet editor is the same as in the Scene Editor so that the
animation only ever continues forward. When disabled, if you change the order of
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the key frames in the dopesheet editor, the spline will remain the same, but the
animation may return from the previously last Key frame to the newly added Key
frame now in last position.

• Loop from Zero: When activated, if there is a gap before an animation loop, the
gap gets included in the loop (like 2.x behavior).

• Speed:

• Manual: Locks all key frames. There is no linear speed with this option. The
duration between each Key frame can be different, depending on the timing value
and the transformation values between the different key frames. The result is that
you will not have a continuous animation speed.

• Linear: Unlocks all key frames. The key frames between the first and last key
frames are locked. If you change the value of either the first or last Key frame, or
any of the key frames in between, the timing will change automatically for each Key
frame. The result is an animation with a continuous speed between all key frames.

• Path:

• Smooth: Sets the animation path to be smooth.

• Linear: Sets the animation path to be linear.

• First/Last Linear: Sets the animation to be linear for the first and last Key frame,
and smooth for the rest.

• First/Last Smooth: Sets the animation to be smooth for the first and last Key
frame, and linear for the rest.

Note: These settings are global for the whole animation in question.

Smooth path

Linear Path

See Also

• Working with Channels in the Stage Tree
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• Working with Channels in the Dopesheet Editor

7.8.3 Action Channel Editor Properties

The Action Channel editor has, in addition, these extra parameters that can be
edited:

• Always Execute Action at 0: If an action is set to execute at 0 on the timeline,
press this button to make sure that the action is executed at 0. If this button is not
pressed (inactive) the action may not work.

See Also

• Action Key Frame Editor Properties

• Working with Action Channels in the Stage Tree

• Working with Action Channels in the Dopesheet Editor

7.9 Dopesheet Editor
The Dopesheet editor displays the items in the stage tree as bars along the timeline.

The items are presented vertically in the Dopesheet editor according to the structure in
the stage tree. The horizontal scaling represents the time value.

Tip: The time value can be set to either seconds, frames, or fields from the Stage
Editor Bar.

The Timeline Marker defines the current time, and the Scene Editor shows the
animation accordingly.
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Dopesheet editor with Snap to Grid option enabled with field width set to 5

The Grid and Snap to Grid options that can be enabled in the Stage Editor Bar make it
possible to position items in the Dopesheet editor more accurately.

Channel tool tip

Key frame tool tip

If the Show Info option is enabled in the Stage Editor Bar, a tool tip with time
information will appear when holding the pointer over an item in the Dopesheet editor.

The Dopesheet editor can contain bars for various stage items: directors, actors,
channels, and so on. Similar to the Stage Tree, directors are displayed with a gray blue
color, container actors with light purple, while channels and actions are displayed with
a gray color.

To build up an animation, key frames and stops/tags can be added to the scene. A Key
frame defines a property at a given time. Multiple key frames belonging to the same
channel are connected in the Dopesheet editor with one or more bars.

Example of animation where stop/tag has been added between two key frames

A stop/tag can be added to a director to end or pause an animation at a given time
(see Working with Events in a Director).
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Example of animation where Cube container is scaled at field 0 and 50

Example: If the scaling of a cube is 1.0 at field 0 and 2.0 at field 50, one Key
frame will be created at field 0 and another at field 50. A bar will connect the two
key frames in the Dopesheet editor.

If the Stage Object Editor is enabled, clicking an item in the Dopesheet editor will open
the corresponding editor. See To enable/disable the Stage Object Editor.

Example: Clicking a director will open the Director Editor, clicking a Key frame
will open the Key frame Editor, and so on.

To enable/disable the dopesheet editor

• From the Stage Editor Menu select Dopesheet View.

Alternatively while holding the pointer over the Stage press the keyboard shortcut
<Ctrl+2>.

To enable the dopesheet editor together with the spline editor

• From the Stage Editor Menu select Dope/Spline View.

Alternatively while holding the pointer over the Stage press the keyboard shortcut
<Ctrl+4>.

To resize the height of the dopesheet editor

• Drag the horizontal separator between the Dopesheet editor and Spline Editor.

To resize the width of the dopesheet editor

• Drag the vertical separator between the Stage Tree Area and Stage Editor.

See Also

• Working with Directors in the Dopesheet Editor

• Working with Actors in the Dopesheet Editor

• Working with Channels in the Dopesheet Editor
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• Working with Action Channels in the Dopesheet Editor

• Working with Key Frames

7.10 Spline Editor
The Spline editor displays the key frames on a channel as splines along the timeline.

The key frames are presented vertically in the Spline editor according to the properties
they possess. The horizontal scaling represents the time value.

Tip: The time value can be set to either seconds, frames, or fields from the Stage
Editor Bar.

The Timeline Marker defines the current time, and the Scene Editor shows the
animation accordingly.

It is possible to drag key frames in the Spline Editor both horizontally (changing the
time) and vertically (changing the value) at once.

This section contains information on the following topics:

• To enable/disable the spline editor

• To enable the spline editor together with the dopesheet editor

• To resize the height of the spline editor

• To resize the width of the spline editor

• To switch between the various splines

• To move key frames in the spline editor

• Position in the Spline Editor

• Rotation in the Spline Editor

• Scale in the Spline Editor

• Material in the Spline Editor

• Additional Best Practices for the Spline Editor

To enable/disable the spline editor

• From the Stage Editor Menu select Spline View.
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Alternatively while holding the pointer over the Stage press the keyboard shortcut
<Ctrl+3>.

To enable the spline editor together with the dopesheet editor

• From the Stage Editor Menu select Dope/Spline View.

Alternatively while holding the pointer over the Stage press the keyboard shortcut
<Ctrl+4>.

To resize the height of the spline editor

• Drag the horizontal separator between the Dopesheet editor and Timeline Marker.

To resize the width of the spline editor

• Drag the vertical separator between the Stage Tree Area and Stage Editor.

To switch between the various splines

• Use the Show Spline 1,2, and 3 buttons from the Stage Editor Bar, or

• Use the keyboard shortcuts <Ctrl+Z>, <Ctrl+X> and <Ctrl+C>

Example of axes X, Y, and Z in the Spline editor

To move key frames in the spline editor

• Select the desired Key frame and drag it around.

• To change only the position on the timeline or the value, press <Shift> to lock the
axes. Keep <Ctrl> pressed while you drag the Key frame if you want to snap to grid
along the timeline.

You can move a Key frame in the spline editor, so either the position on the timeline
(left and right) or the value stored (up and down) in the Key frame will be changed.
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7.10.1 Editing Handles

As each Key frame on the spline has two handles, moving them is the most easy way
to edit the curve. To edit a handle left-click it and drag it around. You will see that the
spline will reflect your movement.

By default you move the handles proportional this way. This means if you change the
handle on one side, the one on the other side will move too. If you want to only edit
the handle on one side, you need to left-click the desired handle. Keep the left button
pressed and press <Ctrl>. If you drag the handle, only the one you drag right now will
move and the other one will stay. This “single handle mode” will be enabled for the Key
frame as long as you press <Ctrl>.

Furthermore you can use the buttons in the main menu to edit the handles at a Key
frame. To do so select the Key frame you want to change the handles in and select the
action in the main menu. For ease of use multiple key frames can be selected.

•  set left and right spline handles in selected Key frame to linear.

•  set spline handles in selected Key frame to smooth left and linear right.

•  set spline handles in selected Key frame to linear left and smooth right.

•  set left and right spline handles in selected Key frame to smooth.

•  set left and right spline handles in selected Key frame to tangential.

See Also

• Scene Editor Animation Controls and Shortcuts

7.10.2 Position in the Spline Editor

If you animate a position, there are much more considerations to make.

See Also

• Path Control

• Spline Control

• Working with Position Key frames

7.10.3 Rotation in the Spline Editor

If you have animated the rotation, you can rotate about up to all three axes at the
same time. In the spline editor three different splines will be shown, one for every
axes. The red one is for the X-axis, the green one for the Y-axis and the blue one for
the Z-axis. For ease of use in the lower left corner you will find indicated which axis is
currently selected.

See Also



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 373

• To create key frames for rotation

• To modify the rotation settings

• Working with Rotation Key frames

7.10.4 Scale in the Spline Editor

If you have animated the scale, you can scale along up to all three axes. In the spline
editor three different splines will be shown (when Prop or Single is selected), one for
every axis. The red one is for the X-axis, the green one for the Y-axis and the blue one
for the Z-axis. For ease of use in the lower left corner you will find indicated which axis
is currently selected.

See Also

• Working with Scale Key frames

7.10.5 Material in the Spline Editor

If you have animated the material, in the spline editor two different splines will be
shown. The red one is for the alpha value, the green one for the shininess. For ease
of use in the lower left corner you will find indicated which parameter is currently
selected.

See Also

• To add and animate a Material

• Animating Material Key frames

7.10.6 Additional Best Practices for the Spline Editor

Normally for each channel only one spline is shown in the spline editor. But there are
animation channels where more splines are available for editing. As you can only edit
the key frames/handles of one spline, you must use the number keys in the Stage
Editor Bar to select the desired spline.

Pressing <Shift> while moving a Key frame in the Spline Editor enables you to drag
it only horizontally or vertically, but not both directions at the same time. Pressing
<Ctrl> while moving a Key frame will enable the Snap to Grid function, allowing the
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Key frame to be placed only at certain timeline intervals. For more information (see
Stage Editor Bar).

When animating certain channels, such as scaling or rotation, up to three splines will
be displayed in the Spline editor, each describing the state along one axis, either X, Y,
or Z. For a better overview, different colors are used; red for X-axis, green for Y-axis,
and blue for Z-axis.Every spline contains various key frames with handles.

Example of Key frame and handle tool tips

If the Show Info option is enabled in the Stage Editor Bar, placing the pointer over a
Key frame or handle will show a tool tip with status information about timeline and
value.

7.11 Stage Object Editor
The Stage Object editor (1) is positioned at the right side of the Stage Editor. The editor
has different views depending on the particular editor it is displaying.

Stage object editor

Example: The Director Editor shows information about directors, the Actor Editor
shows information about actors, the Channel Editor shows information about
channels, the Actor Editor shows information about actions, the Key frame Editor
shows information about key frames, the Event Editor shows information about
stops/tags, and so on.

Clicking an object in the Dopesheet Editor or selecting an item from the stage tree will
open the corresponding editor in the Stage Object Editor.

To enable/disable the Stage Object Editor

• From the Stage Editor Menu select Show Obj. Editor.

• Alternatively, with the mouse pointer over the Stage area, press <Ctrl+1>.
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Stage Object Editor

7.12 Key frame Editor
The Key frame editor shows details about the selected Key frame. To view the Key
frame editor click on a Key frame.

Make sure that the Stage Object Editor is enabled.

This section contains information on the following topics:

• Common Key Frame Editor Properties

• Locked vs Unlocked Key frames

• Action Key Frame Editor Properties

• Working with Position Key frames

• Working with Rotation Key frames

• Working with Scale Key frames

• Animating Material Key frames

• Working with Clip Key frames

See Also

Event Editor

7.12.1 Common Key Frame Editor Properties

• Name: Defines the name of the Key frame. This name is used for external
commands or scripts. For more information, see how To rename a Key frame.

• Time: Defines where along the timeline (in fields) the Key frame is placed.

• Previous: If the property has more than one Key frame, the previous Key frame
along the timeline is selected.

• Next: If the property has more than one Key frame, the next Key frame along the
timeline is selected.

• [Value]: The rest of the Key frame editor options vary according to which property
is being animated.
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Example: For scaling, it is possible to define the size of an object in direction X, Y,
and Z.

See Also

• Locked vs Unlocked Key frames

• Working with Position Key frames

• Working with Rotation Key frames

• Working with Scale Key frames

• Animating Material Key frames

• Working with Clip Key frames

• Event Editor

7.12.2 Locked vs Unlocked Key frames

By default the key frames in the position animation are locked. They store information
about the position of the container along the X-, Y- and Z-axis, as well as the time the
Key frame will be passed by in the animation.

An unlocked Key frame stores only information of the position along X-, Y- and Z-axis,
without the information at which time the Key frame should be passed. To reflect this,
in the object editor for a locked Key frame the Time is grayed out. Furthermore, as
the spline editor shows time and path-percentage, the unlocked key frames will not be
shown there. In the animation editor unlocked key frames will be shown at half height
of locked key frames. Viz Artist calculates the time the Key frame will be passed to fit
with the handles set in the next locked Key frame before and after the unlocked Key
frame.

To better understand the difference between locked and unlocked key frames, create
a simple position animation. You will see the container moving with different speeds
between the key frames. Next unlock all key frames and play the animation once more.
The container will move evenly during the whole animation.

Using unlocked key frames you can define the path to fit your needs without editing the
time for every Key frame. This will save you a great amount of time.

See Also

• Common Key Frame Editor Properties

• Working with Position Key frames

• Working with Rotation Key frames

• Working with Scale Key frames

• Animating Material Key frames

• Working with Clip Key frames

• Event Editor
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7.12.3 Action Key Frame Editor Properties

In addition to the Common Key Frame Editor Properties the Action Key Frame Editor
defines the Action Channel. The action will work when the director timeline equals the
Action Channel Key Frame.

• Value: Enter the command or OS task here

• Type: The action key frames can initialize two main types of actions:

• Command: Use Viz Artist internal commands to execute a great number of
automated tasks in the program. For Viz Artist internal commands documentation
go to <Viz Install Directory>\Documentation\ CommandInterface\index.html>

• Task: A normal shell command, like a dos-prompt. Anything which can initialize
from the OS command prompt can, in principle, be executed as a task in an Action
Key Frame. If the path to the executable file contains spaces, set the complete
path in quotation marks, for example, "c:\program files\microsoft office\office
\winword.exe"

Note: Multiple engine commands can be executed in the Action Key Frame
Editor. The commands must be separated with ; (semi-colon) and on a new
line, for example: RENDERER*TREE*$sometext*GEOM*TEXT SET Hello World;
MAIN_SCENE*STAGE*DIRECTOR*$Default GOTO_TRIO $B $A;

• Dir: Sets which way, forwards or backwards, the animation should go to trigger the
Action Key Frame:

• Both: The Key Frame will be triggered when the animation goes forward and in
reverse.

• Normal: The Key Frame will be triggered when the animation goes forwards.

• Reverse: The Key Frame will be triggered when the animation goes backwards.

• Execute: Starts the action

Examples of Internal Commands for Action Key Frames

Here are some examples of Viz Artist internal commands, which can be used in the
Action Key Frame Editor to create actions:

• THIS_SCENE*: The created action acts on this Scene only

• THIS_EDITOR*: The created action acts on this Editor only

• THIS_DIRECTOR*: The created action acts on this Director only

• THIS_PARENT_DIRECTOR*: The created action acts on this Parent Director only

See Also
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• Action Channel Editor Properties

• Working with Action Channels in the Stage Tree

• Working with Action Channels in the Dopesheet Editor

• Scene Default Values

7.12.4 Working with Position Key frames

A position Key frame contains information about the position of a container at a specific
time. The parameters of position key frames are:

• Speed Control

• Path Control

Speed Control

The Speed control editor lets you to configure speed options.

• Manual Speed: locks all key frames. There is no linear speed with this option. The
duration between each Key frame can be different, depending on the timing value
and the transformation values between the different key frames. The result is that
you will not have a continuous animation speed.

• Linear Speed: unlocks all key frames. The key frames between the first and last
key frames are locked. If you change the value of either the first or last Key frame,
or any of the key frames in between, the timing will change automatically for each
Key frame. The result is an animation with a continuous speed between all key
frames.

Path Control

The Path control editor lets you to set the path.

• Smooth: Sets the animation path to be smooth.

• Linear: Sets the animation path to be linear.

• First/Last Linear: Sets the animation to be linear for the first and last Key frame,
and smooth for the rest.

• First/Last Smooth: Sets the animation to be smooth for the first and last Key
frame, and linear for the rest.

An animation’s path can be either smooth or linear.
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Smooth path

Linear path

See Also

• Locked vs Unlocked Key frames

7.12.5 Working with Rotation Key frames

A rotation Key frame contains information regarding container rotation. In addition to
the default options in the Key frame Editor, for a rotation Key frame it is possible to
define specific rotation options.

Key frame editor with rotation options

• X: Defines the rotation along the X axis.

• Y: Defines the rotation along the Y axis.

• Z: Defines the rotation along the Z axis.

• Angle: Defines the angle of the handles for the path or speed.

• Weight: Defines the weight of the handles for the path or speed.

• Smooth Left/Right: Allows the handles for the path to be smooth.

• Single (S), Locked (L) and Mirror (M): Defines the way handles for the path or
speed should be modified.
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Furthermore in the spline editor three different splines will be shown, one for every
axes. The red one is for the X-axis, the green one for the Y-axis and the blue one for
the Z-axis. As you can only edit the currently selected spline, you must use three spline
buttons at the top of the Dopesheet Editor (or shortcuts <Ctrl+Z>, <Ctrl+X> and <Ctrl
+C>) to select the spline you want to edit. For ease of use in the lower left corner you
will find indicated which axis is currently selected.

7.12.6 Working with Scale Key frames

Scale key frames have to do with the scaling of the object in the animation. For a scale
Key frame, in addition to the default options in the Key frame Editor, it is possible to
define the scaling along the X, Y, and Z axes in the three input boxes.

Key frame editor with scale options

If you have animated the scale, you can scale along up to all three axes. To change all
three scale values, in the object editor you will find an input box for X, one for Y and
one for Z. There you can change if the values should be Locked or if you change them
proportional (Prop) or each Single value.

Furthermore in the spline editor three different splines will be shown (when Prop
or Single is selected), one for every axis. The red one is for the X-axis, the green
one for the Y-axis and the blue one for the Z-axis. As you can only edit the currently
selected spline, you must use three spline buttons at the top of the Dopesheet Editor
(or shortcuts <Ctrl+Z>, <Ctrl+X> and <Ctrl+C>) to select the spline you want to edit.
For ease of use in the lower left corner you will find indicated which axis is currently
selected.

Scale axis, X, Y and Z
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7.12.7 Animating Material Key frames

For a material Key frame, in addition to the default options in the Key frame Editor, it is
possible to define color.

Key frame editor with material options

If you have animated the material, the object editor for the key frames shows a
Material Editor . This allows you to conveniently the change the material.

Furthermore in the spline editor two different splines will be shown. The red one is for
the alpha value, the green one for the shininess. As you can only edit the key frames/
handles of one spline, you must use the number keys in the Stage Editor Bar to select
the desired spline. For ease of use in the lower left corner you will find indicated which
parameter is currently selected.

Alpha and shininess splines

7.12.8 Working with Clip Key frames

Key frame editor with clip options

Time and TimeEnd define the starting and ending time in fields of the key frame. Clip
In and Clip Out mark the corresponding times within the clip itself.

Example:

• Time = 50
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• Time End = 250

• Clip Length = 4 sec (50i clip)

• Clip In = 00:00:01:00

• Clip Out = 00:00:03:00

The clip playback starts 1 second after the director starts. The clip starts at frame 25
and ends at frame 75. Because the key frame duration is twice as long the clip part will
be played twice.

To add a clip to the stage

1. Right-click the director where you want your clip and select Add Scene from the
appearing context menu

2. Right-click the Scene item and from the appearing context menu select, for
example, VideoCodec1 (or 2) and then Clip

• To open the clip’s Key frame editor click the Key frame in the dopesheet

7.13 Event Editor
The Event Editor shows details about the selected Stop, Tag, Pause, Local Stop or Next
Scene Events.

Event Editor

• Name: Set a name for the Event. This name is used for external commands or
scripts (see To name an Event).

• Time: Sets where in the timeline (in frames) the Event is placed (see To move an
Event along the Timeline).

•  Previous/Next buttons: If a Director has more than one Event click the
Previous or Next button to move to the previous or next Event along the timeline.

• Type: Defines the type of Event used:

• Stop (1): Stops the animation until continue animation is clicked. A stop applies for
the director and all subdirectors.

• Tag (3): Shows a position along the timeline. This Event type does not stop the
animation.

• Local Stop (2): Stops the animation until continue animation is clicked. A local stop
only applies for the Director it is placed on, not its subdirectors.

• Pause (4): Stops the animation for a specified amount of frames.
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• Next Scene (5): Mark a position where a Scene ends. The next Scene will start
automatically.

Note: Viz Weather has an automatic play list option where the user does not need
to start the next Scene. The Next Scene Event starts the next Scene automatically
when the current Scene reaches the Next Scene Tag.

• Dir:  Sets the direction where the Event is valid:

• Both: The Event is valid to both normal (forwards) and reverse directions.

• Normal: The Event is only valid when the animation direction is normal (forward).

• Reverse: The Event is only valid when the animation direction is reversed.

To enable the Event Editor

1. Do the procedure To enable/disable the Stage Object Editor.

2. Click an Event in the Dopesheet Editor.

See Also

• Working with Events in a Director
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8 Creating Animations

By creating an animation, the state of an object (for example its position, rotation,
or scaling) is defined at various points in time. Key frames are used to define these
states, and the animation system interpolates between them to create a continuous
animation.

This section contains information on the following topics:

• Working with Directors in the Stage Tree

• Working with Directors in the Dopesheet Editor

• Working with Events in a Director

• Working with Actors in the Stage Tree

• Working with Actors in the Dopesheet Editor

• Working with Channels in the Stage Tree

• Working with Channels in the Dopesheet Editor

• Working with Action Channels in the Stage Tree

• Working with Action Channels in the Dopesheet Editor

• Working with Key Frames

• Basic Animation Functions

• Creating a Basic Animation

• To save a Scene

• Further Advanced Animation Topics

• Creating an Over the Shoulder Scene

See Also

• Scene Editor Animation Controls and Shortcuts

• Stage Controls and Shortcuts

8.1 Working with Directors in the Stage Tree
When creating an animation, there is at least one director in the stage tree. Directors
are used to group a certain set of stage elements, such as actors and channels in the
stage tree. It is possible to create directors at the root level of the stage tree, or as
subdirectors. A director can hold as many items as desired, but to improve usability it
is recommended to group certain items in different directors, especially when working
with complex animations. In addition to improved overview in the stage tree, multiple
directors make it possible to show only the animations contained within each director.
This opens the possibility to for example have multiple animation channels on one
object driven by multiple directors. Each director can also hold controlling elements
such as stop points and actions that only affect the animations within the director (see
Basic Animation Functions).

Directors are displayed in the stage tree with a gray blue background color.

This section contains information on the following procedures:

• To create a director
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• To move a director

• To copy a director

• To rename a director

• To delete a director

See Also

• Working with Directors in the Dopesheet Editor

• Director Control Panel

• Director Editor

To create a director

•  Click the Add New Director button in the Stage Tree Bar.

Alternatively, for greater control of where the (sub)director is created:

• Drag and drop the Add Director icon at the right part of the director label in the
stage tree. (Dropping the icon at the left part of the label will create a director at the
same hierarchy level.)

To move a director

• Drag one or more directors to a different place in the stage tree hierarchy.

To copy a director

• Press <Ctrl> while dragging one or more directors to a different place in the stage
tree hierarchy.

To rename a director

1. Right-click a director in the stage tree.

2. In the Stage Tree Menu that appears, select Rename.

3. In the text box that appears, type a new descriptive name, and then press
<Enter>.

Note: Special characters, such as space, are not allowed in director names.

Alternatively:

1. Enable the Director Editor.

2. Select the director in the stage tree.
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3. In the editor that appears, type a descriptive name in the Name text box, and
then press <Enter>.

To delete a director

1. Right-click a director in the stage tree.

2. In the Stage Tree Menu that appears, select Delete [Director].

Alternatively:

• Drag the director to the trash can.

8.2 Working with Directors in the Dopesheet Editor
Most actions on actors are done when Working with Directors in the Stage Tree. Actions
affecting the timeline are performed directly in the dopesheet editor. Working with
directors in the dopesheet editor enables the Director Editor.

Directors are displayed in the Dopesheet Editor with a gray-blue color.

This section contains information on the following topics:

• To mark a region within a director

• To move a director in the timeline

• To Speed Up or Slow Down a Director

See Also

• Working with Directors in the Stage Tree

• Director Control Panel

• Director Editor

To mark a region within a director

1. In the Dopesheet Editor, press <T> and click a starting point within a director.

2. Press <T> again and click an ending point within the director.
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Dragging the green knobs to lengthen or shorten the selected region within the director
affects only the key frames inside this region.

To move a director in the timeline

• Drag the director to a different time.

To Speed Up or Slow Down a Director

• Click on the start or the end of the director.

• Drag the start or end point to change the director speed:

• Speed up: Lengthen the director

• Slow Down: Shorten the director.

8.3 Working with Events in a Director
Events can be added to a Director to add control to an animation. Events that can be
added to the Director are:

• Stop: Stops the animation until continue animation is clicked. A stop applies for the
director and all subdirectors.

• Tag: Shows a position along the timeline. This Event type does not stop the
animation:

• see To create a Tag (preview point) for Viz Content Pilot

• see To create a Tag (preview point) for Viz Trio

• see To create a Tag (preview point) for Viz Trio with local preview

• Local Stop: Stops the animation until continue animation is clicked. A local stop
only applies for the Director it is placed on, not its subdirectors.

• Pause: Stops the animation for a specified amount of frames.

• Next Scene: Mark a position where a Scene ends. The next Scene will start
automatically.

Note: Viz Weather has an automatic play list option where the user does not need
to start the next Scene. The Next Scene tag starts the next Scene automatically
when the current Scene reaches the Next Scene Tag.
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This section contains information on the following procedures:

• To create a new Event

• To change an Event Type

• To move an Event along the Timeline

• To name an Event

• To delete an Event

To create a new Event

1. Click on a Director in the Stage Tree  .

2. Set the Timeline Marker to the point where the new Event is to be added.

3. Add an Event:

• Click the Add Stop/Tag button in the Stage Editor Bar, or

• Press S and click in a Director where the new Event is to be added.

Note: The default new Event is a Stop Event.

4. If required, change the Event type (see To change an Event Type).

To change an Event Type

1. Enable the Event Editor in the Stage.

2. In the Director, select the Event to be change.

3. In the Event Editor, click an Event type button in the Type area to change status.

4. If Pause is selected: In the Value box, define the number of frames that the
animation should pause for, before it continues.

To move an Event along the Timeline

1. Select one or more Events.

2. Drag the selected Events along the Director Timeline.

Note: To select more than one Event press and hold <Ctrl> and click on each
required Event.

or

1. Enable the Event Editor in the Stage.

2. Select an Event in the Director.

3. Move the selected Event:

• In the Event Editor, enter the new position (in frames) in the Time input box, or

• Click in the Time input box and drag left or right.
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Note: This moves only the last selected Event in the Director.

To name an Event

1. Enable the Event Editor in the Stage.

2. Select an Event in the Director Timeline.

3. In the Event Editor, enter a descriptive name in the Name text box.

4. Press <Enter>.

Note: Special characters, such as space, are not allowed in Event names.

To delete an Event

1. Select the Event to be deleted.

2. Click the Delete Stop/Tag button in the Stage Editor Bar  .

or

1. Select one or more Events.

2. Press <Delete>.

To create a Tag (preview point) for Viz Content Pilot

1. Open the Stage, and select the default Director.

2. Position the Time Marker at the point where the Scene is to be previewed.

3. Click the Add Stop/Tag button in the Stage Editor Bar to add an Event.

4. In the Event Editor enter pilot1 (case sensitive) in the Name text box.

Note: The pilot1 Event is the default preview point for a standalone Scene
or a foreground Scene in a transition logic Scene.

Note: The name pilot1 is the Tag name requested by the control
applications. For more Tags (preview points) continue with pilot2, pilot3, etc.

5. Click on Tag in the Type area.

Note: Custom Tag Events can be used as well; however, those Tags Events are
only selectable within the Newsroom Component.

To create a Tag (preview point) for Viz Trio

• Do the procedure on how To create a Tag (preview point) for Viz Content Pilot.
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To create a Tag (preview point) for Viz Trio with local preview

1. Open the Stage, and select the default Director.

2. Position the Time Marker at the point where the Scene is to be previewed.

3. Click the Add Stop/Tag button in the Stage Editor Bar to add an Event.

4. In the Event Editor enter the  Name as 01, 02, 03, etc. according to the value of
the corresponding Field identifiers (01, 02, 03, etc.).

• Setting these points will, when a tab field in Viz Trio is selected (01, 02, 03, etc.),
preview the Scene in the local Viz Trio preview window.

See Also

• Tables and Preview Points

8.4 Working with Actors in the Stage Tree
A Container is represented as an Actor in the Stage Tree. The Actor carries the same
name in the Stage Tree as the corresponding Container in the Scene Tree. If the
Container is renamed, the Actor will reflect the change.

If an Actor or Actor channel is clicked on it will also show the relevant Container (in the
Scene tree) and object (in the Scene Editor).

Note: If multiple Actors or Actor Channels are selected this is also shown in the
Scene Tree and Scene Editor.

When adding an animation to a Container, the corresponding Actor and channel will
automatically appear in the Stage Tree inside a Director. The Actor for a Container
holds the information of all animated channels: Scene, Camera, or Light.

As it is possible to place different animation channels of an Actor in separate Directors,
the same Actor can be available in several places in the Stage Tree.

Container actors are shown in the Stage Tree as light purple. Scene actors are shown as
green, Camera actors as dark purple, and Light actors as dark gray.
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This section contains information on the following procedures:

• To move an actor

• To copy an actor

• To delete an actor

See Also

• Working with Actors in the Dopesheet Editor

• Working with Channels in the Stage Tree

• Actor Editor

To move an actor

• Drag one or more actors from a director in the stage tree to the target director.

To copy an actor
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• Press <Ctrl> while dragging one or more actors from a director in the stage tree to
the target director.

To delete an actor

1. Right-click an actor in the stage tree.

2. In the Stage Tree Menu that appears, select Delete [Actor].

Alternatively:

• Drag the actor to the trash can.

8.5 Working with Actors in the Dopesheet Editor
Most actions on actors are done when Working with Actors in the Stage Tree. Actions
affecting the timeline are performed directly in the dopesheet editor. Working with
actors in the dopesheet editor enables the Actor Editor.

This section contains information on the following procedures:

• To move an actor in the timeline

• To Speed Up or Slow Down an Actor

• To delay all the animations in an actor
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See Also

• Working with Actors in the Stage Tree

• Working with Channels in the Stage Tree

• Actor Editor

To move an actor in the timeline

• Drag the actor to a different time.

To Speed Up or Slow Down an Actor

• Click on the start or the end of the Actor.

• Drag the start or end point to change the Actor speed:

• Speed up: Lengthen the Actor

• Slow Down: Shorten the Actor.

To delay all the animations in an actor

1. Enable the Actor Editor.

2. Select an actor.

3. In the Actor Editor, set the Offset value (in fields).

Alternatively, it is possible to move the actor (horizontally along the timeline) including
all its animations directly in the Dopesheet Editor, although this will not actually add
the offset value.

8.6 Working with Channels in the Stage Tree
Every animated property of an actor is stored in a separate channel. Separate
channels are created for position, rotation, scaling, and so on. The channel is named
automatically according to the property being animated. It is not possible to rename a
channel.

Along the channel, key frames are placed. Key frames hold information about the
value of the property at the time they are placed on the timeline. If key frames are not
connected by a channel in the Dopesheet Editor, the information about the property is
identical, and there is no animation of this property between these key frames.

This section contains information on the following procedures:
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• To move a channel

• To copy a channel

• To select a channel

• To delete a channel

See Also

• Working with Channels in the Dopesheet Editor

• Working with Actors in the Stage Tree

• Working with Key Frames

• Channel Editor

To move a channel

• Drag one or more channels from a director in the stage tree to the target director.

To copy a channel
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• Press <Ctrl> while dragging one or more channels from a director in the stage tree
to the target director.

To select a channel

• Click a channel in the Dopesheet Editor.

Alternatively:

• Click one or more channels in the stage tree.

To delete a channel

1. Right-click a channel in the stage tree.

2. In the Stage Tree Menu that appears, select Delete [Channel].

Alternatively:

• Drag the channel to the trash can.

See Also

• Animating Channels

• Dopesheet Editor
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• Spline Editor

8.7 Working with Channels in the Dopesheet Editor
Most actions on Channels are done when Working with Channels in the Stage Tree.
Actions which affect the timeline are performed directly in the dopesheet editor.
Working with channels in the dopesheet editor enables the Channel Editor.

This section contains information on the following topics:

• To move a channel in the timeline

• To Speed Up or Slow Down a Channel

See Also

• Working with Channels in the Stage Tree

• Working with Actors in the Stage Tree

• Animating Channels

• Channel Editor

To move a channel in the timeline

• Drag the channel to a different time.

To Speed Up or Slow Down a Channel

• Click on the start or the end Key Frame of the Channel.

• Drag the start or end Key Frame to change the Channel speed:

• Speed up: Lengthen the Channel

• Slow Down: Shorten the Channel

8.8 Working with Action Channels in the Stage Tree
Actions Channels are control elements which do special tasks when the timeline passes
them.

Regular Channels are typically basic actions that can be created through the use of the
Viz Artist GUI. For example, the rotation of a cube can be defined in the Transformation
Editor of the cube container. For more special scenarios, such as audio animations, it
may not be possible to create the animations based on the standard options. In such
cases it is necessary to create actions with custom scripts that suit the situation.
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To create an action, it is necessary to first create an Action Channel. Action Channels
are colored cyan in the stage tree (1).

This section contains information on the these procedures:

• To create an Action Channel

• To move an Action Channel

• To copy an Action Channel

• To rename an Action Channel

• To delete an Action Channel

• To edit the Action Channel

• VizBoldAction Channel Editor Properties

See Also

• Working with Action Channels in the Dopesheet Editor

• Working with Key Frames

To create an Action Channel

1. Select a Director in the Stage tree.

2. Click the Add New Action button in the Stage Tree Bar.

3. In the dialog box that opens, type a new descriptive name for the action channel,
and then press <Enter> or click the <OK> button.

Note: Special characters, such as space, are not allowed in action channel names.

or:

1. Drag the Add New Action icon in the Stage Tree Bar to a director in the stage
tree.

2. In the dialog box that opens, type a descriptive name for the action channel, and
then press <Enter> or click the <OK> button.

To move an Action Channel

• Drag an action channel from a director in the stage tree to the target director.

To copy an Action Channel

• Press <Ctrl> while dragging an action channel from a director in the stage tree to
the target director.

To rename an Action Channel
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1. Right-click an action channel in the stage tree.

2. In the Stage Tree Menu that appears, select Rename.

3. In the text box that appears, type a new descriptive name, and press <Enter>.

Note: Special characters, such as space, are not allowed in action channel names.

To delete an Action Channel

1. Right-click an action channel in the stage tree.

2. In the Stage Tree Menu that appears, select Delete [Action Channel].

or:

• Drag the action channel to the trash can.

To edit the Action Channel

1. Highlight the Action Channel (1).

2. Click on the Action Channel KeyFrame in the Stage Editor area (2) to open the
Action Channel Editor.

3. In the Action Channel Editor define the action of the Key frame. The action will
work when the director timeline equals the Action Channel Key frame.
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Action Channel Editor Properties

• Name: Set the name on the Key frame

• Time: Shows the key frames time value

• Value: Enter you command or OS task here.

• Type: The action key frames can initialize two main types of actions:

• Command: Viz Artist internal commands. These can execute a great number of
tasks in the program. Many elements can be automated by using commands. For
documentation on this, “External Control Commands” on page 151

• Task: A normal shell command, like a dos-prompt. Anything you can initialize from
the OS command prompt can in principle be executed as a task in an action Key
frame. If the path to the executable file contains spaces, you must set the complete
path in quotation marks, like: "c:\program files\microsoft office\office\winword.exe".

• Dir: Sets which way, forwards or backwards, the animation should go to trigger the
action Key frame:

• Both: The Key frame will be triggered when the animation goes forward and in
reverse.

• Normal: The Key frame will be triggered when the animation goes forwards.

• Reverse: The Key frame will be triggered when the animation goes backwards.

• Execute: Executes the action

8.9 Working with Action Channels in the Dopesheet Editor
Most procedures on action channels are done when Working with Action Channels
in the Stage Tree. Procedures affecting the timeline are performed directly in the
dopesheet editor. Working with action channels in the dopesheet editor enables the
Action Channel Editor.

This section contains information on the following procedures:

• To move an action channel in the timeline

• To Speed Up or Slow Down an Action Channel

See Also

• Working with Action Channels in the Stage Tree

To move an action channel in the timeline

• Drag the action to a different time.

To Speed Up or Slow Down an Action Channel
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• Click on the start or the end Key Frame of the Action Channel.

• Drag the start or end Key Frame to change the Action Channel speed:

• Speed up: Lengthen the Action Channel

• Slow Down: Shorten the Action Channel

8.10 Working with Key Frames
A Key frame stores information about a property at a given time. Key frames can be
added to channels and action channels. If two key frames next to each other hold
different values, the key frames are connected with a bar in the Dopesheet Editor.

When selecting a Key frame in the dopesheet editor or the Spline Editor, the
corresponding Key frame in the other editor will be selected too. Working with key
frames in the dopesheet enables the Key frame Editor.

Example of cube with animated position; two key frames and bar between

Example: The position of a cube can be at X=0 at field 0 and X=100 at field 50.
In such a scenario, two key frames will be created, one at field 0 and one at field
50. Since the position of the cube is different in the two key frames, a bar is added
between them, indicating that an animation takes place when the timeline moves
from Key frame A to Key frame B.

This section contains information on the following procedures:

• To add a Key frame

• To move one or more key frames

• To move a Key frame to a specific time

• To copy a Key frame

• To rename a Key frame

• To delete a Key frame

• To reverse the order of key frames

See Also

• Key frame Editor

• Stage Editor Bar

To add a Key frame

There are four methods detailed to create a Key frame

1. Select the channel or action channel in the stage tree where the Key frame should
be added.

2. Set the Timeline Marker to when the Key frame should be added.

3. Click the Add Key frame button in the Stage Tree Bar  .
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or

1. Select the channel or action channel in the stage tree where the Key frame should
be added.

2. Set the Timeline Marker to when the Key frame should be added.

3. Set the Key frame:

• Click the Set key frame button from the Timeline Editor  , or

• With the mouse pointer over the Scene Editor, press <Enter>.

or

1. Select the channel or action channel in the stage tree where the Key frame should
be added.

2. In the Spline Editor, make sure to hold the pointer above the spline at the desired
timeline location (the spline should turn orange if doing this correctly).

3. Click the spline.

or

1. In either the scene tree or the Scene Editor, click the object whose animation path
you want to view.

2. In the Scene Editor, right-click and select Animation.

3. Hold down the <Insert> key and click the path.

A new locked Key frame is added.

See Also
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• Working with Channels in the Stage Tree

• Working with Channels in the Dopesheet Editor

• Working with Action Channels in the Stage Tree

• Working with Action Channels in the Dopesheet Editor

To move one or more key frames

1. Select one or more key frames.

Tip: You can also hold down the <S> key and use the rubber band to select
multiple key frames.

2. Drag the key frames along the timeline in the Dopesheet Editor.

Alternatively:

1. Select one or more key frames.

2. Drag the key frames along the timeline (horizontally) in the Spline Editor.

Note: Dragging a Key frame vertically in the Spline Editor will change the value of
the Key frame, not the timeline value.

To move a Key frame to a specific time

1. Enable the Key frame Editor.

2. Select a Key frame.

3. In the Key frame editor, enter the time (in fields) in the Time input box.

To copy a Key frame

1. Select one or more key frames.

2. Press <C> while dragging the key frames to the new position in the Dopesheet
Editor.

To rename a Key frame

1. Enable the Key frame Editor.

2. Select a Key frame.

3. In the Key frame editor, enter a descriptive Key frame name in the Name text
box, and press <Enter>.

Note: Special characters, such as space, are not allowed in Key frame names.

To delete a Key frame

1. Select one or more key frames.

2. Click the Delete Key frame button in the Stage Editor Bar  .

Alternatively:

1. Select one or more key frames.
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2. Press <Delete>.

8.10.1 Reversing the Order of Selected Key frames

Reversing the order of key frames is akin to mirroring the key frames.

Example: In Figure 40: Animation with normal and reversed Key frame order,
the image to the left illustrates a rotation animation, with key frames placed at
fields 0, 50, and 200. The rotation value at field 0 is X=0, at field 50 X=45, and
at field 200 X=90. After the key frames have been rotated, the image to the right
illustrates the animation with key frames placed at fields 0, 150, and 200. The
rotation value at field 0 is X=90, at field 50 X=45, and at field 200 X=0.

Animation with normal and reversed Key frame order

To reverse the order of key frames

1. Select two or more key frames in the Dopesheet Editor.

2. While holding the mouse pointer over the Stage, Press <Ctrl+R>.

8.11 Basic Animation Functions
This section contains information on the following procedures:

• To play all animations in a director from the start of the timeline

• To play all animations in a scene

• To play an animation in reverse

• To stop a director

• To stop an animation

• To stop all animations

• To continue an animation

• To jump to start of an animation

• To jump to end of an animation

• To delay animations in a director using offsets

• To scale animations in a director

• To scale a region within a director



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 405

To play all animations in a director from the start of the timeline

1. Select the desired director.

2. Click the Start Animation button in the Timeline Editor.

Alternatively:

1. Enable the Director Editor.

2. Select the desired director.

3. In the director editor, click the Start Animation button.

Alternatively:

1. Ensure the mouse pointer is in the dopesheet.

2. Press <Enter>.

Alternatively:

1. Select the desired director.

2. Ensure the mouse pointer is in the dopesheet and press <Space>.

To play all animations in a scene

1. Enable the Director Control Panel.

2. Click All.

3. Do one of the following:

• Ensure the mouse pointer is in the dopesheet and press <Enter>.

• Ensure the mouse pointer is in the dopesheet and press <Space>.

• Click the Start button in the Timeline Editor.

• Click the Start button in the Director Control Panel. (Clicking here will also start the
animations in the other layers if they are available).

To play an animation in reverse

1. In the Timeline Editor, click the Reverse Play button  .
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2. Do one of the following:

• Ensure the mouse pointer is in the dopesheet and press <Enter>.

• Click the Start button in the Timeline Editor.

• Click the Start button in the Director Control Panel. (Clicking here will also start the
animations in the other layers if they are available).

Alternatively:

1. Select the desired director.

2. Ensure that the mouse pointer is in the dopesheet.

3. Press <Shift> + <Enter>.

To stop a director

1. Select one or more directors.

2. In the Timeline Editor, right-click the Stop button.

Alternatively:

1. Enable the Director Editor.

2. In the director editor, click the Stop button.

Alternatively:

1. Select the desired director.

2. Ensure the mouse pointer is in the dopesheet and press SPACE.

To stop an animation

• In the Timeline Editor, click the Stop button.

Note: It is also possible to add one or more stop points to a director, so that each
time the timeline passes a certain frame, the animations stop automatically. For
details on how to create such a stop point, see Working with Events in a Director.

To stop all animations

1. Enable the Director Control Panel.

2. Click the Stop button.

This stops all animations in all layers.

To continue an animation

1. Select the desired director.

2. Click the Continue Animation button in the Timeline Editor.

Alternatively:

1. Select the desired director.

2. Ensure the mouse pointer is in the dopesheet and press SPACE.

Alternatively:
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1. Enable the Director Editor.

2. Select the desired director.

3. In the director editor, click the Continue Animation button.

To jump to start of an animation

1. Select the desired director.

2. Click the Go to Start button in the Timeline Editor.

Alternatively:

1. Select the desired director.

2. Press <Ctrl+Home>.

To jump to end of an animation

1. Select the desired director.

2. Click the Go to End button in the Timeline Editor.

Alternatively:

1. Select the desired director.

2. Press <Ctrl+End>.

To delay animations in a director using offsets

1. Enable the Director Editor.

2. Select the desired director.

3. In the director editor, set the Offset value (in fields).

Alternatively, it is possible to move the director (horizontally along the timeline)
including all its animations directly in the Timeline Editor, although this will not actually
add the offset value.

To scale animations in a director

• Drag the knob at either the beginning or end of a director in the Dopesheet Editor.

Note: If dragging the beginning marker, it is not possible to drag it past the offset
value.

Scaling a director is the easiest way to change the total running time of the animations
in the director. Scaling is done proportionally and includes all subdirectors.

To scale a region within a director

1. Follow the procedure To mark a region within a director.
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2. Drag the green knob at either the beginning or end of the marked region.

Scaling is done proportionally and includes all subdirectors.

8.12 Creating a Basic Animation
This section shows how to create a basic animation in a Scene.

Animation Task

Create a Scene with single a Cube Geometry. Animate the Cube to move right to left.

This use case contains the following procedures:

• To Create the Basic Animation Scene

• To create a Basic Animation

• To create the key frames with the Transformation Editor

To Create the Basic Animation Scene

1. Do the procedure To create a new Scene. Name the scene Basic Animation.

2. Open the Basic Animation Scene.

3. From the Main Menu, click Built Ins

4. Click the GP (Geometry Plugin) tab to show all available Geometry plugins.

5. In the Folders panel, click the Default folder.

6. Drag the Cube icon from the plugin list into the Scene Tree.

7. Click Save.
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8. The Scene Tree and Scene Editor should then look like this:

To create a Basic Animation

1. Open the Basic Animation Scene.

2. Set the timeline, in the Scene Editor (1), to 0 (fields).

3. Create the first Key Frame:

1. Click on the Cube in the Scene Editor.

2. Click the Set Key Frame button (2) or press <Enter>. This sets the first Key
Frame.

4. Create the second Key Frame:

1. In the Scene Editor, drag the Cube to the right, so that it shifts to a different
position.

2. Click the Set key frame button or press <Enter>. This sets the second Key
Frame.

Tip: Use the Transformation editor to move the Cube to precise position (see To
create the key frames with the Transformation Editor).

Note: On the Cube Container, in the scene tree, an Anim icon is automatically
added, which shows that one or more properties on this Container has been
animated.

5. Repeat step 1to create more movement, if required.

6. Click the Start Animation button (3) to see the created animation.

See Also

• To move the timeline marker

• To add a Key frame

To create the key frames with the Transformation Editor

Use the Transformation editor to move the Cube to precise locations then set a Key
Frame.
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1. After the first Key Frame is set, click the Transformation icon on the Cube

container in the scene tree  .

2. In the Transformation Editor, set Position X to 100.

3. Click the Set key frame button or press <Enter>. This sets the second Key
Frame.

4. Move the Cube as required with the Position parameters to a new position. In
the new position click the Set key frame button, or press <Enter>, to set a Key
Frame.

A representation of the animation can be seen in the Stage Tree Area.

See Also

• To save a Scene

8.13 Creating an Advanced Animation
Once you have mastered Creating a Basic Animation, where the position of a cube
is moved, you can move on to more advanced tasks. This section provides some
additional procedures, so that a cube can continue its journey rightward, rotate while
moving, and gain a nicer appearance by adding color to it.

This section contains the following procedures:

• To edit the first Key frame

• To edit the second Key frame

• To create an additional Key frame

• To add a stop point

• To create key frames for rotation

• To modify the rotation settings
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• To run the animations independently

• To add and animate a Material

To edit the first Key frame

1. Enable the Key frame Editor  .

2. Select the Key frame at the far left in the Dopesheet Editor.

3. In the Key frame Editor, set the Position to X = -100.

To edit the second Key frame

1. Select the Key frame at the right in the Dopesheet Editor.

2. In the Key frame Editor, set the Position to X = 0.

Tip: Set the position either by typing in the input box, using the up/down
buttons, or clicking the R (reset/default setting) button.

When playing the animation now, the cube will still slide rightward, but from a point at
the left part of the Scene Editor to the center.

3. Click the Play button in the Timeline Editor.

To create an additional Key frame

1. In the Timeline Editor, set the timeline field to 100.

2. In the Scene Editor, drag the cube to the right, so that it shifts to a different
position.

3. Set an additional Key frame (see To add a Key frame).

4. Click the Play button in the Timeline Editor.

When playing the animation now, the cube will slide rightward from a point at the left
part of the Scene Editor, through the center, and all the way to the right part.

To add a stop point

1. Select the desired director.

2. In the Timeline Editor, set the timeline field to 50.

3. Create a stop by performing the procedure To create a new Event.

4. Click the Play button in the Timeline Editor.
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When playing the animation now, the cube will slide rightward until it reaches the
center of the Scene Editor, and then come to a halt. To continue playing the rest of the
animated journey, see To continue an animation.

To create key frames for rotation

1. Right-click the Cube actor in the stage tree.

2. In the Stage Tree Menu that appears, click Transformation -> Rotation.

A rotation channel and two key frames are added.

To modify the rotation settings

1. Select the Key frame at the right in the Dopesheet Editor.

2. In the Key frame Editor, set the Rotation to X = 360.

3. Click the Play button in the Timeline Editor.

When playing the animation now, the cube will slide rightward until it reaches the
center of the Scene Editor, while rotating all the while before coming to a halt.

4. To continue playing the rest of the animated journey, see To continue an
animation.

To run the animations independently

1. Create a director at the root level of the stage tree. See the procedure To create a
director.

2. Rename the new director to Rotation. See the procedure To rename a director.

3. Drag the rotation channel to the new director. See the procedure To move a
channel.

The stage tree and should now look like this:

When playing the animations now, the output depends on which director is selected.
If the Default director is selected, only the position animation will be played. If the
Rotation director is selected, only the rotation animation will be played. Selecting
both/all directors will play both the position and rotation animations.

See Also

• To play all animations in a director from the start of the timeline
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• To play all animations in a scene

To add and animate a Material

1. Create a Material and define its color (see Create a Material).

2. Drag the Material to the Container in the Scene Tree.

3. In the Scene Tree, click the Material in the Container. The material editor is shown.

4. In the Timeline Editor, set the time when you want the Key frame to be created.

5. In the Timeline Editor, click the Set Key button.

6. Change the material’s color (see Working with Material Elements).

7. To create the next Key frame, in the Timeline Editor, click the Set Key button.

8. Click the Play button in the Timeline Editor.

The cube now has a color that changes as part of the animation.

8.14 Further Advanced Animation Topics
This section will guide you through creating a scene and using the more advanced
animation features in Viz Artist. The following topics are covered:

• Animating Channels

• Path Control

• Spline Control

• Animating Audio

• Animating Cameras

• Animating Light

• Merging Animations

• Multi Select Animation
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As the basis, you can take the scene created in Creating a Basic Animation and
improved on in To save a Scene.

8.14.1 Animating Channels

This section contains information on the following topics:

• Repeating Animation Channels (Loop)

• Repeating Animation Channels in Reverse (Swing)

• Combining Swing and Loop

Repeating Animation Channels (Loop)

The loop operation makes it possible to repeat the animation of a channel either at the
beginning or end of the channel timeline.

Channel with loop operation enabled

To repeat the animation of a channel

1. Select a channel.

2. In the Channel Editor, enable the Loop In/Out buttons.
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Note: Loop at the beginning is only available if the belonging actor has a
defined offset value.

3. Define how many times the loop should run before coming to a halt. Either enter a
number in the field or click the Infinite button.

When enabling loop, the looped animation appears as gray in the in the Dopesheet
Editor

Repeating Animation Channels in Reverse (Swing)

The swing operation makes it possible to repeat the animation of a channel in reverse
play either at the beginning or end of the channel timeline.

Channel with swing operation enabled

To create a swinging animation

1. Select a channel
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2. In the Channel Editor, enable the Swing In/Out buttons.

When enabling swing, the animation appears as gray in the in the Dopesheet Editor.

Combining Swing and Loop

It is possible to combine the swing and loop operations on a channel. The animation
will then first be added in reverse play (swing) and then started once again from the
beginning to the end (loop). This will save you a great amount of time if in need of a
recurring animation, for example a bouncing ball.

Channel with swing and loop operations enabled

To combine swing and loop

1. Follow the procedure To repeat the animation of a channel.

2. Follow the procedure To create a swinging animation.
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Animations with swings and loops appear as gray in the in the Dopesheet Editor.

8.14.2 Path Control

The position animation follows a path you define by the key frames. A spline will be
interpolated from the key frames. You can view and edit this spline in the Scene Editor.

To edit the spline in the Scene Editor

1. Enable the bounding box by clicking the BB button to the left of the Scene Editor.

Alternatively, ensure the mouse pointer is in the Scene Editor, and press <B>.

2. In the scene tree, select the animated container.

3. Right-click in the Scene Editor and select Animation.

The path will be shown as a spline with the key frames marked on it.

4. Drag the key frames around to modify the animation trajectory.

The red and yellow markings on the spline provide information about the speed the
object is moving along its trajectory. One segment represents a field, the longer the
segments are, the faster the object will travel.

As every Key frame has handles (seen in blue) you can use them to modify the Key
frame’s trajectory. To do so select a handle and drag it around.

By default the handles are set to be locked and proportional. If you want to switch to a
mirrored mode, press <Shift> while you drag the handle around. Pressing <Ctrl> will
allow you to edit the single handle only.
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An other option to set the handles is the object editor. Select the Key frame you want
to change the handles in and set either Single, Locked or Mirrored and change the
values in Weight L and R.

8.14.3 Spline Control

In the spline editor the distance spline is shown, which sets the current position of the
container along the path. The y-axis in the spline editor is scaled to use the percentage
of the trajectory, while the x-axis still uses the time. In the spline editor you can only
change the position of a Key frame along the timeline, but not its percentage of the
total trajectory.

By default the handles at every Key frame on the spline are set to be linear.

To edit the spline

• Drag the handles around to change their positions.

By default the handles are set to move proportionally. So as you move the handle of a
Key frame the other one will move to.

• Press <Ctrl> while you drag a handle to modify only the selected one.

This “single handle mode” will be enabled for the Key frame as long as you do not reset
it by a click the Key frame icons in the Stage Editor Bar.

Example: If you, for example, modify the spline in such a way that the value
decreases, the container will move backwards.

To move key frames in the spline

• Select the desired Key frame and drag it.

Multiple key frames can be selected to move at once.

To insert key frames from the spline

1. Moving the cursor on the spline exactly where you would like to add the Key
frame.

2. Click on the desired location to set the Key frame.

To delete a Key frame from the spline
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1. Select the desired Key frame

2. Press <Delete> or click Delete Key frame button in the Stage Editor Bar.

Multiple key frames can be selected to be deleted at once.

8.14.4 Animating Audio

An audio animation plays an audio clip in an animation.

To enable audio in an animation

1. Apply the audio container function to a container in the Scene.

2. Add an actor for this container to the stage tree, if it is not present yet.

Tip: The easy way to do is to drag the container from the scene tree onto the
stage tree.

3. Open the shortcut menu and select Audio followed and then Clip.

4. Select a Key frame in this channel to open the object editor.

5. Switch to the Server/Stage view and drag an audio clip from the server view
onto the Clip drop zone in the object editor.

6. In the object editor for the key frames of the AudioClip channel, configure the
following parameters, as necessary:

• Name: Sets a name for the Key frame. This name is for use only for external
commands or scripts.

• Time: Shows the time value in fields the Key frame is placed. Editing this value
will change to position of the Key frame.

• Clip: Drag an audio clip from the server view onto this drop zone.

• Stop: Stops playback.

• Play: Plays the clip.

• Delete: removes the clip.

• Begin Time: Sets the begin time within the clip. Everything before this time
will not be played in the animation. Another way to achieve this is to drag the
Key frame at the beginning of the clip.

• End Time: Sets the end time within the clip. Everything after this time will
not be played in the animation. Another way to achieve this is to drag the Key
frame at the end of the clip.

• Duration: Shows the duration to be played.
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8.14.5 Animating Cameras

You can animate cameras by adding an actor for a camera to the stage tree is by
setting key frames in the Scene Editor.

To animate a camera

1. Set the Timeline Marker to when the Key frame should be added to start with the
animation of the camera.

2. Click the Add Key frame button in the Stage Tree Bar

3. Change one of the selected cameras’ properties and set the next Key frame. This
will add an actor in the stage tree for the camera whose properties you have
changed.

Another way to animate a camera is to enable position and/or direction tracking in the
camera editor.

See Also

• Camera Editor

• Working with Actors in the Dopesheet Editor

• Working with Key Frames

To animate the current Camera

1. Set a Key frame in the cu rent Camera channel.

2. In the object editor edit the following parameters for the Key frame as necessary.

• Name Set a name for the Key frame. This name is for use only for external
commands or scripts.

• Time Shows the time value in fields the Key frame is placed. Editing this value will
change to position of the Key frame. If you click arrow buttons in the Stage Editor
Bar the previous or next Key frame will be selected.

• Value Sets the camera you want to switch to.

The animation of the current Camera allows you to switch the camera through which to
view at a given time.

To create a zoom animation

If you click Spline button Stage Editor Bar or press <Shift+Q>, the whole spline which
is currently displayed will be zoomed to.

If you have selected an actor or a director, the zoom will be adjusted to fit this entry.

When zooming the whole spline, both the time-axis for animation editor and the spline
editor will be zoomed, as well as the value-axis in the spline editor.

Another way to zoom the time-axis is by pressing X to zoom in and Y or Z to zoom out.
As an alternative you can use the mouse wheel.
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If you press <Shift+Y> you will set the zoom along the time-axis to zoom the whole
spline while <Shift+X> will set the zoom along the time-axis to show the whole
animation.

In the spline editor you can zoom the value axis too. This is done by pressing A to zoom
in or S to zoom out. If you press <Shift+A> you will zoom the whole spline along the
value axis.

You can zoom also if you press one of the “zoom keys” and move the cursor around
with the middle button pressed.

If you have changed the zoom level, you can switch back to standard zoom at any time
by a click designated button in the Stage Editor Bar or if you press <Shift+W>.

As you maybe zoomed the view in such away you are no longer able to edit the spline
comfortably, you can pan by moving around the cursor while the middle button is
pressed.

Zooming along the time axis will zoom both the animation editor and the spline editor.

8.14.6 Animating Light

The only way to add an actor for a light to the stage tree is by setting key frames in
the Scene Editor. To do so set the timeline value to the time you want to start with
the animation of the light and set the first Key frame. Now change one of the selected
lights properties and set the next Key frame. This will add an actor for the light which
property you have changed to the stage tree.

An easier way the animate a light is to enable position and/or direction tracking in the
light editor. To learn more about the light editor, see Working with Light .

8.14.7 Merging Animations

In Viz Artist, it is possible to merge container groups into one single compound object.
If an animation has been defined for at least one of the containers, on merging a
new director will be created, given the name of the merged object in the scene tree.
There will be a subdirector by the name of the original director the animations were
created in. The animations created for the single containers will be kept, but cannot be
changed anymore unless you split the object into the containers it has been created
from.

The animations will be kept also if you save the newly created object in the database.

Please be aware that you cannot add subdirectors to the directors created
automatically by merging.

8.14.8 Multi Select Animation

If two or more objects are selected multiple animations can be created in one step. This
adds independent animations channels for each container within the selection.

1. Select the objects to be animated.

2. Create the animation, as required (see Creating a Basic Animation).

An Actor is created for each selected animated object. Once the animation has been
created each Actor can be edited separately.
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8.15 Creating an Over the Shoulder Scene
An Over the Shoulder (OTS) graphic is a graphic which is placed over the shoulder of,
for example, the news anchor, and can show on the left or right side of the screen. An
OTS graphic can be used to highlight a story with a large image and a headline, and
sometimes a sub-headline.

This section contains information on the following procedures, which when completed
in sequence create an OTS Scene:

• To create a scene

• To add an image and basic geometries

• To add materials

• To scale geometries and place them in Z space

• To add text

• To add gradients

• To add background elements

• To add flares

• To animate

• To animate sub containers

• To animate single containers

• To animate single objects

• To animate out

• To add stop points

• To add controls

To create a scene

• Create a new scene and save it as OTS (see To create a new Scene)

To add an image and basic geometries

1. Open the OTS scene.

2. Add a Rectangle geometry to the Scene Tree.

3. Add an image (for example, a headshot) to the Rectangle container.

4. Rename the Rectangle container to Image.

5. Add a Cube geometry to the scene. Place it above the Image container.

6. Open the Cube Plugin editor and do the following:

1. Set Center Y to Bottom.

2. Adjust the Size X value to fit the width of the image.

3. Adjust the Size Y value to e.g. 10.0.
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4. Adjust the Size Z value to e.g. 1.0.

7. Copy the Cube container. Place it below the original Cube container.

• Press <Ctrl+C> then <Ctrl+V> to place a copy below the original container.

• Press <Ctrl+Left mouse button> to drag and drop a copy to a new location.

8. In the transformation editor of the Cube container set Center Y to Top.

9. Rename the Cube containers to Top_Cube and Bottom_Cube.

10. Open the transformation editor of each Cube container and move the position of
the Cubes. Place one above and the other below the image.

11. Group all containers under a new root container:

• Select all containers and click the Group button, or

• Select all containers and press <Ctrl+G> (when Caps Lock is disabled).

1. Rename the new group container to Image_Holder.

2. Save the scene.

Note: Geometries can also be scaled with the container’s transformation editor.
But this will have an effect on the its proportions when, for example, beveled
edges are added.

To add materials

1. Open the OTS scene.

2. Expand the Image_Holder container.

3. Right-click the Top_Cube container and select Add Material … from the context-
menu.

4. Open the Material Editor and define a color (e.g. blue or red).

5. Copy the Material onto the Bottom_Cube container:

• Drag the Material from one container to the other, or

• Right-click the Material and from the context menu select Copy ‘MATERIAL’ and
then Paste ‘MATERIAL’ onto the receiving container.

6. Save the scene.

To scale geometries and place them in Z space
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1. Open the OTS scene.

2. Add a new group container. Place it above the Image_Holder container:

• Select the Image_Holder container and press <Ctrl+Insert>, or

• Click the New Group button, in the Scene Tree Basic Tab, drag it above the
Image_Holder container.

3. Rename the New Group container to Body.

4. Add a Wall geometry to the scene. Place it as a sub-container of the Body
container.

5. Rename the new container to Wall.

6. Open the Wall editor (not the transformation editor) and do the following:

1. Set the Center option to Center.

2. Adjust the Height value to 540 (for example).

3. Adjust the Width value to 75 (for example).

7. Group the Body and Image_Holder containers under a new container:

• Select the Body and Image_Holder containers and click the New Group button, or

• Select the Body and Image_Holder containers and press <Ctrl+G> (when Caps Lock
is disabled).

8. Rename the new group container to Main.

9. Copy the Material from one of the Cube containers to the Wall container.

10. Open the Body container transformation editor.

11. Adjust the Position Z value to -30.0 (This will avoid potential conflicts with the
geometries in the Image_Holder container).

12. Save the scene.

Note: If the position and/or scaling of the Wall geometry need to be adjusted,
make sure to adjust those values on the Body container, as this will keep future
additions to the container aligned.

To add text

1. Open the OTS scene.

2. Add a New Group container. Place it below the Image_Holder container.

3. Rename the New Group container to Text_Holder.

4. Add a Font to the scene. Place it as a sub-container of the Text_Holder container.
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5. Copy the Font container. Place it below the first Font container.

6. Rename the Font containers to headline and sub-headline.

7. Open the Text Editor of both containers and do the following:

1. Enter some text (e.g. headline, sub-headline).

2. Set the Orientation option to Center.

8. Open the transformation editor of the headline and sub-headline containers and
do the following:

• Scale and position the containers to fit each other.

9. Add a Rectangle geometry to the scene. Place it above the Font containers and
rename it to Text_Rectangle.

10. Open the transformation editor of the Text_Rectangle container and do the
following:

1. Adjust the Position Y value. Center the rectangle between the text objects.

2. Enable single (S) Scaling.

3. Adjust the Scaling X value to equal the width of the image.

4. Adjust the Scaling Y value to 0.1 (for example).

11. Copy the Material from one of the Cube containers to the Text_Rectangle
container.

12. Open the transformation editor of the Text_Holder container and do the following:

1. Adjust the Position Y value to equal the Image_Holder objects.

2. Adjust the Scaling (Locked) if needed.

13. Save the scene.

Note: If the position and/or scaling of the font containers need to be adjusted,
make sure to adjust those values on the Text_Holder container, as that will keep
future additions to the container aligned.

To add gradients

There are several ways to add gradients or ramps. The example below details a very
simple way, which uses a gradient image with alpha.

1. Open the OTS scene.

2. Open the Text_Holder container.

3. Add a gradient image to the Text_Rectangle container.

4. Open the transformation editor of the Text_Rectangle container.

5. Adjust the Scaling values to make the rectangle equal the intended width of the
text.

6. Save the scene.

Note: If the PixelFX pxGradient plugin is used there are more parameters that can
be animated. Gradients from other design tools do not need to be imported.

To add background elements

This procedure details how to add a background image.
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1. Open the OTS scene.

2. Add a New Group container. Place it as a sub-container of the Body container.

3. Rename the New Group container to BackgroundImage_Holder.

4. Add an alpha image to the BackgroundImage_Holder container (for example, a
map of the world).

5. Copy the Material from the Wall container to the BackgroundImage_Holder
container.

6. Open the transformation editor of the Backgroundimage_Holder container and do
the following:

1. Adjust the Scaling values as required.

2. Adjust the Position Z value (for example, 2.0) so that it shows in front of the
Wall object.

7. Save the scene.

Note: If the position and/or scaling of the background elements as a group need
to be adjusted, make sure to adjust those values on the Body container, as that
will keep future additions to the container aligned.

To add flares

This procedure details how to make the designs look more dynamic by the addition of
elements such as flares. A flare is basically an alpha image.

1. Open the OTS scene.

2. Add a New Group container. Place it below the Body container.

3. Rename the New Group container to Flares.

4. Add a New Group container. Place it as a sub-container of the Flares container.

5. Rename the New Group container to Flare_Holder.

6. Add a flare image (with alpha) to the Flare_Holder container.

7. Copy the Material from the Wall container to the Flare_Holder container.

8. Open the transformation editor of the Flare_Holder container.

9. Adjust the Scale, Rotation and Position of the flare so that it makes the
intended effect on the object it is applied to.

10. Add the Expert plugin to the Flare_Holder container.

11. Open the Expert plugin editor.

12. Set Render Mode to Add. The source color is now added to the target color.

13. Save the scene.
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Note: If more than one flare is required repeat the process, or copy the
Flare_Holder container and make the necessary changes (e.g. position and
scaling).

To animate

Before animations are added, move the OTS graphic to its final on-screen position
(normally to the top left or right) where it should be seen by the viewer.

1. Open the OTS scene.

2. Open the transformation editor of the Main container.

3. Adjust the Scaling, Rotation, and Position values.

Make sure any conflicts are resolved now. Notice that when the Scene is rotated,
objects may “drift” apart as they are placed at different depths (Z space).

4. Save the scene.

This procedure focuses mainly on the animation of a root container, mainly to start with
the simplest factor; how do I want my graphics to animate in to view?

1. Open the OTS scene.

2. Set key frames to 60/50 (for example) fields.

3. Click the Set key frame button.

4. Open the transformation editor of the Main container and do the following:

• Adjust the Position X value to 0.0.

5. Set key frames to 0 fields.

6. Click the Set key frame button.

Note: Notice that an Animation object has been added to the Main container.

7. Click the Start animation button on the Timeline Editor.

The graphic now moves from Position X at 0 fields to its final on-screen position at 60
fields.

8. Open the Stage Editor.

The Main container and the animated Position property are located under the Default
director.

9. Right-click the Main container and from the context menu select Transformation -
> Scaling.

This will add a timeline for the Scaling property of the Main container.

1. Click the first key frame on the Scaling animation’s timeline on the Dopesheet
Editor.

This will open the Scaling animation Stage Object Editor.

1. Set the Scaling values to 0.0.

2. Click the Start animation button on the Timeline Editor.
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The graphic will now animate from Position X at 0 fields with Scaling at 0.0 to its final
size on-screen.

1. Save the scene.

Note: If the Viz Engine configuration is set to 50 hertz the default animation
timeline will be 50 fields. If set to 60 hertz, it will be 60 fields. It is always
important to configure the required output format before work is started on the
designs.

To animate sub containers

This procedure focuses on the animation of a sub-containers. In this case the image
and text holder containers.

1. Open the OTS scene.

2. Open the Stage Editor.

3. Drag the Image_Holder container onto the Default director.

4. Right-click the Image_Holder container and select Transformation -> Scaling from
the context menu.

This will add a timeline for the Image_Holder container’s Scaling property.

5. Click the key frame for the Scaling animation. In the Key frame Editor set it to 30
(for example) fields, to delay the introduction of the image.

6. Copy the animation object from the Image_Holder container to the Text_Holder
container.

7. Save the scene.

Note: The Image_Holder and Text_Holder containers are set to grow from the
Center. To grow the containers from other angles, open the transformation editor,
for each container, and adjust the Axis Center properties. If the OTS is placed to
the right, try setting the Text_Holder container’s Axis Center X to R (Right), and
conversely.

Note: Always scrub the timeline in the timeline editor to check for potential
conflicts (caused by rotation of objects).

To animate single containers

This procedure focuses on the animation of a single container, and how to add
additional key frames to the animation. In this case the background image is animated
and an additional key frame is added to grow the size of the background image before
it shrinks back to its final size.

1. Open the OTS scene.

2. Select the BackgroundImage_Holder container.

3. Set the number of fields to 30 in the Timeline Editor.

4. Open the Transformation Editor of the BackgroundImage_Holder container.

5. Set Scaling to 0.0.

6. Click the Set key frame button.
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7. Set Scaling to the original value.

8. Set the number of fields to 60 in the Timeline Editor.

9. Click the Set key frame button.

10. Open the Stage Editor.

11. Select the Scaling animation timeline for the BackgrounImage_Holder.

12. Move the Timeline Marker to a position closer to the end of the animation.

13. Click the Add a key frame button.

14. Click the new key frame and set the Scaling value to be larger than the final size.

15. Save the scene.

Note: Always scrub the timeline in the timeline editor to check for potential
conflicts (caused by rotation of objects).

To animate single objects

This procedure focuses on the animation of single objects. Animating single objects
increases the dynamics of the scene, especially when the scene has reached its final
position on-screen and all other animations have stopped.

This procedure describes how to make a flare move, continuously, along another
object.

1. Open the OTS scene.

2. Open the Stage Editor.

3. Create a new director and name it Loop:

• Click the +D button, or

• Right-click the Stage Tree and select Add Director.

4. Select the Loop director.

5. Set the Timeline Editor to 0 fields.

6. Open the Texture Editor of the Flare image:

• Set Position X to 0 and click the Set key frame button.

• Set Position X to 10 and click the Set key frame button.



Viz Artist User’s Guide

Page 430 Copyright © 2014 Vizrt

Note: When Position X is set to 10 it makes sure that there are no gaps
between the repeating textures.

7. Select both of the Position X key frames and click the Linear left and right
button.

8. Click the Position X channel to open its Channel Editor. Click the Loop out and
Infinite buttons.

The timeline should now look similar to the image above.

9. Save the scene.

Note: Now that there is an animated Flare it is always good to revisit the
Position, Rotation, and Scaling properties of the Flare_Holder container.

To animate out

Animations to the scene so far has brought the graphic on-screen for the viewer to see.
However, the scene should also be able to animate out instead of simply removing it
(hard cut).

This can be achieved in three ways:

• To Fade out the graphic using the Alpha plugin, or
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• To copy the directors, flip them around, then reverse the animation, or

• To create a separate Out Animation

Note: With one or a combination of the three methods an out animation can be
created. The scene will now work in terms animation, however, it will not work
well if someone needs to control, for example, when or how the out animation
should start. For this we need to add controls (using control plugins) that will allow
an operator to control the scene on air.

To Fade out the graphic using the Alpha plugin

1. Open the OTS scene.

2. Add the Alpha plugin to the Main container.

3. Set the timeline to the end of the in animation (at 60 fields for example).

4. Open the Alpha plugin editor.

5. Set the Alpha value to 100%.

6. Click the Set key frame button.

7. Set the Alpha value to 0%

8. Click the Set key frame button.

9. Save the scene.

When played the animation should now animate in and fade out to Alpha at 0%.

To copy the directors, flip them around, then reverse the animation

1. Open the OTS scene.

2. Open the Stage Editor.

3. Create a new director, and name it Default.

4. Place the old Default director under the new Default director

5. Rename it to In.

6. Copy the In director. Place it as a sub-director of the Default director.

7. Rename the copied director to Out.

8. Select the Out director.
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9. Hold <Ctrl>, select the Out director’s first key frame, and drag the key frame past
the last key frame to reverse the animation.

10. Save the scene.

When played the animation should now animate in and out, where the out animation is
simply a reverse of the in animation.

To create a separate Out Animation

To create a separate Out Animation manually create an out animation from scratch, by
the extension of the existing animations to animate out of view.

Alternatively repeat To copy the directors, flip them around, then reverse the animation
and adjust the different animations as required.

To add stop points

When the scene design is finished Controls can be added that will allow the operator
to control the animation while on air. To do this add one or multiple stop points to the
Default director (always the Default director).

1. Open the OTS scene.

2. Open the Stage Editor.

3. Select the Default director.

4. Place the Timeline Marker where the Stop point is to be added (for example,
where the In animation stops, and the Out animation starts).

5. Select the Default director again.

6. Click the Add a Stop/Tag button.

This will add a Stop/Tag to the Default director.

7. Name the first Stop point.

8. Save the scene.

Note: Stop point names can be user defined. However, when the scene is preview
with a remote (external) Viz Engine, either from a newsroom system, or when
connected through a control application to a a Media Sequencer, the pilot1 stop/
tag is the default preview point on the Default director.

Note: The placed pilot1 stop/tag point on the Default director’s timeline, at a
given field, enables Vizrt control applications to create a thumbnail and show it in,
for instance, the playlist.

Now the scene is ready for the operator to control the animation. However, the
operator still lacks one key element; they need to control the content of the graphics
(e.g. text and imagery).

To add controls

Stop/tag points are added to the director to allow the operator to control the animation.
However the operator, when required, should be able to control the content of the
Scene. For this purpose Control plugins are used.
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1. Open the OTS scene.

2. Expand the Scene Tree, or those containers that require any form of control (e.g.
text and imagery).

3. Click the Built Ins button on the Main Menu Left.

4. Click the Container Plugins (CP) tab and select the Control section.

5. Add the Control Text plugin to the headline and sub-headline containers.

6. Add the Control Image plugin to the Image container.

7. Open the headline container Control Text plugin editor.

8. Set Field Identifier to 01.

9. Repeat the process for the sub-headline and Image containers and set Field
Identifier to 02 and 03, respectively. Update the Description fields as required,
by default it will use the container name.

10. Save the scene.

Tip: Number the Field Identifiers to help order them in the control application
interface.

Note: To check that an operator can use the scene test it with a control
application (for example, Viz Content Pilot with the Template Wizard, Viz Trio, Viz
Multichannel, or Viz Weather).

Note: All plugins are installed locally. Plugins used in the design must be available
on the production system for the scene to work.

See Also

• VizBoldControl Button
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9 Cameras

The “camera” which shows the Viz Artist scene can be controlled much the same way
that a real camera is controlled. Viz Artist cameras are used by assigning two tracking
objects. The first is the camera itself, and the second is the object being tracked.

This section contains information on the following topics:

• Camera Editor

• Stereoscopy Best Practices

• Stereoscopic Output Using Shutter Glasses

• Changing Camera Parameters in Orthogonal Views

• Tracking Objects with a Camera

• Receiving Tracking Data from a Real Camera

• Copying Properties from one Camera to another

• Camera Selection

• Camera Animation

9.1 Camera Editor

The Camera editor makes it possible to modify the properties for the 16 editable
cameras that can be used in Viz Artist.

• Camera Editor left panel (1): Shows a list of all 16 editable cameras and the
current view of each camera,

• Camera Editor right panel (2): Shows the parameters for the currently selected
camera.

Tip: The selected camera will automatically be set as viewing Perspective in the
Scene Editor.

To open the Camera Editor

• In the Properties Panel click the Camera tab.

This section has information on the following topics:

• Left Panel Parameters
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• Right Panel Parameters

9.1.1 Left Panel Parameters

•  Lock/Unlock: Click the Keyhole to lock/unlock a Camera (shows orange when
locked). It is not possible to use Scene Editor area keyboard shortcuts on a locked
camera (see Scene Editor Camera Controls and Shortcuts).

Note: Keyboard shortcuts which switch to another camera will work, for example
‘Switch to Front Camera’, ‘Switch to Left Camera’, etc.

Tip: The locked cameras can still be edited. Click the VizBoldViews Button in the
Main Menu. In the Views panel drag the camera to change properties of the locked
camera (see Changing Camera Parameters in Orthogonal Views). Or change the
camera parameters in the camera editor right panel (see Right Panel Parameters).

• Nr: Shows the camera number, from 1 to 16.

• Name: Shows the camera name. Right-click or press <F2> to assign a new camera
name.

• Control: Toggle between Editor and Remote.

• Remote: Enable to receive tracking data from a real camera.

• Editor: Enable to configure camera settings.

• Vis: Shows the status of the camera:

• Off: The camera will not be shown in the six predefined orthogonal views.
Displaying a camera in a predefined orthogonal view can help to change the
properties of a camera, by dragging the parameters in those views.

• On: Shows the camera.

• Inf: The camera will be displayed with infinite lines. This is a good aid for visualizing
the scope of a camera that is located far away.

• View: Shows the current Camera Views of each camera. Options are:

• P: Perspective

• O: Orthogonal

• W: Window
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9.1.2 Right Panel Parameters

The parameters in the right panel change for each type of camera view. There are
three Camera Views.

This section has information on the following topics:

• Camera Views

• Parameters for Perspective View

• Parameters for Orthogonal View

• Parameters for Window View

Camera Views

There are three camera views. The parameter options depend on the View selected:

• Perspective: The basic view of a virtual camera is a normal depth perspective,
showing three dimensions. See Parameters for Perspective View.

• Orthogonal: Shows a camera view without perspective, so that objects will not
change their size when being moved towards or away from the camera (see also
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Changing Camera Parameters in Orthogonal Views). See Parameters for Orthogonal
View

• Window: Shows the camera view like looking through a real window. The graphics,
through a virtual camera, are adapted according to the real camera movement to
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produce this behavior. Set parameters for the physical position and rotation of the
display unit. See Parameters for Window View.

Parameters for Perspective View

• Position: Sets the position of the camera along the X, Y, and Z axis.

Default position settings (L) and modified settings (R)

• Direction: Sets the values for Pan, Tilt, and Twist.
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Direction: pan set to 0 (L) and 15 (R)

• Lens: There are three lens parameters:

• Angle: Set the Camera ‘field of view’ angle (1)

• C. Shift X Shifts the center of the lens according to the X axis.

• C. Shift Y Shifts the center of the lens according to the Y axis.

Zoom set to 10 (L) and 100 (R)

Left is default (0); right is C Shift X = -60 and C Shift Y= -60

• Relative Position: Sets the position of the camera along the X, Y, and Z axis,
relative to a real camera. Entering a value in for X, Y and Z axis for the Relative
Position changes the actual camera position values, but relative to its orientation.

• Verbose: This button in the lower right corner of the Camera editor is linked to
cameras in virtual sets. For more information about the Virtual Set option see the
Virtual Set documentation.

• Stereo Settings: Any Viz Artist animation that was created for 2D broadcast can
also be rendered as a stereo pair.

There are two parameters which define how each image is rendered. Both parameters
are part of the camera configuration, but they can be changed remotely on the fly as
well.

Zero parallax means that the pixels for the left and the right eye are identical. An
object which would be positioned at zero parallax distance from the camera would
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be identical for the left and right eye. The eye separation defines the distance of the
cameras for the left and right eye. When looking at the drawing the cameras are
separated by the same amount as the eyes of the viewer. A different scaling might be
used in the scene and the eye separation must be adjusted accordingly.

If the scene is built in the same scale as the monitor, with the camera at the same
distance from the object as the viewer, and the eyes separated at the same amount an
object positioned at the zero parallax, the distance appears to be flat with the screen’s
surface.

If the zero parallax distance is increased the object moves to the front.
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If the distance is decreased the object moves away.

The eye separation defines how flat or deep an object appears. If we increase the eye
separation, the scene appears deeper.

A very large eye separation parameter results in an unreadable 3D representation,
as the brain can not mix the images for the left and right eye anymore. Zero eye
separation results in a flat representation, like a 2D image.

• Eye Dist.: Fine-tunes for individual users. A higher value for will result in more
depth whereas a lower value will flatten the image.

• Conv. Plane: A higher value for the zero parallax distance means that objects will
come closer to the viewer, a lower one will push the graphics to the back.
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• Method:

• Off Axis: Creates a distortion-free stereo pair. This is the preferred option.

• Toe-In: The cameras point slightly inwards towards each other so that the lens axes
converge at a single point (“vergence point”). Objects in the same plane as the
vergence point will appear to be close to the plane of the image, with other objects
seeming to be behind or in front of this point.

These values must be set during production in accordance with the convergence values
used for the cameras.

See Also

• Stereoscopy Best Practices

• Focus: Focus settings are enabled if the Depth of Field parameter is set to Active
(see Rendering).

• Focal Plane Defines the distance between the camera and objects which are in
focus.

• Blank Near Adjusts the space between the camera and objects nearest to the
camera in focus.

• Blank Far Adjusts the space between the camera and objects furthest from the
camera in focus.

• Fall-off Near Decreases the space between objects with the maximum blur and
objects in focus.

• Fall-off Far Increases space between objects with the maximum blur and objects in
focus.

• Max. Blur Near Sets the size of maximum blur nearest to the camera. For example
a value of 20 signify that a pixel is enlarged to a size of 20 pixels.

• Max. Blur Far Sets the size of maximum blur furthest from the camera. For
example a value of 20 signify that a pixel is enlarged to a size of 20 pixels.
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• F Stop:  Not in use.

To avoid artifacts, avoid using maximum blur levels which are higher than 30 pixels. A
blur radius of 30px creates rather blurry results which should be sufficient. It is possible
to increase this maximum radius, but this would also increase the rendering time.

Set the clipping planes in the range you really need for the scene. So if your scene
has only a depth of 200, set the far clipping plane to 250 or a similar value. Since the
depth of field shader takes the depth from the depth buffer, this causes more accurate
results.

Try to avoid high blur levels for objects before the focal plane. This can cause undesired
effects.

You can increase performance, but artifacts would appear for blur levels lower then
30px.
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Parameters for Orthogonal View

The parameters for Orthogonal view are:

• Position: Sets the position of the camera along the X and Y axis.

• Focus: See Parameters for Perspective View.

Parameters for Window View

• Camera Position: In Window view the Tracking system controls the Camera
Position.

• Window size: In Window View this sets the window size (set to the size of the
display unit).

• Window centre: In Window view this sets the position of the window from the zero
position of the Tracking system.

• Window rotation: In Window view this rotates the window in the Y axis.
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9.2 Stereoscopy Best Practices
The following is a list of what to do and not to do to get the best results.

What to do

• Think of it as a window you are looking through.

• Make sure that single elements which form a new element, like rows of a table, are
all at the same distance and not scaled to appear the same size in 2D.

• Make sure that all graphics which belong to one show are positioned roughly the
same distance away from the camera. This way you do not need to adjust the
convergence parameters all the time.

• With alioscopy, keep the floating objects not too far from the 0 plane, as this will
make them have artefacts.

• For best effect have objects animate slowly forward and then fade to 0 alpha before
hitting the screen edge.

• With alioscopy, for text that is supposed to be readable, keep it big. Dropshadow is
a very good effect to enhance the sense of depth. 3DS productions use HD signals.

• For a 24" screen the best viewing distance is about 2.8 meters. For a 40" it is about
4.4 meters.

• With alioscopy, look at the scene from the top view and space things out like in
a theatre. Depth and various objects in different Z positions will make it more
believable: foreground, middle ground and background.

• Wobble effects are fine as long as they do not exaggerate the effect, otherwise you
get the paper bag effect. This again depends on how far or close to the camera the
object is positioned.

What not to do

• Do not use transparency where it goes over video. It is OK if a transparent graphics
object is over another graphical element if the distance is not too large.

• Do not use too much depth. Try to keep the elements separated not too far from
each other. The Z space available for graphics is limited.

• Do not create animations which come in from the side, especially when the final
result will be floating in front of the screen (this is very disturbing).

• Do not use moving flairs or effects.

• Do not have any objects pulsating forth and back in Z space as a part of a loop as
this will lead to the paper bag effect.

See Also

• VizBoldStereo Settings: Any Viz Artist animation that was created for 2D broadcast
can also be rendered as a stereo pair.

• Stereoscopic Output Using Shutter Glasses

9.3 Stereoscopic Output Using Shutter Glasses
It is very easy to set up a working 3D environment for a designer to start creating
stereoscopic scenes. The demands on the hardware are moderate.

Hardware requirements
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• Any workstation

• Any NVIDIA Quadro graphics card with a 3-pin DIN connector

• NVIDIA 3D vision or equivalent

• Monitor with a refresh rate >= 100Hz

Software requirements

• Viz Artist / Viz Engine 3.3 or later

• The display must be set to a refresh rate >= 100Hz

To set up a 3D working environment

1. In the Windows video board 3D settings, switch Stereo - Enable to On

2. Select the appropriate Stereo - Display mode for your stereo devices.

Note: For NVIDIA’s 3D Vision this is “On-board DIN connector”.

3. Set the Stereo Mode to Quad Buffered in the Viz Config Camera settings.

Alternatively it is possible to use an autostereoscopic monitor that supports sub-fields
or side-fields, such as Miracube’s c190 series. The drawback with these displays is that
you need to go on-air to get a full-screen image, which is halved in resolution.
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9.4 Changing Camera Parameters in Orthogonal Views
Camera parameters can be modified in the predefined orthogonal views.

This section contains information on the following procedures:

• To view the predefined orthogonal views

• To Change the Camera Views

To view the predefined orthogonal views

• Click Views.

The camera is shown as an orange circle (3) in the predefined orthogonal views. Two
small, green, circular handles (1 and 2) make it possible to modify the position along
the X, Y and Z axis of the camera, and also the values for pan and tilt.

To Change the Camera Views

• Drag handle (1): Change the pan and tilt while the position of the camera stays
fixed.

• Drag handle (2): The camera (3) and handle (1) will be dragged along, so that pan
and tilt will not be altered.

• Drag the camera (3): Change the position of the camera while handle (1) stays
fixed. The values for pan and tilt will also change.

9.5 Tracking Objects with a Camera
A virtual camera can be set up to track containers both regarding position and
direction. Tracking position means that the position of the camera will be in the center
of the container. Tracking direction means that the camera will look at the center of the
container, for example throughout an animation.

There are three options for configuring parameters view, depending on your number of
tracking objects:

• Zero tracking objects: You can only modify the Position X and Y.

• One tracking object: When dragging a container to the Position drop zone, all
the parameters will be greyed out. In the Properties Panel, switch from Camera to
Container to modify Positions X, Y and Z.

• Two tracking objects: You can only modify the Lens and Relative Position
parameters.
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For the relevant camera parameter details, see Right Panel Parameters.

To track an object

1. In the scene tree, create a group with two child primitive objects.

Tip: It is better to use objects with a low polygon, like a rectangle, as a
tracking object. High polygon tracking objects, such as a sphere, make the
scene heavy and slow.

2. Drag the first container into the Position drop zone.

3. Drag the second container into the Direction drop zone.

4. Modify the camera parameters. Select the Position and/or Direction tracking
object in the scene tree, and change the position and/or direction in the Container
properties (select Container from the Properties Panel).

• On

• t: Disables the camera tracking.
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9.6 Receiving Tracking Data from a Real Camera
In virtual set scenarios, as the real cameras moves, the virtual camera should move in
the same manner.

To receive tracking data from a real camera

• In the Left Panel Parameters, in the Control column, click the Editor button to set it
to Remote.

For more information about the Virtual Set option, see the Virtual Set documentation.

9.7 Copying Properties from one Camera to another

To copy camera properties

• In the Left Panel Parameters, click the source camera and drag it onto the target
camera.
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The properties of the source camera will be copied onto the target camera.

9.8 Camera Selection
The scene can be viewed from various angles.

There are 16 editable cameras and six predefined orthogonal views available. The label
on the Camera Selection button indicates which camera or view is currently selected
and used in the Scene Editor.

To view the scene from a different angle, click the Camera Selection button, and then
from the Camera menu that opens, select a camera or view. To close the Camera
menu, click the Camera Selection button again.

• 1: 16 Editable cameras.

Note: The position and direction of the 16 editable cameras can be defined in the
Properties Panel. For more information, see Containers .

• Front: Shows output through orthogonal camera in front of the scene.

• Back: Shows output through orthogonal camera behind the scene.

• Left: Shows output through orthogonal camera at the left side.

• Right: Shows output through orthogonal camera at the right side.

• Top: Shows output through orthogonal camera above the scene.

• Bottom: Shows output through orthogonal camera below the scene.

9.9 Camera Animation
All camera parameters can be animated in the same way as Creating Animations in
general. The process is roughly as follows:

• Set a value in the Camera editor

• Add a Key frame

• Change the value

• Add a Key frame again.

Animations can also easily be created in one of the orthogonal views. There the
cameras appear as symbols and by repositioning them and adding key frames,
animation sequences are created. For more information, see Changing Camera
Parameters in Orthogonal Views .

More advanced camera animations are normally created with the camera tracking
feature, as in Tracking Objects with a Camera .
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10 Configuring Viz

Viz Configuration is the configuration interface for Viz Engine and other applications
that integrate with Viz Engine.

The user interface is divided in two; sections on the left and settings on the right.
Various parameters regarding the program functionality can be set in the configuration;
however, additional and more advanced settings can be set using the configuration file
(not recommended).

Viz is mainly configured using Viz Configuration; however, all configuration settings
are stored in a file found under the Viz install directory. The configuration file
uniquely identifies the machine Viz is installed on by using its hostname (e.g. Viz-
<hostname>-0-0.cfg).

Any changes to the hostname will affect the configuration of Viz. If a hostname is
changed, a new configuration file is created with a default setup. The old configuration
file is not deleted, but left unused. It is possible to reassign the old configuration file
using the Viz command -g <config file>.

Caution: Make sure that any changes are saved before Viz Configuration is
closed. Changes are not saved and will not take effect until Viz Artist has been
closed and started again.

This section contains information on the following topics:

• Working with the Configuration

• Audio Settings

• Authentication

• Camera

• Communication

• Clock Formats
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• Database

• Font Options

• Global Input

• Import 3D Options

• Image File Name Convert

• Local Settings

• Maps

• Matrox

• Memory Management

• Path Aliases

• Output Format

• Plugins

• Render Options

• Scene Default Values

• Spaceball

• User Interface

• Video Board

• Video Clip

• Video Input

• Video Output

• Viz Artist 2.x

• Viz License Information

10.1 Working with the Configuration
Viz Artist and Viz Engine can be configured by the Viz Configuration in Viz Artist. Click
on the Config button or start Viz Config from the program menu.

This section explains how to start the Viz Configuration interface and how to save and
load configuration profiles.

Note: Saved configuration profiles only save settings that differ from the default
configuration of your setup (e.g. VGA, Video and so on).

To start Viz Configuration

• Click on the Viz Config icon on the desktop  , or

• Click Start > All Programs > Vizrt > Viz 3 > Viz Config 3, or

• if Viz Artist is running, click Config on the main menu.

Load and save configuration files

To load a configuration profile
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1. Start the Viz Configuration.

2. Click the Load... button.

3. Select a *.cfg file.

4. Click the Restart... button to load config file.

To save a current configuration profile

1. Start Viz Configuration.

2. Change the configuration as required.

3. Click the Save button to save the configuration.

4. Click the Restart... button to apply the saved changes.

To save a new configuration profile

1. Start Viz Configuration.

2. Change the configuration as required.

3. Click the Save As... button to save the configuration.

To reset the Viz Configuration file

The Reset button will set all configuration settings back to default.

1. Start the Viz Configuration.

2. Click the Reset button.

3. Click Restart... to apply the changes

To restart Viz Configuration

Click the Restart... button to save changes.

1. Click the Restart... button.

2. Select from:

• Current

• Viz Engine w/GUI

• Viz Engine w/o GUI

• Viz Artist

• Viz Config

10.2 Audio Settings
This section contains information on the following topics:

• Audio Properties

• Dual Channel Configuration

• To add new audio channels

• To add multi-language audio channels

• To add multiple audio channel configurations

• To map audio output for a dual channel setup
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• To delete audio channels

• To manually activate an audio device

Audio Properties

Audio Settings Various tab

• Audio Active: Makes audio active or inactive.

• Audio Delay Input1 (EE): Delay can be adjusted to synchronize the inputs at the
output (Targa board only).

• For Matrox, see the configuration file and SECTION MATROX_CONFIG’s
Matrox0.AudioIn1.AudioDelayDVE setting.

• Audio Delay Input2 (EE): Delay can be adjusted to synchronize the inputs at the
output (Targa board only).

Note: To enable audio mixing on the video board, these two settings must be
turned on. Otherwise the audio data from Input 1 to Input 4 are not mixed with the
values for the stage and played out.

Note: Targa boards do not distinguish between DVE and texture delays.

• Enable embedded audio on Input1: Enables embedded audio for use with
video as texture or DVE. Input 1 in the Video Input section must be enabled to use
embedded audio output.

• Enable embedded audio on Input2: Enables embedded audio for use with
video as texture or DVE. Input 2 in the Video Input section must be enabled to use
embedded audio output.

• Ring buffer delay: Turn On to enable the audio system to compensate for the ring
buffer delay automatically.

• Driver mode: Select None for no sound card output. Select DirectSound for direct
sound. Select High Performance for high performance MME mode (this only works
for Wave driver cards. Select MME mode for that mode only.

Audio Settings Channels tab

• Configurations: Displays a list of channel configuration(s).

• Add: Adds a new channel configuration to the Configurations list.
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• Delete: Deletes the selected channel configuration from the Configurations list.

• Name: Sets the name of the selected channel configuration.

• Channel Geometry: Sets the channel geometry. Available options are: Mono ,
Stereo , Anamorphic widescreen , 7.1 and Quad .

• Used Channels: Sets the number of configurable channel alias fields that can be
mixed by the internal channels in Viz Engine (software). On a Matrox system this
number must be equal to the number of configured input channels (hardware). This
setting is independent of the Channel Geometry setting.

• Reset Aliases: Sets the channel aliases to the default option; however, the custom
entry is not removed.

• Out Channel 0-15: The Out Channels represent the internal Viz audio channels,
which are mixed to the output device one by one. Alias names are not only useful
for creating multilingual systems, but also define the channel geometry for the
Default and FX audio clip mix modes. Aliases are separated by a semicolon. The
Audio plugin only uses the channel aliases to find the correct speakers for Pan and
3D sound effects in FX mode. With this functionality you are able to use any of the
16 internal audio channels to play any audio geometry.

In this section all installed DirectSound audio cards are listed displaying the available
audio inputs that can be mixed to one audio output by Viz Engine. It is currently only
possible To manually activate an audio device by editing the configuration file.

Note: The Matrox audio-extension board is not configurable through this user
interface.

• Sample Rate:  Reserved for later use. Displays the sample rate. Default sample
rate is 48kHz (48000) which is the maximum allowed.

• Device  n : Displays the name of the audio card.

• Bits per Sample:  Reserved for later use. Displays the number of bits used per
sample. Default value is 16 Bit per sample rate.

• Mode: Refers to the audio mode of the Matrox board. Available modes are
Embedded, AES, Embedded AES, Loop and Default.

• Embedded: Forces the Matrox board to capture audio from the video signal and
outputting embedded audio.

• AES: Forces the Matrox board to capture and output audio through the AES / EBU
connectors.

• Embedded AES: Forces the Matrox board to capture audio from the video signal
and outputting it to the AES / EBU connectors.

• AES Embedded: Forces the Matrox board to capture audio from the AES
connectors and outputting the audio as streams in the video signal.

• Loop: Moves the audio from the inputs to the outputs without being down-mixed by
Viz Engine.

• Default: The default device(s) are used (usually the built-in sound board).
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Note: Matrox X.mio only supports balanced audio through XLR connectors. X.mio
2 and X.mio 2+ only supports unbalanced audio through BNC connectors.

Dual Channel Configuration

In a dual channel setup AES channels can be configured to use up to 4 channels per Viz
Engine for an X.mio and up to 8 channels per engine for an X.mio2 and X.mio2 Plus.
If 8/16 channels are set for one Viz Engine the other Viz Engine will overwrite these
settings as the maximum of AES channels is 8/16 for X.mio/X.mio2/X.mio2 Plus.

For correct mapping both Viz Engines should be set to an equal number of used AES
channels.

To add new audio channels

1. Click the Add button.

2. Select the new entry from the Configurations list, and enter the new name in the
Name field.

3. Set the Channel Geometry, and the number of Used Channels.

4. Click Save.

To add multi-language audio channels

Multi-language, audio setup

1. Click the Add button.

2. Select the new entry from the Configurations list, and enter the new name in the
Name field.

3. Set the Channel Geometry to Stereo, and then click Reset Aliases.

4. Increase the number of Used Channels to 4

• This will improve the performance.

5. In the Channel 2 field add the alias FrenchLeft.

6. In the Channel 3 field add the alias FrenchRight.

• Add the same configuration for English (EnglishLeft, EnglishRight) and German
(GermanLeft, GermanRight) on the other machines.

7. Click Save.

To add multiple audio channel configurations
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Multi-language, all setup

1. See how To add multi-language audio channels , and repeat the process such that
the Audio Settings configuration has 3 setups for the three languages.

2. Name the configurations the following way;

• Multi-languageF

• Multi-languageE

• Multi-languageG

3. Add a Multi-languageAll configuration (see Multi-language, all setup ).

4. In the Channel 1  field add the alias FrenchLeft ,  EnglishLeft  and 
GermanLeft., and do the same for Channel 2.

FRONT_LEFT;Channel_0;FrenchLeft;EnglishLeft;GermanLeft;
FRONT_RIGHT;Channel_0;FrenchRight;EnglishRight;GermanRight;

5. Click Save.

To map audio output for a dual channel setup

1. In a dual channel environment there are two configuration files, one for each Viz
Engine.

2. For the first Viz Engine (1) the configuration of the audio output channel mappings
should look like this:

Matrox0.AudioOut1.MapToVizChannel = 0
Matrox0.AudioOut2.MapToVizChannel = -1

3. Note that the audio output for the first Viz Engine (1) should be according to the
video output channel:

Matrox0.VideoOut1.MapToVizChannel = 0
Matrox0.VideoOut2.MapToVizChannel = -1

4. For the second Viz Engine (2) the configuration should look like this:

Matrox0.AudioOut1.MapToVizChannel = -1
Matrox0.AudioOut2.MapToVizChannel = -1

5. Mind the difference to the video output settings:

Matrox0.VideoOut1.MapToVizChannel = -1
Matrox0.VideoOut2.MapToVizChannel = 0

6. All other audio output channels should be turned off:

Matrox0.AudioOut3.MapToVizChannel = -1
Matrox0.AudioOut4.MapToVizChannel = -1

To delete audio channels
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1. Select a configuration entry from the Configurations list, and click the Delete
button.

2. Click Save.

To manually activate an audio device

1. Open the configuration file.

2. Go to SECTION AUDIO_CONFIG and locate the Available0 setting.

3. Activate the identified audio device (Available0) by adding its name to the
AudioDevice0 setting.

• For multiple outputs, more than one device can be added as AudioDevice1,
AudioDevice2 and so on; however, this is not very common.

4. Save the configuration file.

Example: AudioDevice0 = Realtek HD Audio output

10.3 Authentication
The Authentication panel is for the authentication of one or more Viz One systems on
Viz Artist. Enter the details of each Viz One system to connect to.

All three panels (Host Info, Realm and User Info) of the Authentication panel must be
completed to save a new User (if a Realm is not required type <empty> in the Realm
panel). If only one or two panels are completed then the information will not be saved:

• Host Info: The host name of the Viz One server

Note: The host info is in the form ‘host:port’, where the : sign and the port
number is optional. A single value of * shows that it should be used against all
hosts. The host info is not just the Viz One host name, it could also be the ip-
address.

Example: Host Info = hostname[:port] or ip-address[:port] or ‘*’

• A Host can not be added without at least one Realm (or an empty Realm with
<empty> entered) and one User defined

• A Host can have more than one Realm.

• Realm: Used to determine whether this entry should be used in an authentication
process for a given URI

Example: A single value of * shows that it should be used against all
realms,i.e., Realm = [a-zA-Z_0-9]* or ‘*’

• A Realm can not be added to a Host without at least one User defined

• A Realm can have more than one User.
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• User Info: Name and password for each User, for the selected Host and Realm

This section contains information on the following topics:

• Authentication Properties

• Authentication Panel Procedures

10.3.1 Authentication Properties

This section contains information on the following topics:

• Host Info Properties

• Realm Properties

• User Info Properties

Host Info Properties

• Add: Add a host name (see To Add a Viz One Host)

• Change: Change a selected host name (see To Change a Host, Realm or User
Name)

• Remove: Remove a selected host name (see To Change a Host, Realm or User
Name)

• Host Info: Enter the name of the required Viz One host
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Realm Properties

• Add: Add a Realm (see To Add a Realm)

• Change: Change a selected Realm (see To Change a Host, Realm or User Name)

• Remove: Remove a selected Realm (see To Change a Host, Realm or User Name)

• Realm: Enter the name of the required Realm

User Info Properties

• Add: Add a User (see To Add a User)

• Change: Change a selected User (see To Change a Host, Realm or User Name)

• Remove: Remove a selected User (see To Change a Host, Realm or User Name)

• User: Enter the User name

• Password: Enter a password for the User (if required)

• Confirm PW: Confirm the User password (if required)

Note: A User password is not mandatory.

10.3.2 Authentication Panel Procedures

This section contains information on the following topics:

• To Add a Viz One Host

• To Add a Realm

• To Add a User

• To Change a Host, Realm or User Name

• To Delete a Host, Realm or User Name
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Note: After the completion of the required procedures make sure that Viz Artist is
restarted. Changes are not save until Viz Artist has been restarted.

To Add a Viz One Host

To add a Viz One Host, a Realm and a User must also be defined.

1. Enter a Viz One Host name.

2. Click Add.

3. Enter a Realm name (if no Realm is required enter <empty>).

4. Click Add.

5. Enter the new User name.

6. Enter a User password (if required).

Note: A User password is not mandatory.

7. Confirm the User password (if required).

8. Click Add.

9. Click Save or Save as...

To Add a Realm

1. Click on a Viz One Host.

2. Enter a Realm name.

3. Click Add.

4. Enter a User name.

5. Enter a User password (if required).

Note: A User password is not mandatory.

6. Confirm the User password (if required).



Viz Artist User’s Guide

Page 464 Copyright © 2014 Vizrt

7. Click Add.

8. Click Save or Save as...

To Add a User

1. Select a Viz One Host.

2. Select a Realm.

3. Enter the new User name.

4. Enter a User password (if required).

Note: A User password is not mandatory.

5. Confirm the User password (if required).

6. Click Save or Save as...

To Change a Host, Realm or User Name

1. Click in the name field for either the:

• Host Info

• Realm

• User

2. Make a change to the name as required.

3. Click Change.

4. Click Save or Save as...

To Delete a Host, Realm or User Name

Note: If a Host is to be removed, any defined Realms or Users for that Host will
also be removed.

Note: If a Realm is to be removed, all Users for that Realm will also be removed.

1. Make sure that the item to be deleted is highlighted (1).

2. Click Remove (2) for either the:

• Host Info

• Realm

• User

3. Click Change.
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4. Click Save or Save as...

10.4 Camera

In this section, special camera behavior settings that are used for virtual studio setups,
can be defined. Viz IO is used as the studio configuration and calibration tool for
enabling connectivity and control between all required studio devices such as cameras,
routers, VTRs, video servers, audio mixers and other studio equipment.

• Virtual Studio: When set to Active the tracking process will be started when Viz
Engine is started.

• Command: Sets the path to the .bat file that will start the tracking process. If a
valid path is given, Viz Engine will start Viz IO during startup.

• On-air camera: Activates the selected camera that should be used when setting
the scene in on air mode. The camera is controlled by an external tracking device.

• Stereo Mode: settings will only take effect on air, during artist you do not see this
rendering behavior!

• Anaglyph: Renders a classical red/blue image.

• Quad Buffered: When using nVisio glasses together with a monitor with a
frequency >100Hz the image for the left/right eye will be shown alternately and the
glasses will darken the other eye. This configuration provides the full resolution.

• OverUnderLeftTop/OverUnderRightTop: Both images will be drawn beneath
each. Either side can be drawn first. The image height will be halved, providing half
resolution.

• Left Eye/Right Eye: Either the left or the right eye image will be rendered for
dual-channel setups in combination with a Viz Video Wall / Stereo Distributor. Full
resolution.

• SideBySideLeft/SideBySideRight: Both images will be rendered side by side,
either left or right first. The image width will be halved, providing half resolution.
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• RowInterlacedLeftTop/RowInterlacedRightTop: Both images are rendered
interlaced underneath each other, either starting with left or right image.

• ColumnsInterlacedLeft/ColumnsInterlacedRight: Both images are rendered
interlaced beneath each other, either starting with left or right image.

• Depth of field: Allows you to define from where parameters will be taken. When
set to Use editor, parameters for depth of field are taken from the editor. When
set to Focal plane from external, only the focal plane is taken from the external
camera. When set to All from external, all parameters are taken from the external
camera.

10.4.1 EVS Epsio Tracking

EVS Epsio is an optical tracking system produced and sold by EVS Broadcast Equipment
SA. When integrated with Viz Engine, it is commonly used in combination with a Matrox
board.

The Epsio system is based on image recognition and is able to analyze a dirty feed of
field-based sports (e.g. soccer and tennis) to generate camera position, rotation and
field of view information for external render engines like Viz Engine.

As the Epsio system analyzes the video and generates tracking information for the
actual camera, tracking data is shared with Viz Engine by sending video to the Matrox’
live input. The tracking data is used to modify Viz Engine’s virtual cameras accordingly.
For the graphics designer nothing changes, except that the camera is moved by an
external source.

Note: For information on how to setup and connect the Epsio system, please refer
to relevant Epsio documentation.

To activate Epsio tracking for Viz Engine

1. Open your configuration file (e.g. VIZ-<machine name>-0-0.cfg)

• 32-bit system: C:\Program Files\vizrt\Viz3\ or

• 64-bit system: C:\Program Files (x86)\Viz3\

2. Go to SECTION CAMERA

3. Set the evs_tracking_port entry to match the port used by the Epsio tracking
system to send the camera tracking data

• If this port is set to 0, the Epsio system is deactivated

• The evs_command_port is for future use and should be set to 0

4. Restart Viz Engine

• Viz Engine’s EVS Epsio receiver should be ready to use.

To activate Epsio tracking for Viz Engine via command

In Viz Engine the system is activated by the following command:

-1 RENDERER*CAMERA1*EVS_TRACKING SET <delay>

http://www.evs.com/
http://www.evs.com/
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<delay> tells the system for how many fields the tracking should be delayed. Usually
a delay of 10 fields is used. This can vary depending on the video card used. If <delay>
is set to 0 the EVS system is deactivated.

The following example activates Epsio tracking with a delay of 10 fields

-1 RENDERER*CAMERA1*EVS_TRACKING SET 10

The following example deactivates Epsio tracking

-1 RENDERER*CAMERA1*EVS_TRACKING SET 0

10.5 Communication
In this section, network connections can be set. Any external control software, for
example Viz Trio, uses TCP/IP network connections to send commands to the Viz Engine
renderer engine. Viz Artist expects the commands at the port that is defined here . For
a single pipe (one display) system, the default value (6100) should normally not be
changed.

Global

• General Communication Port: Sets a general communication port for receiving
external commands when in On Air mode. Changes to this setting must be reflected
on the client side. Default is port 6100.

• Additional Communication: Enables commands to be sent to Viz Engine on UDP
and Multicast or a combination of the two. This is used by Viz Video Wall.

• Udp&multicast Port Number: Sets the port number for the computers that share
the same virtual IP address.

• Multicast IP Address: Sets the shared virtual IP address.



Viz Artist User’s Guide

Page 468 Copyright © 2014 Vizrt

Note: The default maximum number of TCP connections is limited to 255. Within
this number of connections a User defined limit of maximum connections can be
set (see To limit the number of TCP connections).

• Enable GPI: GPIO device control. Enables frame accurate triggering of commands
via GPI (general purpose interface). We support Sealevel GPI devices for GPI input.

• MUX Isolated Port: Port number for isolated sessions - no data shared (NLE).

• MUX Shared Port: Port number for shared sessions - shared data (NLE).

• MUX Fixed Port: Port number for fixed sessions - shared data, no reference
counting (NLE).

• Still Preview Port: Port number for still preview.

• Multi Touch Input:

• Server UDP: The Viz Multi Touch Interface (see protocol documentation, Viz
MultiTouchServer) is used to retrieve Multi Touch events. An external server
application is connected to the touch device, it translates the hardware messages
into the Viz Multi Touch Protocol and sends it via UDP to Viz. The internal Multi Touch
events in script and plugin API will be triggered.

• Mouse: Use to test trigger Multi Touch callbacks through a standard mouse device

• Win7 Touch: Win7 Touch messages are used to generate Multi Touch events in Viz

• TUIO: (Tangible User Interface Object) Select this if the touch device and/or
application works with TUIO/OSC (Open Sound Control).

• PPI: With the Perceptive Pixel API it is possible to retrieve additional information
from PPi touch screens, e.g. it is possible to get pressure information for each touch
on the device. A license from Perceptive Pixel is required to use this Multi Touch
input

Note: Many PPi screen drivers support a Win7 Touch emulation mode as well,
which means that the system is not bound to the PPI API.

• Leap: Leap Motion is a hand and finger tracking device. Activate to receive multi-
touch events from Leap.

• Win Stylus: Activates stylus pen input.

• Multi Touch Port: Port number to listen to the multi touch server. Required for
Server UPD communication.

• Multi Touch IP Address: IP address to listen to the multi touch server. Viz sends
Keep-Alive messages to the Multi Touch Server. You need to enter the IP address of
this server. Required for Server UPD communication.

• TUIO Port: Sets the TUIO port number for communicating with a TUIO enabled
multi-touch device. TUIO is a protocol for Table-Top Tangible User Interfaces. Default
port for most TUIO applications is 3333.

• Display Diagonal (inches): Viz can calculate transformations with momentum. For
this it needs to know the real, physical, screen-dimension to calculate the correct
animation speeds. The entered value should be in inches.

• Display Aspect Ratio: The real aspect ratio of the screen is needed as well (some
screens do not have pixel aspect ratios of 1.0).

• Frame Accurate Viz Comm.: Frame accurate commands via TCP (commands
delayed by ring buffer and specified FAVC bias). Enable only for external control that
supports special frame accurate command execution.
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• FAVC Bias: Delay fields (in addition to ring buffer size) for frame accurate
commands via TCP or GPI. This is the bias in frames for the commands if Frame
Accurate Viz Command is turned on. Could be negative as well.

• Command Field Dominance: States when to handle the commands sent to the
engine. E.g when set to “Odd retrace counter” all commands will be handled on odd
fields. Not valid in progressive modes. Options are:

• Always

• Odd Retrace Counter: Execute commands at an odd retrace counter.

• Even Retrace Counter: Execute commands at an even retrace counter.

• Intern. Always/Extern. Odd: Execute commands internally always and externally
at an odd retrace counter.

• Intern. Always/Extern. Even: Execute commands internally always and externally
at an even retrace counter.

• On air Mouse Events: Set mouse events in On Air Mode to On or Off

Shared Memory

• Multicast IP Address: Set the address for synchronizing distributed shared
memory map without Viz Graphic Hub.

• Multicast Port: Synchronize shared memory between all Viz Engines listening to
the multicast.

• UDP Port: Set the UDP listening port for shared memory input.

• TCP Port: Set the TCP listening port for shared memory input.

• Debug: Enable Shared Memory logging for UDP and TCP communication.

• Master Engine IP Address: Set the IP address of the master Viz Engine which
holds the complete shared memory map (loaded during startup of Viz Engine).

• Master Engine Port: Set the initializing port for the shared memory on startup
(the command port of the master Viz Engine).

• Master Poll: When enabled Viz Engine will load the shared memory map from the
defined master Viz Engine. Available options are:

• Inactive

• Commands

• UDP

• TCP

To limit the number of TCP connections

From Viz Engine 3.3 the number of TCP connections to Viz Artist can be set in the Viz
configuration.

1. Open the Viz configuration file (Viz-<hostname>-0-0.cfg):

• 32-bit system: C:\Program Files\vizrt\Viz3\ or
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• 64-bit system: C:\Program Files (x86)\Viz3\

2. Under SECTION COMMUNICATION set ‘max_tcp_connections’ to the number of
TCP connections required.

Note: If the number is set to 1 the first control application connecting to Viz will
get exclusive control over Viz.

Note: This setting applies to the default port (6100) and the Multiplexing Ports.

10.6 Clock Formats

In this section, twenty (20) various digital date and time formats can be set.

• Format 1-20: Sets and enables the clock formats that may be selected in Viz Artist
during scene design.

Tip: Add a font GEOM in Viz Artist to see how the clock formats can be used.

10.7 Database
The Database section has the following tabs for setting connections to, e.g. Viz Graphic
Hub, failover servers and deploy server.

• Global

• Failover

• Deploy
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Global

In this section, the Viz Graphic Hub database connection settings are configured.

• Host Name: Set the name of the Viz Graphic Hub naming service. The naming
service will always be a one to one map to the hostname of the machine running Viz
Graphic Hub.

• Hub: Set the Viz Graphic Hub server name.

• Port Number: Set the listener port number for Viz Graphic Hub. The default port
number is 19396, and should normally not be changed.

• User: Set the default user.

• Communication Timeout Settings:

• Failover Timeout (sec): Set the maximum time to wait before a fail over is
initiated from the main to the replication Viz Graphic Hub.

• Global RT Timeout (sec): Set the maximum response time for any request to Viz
Graphic Hub.

• Establishing Timeout (sec): Set the maximum waiting time to establish a
connection to Viz Graphic Hub.

• Show Auto Login: Enable (Yes) the user to check the Auto login check-box in the
Viz Graphic Hub login window. When disabled (No), the Auto login check-box is
hidden.

• Auto Login: Enable or disable automatic login to Viz Graphic Hub. This will disable
the login screen for Viz Engine and Viz Artist.

• Import by Name: Set to Yes to check for objects by name rather than by UUID. Set
to No to check by UUID.

• Popup Server Messages: Enable or disable popup server messages. Disabled
only works on local host.

• Date Format: Set the date format to EU (DD.MM.YYYY 13:54) or US (MM/DD/YY
01:54).

• Archive Bit-Mode: Set the bit-mode in which the archive will be saved.
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Note: For compatibility, 32-bit should be enabled if scenes will be imported to Viz
Artist versions prior to build 2310.

• Allow Folder Move: Allow or restrict the users ability to move/organize projects
and folders in Viz Graphic Hub. Options are Normal, with Shift or No. Default is
Normal which allows the user to freely move projects and folders.

The following prefix settings are needed if you are using an external control application
that sends commands containing certain path locations, but where the path of your
files is a different one on your Viz Graphic Hub (e.g. because you deployed them to a
specific location).

• Prefix Mode: Activate the prefix mode.

• Prefix Converting Info: Show the prefixed (final) paths in the console (this
behaves like the Viz Artist 2.x debug mode).

• Prefix Path: Contains the prefix path string that is used for incoming commands
containing path parameters.

Failover

To add redundant servers to the failover list

1. Enter the host name.

2. Enter the Graphic Hub.

3. Enter the port number.

4. Click Add.

Tip: Use the Up and Down buttons in the database failover list to raise and/or
lower a database’s priority in the event of failover.

5. Click Save.

Deploy
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• Deploy: Enable or disable deployment of Graphic data. When activated a Deploy
tab/button will show in the Viz Artist Main Menu Right.

• Deploy Host Name: Set the hostname of the Viz Graphic Hub machine to deploy
files to.

• Deploy Hub: Set the name of the Viz Graphic Hub instance to deploy files to.

• Deploy Port: Set your Viz Graphic Hub’s listener port number.

• Use Prefix Folders: Enable to define a prefix source and target.

• Prefix Folder Uuid Source: Set the source folder’s Uuid of the Viz Graphic Hub to
deploy from.

• Prefix Folder Uuid Target: Set the target folder’s Uuid of the Viz Graphic Hub to
deploy to.

Note: To see if the Uuids are correct the related Viz Graphic Hub systems must be
up and running.

10.8 Font Options

In this section, the font encoding can be configured.

• Font Options: Sets the font encoding. Available options are:

• Default: Sets the font encoding to single character interpretation (limited to 255).

• Japanese Industry Standard Code (JIS): Sets Japanese industry standard code
character encoding.

• Shifted Japanese Industry Standard Code (SJIS): Sets the newer Shift JIS
character encoding standard which sets aside certain character codes to signal the
start of a two-character sequence.

• Extended Unix Code (EUC): Sets Extended Unix Code (EUC) character encoding
that is a multi byte character encoding system used primarily for Japanese, Korean,
and simplified Chinese.

• Unicode: Sets the Unicode character encoding where every two characters are
interoperated as one (not widely used).

• UTF-8: Sets UTF-8 (8-bit UCS/Unicode Transformation Format) character encoding
that is a variable-length character encoding for Unicode.
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• Default Text Orientation: Sets the default horizontal text orientation. Available
options are; Left, Center and Right.

• Default Text V. Orientation: Sets the default vertical text orientation. Available
options are; Top, First Line, Center and Bottom.

• Default Text Direction: Sets the default text direction. Available options are; Left
to Right, Right to Left and Top to Bottom.

• Font Handling: Sets the font handling. Available options are Font file or Complex
script.

• Font file: Sets the font kerning to Font file that is mainly used for languages written
from left to right.

• Complex script: Sets the font kerning to Complex script. Complex script is mainly
used for languages written from right to left and/or that one character can be are
composed of one or several Glyphs.

• Font Import: Sets the Font import. Available options are; File (Standard) and
Windows (Advanced).

• File (Standard): Imports and stores fonts on the database.

• Windows (Advanced): Stores only the font name on the database. For this to work
the font must be installed on the Windows system where Viz Engine resides.

• Blur Import: Enables blur levels for fonts used in Viz 2.x scenes. These options will
make sure that fonts imported to Viz 3.x will be recreated with all blur levels used in
Viz 2.x. Available options are Blur 1-4.

• Outline Import: Enables outline levels for fonts used in Viz 2.x scenes. These
options will make sure that fonts imported to Viz 3.x will be recreated with all outline
levels used in Viz 2.x. Available options are Outline 1-3.

• Calculate Max Bounding Box Size: Enables Viz 3.x to calculate the bounding
boxes as they were calculated in Viz 2.x. In Viz 3.x a text object’s bounding box
height will increase if a capital character is entered (e.g. an umlaut (double dots)).
In viz 2.x the bounding box height was always the same and independent of the
characters in the text object. Available options are Active and Inactive. Default is
Inactive (false).

• Replace missing Characters with: Replaces a missing font character in a font
file with a default font character. The Unicode value refers to the decimal value of
the replacement character in the Unicode table (valid values are 0-65553). Normal
usage would select a * (42) or _ (95).

10.9 Global Input

The Global Input settings influence the generation and handling of Six Degrees of
Freedom (6DoF) messages that can be distributed to several Viz Engines.

6DoF is used when working in 3D space in combination with special input devices such
as a mouse. A mouse uses two coordinates (xy) which Viz is able to translate into three
coordinates (xyz) based on a grid.
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• Group: Defines which multicast group the generated or received messages belong
to. If more than one group is to be defined, a unique Group number must be set for
each group.

• Role: Defines how messages are generated and processed. Alternatives are; None,
Master and Slave.

• None: Messages are only generated and processed on the local Viz Engine.

• Master: A Master creates messages for himself and the defined group.

• Slave: A Slave reads and processes 6DOF messages but is not allowed creating
them.

• Synch. Properties: Activates/deactivates synchronization of Viz Engine scene
properties.

To synchronize multiple Viz Engines

1. Start Viz Config on all involved render machines.

2. Set the same Group ID for all engines, and set Synch. Properties to Active.

3. Save and close all Viz Configs.

4. Open the Control Panel on all render machines, and make sure that you deactivate
all unused network connections.

• Viz Engine always uses the first network connection setup by the Windows
operating system.

• Synchronized engines work within the same network segment only because it
is using multicasts, hence, it is important to use the right connection.

• You can also determine the first connection by setting a manual metric in
Windows: http://support.microsoft.com/kb/299540.

5. Start all Viz Engines again.

6. Create a simple test scene with a geometry and the Synchronized Properties
plugin (Built Ins > Container > Global) on the same container.

7. Save the scene and open it on all involved engines.

8. Move the geometry on one engine.

• All the other engines will show the same object movement.

10.10 Import 3D Options

In this section, parameters influencing the import of 3D objects can be configured.
There are four different formats; Wavefront, AutoCAD, 3D-Studio, and Softimage.

The Wavefront, AutoCAD, and 3D-Studio formats have three available controls:

• Unify Object Size: If enabled, all vertices are recalculated during import in a way
that the object centre is moved to the origin (0,0,0), and the size of the object is 100
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cm in its largest extent. If disabled, all vertices retain their values as defined in the
original file. An object could appear invisible in a Viz Artist scene because the object
is translated a lot from the origin or is scaled up or down a lot. It could be necessary
to deactivate the unification to be able to recombine several separately imported
objects that must keep their size and relative position.

• Face Orientation: Polygonal 3D models often do not have a consistent face
orientation, but for performance reasons, the Viz Artist renderer expects that all
faces of an object point to the same direction. If enabling this function, Viz Artist
tries to rearrange the orientation of the object faces during import.

• Shading Angle: If the 3D object has no normal vector information, Viz Artist
automatically recalculates the normal’s from the geometry to make lighting
possible. This recalculation is influenced by the shading angle, which acts as a
threshold between sharp and soft edges.

Note: A shading angle value of 60 means that an edge between two faces is
considered to be a soft edge for angles below 60 and a sharp edge above this
level. 60 is the default shading angle.

The Softimage format has two available controls:

• Classic Scaling: Changes Softimage rotation order to conform to the internal
rotation order of Viz.

• Enable Animations: Allows import of saved Softimage animations.

10.11 Image File Name Convert

In this section, nine (9) different replacement configurations can be set for image file
names. For example; If an image file name starts with the string Replace this part of
the file name can be replaced by the string With.

• Replace: Defines the string that will be replaced.

• With: Defines the replacement string.

10.12 Local Settings

• Log Directory: Enter the storage location of Viz Artist log files.
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• Verbosity: Select content of log files, if no selection is made only the default
content of the log file will be created:

• Verbose Output (this enables the most information to be shown in the Viz Engine
Console).

• Include Date and Time

• OpenGL Error Output (AMD)

• Write GH Connection Log

10.13 Maps

• Map Server: Enables or disables Viz World Server (WoS) connection for Viz World
Client (WoC).

• Server: Sets the Viz World Server host.

• Project: Sets the default map project that will be opened with the client
application.

• Available: Lists all available Viz World Server projects.

• Map size: Sets the default map size that will be used with the client application.

• Cache: Enables caching of maps for faster preview and fetching of maps. Especially
useful for journalists and operators using Newsroom Component and Viz Trio
respectively.

• Cache Directory: Sets the cache directory for cached maps which can be a local
drive, mapped drive or a Universal Naming Convention (UNC) path.

IMPORTANT! Make sure the Cache Directory folder is configured with read and
write access rights.

• Memory (Images): Sets the number of images to keep in memory.

• On disk (Days): Sets the number of days to save images on disk.

• 2nd Cache Directory: Enables a second cache (see Cache above). The main
purpose of the second cache is to enable redundancy in those cases where a main
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cache directory is on a different computer and for some reason fails. Another use
case is to use it as a local cache to save loading time (e.g. if you load all borders for
the entire world you would have 100MB+ of cached files). To shorten load time you
can copy large static files to the correct local cache folder. In the 3D Map Setting
plugin you will also find a Sync Local Cache Folder button which will copy all the
needed files to your local cache. Note that the second cache directory settings can
only be used by Viz World version 12.0 and later.

• Priority: Sets the machine’s connection priority to the Viz World Server (Wos).
Setting a number, where 1 is the lowest and 100 is the highest you may override
connection priorities set by other machines. The configuration interface will allow
you to prioritize client connections from Viz Artist and On Air Viz Engine’s used
for preview and program output. Viz Engines must be in On Air mode for them to
be prioritized. For Viz World Map Editor you can set it from its context menu. To
enable this behavior on the server side you need to enable WoS to prioritize its
connections/logins. For more information, see the Viz World User’s Guide Server
Launcher Configuration section. If the configuration option is not visible, please read
how To add the VizWorld.ini file and set the priority.

• Network Monitor: Enables you to monitor relevant network connections (server
and cache folders). If you do not monitor the network and you try to connect
over a “disconnected network”, connecting to a server or a UNC path, it will take
time before the system reports back (e.g. 30 seconds or more). Enabling network
monitoring will avoid such connection issues. Note that the network monitor will
only monitor a cache folder that use a UNC path (not mounted/mapped drives). If
the configuration option is not visible you need To add the VizWorld.ini file.

• Languages: Sets the current language to be used on labels fetched from Viz World
Server. For more information, see the Viz World User’s Guide.

• Attributions: Adds an attribution to the map. Alternatives are; Static and Dynamic.

• Dynamic: Displays the attribution when a licensed imagery is in view and
disappears when the image is out of view.

• Static: Displays the attribution as long as there is a licensed imagery in the scene.

• Attribution Font: Sets the font for the attribution.

• Bold: Sets the attribution font to bold.

• Italic: Sets the attribution font to italic.

• On Top: Places the attribution image to the top in the screen. Default is bottom.

• On Right: Places the attribution image to the right in the screen. Default is left.

To add the VizWorld.ini file

1. Create a and save a VizWorld.ini file to the following location:

C:\Program Files (x86)\vizrt\Viz3\plugin\data\maps

2. Open the file and enter the following:

Monitor=1
Priority=1
Language=[my Language ID]

3. Save the file and start e.g. Viz Config to see the configurable parameters

Monitor enables network monitoring. For more information see the Network Monitor
setting under the Maps section.

Priority sets Viz’ connection priority to the Viz World Server. For more information
see the Priority setting under the Maps section and the Viz World User’s Guide Server
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Launcher Configuration section on how to enable prioritized connections on the server
side.

my Language ID refers to the order of languages in your list of languages (e.g. English
= 0, Arabic = 1, Hebrew = 2 and so on). For more information see the Languages
setting under the Maps section.

10.14 Matrox
In Viz Artist it is possible to assign Matrox in and out channels to Viz Artist’s in and out
channels.

The GUI shows a tab for General and, according to the installed hardware, tabs for
VideoOut, VideoIn, and ClipIn. Depending on your installed hardware there might be
different tabs available.

This section contains information on the following topics:

• General

• VideoOut

• VideoIn

• ClipIn

• ClipOut

10.14.1 General

The General tab shows information about the installed hardware.

• Serial No.: Shows the serial number of the installed Matrox board.

• Board Info: Shows the model and type of the Matrox board.

• DSX Info: Shows the software version and driver version.

• Print Clip Info: When activated this setting enables printing of clip information to
the console; however, such information may cause the render loop to stall. Default
mode is Inactive.

• Use Watchdog: When activated this setting enables the Matrox X.mio watchdog
feature. It defines what kind of key is produced when the watchdog takes over
control. Default mode is Inactive. When the watchdog is enabled, turning off the
video out will activate the hardware bypass after a given timeout (see next setting).
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• Timeout: Defines the time in milliseconds until the watchdog takes over control.
This value should not be smaller than the time of two fields/frames. Default value is
999 milliseconds.

• Use Flywheel: When activated, the Matrox board adopts a tracking mode if the
genlock signal is interrupted or lost that maintains the signal frequency until the
source genlock signal is regained. Default mode is Active.

• Max Recovery Time: Represents the time in milliseconds (ms) provided to the
flywheel to attempt to regain the genlock before an abrupt jump to the locked state
is performed. Default value is 15.

• Max Unclock Time: Represents the time in milliseconds (ms) provided to the
flywheel to remain in the unlocked state before switching to the free running state.
Default value is 15.

10.14.2 VideoOut

The VideoOut tab displays a simple and an Advanced Properties view. The simple view
shows the mapped Viz Artist channel. In the advanced view every setting of the output
channel can be controlled. The switch between the simple and the advanced view is
done with the small black triangle on the right-hand side.

• Map to Viz Channel: Decides which Viz Artist video out channel is mapped onto
this Matrox video out channel. The drop-down gives a choice between the available
channels. Only the channels not already taken are shown.

• Unused: Do not use this Matrox channel for output.

• Program: Plays out the Program signal of Viz Artist.

• Preview: Plays out the Preview signal of Viz Artist.

On a single channel configuration VideoOutA is usually mapped to Program and
VideoOutB to Preview, whereas for a dual channel configuration usually the first
channel maps VideoOutA to Program and the second channel VideoOutB to Program.

This section also contains information on the following topics:

• Advanced Properties



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 481

Advanced Properties

Group for fill component of the video output.

• Allow Super Black: Determines whether or not to clip an output video signal that
is under 7.5 IRE unit s. Default mode is Inactive.

• Allow Super White: Determines whether or not to clip an output video signal that
is over 100 IRE unit s. Default mode is Inactive.

• Allow Chroma Clipping: Determines whether or not to clip over-saturated chroma
levels in the active portion of the output video signal. Default mode is Inactive.

• Digital Edge Sharpening Filter: Applies an edge sharpening filter to digital
output video. Default mode is Inactive. SD configurations only.

Group for key component of the video output.

• Watchdog Key Opaque: Specifies if the output key must be opaque or transparent
when the watchdog unit activates. Default mode is Inactive.

• Allow Super Black: Determines whether or not to clip an output video signal that
is under 7.5 IRE unit s. Default mode is Inactive.

• Allow Super White: Determines whether or not to clip an output video signal that
is over 100 IRE unit s. Default mode is Inactive.

• Allow Chroma Clipping: Determines whether or not to clip over-saturated chroma
levels in the active portion of the output video signal. Default mode is Inactive.

• Apply Offset: Applies an offset to the luminance values such that the inverted
result still falls within the 16-235 range. Default mode is Inactive.

• Downscale Luma: Compresses the luminance range of the output key signal from
0-255 to 16-235. Default mode is Active.

• Invert Luma: Inverts the luminance part of the output key signal (inverts the key).
Default mode is Inactive.

• Manager Size (frames): Sets the number of frames available in the on-board
memory for output. A too high value may cause memory problems on the Matrox
board. Default value is 3.
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• Repeat Mode: Defines the way the output should be repeated if Viz Engine is
stalled and does not update the output. Default mode is Field. Available modes are:

• None: Does not repeat. Output goes black.

• Field: Repeats the last played field.

• Frame: Repeats the last played frame.

• 3G Level B: Activates Level B for 3G mode in 1080p 50/60/60M (default mode is
Level A).

Group for Vertical Blanking Interval (VBI) related settings.

• VBI Enable: Enable/disable VBI output.

• Start Line: Defines at which line on the output the VBI section should start. Default
value is 0 (Off). The minimum VBI values are:

• NTSC: 7

• PAL: 6

• 720p: 7

• 1080i: 6

• Total Lines: Defines how many lines the VBI section in the output should have in
total. Default value is 0 (Off). The maximum VBI values are:

• NTSC: 32

• PAL: 34

• 720p: 19

• 1080i: 30

10.14.3 VideoIn

The VideoIn tab comes with a simple and an Advanced Properties view. The simple view
shows only the mapped Viz Artist channel. In the advanced view every setting of the



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 483

input channel can be controlled. The switch between the simple and the advanced view
is done with the small black triangle on the right hand side.

• Map to Viz Channel: decides which Viz Artist video in channel is mapped onto
this Matrox video in channel. The drop-down gives a choice between the available
channels. Only the channels not already taken are shown.

• Unused: Do not use this Matrox channel for video input

• Video1: Captured input is available in Viz Artist Video1.

On a single channel configuration VideoInA is usually mapped to Video1 and VideoInB
to Video2 and so on whereas for a dual channel configuration usually the first channel
maps VideoInA to Video1 and the second channel maps VideoInB to Video1. In this case
both the first and the second channel have one video input configured, namely Video1.

When running a machine with two graphics cards (i.e. a dual channel or Viz Trio Box
setup) you should note that video inputs are hardware resources on the Matrox board
that cannot be shared. If you need one input for both Viz Engine instances you have to
split the signal and apply it to 2 video input connectors.

This section also contains information on the following topics:

• Advanced Properties

Advanced Properties

Group for signal related settings.

• Brightness: Sets the relative offset on the luminance component of the incoming
video (min./max. values are dynamic and determined by the hardware). Default
value is 0 (Off).

• Lumagain: Sets the gain on the luminance component of the incoming video (min./
max. values are dynamic and determined by the hardware). Default value is 0 (Off).

• Hue: Sets the color shift on the chrominance component of the incoming video
(min./max. values are dynamic and determined by the hardware). Default value is 0
(Off).

• Saturation: Sets the gain on the chrominance component of the incoming video
(min./max. values are dynamic and determined by the hardware). Default value is 1
(On).

• Allow Super Black: Determines whether or not to clip an input video signal that is
under 7.5 IRE unit s. Default mode is Active.

• Allow Super White: Determines whether or not to clip an input video signal that is
over 100 IRE unit s. Default mode is Active.
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• Allow Chroma Clipping: Determines whether or not to clip over-saturated chroma
levels in the active portion of the input video signal. Default mode is Inactive.

Group for key component of the video input.

• Contains Alpha: Enables/Disables use of alpha component. This switch is only
enabled on input channels where capture with alpha is supported.

• Key Apply Offset: Enables/Disables key offset.

• Key Upscale Luma: Enables/Disables key upscale luma.

• Key Invert Luma: Enables/Disables key invert luma.

• Shaped: Enables/Disables capture in shaped format.

Group for fill component of the video input.

• Manager Size: Sets the number of frames available in the on-board memory for
capturing. This value is influenced by the input delays specified in the parameters
below and will automatically be adjusted if it is too low. A too high value may cause
memory problems on the Matrox board. Default value is 6.

• Streaming Size: Not in use.

• Texturemanager Size: Defines the size of the texture buffer in frames. Default
value is 8.

• Video Delay DVE: Sets the number of frames the live input should be delayed
before it can be used as a DVE layer. Default value is 0 (Off).

• Video Delay Texture: Sets the number of frames the live input should be delayed
before it can be used as a texture in the scene. Default value is 4.

• RP188 Enable: Enables capturing of SMPTE RP 188 extra information such as LTC
and VITC. Default is Inactive.

• Repeat Mode: Determines the behavior of the video input in case of capture drops.
The drop-down gives a choice between

• None: Does not repeat. Input goes black.

• Field: Repeats the last field.

• Frame: Repeats the last frame.
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• 3G Level B: Activates Level B for 3G mode in 1080p 50/60/60M (default mode is
Level A).

Group for Vertical Blanking Interval (VBI) related settings.

• VBI Enable: When set to Active this setting will enable VBI for this channel. Default
is Inactive. Note that if the input resolution is different from the output resolution it
is impossible to activate VBI since VBI can only be inserted if the resolutions are the
same.

• Start Line: Defines at which line on the input the VBI section will start. Default
value is 0 (Off). The minimum VBI values are (as for VideoOut):

• NTSC: 7

• PAL: 6

• 720p: 7

• 1080i: 6

• Delay DVE: Sets the number of frames the VBI should be delayed before the clip
can be used in DVE mode (Default is 0 (Off)).

• Delay Texture: Sets the number of frames the VBI should be delayed before the
clip can be used in texture mode. Default is 0 (Off).

Group for audio related settings.

• Audio: When set to Active this setting enables audio capturing on this channel.
Default mode is Active.

• Channels: Sets the number of audio channels to capture. Default number of
channels are 2. Available channel options for AES on X.mio are None, 1, 2, and 4.
For AES on X.mio 2/X.mio 2+ and for Embedded the channel options are None, 1, 2,
4, 8, and 16.

• Delay DVE: Sets the number of frames the audio should be delayed in DVE mode
before it can be mixed to the output. Default value is 4.

• Delay Texture: Sets the number of frames the audio should be delayed in texture
mode before it can be mixed to the output. Default value is 4.



Viz Artist User’s Guide

Page 486 Copyright © 2014 Vizrt

10.14.4 ClipIn

The ClipIn tab comes with a simple and an advanced view. The simple view shows only
the mapped Viz Artist channel. In the advanced view every setting of the input channel
can be controlled. The switch between the simple and the advanced view is done with
the small black triangle on the right hand side.

• Map to Viz Channel: Decides which Viz Artist clip in channel is mapped onto
this Matrox clip in channel. The drop-down gives a choice between the available
channels. Only the channels not already taken are shown.

• Unused: Do not use this Matrox channel for clip input.

• Clip1: Clip playback is available in Viz Artist Clip1.

Usually Matrox’ ClipIn1 is mapped to Viz Engine’s Clip1 and ClipIn2 to Clip2 and so on.

When a machine has two graphics cards installed (i.e. a dual channel or Viz Trio Box
setup) you should note that clip channels are not hardware resources on the Matrox
board, hence, both instances can address 2 clip channels each. Limiting factors are
performance and number of DVE layers.

This section also contains information on the following topics:

• Advanced Properties

Advanced Properties

• Pipeline Size: Defines the number of frames Matrox’ internal clip reader buffer
should buffer in advance. Default value is 30.

Group for fill component of the clip in channel

• Texuremanager Size: Texture download buffer size.
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• Video Delay DVE: DVE Delay of video when used as DVE.

• Video Delay Texture: Texture Delay of video when used as Texture.

Group for Vertical Blanking Interval (VBI) related settings.

• VBI Enable: Defines whether VBI should be used for this channel. Default mode is
Inactive.

• Delay DVE: Sets the number of frames the VBI should be delayed before the clip
can be used in DVE mode. Default value is 0 (Off).

• Delay Texture: Sets the number of frames the VBI should be delayed before the
clip can be used in texture mode. Default value for Viz 3.3 is 1. For Viz 3.2 the value
is 2.

Group for audio related settings.

• Audio Enable: When activated, this setting enables audio for this channel. When
inactive audio is disabled. Default value is Activated.

• Delay DVE: Sets the number of frames the audio clip should be delayed in DVE
mode before it can be mixed to the output. Default value is 4.

• Delay Texture: Sets the number of frames the audio clip should be delayed in
texture mode before it can be mixed to the output. Default value is 4.

Group for key component of the clip in channel

• Contains Alpha: Enables/disables playback of clips with alpha.

• Upscale Luma: Enables/disables the default for upscale luma. Per scene setting of
this value is set per clip channel under Scene Settings and Video clip options.

• Shaped: Defines whether the fill from this channel, when the channel is used in
DVE mode, should be interpreted as shaped video during DVE compositing. Default
value is Inactive.

• Repeat Mode: Determines the behavior of the video input in case of capture drops.
Available options are None, Field and Frame.

• None: Does not repeat. Input goes black.

• Field: Repeats the last field.
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• Frame: Repeats the last frame.

• Loop Mode: Enables/disables default for loop mode. Per scene setting of this value
is set per clip channel under Scene Settings and Video clip options.

• Reverse Fields: Swaps fields when playing interlaced clips with negative playback
speed (default setting). Per scene setting of this value is set per clip channel under
Scene Settings and Video clip options.

Group for pending support.

• Pending Enable: Enables/disables pending clip player for this channel. The
pending clip player allows clip loading of another clip while the clip channel is still
using the current clip.

• Mode on Load Error: Determines the behavior of the current clip when loading of
the pending clip fails.

• None: Current clip mode is not changed.

• Stop: Performs a Stop command on the current clip.

• Pause: Current clip enters pause mode.

• Flush: Unloads the current clip.

10.14.5 ClipOut

• Capture Enable: Enables or disables the clip writer functionality. The main use is to
give you control over host memory resources. When the clip writer functionality is
not needed then the clip out channel does not need to be allocated.

• Pipeline Size: Gives control over the number of frames that the clip writer uses for
file handling, similar to the setting in the ClipIn channels.

10.15 Memory Management

• Free Image Data: Loads images into the main memory, and if those images are
rendered too, they will be loaded as texture to the graphics card memory as well.
Free Image Data gives the possibility to free the image data from the main memory
after texture creation. Available options are No, On-air and Always.
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Note: If there are modifications done to an image then its texture will be
rebuild a lot faster if the data already lies in the main memory (instead of re-
loading it from the database).

• No: Disables the Free Image Data option. This option is faster, but needs a lot of
memory.

• On-air: Frees image data when in On Air mode, but not in Viz Artist. mode.

• Always: Frees image data every time after the texture was created. This option
saves a lot of memory but is slower in case of texture rebuilds.

• Free Images: Removes unused images (not referenced in a loaded scene) from the
Image Pool (main memory and graphics card memory).

• Free Fonts: Removes unused fonts from the Font Pool.

• Free Memory Threshold (MB): If set to greater than zero (>0) then Viz Engine
tries to automatically unload unused Pool objects until the specified amount of main
memory is free again.

• Preload Textures: When enabled (On), then all images which will be loaded with
a scene (they do not need to be rendered) are loaded as textures to the graphics
card too. This eliminates the texture creation time during rendering afterwards (e.g.
useful when initializing a show or a playlist). Default is disabled (Off).

• Preload Textures: If this option is ON, all Images, which will be loaded with a
Scene (they do not have to be rendered), are loaded as texture to the graphics card.
This eliminates the texture creation time during rendering afterwards (useful when
initializing Viz Trio shows).

• Free Now: Frees the selected unused Pool objects (Scenes, Geometries, Images,
Fonts or all) from the memory.

10.16 Path Aliases

In this section, five favorite archive and import paths can be set.

• Name: Sets the path alias name for the archive or import path.

• Path: Sets the archive or import path which can be a local drive, mapped drive or a
Universal Naming Convention (UNC) path.

IMPORTANT! Make sure the archive folder is configured with read and write
access rights.
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Tip: Path aliases are available in the Viz Artist’s Archive and Import panes.

To add a path

1. Enter a descriptive name in the Name field

2. Enter a path in the path field, or click the Browse button to navigate and select a
path.

3. Assign a type. Your options are:

• Images

• Fonts

• Objects

• Scenes

• Audio

In this way, when you click on an alias before Importing Files, it automatically takes you
to the designated folder and switches to the assigned type.

4. Click Save.

10.17 Output Format

In this section, the output format of the rendering engine can be set. All video
hardware configurations are hooked to the video standard set as output format. This
setting defines the frequency (frame rate) at which Viz Engine is running.
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For PAL and NTSC, the aspect ratio of the format can be set to 4:3 (standard TV) and
16:9 (wide screen TV). Fullscreen sets the output format to the screen size on the
current machine. Note that Fullscreen also allows you to customize the frame rate
setting, but not other settings.

User Defined output format

Clicking the User Defined option opens a panel below the output format list. The user
defined output format can be used to fit the requirements of multi-pipe systems (for
example video walls or visionariums). The multi-pipe settings can be configured in the
right part of the editor.

Setup of multi-pipe systems should be performed by experienced system engineers.
For more information, please contact your local Vizrt representative.

• X: Sets the horizontal alignment in pixels on the screen. Value is calculated from top
left of the screen.

• Y: Sets the vertical alignment in pixels on the screen. Value is calculated from top
left of the screen.

• Width: Sets the width in pixels.

• Height: Sets the height in pixels.

• Frame: Sets the refresh rate/frequency per frame in hertz (Hz).

• Aspect: Sets the aspect ratio. For example 1.778:1 which is 16:9 or 1.333:1 which
is 4:3.

Note: Make sure that the physical refresh rate of the graphics hardware and the
video hardware is configured correspondingly.

There are 3 frequency groups/families; 50, 59,94 and 60 Hz. This defines the output
format, and how fast Viz Engine operates. The frequency is the same as frames per
second. This will also define the input format that is allowed; hence, an NTSC SD input
cannot produce a PAL SD output, but an HD input with the same frequency as the SD
output would work.
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10.18 Plugins

In the Plugins panel, all installed plugins, that are identified as valid plugins, are listed.
Plugin categories are:

• Geometry: see Geometry Plugins

• Container: see Container Plugins

• Scene: see Scene Plugins

• Shader: see Shader Plugins

• Fontstyle: see Working with Modifiers

• RenderToDisk: see Post Rendering

• Inactive: List all Plugins which are not loaded (inactive).

All plugins can individually be activated or deactivated. If a plugin is inactive it will not
be loaded at startup. All inactive plugins are listed under the Inactive panel.

Click on the Plugin dropdown menu to select a Plugin category.

Note: Some unlicensed plugins will not be loaded while others will. In the latter
case a watermark will be shown.

Note: The Config section in Viz Artist must open to show all information. In the Viz
Config standalone application, the plugins are not actually loaded. However you
can still enable or disable the loading state.

Warning: Viz does not load inactive plugins during run-time. If a scene uses a
plugin that is deactivated Viz is unable to activate it.

See Also
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• Viz License Information .

10.19 Render Options

In this section, the following render options can be set:

• Keep Editing Aspect: Influences scene designs in Viz Artist mode. Options are:

• Off: Scenes are only shown in Anamorphic widescreen in the 4:3 VGA render
window.

• Editor: Scenes are displayed using a letter-box format during scene editing giving
designers the option to set a user defined camera aspect ratio (under Scene
Settings -> Rendering). OnAir and Viz Engine modes are not affected.

• No Video: Scenes are shown using a letter-box format as long as the video out is
inactive. If video out is active scenes are shown in Anamorphic widescreen in Viz
Artist mode.

• Resize GUI: Increases the renderer window when editing 16:9 scenes to 16:9
format. On-Air and Viz Engine modes are not affected.

• Use Display Lists: Activates or deactivates the use of display lists in the Open GL
engine.

• Extended Color Space:  Not in use.

• Full Scene AA: Sets the hardware Anti aliasing (provided by the graphics card).
Options are:

• None

• 4 Samples

• 8 Samples

• 16 Samples

• Fill Mode:

• Direct: Unmodified fill output.

• Unshaped: Brightened fill when AutoKey is enabled.
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• Shaped: Fill is premultipled with key. Also see Shaped video versus unshaped video
.

• Use Fill Mode (for Post Production and NLE):

• Active: Use Fill Mode for Post Production and NLE.

• Inactive: Fill mode is not used for Post Production and NLE.

• RGB to YUV: Enables color conversion either in the Shader or on the Matrox board.

Note: If GpuDirect is set to ON (see Video Board) make sure that RGB to YUV is
set to Matrox.

• On Air Resolution: Sets the DVI output resolution for Viz Video Wall. Viz Video Wall
must activate DVI Output in the Video Output section for the On Air Resolution to
take effect. Options are:

• Desktop Resolution

• 800x600

• 1024x768

• 1280x1024

• 1600x900

• 600x1200

• On Air Mouse Cursor: Enables a mouse cursor when in On Air mode and using
interactive applications. Should be disabled for Viz Video Wall and when DVI out is
enabled.

• Execute All Animations: When deactivated this setting will enable Viz Engine to
only animate visible objects. Default is Active.

• Frame Counter: This setting takes effect for Standard-PC versions that use NVIDIA
cards and drivers.

• Incremental: Increases the field counter with every field

• OpenGL: Tries to requests the retrace counter thru OpenGL. If not possible, due to
driver or hardware problems, it falls back to the Incremental mode.

• System: Uses the internal CPU clock.

• Frame Speed: Enables Viz to run at a slower rate than the actual refresh rate
(determined by the screen speed with the use of a g-sync card). This is relevant
for video wall applications when the scene (e.g. interactive scenes) cannot run
real time (resource intensive), hence, all participating computers are synched to a
lower speed. Running at 30Hz (screen speed 60Hz divided by 2) can be acceptable,
however, this will affect the animation quality (animation will not be as smooth).

Combined Images

• Image Combining: In a texture editor (see Viz Artist) it is possible to set a second
texture which will be used for the image combining. The texture editor offers
two possible modes: The first mode uses the second image as an alpha channel,
whereas the second mode defines a blend between the two textures. Configuring
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Image Combining to Software enables the combination to be calculated entirely on
the CPU. Configuring Image Combining to Multi Texturing enables the combination
to be calculated on the graphics card for combining or blending the two images. In
this case the texture creation is faster and memory will be saved as well. Default
is Software. If there are performance or memory issues, especially with scenes
imported from Viz 2.x, it is recommended to change this setting to Multi Texturing.

• Key Render Mode: This configuration is used when the Key Render Mode under
Scene Settings in Viz Artist is set to Config, and determines how the key should be
rendered:

• Double Pass: Uses two rendering steps as in older 3.x versions. Double Pass should
be used for old 3.x scenes for not breaking compatibility, for new scenes Single Pass
should be used as it is faster.

• Single Pass: Uses one rendering step as in 2.8 versions.

Shaped video versus unshaped video

A shaped video image has its video data multiplied by its alpha component while the
video data of an unshaped image remains untouched. Shaped images are also referred
to as pre-multiplied alpha images.

• HD Interlaced: Specifies if Viz Engine should render frames or fields for interlaced
HD formats (i.e. 1080i). Rendering frames improves the rendered output but has a
higher performance cost. Available options are: Field and Frame.

• Sync. DirectShow: Synchronize DirectShow clip playback with renderer (may
cause video jumps and audio cracks).

• NLE Antialiasing: Antialiasing for small images snapshots and NLE frames.

• Image Load Error: If an image load error occurs you can configure Viz to keep the
old image or clear the image (i.e. not showing anything).
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10.20 Scene Default Values

Scene Default Values

This section configures the default values for new scenes.

• Key: Sets the key mode. Alternatives are; Virtual Set, Full Screen, Overlay, and Auto
Key.

• Animation Motion Path: Sets the default setting for all new position key frames.
When set to Smooth all handles in the scene output enables a smooth motion path.
When set to Linear no handles are available; hence the motion path is not smooth.
This setting corresponds with the Path Control setting in the Key frame editor. When
set to manual handles are made available in the spline view that enables speed
to be manually handled between key frames. When set to Linear no handles are
available.

• Animation Motion Speed: Sets the default setting for all new position key frames.

• Flicker Filter: When enabled it will reduce interlaced flicker on high contrast
objects. For example small lines and hard objects. Alternatives are; Off, and Level
1-3.

• Gamma: Sets the gamma radiation/emission for textures.

• Camera Clipping Plane: Sets the range of the virtual camera. Near sets the
close range while far defines the far range. Only objects within this range will be
rendered.

• Near: Sets the Near value to clip unwanted objects from the foreground. Default
value is 50.

• Far: Sets the Far value to clip unwanted objects from the background. Default value
is 20000.
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Note: The camera range is where the Z-buffer is within. So if Z-buffer problems
arise, they may be solved by editing the camera clipping plane settings.

• Ringing Filter: Sets the default value for the Ringing Filter. A ringing filter reduces
high frequency values in the video signal created by high contrast and color
changes in horizontal directions.

• Show Merge Style Dialog: Enables the user, when opening a scene in Viz Artist,
to open old-style merged objects and expose containers within it.

This feature relates to scenes using old-style ordering of containers within merged
objects, and solves the problem with auto-follow. When loading such scenes the
dialog lets the user decide how to deal with them.

Users that are aware of this and decide to keep the old style can deactivate this
dialog.

• Output Region: Shows which region of the screen Viz is licensed to render.

• Half Edition: Allows Viz to render half screen. Available options are; left, right, top,
bottom, bottom left, bottom right and bottom top.

• Quarter Edition: Allows Viz to render quarter screen. Available options are; left,
right, top, bottom, middle left, middle right, middle top and middle bottom.

• Show Black After End: Shows black after a clip has finished playing.

• Texture Sharpen Default: Sets the default sharpen value for textures.

• Video Input Layer Targets and Priority: Set the defaults for how the specific
input channel should be used and its priority. Available options are, Inactive,
Texture, DVE and Priority.

10.21 Spaceball

The Spaceball section is used to configure a 3D navigation device.

• SpaceBall Mode: Sets special setups where the spaceball should only control
specific plugins without influencing the scene (objects/camera):

• None: No setup.

• Plugin: Controls plugins.

• Viz: Controls Viz objects.
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• Both: Controls both plugins and Viz objects.

• Object Control:

• None: No setup.

• Selected: Modifies only the selected object.

• Button Mode:

• None: No setup.

• Pressed: When set to Pressed, this mode will trigger an action like a button in a
user interface.

• Toggle: When set to Toggle, this mode will set a state. For example when a button
is pressed only the dominant axis will be considered in a move, whereas when the
button is released all movements are applied.

The numeric fields are used to map the various buttons on the 3D navigation device.
This varies by the vendor and the vendors model; hence, the button numbers need to
be looked up in the User’s Guide for the respective device.

Button options are:

• Object Control

• Pan Only

• Tilt Only

• Roll Only

• X Only

• Y Only

• Z Only

• Transformation Only

• Direction Only

• Zoom In

• Zoom Out

• Save Camera Values

• Retrieve Camera Values

10.22 User Interface
This section describes the user interface settings. Some of these settings are also
available in Viz Artist.

This section contains information on the following topics:

• Various

• Colors

• Shortcuts
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10.22.1 Various

Various user interface settings

• GUI Icon Font: Sets the Font type for all icons of elements such as scenes, objects,
materials, images, fonts, and audio clips. Complex character sets such as Arabic,
Hebrew and Chinese must change the default font type to show the correct names
for the icons.

• GUI Font Size: Sets a global font size for the Viz GUI. Alternatives are; 10, 12, and
14 pixels.

• Button Gradient: Sets the gradient level of the buttons in the Viz Artist user
interface.

• Mouse Over Effect: Mouse over effect for buttons in the Viz Artist user interface.
Set to Active or Inactive.

• Scene/font/Audio Icon size: Sets a size preference for scene, font and audio
icons. Icon size can also be switched using the context menu in the server view in
Viz Artist; however, a switch in Viz Artist will not be saved as a preference for later
sessions.

• Show “Blur” fonts: Sets the default for showing or hiding the blur fonts in the
Server area. The option can then be toggled using the Element Context Menu.

• Show “Outline” fonts: Sets the default for showing or hiding the outline fonts in
the Server area. The option can then be toggled using the Element Context Menu.

• Import Default Type: Selects the default type for imports. This will then be pre-
selected in the Import Menu. Options are:

• Fonts

• Images

• Objects

• Scenes

• Audio

• Archives
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• Folder Type Highlighting: When enabled this will highlight the folders that
contain content matching the current Viz Artist’s Server view (for example Scene,
Object, Material, Image, Font, Audio, etc.).

Note: This can cause some performance overhead, when switching to different
types and/or with opening sub folders (but only first time, as the information is
cached).

• Auto Grab Focus: When Inactive, a middle mouse click grabs the focus, as a left
and right-click do. When audio grab focus is Active, the focus is grabbed as soon as
you move the mouse over a widget.

• Reset Startup Default Folder: Resets the startup folder. If Viz Artist is unable to
start due to problems with the last saved server view, clicking the Reset button will
reset the Server view to its top node.

• Performance Update Interval: Sets how often Viz Engine should update the
Performance Bar when it is opened.

• OnAir Update Interval: Update interval for the On Air Information window. Note
that a shorter interval decreases render performance. Setting to 0 means that no
update occurs.

• Tooltips: Enables or disables the tool tip information (pop-ups) in the Viz Artist user
interface.

• Delay On (ms): Sets the amount of time in milliseconds before the tool tip
appears. Default is 1500 ms.

• Delay Off (ms): Sets the amount of time before the tool tip disappears. Default is
4000 ms.

Note: A millisecond is one thousandth of a second.

• Screen Layout Mode: Set to either:

• Normal: Default screen (single monitor)

• Mosaic Horizontal:  Viz Artist shows on the left monitor and the Scene
Editor shows on the right monitor (two monitors).

• Mosaic Vertical:  Viz Artist shows on the top monitor and the Scene Editor
shows on the bottom monitor (two monitors).

Note: Mosaic Horizontal and Mosaic Vertical are only available with NIVIDA
graphics cards, with Windows 7 on. Open the NVIDIA properties to setup Mosaic
before changing the Viz Configuration file.

• Dual: The Scene Editor opens in a new window (two monitors).
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Normal Screen

Mosaic Horizontal

Mosaic Vertical
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Duel Screen

• Default Merge Button: Sets the default merge behavior available in the Viz Artist
user interface. Options are:

• Merge

• [Merge] to sub director

• [Merge] w/actions & events

• [Merge] w/actions and events to sub director (w/A. & E. to Subd.)

• Default Split Mode: Sets the default split behavior available in the Viz Artist user
interface. Options are:

• Split

• [Split] to existing director

• Default Color Space: Select RGB or HSV as the default color space for the Material
editor

• Update Control Text: Click to make Update Control Text active or inactive:

• Active: The Control text, in Control Objects, is updated with every key stroke

• Inactive: The Control text, in Control Objects, is not updated with every key stroke

10.22.2 Colors

The Colors tab gives the ability to change the User Interface color theme.

This section contains information on the following topics:

• Global Settings

• Scene Tree
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Global Settings

Use Global Settings to change the color theme of the User Interface.

Note: All the changes made to the User Interface are local. Click Save then
restart Viz Artist for the changes to take effect.

There are six pre-set color themes (4):

• Classic I

• Classic II

• Stone (default)

• Aqua

• SyringaBlue

• DarkMatrix

To change a pre-set color theme

• Click on a pre-set color theme (4).

Individual parts of the User Interface can be assigned a new color, if the part is listed in
the Subject panel (1).

To change a Subjects color

1. Click on a Subjects color bar in the Local panel (2).

2. In the color selection area (3) select RGB or HSV.

3. In the color selection area, click a color bar, or the color circle, and drag to change
the color.

or

1. Drag one of the current Subjects color (in the Local field).

2. Drop it onto another Subjects Local field.

or

1. Click on the eye dropper icon in the color bar.

2. Move the cursor to an area, color on-screen.
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3. Click to accept the new color.

Scene Tree

Use the Scene Tree panel to set the color codes for Containers in the Scene Tree. A
Container with a color code can be searched for in the Scene Tree, and the Scene Tree
can be restricted to Containers with certain colors (see Scene Tree Tabs).

A text tag can also be added to the color. The text is Scene specific and saved with
the Scene on the Viz Graphic Hub. Note that the colors might change if the Scene is
opened on a different machine with a different color setting.

Example: All text Containers can be colored gray and tagged Text, while all
Containers that hold images can be colored green and tagged Image, and so on.

Four colors are configured and active by default with no text descriptions. Click Set to
Default to set all color bars to their default setting.

The color options are available in the Scene Settings panel in the Tree Color Text
setting, and available for use in the Scene Tree panel.

To change the amount of active colors

• In the Active Colors field enter the amount of colors to be active.

Note: Up to 16 colors can be configured and made active.
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To create a color

1. Click on a unused color bar (1).

Note: It is also possible to change the color of the first four colors. Click in
their color bar.

2. In the color selection area (2) select RGB or HSV.

3. In the color selection area, click a color bar, or the color circle, and drag to change
the color.

4. If required: Click the color bar (1) and enter a name for it.

or

1. Click on the eye dropper icon in the color field.

2. Move the cursor to an area, color on-screen.

3. Click to accept the new color.

10.22.3 Shortcuts

The shortcuts view displays all available server, scene tree and property actions and
the currently assigned shortcuts. All shortcut configurations are saved to the database
into the user table for personalization.

User interface shortcut settings

• Server, Scene Tree and Properties: Displays all server actions and their
currently assigned shortcuts.

• Shortcuts: When clicked, displays a list of available shortcut key-combinations that
can be assigned to the selected action.

• Reset All: Resets all shortcuts to the default setup.

10.23 Video Board
This section is used to configure video input, output and clip playback related settings.
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This section contains information on the following topics:

• Video Board Properties

• Select Multiple Directories

10.23.1 Video Board Properties

• Clip Data Directory: Sets the clip directory (default directory is D:\ drive). Clips
that are transferred from Viz One, use V:\ drive.

Note: The directory has to match the directory set when installing the Mediaftp
service for video transfer from Viz One.

• Loopthrough Delay (EE): Sets delay for live video input in DVE mode
(Targa board only). This setting applies for all input channels. For Matrox, see
(Matrox0.VideoIn1.VideoDelayDVE) ... Configuration File.

• Videoout Ringbuffer: Sets the render buffer for video output. Helps to prevent
frame drops on the video output during execution of commands or loading of
objects. When enabled the engine will render a number of graphics frames in
advance and provide it to the video hardware. The number of frames rendered
forwardly is defined by the Ringbuffer Size. Large buffer sizes will delay the output
and increase the input to output delay for video textures.

• Ringbuffer size: Sets the size of the Ringbuffer in frames.

• Format Codec 1: Enables the codec matching the codec (Targa board only).
Alternatives are MPEG and DV. This only applies to video clips.

• Format Codec 2: Enables the codec matching the codec (Targa board only).
Alternatives are MPEG and DV. This only applies to video clips.

• Viz Link: Enables clip transfer from the Viz One. If enabled this option has the
following effects:

• In the VGA version, setting the clip takes immediate effect instead of the
command travelling through the ring buffer.

• In the VGA version a clip channel set to DVE will play the clip in texture mode.

• Activates the asynchronous Command feedback when setting a clip. The first
answer in this case is a ANSWER DELAYED message to the client and after that,
either an error message or a success message is sent back to the client.

• A clip which is currently playing in the active player will not be loaded back to
back.

• DVS Ring Buffer: To have a separate ring buffer setting for DVS (especially for
combinations with Matrox DSXLE2), set this to ON (visible when DVS card installed).

• Watch Dog Mode: The following options are available:



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 507

• First Geom Load: Video Out is activated when the first geometry is loaded.

• At Startup: Video Out is activated at start up.

• First Geom Load/DVE: Video Out is activated when the first geometry is loaded or
an input or clip channel is set to DVE.

• Watch Dog Reactivation: Set to ON to activate the watch dog again if scenes are
unloaded from renderer.

• Use GPU Direct: Set to ON to enable a fast, low latency method to copy frames
from the video IO device to the GPU and back (gives more time for the renderer to
process complex and GPU intense visual effects).

10.23.2 Select Multiple Directories

More than one clip directory can be selected.

When more than one directory path is selected, for example, D:\AEClips; D:\DecoClips,
etc., in the Clip Name box (see Video Properties) change the file path to ‘<clip_root>’.
The file name is then searched for, in the selected directories, one after the other, for
stored video clips with the same name.

Example: Search for a video clip named ‘next_tuesday.avi’ in V:\AEClips\AFL
\Promos. In the Clip Name box change ‘V:\AEClips\AFL\Promos’ to ‘<clip_root>’
The filename shown in Viz Artist should be <clip_root>\next_tuesday.avi

Note: The directory has to match the directory set when the Mediaftp service for
video transfer from Viz One was installed.

Multiple directories can be used with:

• A Dual Channel or Trio Box CG configuration, or

• With any Viz Engine / Artist configuration for the selection of a secondary video clip
directory if a directory fails.

If the file path for a video clip is set to ‘<clip_root>’, and the first directory falls over
the same video file will be searched for and used, from the next directory in the Clip
directory list.

• If, when multiple Clip directories are selected, the Clip Name box (see Video
Properties) is used to search for a video, the search will default to the last used
directory.
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10.24 Video Clip
Select the video clip directory to search for video clips. If required more than one
directory path can be selected (see Dual Channel and Trio Media Box configuration).

• Clip Data Directory: Sets the clip directory to search. The default directory is D:\
drive.

10.25 Video Input

Video input channels are enabled in this section. To be able to use a Live input channel,
a Clip channel or a Stream channel, it first has to be set to active in this panel.

The frequency of the channels is defined in the Output Format section.

This section contains information on the following topics:

• Live and Clip Channels

• No Onboard Video Board

• No Onboard Video Board
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Live and Clip Channels

This panel activates the Live input and Clip channels and defines the video standard
that the channel is configured to. It is possible to mix video standards, for example, a
Viz Engine configured to play out 1080i50 can have inputs configured to SD.

Clip channels are for video clips. Clip Channel 1 and Clip Channel 2 must be configured
to the same video standard.

• Live w/Alpha: For the Input this will combine the two (Live 1 and Live 2) channels
to one channel carrying fill and key. This means that the Y (luminance) from Live 2
in YUV will be used as the key signal.

• Clip Channel w/Alpha: When enabled the clip file must either contain key
information or a key clip must be provided. The key clip must have the string
“_key” appended to the filename. For a clip named i422_50M.avi this would be
i422_50M_key.avi.

Note: Video input format may be limited by hardware capabilities on the video
board (for example Targa boards only support SD, and Matrox 6000 series boards
does not support HD clips).

Stream Channels

The Stream channels are for live video streams (see External Video Stream Through
Texture). Set each Stream to active or inactive.

The Stream channels are for live video streams (see External Video Stream Through
Texture, in the Viz Artist User Guide). Set each Stream to active or inactive.

No Onboard Video Board

Video input settings without video board

When there is no onboard video board (standard-PC) the video input section no longer
shows the Alpha options for Live and Clip. Video input for standard-PC versions enable
clip playback through the Properties Panel.

When there is no onboard video board (standard-PC) the video input section no longer
shows the Alpha options for Live and Clip. Video input for standard-PC versions enable
clip playback through the Viz Artist Properties Panel.
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10.26 Video Output

Video Output (Matrox Card)

This section is used to configure special settings for video output such as SPG settings
and so on.

• Show Video Output Config. Editor: Opens the Video Output Editor , or press (Alt
+V).

• Use NVIDIA SDI output/capture card(s): Enables your NVIDIA card’s SDI module
to output video. This will shorten the output delay when outputting graphics
and video through the video board. However, this requires audio to be handled
externally since NVIDIA’s SDI module does not support embedded audio output.

• Video wall/Multi-display: Sets the main output to the Digital Visual Interface ( DVI
). Viz Artist will render to fullscreen (set the resolution in Render Options section).

• Allow Super Black (NVIDIA SDI card only): Controls the key output:

• Inactive: Use the video range (only valid in conjunction with NVIDIA SDI and driver
versions older than 259.12).

• Active: Use the full signal range. When active it will determine to clip or not to clip
the key output video signal that is under 7.5 IRE units or over 100 IRE units.

• Readback Async: (DVS board only) Output only, see Video Board, ‘Use GPU
Direct’.

• Render preview default setting: Sets the default value for the Preview button
(see Control Buttons ) when Viz Engine is in On Air mode.

• Inactive: Rendering will only be done for video out signals. This will increase
performance as the renderer does not have to render into an editor on-screen and
into pixel buffer.

• Active: Rendering will be done for both video out signals and on-screen (this will
decrease the performance).

• Fullscreen: Set the On Air window to screen size.

Note: Machines without a video board do not have the Video Output section.

10.26.1 Video Output Editor
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The Video Output Editor defines the synchronization standard and the output signal
phases.

• Freerun: Locks Viz Engine to a clock signal on the video board.

• Blackburst and Tri-level: Locks Viz Engine to a GenLock signal.

• Digital Input 1 and 2: Locks Viz Engine to the signal on Input 1 or 2.

• H-Phase and V-Phase: Shifts the output signal with respect to the sync signal.

To make the V- and H-phase values coincide

1. Set the V-phase value

• The V-granularity is taken from the genlock

• The V-delay is calculated from V-phase * V-granularity

• The genlock is set with this V-delay

2. Set the H-phase value. Note that there is a distinction whether the H-phase is a
positive or a negative value.

1. If the H-phase > 0

• The genlock H-delay is set to 0

• The H-granularity is taken from the video out channel

• The H-delay is calculated from H-phase * H-granularity

• The fill and key channels are set with this H-delay

2. If the H-phase <=0

• The fill and key channel H-delay is set to 0

• The H-granularity is taken from the genlock

• The H-delay is calculated from - H-phase * H-granularity

• The genlock is set with this H-delay

Note: The granularity and possible min/max values are printed to the Viz console
during startup.

It should be taken into account that when the genlock video format is different from
the fill/key video format the value of the V-delay matches the genlock lines and not the
video output lines. The same applies to negative H-phase values.

See Also

• Output Format

• Video Input

10.27 Viz Artist 2.x
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In this section, Viz Artist 3 can be switched to Viz Artist 2 mode for compatibility issues.

In Viz Artist versions prior to 3.0, assets were stored in specific subdirectories
(Scene, Object, Material, Font, and Image). As Viz Artist 3 stores assets anywhere
in the directory, older control applications may not find these assets. If enabling 2.x
mode, the assets will be looked for in the subdirectories, and calls for scenes will be
represented by green lines in the console window.

When working in 2.x mode, Viz_2x will automatically be added before the default
messaging path. Furthermore, the paths sent by the external control applications will
be converted to lower case (as the names of the data will be converted to lower case
when importing). So, external control programs must not be re-written when migrating
from Viz Artist 2 to 3.

• Use 2.x mode: Enables Viz Engine to run in 2.x mode.

• Show converting Info in Viz-Console: Enables the calls for scenes to be shown
as green text.

Note: It is only recommended to use 2.x mode if new scenes are organized
according to the old 2.x data structure.

10.28 Viz License Information

In this panel, information about the current Viz license is shown. The panel lists the
various licensed features, for example, the available plugin packages.

• License: Enter a license key into the License field, press <Enter>, and click Save.
Restart Viz for the new license key to take effect.

See Also

• Plugins
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11 Geometry Plugins

Geometry (Geom) plugins are housed in the following folders:

• Default

• PixelFX Plugins

• Primitives

• RealFX Plugins

• Ticker

• Vizual Data Tools

Tip: The default path for the Geometry plugins is: <Viz Install Directory>\plugin
\<plugin name.vip>

11.1 Default
The following Geometry plugins are housed in the Default folder:

• 2D Line

• 2D Patch

• 2D Ribbon

• Alpha Map

• Arrow

• Circle

• Cloth

• Cog Wheel

• Cone

• Connector

• Cube

• Cylinder
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• Cylinder3

• Dexter

• DisplacementMap

• Eclipse

• Fade Rectangle

• Filecard

• Graph

• Graph2D

• Icosahedron

• Image FX

• Noggi

• Pointer

• Polygon

• Rectangle

• Ring

• Roll

• Soft Clip Draw Pixels

• Sphere

• Spline Path

• Spline Strip

• Spring

• Torus

• Trio Scroll

• Wall

• Wave

11.1.1 2D Line

 The 2D Line plugin draws a simple 2D line through given 2D coordinates,
respectively point values.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• 2D Line Properties

• To create 2D lines

2D Line Properties



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 515

• use LOD: Enables level of detail. Range: On - Off. Default: ON

• Enable Outline: Enables drawing of an outline. Range: On - Off. Default: ON

• Width: Width of the drawn line. Range: 0.0 - 500.0. Default: 5.0

• Point values: List of x,y pairs separated by ‘:’ character. x and y values are
separated by blanks. Example: 0 0: 100 100: 200 70: 300 240: 400 280: 500 240:
600 400.

• New Line: Needs to be pressed before entering values to (i.e. Point values), or else
the line will not be rendered visible.

• Clear All: Deletes all line-segments.

To create 2D lines

1. Enter the Point Values. For example: 0 0 : 200 45 entered in the Point Values
field will create a line that starts at the point X1(0), Y1(0) and ends at point
X2(200), Y2(45).

2. Click the New Line button to create the line.

11.1.2 2D Patch

 The 2D Patch is a two dimensional planar curved grid of polygons. The grid is
defined by control points that are located on the perimeter of the grid. The parameters
of each one of the control points is the location X and Y, and the assigned texture
coordinates U and V. The calculation of the internal grid points is done with a mix of a
one-dimensional cubic spline and a two dimensional bilinear interpolation.

It is possible to specify the interpolation direction to be just in one direction, or in both.
Depending on the shape that should be created, it is important to choose the right
direction (for example it is not too difficult to create an annulus with this plugin, after
choosing the right interpolation direction along the radius).

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• 2D Patch Properties

• Workflow

• Tips

• Known Limitations
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2D Patch Properties

• use LOD: Enables/disables dynamic level of detail.

• X and Y Number of Intervals: Sets the number of intervals between the control
points in the X and Y direction respectively. Parameter name: NX/NY.

• Interpolation Direction: Defines the direction of interpolation from the control points
on the perimeter to the internal grid points. Parameter name: interDirect.

• X Size, Y Size, Reset XY (button) and Reset UV (button): Gives initial values
for the control points. The values of X and Y-Size will take affect just after hitting
the Reset XY button. The Reset UV button is setting default values to the texture
coordinates. Parameter name: SX/SY, resetXY/resetUV.

• X Resolution and Y Resolution: Defines the number of subdivisions to polygons
between the control points in the X- and Y-direction respectively.Parameter name:
MX/MY.

• Interactive mode: A toggle to enable or disable the interactive mode of direction
manipulation with the mouse. Parameter name: interactive.

• Editing Range %: Sets the amount of “effect” the movement of one point (move
with <Shift> pressed) should have on the neighboring points. Parameter name:
EditingRange.

• Editing Mode: When moving a point, it is possible, by pressing <Shift>, to move
the other points simultaneously. How the points move depends on the editing mode
that is chosen. Parameter name: EditingMode.

• Constant (button): The other points will move their positions exactly equal to the
one you move.

• Linear (button): The other points move in a linear way, based on the distance
from the point that is being moved.

• Exponential (button): The other points move in an exponential way, based on the
distance from the point it is being moved.

• Draw Control Points: A toggle to draw or not to draw the control points. Enables
the Control Point Size parameter. Parameter name: drawControlPoints.

• Control Point Size: Sets the control point size.
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• Show Control Points Values: Enables the manipulation of the control points in
the rendering window. Parameter name: controlPointSize.

• New edit mode: When enabled, and you press down the Ctrl-key, you can see the
control points and also you have the opportunity to move the control points. The
“Interactive mode” and the handle “script/plugins event mode” must be enabled.

• X, Y, U and V: Sets position and texture coordinates for each of the control points.
These values will typically be changed in the rendering window only with the mouse.

Note: There are 12 control points that each have their own X,Y,U and V
parameters.

Workflow

1. Set the right number of control points, according to your estimation of how
complex the patch is you are going to create. This number can be changed at any
time. The plugin will redistribute the new points along the already defined patch.

2. Estimate the final length and width of the patch.

3. Move the patch to the right place in your scene. If it is going to be on some
horizontal plane, it might be easier first to edit it in the default orientation, and
afterwards rotate it to the right place. There is no problem to continue working on
it after the rotation has been made, but because of the perspective, it might be
less straightforward.

4. Turn on the Draw Control Points toggle and the Interactive toggle. While working
with the cursor, you do not have to be very close to the control point that you
would like to manipulate. The plugin will find by itself the nearest control point
to where is your cursor is. The selected control point will get yellow color, as
compared to all the rest that are white, to indicate that it has been selected for
editing.

5. Note that you will be able to do the direct manipulation just if the object is the
selected object in the Viz Artist container tree. Remember also, that regardless of
the position of your cursor, if the patch is the selected object, and the interactive
toggle is on, always one control point will become selected and will be changed
while working with the cursor. Hitting the space key on the keyboard deselects
the object currently selected, and then the cursor gets back its usual functionality
until the patch object is selected again.

6. With the left button, according to the selection roles above, you can change the X
and Y location of each of the control points.

7. Once the shape of the patch is more or less defined, it is a advisable to set the
resolution parameter. Performance wise you should set it as low as possible, but it
should be high enough to guarantee a smooth enough look.

8. Choose an image and drag it on the patch in the usual way. After doing it open
the image texture editor and set the Mapping property to Vertex, and the Wrap
property to Clamp.

9. The next step is to map more accurately the image on the patch. Set first the
Texture Length according to your estimation, then choose the Texture Direction,
and then play with the Texture Head Location to see the texture flowing along the
patch. This is a good point to review again all the parameters you set before.

10. The last step is to define an animation if necessary. Typically with the patch
the animation will be just on the Texture Head Location. To learn more about
animation see Creating Animations .
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Caution: While defining an animation on the parameters of a 2D Patch, you must
make sure that the right window is open in Viz Artist. Without it, the changes that
you are doing with the cursor will not take effect with regard to the animation.

Tips

1. It is sometimes useful to work with 2D Patch while in wireframe mode. If you have
a texture with alpha, to see it correctly, you need to turn the image off with the
small enable/disable button near the image icon.

2. Remember that if the 2D Patch is not selected, the interactive mode is not active.
As result of this, the first click with the mouse on unselected object will be always
with the normal Viz Artist functionality of the cursor, of moving, rotating and so on
the object.

3. If you are done with the interactive session of defining a 2D Patch, turn the
Interactive toggle off.

4. While working on a 2D Patch in the interactive mode, it is not possible to select
another object with the cursor in the Viz Artist Scene Editor. The way to select
another object is first to hit SPACE, and thereafter select the other object.

5. Doing animation on the 2D Patch is quite expensive performance wise. Be aware
to it, and try to use as much as possible a small number of control points and
polygons.

6. For the texture used for the 2D Patch, make sure that along the flow direction, you
have on both texture edges a clean line with alpha equal to 0. Other wise you will
get a wake of the image edges in front or behind it.

7. Do not change the number of control point along an animation. It is possible, if
necessary, to change the resolution number.

8. While defining an animation, make sure to remove from it, if necessary, the toggle
values of Show Control Points, Interactive Mode and so on.

Known Limitations

1. Note that when you use 2D Patch in a scene, by choosing an object in the Viz
Artist rendering window, the Viz Artist user interface is not updated automatically.

2. While copying a 2D Patch, to make it work in the interactive mode, it is necessary
to save the scene first.

3. If the texture coordinates on the control points are getting outside the [0,1] range
artifacts may appear. Be aware to keep it within the [0,1] range.

11.1.3 2D Ribbon

 The 2D Ribbon is a curved strip. It is ideal for making customized curves to
symbolize frontiers on a map or similar. The way the object is curved is easily edited
in the property editor. It is possible to enable interactivity so you can drag the
counterpoints of the ribbon by using the cursor.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• 2D Ribbon Properties

• Workflow
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• Tips

• Known Limitations

2D Ribbon Properties

• Use LOD: Enables/disables dynamic level of detail.

• Working Mode: Available modes are Ribbon, Filled Area and Double Outline.
Default is the Ribbon mode.

• Number of control points: Sets the number of control points along the ribbon.

• Texture Direction: Defines which direction the texture is to be mapped along the
2D Ribbon.

• Closed Curve: Creates a closed a curve like a circle. The forward end touches the
backward end.

• Constant Width: With this option enabled, the width of the ribbon is fixed. The
value that defines the width is then the width of the first control point.

• Texture Head Location: Defines the position on the ribbon where the edge of the
texture is mapped. The unit is percentage of the ribbon length.

• Texture Length: Defines the portion of the ribbon, in percentage, that the texture
will be mapped onto.

• Resolution: Defines the number of subdivisions to polygons between the control
points.

• Control Point Size: Sets the size of the control points, in the Viz Artist normal
units.

• Reset Options: These properties are useful for giving initial values for the control
points. The values of Ribbon Length and Ribbon Width will take affect after the
Reset button has been pressed.
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• Reset: Reset all created curves but does not delete the existing control points.

• Interactive Mode: A toggle to enable or disable the interactive mode of direction
manipulation with the cursor.

• Editing Range %: Sets the amount of “effect” the movement of one point (move
with <Shift>) should have on the neighboring points.

• Editing Mode: When moving a point, it is possible, by pressing <Shift>, to move
the other points simultaneously. How the points move depends on the editing mode
that is chosen.

• Constant (button): The other points will move their positions exactly equal to the
one you move.

• Linear (button): The other points move in a linear way, based on the distance
from the point that is being moved.

• Exponential (button): The other points move in an exponential way, based on the
distance from the point it is being moved.

• Texture Options: If this toggle is switched on some texture settings are available.

• Texture Direction: Shows the texture in different directions. For example if you
have a pointer right-showing used as texture the pointer shows to the right side if
the “Horizontal” option is activated. Otherwise to the left side if the “-Horizontal”
option is set. Same for the “Vertical” and “-Vertical” option. The rendered pointer
shows to the top or to the bottom side.

• Texture Head Location: Moves the texture either to top or bottom direction.

• Texture Length: This options stretches the texture.

• Use Texture Factor: When enabled (On) it enables the texture factor parameter.

• Texture Factor %: Sets the texture factor.

• Show Spline: Switches the display of the ribbon in the Scene Editor on and off.

• Use Progressive Visualization: Is this toggle is switched to on the activated
parameters will affect the rendering.

• Progress Mode: You have two options “By Length” and by “Control Points”. Slices
the curve in x-direction by length or by the control point index.

• Path Position: It limits the workspace so you have fewer control points for
preparing.

• Render Bumps: The curves are top-barbed which is useful for weather
broadcasting.

• Avoid Internal Outline: This option is only available if the option “Working mode”
is set to “Ribbon” and the “Closed Curve” option is set to “on”. Also the “Expert”
plugin, located in “Container Plugins/Global” must be added to the same group
which is holding the “2DRibbon” plugin. Switch the “Draw mode” to “Outline” in the
“Expert” plugin for unlocking.

• Show Control Points Values: Enables the manipulation of the control points in
the rendering window. X, Y, and W values sets the X/Y position and the width of the
curve at the different control points. These values will typically be changed through
editing directly in the Viz Artist Scene Editor.

Workflow

1. Drag the 2D Ribbon from the Viz Artist built in geometries onto the scene tree.

2. Set the right number of control points, according to your estimation of how
complex the ribbon you are going to create will be. This number can be changed
at any time. The plugin will redistribute the new points along the already defined
ribbon.



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 521

3. Estimate the final length and width of the ribbon, enter it to the right fields and hit
the Reset button. You will get a straight ribbon with the right sizes.

4. Set correctly the toggle of the Constant Width according to your requirements.

5. Move the ribbon to the right place in your scene. If it is going to be on some
horizontal plane, it might be easier first to edit it in the default orientation, and
afterwards rotate it to the right place. There is no problem to continue working on
it after the rotation has been made, but because of the perspective, it might be
less straightforward.

6. Turn on the Draw Control Points toggle and the Interactive toggle. While working
with the mouse, you do not have to be very close to the control point that you
would like to manipulate. The plugin will find by itself the nearest control point
to where is your cursor is. The selected control point will get yellow color, as
compared to all the rest that are white, to indicate that it has been selected for
editing.

7. Note that you will be able to do the direct manipulation just if the 2D Ribbon is the
selected object in the Viz Artist container tree. Remember also, that regardless of
the position of your cursor, if the ribbon is the selected object, and the interactive
toggle is on, always one control point will become selected and will be changed
while working with the cursor. Hitting SPACE deselects the object currently
selected, and then the cursor gets back its usual functionality until the ribbon is
selected again.

8. With the left button, according to the selection roles above, you can change the X
and Y location of each of the control points. With the right button you can change
the width of the ribbon. According to the Constant Width toggle the change will be
just on the control point, or all over the ribbon. All three values are interpolated
with cubic spline, and accordingly the affect of moving a control point is global,
but with decreasing affect with the distance from it along the ribbon.

9. Once the shape of the ribbon is more or less defined, it is a advisable to set the
resolution parameter. Performance wise you should set it as low as possible, but
it should be high enough to guarantee a smooth enough look in the corners of the
spline, and also a smooth enough mapping of the image/texture on the ribbon.

10. Choose an image and drag it on the ribbon object in the usual way. After doing
it open the texture editor and set the Mapping property to Vertex, and the Wrap
property to Clamp.

11. The next step is to map the image more accurately on the ribbon. Set first the
Texture Length according to your estimation, then choose the Texture Direction,
and then play with the Texture Head Location to see the texture flowing along the
ribbon. This is a good point to review again all the parameters you set before.

12. The last step is to define an animation if necessary. Typically with the ribbon the
animation will be just on the Texture Head Location.

Caution: While defining an animation on the parameters of a 2D Ribbon,
you must make sure that the right window is open in Viz Artist. Without it the
changes that you are doing with the cursor will not take effect with regard to the
animation.

Tips

1. It is sometimes useful to work with 2D Ribbon while in wireframe mode. If you
have a texture with alpha, to see it correctly you need to turn the image off with
the small enable/disable button near the image icon.
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2. Remember that if the 2D Ribbon is not selected, the interactive mode is not
active. As result of this, the first click on unselected object will be always with the
normal Viz Artist functionality of moving, rotating and so on the object.

3. If you are done with the interactive session of defining a 2D Ribbon, turn the
Interactive toggle off.

4. While working on a 2D Ribbon in the interactive mode, it is not possible to select
another object with the cursor in the Viz Artist Scene Editor. The way to select
another object is first to hit SPACE and thereafter select the other object.

5. Doing animation on the 2D Ribbon is quite expensive performance wise. Be aware
to it, and try to keep the number of control points and polygons as low as possible.

6. For the texture used for the 2D Ribbon, make sure that along the flow direction,
you have on both texture edges a clean line with alpha equal to 0. Other wise you
will get a wake of the image edges in front or behind it.

7. Do not change the number of control point along an animation. It is possible, if
necessary, to change the resolution number.

8. While defining an animation, make sure to remove from it, if necessary, the toggle
values of Show Control Points, Interactive Mode and so on.

Known Limitations

1. Note that when you have in the scene a 2D Ribbon, by choosing an object in the
Viz Artist Scene Editor, the Viz Artist user interface is not updated automatically.

2. While copying a 2D Ribbon, to make it work in the interactive mode, it is
necessary to save the scene first.

3. If the texture coordinates on the control point are getting outside the [0,1] range
artifacts may appear. Be aware to keep it within the [0,1] range.

See Also

• 2D Follow

• Creating Animations

11.1.4 Alpha Map

 This plugin enables you to create alpha maps by means of a grayscale image which
cannot use an alpha image as an alpha channel directly. The intensity value of the
grayscale image is translated to an opacity (alpha) value. An image can have another
image as alpha channel, but a video source cannot. So if you want a video source to
have an overlying alpha mask, you can use the alpha map.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Alpha Map Properties

• To add an alpha map
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Alpha Map Properties

• Detail: Sets the detail level of the map, the lower the value the higher the level of
detail.

• Image: Drag the image you want to use creating the map, onto the drop zone here.
The image must be a valid alpha image.

• X-size: Sets the size of the map along the X-axis.

• Y-size: Sets the size of the map along the Y-axis.

• Texture X Offset %: Sets the offset of the texture in the X-axis.

• Texture Y Offset %: Sets the offset of the texture in the Y-axis.

• Texture X Width %: Stretches or compresses the texture in the X-axis.

• Texture Y Width %: Stretches or compresses the texture in the Y-axis.

• Patch mode:

• Triangle Strip: Uses the same size of triangle polygon on the whole surface.

• Optimized Quads: Uses bigger triangle polygons where the surface of the
displacement map is flat, thereby reducing the total number of polygons and
improving performance.

• Inverse: Mirrors all coordinates.

• Texture Coordinates Repeat/Clamp: Sets if the texture is the be repeated or
clamped when it is to small to fit onto the alpha maps rectangle. Clamp stretches
the texture to make it fit, Repeat starts drawing the texture over again.

• Texel Precision: Use “Subtexel” for better texture image quality.

• Texel no subpixel/subtexel correction are made.

• With Subtexel there is a limited number of pixels available on the screen, if a
line does not run through a real pixel, it must be moved to the nearest one, this
introduces a positional error. If subtexel is selected Viz Artist will break up pixels into
smaller sub pixels in memory so that the line can be drawn to the nearest sub pixel.

• Smooth: Is used to create a smooth look of the map, without reducing the polygon
details of the map. In some cases you need the number of polygons you have to
obtain the correct lightning.
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• Texture Coordinates: Decides if texture coordinates are to be created, and to
which level, either none, full or partially. You need this enabled to some level if a
texture is applied using a vertex mapping. Texture mapping is resource consuming,
so if you do not need it keep it off.

• Color: Sets the color of the alpha map rectangle.

To add an alpha map

1. Drag and drop the Alpha Map plugin onto the tree.

2. Add the alpha image onto the alpha map editor’s Image placeholder and drag the
video source icon onto the alpha map’s container.

11.1.5 Arrow

 The Arrow built in geometry allows you to create and customize an arrow. The arrow
is a 2D object. By clicking on the arrow icon in a container, the arrow editor opens. The
default arrow has two heads. At the tip of each arrowhead the reference points are
placed. The left point is 1 and the right is 2.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Arrow Properties

• To create an arrow

Arrow Properties

• Use LOD: Enables/disables dynamic level of detail.

• Point 1 X: Allows you to alter point 1s X offset.

• Point 1 Y: Allows you to alter point 1s Y offset.

• Point 1 Z: Allows you to alter point 1s Z offset.

• Point 2 X: Allows you to alter point 2s X offset.

• Point 2 Y: Allows you to alter point 2s Y offset.

• Point 2 Z: Allows you to alter point 2s Z offset.

• Width: Sets the width of the arrow shaft.

• Style 1: Allows you to select if the arrows end at point 1 should have a head or not.
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• Style 2: Allows you to select if the arrows end at point 2 should have a head or not.

• Arrow Width: Sets the width of the arrow heads.

• Arrow Length: Sets the length of the arrow head.

• Percent: Scales the arrow in percent of the size defined by X-, Y- and Z-values.

• Mode: Defines if the arrow lies in an XY, XZ or YZ plane.

To create an arrow

1. Create a group and add the Arrow plugin to it.

2. Add a material and/or an image to the same container as the arrow plugin to add
color and/or texture to it.

11.1.6 Circle

 With this plugin you can create a circle with different corner levels.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Circle Properties

• To create a circle

Circle Properties

• Use LOD: Enables/disables dynamic level of detail.

• Corners: Allows you to decide the number of corner the circle is to be constructed
of. The circle is set together by tiled triangles and the higher the number of corners
is set, the more triangles are used to construct the circle. The higher the value is set
the more rendering performance will be used.

• Mode: Changes the space perspective. Possible values are “XY” (front - view),
“XZ” (bottom - view), “YZ” (left - view)

To create a circle

1. Create a group and add the Circle plugin to it.

2. Add a material and/or an image to the same container as the circle plugin to add
color and/or texture to it.
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3. Set the number of corners.

11.1.7 Cog Wheel

 Use this plugin to create a cog wheel. It has a range of with that has a range of Cog
Wheel Properties that can be set to adjust the look and feel of the cog wheel.

To avoid decreasing the system performance, set the tessellation to a lower value since
it does not make much difference in quality.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Cog Wheel Properties

• To create a cogwheel

Cog Wheel Properties

• Use LOD enables/disables dynamic level of detail.

• Tessellation sets the level of detail.

• Corners sets the number of corners the cogwheel is to be constructed of. The
cog wheel gets one tooth for each corner, so the number of teeth changes
correspondingly.

• Height sets the height or width of the cog wheel.

• Tooth height sets the height of the cog wheel teeth.

• Diameter sets the diameter of the cog wheel.

• Hole creates and sets the size of a hole in the cog wheel.

• Bevel sets the degree of bevel at the cog wheel.

• Inner Bevel enables or disables bevel in the cog wheel hole.

• Show Top enables or disables visualization of the top.

• Show Bottom enables or disables visualization of bottom.

• Center allows you to select where the geometrical centre should be placed on the
cog wheel, either Center, Bottom or Top.
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To create a cogwheel

1. Add the Cog Wheel plugin to a container.

2. Add a material to the same container.

3. Set Hole parameter to 50.0.

4. Set the transformation parameters for the container to:

• Set rotation X: 90.0, Y:45.0 and Z: -45.0.

11.1.8 Cone

 This plugin creates a cone geometry.

Set the tesselation to a reasonable value since it does not make a great difference in
quality.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Cone Properties

• To create a cone

Cone Properties

• Use LOD: Enables/disables dynamic level of detail.

• Tessellation: Sets the degree of detail. Parameter name: Tesselation.

• Height: Sets the height of the cone. Parameter name: height.

• Diameter: Sets the diameter of the cone. Parameter name: diameter.

• Corners: Allows you to decide the number of corners the cone is to be constructed
of. Parameter name: corners.

• Show Bottom: Enables or disables visualization of the cone bottom. Parameter
name: show_bottom.

• Center: Allows you to select where the geometrical center should be placed on the
cone, either Center, Bottom or Top. Parameter name: center.
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• Smooth: Enables a smoothing of the cone edges. Parameter name: smooth.

• Rounded Tip: Enables the user to adjust the roundness of the cone’s tip.
Parameter name: roundedTip.

• Rounded Tip Height: Sets the parameter for the roundness of the tip. The angle of
the cone’s side does not change, the rounded tip is created by “taking away” from
the pointed tip. Therefore the cone will not have the full height.

To create a cone

1. Add the Cone plugin to a container.

2. Add a material to the same container.

11.1.9 Connector

 This plugin is useful to connect two objects with a line in a desired color and width.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Connector Properties

• To connect two objects

Connector Properties

• Use LOD: Enables/disables dynamic level of detail.

• Container 1 and 2: Placeholder for container 1 and 2. Drag the container onto the
drop zone. Click R to remove the container.

• Connection Point 1 and 2 By X, Y and Z Axis: is the X, Y and Z-value of
container 1 and 2 where the line should start. Can be set to Min, Center, Max,
CenterBB or Origin.
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• Line Width: Sets the width of the connecting line.

• Drawing Mode: Available options are Line and Mesh.

• Line Color: Defines the color of the line.

To connect two objects

1. Create a new group and add the Connector plugin to it

2. Create two new group containers and add a geometry object (e.g. Cylinder and
Cone) to each group

3. Open each container’s transformation editor and move the objects a part

4. Add a material and/or an image to the geometry objects

5. Open the connector plugin editor and drag and drop the two containers to the
Container 1 and Container 2 placeholders, respectively

6. Adjust the color line

7. Open the Connector plugin editor and play with the settings

8. Add more objects to Container 2 and animate it

See Also

• Scene Editor Scene Editor Buttons

• BoundingBox plugin

11.1.10 Cube

 Use this plugin to create cubes with particular widths, heights, depths and other
attributes.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Cube Properties

• To create a cube
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Cube Properties

• Use LOD: Enables/disables dynamic level of detail.

• Size X: Sets the size of the cube in the X-axis. Parameter name: size_X.

• Size Y: Sets the size of the cube in the Y-axis. Parameter name: size_Y.

• Size Z: Sets the size of the cube in the Z-axis. Parameter name: size_Z.

• Center Y: Sets the position of the cube center along the Y-axis. You can choose
between Center, Bottom or Top. Parameter name: center_Y.

• Tessellation: Sets the degree of detail. Parameter name: tesselation.

• Adaptive Tesselation: Adjusts tesselation on each axis separately, depending on
the extension of the cube on that axis. The reference value is an extension of 100.
For a face of size 200 the tesselation-parameter will be doubled, for a face of size 50
the tesselation is halved. The automatically adapted tesselation still never exceeds
its maximum value of 100. Parameter name: adaptiveTesselation.

• Bevel: Adds a bevel of the given size to corners and edges of the cube. The size of
the bevel reduces the size of the cube’s axis-aligned faces which: in case Adaptive
Tesselation is enabled: will cause them to become less tesselated accordingly.
Tesselation of the bevel itself is affected by Adaptive Tesselation too. Parameter
name: bevel.

• Rounded Bevel: If enabled the beveled edges and corners will appear rounded.
How much the round bevel is tesselated will be affected by adaptive tesselation.
Parameter name: roundedBevel.

• Show Top, Bottom, Front, Back, Left, Right: Shows or hides the cube's face and
adjacent corners and edges. Parameter names: Top, Bottom, Front, Back, Left and
Right.

• Show Size 0: Enables/disables display of the cube at axis value zero (0). If one
of the axis values are set to 0 the cube will remain visible if the setting is enabled
(On). Disabling (Off) it will make the cube become invisible as long as one of the
axis values are 0. A situation where this parameter is useful is when creating bar
chart animations. In such animations it would then be possible to hide the bar at
value 0 by disabling this setting.
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To create a cube

1. Create a new group container and add the Cube plugin to it.

2. Add a material and/or an image to the same container.

3. Open the cube editor and set Rotation Y and Z values to 45.0.

11.1.11 Cylinder

 Use this plugin to create cylinders with different heights, widths and depths and
other attributes.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Cylinder Properties

• To create a cylinder

Cylinder Properties

• Use LOD: Enables/disables dynamic level of detail.

• Height: Sets the height of the cylinder.

• Diameter: Sets the diameter of the cylinder

• Rotation: Sets the rotation around X-axis.

• Angle: Sets the opening angle from 0-360°. As the value decreases below 360° an
increasing angle will open in the cylinder.

• Corners: Sets the number of corners the cylinder is to be made up from.

• Hole: Creates a hole in the cylinder, making it into a tube.

• Center: Sets the position for the center. You can choose between Center, Bottom or
Top.

• Bevel: Sets the size of bevel at the cylinder.
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• Inner Bevel: Enables/disables bevel in the cylinder hole if bevel is set at the bevel
parameter.

• Show Top: Turns off/on visualization of cylinder top.

• Show Bottom: Turns off/on visualization of cylinder bottom.

• Show size 0: Enables/disables display of the cylinder at height value 0. If you
set height to zero, the cylinder is visible by default. If you disable this option, the
cylinder becomes invisible. If you make a pie chart visualization you will have use
for this option.

To create a cylinder

1. Create a new group container and add the Cylinder or Cylinder3 plugin to it.

2. Open the Cylinder editor and set Hole to 50.0.

3. Add a material and/or an image to the same container.

4. Open the cylinder editor and set Rotation Y to 75.0 and Z to 90.0.

11.1.12 Cylinder3

 Use this plugin to create cylinders. In relation to the ordinary Cylinder plugin you
have more options and settings available with the Cylinder 3 plugin.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Cylinder 3 Properties

• To create a cylinder

Cylinder 3 Properties
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• Use LOD: Enables/disables dynamic level of detail.

• Height: Sets the height of the cylinder.

• Diameter: Sets the diameter of the cylinder

• Rotation: Sets the rotation around X-axis.

• Angle: Sets the opening angle from 0-360°. As the value decreases below 360° an
increasing angle will open in the cylinder.

• Opening Mode: Describes in which direction the cylinder will be opened if you
change the “Angel” parameter.

• Corners: Sets the number of corners the cylinder is to be made up from.

• Hole: Creates a hole in the cylinder, making it into a tube.

• Center: Sets the position for the center. You can choose between Center, Bottom or
Top.

• Bevel: Sets the size of bevel at the cylinder.

• Inner Bevel: Enables/disables bevel in the cylinder hole if bevel is set at the bevel
parameter.

• Show Top: Turns off/on visualization of cylinder top.

• Show Bottom: Turns off/on visualization of cylinder bottom.

• Show size 0: Enables/disables display of the cylinder at height value 0. If you
set height to zero, the cylinder is visible by default. If you disable this option, the
cylinder becomes invisible. If you make a pie chart visualization you will have use
for this option.

• Show inner bevel: If this toggle is off, the inner bevel, respectively the inner
cylinder is not rendered.

• Show outer bevel: If this toggle is off, the outer bevel, respectively the outer
cylinder is not rendered.

• Show caps: This setting only affects the geometry object if the angle is lesser than
360°.

• Static texture: If you change the texture mapping of the texture to “Vertex”:
mode this option will bend or not bend the texture around the object.

• Texture anchor: It changes the texture orientation in x-direction to left or right.
You can see the result if the angle is lesser than 360°.

11.1.13 Dexter

 Dexter is a macro-based text-ticker tool that generates static horizontal text
crawl and vertical text rolls. The Dexter editor is organized in five sections, Control,
Design, Text, Trigger and Stopper. When adding the plugin, two sub-containers are also
added; Animation (visible) and Templates (hidden). In addition it has a set of scripting
possibilities.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Control

• Design

• Text

• Trigger
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• Stopper

• Control Buttons

• Parameters

• Script Programming - Parameters

• Script Programming - Tokens

• Script Programming - Syntax

• Script Programming - Templates

• Script Programming - Newline Logic

• Script Programming - Triggers

Control

The control section allows you to start, stop, continue and reset the scroll/roll. In
addition it contains buttons that allows you to select the velocity mode and speed of
the ticker.

• Start starts the animation.

• Stop stops the animation.

• Reset resets the animation.

• Cont continues the animation.

• Loop loops the scroller/crawl.

The velocity control allows you to define how the speed of the crawl/roll is to be
calculated.

• Duration (all groups same) makes all group use the same amount of time to
crawl/scroll from start to end. The duration will be measured at the group containing
the longest text string.

• Duration (for each group) makes all groups use exactly the same time. As a
consequence, longer text strings will scroll faster then shorter ones.

• Speed makes all groups scroll at the same speed, as a consequence long message
will take longer time to scroll than shorter messages. The speed unit is pixels per
frame divided by 10.
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Design

In the design section of the dexter editor you can set a range of parameters to how the
text will appear.

• Screen width: Sets the width of the screen used for placing the text objects and
culling. Possible values range from 20 to 4000.

• Screen height: Sets the height of the screen used for placing the text objects and
culling.

• Loop kerning: Defines the spacing between two loops. Possible values range from
0 to 1000.

• Group kerning: Sets the vertical distance between group elements.

• Crawl mode: Creates a normal horizontal scrolling text.

• Roll mode: Creates a vertical scroll.

• Default Font: Shows the default font. To load a font, drag a it from the server view
and onto the font drop zone. This must be set to get any text unless you specify a
font in the macro and all text are executed with macros.

• Autosplit text: If you have a long text string written in one line, without the
autosplit feature, this is built as a big text object. This is not good for culling and
performance. If you activate autosplit, long text objects will be split up into smaller
ones which is better for performance.

• Corr. val.: Every time the autosplit feature splits a text object, the correction value
is added to the gap between the two new objects. Although it reads the length
of a space character from the font to make a proper placing of the objects there
is a slight difference in length between a split and a non-split text. Therefore the
correction value is inserted to correct text that does not look good because of
incorrect placing when the objects are split.

• Min. object length: Sets the minimum object length for an autosplit object.

• Col1: Allows you to set the default color 1. To set it, either drag a material from the
server view onto the col1 icon, or use the color editor below.

• Col2: Allows you to set the default color 2. To set it, either drag a material from the
server view onto the col1 icon, or use the color editor below.

• Col3: Allows you to set the default color 3. To set it, either drag a material from the
server view onto the col1 icon, or use the color editor below.
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Text

The text editor contains the text area where you enter the script commands. In addition
it contains a list of all tokens and parameters. By clicking on a token or parameter, you
automatically insert it into the script text at cursor position.

• Space=Text: Forces the parser to interpret spaces at the beginning of a line/after a
token has ended as legal text (in its default state those spaces are abandoned).

• Load File: Allows you to browse for a script file. The default extension for the file
is .edx. The script file must contain macro script with standard syntax. When the file
loads, the contents is written onto the text field.

Trigger

• Act.: If this toggle is on, the marker will be evaluated.

• Mark: The name of the marker for orientation.

• Position: Here you can set the marker position where an event should occur.

• Command: You can type in here desired viz commandos.

The concept of marks and triggers allows you to send commands to Viz when the
animation reaches a certain position. To make it work you need to define two elements:

First of all you need to mark the trigger positions in the text crawl/roll. This is done
using the token <MARK>.

Animation starts<MARK A>here.

You have six marks, named A, B, C, D, E and F, that you can put wherever you want in
the text. If you enable Info you will see a representation of the mark on-screen.
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In addition to the six user-definable marks, there are two marks that are created
automatically, named BEGIN and END. They are located at the beginning and end
of the crawl/roll. Please keep in mind that the END mark is located before all the
containers created for the loop feature and that marks are not looped.

After setting marks and building the crawl/roll, you must specify trigger actions. All
eight marks are listed in the trigger section of the editor. The on/off switch left to the
mark name is used to set that mark active/inactive. The position value right to the
mark name sets the position where the triggering should occur (value 0 is at the end of
the dexters bounding box. When animation is running and the mark in the text reaches
this position, the specified command is triggered. If you switch on Info you will see
a line representing the trigger position. Simply switch it on and watch the marks and
lines interacting to see how this works. Right to the trigger position you will find a text
field where you can enter the command which should be sent to Viz Artist when a mark
triggers. You may use every command available via external control, for example you
may change values in Viz Artist, start animations, execute plugins, and so on.

First you may issue two or more commands when a mark reaches its trigger position.
Simply split them using a ; character (semi-colon). Also you may use the DEXTER
location to send pseudo-commands to Dexter.

Currently two such pseudo-commands are implemented: The first one is DEXTER*STOP,
which stops Dexter’s animation, the second one is DEXTER*PAUSE X, where Dexter
will stop the animation for X seconds (of course this is a floating point value, so
DEXTER*PAUSE 0.5 is also possible) and continue with the same speed as before.
Please note that these two pseudo-commands are not supported by Viz Artist
command interface, they are only available using Dexter’s trigger feature. Dexter
supports the THIS_SCENE pseudo location as well; you may want to use this to refer to
objects/animations in the local scene.

Stopper

• Enable: If this toggle is on, the markers will be evaluated.

• Use Mark: If this toggle is switched to “on” the given positions will be used.

• Position: Sets the position of the “Ease-Out” and “Ease-In” range.

• Ease Out: The text object is leaving this position during the movement.

• Continue: This parameter has two options. “Wait for Cont” and “Wait Nr Fields”.
In first case the text object waits until an “continue” viz commando is being sent. In
second case the text object waits for the number of fields. Consider that two fields
comply one frame.

• Ease In: The text object slows down and waits for a continue signal or until the
number of fields are reached.
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• Global: Stops global or local to a certain group.

• Info: It shows the delimited borders defined by the mark settings.

• Update: Applies the changes on the already existing containers.

• Build: Rebuilds all objects.

• Clear: Clears the text objects.

The Stopper is an extension to the triggering ability of Dexter. It allows you to create
ease in/out animations at defined points along the crawl/roll.First you need to create a
set of marks using the <MARK> token to define the stop points in your text. Then open
the Stopper page in the Dexter editor and check the Enable button.

Select which marks to use. If you have defined your stop points using the <MARK C>
token you need to select C here. If you enable Info you will see a representation of
the animation curve in the editor. Using the position, ease in and ease out slider you
can move and alter that animation like you need. (Please keep in mind that the ease
out part of the animation is executed before the ease in part: although usually it is the
other way round. But here we do not want to start an animation smoothly and then
stop it, we want to stop it first and then restart it again).

Using the continue switch you can select what Dexter should do after the animation
has stopped: Either wait a certain number of fields or wait until the Continue button in
the Control section is pressed. If you have more than one group in crawl mode you may
want to check the Global as well. If it is checked, all groups will be halted as soon as a
marker in any group reaches the stopper position. If it is unchecked only the group that
contains this marker is stopped.

Control Buttons

These buttons are found top right of the dexter editor and are not active in control
mode.

• Update: Applies the changes on the already existing containers.

• Build: Rebuilds all objects.

• Clear: Clears the text objects.

Parameters

Parameters

Name Type Function

text string This is the script dexter uses for building the text.

screenw float Screen width (used for placing the text objects and
culling) 20/4000.

screenh float Screen height (used for placing the text objects and
culling) 20/4000.

time float Animation length (in seconds) or animation speed
1/500.

file string File name (default extension .*).

loopmode bool Loop on or off.
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Name Type Function

loopkern float Defines the spacing between two loops (global)
0/1000.

groupkern float Defines the spacing between two groups (global)
0/1000.

showarea bool View the culling area on or off.

doautosplit bool If on, it splits text objects into pieces.

autosplitcorr float Correction value for autosplit feature -1e6/+1e6.

autosplitmin int Minimum number of characters for split text objects
0/100000.

timeline float Value for preview control (works if animation is
stopped) 0/1000.

deffont string Default font (e.g. Peak/AvantGarde/AvantGarde-
Book).

col1 unsigned long Default color value.

col2 unsigned long Color value #2.

col3 unsigned long Color value #3.

durmode int Selects animation mode (duration/speed) 0/2.

roll bool Switches between vertical (0) and horizontal (1)
animation.

trigonbegin bool Turns on/off trigger BEGIN (see 2.6).

trigona bool Turns on/off trigger A.

trigonb bool Turns on/off trigger B.

trigonc bool Turns on/off trigger C.

trigond bool Turns on/off trigger D.

trigone bool Turns on/off trigger E.

trigonf bool Turns on/off trigger F.

trigonend bool Turns on/off trigger END.

trigposbegin float Position of trigger BEGIN -100000/100000.

trigposa float Position of trigger A -100000/100000.

trigposb float Position of trigger B -100000/100000.

trigposc float Position of trigger C -100000/100000.
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Name Type Function

trigposd float Position of trigger D -100000/100000.

trigpose float Position of trigger E -100000/100000.

trigposf float Position of trigger F -100000/100000.

trigposend float Position of trigger END -100000/100000.

trigcombegin string Command for trigger BEGIN.

trigcoma string Command for trigger A.

trigcomb string Command for trigger B.

trigcomc string Command for trigger C.

trigcomd string Command for trigger D.

trigcome string Command for trigger E.

trigcomf string Command for trigger F.

trigcomend string Command for trigger END.

status bool While animation is running, this parameter is set to
1 (read-only).

Boolean values can either be 1 (on) or 0 (off). Color values are 4 byte unsigned
integers, byte 0 = red, 1 = green, 2 = blue, 3 = alpha.

Script Programming - Parameters

Parameters

Name Default
value

Function

AnchorX, AnchorY,
AnchorZ

0 X, Y and Z position of a new text object.

AnimDirection Default Animation direction, set to anything but “Default” to
reverse animation

AutoSplitCorr 0 Correction value for autosplit feature

AutoSplitMin 20 Minimum number of characters for split text objects

Col1, Col2, Col3 255/255/255/255Holds the color value from the gui/external control
(parameter Col1)

Command - Sends a command to Viz.

Detail Auto Sets detail/fontstyle of text objects (see above).

DoAutoSplit 0 Enables/disables autosplit feature.
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Name Default
value

Function

Enlighted 0 Set to 1 if you want enlighted text.

FontStyle - Sets the font used to create text objects (e.g. vizrt/
AvantGarde/AvantGarde-Book).

GroupKerning - Sets horizontal spacing between groups (like Jump).

Jump 0 Sets horizontal spacing between groups.

LastContainer - Holds the container number of the last created
container.

LastX, LastY 0 If a new text object is created, the last X and
Yposition will be stored here.

MarkOffsX,
MarkOffsY

0 X and Y offset for marks (see Script Programming -
Tokens).

Material 255/255/255/255The material used for creating text objects.

ObjectKerning 5 Sets spacing between two text objects.

RollAlign C Align groups in roll mode. values are R/r (right), L/l
(left) and C/c (center).

RollBorder 0 Sets left/right border for groups (if aligned left or
right in roll mode).

Scaling 20 Sets scaling in percent (20 means a scaling of 0.2).

ShadowDirection 320 Direction of shadow.

ShadowDistance 10 Distance of shadow

ShadowMaterial 204/204/204/204Material of shadow.

ShadowZOffset -1 Z offset of shadow.

SoftShadowLevel 1 Level of soft shadow (1-4).

Step 15 Sets the amount AnchorX is increased on a newline
(see newline logic).

Template - Sets template to be used for creating text objects
(see Script Programming - Templates).

TextKerning 0 Adjusts text kerning (in text object).

UseShadow 0 Set to 1 to enable shadow.

UseSoftShadow 0 Set to 1 to enable soft shadow.

WordSpacing 0 Adjusts word spacing (in text object).



Viz Artist User’s Guide

Page 542 Copyright © 2014 Vizrt

Name Default
value

Function

XScaling, YScaling,
ZScaling

20 Scaling value for X, Y and Z axes.

Color values are described in the form r/g/b/a with decimal numbers (base 10).
Col1 is also used as the default color value (Material is initialized with this value).
Material can also hold an existing material in the viz material pool, e.g. “Vizrt/Artdeco/
artdeco.0” (see Col1, Col2, Col3).

Detail can have one of the following values: 1, 2, 3, 4, 5, 6 or T. 1 through 6 are
detail levels, T means texture font. Every other value (like the default “Auto” will be
interpreted as detail level auto) (see Detail).

Script Programming - Tokens

Tokens

Name Syntax Function

ADD <ADD Parameter Value> Adds Value to Parameter (see example
below).

CLEAR <CLEAR Parameter> Clears Parameter (sets it to "").

CONTAINER <CONTAINER Path> Inserts a container into the text (see
example below).

ENDMAC <ENDMAC> Ends macro definition (nested macros are
not allowed).

EXEC <EXEC Name> Executes the macro Name.

GROUP <GROUP> Begins a new group of containers.

IMAGE <IMAGE name> Inserts an image in the text.

MACRO <MACRO Name> Defines the macro Name.

MARK <MARK Type> Sets a mark (see Script Programming -
Triggers).

MAX <MAX Parameter Value> If Value is higher than Parameter then
Parameter = Value.

MIN <MIN Parameter Value> Works like MAX but takes the smaller
value.

NEWLINE <NEWLINE> See Script Programming - Newline Logic.

NOTEXT <NOTEXT> See Script Programming - Newline Logic.

SET <SET Parameter Value> Sets Parameter to Value.
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The ADD token adds either a string or a float to one. If either Parameter or Value
are strings, the two strings can be combined to one. If both are floats, an arithmetic
addition will be done.

For example:

<SET Test Vi><ADD Test zrt>

results in “Vizrt”, but:

<SET Test 5><ADD Test 6.3>

results in Test holding the value 11.3.

The CONTAINER token is used to define a container path for inserting a container into
the text. A container path may either look like “1/3/2/3/1” (the same system as used in
the GUI), “$Containername” or “#Containernumber”.

<CONTAINER 1/3/2/4>
<CONTAINER $$Sphere> (or: <CONTAINER “$Sphere”>)
<CONTAINER #307>

The MARK token sets a mark that can be A, B, C, D, E or F.

The GROUP token begins a new group of containers. Instead of writing <GROUP> you
may leave one line empty as this has the same effect. Use groups for making lines in
roll mode.

Script Programming - Syntax

The syntax consists of tokens and text. <tokens> are surrounded by <>, e.g.
<ENDMAC>. Spaces are used to separate tokens and arguments. Text is everything
that is not bracketed. Tokens can be everywhere in the text, e.g. Viz is <SET Material
234/34/58/114>great is valid. You do not need to write every token in a new line.
Nested tokens are not allowed. A macro cannot execute itself.

In addition to the tokens, there is the escape character $:

• $Parameter inserts the value of Parameter in the text

• $_ inserts a space character in the text (for use in tokens)

• $< inserts a < character

• $> inserts a > character

• $$ inserts a $ character

The $ character can be placed in tokens and in the text, e.g. $<Dexter$> says:

<SET Text Hello><ADD Text $_World>$Text

Inside tokens you may use " characters to insert text.

<SET Text “This is a text”>

All $ characters and spaces inside two " characters are ignored for parsing/executing.
Two " characters are interpreted as one:

 <SET Name ""Harry"">

Script Programming - Templates
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You can define templates for the creation of text objects. Under the Dexter container
you will find a container named “Templates”. Under this container you can create a
set of template containers. These can hold animations, plugins, key, alpha, etc. Give
every template container a unique name. To access it in the script, you need to set the
Template parameter to the name of the template you want to use:

<SET Template AlphaKey1>

After you set the Template parameter, Dexter will use this template container as basis
for every text object. To switch this behavior off set Template to its default value (which
is ""):

 <CLEAR Template>

Caution: Certain parameters (like material) are overwritten by Dexter after the
container has been created from the template.

Script Programming - Newline Logic

The token <NEWLINE> describes a new text object, which is separated from the
previous one. Every newline moves AnchorX (see AnchorX, AnchorY, AnchorZ) a bit
further, depending on the value of Step. This token will be inserted internally to prevent
you from typing <NEWLINE> over and over again.

The following text

One
Two

is converted to

One
<NEWLINE>
Two

No newlines:

• From the beginning of the script until the first occurrence of text

• After a line that does not contain text (if the line is empty a new group will be
created)

• After the tokens MACRO, ENDMAC and NOTEXT, and the last newline before those
tokens will be deleted

For example:

Lines Explanation

No new lines because no text occurred.

<SET Camera Bobby> No text, no new line.

Return of the Here is the first new line.

Killer Tomatoes II No new line because of token MACRO in the next line. From
here on there are no new lines until the end of the MACRO.
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Lines Explanation

<MACRO SetDir>

<SET Director Jimmy>

<ENDMAC>

<EXEC SetDir> No new line because there is no text in the line.

Director: New line.

$Director New line.

<SET FontStyle Arial> No new line because there is no text in the line.

Camera: New line.

$Camera

<NOTEXT> The <NOTEXT> token will not add new lines before the
next text element occurs.

x New line.

y New line.

<SET Material $Col2> No new line because there is no text in the line.

z New line.

1<NEWLINE>2 New line for 1 and 2.

The macro SetDir in the example above can be used as follows without creating a
newline:

Hello<EXEC SetDir>World

The same rules applies to automatically inserted GROUP tokens.

Script Programming - Triggers

The concept of marks and triggers allows you to send commands to Viz when the
animation reaches a certain position. Therefore you need to define two elements:

• First is setting a mark in the text. You have six different marks to place wherever
you think they are useful, together with the automatically created BEGIN and END
mark this gives you a total of eight marks.

• The second elements are the triggers, where you have as well eight different
triggers. While marks are set with a token in the text, triggers can be defined in
the trigger section of the dexter editor or using external control. You can define a
position and a command for every trigger. When the corresponding mark reaches
the trigger position, the command is issued to Viz.
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Note: Only marks and triggers of the same type work together! If for example
mark B reaches the position of trigger D, nothing will happen.

Marks are set using the MARK token, for example: Animation starts exactly<MARK
D>here!

User defined marks are numbered A through F and are color coded in the trigger editor
and as graphical symbols when show area is turned on. In addition to the user defined
marks there are the automatically created marks BEGIN and END, which are inserted
at the beginning and ending of the crawl/roll. The commands being issued do not have
to be numbered, this is optional. If you do not give them a number, -1 is added before
the command is sent to viz. you can as well define more than one command, separate
them by a ; character (semi-colon).

You may invoke two internal commands using the trigger function with the DEXTER*
location: stop and pause.

DEXTER*STOP
DEXTER*PAUSE X

Note: X is the time in seconds.

11.1.14 DisplacementMap

 This plugin enables you to create topographical (height) maps by means of a
grayscale image. The intensity value of the gray scale image is translated to a height
value.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Displacement Map Properties

• To create a displacement map
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Displacement Map Properties

• Detail: Sets the detail level of the map, the lower the value the higher the level of
detail.

• Image: Drag the image you want to use creating the map, onto the placeholder.
The image must be a valid luminance or alpha image.

• X-size: Sets the size of the map along the X-axis.

• Y-size: Sets the size of the map along the Y-axes.

• Height: Sets the height of the map.

• Texture X Offset %: Sets the offset of the texture in the X-axis.

• Texture Y Offset %: Sets the offset of the texture in the Y-axis.

• Texture X Width %: Stretches or compresses the texture in the X-axis.

• Texture Y Width %: Stretches or compresses the texture in the Y-axis.

• Patch Mode

• Triangle Strip: Uses the same size of triangle polygon on the whole surface.

• Optimized Quads: Uses bigger triangle polygons where the surface of the
displacement map is flat, thereby reducing the total number of polygons and
improving performance.

• Inverse: Mirrors all topographic coordinates through the zero level. This will make a
mountain top to a crater.

• Texture Coordinates: Repeat/Clamp sets if the texture is the be repeated or
clamped if it is too small to fit onto the displacement maps rectangle. Clamp
stretches the texture to make it fit, Repeat starts drawing the texture over again
when it reaches the end.

• Texel Precision

• Texel: No subpixel/subtexel correction is made.

• Subtexel: There is a limited number of pixels available on the screen, if a line does
not run through a real pixel, it must be moved to the nearest one, this introduces a
positional error. If subtexel is selected Viz Artist will break up pixels into smaller sub
pixels in memory so that the line can be drawn to the nearest sub pixel.
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• Smooth: Use this parameter to smooth the look of the map, without reducing the
polygon details of the map. In some cases you need the number of polygons you
have to obtain the correct lightning.

• Texture Coordinates: Decides if texture coordinates are to be created, and to
which level, either None, Full or Partially. You need this enabled to some level, if a
texture is applied using a vertex mapping. Texture mapping is resource consuming,
so if you do not need it, keep it off.

Note: Please be aware not to increase to number of polygons in detail not too
much, as this is a common mistake.

To create a displacement map

1. Create a new group and add the displacement plugin to it.

2. Add material to the group container.

3. Open the displacement plugin editor, and drag and drop a grey-scaled image onto
the image placeholder.

4. Open the group container’s transformation editor and adjust the Rotation values.

Note: An RGB or similar image does not work, and you will get an information in
the log field. The image must be a valid luminance or alpha image.

11.1.15 Eclipse

 This plugin enables you to create an eclipse shape.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Eclipse Properties

• To create an eclipse
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Eclipse Properties

• Use LOD: LOD stands for “Level of Detail”. In depending of the camera <-> object
distance a high or lower detailed object will be rendered with marginal quality
casualties if this toggle is switched on.

• Corners: It changes the number of triangles the object has. If you want a good
quality increase the value. A value of 40 is a reasonably value.

• Inner Radius 1 and 2: Changes the inner radius in X-Position (1) and the inner
radius in Y-Position (2).

• Outer Radius 1 and 2: Changes the outer radius in X-Position (1) and the outer
radius in Y-Position (2).

• Hole Offset X, Y and Z: Moves the inner hole to X, Y, Z-position. With this
parameter you can shape great objects like a volcano.

• Rotation: Rotates the eclipse. The result is visible if you change the angle less than
360°.

• Angle: Change this to create a view like a cake respectively a divided circle.

• Create Uniform Normals: It adapts the varying normals to the majority of normals
in same direction.

To create an eclipse

1. Create a new group and add the eclipse plugin to it.

2. Add material to the group container.

3. Open the eclipse plugin editor, and adjust the following values:

• Set Inner Radius 1 and 2 to 40.0

• Set Hole Offset X to 20.0

4. Open the group container’s transformation editor and adjust the Rotation values.
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11.1.16 Fade Rectangle

 The Fade Rectangle’s four sides can be set to fade in a way specified by the user.
Both the degree of fading an the area influenced by the fading can be customized.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Fade Rectangle Properties

• To create a faded rectangle

Fade Rectangle Properties

• Use LOD: Enables/disables dynamic level of detail.

• Tessellation: Sets the degree of detail.

• Width: Sets the width of the fade rectangle.

• Height: Sets the height of the fade rectangle.

• Lock Blend: Allows you to decide whether to adjust the blending looked for both
the X- and Y-axis or single (each axis separately).

• Blend Range: Allows you to set the blend range if looked mode is selected.

• Blend Range X and Y: Sets the blend range of the X and/or Y axis if single blend is
selected.

• Blend Factor: Sets the alpha ramp of the fade rectangle. To see the effect set the
alpha value to 0 and adjust the blend factor.

• Color: Displays the color of the rectangle. Set the color either in the editor below or
drag a material from the server view onto the color icon.

To create a faded rectangle

1. Create a new group and add the fade rectangle plugin onto it.

2. Add an image to this group.
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3. Open the fade rectangle editor and change the desired color through the color
parameter and adjust the width and the height.

11.1.17 Filecard

 Use this plugin to create filecards with different widths and heights and other
attributes.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Filecard Properties

• To create a filecard

Filecard Properties

• use LOD: Enables/disables dynamic level of detail.

• Width: Changes the width of the filecard.

• Height: Changes the height of the filecard.

• Tab Position X and Y: Changes the tab position in x-direction and y-direction.

• Tab Angle: Change this value to get a smaller curve.

• Bevel: Increase this value to get a soft edge.

• Tesselation: This value changes the number of triangles of the rendered filecard to
increase the visual quality. Please consider that the number of triangles will affect
the performance of the system.

To create a filecard

1. Create a new group and add the filecard plugin to it.

2. Add a material and/or a texture to the group.

3. Open the filecard editor and set the following parameters:

• Set Width to 700.0

• Set Tab Position X to 70.0, and Tab Position Y to 60.0

• Set Tab Angle to 45.0
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• Set Bevel to 25.0

11.1.18 Graph

 The Graph object allows you to create a 2D or 3D graph with up to 50 values.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Graph Properties

• To create a graph

Graph Properties

• Use LOD: Enables/disables dynamic level of detail.

• Width: Sets the width of the graph.

• Height: Sets the height of the graph.

• Start: Sets the starting point of the graph.

• End: Sets the ending point of the graph.

• Line Width: Defines the line width.

• 1st/last segment interpolation: Switches the interpolation of the first and last
segment on or off.

• 3D: Enables/disables 3D visualization of the graph.

• Extrusion depth: Sets the graph’s extrusion depth.

• Add backside: Enables/disables visualization of the graph backside.

• Use vertex color: Enables a base color for the graph. Set the values in the color
editor or drag a material onto the small square below the parameter.

• Line color: Enables the use of a vertex color.

• X0/Y0 to X49/Y49: Enables up to 50 different value points of the graph by giving
coordinates on the X- and Y-axis.
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To create a graph

1. Create a new group and add the graph plugin to it.

2. Add a material and/or a texture to the group, or open the graph editor and enable
Use Vertexcolor and set the Line Color.

3. Open the graph editor and set the Start and End points.

4. Enable 3D and set Extrusion Depth to 30.0.

5. Add points for the X- and Y-directions (i.e. X0/Y0, X1/Y1 and so on).

11.1.19 Graph2D

 Use this plugin to create 2D and 3D graphs, lines and bars from imported files.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Graph 2D Properties

• To create a 2D graph

• To create a channel file for the 2D graph

Graph 2D Properties

• use LOD: LOD stands for “Level of Detail”. In depending of the camera <-> object
distance a high or lower detailed object will be rendered with marginal quality
casualties if this toggle is switched on.
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• Channel: Affects the filename to search for. The file is holding the vertex and other
data to define the entire graph.

• Use: Load the file through a channel file or remote access.

• Max (%): It sets the rage for rendering. For example if you set the range to 50% the
graph will be cut 50% in width.

• 3D: Enables 3D rendering of the graph, and the Show Back option.

• Show Back: Enables the object to show the back in case the object will be rotated.

• Type: Following types are available: Graph, Line and Bars. Take a change if you
want another visual depiction. Graph enables the Reduction and Minimum Points
settings. Line enables the Constant Width, Line Width (%), Reduction (%) and
Minimum Points settings. Bars enables the Bars Width (%) and Bar Animation
settings.

• Reduction (%): The points will be reduced by the Douglas-Peucker algorithm. The
Douglas-Peucker algorithm is an algorithm for reducing the number of points in a
curve that is approximated by a series of points.

• Minimum Points: Changes the number of points for rendering the graph.

• Constant Width: Sets a constant width.

• Line Width (%): It changes the width of the line.

• Reduction (%): The points will be reduced by the Douglas-Peucker algorithm. The
Douglas-Peucker algorithm is an algorithm for reducing the number of points in a
curve that is approximated by a series of points.

• Minimum Points: It changes the number of points for rendering the graph.

• Bar Width (%): It changes the width of all bars.

• Bar Animation: One by One: Each bar will be separately rendered. All together: All
bars will be rendered at the same time.

• Use Colors: Sets the color for positive and negative values. This setting is only
available for graphs and bars (not line).

• Show Frame: Shows the frame around the graph. Useful for orientation.

• Aspect Ratio: Stretch the graph evenly in x-direction.

• Refresh Data File (button): Reload the file which holds the data value for the x-
and y-points.

To create a 2D graph

1. Create a new group and add the Graph2D plugin to it.

2. Add a material and/or a texture to the group.

3. Change the Channel parameter to the existing file (e.g. 2 for CHANNEL2).

4. Refresh the data file if the file has changed its content.

To create a channel file for the 2D graph

1. Create a text file (e.g. “CHANNEL2”) with no file extension which is holding the
following data: 5 0 0 10 20 20 0 30 20 40 0.
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• The first number (5) holds the number of points available in the file.

• The other definitions are the X and Y points -> (0/0), (10/20), (20/0) etc.

2. Create the following directory <Viz directory>\data\plugin\graph2D. and place
the channel file in it.

IMPORTANT! The channel file must always be named “CHANNEL<Channel
number>”.

11.1.20 Icosahedron

 An Icosahedron is a Platonic solid composed of twenty faces that span twelve
vertices, each face of which is an equilateral triangle. An icosahedron can be
considered a rough approximation for a sphere.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Icosahedron Properties

• To create an icosahedron

Icosahedron Properties

• Use LOD: Enables/disables dynamic level of detail.

• Smooth: Enables smoothing of edges.

• Depth: Sets the number of planes at the icosahedron. The more planes you set the
more it looks like a sphere.

• Tessellation: Allows you to choose level of detail setting between Low, Middle
and High.

To create an icosahedron

1. Create a new group and add the Icosahedron plugin to it.

2. Add a material and/or a texture to the group.
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3. Open the Icosahedron editor and disable the Smooth option, set Depth to 3 and
Tesselation to Middle.

11.1.21 Image FX

 Image FX is a tool that enables you to create a wide variety of transitions between
one or more images. The plugin uses many different effect models that can be
customized through parameters. Some properties use advanced mathematical
formulas to create the effects, and not all of them can be explained meaningfully in
normal words. Because of this, not all properties can be explained completely here,
you will have to “play” with some properties to see the effects they create in a given
situation (what some properties are set to will have impact on the effect that other
properties give).

The images are split into a number of user-defined sections and every section is
controlled independently based on progress maps. Any number of images of any Viz
Artist supported format can be controlled using ImageFx. All images will be resized (if
needed) to the first image size. The image transition order can be modified on the fly
and images may be added to the sequence using external commands.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section also contains information on the following topics:

• Image FX Properties

• Image

• Geometry

• Trigger

• Effect

• Control

• To add, load and remove images

Image FX Properties

At the top of the editor you will find a set of buttons to switch the properties.

Image

•  Add and Remove: Images dropped onto the Add/Remove drop zone will be added/
removed as sub-containers of the plugin container in the scene tree.

• Load from Scenetree: Loads images that are added directly as sub-containers to
the ImageFX plugin container.

• Clear all: Removes all sub-containers to the ImageFX plugin container.
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Geometry

The image is split into a number of stand-alone sections that can be modified
independently.

• Geometry Type: Select here which kind of geometry you want the images to be
split up in.

• Tiles: GL quads, the number of quads are X tessellation times Y tessellation.

• Mesh: (vertices) GL quad strip, the number of vertices are (X tessellation +1) times
(Y tessellation +1). Modification can apply to every vertex in the mesh.

• Triangles: GL triangles, the number of triangles are X tessellation times Y
tessellation times 2. Modification can apply to one triangle (3 vertices).

• Random Triangles: GL triangles, triangles are generated using random points.
Number of triangles is a minimum of X tessellation times the Y tessellation.
Modification can apply to one triangle (3 vertices).

• Random Seed: Is relevant if you have chosen random triangles. It specifies a seed
for the random number generator. Even though Viz Artist use random numbers, the
layout of a specific random seed will always look the same. Press the wireframe
button and click the new random seed button and you will see the effect.

• Tesselation: Sets the degree of detail (enable wireframe to view the effect).

• Spacing: Sets a spacing between the geometrical parts in the image.

• Border: If spacing has some value, this parameter will draw a border with the width
defined here between single sections.

• Crop: Enables/disables cropping of the border.

• Alpha: Sets an alpha value for the border.

• Color: Sets a color for the border.

Trigger

In the trigger section you can select between different progress maps that defines how
every section of the image is to be triggered by the global progress. Each section of
the image receives its base value, the global progress is a value that changes as you
animate by using one of the options in the control menu. Since every section gets a
different base value, it will be triggered differently by the global progress.
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Example: In a domino effect which starts at the bottom left the section at the
bottom left will receive a value of 100 and the section at the top right will receive
a value of 1. As the progress moves section with high values will be influences,
fast then sections with low values. If we continue with the above example with a
fade effect, the bottom left section will fade out when progress is 20 but the top
right section will only fade out when progress is 100.

The options for progress maps are:

• Clock: Sets the values for the sections that are computed based on a clock hand
movement. It has the following properties:

• Center: Sets the center for the clock hand movement.

• Start Angle: Sets the starting angle for the clock hand.

• Whirl: Applies a whirl effect to the movement.

• Direction: Sets the direction for the clock hand movement.

• Domino: Sets the values for the sections that are computed based on a domino
movement. It has the following options:

• Order: Sets the order in which the tiles will be moved. Choose between Lines
(Line by line movement), Columns (Column by column movement, Center (From
center and outwards movement), Bottom Left (Bottom left tiles first and then
diagonal movement towards top right corner) or Top Left (Top left tiles first and
then diagonal movement towards bottom right).

• Direction: Sets the starting point of the movement.

• Noise: Sets the values for the sections that are computed based on user-defined
noise map created using noise algorithms (perlin noise).

• The settings create a noise texture and the image transformations are based on this
image.

• When you edit the noise properties it is a good idea to enable the show button.
This will let you see the image that are created and you will see changes you do
instantly.

• Wave, Cloud, Marble and Noise are predefined noise parameter settings. It is
normally a good idea to start with one of these and thereafter edit until you get the
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desired effect. The four images below show how the four noise parameters look like
when the show option is enabled:

• Turbulence 1 to 3: Sets the noise level. The settings must be played with to see
what kind of effect you get as they influence each other. So what effect one gives
depends on the state of the other.

• Frequency: Defines something that can be described as the “wave length” of the
noise function. A large number gives a small wave length which will create a lot of
changes to the image, while a small number will create a smoother image.

• Exponent: Controls the ratio between the white areas and the black areas without
changing the shape significantly. Exponent zero give a full white picture, and as the
value will grow, the black area will become larger and larger.

• Scale X/Y: Are quite similar to the usual texture scale, but they are working with
reverse logic. In the usual texture scaling, increasing the scale is like zooming into
the image, but in Image FX it works like zooming out. Also the units are different,
but beside this, they are quite similar.

• Random: The values for the sections are computed randomly.

• Image: The values for the sections are computed based on pixel values of an image
you drag onto the drop zone. What the function does is to create links between the
animated image tiles and the pixels of the image and then use the luminance level
of each pixel to set the base value for the tiles. By default 100% luminance sets
high base value and 0% sets a low base value. This option allows you to generate
any progress map you want by using other tools.

• Static: All sections receive the same value. The complete image will move out and
the other will move in.

• Random Seed: Is relevant if you have chosen random order. It specifies a seed for
the random number generator. Even though Viz Artist use random numbers, the
animation for a specific random seed will always look the same.
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Effect

The trigger section defined the order in which the tiles would be influenced by the
global process. The effect section allows you define what kind of effect/transition that
will be used.

• Target Image

• Static: The target image is not effected at all the by the effect. A typical example
would be a reveal effect where target image is “hidden” behind main image and a
transition effect on the main image will reveal the target image.

• Dynamic: The target image is controlled by the effect. A typical example would
be main image flying out of the frame and at the same time target image flying in.
If a dynamic target image is used, its effect can be either being the invert of main
image or can be defined separately.

• Interpolate

• Linear: A linear interpolation will be used for the transformations.

• Smooth: A smooth interpolation will be used for the transformations.

• Position > Move: You can specify a position for the source image, for the target
image and a random position.

• For the source image, which is the image that is currently displayed, you specify
a source position. This is the position that the image tiles will move to when the
animation runs.

• If no target position is specified, the target image will animate from the source
position to the initial position of the source image.

• If you specify a target value the target image will move from that position and onto
the initial position of the source image.

• Switch on X, Y and Z to alter the values.

• Absolute: All sections will move to the same end position.

• Relative: The sections will maintain their original relationship.

• Position > Explode: Final positions for the sections are calculated based on a
user-controlled explode algorithm. The tiles of the image are treated as particles
in an explosion and they are moved in one to three axis depending on what you
specify. All tiles are thrown out of a emitter that can be defined to have any opening
angle, so the particles can be sent within a narrow angle, like a canon fire, or in all
direction like a explosion. The parameters are:

• Duration: Sets the duration for the movement of the tiles/particles.

• Opening Angle: Sets the opening angle for the emitter. Remember to choose more
than one axis to get any clear effect.

• Angle Rotate X: Rotates the emitter hole on the X-axis.

• Angle Rotate Y: Rotates the emitter hole on the Y-axis.
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• Force sets the degree of force that throws the particles out in space.

• Force Spread %: Randomizes the initial impels of the tiles. Spread 0 % means all
elements have the same impulse, 100% means a high degree of randomness.

• Gravity: Sets a gravity force for the environment.

• Use Axis: Select which axes or axis to use.

• Rotation: The sections are rotated.

• Scaling: The sections are scaled.

• Alpha: The alpha value of the sections are changed from Alpha Start to Alpha
End.

To all options (except alpha) a certain degree of user-controlled randomness can be
added.

• Random Seed: Is relevant if you have a random property. It specifies a seed for
the random number generator. Even though Viz Artist use random numbers, the
animation for a specific random seed will always look the same.

The final effect of transformation can be a combination of effects where the timing
between the different effects can be tuned using the mini-stage. Move the start and
end key frames to time the effects.

Example: A position explode effect can be combined with a rotation effect so the
sections will rotate as they explode. An alpha effect can be added to fade out the
sections at the end.

The pivot properties have relevance when you use rotation on the tiles. The settings
decide where the rotation center should be on the tiles. To see the effect, create a low
tesselation transition with tiles and a 180 degree X or Y rotation. Change the pivot
properties for Y pivot if you have an X rotation or the X pivot if you have an Y rotation
and see the effect.

Control

The global progress value that is used to animate the sections can be controlled in
different ways:

• Auto: When using auto mode ImageFx will start the effect as soon as the “Take”
button is invoked. Useful for external control to run a sequence of images.
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• Animation: The global progress value is animated and the effect follows the stage
progress. In this mode you can combine the effect animation with other animations.

• Global Animation: When using a sequence of images the complete progress will
animate all images.

To add, load and remove images

1. Add the images you want to create transitions between by dragging them from
the server view and dropping them onto the Add drop zone.

• The added images will be visible in the scene tree as sub-containers of the ImageFX
plugin container.

2. To add images directly as sub-containers to the plugin container you must click
the Load from Scenetree button to make the plugin recognize the added
images.

3. Remove images by dragging them from the server view and onto the Remove
drop zone, or simply remove them directly from the scene tree.

4. To remove all, click the Clear all button.

11.1.22 Noggi

 Use this plugin to create geometry objects of beveled rectangles with some
attributes.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Noggi Properties

• To create a noggi

Noggi Properties

• Width: Changes the width in X-direction.
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• Height: Changes the height in Y-direction.

• Bevel (top/right, top/left, bottom/left and bottom/right): Changes the bevel
on each corner.

• Stretch: The result is an object like a parallelogram. Stretch is in percent (=
tan(alpha)). If Geometry Type is Outline.

• Horizontal Alignment: Changes the object alignment to left, center or right. This
change will affect the y-rotation.

• Vertical Alignment: Changes the object alignment to bottom, middle or top. This
change will affect the x-rotation.

• Geometry Type: Renders the object as area- or with outline look.

• Inner Outline: Changes the vertex sequence in outline mode. Inner Outline is
important for face orientation when extruding the geometry.

• Outline Width: Changes the thickness of the rendered outline.

• Edge Points: Change the number of triangles to render an beveled corner. A lower
value means a

• Crop: Enables/disables cropping of the object. Cropping and vertex texture are only
available if Geometry Type is Area.

• Crop Face (Left, Right, Bottom and Top): Crops the object on each given side.

To create a noggi

1. Create a new group and add the Noggi plugin to it.

2. Add a material and/or a texture to the group.

3. Open the transformation editor and set Position X to -150.0.

4. Open the Noggi editor and set the following parameters:

• Set Width and Height to 600.0 and 100.0.

• Set Bevel top/right and bottom/left to 0.0.

• Set Bevel top/left and bottom/right to 20.0.

11.1.23 Pointer

 The pointer is similar to the Arrow. The main difference is that the pointer has a joint
link, so it looks more like a bend arrow. The pointer has two reference points which
controls the pointer’s position. The first point is in the joint link and the second point is
at the arrow’s head.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Pointer Properties

• To create a pointer
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Pointer Properties

• Use LOD: Enables/disables dynamic level of detail.

• Point 1 X: Sets the position of point 1 on the X-axis.

• Point 1 Y: Sets the position of point 1 on the Y-axis.

• Point 2 X: Sets the position of point 2 on the X-axis.

• Point 2 Y: Sets the position of point 2 on the Y-axis.

• Width: Sets the width of the pointer shaft.

• Cap Style Begin: Allows you to select the style on the pointers beginning. The
options are Flat, Circle or Arrow.

• Cap Style End: Allows you to select the style on the pointers end. The options are
Flat, Circle or Arrow.

• Arrow Length: Sets the length of the arrow head.

• Arrow Width: Sets the width of the arrow head.

• Circle Radius: Sets the radius of the circle, if cap style is selected.

• Circle Segments: Sets the resolution of the outer side of the pointer angle. Switch
to wireframe to see the effect as you change the value.

• Joint Style: Sets the style of the pointer joint, either Round or Miter.

To create a pointer

1. Create a new group and add the Pointer plugin to it.

2. Add a material and/or a texture to the group.

3. Open the Pointer editor and set the following parameters:

• Set Point 1 X and Y to 50.0.

• Set Point 2 X and Y to 75.0.

• Set Width to 20.0.

• Set Cap Style Begin and End to Circle and Arrow, respectively.
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• Set Arrow Length, Width and Radius to 50.0.

11.1.24 Polygon

 The Polygon built-in object enables you to create a user defined polygon. The
polygon is a 2D object. The extrusion can be applied to it to make it into a 3D object. If
you open the property editor for the polygon plugin, a drawing pad will be shown. Note
that polygons that overlap each other will act as masks.

Note: Polygon is not a plugin with its own file as it is part of the internal Viz core.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Polygon Properties

• To draw a spline

• To draw a new spline

• To undo

• To move and scale a polygon

• To alter the shape of the polygon

• To select existing elements for editing

• To mirror the spline sections

• To flip spline sections

• To rotate a spline

• To split a spline

• To merge two splines

See Also

• Import File Shortcuts

Polygon Properties
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At the bottom of the drawing pad you will find a main menu, offering you the following
options:

• Import...: Allows you to import an Adobe Illustrator file to be used as spline.

• Smooth Spline: When enabled the spline will be calculated as curve connecting
the intersection points. If switched off the intersection points will be connected by
straight lines.

• Close Spline: Closes the spline to one curve from the first to the last point. If
switched off the first and last point of the spline will be connected by a straight line
to form the border of the polygon.

• Precision: Sets the tessellation. To view the effect of changes, switch the Scene
Editor to wireframe.

• Clear all: Deletes all splines.

For information on how to use the drawing pad’s context menu, see the different
procedures.

To draw a spline

An outline of the spline created on the drawing pad is displayed as a polygon in the
Scene Editor. As the polygon needs a closed border in the Scene Editor the spline
will automatically be closed. This is done without taking the shape of the spline into
consideration.

1. Move the cursor on the drawing pad to the position you want to start from and do
a left-click.

• This will set the first point of your spline.

2. Move the cursor to the place where the second intersection point should be placed
and do another left-click.

3. Repeat step 2 until your spline is defined by enough intersection points to create
the desired polygon shape.

• For ease of use all intersection points are numbered.

• If you added an intersection point by accident press the <Delete> button to remove
it.

To draw a new spline

• Right-click and select the point on the drawing pad where the new spline should
start, and from the appearing context menu select spline and then new.

To undo

• Press <Delete>, or press and hold the <Ctrl> button while turning the mouse wheel
backwards (one step at a time) to undo the previous action.
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To move and scale a polygon

1. Press the SPACE bar, or right-click and select a spline, and from the appearing
context menu select properties, editor and bounding box.

2. Place the cursor in the center of the polygon, left-click and hold the mouse button
while dragging the polygon.

3. Drag the handles of the bounding box to scale the polygon.

To alter the shape of the polygon

To change the shape of the polygon you have to alter the spline. You are provided with
a set of options to do so:

1. Move an intersection point by clicking and holding the left mouse button while
moving the cursor around. Release the button to set the new position of the point.

• While hovering the intersection point the color of the intersection point will become
green and the status information displayed.

2. Add an intersection point by hovering above the spline and left-clicking the
mouse button, or hold the mouse button to move the intersection point to another
position.

3. Remove an intersection point by left-clicking and holding an intersection point
while pressing the <Delete> button.

4. Edit handles (i.e. the ones on the right and left of the intersection point) by left-
clicking and holding the mouse button to move the handles around. Release the
button to set the new position of the handle.

• Set sharp edges on selected or all intersection points by right-clicking the spline
and selecting spline, point and sharp edge. Reset changes by selecting the reset
handles option.
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To select existing elements for editing

1. Press and hold the Ctrl button and the left mouse button while drawing a
rectangle that covers the intersection points to be selected, or

2. Right-click and select an intersection point, and from the appearing context menu,
select spline, select and then one of the following options:

• all: Selects all spline sections of the polygon.

• to begin: Selects all spline sections from the point selected to the beginning of the
polygon.

• to end: Selects all spline sections from the point selected to the end of the polygon.

• invert: Inverts the selection already made. If all is selected, invert will change it to
none selected, and conversely. If to begin was selected, it will transform it to to end,
and conversely.

To mirror the spline sections

• Right-click the drawing pad, and choose spline, mirror and one of the following
options:

• all: Mirrors whole spline along X- and Y-axis.

• all x: Mirrors whole spline along X-axis.

• all y: Mirrors whole spline along Y-axis.

• selected: Mirrors only selected points along X- and Y-axis.

• selected x: Mirrors only selected points along X-axis.

• selected y: Mirrors only selected points along Y-axis.

To flip spline sections

What the flip function does is to switch the X or Y values between the points in an order
where the first point switch value with the last point, the second point switch value with
the last but one, and so on.

• Right-click and select spline, flip and one of the following options:

• all x: Flips whole spline over X-axis.

• all y: Flips whole spline over Y-axis.

• selected x: Flips selected points over X-axis.
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• selected y: Flips selected points over Y-axis.

To rotate a spline

1. Select and right-click the intersection point to rotate around, and from the
appearing context menu select anchor and then set.

2. Press the SPACE bar, or right-click and select a spline, and from the appearing
context menu select properties, editor and bounding box.

3. Move the cursor next to a vertex of the bounding box and the cursor will be shown
as rotating arrow.

4. Press the left button on the mouse and move the cursor to rotate the spline.

To split a spline

Splitting a spline section can be done in three ways:

1. Right-click and select the section to split and from the appearing context menu
select spline and then split, or

2. Select the section and press S, or

3. Press <Shift+S> (showing a pair of scissors) and left-click the mouse on the
section to be split. Right-click the mouse to revert to normal editing mode.

• After you have split the section the numbering of the points will change.

To merge two splines

1. Right-click and select a start/end point to be connected, and from the appearing
context menu select spline and then merge.

2. Double-click the start/end point on the other spline to be merged.

• The cursor will become a chain.

3. Click on the start/end point on the first spline to connect them.

• After you have merged the splines the numbering of the points changes.

11.1.25 Rectangle

 Use this plugin to create a simply 2D rectangle with some attributes.
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Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Rectangle Properties

• To create a rectangle

Rectangle Properties

• Use LOD: Enables/disables dynamic level of detail.

• Tessellation: Sets the degree of detail.

• Bevel: Enables and sets the degree of bevel at the rectangle edges. Bevel may
have an effect on the height of the rectangle. For example if Height is set to 100.0
and Bevel is set to 51.0, the effective height is 102.0.

• Width: Sets the width of the rectangle.

• Height: Sets the height of the rectangle.

• Corners: Sets the number of corners the rectangle is build up from, it become
visible, when you set a bevel on the rectangle.

• Use Vertexcolors: Enables you to set the four color parameters below. If this
option is set, the rectangle does not respond to container color anymore.

• Upper Left: Sets the color and alpha of the upper left section of the rectangle.
Press the colored button to enable color editing on that section and change the
color in the color editor below. You can also drag a material from the server view
and onto the color icon.

• Lower left: Sets the color and alpha of the lower left section of the rectangle. Press
the colored button to enable color editing on that section and change the color in
the color editor below. You can also drag a material from the server view and onto
the color icon.

• Upper Right: Sets the color and alpha of the upper right section of the rectangle.
Press the colored button to enable color editing on that section and change the
color in the color editor below. You can also drag a material from the server view
and onto the color icon.

• Lower Right: Sets the color and alpha of the lower right section of the rectangle.
Press the colored button to enable color editing on that section and change the
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color in the color editor below. You can also drag a material from the server view
and onto the color icon.

• Mode: Sets the orientation of the plane to XY, XZ or YZ.

To create a rectangle

1. Create a new group and add the Rectangle plugin to it.

2. Add a material and/or a texture to the group, and/or open the Rectangle plugin
editor and enable and set the vertex colors.

3. Open the transformation editor and set Position Y to -150.0.

4. Open the Rectangle editor and set the following parameters:

• Set Bevel to 15.0.

• Set Width to 600.0.

• Set Height to 30.0.

11.1.26 Ring

 Use this plugin to simply create an open or closed ring with some attributes.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Ring Properties

• To create a ring

Ring Properties

• Use LOD: Enables/disables dynamic level of detail.

• Corners: Sets the number of corners on the ring.

• Inner Radius: Sets the size of the inner radius.

• Outer Radius: Sets the size of the outer radius.
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• Rotation: Rotates the ring like a “turning wheel”. This is typically used in
combination with an open angle, to place the angle at the desired point.

• Angle: Defines an open angle on the ring.

• Mode: Changes the object view coordinate. Available options are XY, XZ and YZ.

To create a ring

1. Create a new group and add the Ring plugin to it.

2. Add a material and/or a texture to the group.

3. Open the Ring plugin editor and animate the Angle.

• Set Angle to 0.0 (60/50 fps).

• Set Angle to 360.0 (120/100 fps).

11.1.27 Roll

 The roll allows you to create a rectangle that rolls up in different ways. This is
typically used for different kinds of unveiling. To make the roll look realistic, the expert
plugin must be added to the container to enable visualization of backface and two-
sided lightening.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Roll Properties

• To create a roll

Roll Properties

• Use LOD: Enables/disables dynamic level of detail.

• Size X: Sets the size of the rectangle on the X-axis.

• Size Y: Sets the size of the rectangle on the Y-axis.

• Tessellation: Sets the level of detail.
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• Angle: Sets the angle of the rolling up.

• Diameter: Sets the diameter of the roll.

• Helix factor: Defines how tight the roll is to be rolled up. With a high helix factor,
there will be much space between the layers of the roll.

• Drawing: Selects how the roll rectangle is to be drawn up. If you switch to
wireframe mode and toggle between the two settings you will see the difference:

• Segments: Draws the rectangle up by using many long lines stretching from
edge to edge. This mode does not look as good as Mesh but it demands less
performance of the render engine.

• Mesh: Draws the rectangle using many small equally sized triangles. The number
and size depends on the level of tessellation selected. This drawing mode can be
heavy to render if the tessellation is set high. Mesh creates a better lightning of the
roll rectangle.

• Style sets the style of the roll:

• Cigar roll makes the rectangle roll up in a normal manner.

• Wipe rolls the carpet up without creating a roll.

• Outline enables an outline view for the roll. You must in addition add the expert
plugin and enable the outline setting there.

• Time sets the time for the roll sequence. Animate this value to create an animation
of the roll object. To learn more about animation see Creating Animations .

To create a roll

1. Create a new group and add the Roll plugin to it.

2. Add the Expert plugin to the group.

3. Open the Expert editor and enable (On) the Back Face property.

4. Add a material and/or a texture to the group.

5. Open the Roll editor and set the following parameters:

• Set Size X to 150.0.

• Set Size Y to 20.0.

• Set Angle to 10.0.

6. Adjust the Time parameter to see the roll effect.

11.1.28 Soft Clip Draw Pixels

 Plugin for playing video clips by drawing pixels.

Choose a video file to play. Playback can be achieved by either animating over the
frame numbers or by turning on live playback. While in live playback mode, the frames
will be displayed synchronized to viz rendering, or according to the Frames Per Second
(FPS) setting, depending on the play mode that is chosen.
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On machines with multiple CPUs turning on the decode thread will help balancing the
CPU load over the CPUs. If you use live play, the Preload frame count can help reducing
spike-loads and avoid dropped frames.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Soft Clip Draw Pixels Properties

Soft Clip Draw Pixels Properties

• use LOD: Enables/disables dynamic level of detail.

• Clip file: Loads the AVI clip file.

• Live Play: The clip is being automatically played.

• Play mode: Plays the frames synchronized to viz rendering or according to the
given Frames per second.

• Frame per second: Renders the number of frames per second.

• Loop video: Plays the video in an endless loop.

• Use decode thread: Useful if the machine owns more than one CPU core. It
increases the rendering performance if this parameter is set.

• Preload frame count: Increases the performance through loading frames in RAM
before they are currently needed. Recommended setting is 1.

• Frame skipping: Skips frames if the machine has not enough performance
to render all frames in the given time range instead of slowing down the video
playback.

• Force Opaque (fill alpha channel): Ignores the transparency.

• Preferred CPU (0 = Any): Use this option if you want choose manually a core for
rendering and processing. Choose 0 for automatically selection.

• Priority: Allows you to set the priority if the entire achievement is needed because
of clip rendering lapse. Setting priority to Low should not reduce the overall render
performance.

• X, Y and Z Position: Changes the X, Y and Z coordinates for clip translation.
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11.1.29 Sphere

 Use this plugin to create a simple sphere with some attributes.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Sphere Properties

Sphere Properties

• Use LOD: Enables/disables dynamic level of detail.

• Tessellation: Sets the degree of detail for the sphere.

• Rotation: Allows you to rotate the sphere around its Y-axis.

• Open Angle: Allows you to create an open angle in the sphere.

• Texture: Allows you to select between three different positions of the texture
mapping coordinates when a vertex texture is mapped onto the sphere. To visualize
the effect of the different settings, add a plain texture onto the sphere, like a
chessboard image and set the texture mapping to vertex in the texture editor.
Create an opening in the sphere and change the sphere texture parameters.
Increase and decrease the opening angle with the different settings enabled and the
effect should be visible.

• Absolute: Compresses and expands the texture mapping coordinates as the
opening of the sphere changes.

• Relative: Cuts/adds texture coordinates as the opening changes. The cut/add is
done on the one side of the opening angle. The coordinates are anchored at the
other side.

• Centered: Does the same as the relative mapping, but cuts/adds coordinates from
both sides. The texture is anchored in a centered position on the sphere. The center
of the sphere is 180° from the point where the opening angle starts.

11.1.30 Spline Path

 Use this plugin if you want create complex paths with an arrow look.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Spline Path Properties

• To create a spline path
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Spline Path Properties

• use LOD: Enables/disables dynamic level of detail.

• Node: Define the node index you want. For example node 3 or node 25.

• X, Y and Z: It sets the 3D point to define a node.

• Length: Stretches the entire path in X-direction.

• Width: Stretches the entire path in Y-direction.

• Threshold: Increase this value if you do not need a high path accuracy but more
performance.

• Add, Move, Remove and Clear: Add adds a new node with an specific index.
Move, moves an existing node to another X, Y, Z-point. Remove removes an existing
node. Clear clears all nodes.

• Mode: The following options are available:

• Tube: Renders the entire object.

• Band XY: Renders only the front side.

• Band XZ: Renders only the top side.

• Band YZ: Renders only the left side.

• Arrow: Creates an array look.

• Arrow Length: This option works only if the Arrow toggle is switched to “on”. It
stretches the arrow.

• Arrow Width: This option works only if the “Arrow” toggle is switched to “on”. It
changes the arrow width.

To create a spline path

1. Create a new group and add the Spline Path plugin to it.

2. Add the Expert plugin to the group.

3. Open the Expert editor and enable (On) the Back Face property.

4. Add a material and/or a texture to the group.

5. Open the Spline Path editor and set the following parameters:

• Set Node to 0, X to 50.0, Y to 50.0, and click Add.

• Set Node to 1, X to 150.0, Y to 25.0, and click Add.
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• Set Node to 2, X to 250.0, Y to 10.0, and click Add.

• Set Node to 3, X to 350.0, Y to 45.0, and click Add.

11.1.31 Spline Strip

 The Spline Strip plugin is used for creating 3D interactive loft extrusions which are
able to be animated in their length and surface. You can use modifiable lines, circles or
rectangles for the extrusion. Arrows and terrain alignment are also supported.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Spline Strip Properties

• To create a simple spline strip

Spline Strip Properties

• Path Node Index: Defines where Path Nodes get added, moved or removed. The
first node within a path owns the index 0. If you add nodes at the end, then the Path
Node Index is increased automatically to provide a simple path generation.

• X, Y and Z: Sets the Path Node’s X, Y and Z-position.

• TC: Sets the Path Node’s TC-position.

• Add Node: Adds a path node at the current Path Node Index with position X, Y, Z
and TC.

• Move Node: Moves the current path node to your desired X, Y, Z and TC position.

• Remove Node: Removes a path node at the current Path Node Index.

• Interactive Mode: If you have finished the process of setting path nodes then you
are able to edit it simpler by mouse. Just drag and drop the displayed nodes to a
new position. Left Mouse Button: move node in XY. Middle Mouse Button: move node
in XZ.

• Interactive Orientation: World, Local, View. Move nodes interactive with world-,
local-, or viewpoint- coordinates.

• Node Size: Sets the interactive node’s size.

• Storage: Is used for storing your defined path nodes in a #-separated string. It is
possible to edit nodes directly in the Storage Text field.

• Clear Storage: Clears the spline strip object and its storage.

• Use Time Code: Activates Time Code functionality.

• TC Current: Contains the current Time Code of an external Time Code source.

• TC Start: Sets the starting point of your Time Code animation.

• TC Reference: If you are using more than one spline strip then they probably will
not start all at the same Time Code position. But you can change that by a simple
time shift with the Help of TC Reference.

• Path Steps: Defines SplineStrip tessellation.

• Use Threshold: You can optimize your spline strip with that option. Path Steps are
added at necessary positions only. So the number of Path Steps increases with a
decreasing Threshold.
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• Threshold: Sets the Threshold for Path Steps generation.

• Path Start: Sets the starting point of the path geometry.

• Path Length: It defines the length of our spline strip object. Feel free to animate
that value!

• Path Alignment: Fits the spline strip to Terrain plugins in viz. (e.g. use Terrain for
drawing paths over a mountain). Available options are; Free and Topography.

• Surface Offset: Shifts Path on Y axis.

• Use Surface Normal: If activated then the surface offset is computed via terrain
normals.

• Show Path: Shows the Path which you have defined at the beginning. This option is
quite helpful when you are editing Path Nodes.

• Shape Type: If you activate the Organic Mode, your spline strip will start to wobble
in dependency of the adjusted Organic Amplitude, Organic Speed, and Organic
Period’s Length. Available options are; Static and Organic.

• Shape: Defines the shape used for the loft extrusion. Available options are; Line,
Circle and Rectangle.

• Shape Width: Sets the shape’s width.

• Shape Height: Sets the shape’s height.

• Shape Tessellation: Defines how many steps are used to draw the desired shape.

• Shape Rotation: You are able to move the spline strip shape up to 360 degrees.

• Shape Orientation: When set to Free, shapes are rotated in dependency of the
adjusted Shape Rotation value. When set to XZ, YZ or YX, shapes are auto rotated
to obtain a constant SplineStrip width in the desired aspect. When set to Terrain,
shapes are rotated to fit the terrain beneath them.

• Translate Vertices To Terrain: Moves every single vertex to fit the terrain. This
mode only makes sense if you are using Line extrusion.

• Flip Normals: Flips spline strip normals.

• Backface Culling: Switch off drawing spline strip’s backside.

• Organic Amplitude: Adjusts the animated diameter reduction from 0% to 100%.

• Organic Speed: Changes speed of organic mode animation. Also negative values
are allowed.

• Organic Period’s Length: Sets the diameter reduction function’s period length.

• Termination: Closes our spline strip object at the Beginning, End or at Both sides.
Available options are; None, Beginning, End and Both.

• Arrow: Puts an Arrow to the Beginning, End or Both sides. Available options are;
None, Beginning, End, Both

• Object Width: Changes arrow width.

• Object Height: Changes arrow height.

• Object Length: Changes arrow length.

• Object Tessellation: Changes arrow tessellation.

• Generate Texture Coordinates: Activate this function if you are using vertex
maps on your spline strip.

• Stretch Texture to Path Length: If activated then the map is stretched to the
actual path length.

• Draw Mode: Switch between fill- and wire-frame mode. Available options are; Fill
and Wire.
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• Buffer Geometry: The whole spline strip data is buffered to memory. If you
use spline strips with a huge number of vertices then Buffer Geometry is able
to improve performance. Activate this mode only if you do not use any kind of
animation in your current spline strip.

• Color: Defines path’s and interactive-mode-node’s color. Color is also used if Wire is
activated and no maps are applied onto your spline strip object.

• Child Distance: Defines distance between path end and child container.

• Rotate Child: Activates child container rotation.

To create a simple spline strip

1. Create a new group and add the Spline Strip plugin to it.

2. Open the Spline Strip editor.

3. Use all default values, and click Add Node.

4. Change X to 100.0, and click Add Node.

5. Change X to 200.0, Y to 50.0, and click Add Node.

6. Set Shape Width and Shape Height to 50.0.

7. Go to Shape and change it to Circle.

8. Set Shape Tessellation to 20.

9. Play with the Path Length parameter. Optionally you can click and try Interactive
Mode.

10. Change Node Size to for example 15.0.

11. Drag and drop the small Cubes.

11.1.32 Spring

 The spring object creates a spiral spring. Be aware this object can easily be very
heavy to render if a high level of tessellation and corners are selected.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Spring Properties

• To create a spring

Spring Properties
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• Use LOD: Enables/disables dynamic level of detail.

• Tessellation: Sets the degree of detail for the spring

• Corners: Sets the number of corners the spring should have.

• Gradient: Sets the size of the spring gradient.

• Diameter torus: Sets the diameter of the springs.

• Diameter cross section: Sets the diameter of the spring cord.

• Show Bottom: Shows/hides bottom of the spring.

• Show Top: Shows/hides Top.

• Center: Sets the location of the spring center, either Center, Bottom or Top.

To create a spring

1. Create a new group and add the Spring plugin to it.

2. Open the Spring editor and set the following parameters:

• Set Turns to 6.0.

• Set Gradient to 20.0.

• Set Diameter torus to 200.0.

• Set Diameter cross section to 100.0.

• Set Center to Center.

3. Add a material and/or a texture to it.

11.1.33 Torus

 Use this plugin to create a torus with different attributes.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Torus Properties

• To create a torus

Torus Properties

• Use LOD: Enables/disables dynamic level of detail.
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• Tessellation: Sets the degree of detail for the torus.

• Corners: Sets the number of corners on the torus.

• Radius: Sets the radius of the torus from its center in the middle of the hole.

• Radius cross section: Sets the radius of the torus cross section or “tube”.

To create a torus

1. Create a new group and add the Torus plugin to it.

2. Open the Torus editor and set the following parameters:

• Set Radius to 50.0.

• Set Radius cross section 20.0.

3. Add a material and/or a texture to it.

11.1.34 Trio Scroll

 The Trio Scroll plugin is essentially a geometry plugin for positioning and scrolling a
fixed set of elements in a specified direction, often used for credit lists or crawls.

Scrolling templates can be built in Viz Trio using the Create New Scroll feature. The
scroll scene that is automatically created by Viz Trio can be edited in Viz Artist, but it is
also possible to build them manually.

Some of the supported features are:

• Scrolls can be created by receiving element data from Viz Trio’s XML format.

• Fine-tuned control of spacing between individual elements.

• Easepoints (ease in and out) on particular elements.

Scrolls are usually built in Viz Trio, but it is possible to add elements in Viz Artist by
adding merged objects under the base_elements group and clicking the Initialize
button.

Adding the Trio Scroll plugin to the scene tree will automatically add the Control Object
plugin (if it is not present).

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Trio Scroll Properties
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Trio Scroll Properties

• Field Identifier: When making templates for Viz Trio, this should be a numeric
value, Range: 1-n. For Viz Content Pilot and Viz Ticker, this can also be a descriptive
text string. This value is used by the control clients to identify the editable element
in the scene. In Viz Trio the numbers from the control plugins are used to create the
tab-order between the editable elements.

• Description: A description of the tab field or editable object. This will be used as a
description for the elements when used in the control clients.

• Show only in Expert Mode: If Viz Trio is connected, changes are possible if this
toggle is switched to off.

• Mode: Select the direction the scroller should move across the screen.

• Scroll area width: Select the area in width the scroller should use.

• Scroll area height: Select the area in height the scroller should use.

• Scroll speed: Set the scroller speed.

• Wanted total scroll time: Sets the scroll time.

• Actual total scroll time: Sets the scroll time.

• Global spacing: Sets spacing between the pages.

• Loop: Enables the Loop property Turn on or off (default) looping. Turning off looping
will not stop the playlist from being played till its end.

• Show bounds: Enables and displays the scroll’s bounding-box on the preview and
program renderer.

• Auto-start scroll: Enables the Auto-scroll on take property.

• Start position: Sets the start position for the scroll. This setting will affect the
Actual total scroll time.

• Alignment: Sets the alignment of the scroll. The position is relative to the position
of the scene design. Available options are: None, Left/Bottom, Center and Right/Top.

• End-of-scroll director: Triggers a Continue on a specified end director. The
director is triggered when the scroll leaves the scroll area. It is only supported in
normal mode (real time), not in post rendering or NLE mode.
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See Also

• Create New Scroll in the Viz Trio User’s Guide.

• Control Object

• Trio Scroll Element

11.1.35 Wall

 The wall object is a curved wall. The size and curving of the wall can be customized.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Wall Properties

• To create a wall

Wall Properties

• Use LOD: Enables/disables dynamic level of detail.

• Height: Sets the height of the wall.

• Width: Sets the width of the wall.

• Depth: Sets the depth of the wall curving. The higher this value is set, the more
curved the wall will appear.

• Angle: Sets the angle of the walls curving. Use this parameter together with
Depth: To achieve the wanted curving of the wall.

• Corners: Sets the number of internal corners the wall should be built up from.

• Center: Sets the center axis of the object. Choose between Center, Bottom or
Top.

• Front: Lets you switch between front and back.

To create a wall

1. Create a new group and add the Wall plugin to it.

2. Open the Wall editor and set the following parameters:

• Set Height to 200.0.

• Set Width to 400.0.

• Set Depth to 400.0.
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• Set Center to Center.

3. Add a material and/or a texture to it.

4. Open the Transformation Editor and set Rotation Y to -45.0.

11.1.36 Wave

 The wave allows you to create a wave sequence on a flat surface. The properties of
the sequence are visualized in a graphical display in the wave editor.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Default

This section contains information on the following topics:

• Wave Properties

• To create a wave

Wave Properties

• Size X and Y: Sets the size of the rectangle where the waves appear.

• Geom Type: Allows you to select between Circular and Linear waves.

• Stretch: Allows you to customize the form of the circular waves. By altering the
stretch X and Y values, you can for instance obtain an oval or a compressed form of
the waves.

• Time: Is the timeline for a wave sequence. You see a thin red vertical line moving
in the graphical display as you alter the time value. You can also alter the value by
dragging the red line.

• Tess.: Sets the tessellation / level of detail.

• Angle: Sets the angle of the waves when a linear mode is chosen.

• Ref.Pnt X and Y: Sets the position of the waves starting point.

• W. Length: Sets the length of the waves.

• Damp. mode: Enables damping of the waves. The amplitude of the wave is
reduced by the damp length calculated from the center of the wave.

• Damp. Length: Sets the length the distance that is used to damp the waves in the
Damp. mode function.

• Offset: Sets an offset value of the Ref.Pnt.

• Ampl: Amplifies the waves, resulting in both bigger and higher waves.

• Inverse OFF/ON: Inverts the wave curves.
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• Envelope Generator: Enable this option if you want to draw the wave manually.
When disabled the wave is built by a sinus wave function.

• Position X and Y: Allows you to edit the position values of the wave control points.
Select a point by clicking on it. Its color changes to red to show that it is selected.
Now you can drag it around.

• Lock: Allows you to decide whether the points controlling the crest of the waves
should be edited in a locked manner, with the points controlling the troughs of the
waves or conversely, if they are to be edited separately.

• Spline Curve: The control points of the spline curve, that shows the wave
sequence, can be edited by using the cursor. Click on a point and drag it to the
desired position.

To create a wave

1. Create a new group and add the Wave plugin to it.

2. Open the Transformation Editor and set Rotation X to -75.0.

3. Add a material and/or a texture to it.

4. Open the Wave editor and set the following parameters:

• Set Size X and Y to 350.0.

• Set W.-Length to 8.0.

5. Click the Lock button to unlock the spline curve editor.

6. Play with the spline curve handles, Time, Position X and Y values to see how the
wave behaves with different settings.

11.2 PixelFX Plugins
The Lens Flare plugins, which are part of the PixelFX plugins set, simulate the effect of
streaks and spots of light, caused in real cameras when light enters and bounces inside
a camera lens. This plugin set contains geometries that simulate different shapes,
which can be used for lens flare or simple flare effects.

The Flare draws itself as a combination of geometry shader and pixel shader. When a
Flare Container is created a non-editable pixel shader will be added to the created Flair
container.

In addition, the Expert Container plugin is automatically added and configured in
such a way as to cause the shape used to always be seen in front of all other objects,
blending with the rest of the scene to resemble the effect of light bouncing off the lens.

See Also
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• PixelFXLenseFlare

Note: Lens flare plugins reside in their own containers. Applying these plugins to
a container with geometry will overwrite the geometry and disable any shaders in
child containers.

The baseline plugin within this set is the pxLensMulti plugin, which is a container
plugin, whose purpose is to manage other geometry plugins. The one exception in this
set is the pxLensEnergyBolt, which does not simulate lens flare, but rather the effect of
electricity or lightning and it is not managed by pxLensMulti.

The following Geom plugins are housed in the PixelFX folder:

• pxLensEnergyBolt

• Lens Flare Geometries

• pxLensGlowBall

• pxLensGlowSpikes

• pxLensPolyElement

• pxLensRandomPoly

• pxLensSpark

• pxLensStripes

• pxLensRays

11.2.1 pxLensEnergyBolt

 pxLensEnergyBolt produces the effect of electricity-like lightning between two points
in space. These points may be defined manually by entering positions, or by tracking
the positions of other containers. The parameters of Radius, Core, End Caps, Distortion
and N define the effect’s look and Speed defines change rate.

Note: This plugin is located in: Built-ins -> Geom Plugins -> PixelFX
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See Also

• PixelFXLenseFlare

11.2.2 Lens Flare Geometries

The following lens flare plugins are simply different shapes for the composition of final
lens flare effects. Each has its own parameters to define its appearance.

• pxLensGlowBall

• pxLensGlowSpikes

• pxLensPolyElement

• pxLensRandomPoly

• pxLensSpark

• pxLensStripes

Each plugin can in its own right take on very different appearance depending on how
the parameters are adjusted. The best advice for working with these plugins is to
simply play around with the parameter configurations. The following example shows
varying manifestations of the pxLensRandomPoly.

Note: This plugin is located in: Built-ins -> Geom Plugins -> PixelFX

See Also

• PixelFXLenseFlare
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11.2.3 pxLensRays

 pxLensRays can be used to produce the effect of rays. The rays can be static or
move randomly based on the Speed parameter. The shape is defined with the following
parameters:

• Angle

• Width

• Size

• Inner radius

The number or density of the rays is defined by the Rays parameter. Rays can receive
their color from a predefined or user defined gradient ramp, or from an image, by
dragging the image into the Image box.

Note: This plugin is located in: Built-ins -> Geom Plugins -> PixelFX

See Also

• PixelFXLenseFlare

11.3 Primitives
The following Geom plugins are housed in the Primitives folder:

11.3.1 N Quad

 Use this plugin to create a rectangle with different attributes.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Primitives

This section contains information on the following topics:

• N Quad Properties

• To create an N Quad
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N Quad Properties

• Use LOD: Enables/disables dynamic level of detail.

• Tessellation U: Sets the degree of detail.

• Tessellation V: Sets the degree of detail.

• Orientation: Switches the orientation from Top-Bottom to Left-Right.

• Top/Left Width: Sets the width.

• Bottom/Right Width: Sets the width.

• Height/Width: Sets the height.

• Depth: Sets the depth.

• Center X: Switches the center in X between Center, Top and Bottom.

• Center Y: Switches the center in Y between Center, Left and Right.

• Shearing: Sets the shearing value, so the bottom is shifted.

• Image Mapping: May be set to Stretch or Tile.

• Crop Top/Left: Crops the top.

• Crop Bottom/Right: Crops the bottom.

• Border Geometry: Enables/disables the top and bottom border width parameters.
When enabled, only the border outline is visible.

• Top Border Width: Sets the width of the top border.

• Bottom Border Width: Sets the width of the bottom border.

To create an N Quad

1. Create a new group and add the N Quad plugin to it.

2. Add a material and/or a texture to the group.

3. Open the transformation editor and set Rotation X and Z to -45.0.

4. Open the N Quad editor and set the following parameters:

• Set Orientation to Left-Right.

• Set Top/Left Width to 200.0.

• Set Bottom/Right Width to 0.0.
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• Set Height/Width to 300.0.

• Set Depth to 100.0.

• Set Center X and Y to Center and Bottom, respectively.

11.4 RealFX Plugins
The RealFX plugin set enables you to create particle effects in Viz Artist.

See Also

• RealFX in Shader Plugins

• pxColorWorks in Container Plugins

Particle systems are a computer graphics technique to simulate certain physics-based
effects, which are otherwise very hard to reproduce with conventional rendering
techniques. Examples of such effects which are commonly replicated using particle
systems include fire, explosions, smoke, weather effects, sparks, falling leaves, dust,
meteor tails, or abstract visual effects like glowing trails, magic spells, etc.

The particle effects in Viz run in real-time, meaning that there are a few inherent
constraints that must be taken into account when considering best practices for
employing this plugin set. For example, there is a trade-off between the number of
particles and performance optimization; more generally there needs to be a considered
balance between performance and visual quality.

RFxSmoke is the baseline plugin within the RealFX plugin set. The remaining plugins
in this set are applied on top of RFxSmoke in any given container. RFxSmoke includes
built-in functionality and the ability to host the additional functionality contained in the
other plugins in this set. Part of the built-in functionality, e.g. turbulence, is kept for
compatibility with previous version of Viz Artist.

There are three categories of additional plugins:

• Birth plugins: refer to where the particles are spawned

• Motion control plugins: govern the position, direction, velocity, size and color of
each particle

• Texture control plugins: affect the texture mapping and the “look” of each
particle by using pixel shader technology
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RealFX Architecture

The following Geom plugins are housed in the RealFX folder:

• Cloth

• RFxSmoke

11.4.1 Cloth

 Cloth provides a simulation of an elastic vertex system. The vertex system can
be configured with many different parameters. Most of the parameters depend on
each other, and some must be set in conjunction with others. The stress of the system
will be mentioned below, and the rule is that the greater the stress is the greater the
chance is that the system will run amok (unstable). With low stress factors the system
is completely stable.

Adding the Cloth plugin to a container will also add the Expert plugin.

Note: This plugin is located in: Built-ins -> Geom Plugins -> RealFX

This section contains information on the following topics:

• Cloth Properties

• To create a cloth effect
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Cloth Properties

• reinitialize: It is rendering the object from beginning.

• Elastic: Changes the elastic properties of the system. If you set it to 0.1 you will
have a system which will have properties like latex, and at 1.0 more like cloth. When
this factor increases the stress of the system increases.

• dampingFct: Specifies how much speed each vertex should loose. The lower this
factor is the less speed the system will loose. The stress of the system decreases
when this factor increases.

• pause: Pauses all calculations and freezes the system’s animation.

• Tesselation direction U and V: Sets the tesselation in the two directions on the
systems surface. The calculation time needed will increase with more vertices. The
stress of the system also increases slightly when the number of vertices increase.

• Speed: This factor is directly connected to how many calculations needed per
frame. The less calculation done the slower the system will move. You can also
increase the number of calculations and the system will move faster. This factor
does not affect the stability of the system.

• WindX, Y and Z: Three factors combined gives the speed and direction of the wind
affecting the system. If the absolute value of this factor increase then the stress on
the system will also increase.

• TurbulenceSpeed: Three factors combined gives the speed and direction of the
wind affecting the system. If the absolute value of this factor increase then the
stress on the system will also increase.

• TurbulenceFactor: This factor multiplies up the wind speed.

• GravityX, Y and Z: A vector which defines gravity affecting all vertices of the
system. When this factor increases the stress of the system increases.

• Scaling u(width): Changes the width of the rectangle which is including the
animated cloth without increasing the number of triangles.

• Scaling v(height): Changes the height of the animated rectangle which is
including the animated cloth without increasing the number of triangles.

• Draw normals: Shows the normals for each triangle.

• Draw force: Shows the appealing wind in color.
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To create a cloth effect

1. Add the Cloth plugin to a Container.

2. Add a material to the same Container.

3. Set WindX to 2.0.

4. Click the reinitialize button to see the result.

See Also

• Expert

11.4.2 RFxSmoke

 RFxSmoke is the baseline plugin within the RealFX plugin set. It allows you to create
realistic visualization of smoke, fire, explosions and much more (the level of creative
skill is the only limitation). The basic function of the object is that it emits particles
from a point and moves them in some direction until they die or fade away. By using
different texture mappings and settings many effects can be achieved.

Note: This plugin is located in: Built-ins -> Geom Plugins -> RealFX

This section contains information on the following topics:

• RFxSmoke Properties

• Spawn

• Impulse

• Forces

• Size

• Rotation

• Color

• Alpha

RFxSmoke Properties

• Number of particles: Sets the number of particles to be active at the same time.
The number of particles is the product of the Birth Rate and the Life Span, so the
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value should normally not be set higher than that. To the right of the input value
field, you see “required” which is Birth Rate*Life Span. If the value is set much lower
than the required, the particles will create puffballs instead of continuous smoke.

• Birth Rate: Sets the birth rate of particles per second.

• Life Span: Sets the life span of the objects in seconds. The field to the right of
Life Span, allows you to set a percentage, over which the life span of the particles
will vary. If you have set Life Span to 3 and the variation to 50%, the life span of
particles will vary randomly between 1,5 and 4,5 seconds. This will help create more
realism, since particles in real smoke or fire does not have equal life span.

• Reference: Allows you to choose the particles reference to either Container or
World. If Container is chosen, after being emitted the particles will relate their
position to the containers position. If you move the emitter object, the particles will
alter their position correspondingly. If World is chosen, the particles will maintain
their position and path even if the emitter is moved, they have their own world
coordinates.

• Billboard: If you enable billboarding for the particles, the particles will maintain a
frontal position against the camera when it moves.

• Sort: Lets you switch sorting on/off.

• Array: Enables/disables the use of array.

• Reset Particles: Clicking this button removes all the particles already emitted.

• Show Forces: Enabling this option displays “help lines” that shows the forces
settings of some of the parameters.

• Freeze Motion: Halts the emitting process.

Spawn

Opens a section of parameters related to the position of the smoke emitter. You can
define the shape and size of the area in which the emitter should emit the particles.

• Type: The buttons Cube, Sphere, Container and Image allows you to set whether
the spawn area should be shaped as a Cube or a Sphere or if a container or image
should be used.

• Size: The X-, Y- and Z-values sets the size of the selected form. If you have
selected Sphere and you set only the X-value, the emitter will create particles while
it moves randomly along a line. If you set an Y-value in addition, the emitter will
move within a circle, and finally if you set a Z-value, within a sphere. If you have
selected a Cube the same applies but the stages would then be a line, a rectangle
and a Cube.

• Spawn Range: Sets the range within the sphere or cube, the emitter should use
for distributing the particles. Default is 100% where it uses the whole spawn area. If
you reduce the value, a section starting from the middle of the spawn area, where
no particles are being emitted, will increase correspondingly. If the value is set to
1%, the emitter only emits particles at the outer edge or surface of the cube or
sphere.
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Container is especially valuable when animating a scene as the smoke will be emitted
from the outline of an animated container. To set the container you want the smoke to
be emitted from, drag it from the scene tree onto the drop zone.

Note: A container must be 2D, such as a rectangle, circle, square, etc.

To learn more about animation see Creating Animations .

Impulse

Opens a sub section where you can set parameters on how particles are emitted.

• Speed: Sets the speed the particles have when the are being emitted. The field to
the right of Speed, allows you to set a percentage over which the particle speed will
vary

• Rot X: Sets the X-axis angle of the “opening” in the emitter, the emitter hole.

• Rot Z: Sets the Z-axis angle of the “opening” in the emitter, the emitter hole.

• Angle X: Sets the X-axis opening angle of the emitter hole. It can be done locked
with the Z-axis, or independently. The button to the right of the value field enables/
disables locking of the axes.

• Angle Z: Sets the Z-axis opening angle of the emitter hole.

• Twist creates a twist of the opening angels of the emitter hole. It can also be
described as a rotation of the emitter around the Y-axis.

• Align to Center: Disables all the above impulse parameters and aligns the
particles above the emitter.

Forces

Opens a sub section with parameters for creating environmental effects, like wind,
gravity and air resistance.

• Gravity: Sets the degree of gravity affecting the path of the particles. If it is set
high, the smoke will go downwards. With a negative gravity the particles will rise
faster.

• Air Resistance: Sets the degree of air resistance. It creates a force that, to a level
you define, prevents the particles from rising.
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• Turbulence X, Y and Z: Allows you to define a simulation of turbulence on the
particles as they rise. The turbulence effect is achieved through a jittering of the
particles. The X-, Y- and Z-values set the axis of the jittering movement.

• Wind Force: Sets a level cross wind. A positive value makes it blowing from the left
to towards the right, a negative the other way around. Use the two next parameters
to adjust the angle of the wind, if you do not want a horizontal wind force.

• Wind Rot X: Sets the rotation of the wind force on the X-axis. Altering this value
and the value below, will change the direction of the wind defined in the Wind
Force.

• Wind Rot Z: Sets the rotation of the wind force on the Z-axis

Size

Opens a section with parameters to the size of the particles at the moment of their
birth and death. Between the time of birth and death, the size is a product of a linear
interpolation.

• Size Birth X and Y: Sets the size of each particle at the time it is being emitted.

• Size Death X and Y: Sets the size of each of the particle at the time it fades away
and dies.

Rotation

Opens a section where you can define a static rotated position or a spin of the
particles. Both the static rotated position and the spin can either be set as an offset
equal on all particles or as a range where the particles will be rotated or span randomly.
To easily see the effect, set the number of particles to a very low value and alter the
rotation parameters.

• Initial Offset: Sets the degree of rotation the particles should have. This rotated
position is static and will remain throughout the life of each particle.

• Initial Range: Sets a degree range of rotation the particles should have. This
rotated position is static and will remain throughout the life of each particle. If for
example the value 30 is set, the static rotated position of the particles will vary
randomly between 30° and -30°.

• Spin Offset: Sets the degree of spin each particle should have throughout its life
time. The higher the value, the higher the number of spins. A positive value creates
an counterclockwise rotation, a negative creates a clockwise.

• Spin Range: Sets a spin degree range for the particles. They will spin randomly
between the parameter value and the same value mirrored through zero.
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• Follow Path: If the RFxSmoke object is animated, enabling this option will make the
particles align their position to the animation path in the same way as is the case
with the follow path option in the transformation editor.

Color

Allows you to set the color of the particles throughout their life cycle. The particles can
be set to change their color through stages from their birth to their death by adding
more key frames (single click the color stage).

The left side of the color stage is at birth time and the right is at death time. By default
there are two color key frames at each end that you can click on to set their color. The
color range between two key frames will be an interpolated transformation. More key
frames can be added to create a more complex color transformation between particles
birth and death.

Delete color key frames by selecting them and pressing the <Delete> or <Backspace>
button on the keyboard.

Alpha

Allows you to set the alpha values of the particles throughout their life cycle. The alpha
editor contains a curve with points that you can move in both X and Y directions to
change the form of the curve. The X-axis is the life time of the particles and the Y-axis
is the alpha value.

Select a point, or create a new one by left-clicking on the graph, and drag the point to
the desired X and Y position. Delete a point by selecting it and pressing the <Delete>
button on the keyboard.

11.5 Ticker
The following Geometry plugins are housed in the Ticker folder:

• Scroller

11.5.1 Scroller

 The Scroller plugin is a geometry plugin, mostly used for creating scrolling tickers,
that generates a dynamic line of scrolling elements.
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When used with Viz Ticker 3D the scene is designed as a transition logic scene
where each data element is an instance of a scene template designed as part of the
background scene. This is unlike traditional transition logic scenes where each data
element would be based on a specific foreground scene controlled by the background
scene. Based on the scene template that resides with the background scene the
Scroller is able to construct and configure the scene templates on demand for Viz
Ticker 3D that manages and reuse them.

To design a scrolling carousel, the Scroller and one or more scene templates must
be added to the background scene. The scene templates serve as prototypes for the
containers that the Scroller plugin generates. Alignment of the generated containers is
done by editing the alignment of the scene templates.

Note: Before saving a Scroller scene, remember to hide the scene template’s
containers, otherwise the scene template will show on-screen.

Note: This plugin is located in: Built-ins -> Geom Plugins -> Ticker

This section also contains information on the following topics:

• Scroller Properties

• Global Conventions

• Scrolling Carousel Conventions

• Flipping Carousel Conventions

• Logo Animations as Flipping Carousels

Scroller Properties

• Element Source: Element descriptions are added here. Either descriptions are
entered in the element source syntax, or they are put in the name of a Shared
Memory segment that uses the Shared Memory protocol. When designing and
testing a scene, the element source syntax is used to make the system scroll
instances of the design containers.

• Show Advanced: Displays additional parameters.

• Layer: Defines the layer name for the scroller. The layer name must be identical to
the name of the director that holds the in and out stop points for the carousel.
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• Mode: Defines if elements should be shown as scrolling or flipping elements for
scrolling and flipping carousels, respectively.

• Direction: Defines the direction of the scroller.

• Scroll Region Width: Defines the width of the scroller. This option is only relevant
for left-to-right/right-to-left scrollers.

• Scroll Region Height: Defines the height of the scroller. This option is only
relevant for up-down/down-up scrollers.

• Scroll Speed: Defines the speed of the scroller. The x position of the scrolling
elements will be decremented with this value for each frame that passes.

• Padding: Defines an extra padding value that will be added to the width of the
bounding box of an element when calculating the spacing between the elements.
Negative padding can be used to make elements overlap.

• Show Bounds: If enabled, the area in which the scroller tries to maintain the
illusion of a continuously scrolling flow of elements is visible on-screen.

• Active: Scrolling or flipping is available when enabled.

• Preload Cache: Use this on machines without ringbuffer to move all spike-
load related to element creation to the initialization phase. Designs named
DESIGN_whatever_Xnnn will get nnn (where nnn is an integer) precreated instances.

• Reinitialize: Reinitializes the plugin by deleting all cached objects and
reconstructing the initial node structure. This parameter can be used to update the
scroller after changing for example the element source.

• Clear: Clears all current ticker elements in the rendering window.

• Trigger: Triggers the director named in the Trigger Director field provided that there
are elements in queue to be scrolled in. If no director is specified then the scroller is
activated.

Global Conventions

Ticker carousels are created in Viz Artist as scenes. The following design conventions
apply for all carousels (both scrolling and flipping):

• Control Plugins: Elements that should be modified in Viz Ticker Client must have
control plugins attached. The Control Object plugin must be added to the template
root container, while additional Control plugins should be added to Sub-Containers.

Tip: If text should be edited add the Control Text plugin to the text container.

• States: Carousels must have one out state, and at least one in state. The in state
means that the graphics is visible on-screen, while the out state means that the
graphics is positioned outside the visual bounds.

The scene can have multiple stop points that define the out state, but they must all be
named O, as there is only one out state.

• Horizontal Alignment: The horizontal alignment of carousel templates can be
set to either left, right, top, or bottom. Leftward scrolling should be left centered,
rightward scrolling should be right centered, upward scrolling should be top
centered, and downward scrolling should be bottom centered.

A ticker with Arabic text should typically be right centered, as Arabic is a right-to-left
language.
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Scrolling Carousel Conventions

The following design conventions apply only for scrolling carousel scenes.

Scrolling carousel scenes are characterized by containing one or more Scroller plugins
with belonging directors and stop points.

A scrolling carousel scene must be designed according to the following conventions:

• The Layer setting in the Scroller plugin editor must be identical to the director
holding the in and out stop points.

• The Element Source in the Scroller plugin editor must be identical to the in state
stop point of the layer director.

• The out state stop point of the layer director must be named the letter O. All other
states are in state stop points.

• All template containers must be organized under a root container called
ticker_templates. It is important to position the ticker_templates container at the
top of the root level of the scene tree, as Viz Engine performs a depth-first search
when identifying containers. This means that the system starts with the first root
container, and searches through all of its Sub-Containers, before moving on to the
second root container, and so on. Keeping template containers high up in the tree
structure improves performance.

• Do not add any containers under the container holding the Scroller plugin. The
scroller generates its own tree structure with copies of the template containers.

Flipping Carousel Conventions

The following design conventions apply only for flipping carousel scenes.

Flipping carousel scenes are characterized by containing one or more Toggle plugins
with belonging directors and stop points.

A flipping carousel scene must be designed according to the following conventions:

• The background scene and the scene templates (foreground scenes) must be built
as separate scenes.

• All flipping carousel template scenes must have a root container named object.

• The container holding the Toggle plugin must have the same name as the director
holding the in and out stop points.

• In the Control Object editor for each foreground scene (scene template), the Layer
Identifier must be identical to the director holding the in and out stop points in the
background scene.

• Also in the Control Object editor in the foreground scene, the State Identifier must
be identical to an in state stop point of the layer identifier director.

Logo Animations as Flipping Carousels

To create a logo animation, create a flipping carousel. While a regular flipping carousel
is equipped with multiple template elements, a logo animation is only equipped with
one. The ON and OFF buttons in Viz Ticker Client will animate the logo in and out.

See Also

• Control plugins

• Toggle plugin
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• Transition Logic

11.6 Vizual Data Tools
The following Geometry plugins are housed in the Vizual Data Tools folder:

• Overview

• Area Chart

• Bar Chart

• Line Chart

• Pie Chart

• Scatter Chart

• Stock Chart

See Also

• Data Fit

• Data Import

• Data Label

• Data Storage

• Tutorial on www.vizrt.com under the Training section

11.6.1 Overview

Viz Vizual Data Tools (VDT) were designed for Viz Artist to show any kind of statistic
data in the best fitting way. All plugins use the same transport channel: Viz Artist
Shared Memory. Shared Memory is a map holding user-defined variables indexed by a
string – this is also known as a key-value pair.

There are 3 types of Shared Memory Maps – the difference between them is their
distribution location:

• Scene

• Local - (local engine, data sharing between scenes in different layers)

• Distributed - Shared Memory (share data between engines connected to the same
GH)

The key-value pairs of Shared Memory can be accessed via UDP (external control
applications), Viz commands, Viz plugin API and Viz Scripting language (refer to
the Script documentation, section Data Sharing for more details). Shared Memory
contains functionality which allows you to register for value changes. VDT is using this
functionality which means that if a value in the shared memory map is changed the
chart which is registered to the certain shared memory key immediately redraws itself.

For example there could be a control PC running a Viz Content Pilot template that
sends stock prices to a Viz Engine for displaying the data as a stock chart using SDI
output and to another one using HD video output. The data has to be sent only once.
If you run a 3D stereoscopic render system with two engines you can also just send
the data to one engine. Another way this could be used would be to show data on each
renderer in a different chart type.
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The VDT plugin suite consists of Geometry Plugins and Container Plugins. The
geometry part is responsible for drawing the chart itself while the container plugins are
used for chart labeling, data scaling, and so on.

To learn more about the use of Vizual Data Tools you can download a tutorial on
www.vizrt.com under the Training section.

See Also

• Container Plugins

• Geometry Plugins

• Scripting

• Scripting Data Types and Procedures

11.6.2 Area Chart

 This plugin draws an area chart, filled with data out of a Shared Memory Map. You
can use delimited strings or arrays for data transfer via Scene-, Global- or Distributed-
Shared Memory.

Note: This plugin is located in: Built-ins -> Geom Plugins -> VizualDataTools

This section contains information on the following topics:

• Area Chart Properties

• To create a scene using area chart

Area Chart Properties

• Shared Mem.: Changes between Scene-, Global- and Distributed-Shared Memory.
Use Inactive memory to not forward any values via Shared Memory.

• Specify X Values: Enables DataX input.

• Key DataX: Shared Mem. key name for X values.

• DataX: Parameter for X values if Shared Memory is set to Inactive.

• Key DataY: Shared Mem. key name for Y values.

• DataY: Parameter for Y values if Shared Memory is set to Inactive.

• Transfer Mode: Sets string- or array-based data transfer. Not available when set
shared memory is set to Inactive.

• Data Delim.: Defines the value separator sign(s).

• DataX, -Y Fit: Enables data normalization.

• DataX, -Y Scale: Scales input by the selected factor.

• DataX, -Y Offset: Adds an offset to the incoming data.

• DataX, -Y Auto Scale: Enables automatic data normalization.

• DataX, Y Fit Size: Total scales the whole chart to the defined borders. Current
scales the current chart segment to the set borders.

• DataX, -Y Detect Limits: Detects minimum and maximum of all values and scales
them to adjusted Start and Stop. This option is used to upscale the interesting part
of the chart - especially if there are only little changes between the data values.
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• DataX, -Y Threshold: Adds a definable offset to the detected limit.

• DataX, -Y Start: Lower Auto Scale edge.

• DataX, -Y Stop: Upper Auto Scale edge.

• Horizontal Alignment: Sets horizontal orientation to left, center or right.

• Type: Creates different graph looks. Available options are Normal, Spline, Staircase
and Constrained Spline.

• Normal: Enables direct connections between entered values.

• Spline: Interpolates extra values to chamfer the graph.

• Staircase: Creates a staircase look.

• Constrained Spline: Same as Spline mode but with a different algorithm to
prevent overshooting.

• Stair Width: Defines width for a single stair or for all stairs if Specify X Values is
activated.

• Chart Width: Adjusts the chart width.

• Chart Depth: Adjusts extrusion.

• Tessellation Width: Sets tessellation in Spline mode.

• Selection: Specifies Start- and Stop-type.

• Relative: 0%: 100%.

• Absolute: depends on your specified data.

• ID: Value ID starting from 0.

• Start[%, abs, #]: Graph’s starting point.

• Stop[%, abs, #]: Graph’s stopping point.

• Reposition Start: Translates the whole chart always to the same starting point
independent of varying Start and Stop positions.

• Bevel: Activates Bevel mode.

• Bevel Bottom: Chamfer the chart’s bottom.

• Bevel Size: Adjusts bevel’s size.

• Bevel Steps: Sets roundness via the number of segmentation steps.

Note: A chamfer is a beveled edge connecting two surfaces.

• RelativeMapping: Stretches texture to fit graph width.

• Pos. Container: Translates every child container to a bar’s top.

• Container Offset: Adds a certain offset to each container.

• Container Offset Z: Adds a Z Axis offset to each container.

• Center Container: Centers each translated container.

• Pointers Shared Mem.: Select the map where the pointer values should be
distributed to.

• Key Data Pointers: Define Shared Memory Keyname.

• Pointer: Activates the Pointer.

• Container: Define Container which should be used as pointer.

• Selection: Choose navigation type.

• Position[%, abs, #]: Sets pointer position in dependency of the selected
navigation type.
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• Offset: Define pointer offset from the chart.

• Normal Offset: Rotate offset to the direction of the current surface normal.

• Rotate: Rotate the pointer to the direction of the current surface normal.

• Offset Z: Add an additional Z offset to the pointer container.

• Center Container: Center Container - useful for varying pointer sizes.

• Low Pointer: Activates the low pointer.

• Container: Choose a container for the pointer.

• High Pointer: Activates the high pointer.

• Container: Choose a container for the pointer.

• Start Pointer: Activates the Start Pointer.

• Container: Choose a container for the pointer.

• Stop Pointer: Activates the stop pointer.

• Container: Choose a container for the pointer.

To create a scene using area chart

1. Create a new group and add the Area Chart plugin to it.

2. Open the Transformation Editor and set Position X and Y to -100.0 and Rotation Y
to -25.0.

3. Add a material and/or a texture to it.

4. Open the Area Chart editor and set the following parameters:

• Set the following DataY values: 10,20,30,20,50,60,80,45,20.

• Set Type to Spline.

• Set Width to 200.0.

• Set Depth to 30.0.

To create a scene using area chart and data storage

1. Create a new group and add the Area Chart plugin to it.

2. Add the Data Storage plugin to the same container as Area Chart.

• The plugin will automatically jump to your Area Chart container.

3. Select your Area Chart plugin, and set the SharedMem. parameter to Scene.

4. Rename the Key Data Y parameter to MyDataY.

5. Open the Data Storage editor and enter the same key name for Key Data1
as you just did in the Area Chart plugin to MyDataY, and set the SharedMem.
parameter to Scene.

6. Go to the Data1 parameter in the Data Storage plugin and type the following text
sequence into the text field. 10,40,50,20,80,90,60,50.

• While you are typing you can see the graph already growing. We are using “,” as
a delimiter sign which is the decimal sign in some countries. But you can use any



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 605

delimiter you want. Just go to the chart plugin, AreaChart in our case, and set Data
Delim. to the desired sign.

See Also

• Control Chart

• Data Fit

• Data Import

• Data Label

• Data Storage

11.6.3 Bar Chart

 This plugin draws a bar chart, filled with data out of a Shared Memory Map. You
can use delimited strings or arrays for data transfer via Scene-, Global- or Distributed-
Shared Memory.

Note: This plugin is located in: Built-ins -> Geom Plugins -> VizualDataTools

This section contains information on the following topics:

• Bar Chart Properties

• To create a bar chart

Bar Chart Properties

• Shared Mem.: Changes between Scene-, Global- and Distributed-Shared Memory.
Use Inactive memory to not forward any values via Shared Memory.

• Data: Shared Mem. key name.

• Data: Input parameter for data.

• Transfer Mode: Sets string- or array-based data transfer.
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• Data Delim.: Defines the value separator sign(s).

• Data Fit: Enables data normalization.

• Data Scale: Scales input by the selected factor.

• Data Offset: Adds an offset to the incoming data.

• Data Auto Scale: Enables automatic data normalization.

• Data Fit Size: Scales complete chart in dependency of the defined Start and Stop
settings (total) or scales the Current chart segment to the set borders.

• Data Detect Limits: Detects minimum and maximum of all values and scales
them to adjusted Start and Stop.

• Data Threshold: Adds a definable offset to the detected limit.

• Data Start: Lower Auto Scale edge.

• Data Stop: Upper Auto Scale edge.

• Compare: Specify another BarChart for comparison. You have to set this parameter
also in the other chart(s) so that each chart can react on changes of the other(s).

• Horizontal alignment: Sets horizontal orientation to left, center or right.

• Corners: Sets the bar’s corners.

• Chart Width: Defines width for a single bar or for all bars.

• Bar Width: Value of the previous parameter.

• Max Width: This setting can be used to allow bars to grow only to a certain width.

• Bar Gap RatioMax. Width: This setting can be used to allow bars to grow only to
a certain width.

• Depth: Defines if the bar depth should equal its width or lets you set a custom
depth.

• Bar Depth: Adjusts bar depth in custom depth mode.

• Bar Thickness[%]: Adjusts the gap between the single bars, 0% means no gap.

• Draw Zero: If the bar’s value is equivalent to 0 than there will be drawn a very flat
bar instead of nothing.

• Tesselation Length: Tesselates bar length.

• Progress Mode:

• Bars: Each bar grows to its value

• Chart: The whole chart grows horizontally and the incoming bars already have their
final height.

• Relative Length: If activated, each bar will have its own 100% length (e.g. 7 bars
equal 700%).

• Const. Speed: Sets the same animation duration for each bar.

• Start[%]: Graph’s starting point

• Stop[%]: Graph’s stop point

• Bevel: Activates Bevel mode.

• Bevel Top: Chamfer bar’s top.

• Bevel Bottom: Chamfer bar’s bottom.

• Bevel Size[%]: Adjusts bevel’s size from 0 to 100.

• Bevel Steps: Sets roundness via the number of segmentation steps.

Note: A chamfer is a beveled edge connecting two surfaces.
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• Pos. Container: Translates every child container to a bar’s top.

• Container Offset: Adds a certain offset to each container.

• Container Offset X: Adds a X Axis offset to each container.

• Container Offset Y: Adds a Y Axis offset to each container.

• Container Offset Z: Adds a Z Axis offset to each container.

• Center Container: Centers each translated container.

• Size Compensation: This option can be used to reposition containers if the can
change their size. E.g. Text geometries used as chart labels. The labels will vary in
their width which requires a repositioning if a horizontal BarChart (rotated 90 deg) is
used.

• None: Container size compensation inactive.

• Width: Compensates with changes.

• Height: Compensates height changes.

• Map: Calculates texture coordinates for all bars, a single bar or defines vertex
colors instead. Colors can be set individually for each bar or value dependent (+/-
color). In the Color +/- mode you can override value dependent colors.

• Color ID: Moves between the available vertex colors.

• Color: Choose color for the current ID.

• Positive: Choose color for positive values.

• Negative: Choose color for negative values.

• Color Override: Activates or deactivates overriding of a positive or negative color
with a defined alternative color.

To create a bar chart

1. Create a new group and add the Bar Chart plugin to it.

2. Open the Transformation Editor and set Position X and Y to -100.0 and Rotation Y
to -25.0.

3. Add a material and/or a texture to it.

4. Open the Bar Chart editor and set the following parameters:

• Set the following DataY values: 10,20,30,20,50,60,80,45,20.

• Set Corners to 3.

• Set Bar Width to 20.0.

• Set Bar Gap Ratio[%] to 10.0.

See Also

• Control Chart

• Data Fit

• Data Import

• Data Label
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• Data Storage

• Presenter

11.6.4 Line Chart

 This plugin draws a line chart, filled with data out of a Shared Memory Map. You
can use delimited strings or arrays for data transfer via Scene-, Global- or Distributed-
Shared Memory.

Note: This plugin is located in: Built-ins -> Geom Plugins -> VizualDataTools

This section contains information on the following topics:

• Line Chart Properties

• To create a line chart

Line Chart Properties

• Shared Mem.: Changes between Scene-, Global- and Distributed-Shared Memory.
Use Inactive memory to not forward any values via Shared Memory.

• Specify X Values: Enables DataX input.

• DataX: Shared Mem. key name for X values. DataX is the default input parameter
for X values.

• Key DataX: Shared Mem. key name for X values.

• DataY: Shared Mem. key name for Y values. DataY is the default input parameter
for Y values.

• Key DataY: Shared Mem. key name for Y values.

• Transfer Mode: Sets string- or array-based data transfer.

• Data Delim.: Defines the value separator sign(s).

• DataX, -Y Fit: Enables data normalization.

• DataX, -Y Scale: Scales input by the selected factor.

• DataX, -Y Offset: Adds an offset to the incoming data.

• DataX, -Y Auto Scale: Enables automatic data normalization.

• DataX, -Y Fit Size: Total: Scales the whole chart to the defined borders. Current:
Scales the current chart segment to the set borders.

• DataX, -Y Detect Limits: Detects minimum and maximum of all values and scales
them to adjusted Start and Stop. This option is used to upscale the interesting part
of a chart - especially if there are only little changes between the data values.

• DataX, -Y Threshold: Adds a definable offset to the detected limit.

• DataX, -Y Start: Lower Auto Scale edge.

• DataX, -Y Stop: Upper Auto Scale edge.

• Horizontal Alignment: Sets horizontal orientation to left, center or right.

• Line Type:

• Normal: direct connections between entered values.

• Spline: interpolates extra values to chamfer the graph.
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• Constrained Spline: Same as Spline mode but with a different algorithm to
prevent overshooting.

• Chart Width: Adjust line width (0 for 2D mode).

• Tesselation Width: Sets tesselation length in spline modes.

• Thickness: Adjusts line thickness (0 for 2D mode).

• Depth: Adjust line depth (0 for 2D mode).

• Tesselation Thickness: Tesselates line thickness.

• Tesselation Depth: Tesselates line depth.

• Const. Thickness: Builds the geometry with a constant width.

• Miter: Applies a miter cut-off to avoid huge peaks for small data point angles.

• Selection: Specifies Start- and Stop-type. Relative: 0%: 100%. Absolute: depends
on your specified data. ID: Value ID starting from 0.

• Start[%, abs, #]: Graph’ starting point.

• Stop[%, abs, #]: Graph’s stop point.

• Reposition Start: Translates the whole chart always to the same starting point.

• Bevel: Activates Bevel mode.

• Bevel Start: Chamfer start.

• Bevel Stop: Chamfer stop.

• Bevel Size[%]: Adjusts bevel’s size from 0 to 100.

• Bevel Steps: Sets roundness via the number of segmentation steps.

Note: A chamfer is a beveled edge connecting two surfaces.

• RelativeMapping: Stretches texture to fit graph length.

• Pos. Container: Translates every child container to a bar’s top.

• Container Offset: Adds a certain offset to each container.

• Value Dependent Pos.: Translates the container above or below the line in
dependency on the data values.

• Container Offset Z: Adds a Z axis offset to each container.

• Center Container: Centers each translated container.

• Pointer: You can use a container as a pointer and move it along the chart’s shape.

• Container: This container represents your pointer.

• Selection: Specifies the position-type. Relative: 0%: 100%. Absolute: depends on
your specified data. ID: Value ID starting from 0.

• Position[%, abs, #]: The pointer is translated by this parameter.

• Offset: Adds an offset to the container’s position.

• Normal Offset: Rotates the offset so that it is perpendicular to the chart’s surface.

• Rotate: Rotates the container in dependency on the chart’s shape.

• Offset Z: Adds a Z axis offset to the pointer.

• Center Container: Use the container’s center for translation and rotation.

• Low Pointer: Activates the low pointer.

• Container: Choose a container for the pointer.

• High Pointer: Activates the high pointer.
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• Container: Choose a container for the pointer.

• Start Pointer: Activates the Start Pointer.

• Container: Choose a container for the pointer.

• Stop Pointer: Activates the stop pointer.

• Container: Choose a container for the pointer.

To create a line chart

1. Create a new group and add the Line Chart plugin to it.

2. Open the Transformation Editor and set Position X and Y to -100.0 and
Rotation Y to -25.0.

3. Add a material and/or a texture to it.

4. Open the Line Chart editor and set the following parameters:

• Set Shared Mem. to Inactive

• Set the following DataY values: 10,20,30,20,50,60,80,45,20

• Set Line Type to Spline

• Set Chart Width to 250.0

• Set Depth to 10.0

• Enable Bevel, Bevel Start, Bevel Stop

• Set Bevel Size[%] to 100.0

• Set Bevel Steps to 10.0

See Also

• Control Chart

• Data Fit

• Data Import

• Data Label

• Data Storage

11.6.5 Pie Chart

 This plugin draws a pie chart, filled with data out of a Shared Memory Map. You
can use delimited strings or arrays for data transfer via Scene-, Global- or Distributed-
Shared Memory.

Note: This plugin is located in: Built-ins -> Geom Plugins -> VizualDataTools

This section contains information on the following topics:

• Pie Chart Properties

• To create a pie chart
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Pie Chart Properties

• Shared Mem.: Changes between Scene-, Global- and Distributed-Shared Memory.
Use Inactive memory to not forward any values via Shared Memory.

• Data: Shared Mem. key name. Data is the default input parameter.

• Transfer Mode: Sets string- or array-based data transfer.

• Data Delim.: Defines the value separator sign(s).

• Data Fit: Enables data normalization.

• Data Offset: Adds an offset to the incoming data.

• Diameter: Sets pie’s size.

• Total Segment[deg]: Set"s the pie’s maximum angle in degrees (default: 100%
are equal to 360 degrees).

• Inner Cutoff: Cuts off a round piece from the cake’s center.

• Height: Adjust height.

• Corners: Defines the minimum amount of corners at the pie’s edge. In dependency
on the number of pieces an algorithm adds corners to give the cake always the
same appearance.

• Keep Proportions: If enabled, the cake would look like a real one. Otherwise each
piece’s radius is recalculated.

• Const. Offset: Sets a constant gap width.

• Center Offset: Every pieces’ distance from the pie’s center.

• Piece Scaling: All: All pieces equal 100%. Single: Every piece’s size is described by
it's own 100% (e.g. 3 pieces mean 300%). Fit: All pieces equal 100%, but they are
scaled relatively to fit their new area with the correct values.

• Piece Size[%]: Parameter for the previous option.

• Bevel: Activates Bevel mode.

• Bevel Top: Chamfer cake’s top.

• Bevel Bottom: Chamfer pie’s bottom.

• Bevel Size[%]: Adjusts bevel’s size from 0 to 100.

• Bevel Steps: Sets roundness via the number of segmentation steps.

• Move Piece: Defines the piece for the next parameter operation. Starts with 0, -1
means nothing selected.

• Center Offset: Additional center shift for a certain piece.

• Height Offset: Additional height shift for a certain piece.

• Effect Range: Sets the range of pieces to move.

• Effect Distribution: Sets the distribution of the effect range.

• Pos. Container: Translates every child container to a piece of cake.

• Container Offset: Adds a certain center offset to each container.

• Center Container: Centers each translated container.

• PosX, Y, Z: Activates container translation on the particular axis.

• Container Pos. Z[%]: Sets the relative position on the z axis for each child
container.

• Map:
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• Color Bar: Sets a single color (V texture coordinate) for a certain piece (e.g. 3
pieces: V = 0.0, V = 0.5 and V = 1.0).

• Vertex: Use vertex colors for each piece starting with ID 0. Color ID moves
between the available vertex colors. Color lets you choose color for the current ID.

Note: A chamfer is a beveled edge connecting two surfaces.

To create a pie chart

1. Create a new group and add the Pie Chart plugin to it.

2. Open the Transformation Editor and set Position X and Y to -100.0 and Rotation Y
to -25.0.

3. Add a material and/or a texture to it.

4. Open the Pie Chart editor and set the following parameters:

• Set the following DataY values: 10,20,30,20,50,60,80,45,20.

• Enable Keep Proportions.

• Set Center Offset to 6.0.

• Set Move Piece to 1.

• Set Center and Height Offset to 20.0.

• Enable Vertex and set different colors for all Color IDs.

See Also

• Control Pie

• Data Fit

• Data Import

• Data Label

• Data Storage

• Presenter

11.6.6 Scatter Chart

 This plugin draws a scatter chart, filled with data out of a Shared Memory Map. You
can use delimited strings or arrays for data transfer via Scene-, Global- or Distributed-
Shared Memory.

Note: This plugin is located in: Built-ins -> Geom Plugins -> VizualDataTools

This section contains information on the following topics:

• Scatter Chart Properties
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• To create a scatter chart

Scatter Chart Properties

• Shared Mem.: Changes between Scene-, Global- and Distributed-Shared Memory.
Use Inactive memory to not forward any values via Shared Memory.

• Key DataX: Shared Mem. key name for X values. DataX is the default input
parameter for X values.

• Key DataY: Shared Mem. key name for Y values. DataY is the default input
parameter for Y values.

• Key DataZ: Shared Mem. key name for Z values. DataZ is the default input
parameter for Z values.

• Transfer Mode: Sets string- or array-based data transfer.

• Data Delim.: Defines the value separator sign(s).

• DataX, -Y, -Z Fit: Enables data normalization.

• DataX, -Y, -Z Scale: Scales input by the selected factor.

• DataX, -Y, -Z Offset: Adds an offset to the incoming data.

• DataX, -Y, -Z Auto Scale: Enables automatic data normalization.

• DataX, -Y, -Z Detect Limits: Detects minimum and maximum of all values and
scales them to adjusted Start and Stop.

• DataX, -Y, -Z Threshold: Adds a definable offset to the detected limit.

• DataX, -Y, -Z Start: Lower Auto Scale edge.

• DataX, -Y, -Z Stop: Upper Auto Scale edge.

• Horizontal Alignment: Sets horizontal orientation to left, center or right

• Chart Width: Adjusts the chart width.

• Container: Drag drop the container which will be used for the scatter nodes.

• DataZ Position: Use DataZ for Z-axis positioning.

• DataZ SizeX: Z Values influence X scaling.
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• DataZ SizeY: Z Values influence Y scaling.

• DataZ SizeZ: Z Values influence Z scaling.

• Center Container: Centers each translated container.

• Fit Width: Considers the width of the scatter node containers which means that the
containers do not reach outside of the specified range.

• Animate Position: Sets the translation type: None: no animation, Y: animates
the container along the Y axis (suggestion: Scale Y + DataLabel for BarChart alike
labeling).

• Animate Scaling: Sets the scaling type: None: no scaling at all, XYZ: linear scaling
in all directions, Y: scales in y direction only (->BarChart)

• Relative Length: If activated, each scatter node will have its own 100% size (e.g. 7
nodes equal 700%).

• Const. Speed: Sets the same animation duration for each bar.

• Total Length[%]: Sets the accumulated size of all scatter nodes in percent.

To create a scatter chart

1. Create a group and add the Sphere plugin to it.

2. Open the transformation editor and set the Scaling (locked) to 0.2.

3. Add a material and/or a texture to the sphere.

4. Set the group with the sphere to hidden.

5. Create a new group and add the Scatter Chart plugin to it.

6. Open the Transformation Editor and set Position X and Y to -100.0.

7. Open the Scatter Chart editor and set the following parameters:

• Set the following DataY values: 10,20,30,20,50,60,80,45,20.

• Set Width to 250.0.

• Drag and drop the container with the Sphere to the Container placeholder.

See Also

• Control Chart

• Data Fit

• Data Import

• Data Label

• Data Storage
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11.6.7 Stock Chart

 This plugin draws a stock chart, filled with data out of a Shared Memory Map. You
can use delimited strings or arrays for data transfer via Scene-, Global- or Distributed-
Shared Memory.

Note: This plugin is located in: Built-ins -> Geom Plugins -> VizualDataTools

This section contains information on the following topics:

• Stock Chart Properties

• To create a stock chart

Stock Chart Properties

• Shared Mem.: Changes between Scene-, Global- and Distributed-Shared Memory.
Use Inactive memory to not forward any values via Shared Memory.

• Key Open: Shared Mem. key name for open values. DataOpen is the default input
parameter for open values.

• Key Close: Shared Mem. key name for close values. DataClose is the default input
parameter for close values.

• Key High: Shared Mem. key name for high values. DataHigh is the default input
parameter for high values.
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• Key Low: Shared Mem. key name for low values. DataLow is the default input
parameter for low values.

• Transfer Mode: Sets string- or array-based data transfer.

• Data Delim.: Defines the value separator sign(s).

• Data Open, -Close, -High, -Low Fit: Enables data normalization.

• Data Open, -Close, -High, -Low Scale: Scales input by the selected factor.

• Data Open, -Close, -High, -Low Offset: Adds an offset to the incoming data.

• Data Auto Scale: Enables automatic data normalization.

• Data Detect Limits: Detects minimum and maximum of all values and scales
them to adjusted Start and Stop.

• Data Start: Lower Auto Scale edge.

• Data Stop: Upper Auto Scale edge.

• Draw Open: Draws open data.

• Draw Close: Draws close data.

• Draw High: Draws high data.

• Draw Low: Draws low data.

• Candle Corners: Sets candle segments.

• Wick Corners: Sets wick corners.

• Width Scaling: Single Candle: Adjust size for a single candle. Fit: Adjust all candles
to fit a certain width.

• Candle Width: Value for the previous parameter.

• Candle Gap Ratio[%]: 100% means that the gaps have the same size as the
candles.

• Candle Wick Ratio[%]: 100% means that the wicks have the same size as the
candles.

• Bevel Candle: Activates Bevel mode for the candle geometry.

• Bevel Candle Top: Chamfer candle’s top.

• Bevel Candle Bottom: Chamfer candle’s bottom.

• Bevel Candle Size[%]: Adjusts bevel’s size from 0 to 100.

• Bevel Candle Steps: Sets roundness via the number of segmentation steps.

• Bevel Wick: Activates Bevel mode for the wick geometry.

• Bevel Wick Top: Chamfer wick’s top.

• Bevel Wick Bottom: Chamfer wick’s bottom.

• Bevel Wick Size[%]: Adjusts bevel’s size from 0 to 100.

• Bevel Wick Steps: Sets roundness via the number of segmentation steps.

• Relative Length: on: all accumulated candle lengths equal 100%. off: every candle
has its own 100% (e.g. 3 candles: 300%).

• Total Length: Value for the previous parameter.

• Use Vertex Colors: Activates the following parameters.

• Bull Candle Color: Defines the color for all candles where the close value is higher
than the open value.

• Bear Candle Color: Defines the color for all candles where the close value is lower
than the open value.

• High Wick Color: Sets high wick’s color.
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• Low Wick Color: Sets low wick’s color.

Note: A chamfer is a beveled edge connecting two surfaces.

To create a stock chart

1. Create a new group and add the Stock Chart plugin to it.

2. Open the Transformation Editor and set Position X and Y to -100.0.

3. Open the Stock Chart editor and set the following parameters:

• Set the Data Open parameter to the following values: 10,20,30,40,50,40,30,40,50.

• Set the Data Close parameter to the following values: 20,15,35,45,40,60,45,20,20.

• Set the Data High parameter to the following values: 25,20,40,50,55,60,50,40,50.

• Set the Data High parameter to the following values: 10,15,30,30,25,30,30,20,15.

• Set Candle and Wick Corners to 10.

• Set Candle Width to 25.0.

See Also

• Control Chart

• Data Fit

• Data Import

• Data Label

• Data Storage
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12 Container Plugins

Container plugins are housed in the following folders:

• Arrange

• Container

• Container FX

• Control

• Default

• Global

• MPS

• MultiTouchComp

• PixelFX

• Presenter

• pxColorWorks

• RealFX

• Script Plugins

• SplineFX

• Text

• TextFX

• Texture

• Ticker

• Tools

• Transformation

• Vizual Data Tools

Note: The default path for the Container plugins is: <Viz Install Directory>\plugin
\<plugin name.vip>
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12.1 Arrange
The following container plugins are housed in the Arrange folder:

• Circle Arrange

• Grid Arrange

• Time Displacement

12.1.1 Circle Arrange

 Circle Arrange is a tool for arranging a set of containers into a circular structure.

Note: This plugin is located in: Built-ins -> Container Plugins -> Arrange

This section contains information on the following topics:

• Properties

• To arrange containers in a circle

Properties

• Number of Elements: Allows you to define how many elements the structure is to
be constructed by.

• Number of Rows: Sets the number of rows/rings for the circular structure

• Distribution: Allows you to define how the containers are to distributed in the
circular shape.

• Monospace: Sets the same number of elements in each circle row. The spacing
between objects in the outer rows will then be bigger than in the inner rows.

• Equal: Distributes the objects between the rows so the distance between the
objects in the different rows are equal. The number of containers will then be larger
in the outer rows.

• Inner Radius: Sets the radius from the center to the first container ring.

• Outer Radius: Sets the radius from the center to the outer ring.

• Start Angle: Setting this above -180° will create an open section in the circle
structure. The opening is created in a clockwise direction.

• End Angle: Setting this below 180 will create an open section in the circle
structure. The opening is created in a counterclockwise direction.

• Orientate: If this option is enabled, the containers will orientate themselves with
their bottom towards the center of the circular structure.
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• Rebuild Containerlist: Use this button to rebuild the structure after having added
or removed containers form the group.

To arrange containers in a circle

1. Create a group container, and name it Circle.

2. Add a Sphere as a Sub-Container to the Circle container.

3. Add a material and/or a texture to the Sphere container.

4. Open the Transformation Editor for the Sphere container, and set Scaling (locked)
to 0.2.

5. Optional: Animate the Sphere object.

6. Make 15 copies of the Sub-Container, totalling the number of Sphere containers to
16. All copies should be placed as Sub-Containers of the Circle container and have
the same position as the original.

7. Add the Circle Arrange container plugin to the Circle container.

8. Open the Circle Arrange editor and do the following:

• Set Number of Elements to 16.

• Set Number of Rows to 2.

9. Click the Rebuild Containerlist button.

• The plugin will position all Sub-Containers in a circular structure.

The order of the containers in the group decides their placing in the circular structure.
If more than one row is selected, the first containers end up in the outer circle and the
last containers in the inner circle.

See Also

• Grid Arrange

12.1.2 Grid Arrange

 The Grid function is an effective tool for arranging a set of containers into a grid or
tabular structure.

Note: This plugin is located in: Built-ins -> Container Plugins -> Arrange

This section contains information on the following topics:

• Properties
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• To arrange containers in a grid

Properties

• Number of Rows: Sets the number of rows the containers are to be distributed
over.

• Number of Columns: Sets the number of columns the containers are to be
distributed over.

• Row Offset: Sets the distance between the rows.

• Column Offset: Sets the distance between the columns.

Note: The product of number of rows and number of columns should normally be
equal number of containers. If it is higher, all rows will not be equal, if it is lower,
some containers will not be shown, but they will still be rendered.

To arrange containers in a grid

1. Create a group container, and name it Grid.

2. Add a Sphere as a Sub-Container to the Grid container.

3. Add a material and/or a texture to the Sphere container.

4. Open the Transformation Editor for the Sphere container, and set Scaling (locked)
to 0.2.

5. Optional: Animate the Sphere object.

6. Make 15 copies of the Sub-Container, totalling the number of Sphere containers to
16. All copies should be placed as Sub-Containers of the Grid container and have
the same position as the original.

7. Add the Grid Arrange container plugin to the Grid container.

8. Open the Grid Arrange editor and do the following:

• Set Number of Rows to 4.

• Set Number of Columns to 4.
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• Set Row Offset to 40.0.

• Set Column Offset to 40.0.

• The plugin will position all Sub-Containers in a grid structure.

The order of the containers in the group decides their placing in the grid structure. If
more than one row is selected, the first containers end up in the first row(s) and the
last containers in the last row(s).

See Also

• Circle Arrange

12.1.3 Time Displacement

 Time Displacement allows you to use a grayscaled alpha image for setting animation
time offsets for all the objects in a group container. This is typically useful if you want
to create some kind of randomized animation effect or that should follow a certain
pattern.

What the function does is to create links between the animated containers and the
pixels of the grayscale image and then use the alpha level of each pixel to set the
offset of the containers. The range from 100% alpha to 0% alpha on the pixels sets the
offset level. By default 100% alpha sets no offset and 0% sets maximum offset.

Note: This plugin is located in: Built-ins -> Container Plugins -> Arrange

This section contains information on the following topics:

• Properties

• To set animation time offsets using a grayscaled alpha image

Properties

• Image: Drag the alpha image you want to use for creating the containers offsets
onto the drop zone here.
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• Invert: Inverts the link between the image pixels and offsets. 0% gives no offset
and 100% gives maximum.

• Image Width: Sets the height of the alpha image.

• Image Height: Sets the height of the alpha image. Image Width*Image Height
should normally be the same as the number of containers that are to be used in the
function.

• Pixel Reference: Defines the way the pixels should be associated to the animated
containers. You can choose between:

• Order in Tree: The container order in the transformation tree decides how the
pixels should be associated.

• Name of Container: The container name sets the order in which the containers
will be associated with the pixels.

• Search Tree: Sets the search level of the function, when it decides which Sub-
Containers to include in the function:

• One Level: Only the first level of Sub-Containers is being included in the function.

• Recursive: All levels of Sub-Containers are being included.

• Threshold Action: Is executed if the pixel value is lower than the threshold value.

• None: No action is performed.

• Skip Pixel: The pixel is skipped in the offset process.

• Visible - Makes objects visible when the pixel value is lower than the threshold
value.

• Invisible - Makes objects invisible when the pixel value is lower than the threshold
value.

• Threshold: Sets the Threshold value where one of the above selected actions will
be performed.

• Stage Range (frames): Sets the range of the offset distribution. A high value will
result in bigger differences in offset between containers that are associated with
different pixel alpha values.

• Stage Offset (frames): Adds a static offset value to all containers.

• Filter Type - Filters the containers in or out. Available options are; None, Including
and Excluding.

• Filter String - Sets the name of the containers that are to be included in the filter.
Use of asterisks is supported.

• Execute: Starts the operation

To set animation time offsets using a grayscaled alpha image
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1. Add a group to the scene tree and name it TimeDisplace, and the TimeDisplace
plugin to it.

2. Create a Sub-Container of the TimeDisplace container and name it Sphere.

3. Create a new group container as a Sub-Container of Sphere.

4. Add a Sphere geometry plugin and material to the group container.

5. Animate the group container from Position X -200.0 to 200.0.

6. Make 6 copies of the Sphere container under the TimeDisplace container.

7. Add the Grid Arrange plugin to the TimeDisplace container.

8. Open the Grid Arrange editor and set Number of Rows to 6 and Row Offset to 30.0.

9. Optional: Remove the Grid Arrange plugin.

10. Add the Corena plugin and rename the containers to Sphere, starting at index 0.
This will allow you to filter out specific containers using the TimeDisplace filter.

11. Optional: Remove the Corena plugin.

12. Open the TimeDisplace editor and add an alpha image to the Image drop zone.

13. Click Execute.

14. Click the Stage to see the offsets being added to the containers.

15. Run the animation to see the time offset in action!

See Also

• Image Editor

• Grid Arrange

• Corena

12.2 Container
The following container plugins are housed in the Container folder:

• BoundingBox

• Cobra

• Coco

• Colin

• Cora

• Corena

• Toggle
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12.2.1 BoundingBox

 Use this plugin to redefine the standard Bounding Box which is bounding all
geometry objects.

Note: This plugin is located in: Built-ins -> Container Plugins -> Container

This section contains information on the following topics:

• Properties

Properties

• X Left Bottom Back: It changes the dimension in X-direction starting from left.

• Left Bottom Back: It changes the dimension in Y-direction starting from bottom.

• Left Bottom Back: It changes the dimension in Z-direction starting from flipside.

• Right Top Front: It changes the dimension in X-direction starting from right.

• Right Top Front: It changes the dimension in Y-direction starting from top.

• Right Top Front: It changes the dimension in Z-direction starting from front.

• Set to Standard: Initialize minimum values to hold the entire geometry object.

12.2.2 Cobra

 The Cobra function is an easy to use function replace (parts) of container names.
Enter a search pattern and a string the search should be replaced with and execute.

Note: This plugin is located in: Built-ins -> Container Plugins -> Container

This section contains information on the following topics:

• Properties

• To rename container(s)

Properties

• Search pattern: Sets the string you want to replace.
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• Search pattern position: Defines the position within the string. It can be set to
Begin, End and Any.

• Replace with: Sets the string you want to use instead of the search pattern.

• Search level

• Same: Only container on the same hierarchy level will be affected.

• Down: Only Sub-Container of the current container will be affected.

• Tree: Searches the whole scene tree.

• Replace: Starts the replace process.

To rename container(s)

1. Add the Cobra plugin to a container that for example has Sub-Containers that
should be renamed.

2. Open the Cobra editor.

3. Enter the Search pattern string (e.g. Copy), and set the Search patter position to
Begin.

4. Enter the Replace with string (e.g. Sphere), and set the Search level to Down.

5. Click the Replace button.

See Also

• Coco

• Corena

12.2.3 Coco

 The Coco plugin allows you to create copies of a container with great ease. This
function is typically used together with the Arrange plugins.

Note: This plugin is located in: Built-ins -> Container Plugins -> Container

This section contains information on the following topics:

• Properties

• To create copies of containers
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Properties

• Number of Copies: Sets the number of copies to be created when the function is
executed.

• Scene Tree Level: Allows you to select the hierarchic position of the copies.

• same: Sets the copies on the same level as the source container.

• down: Sets the copies as Sub-Containers to the source container.

• Clear Transformation: Sets all transformation values on the new copies, like
scaling, position and rotation, back to zero. All copies will then be stacked at a initial
position with all transformation values set to zero.

• Starting Index: Allows you to alter the starting point of the index numbering of the
copies. By default the numbering starts on 1.

• Container Name: Allows you to change the name the containers will be given by
default.

• Execute: After having set the required parameters, click this button to execute the
duplicating process.

To create copies of containers

1. Add the Coco plugin to the container you want to copy.

2. Open the Coco editor and enter the Number of Copies (e.g. 10)

3. Set Scene Tree Level to down.

4. Click the Execute button.

See Also

• Arrange

• Cobra

12.2.4 Colin

 The Colin plugin allows you to align a container in the scene using two other
containers as reference. This makes it easy to maintain a good and controlled
symmetry in the scene.

Note: This plugin is located in: Built-ins -> Container Plugins -> Container

This section contains information on the following topics:

• Properties

• To align containers
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Properties

• Container 1: Is the drop zone for the first referential container.

• Container 2: Is the drop zone for the second referential container.

• HOffset %: Sets the horizontal offset between the referential containers in
percent. Horizontal means here an invisible line between the referential containers
regardless of the actual boning of the line.

• VOffset: Sets the vertical offset from the horizontal line.

• ZOffset: Sets the Z offset from the line between the referential containers.

• Align container rotation

• 2D: When enabled, this option will position and rotate the container in the X- and Y-
axis to keep itself aligned on the invisible line between the referential containers as
they move.

• 3D: When enabled, this option will position and rotate the container in the X-, Y- and
Z-axis to keep itself aligned on the invisible line between the referential containers
as they move.

• Automatic label orientation: This parameter only works if the Align container
rotation parameter is switched to 2D or 3D. It adapts automatically the rotation
angles.

• Autoscale object: Unlocks the Scaling value.

• Scaling: Lets you enter the value the container should be scaled to.

To align containers

1. Add the Cube, Sphere and Icosahedron geometries to the scene tree.

2. Open the transformation editor for Cube and Icosahedron and set them to Position
X -200.0 and 200.0, respectively, and Position Y 100.0.

3. Add the Colin plugin to the Sphere container.

4. Open the Colin editor and drag and drop the Cube and Icosahedron containers
onto the Container1 (left) and Container2 (right), respectively.

• The container is then aligned between the two referential containers.
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12.2.5 Cora

 The Cora plugin allows you to sort a set of Sub-Containers based on multiple criteria.
It is a useful tool when your scene starts getting complex and it is difficult to maintain
the overview. To make sorts by different criteria it can help you reorganize the scene
tree structure. It works on all containers under the container it is added to.

The plugin is often used together with the Time Displacement plugin which enables
many creative possibilities.

Note: This plugin is located in: Built-ins -> Container Plugins -> Container

This section contains information on the following topics:

• Properties

• To organize the scene tree

Properties

• Criteria: Selects the wanted sort criteria.

• Name: Performs a case sensitive sort. In normal sort order, capitalized letters are
listed first. Be aware, use letter case consistently if you want to have a correct result
when you perform a sort by name.

• X: Sorts by X-values.

• Y: Sorts by Y-values.

• Z: Sorts by Z-values.

• Vis: Sorts all the visible containers first.

• Alpha: Sorts by the alpha value among those containers who have an alpha
function attached. Alpha values set on the material of a container are ignored.

• Key: Sorts containers by key function. Among those with key signal attached, the
key alpha value is used for the further sorting.

• Rand: Sorts by random.

• Mode: Sets the order of the sorting. Choose between setting the Highest or the
Lowest values.

• Random Seed: Is relevant if you have chosen random as your sort criteria. It
specifies a seed for the random number generator. Even though Viz Artist use
random numbers, the animation for a specific random seed will always look the
same.

• Random Weight: Defines how random the randomize function will sort. Random
1.0 means random, random 0.0 does nothing and random 0.5 gives you a 50%
chance if a container is resorted or stays in place.

• Execute: Starts the operation.

To organize the scene tree
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• Add the Cora plugin to the container that holds the Sub-Containers you want to sort,
select the sort criteria and press the Execute button.

See Also

• Time Displacement

12.2.6 Corena

 The Corena plugin renames all Sub-Containers of the container you apply it to. The
plugin is often used together with the Time Displacement plugin which enables many
creative possibilities.

Note: This plugin is located in: Built-ins -> Container Plugins -> Container

This section contains information on the following topics:

• Properties

• To rename container(s)

Properties

• Name sets the name you want to rename the Sub-Containers to. You can define the
number format of the new names by entering a hash in addition to the name for
each digit you want in the numbering. If you enter ###newname, the containers
will be named: 001newname, 002newname, and so on.

• Add Index enables/disables creation of a numbering index.

• Starting Index sets the number you want the numbering index to start from.

• Reverse Index if enabled, creates the index in a reversed order.

• Execute start the operation.

To rename container(s)

1. Add the Corena plugin to the container that holds the containers you want to
rename.

2. Enter the new name, set the indexing parameters and click Execute.

See Also

• Cobra
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12.2.7 Toggle

 Toggle is used to toggle between two objects. The plugin is most commonly used
with Transition Logic scenes.

Note: This plugin is located in: Built-ins -> Container Plugins -> Container

This section contains information on the following topics:

• Description and Methodological Considerations

• Properties

Description and Methodological Considerations

Toggle plugin is one of the main building blocks of Transition Logic, and it is in general
a relatively simple plugin. When the Toggle plugin is added to a container it will create
two child containers that act as placeholder containers for objects that can toggle on
and off screen. In addition it will also create some utility directors in the stage.

Toggle placeholder containers

The two placeholder containers correspond to an A-side and a B-side. Each of the
placeholders will again have a child container; one named current the other named
other. The current is typically the visible container, while the other is not visible. At
the time of a switch, these containers will switch names. This means that at any given
time it is not possible to know if the current parent is the A side or the B side. It is the
responsibility of the Toggle plugin to keep track of this.

Toggle directors and keyframes

The Toggle plugin will create two directors each containing a default 1 second cross
fade animation. These animations are placed in the AX and BX directors. AX can be
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interpreted as the A-side cross fade. The animations can be modified to show any kind
of transition, but it is important that the AX and BX are the same.

In addition to the cross fade directors the Toggle plugin will also create placeholder
directors for the object animations. Merged objects that are loaded into these
placeholder containers during playout may contain animations embedded in the
geometry object. The object animations are automatically added as a sub-director to
the AO or BO director depending on if the object is being loaded on the A-side or B-
side.

Caution: It is NOT recommended to manually adjust the AO and BO directors.

There are two different scenarios of when the utility directors will be triggered:

1. When there is a state change.

• When there is a state change the Toggle Layer director will be animated from the
current state to the desired next state. In this scenario the utility directors will be
triggered according to the toggle keyframes in the stage. This means that it is
the position of these keyframes that will determine the timing of when the utility
directors are triggered.

2. No state change, only changing the current object.

• When there is no state change there will be no movement of the Toggle Layer
director. In this case the Toggle switch action will be triggered, which in effect will
animate the utility directors at the same time; animating the current object out and
the next object in at the same time.

Note: Placeholder containers and directors are only generated if none exists from
before.

The plugin has a built-in support for object loading. Enter the path to an object (e.g.
GEOM*myfolder/myobject) into the Object field, and the plugin will load this object on
the other container. The object will by default be invisible and can be loaded with data,
before activating the Switch action to show the object.
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An object loaded this way will be cached, so that requesting the same object again will
not trigger loading again. The object cache can also be preloaded by specifying all the
geometries that should be preloaded before initializing the Toggle plugin. Preloading of
the objects needed by the Toggle plugin is done when a playlist is initialized. For this
reason the Preload Object text field should normally not be manually modified in Viz
Artist.

Before adding the plugin to a container in a scene, please make sure that:

1. You give the container a unique and sensible name. This name will become
the Toggle Layer name. Also, as the Toggle plugin will automatically generate
directors, which will be named based on the container name and its parents
names, it is worth considering if the location of the container that will host the
Toggle plugin is in the correct position in the scene tree.

2. The container the Toggle plugin will be added to must not have any child
containers.

3. A director with the same name as the container (Toggle Layer name) is created.

4. The director has a minimum of two stop points and that these stop points are
named correctly. The names must correspond with the Toggle Layer states.

IMPORTANT! One of the Transition Logic requirements is to have a stop point
named “O”. Best practice is to always name the first stop point “O” (frame 0).

After the Toggle plugin has been added to the container, the plugin icon can be clicked
to see its properties. Clicking the Default Keyframes button will create the most
commonly used keyframes for triggering the toggling between the current and the
other objects. Adjusting the timing can easily be done by moving the keyframes in the
stage.

Properties

Toggle editor

• Object: Displays the name of the currently loaded object (front scene GEOM). This
field changes depending on the object loaded in the layer the toggle plugin resides.

• Show advanced: Displays the advanced parameters.

• Auto-continue other object on Switch: With this option enabled, toggle will
issue a continue action to the other placeholder when a switch action is triggered.
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• State control only: If this option is enabled all commands sent to the Toggle will
be ignored. This mean that no object will be loaded and only state changes on the
layer director will be run.

• Controls video: Controls the toggling of video channel 3 and 4. This applies when
using the Control Video plugin.

• Preload objects: Specifies the objects that are to be pre-loaded on initialization.

• Director commands: This field can be filled with certain director command
parameters like for instance: SHOW 0.5, SHOW 50f, SHOW $pilot1. The parameters
are then formed into a valid set-director-position command, and applied to either
current or other placeholder object director.

• Run director command on current and Run director command on
other: These buttons will form and apply a director command based on the
director_commands field as described above. Note that these options will be
deprecated in future versions.

• Switch without animation: Will switch the visible container without running any
of the (A|B)X directors or starting the object animation. The AX and BX directors will
be set to the correct in/out positions.

• Dummy: Is animated to create an animation that spans all the other toggle
keyframes. This will in some cases solve problems with toggle keyframes not being
triggered correctly.

• Switch: Animates out the current placeholder, then switches the other placeholder
to current and animates it in.

• Out: Animates out the current placeholder.

• In: Animates in the current placeholder.

• Switch in: Switches the other placeholder to current and animates it in.

• Switch in preview: Hides the current placeholder without animating it, then
switches the other placeholder to current. Afterwards it shows the new current
placeholder by jumping to a director state suitable for generating a still preview.

• Default Keyframes: Inserts default Toggle keyframes to invoke the toggles utility
directors.

• Continue: Sends a continue action to the current object animation director.

• Delete default keyframes: Removes the default keyframes that were generated
by the Default keyframes button.

• Initialize: Clears the cache, and reloads pre-loaded geometries.

• Position object director at preview location: When invoked, position the object
director at given preview location in position field.

• Move object director to next stop: Moves the stage position to the next director
stop point on a loaded object.

• Delete containers for cached object: Deletes all the containers used as the
Toggles object cache.

See Also

• Transition Logic

12.3 Container FX
Container FX is much like TextFX, except that instead of text, a set of containers are
added under the plugin. Instead of animating the containers, Container FX animates
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the containers below (aka the container-Set). Those containers can be circles and so
on.

Like Text FX plugins use containers, a Container FX plugin will use a set of containers
under the plugin and change their position like Text FX does. It is recommended to be
familiar with Text FX before designing with Container FX to understand the idea. You
can also use the Cloner plugin to create the necessary containers under the plugin.

In the above example the containers under the group container with the Sphere names
is the container-set, and will be animated here.

The following container plugins are housed in the Container FX folder:

• Common Container FX Properties

• Container FX 2D Follow

• Container FX Alpha

• Container FX Arrange

• Container FX Color

• Container FX Explode

• Container FX Jitter Alpha

• Container FX Jitter Color

• Container FX Jitter Position

• Container FX Jitter Scale

• Container FX Plus Plus

• Container FX Rotate

• Container FX Scale

12.3.1 Common Container FX Properties

The following properties are common to most of the Container FX plugins:
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• Progress %: 0% progress is the beginning of the effect, 100% the end. Animate
this value from 0% to 100% to see the effect or from 100% to 0% to animate the
effect backwards.

• Progress Type

• Absolute: 100% progress will animate all container’s set, regardless of how many
containers it has.

• Relative: 100% progress animates 10 containers. This is needed to adjust the
timing of several containers with different sizes. The effect speed should be for
example 5 containers per second, so the animation must be from 0% to 100% in
two seconds. This will work for with 10 containers or less. If you want to use more
containers, animate the progress value over 100% (10% for each container).

• Direction: Sets the direction of the effect sequence, you can choose between the
following options:

• Left: Starts with the first container in the containers-set.

• Right: Starts with the last container in the containers-set.

• Random: Uses a random order.

• Static: All containers are processed at the same time.

• Wave: Starts with the first container, animates the effect from 0: 100% and then
down again to 0%.

• Center: Starts the effect from the center of the containers-set.

• 2 Center: Starts the effect at the same time from the beginning and the end of the
containers-set. They meet at the center.

• Interpolate: Choose between a soft or a linear interpolation of the transition from
container to container.

• Effect Range: Defines how many containers are processed at the same time. If for
example the Effect Range is set to 4, and you manually increase the progress value,
you will see that when the fifth container starts to be processed, the first is finished,
when the sixth starts, the second is finished, and so on.

• Random Seed: Specifies a seed for the random number generator when a random
direction is chosen. Even though Viz Artist uses random numbers, the animation
for a specific random seed will always look the same. This is typically useful if you
combine two different container effects.

• Container Order: Sets the container order for the effect. Available options are
As Is, Horizontal or Vertical. Horizontal and Vertical enables the containers -set
Direction options.

• Direction: Sets the horizontal and vertical container-set direction (see Container
Order). When the containers-set order is set to Horizontal, the container-set
direction must be set to Left to Right or Right to Left. When the container order is
set to Vertical, the containers-set direction must be set to Up to Down or Down to
Up.

12.3.2 Container FX 2D Follow

 The Container FX 2D Follow plugin allows you to create an animation of the
Containers following a path (usually 2DRibbon).

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:
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• Properties

Properties

• Positioning: Absolute positioning evenly distributes characters over the length of
the spline. Relative means that the text spacing of the string is used to position the
text on the spline.

• Path Position: Moves the characters on the shape.

• Position Wrap: Interpolate means that text continues in the direction set by the
last section of the spline; Clamp will stop the string on the spline end-point; Repeat
will cause the string to move to the other spline end-point as soon as it moves over
the end-point.

• Kerning Scale: Scales the kerning of the text on the spline.

• Align: Rotates the characters by Z to align the X-Axis with the tangent of the spline
at the characters position.

• Translation offset: Moves the text from the spline in the XY plane.

• Rotation: Rotates the characters using the spline as a rotation axis.

12.3.3 Container FX Alpha

 The Container FX Alpha plugin is a container-set effect that creates a fade in effect
for the containers in the set. The effect sequence can be set to go many different ways.
A fade in and out effect can also be achieved.

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties
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Properties

• Alpha Begin %: Sets the alpha level of the containers at 0% effect.

• Alpha End %: Sets the alpha level of the containers at 100% effect.

See Also

• Common Container FX Properties

12.3.4 Container FX Arrange

 The Container FX Arrange plugin allows you to arrange containers in either a circular
or a wave shape. The containers can be animated on the selected shape by animating
the offset value.

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties

Properties

• Offset %: Moves the containers on the shape. 100% means one full rotation of the
containers-set on the circle.

• Scale %: Sets the container-set on the shape. The parameter does not scale the
containers, but the center of the bounding box of the containers.

• Shape: Changes the shape of the container layout. The options are Circle or Wave.

• Diameter: Sets the diameter of the circular shape.
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• Positioning: Defines the position of the container-set on the circular shape.
Relative means that the spacing of the container-set is maintained. Absolute means
that the container-set is evenly distributed out on the circle.

• Direction: Sets the direction of the container-set on the circle to either Clockwise or
Counterclockwise.

• Align: Aligns the container along the curve.

12.3.5 Container FX Color

 Adds a color effect to the containers-set.

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties

Properties

• Color Start: Sets the initial color before applying the effect.

• Color End: Sets the color the effect should apply.

See Also

• Common Container FX Properties

12.3.6 Container FX Explode

 The Container FX Explode plugin creates an explosion like function where the
containers get thrown away from their initial position. The speed, direction and spread
of the moving containers can be altered with parameters.

Note: Works only if the containers-set is set to texture

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties
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Properties

• Duration: Defines the duration of the progress for each of the containers. Simply
increase the value if you want it last longer. You could achieve the same by making
the gravity stronger and animating the progress slower, but it is easier to increase
the duration instead if your explode effect is too short.

• Opening Angle: Sets the angle for the spread of the containers. 0 will send them
straight up, 360 will spread them in a circular shape.

• Angle Rotate X: Rotates the opening angle around the X-axis.

• Angle Rotate Y: Rotates the opening angle around the Y-axis.

• Force: Sets the force that throws away the containers. A high force will make them
go far away, conversely a low force will create only a small motion of the containers.

• Force Spread %: Sets a variation of the force among the containers.

• Use Axis: Allows you to select on which axis or combination of axes the containers
are to spread along.

• Gravity: Sets a gravity force that influences the path of the containers to end up
going downwards. The higher the value is set, the faster each container will divert
from its initial path and start going downwards.

• Use Rotation: With this option enabled, the container will rotate as they are being
thrown away from their initial position.

• Rotation Force: Sets the degree of rotation as the containers are being thrown
away.

• Show Force: With this option enabled, lines showing the containers path and speed
will be visible in the Scene Editor.

See Also

• Common Container FX Properties

12.3.7 Container FX Jitter Alpha

 The Container FX Jitter Alpha plugin creates a jittering motion of the containers by
randomly changing the alpha value of each container. The degree of change and the
start sequence of the jittering can be altered. To use the plugin, add it onto a container
with a font. To create an animation, animate the progress. Other values can of course
be animated as well.

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties
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Properties

• Effect What: Defines where the effect should have an effect. Available options are
background (BG), foreground (FG) or both.

• Alpha Begin: Sets the alpha level of the container at 0% effect.

• Alpha End: Sets the alpha level of the container at 100% effect.

• Randomness: Sets the intensity of the jittering alpha changes.

See Also

• Common Container FX Properties

12.3.8 Container FX Jitter Color

 The Container FX Jitter Color animates a jittering effect on the color of the container.

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties

Properties
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• Anchor Horizontal: Sets the anchor point for the containers on the horizontal
plane.

• Anchor vertical: Sets the anchor point for the containers on the vertical plane.

• Use Axis: Defines on which axis or axes the containers scale to create the jittering
effect.

• Lock Axis: With this option enabled, all the axes get the same Min, Max and
Randomness settings. If you disable randomness, these parameters will be visible
for each of the axes and must be set individually.

• Min: Sets the minimum scaling for the containers.

• Max: Sets the maximum scaling for the containers.

• Randomness: Sets the intensity of the jittering movement.

See Also

• Common Container FX Properties

12.3.9 Container FX Jitter Position

 The Container FX Jitter Position plugin creates a jittering motion of the containers by
randomly changing the position of each container. The degree of position change and
the starting sequence of the jittering can be altered. To create an animation, animate
the progress. Other values can of course be animated as well.

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties

Properties

• Use Axis: Defines on which axis or axes the containers moves to create the jittering
effect.

• Lock Axis: With this option enabled Range and Randomness will be the same for all
axes. If you disable it, Range and Randomness for each of the axes will be displayed
and you can set them individually.

• Range: Sets the range of the jittering movement.

• Randomness: Sets the intensity of the jittering movement.
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See Also

• Common Container FX Properties

12.3.10 Container FX Jitter Scale

 The Container FX Jitter Scale animates a jittering effect on the scale of the container.

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties

Properties

• Anchor Horizontal: Sets the anchor point for the containers on the horizontal
plane.

• Anchor vertical: Sets the anchor point for the containers on the vertical plane.

• Use Axis: Defines on which axis or axes the containers scale to create the jittering
effect.

• Lock Axis: With this option enabled, all axes get the same Min, Max and
Randomness settings. If you disable randomness, these parameters will be visible
for each of the axes and must be set individually.

• Min: Sets the minimum scaling for the containers.

• Max: Sets the maximum scaling for the containers.

• Randomness: Sets the intensity of the jittering movement.

See Also

• Common Container FX Properties

12.3.11 Container FX Plus Plus

 The Container FX Plus Plus plugin allows you to set a number of effects on a
container’s set.
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Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties

Properties

• Position Wrap

• Extrapolate: Above 100% or below 0% of Path Position will continue the direction
of the spline.

• Clamp: Will stop the string on the spline endpoints.

• Repeat: Will cause the string to move to the other spline endpoint as soon as it
moves over the endpoint.

• ContainerFx: Will position containers by the relative spline of each container using
the ContainerFx parameters.

• Scheme Type: Defines how the container-set will look at 0% and 100% progress.

• In -> In: at 0% first container will be at the beginning of the spline, at 100% last
container will be at the end of the spline.

• In -> Out: at 0% first container will be at the beginning of the spline, at 100% first
container will be at the end of the spline.

• Out -> In: at 0% last container will be at the beginning of the spline, at 100% first
container will be at the end of the spline.

• Out -> Out: at 0% last container will be at the beginning of the spline, at 100% last
container will be at the end of the spline.

• Progress (%): Animates the progress of the effect(s).

See Also

• Common Container FX Properties

12.3.12 Container FX Rotate

 The Container FX Rotate plugin allows you to create an effect where the containers
rotate on the X-, Y- or Z-axis.

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties
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Properties

• Anchor Horizontal: Sets the anchor point for the containers on the horizontal
plane.

• Anchor Vertical: Sets the anchor point for the containers on the vertical plane.

• Use Axis: Defines on which axis the containers rotate.

• Begin: Sets the initial rotated position of the containers.

• End: Sets the ending rotated position of the containers.

See Also

• Common Container FX Properties

• Expert

12.3.13 Container FX Scale

 The Container FX Scale plugin allows you to create a scaling animation of the
containers.

Note: This plugin is located in: Built-ins -> Container Plugins -> ContainerFx

This section contains information on the following topics:

• Properties

Properties

• Anchor Horizontal: Sets the anchor point for the containers on the horizontal
plane.

• Anchor Vertical: Sets the anchor point for the containers on the vertical plane.

• Use Axis: Defines on which axis or axes the containers scale.

• Lock Axis: With this option enabled the Begin- and End scaling are the same
for all the axes. If you disable the option, Begin and End must be set for all axes
individually.

• Begin: Sets the initial size of the containers.

• End: Sets the ending size of the containers.
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See Also

• Common Container FX Properties

12.4 Control
The following Container plugins are housed in the Control folder:

• Common Control Plugin Properties

• Apply Shared Memory

• Control Action

• Control Action Table

• Control Audio

• Control Bars

• Control Chart

• Control Clip

• Control Clock

• Control Condition

• Control Container

• Control Data Action

• Control Datapool

• Control DP Object

• Control FeedView

• Control Geom

• Control Hide in Range

• Control Hide on Empty

• Control Image

• Control Keyframe

• Control List

• Control Map

• Control Material

• Control Num

• Control Object

• Control Omo

• Control Parameter

• Control Pie

• Control Scaling

• Control Sign Container

• Control SoftClip

• Control Stoppoint

• Control Text

• Control Targa Alpha

• Control Targa Clip

• Control Video



Viz Artist User’s Guide

Page 648 Copyright © 2014 Vizrt

• Placeholder

12.4.1 Common Control Plugin Properties

Most control plugins have a set of common properties. These are the Field Identifier,
Description and Show only in Expert Mode.

• Field Identifier: When making templates for Viz Trio, this should be a numeric
value, Range: 1-n. For Viz Content Pilot and Viz Ticker, this can also be a descriptive
text string. This value is used by the control clients to identify the editable element
in the scene. In Viz Trio the numbers from the control plugins are used to create the
tab-order between the editable elements.

• Description: A description of the tab field or editable object. This will be used as a
description for the elements when used in the control clients.

• Show only in Expert Mode: Hides the tab-field properties for the user if Expert
Mode is enabled in Viz Trio. For more information, read about Viz Trio’s macro
commands, and the command set_expert_mode_enabled.

12.4.2 Apply Shared Memory

 The Apply Shared Memory plug-in allows values to be transferred into Viz Engine
using Data Sharing mechanisms provided by shared memory maps that can be applied
to control plug-ins such as Control Text. Just as Control Object acts as a distribution hub
for content provided by control applications, the Apply Shared Memory plug-in acts
as a distribution hub for content provided by external systems feeding real-time data
through the shared memory maps.

The control plug-ins that the Apply Shared Memory plug-in can apply content to resides
in the same folder.

Just like the Control Object plug-in, the Apply Shared Memory plug-in only applies
values to control plug-ins residing in the subtree of the scene tree where the Apply
Shared Memory plug-in resides. Also like the Control Object plug-in, it matches the keys
of incoming content with the field identifiers of individual control plug-ins to determine
where to apply which incoming content value.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

• Visualizing composite data structures

• How shared memory keys are determined

• To visualize stock data from shared memory

• To test stock visualization
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Properties

• Shared Memory Source: Specifies which shared memory map to apply values
from. The Scene, Global and Distributed choices select the shared memory
maps that are referred to as Scene.Map, System.Map and VizCommunication.Map
respectively in the Data Sharing section.

• Memory Base Key: The key prefix path to combine with the field identifiers of
control plug-ins to determine the key to look up in the chosen shared memory map
when applying values to a particular field exposed by a control plug-in.

• Expose Base Key: Expose the Memory Base Key property as a controllable field.
Once this option is turned on the properties Field Identifier and Description as
described in the Common Control Plugin Properties section can be specified.

The Expose Base Key property is typically used to allow a control application to
control the base key which determines where in the shared memory map to pull values
from. However, since the exposed property is an exposed control field like any other, a
parent Apply Shared Memory plug-in can be used to make the shared Memory Base
Key property controllable by external systems through a shared memory map.

Choosing whether to allow the exposed field to be controlled by control applications or
external systems feeding the shared memory map is done by placing either a Control
Object or another Apply Shared Memory plug-in on a parent container, respectively.

Visualizing composite data structures

The Memory Base Key property combined with the field identifiers exposed by control
plug-ins can be seen as a way to visualize sets of related key-value pairs stored in
shared memory maps. While the Memory Base Key property specifies where in the
shared memory map to locate the set of related key-value pairs, the exposed field
identifiers specify which of the related key-value pairs from the selected set to visualize
in a particular way in the scene subtree.

For example, the Memory Base Key property can specify a shared memory path
representing a particular stock symbol, while the field identifiers of control plug-ins
picks out particular values such as stock name, value and change from that location in
the shared memory map.

Since the Apply Shared Memory plug-in only affects the scene subtree it is placed on,
visualizing multiple composite data structure instances sharing the same structure and
presentation can easily be achieved by copying subtrees and only change the Memory
Base Key property.

For example, design a stock presentation design once, and copy it many times to
create a scene showing several distinct stocks using the same visual style. Turning on
the Expose Base Key property gives users of control applications control of which
stocks to show in each presentation copy, while the data content for each stock is still
supplied in real-time through the shared memory map.

How shared memory keys are determined

The shared memory keys used to look up values in a shared memory map is
constructed by the combination of an absolute path specified in Memory Base Key
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property and an either relative or absolute path consisting of the field identifier of an
exposed field. Any path starting with a slash (/) is considered an absolute path, while all
other paths are considered relative.

If the field identifier is an absolute path, then that absolute path alone is the result
of the resulting shared memory key used. For example, the field identifier “/weather/
norway/bergen/temperature” will result in the shared memory key “/weather/norway/
bergen/temperature” regardless of what the Memory Base Key property is.

If the field identifier is a relative path, the path is interpreted relative to the absolute
base path provided in the Memory Base Key property, and the absolute path
resulting from that interpretation is used as the shared memory key. For example, a
Memory Base Key property of “/weather/sweden/stockholm” and a field identifier
of “temperature” results in the shared memory key “/weather/sweden/stockholm/
temperature”.

Like file system paths, a path segment consisting of a single dot (.) is considered
referring to the current directory, while two dots (..) is considered referring to the
parent directory. This notation is resolved to a regular absolute path before using the
result as a shared memory key. For example, a Memory Base Key property of “/
weather/./norway/trondheim” and a field identifier of “../oslo/windspeed” will resolve to
the shared memory key “/weather/norway/oslo/windspeed”.

To visualize stock data from shared memory

This procedure will visualize composite content fed through a shared memory map to
the control plug-ins Control Text, Control Num and Control Sign Container.

1. Create a new container

2. Drag and drop a Apply Shared Memory plug-in into this container

3. Set the Memory Base Key property of the Apply Shared Memory plug-in to “/
stocks/nyse/ibm”

4. Create two text geometries as children of this container

5. Drag and drop a Control Text plug-in into the first text geometry container

6. Set the Field Identifier property of the Control Text plug-in to “name”

7. Turn off Use formatted text property of the Control Text plug-in

8. Drag and drop a Control Num plug-in into the second text geometry container

9. Set the Field Identifier property of the of the Control Num plug-in to “value”

10. Create a third container as a child of the Apply Shared Memory plug-in container

11. Drag and drop a Control Sign Container plug-in into this container.
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12. Set the Field Identifier property of the of the Control Sign Container plug-in to
“value”

13. Create three text geometries as children of the Control Sign Container plug-in
container

14. Drag and drop a Control Num plug-in into each of these three text geometry
containers

15. For each of these three Control Num plug-ins set the Field Identifier property to
“change”

16. Arrange the layout of the text geometries, and apply materials for styling

To test stock visualization

To test that stock visualization commands can be sent to populate the global shared
memory map, see the descriptions in the Data Sharing section.

While these commands are suitable for testing the designs, a real external system
that feeds the Viz Engine with data would use a more efficient data transfer protocols
to populate the shared memory map. See the Accessing Maps via the TCP or UDP
Interface section for information about sending data efficiently using UDP.

When changing a value in the shared memory map that is visualized by a control plug-
in the scene updates immediately to reflect the new value. The shared memory map
can be populated with stock values for many stock symbols, including stocks that are
not visualized at the moment. As soon as the Memory Base Key property of the Apply
Shared Memory plug-in is changed to visualize the values for a different stock symbol,
and the scene updates immediately to reflect the value previously populated into the
shared memory map for that stock symbol.

12.4.3 Control Action

 The Control Action plugin executes an action, for example Viz Engine commands or
Control Object commands, when receiving input on the “input” field.

The action can contain more than one command to be called, and the commands must
be separated by semicolons. When “Notify Only When Value Change” is checked the
actions will only be triggered if the input value differs from the one already stored on
the “input” field from previous invocations.
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Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Input Value: Specifies the value input will be compared against

• Notify Only When Value Change: Triggers a command when a value is changed.

• Action Type

• Viz Command: Triggers an internal Viz Engine command. For example:
“THIS_SCENE*STAGE*DIRECTOR*Audio START”.

• ControlObject Command: Triggers a ControlObject command. For example: “ON 1
SET abc”.

• Action: Actions to execute if values match.

See Also

• Common Control Plugin Properties

• Control Object

12.4.4 Control Action Table

 The Control Action Table plugin allows defining a table of actions similar to Control
Action. The actions are associated with a given value. When Control Action Table
receives input, it compares the received data to each of the values. If the data matches
one of the values the plugin starts the corresponding action.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Input Value: Specifies the value input will be compared against
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• Notify Only When Value Change: Triggers a command when a value is changed.

• Value(n): The value that the given action should be associated with.

• Action(n): Actions to execute if value match

• Default Action: Will be executed if the input does not match any of the specified
values.

See Also

• Common Control Plugin Properties

• Control Object

12.4.5 Control Audio

 The Control Audio plugin enables the operator of a control application to choose a
sound clip.

To expose the different properties, and change the audio file in one of the control
applications, simply add the Control Audio plugin to the same container as the Audio
plugin.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Director: Sets the name of the stage director the audio channel is located below.

• Audio Keyframe: Sets the ID/name of the audio clip keyframe.

Note: Under most circumstances there is no need to set director and audio
keyframe.

See Also

• Common Control Plugin Properties

• Control Object

• Audio

12.4.6 Control Bars

 The Control Bars plugin allows binding of tab field values to the Bar Value fields in
the Bar values presenter plugin. Each bar value property in the Bar Values editor is
presented as a separate tab field in Viz Trio.
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Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• First Bar Field ID: Sets the tab-field ID for the first Bar value.

• Last Bar Field ID: Sets the tab-field ID for the Last Bar value

• Expose Bars Max/Total Value: If enabled the Bars Max/Total value will be exposed
as a separate tab field.

See Also

• Common Control Plugin Properties

• Control Object

12.4.7 Control Chart

 The Control Chart plugin binds control of chart data to a Control Object. It currently
supports the graph geometry plugin and the bar values, pie values and Vizual Data
Tools plugins. It serves the purpose to interface all kind of chart data. It covers graph
charts, bar charts, pie charts, area charts and generally all kind of plugin data, which
has a table-like representation.

Control chart offers the same kind of interface like control list. That means it delivers
a schema specification as type encoding. The chart data is communicated as an
XML table value fully compatible to control list values. The supported control chart
commands mimic the control list commands.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties
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• Custom Number of Exposed Rows: Enables the Number of exposed Rows
setting.

• Number of exposed rows: Sets the default number of exposed rows for the scene
when the number of rows can be changed by the operator. If the number of rows
cannot be changed the number of exposed rows is fixed.

• Mutable Number of Rows: If set to on, the operator can add or delete rows.

• Custom minimum and maximum Number of Rows: Enables the Minimum and
Maximum Number of Rows settings. To the operator, the number of fields can only
be added or deleted when inside the range (for example greater than > 2 and less
than < 10).

IMPORTANT! If Control Chart is used in combination with Vizual Data Tools
plugins, make sure the Vizual Data Tools plugin’s Shared Memory is set to Inactive.

See Also

• Common Control Plugin Properties

• Control Object

• Vizual Data Tools

12.4.8 Control Clip

 The Control Clip binds control of an AVI clip played by Mo Viz or Softclip to a Control
Object. With the Control Clip plugin the clips may be changed within the control
application.

The Mo Viz plugin enables the user to play media files or media streams inside Viz
Engine. Mo Viz uses the Microsoft DirectShow Filtergraph framework to render the
media. Therefore it is possible to play for example MPEG and QuickTime files or
streams from a server. For the latter to work, the system must be appropriately
equipped.

Softclip is a Viz plugin that can show AVI clips, either projected on a texture, or
rendered directly.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

This plugin does not have any properties or parameters except those that are common
to all plugins.

See Also

• Common Control Plugin Properties
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• Control Object

12.4.9 Control Clock

 The Control Clock plugin allows the user to set time for a clock as well as controlling
several clock functions. The clock object is a text container in the scene with the clock
function enabled.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Expose Limit: Enables the user set a limit for the clock.

• Expose Direction: Enables the user to choose the direction for the clock.

• Action: Sets the clock action that will be the default value in the control client’s
clock editor.

• Input Value: Shows the current value for the plugin. It is not necessary to set any
value here. It is normally only used for debugging purposes.

See Also

• Common Control Plugin Properties

• Control Object

12.4.10 Control Condition

 With the Control Condition plugin action can be triggered based on the input given
in a tab-field with the same field identifier. Actions can be Control Object commands in
the form like this

“ON 2 SET Mike Johnson”

or Viz commands like

0 RENDERER*STAGE START

The Viz Engine commands must be prefixed with a zero followed by a space. This is to
enable the plugin to recognize that the command should be interpreted as a Viz Engine
command.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control
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This section contains information on the following topics:

• Properties

Properties

• Input Value: Shows the current input value to the plugin.

• Format: Sets the format for the input value that it should conditionally trigger on.

• Condition: Sets the type of condition if Format is set to number.

• Arguments: Sets the arguments for the conditional operation.

• Action Type / Action: Sets the action that is to be performed when the condition
is met. It can be a control object command like “ON 2 SET mytext” or a Viz Engine
command prefixed by a zero and a space.

• Use Else Commands: When enabled, an else action will be triggered when the
input data falls within the conditions.

• Else Action: Sets the else action that will be triggered when the input data does
not fall within the conditions.

See Also

• Common Control Plugin Properties

• Control Object

12.4.11 Control Container

 The Control Container plugin exposes a range of different transformation properties
for a container. See the Viz Artist User’s Guide for a detailed explanation of all the
transformation properties.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties
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Properties

The following properties can be exposed:

• Visibility

• Object

• X/Y/Z position

• X/Y/Z rotation

• X/Y/Z scaling

For position, rotation, and scaling a stop point keyframe can be specified. This enables
the user to control a keyframe in an animation, for instance the end keyframe in a
position animation.

See Also

• Common Control Plugin Properties

• Control Object

12.4.12 Control Data Action

 Binds control of a control parameter to a Data Action.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

See Also

• Common Control Plugin Properties

• Control Object

12.4.13 Control Datapool

 Control data pool can bind a tab field value to a data pool plugin variable. There
exist many kinds of datapool plugins. All data pool plugins, which are used in a
scene, must have its variable listed in the scene plugin named “data pool”. It is these
variables which the control data pool plugin links a tab-field to. For more information
about the datapool plugins see the data pool documentation.
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Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• DataPool Variable: The datapool variable can be controlled by the user.

• Input Value: Shows the current input value.

• Control Type: Specifies if the tab-field value should be controlled through a
datapool variable or a field name.

• Variable Type: Allows the user to define the kind of data the referenced variable is
linked to. The type selected here will decide what kind of editor will be opened in a
Viz Trio client.

See Also

• Common Control Plugin Properties

• Control Object

12.4.14 Control DP Object

 Allows copying or linking of Data Pool objects.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

See Also

• Common Control Plugin Properties

• Control Object

12.4.15 Control FeedView

 Set the FeedView locator to a given value. Example input values:

/nyse/nasdaq/cisco
/nyse/nasdaq/intel

If a prefix is set it will be added to the front of the locator key, a prefix of:

/nyse/nasdaq
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With an input of:

IBM

Will resolve to:

/nyse/nasdaq/IBM

The locator field is the value as received from ControlObject. It will be trimmed of CR/LF
before concatenated into a FeedView key.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Locator: Sets the FeedView locator to a given value.

• Prefix: If a prefix is set, it will be added to the front of the locator key.

See Also

• Common Control Plugin Properties

• Control Object

12.4.16 Control Geom

 The Control Geom plugin exposes the control of geometry objects to the user.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Geom location Prefix: Sets a path to a folder. The geometry location exposed to
the control client can be a simple string, instead of a full path. This is relevant if
connected to a newsroom system. For example if a user wants to edit a text and
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geometry on the same tab-field by just entering a text string. If for instance the user
have a folder of weather symbols and the control client receives “sunny” from the
external system it will load the geometry object with the path: “geom location prefix
+ sunny”, which then typically would be an image of a shining sun.

• Input Value: Shows the current input value. Enter a value to test the relation of
max/min. input and scale values.

• Deny Browsing Upwards: When enabled, it restricts the user from browsing for
objects in folders other than the selected folder and its sub-folders.

See Also

• Common Control Plugin Properties

• Control Object

12.4.17 Control Hide in Range

 The Control Hide in Range plugin hides or shows a container if the input value given
by the user is within or outside a specified value range. The input value must be from a
font container that holds a numeric value, typically with a Control Num plugin.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Input Value: Shows the current input value

• Lower Range Bound: Sets the upper bound for the range

• Upper Range Bound: Sets the lower bound for the range

• Visibility in Range: Sets if the container should be visible or hidden when the
input value is within the range.

See Also

• Common Control Plugin Properties

• Control Object

12.4.18 Control Hide on Empty

 The Control Hide on Empty plugin performs a very simple function: It hides the
container it sits on if the input value is blank (text) or zero (numbers). Use this plugin to
hide the graphics elements if the user does not enter any value in the connected tab-
field. Together with the Autofollow plugin, the plugin can be used to make intelligent
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scenes that hide objects that receive no value from the Viz Trio user and also rearrange
those elements that have a value or text and are visible. For example when using a
lower third scene with a bug and a breaking news bar, the bug and the breaking news
bar should not be shown all the time. So instead of having to make several explicit
variants simply make one scene and use the plugin to hide the bug and the breaking
news only if the page in Viz Trio have no value in those tab-fields.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Input Value: Shows the current input value

• Treat Input as Numerical: When enabled this option will hide the containers when
the input value is 0 or 0.0.

See Also

• Common Control Plugin Properties

• Control Object

12.4.19 Control Image

 The Control Image plugin creates an image control in the control clients. The plugin
must be placed on the container that holds the image/texture. If an image/texture is
invalid or Viz Engine for some reason cannot load it, then the current image/texture
remains visible.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties
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• Expose Image Position: Allows the user to change the position of the image/
texture.

• Expose Image Scaling: Allows the user to change the scaling of the image/
texture.

• Deny Browsing Upwards- When enabled, it restricts the user from browsing for
images/textures in folders other than the selected folder and its sub-folders.

• Image location Prefix: If the full path to a folder is entered, the image/texture
location exposed to the control clients can be a simple string, instead of a full path.
This is relevant if connected to a newsroom system. For example if a user wants edit
a text and an image/texture on the same tab-field by just entering a text string. This
is relevant if a user has a folder containing flag images/textures, and the control
client receives “US” from the external system it will load the image/texture with the
path: “image location prefix + US”, which then typically would be the “Stars and
stripes” (flag of the U.S.A).

• Input Value: Shows the current value for the plugin. It is not necessary to set any
value here. It is used for debugging purposes.

See Also

• Common Control Plugin Properties

• Control Object

12.4.20 Control Keyframe

 The Control Keyframe plugin can be used to give the user control over the value
of a “single value keyframe” unlike position values for instance where all three axes
must be specified. Create an animation, for instance an alpha animation, and give the
keyframe to control a name. Put the Control Keyframe plugin on the object’s container
and set the parameters.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Expose Time: Enables the user to adjust the keyframe along the timeline.

• Control Parent: When enabled, this option allows for two Control Keyframe plugins
to be within one container. Note that in this case the control keyframe plugins must
be added as Sub-Containers of the container.

• Minimum Input: Sets the minimum allowed input value.
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• Maximum Input: Sets the maximum allowed input value.

• Minimum Value: Sets the minimum value, which will be set relative to the
minimum input value.

• Maximum Value: Sets the maximum value, which will be set relative to the
maximum input value.

• Input Value: Shows the current input value. Enter a value to test the relation of
max/min. input and scale values.

• Keyframe Time: Sets the time value of the keyframe.

• Keyframe: Sets the name of the keyframe that is to receive a value by the control
client user.

Example for the input values: If the keyframe is an alpha keyframe which in Viz Artist
can be float values from 0 to 100, and the following values are set:

• Minimum input = 1

• Maximum input = 10

• Minimum value = 10

• Maximum value = 90.

This means that if the user gives the following input:

• 1, which is the lowest input value allowed, the alpha value in Viz Artist will be set to
10.

• 4, which is somewhere in between, the relative alpha value will be 36,666... .

• 10, which is the highest value allowed, the alpha value is set to 90.

See Also

• Common Control Plugin Properties

• Control Object

12.4.21 Control List

 The Control List plugin allows creation of table controls. By following some design
conventions when designing the table in Viz Artist, Viz Trio will show a table editor to
the user. This editor supplies a more effective way for filling tables than having one tab
field for each table cell.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

• Tables and Preview Points

• To design a table scene
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Properties

• Number of exposed rows: Sets the default number of exposed rows for the scene
when the number of rows can be changed by the operator. If the number of rows
cannot be changed the number of exposed rows is fixed.

• Mutable Number of Rows: If set to on, the operator can add or delete rows.

• Minimum and Maximum Number of Rows: Sets the minimum and maximum
number of rows. To the operator, the number of fields can only be added or deleted
when inside the range (for example greater than > 2 and less than < 10).

Tables and Preview Points

A table scene might be hard to read if you need to show a large table with many rows
(e.g. 20) and/or columns. In such cases it is not uncommon to only show a subset of
the information (e.g. 5 rows), and rather animate the scene to show the next 5 rows
and so on.

However, in such a situation, while editing table data in Viz Trio, you cannot use a basic
jump to keyframe event for preview, as this will only show the keyframe that relates to
the table’s Field identifier (e.g. 3), and not the rows or columns of the table.

To enable operators to preview the data in the scene, it is therefore possible to add a
preview point that extends to the next starting point (i.e. the next 5 rows of the table),
using the table’s (Control List) Field identifier in addition to the row number.

So, if the identifier of Control List is 03, you have to define tags with names 03.0, 03.5,
03.10 and 03.15 (zero based row index) for Viz Trio to detect the tags and jump to them
on focusing the according rows in Viz Trio’s Control List table editor.

• Basic jump to keyframe: When adding keyframe events (stop points, tags,...) and
giving them the name of a control plugin identifier, Viz Trio jumps the timeline to
that keyframe event when selecting the tab field with that identifier.

• Extended jump to keyframe: If the keyframe event name is e.g. 3_005 and there
is a control list with identifier 3, then Viz Trio jumps the timeline to that keyframe
event. In this case when the sixth row of the table is focused.

To design a table scene

To design a table scene that will be correctly interpreted by the Control List plugin there
are some design conventions that needs to be followed:



Viz Artist User’s Guide

Page 666 Copyright © 2014 Vizrt

1. Add a group as the root container for the table. Give it a descriptive name such as
“table”

2. Add the Control List plugin to the table group container

3. Add a new group as a Sub-Container to the table container. This container will be
the design for the rows in the table. Give it a name such as “row_1”.

4. Add a Control Object plugin to the newly added row container.

5. As Sub-Containers of the row container, add text containers with backgrounds to
form the design for a single table row with the desired number of columns.

• Each of the text containers must get a Control Text plugin and the field identifiers
for each must be set from 1-n depending on how many columns the table should
have.

• The Description property in the ControlText plugins will be picked up by the Control
List plugin and used as column headers.

6. When the single row looks as it should, duplicate it to make the needed total
number of table rows.

• The container plugin Coco can be used to automate this task.

• Add the Coco plugin to the row container, and set the number of copies, for example
9 (1+9=10), and click Execute.

7. Arrange the rows

• The arrange plugin Grid Arrange can be used to automate this task.

• Add the Grid Arrange plugin to the table container, and set the number of rows to
the same as above and press ENTER.

• Set the row offset and press ENTER.

The table element of the scene is ready and when imported into Viz Trio and read, the
table tab-field will be displayed with a special table editor. When imported into Viz
Template Wizard, a template with a custom table editor will be generated.

See Also

• Common Control Plugin Properties

• Control Object

12.4.22 Control Map

 The Map plugin binds the control of the Viz World Client plugin XML property to a
ControlObject which allows an operator to use the Viz World Client Editor to select
maps.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties
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Properties

This plugin does not have any properties or parameters except those that are common
to all plugins.

See Also

• Common Control Plugin Properties

• Control Object

12.4.23 Control Material

 The Control Material plugin exposes the material control to the Viz Trio user.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Material: Sets the path to the material that should be used when the page is
imported into the control client.

• Deny Browsing Upwards: When enabled, it restricts the user from browsing for
materials in folders other than the selected folder and its sub-folders.

See Also

• Common Control Plugin Properties

• Control Object

12.4.24 Control Num

 The Control Number plugin (also known as Control Num) is used to be able to decide
how a number input is to be formatted. It can be a value given by the control client
user or by any external source. It should be used instead of Control Text when numbers
are to be the input value. To make it work, add the plugin to the container that holds
the text object.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:
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• Properties

Properties

• Minimum Input: Sets the minimum allowed input value.

• Maximum Input: Sets the maximum allowed input value.

• Input Value: Shows the current input value. Enter a value to test the number
formatting.

• Show Verbatim: When enabled, this option disables all formatting.

• Thousand Separator: Sets the desired thousand separator for the output.

• Plus Prefix: The prefix entered here will be put in front of positive values.

• Minus Prefix: The prefix entered here will be put in front of negative values.

• Suffix: The string entered here will be put after all values.

• Decimal Point: Defines the decimal point for the output.

• Decimal Places: Sets the number of decimals that will be shown by the output.

• Leading Zero: When enabled, a zero will be put in front of decimal values between
1 and -1.

• Zero Replacement: Sets the string to show instead of zero values.

See Also

• Common Control Plugin Properties

• Control Object

12.4.25 Control Object

 For each Viz Artist scene that is to become a Viz Trio page template, a Viz Content
Pilot template or a Viz Ticker template it must have one instance of the Control Object
plugin. For Viz Ticker it is possible to have more than one Control Object plugin. It
should be on the root container for the tab objects in the scene.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Without Transition Logic

• With Transition Logic Enabled

• Advanced Properties
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Without Transition Logic

In the simple scene based mode, the plugin should be put on the root container for the
page tab-field containers. A description which will be used as template description in
the control clients should also be entered. To load the graphics in another rendering
layer than the Middle (default), choose Front or Back. By using different layers up to
three elements can be on screen simultaneously without having to design a Transition
Logic setup. Be aware that objects in the Back layer of course will be rendered behind
objects in the Middle and Front layer and so on, so the scenes must then be designed
with that in mind.

With Transition Logic Enabled

With Transition Logic enabled, logical layer and state can be defined for the scene.
These will be used by the control clients to find out which transitions and animations
to trigger when a page is put on-air or off-air. These transitions and layers must all
be defined in the background scene. A background scene name can also be set if a
background scene other than the default (named default) is used.

Advanced Properties

By clicking the Show Advanced button in the Control Object editor, a channel property
is displayed as well as a text box for manual field definitions. Most of these parameters
are used for system integration purposes and are rarely relevant when doing normal
scene design for Viz Trio, Viz Content Pilot and Viz Ticker.

• Channel: Sets the name of the default playout channel for the template.

• Manual field definitions: In the text box, custom fields can be defined by using a
fixed syntax: Each entry is a line of text consisting of colon (‘:’) separated fields. The
fields for each entry are:

Advanced Properties

VizBoldField description VizBoldExample

Field identifier/key votes

Property location $top$label*GEOM*TEXT

Type integer
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Minimum value 0

Maximum value 100

Maximum number of characters 8

Field description Percentage of votes

Auxiliary field

• Remap fields: For use in scenes with nested control object plugins. This feature is
mainly for advanced integration use. When turned on, Control Object will give the
control clients the list of entries in map, rather than the list of entries registered by
control plugins below the Control Object in the scene tree, and manually entered
entries from entries. When actions are performed on fields, the Control Object will
use map to rename the field identifier before dispatching the action.

• Store Stop Points: This mechanism can be used to work around the default
behavior of Viz Artist which discards stop-points when sub-trees are merged into
objects. It stores information about the stop-points of directors used by the sub- tree
in a way that will survive when merging the sub-tree into an object stored in the
object pool.

• Restore Stop Points: Recreates the stop-points used by the director of an object
that has been loaded from the object pool. This uses the information previously
stored by Store Stop Points. When used in conjunction with the Toggle plugin, it will
operate on the object’s animation director.

See Also

• Common Control Plugin Properties

• Control Object

• Toggle

• Transition Logic

12.4.26 Control Omo

 The Control Object moving (Omo) plugin in Viz Artist gives the possibility to add a
group of containers and reveal one at the time. This is done by adding an Omo plugin
on the root container and in its editor specify which of the Sub-Containers to show. The
Omo value can be made accessible for the control client by adding the Control Omo
plugin on the same container as the Omo plugin.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties
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Properties

• Minimum Value: Sets the minimum input value.

• Maximum Value: Sets the maximum input value.

See Also

• Common Control Plugin Properties

• Control Object

• Omo

12.4.27 Control Parameter

 The Control Parameter plugin works with function plugins, and is a very flexible
plugin that can be used to control properties that are not exposed in a specific plugin,
and requires some knowledge in the Viz Artist command language. The parameter to
control must be identified by its command path relative to the container the plugin
is located at. To find the correct command path, open the Show Commands window
(button in the lower left corner in Viz Artist) and make changes to the parameter to
control. The command path will then be shown among the commands. For instance if
the value to be changed is the alpha value in an alpha editor the command window will
show the following:

receive <-1 SCENE*noname*TREE*#805*ALPHA*ALPHA SET 99.0>

#805 is the internal name for the container and the part needed to expose the alpha
parameter (ALPHA * ALPHA). The SET part is added by the plugin. To expose the alpha
parameter for a container write ALPHA * ALPHA in the Parameter section in the plugin
and then set the correct data type which in this case is “Float”.

Another example would be to use Control Parameter to expose and control additional
values like controlling both Pie Max and Max Value. These parameters are dependent
on each other, but both values are not exposed unless the Control Parameter is used.
Adjusting the Pie Max value gives the following:

receive <5679 SCENE*noname*TREE*#378*FUNCTION*PieValues*DATA GET>

In this case the FUNCTION*PieValues*DATA is the parameter that will expose the object
property Pie Max such that it can be controlled through a template.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties
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Properties

• Parameter: Sets the parameter path to the property to enable control for.

• Input Value: Shows the current input value

• Data Type: Sets correct data type depending on the type of parameter to enable
control for.

• Normalize: Enables normalization options, to normalize the input range for the Viz
Trio user.

• Minimum Input: Sets the minimum allowed input value.

• Maximum Input: Sets the maximum allowed input value.

• Minimum Value: Sets the minimum value, which will be set relative to the
minimum input value.

• Maximum Value: Sets the maximum value, which will be set relative to the
maximum input value.

• Prefix: Adds a prefix to all values that are sent to the renderer. This can be used to
show specific text or it can be used to add a path to an object pool for instance.

• Control Parent: When enabled, the parent container is controlled instead.

See Also

• Common Control Plugin Properties

• Control Object

12.4.28 Control Pie

 The Control Pie plugin is able to bind a tab-field to values from PieSlice plugins.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

• To build a pie chart

Properties
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• First slice ID: Sets the tab-field number for the first slice (the first container below
the group that holds the ControlPie Plugin).

• Last Slice ID: Sets the tab-field number for the last slice (the difference between
Last and First should correspond to the total number of slices in the pie chart).

• Expose Pie Max/Total Value: When enabled, the Viz Trio user can set Max value
for a pie slice and Max/Total value for the whole pie chart.

To build a pie chart

1. Add a group container and name it, for instance “pie”. Add the presenter plugin
Pie Values and the control plugin Control Pie to the group.

2. Add a Cylinder object as a Sub-Container to the group. Add material and the
presenter plugin Pie Slice to the new container. Name the container “slice” or
similar.

• The Cylinder object is not visible.

3. Open the Pie Values editor and increase the Value0 property a bit. The cylinder
becomes visible and its size changes.

4. Open the Cylinder editor and set Centre to “Top”.

5. Open the Transformation Editor for the pie group, and rotate the pie group around
90 degrees on the X-axis to make the cylinder top face the camera.

6. Add a font as Sub-Container to the slice container, and add a material to make it
visible against the background.

7. Open the text editor and set the horizontal justification to Centre. Open the
Transformation Editor and rotate the font around the X-axis to -90 degrees and set
Y position to 1.0.

8. Scale the font down a bit so it fits over the slice (for example 0.2).

9. On the slice container, open the PieSlice editor and set Control Text Values to a
data type, e.g. None, Integer, Float or Formatted. By choosing Integer or Float the
slice text will change, displaying the value for the slice.

10. In the pie slice editor, adjust the Text Offset to position the value label relative to
the centre of the pie (for example 70.0).

11. A single pie slice should be ready. Make the number of slices needed by
making copies of the slice container and change their material so they can be
differentiated from each other.

12. Set the different values in the PieValues editor to test.

See Also

• Common Control Plugin Properties

• Control Object

• Pie Slice
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• Pie Values

12.4.29 Control Scaling

 The Control Scaling plugin enables the Viz Trio user to edit transformation scaling
values for objects. Normalization between input and output values can be set by
parameters.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Minimum & Maximum Input: Sets minimum and maximum allowed input values.

• Minimum Scaling: Sets the minimum transformation value which will be set
relative to the minimum input value.

• Maximum Scaling: Sets the maximum transformation value which will be set
relative to the maximum input value.

• Control X, Y, Z- When enabled, it controls the X, Y, and Z-axis independently. The
Viz Template Wizard TripletEditor component has three onChange events available
that accommodates for these parameters.

• Input Value: Shows the current input value. Enter a value to test the relation of
max/min. input and scale values.

• Stop Keyframe: If the scaled object is animated, the scaling values entered must
be put into the end keyframe for the animation. For instance if a user is to create a
bar graph that animates from zero to a value specified, then this is the case. Name
the end keyframe in the Viz Artist stage and enter that name in the “stop keyframe”
field in the control scaling plugin.

See Also

• Common Control Plugin Properties

• Control Object

12.4.30 Control Sign Container

 The Control Sign Container value can show one of three containers based on the
value of a numerical input. The container that holds the plugin must have three Sub-
Containers:
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• A negative value will trigger show the first container.

• A positive value will trigger show the second container.

• A zero value will trigger show the third container.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Input Value: Shows the current input value. Enter a value here to test that the
correct Sub-Container is displayed.

See Also

• Common Control Plugin Properties

• Control Object

12.4.31 Control SoftClip

 The Control SoftClip plugin allows the user to control and browse for video clips
which are played with the Soft Clip plugin in Viz Artist. To make it work, simply add
the control plugin on the same container as the Softclip plugin. Further, specify a Field
Identifier and a Description.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

This plugin does not have any properties or parameters except those that are common
to all plugins.

See Also

• Common Control Plugin Properties

• Control Object
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12.4.32 Control Stoppoint

 Control Stop point enables control of the time value on a stop point. This can
typically be used for setting the length of an animation.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Stoppoint: Sets the name of the stop point to control.

• Director: Sets the name of the animation director where the stop point is placed.

• Stop Time: Sets the stop time in seconds. This is the value that is set by the Trio
operator.

Note: This Control Plugin does not work with transition logic based scenes.

See Also

• Common Control Plugin Properties

• Control Object

12.4.33 Control Text

 The Control text plugin enables editing of a text element. Put the plugin on the text
container and set the parameters. The plugin also works together with all the Text
Effects plugins.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties
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Properties

• Maximal Characters: Sets the maximum number of characters which can be typed
into the text field.

• Upper Case: When enabled, lower case input is converted to upper case.

• Expose Kerning: When enabled, kerning can be adjusted.

• Minimum Kerning: Sets the minimum kerning that can be set.

• Maximum Kerning: Sets the maximum kerning that can be set.

• Expose Line Spacing: When enabled, a minimum and maximum value can be
specified.

• Minimum Line Spacing -Sets the minimum line spacing that can be set.

• Maximum Line Spacing: Sets the maximum line spacing that can be set.

• Single Line: Displays the text using one single line by disabling text wrapping.

• Use Formatted Text: Enables the use of character specific formatting, i.e. kerning,
position, rotation, scaling, alpha, and color.

• Viz Trio: The user can enter a desired formatting mode by pressing the assigned
shortcut key. The Viz Trio user can change the formatting of one or more characters
by holding the <Alt> key down, and shift mode by toggling the right and left arrow
keys. See the Viz Trio User’s Guide for more information on Character Formatting.

• Viz Content Pilot: Not supported.

Note: Formatted text cannot be used together with the TfxWrite text effects
plugin!

• Input Value: Shows the current value for the plugin. It is not necessary to set any
value here. It is used for debugging purposes.

See Also

• Common Control Plugin Properties

• Control Object

12.4.34 Control Targa Alpha

 The Control Targa Alpha plugin binds control of targa video alpha properties to a
Control Object.
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Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Channel: Sets which channel to control.

See Also

• Common Control Plugin Properties

• Control Object

12.4.35 Control Targa Clip

 The Control Targa Clip plugin exposes control over a Targa clip channel. The Viz Trio
user will get a Windows file browser where video clips to play can be browsed for.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Global Clip: When enabled, the clip specified will not be added to the stage but will
play globally in the scene. If deselected two more fields appear; Director and Device
keyframe. The clip will then be loaded at the named keyframe in the specified
director and will run when the director is triggered.

See Also

• Common Control Plugin Properties

• Control Object

12.4.36 Control Video

 The Control Video plugin exposes control over a video codec channel. The user will
get an editor (e.g. Viz Object Store) where video clip files from Viz One can be searched
for.
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Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Loop: Enables or disables continuous looping for a video clip in graphics.

• Toggle Channel: Enables a transition logic scene to toggle between two clips. If
toggle is enabled a new clip will be loaded creating a smooth transition between the
two clips.

• Codec Channel: Sets the codec channel for the video board in use.

• 1: Is normally used as the default codec channel for full screen video.

• 2: Is normally used as the default codec channel for video in graphics.

• Global Clip: When enabled, the clip specified will not be added to the stage but will
play globally in the scene.

• Director: Sets the name of the Director.

• Clip Keyframe: Sets the name of the keyframe.

Disabling Global clip will enable the Director and Clip Keyframe fields. Setting Director
and Clip Keyframe will load the clip at the named keyframe in the specified director and
will run when the director is triggered.

Viz Engine is configured to use 4 video channels, where 2 are dedicated to live feeds,
and the remaining 2 are used for video clips and graphics with embedded video clips.

These are the default options:

• A full screen video in codec channel 1, and graphics with video in codec channel 2.
Full screen video is by default played out in the BACK layer using a default scene.
Default scenes are pre-configured by Vizrt. Graphics are played out in the MIDDLE or
FRONT layer.

• Two videos in graphics without the use of full screen video.

See Also

• Common Control Plugin Properties

• Control Object

• To create a simple video clip scene
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12.4.37 Control World

 The ControlWoC plugin allows you to expose a set of properties to the operator. The
control is a replacement for the Control Map plugin with much more options and on-
the-fly feedback from Viz.

Note: The two controls are not compatible. The new control with not work with Viz
Content Pilot, and is only a part of Viz 3.3 and above.

The control can expose different fields based on the container it resides on. When
tabbing to the control (in a navigator scene) the camera will jump to map location and
all feedback (exact camera position) will be immediate.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties

Properties

• Client Mode: Sets the client mode to Full or Simple. This will, when selecting a
map, open the full or simple map client in the control application.

• Input: Sets the exposed properties. The field is based on the input from the
NavFinder plugin; however, you may also manually change this field.

See Also

• Common Control Plugin Properties

• Control Object

12.4.38 Placeholder

 The Placeholder plugin is used to mark placeholder containers when designing
library objects for Viz Trio compositing. A placeholder container will be available as a
parent to other compositing objects in the scene tree.

Note: This plugin is located in: Built-ins -> Container Plugins -> Control

This section contains information on the following topics:

• Properties
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Properties

• Sort Order: Integral sorting order identifier (lower number is sorted first).

• Description: A description of the tab field or editable object. This will be used as a
description for the elements when used in the control clients.

See Also

• Common Control Plugin Properties

• Control Object

12.5 Default
The following container plugins are housed in the Default folder:

• Trio Scroll Element

12.5.1 Trio Scroll Element

 The Trio Scroll Element plugin is used for data storage by the Trio Scroll, which is
a geometry plugin. It is automatically added to each base element of a Viz Trio scroll
scene.

Note: This plugin is located in: Built-ins -> Container Plugins -> Default

This section contains information on the following topics:

• Properties

Properties

• Prototype: Sets the path and the name of the scene.

• Extra space before element: Sets the space before the element.

• Extra space after element: Sets the space after the element.

• Easepoint 0-4 enabled: Enables the easepoint(s).

• Identifier: Sets the identifier for the easepoint.

• Slow down length (EaseOut): Sets the size in pixels that will be used to ease out
the scroll element.
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• Speed up length (EaseIn): Sets the size in pixels that will be used to ease in the
scroll element.

• Pause time in seconds, or -1 (indefinitely): Sets the time in seconds for how
long the scroll should wait before continuing the scroll. Note that this will affect the
total time the scroll is scheduled to use. See

• Element alignment (0.5 for center): Sets the alignment of the element relative
to the height of the element. 0.5 (equal to 50%) is the default value and represents
the middle of the element’s bounding box area.

• Scroll area alignment (0.5 for center): Sets the scroll alignment for the element
in the scroll area. 0.5 (equal to 50%) is the default value and represents the middle
of the scroll’s bounding box area.

See Also

• Create New Scroll in the Viz Trio User’s Guide.

• Trio Scroll

12.6 Global
The following container plugins are housed in the Global folder:

• Alpha

• Audio

• Clipper

• Expert

• Extrude

• Glow

• HDR

• Key

• Look-At

• Mask Source and Mask Target

• Lighting

• Z-Sort

• Projector Source and Projector Target

• Script

• Shadow Caster and Shadow Receiver

• Synchronized Properties

• Video Clip

• Window Mask

12.6.1 Alpha

 The Alpha plugin adds an alpha channel to the container. The alpha channel defines
the degree of transparency for the container and its Sub-Containers. This feature can
be used to easily fade in or out a complete part of the scene-tree.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global
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This section contains information on the following topics:

• Properties

Properties

• Alpha: Sets the alpha value for the container.

12.6.2 Audio

 The Audio plugin allows a designer to configure audio channels. The Audio plugin
can be applied to any container.

The Audio plugin has four different audio clip mixing modes; Default, FX and Manual.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section contains information on the following topics and procedures:

• Default

• FX

• Manual

• To configure audio channels

• To test audio channel setup

Default

The Default mode uses the Channel settings stored in the clip. For example FrontLeft
and FrontRight are mixed to the aliases FRONT_LEFT, FRONT_RIGHT and so on.

If Viz Engine is configured with fewer channels, Viz Engine mixes the remaining clip
channels according to the channel geometry. For example if Viz Engine only has stereo
configured, but the clip used has 7.1 surround sound, Viz Engine mixes LeftBack and
LeftMiddle to FRONT_LEFT and so on.

Pan slider, Audio plugin

The Pan slider uses audio aliases when adjusting the volume of the left and right
speakers. This is valid for multichannel configurations as well. If the slider is moved to
the right in a 7.1 configuration LeftBack, LeftMiddle and LeftFront will be muted.

Volume, Audio plugin

The Volume field controls the overall audio volume of all clip channels.
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FX

In the FX mixing mode Viz Engine mixes the clip in relation to the listener position
which can be defined in the fields X and Y. Viz Engine takes the channel geometry into
account.

Manual

In the Manual mixing mode it is possible to manually enter the Out Channel alias for
every clip channel. The mask can hold more than one channel. This enables you to mix
every clip channel to an arbitrary amount of out channels.

The syntax for the string is as follows:

CHANNEL_ALIAS%VOLUME+CHANNEL_ALIAS%VOLUME….. 

or

[CHANNEL_ALIAS%VOLOUME]+

Example: FrontRight%50+EnglishLeft%20

To configure audio channels

1. Add a group container to the Scene tree  .

2. Click the Set Key button to add a key frame for the container.

3. Add the Audio plugin to the new group container.

4. Click the Stage (not Server/Stage) button, and select the Dopesheet/Spline
view (Ctrl+4).

5. Right-click the group node, and select Audio -> Clip from the context menu.

6. Click the Server button to return to the Server view.

7. Click the Audio plugin icon to open the Audio plugin editor.

8. Click the Manual button to enable manual configuration of Viz Engine’s audio
channels.

9. Enter the following channel configurations:

• Out Channel 0: FrontLeft

• Out Channel 1: FrontRight

• Out Channel 2: EnglishLeft

• Out Channel 3: EnglishRight

• Out Channel 4: FrenchLeft

• Out Channel 5: FrenchRight

• Out Channel 6: GermanLeft



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 685

• Out Channel 7: GermanRight

Note: You can use aliases as configured in the Channels tab (see Audio
Settings).

10. Save the scene.

Depending on the settings in the channel configuration a clip will now play the different
languages.

To test audio channel setup

1. Create a new scene

2. Add a group container to the scene tree

3. Add the Audio plugin to the group container

4. Open the Audio plugin editor, and add an audio clip to the Test Clip drop-zone, and
click Play

Tip: Always have a set of test clips that will provide audio for the different channel
setups.

See Also

• Audio Settings

• Audio Reference in the Viz Engine User’s Guide.

12.6.3 Clipper

 The Clipper plugin is an alternative to the mask function. Objects with the clipper
plugin attached that are placed behind the clipper plane and will be masked/clipped.
If an object is only partially behind a clipper plane, only the part of the object that are
behind the plane will be clipped out, since the clipping is done in true 3D space. The
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function uses the OpenGL clipping planes. Up to 6 of them may be used. To define a
clipper plane use the Properties Panel (see Modifying Container Items).

All the containers that you want to be affected by the clipping plane, you must have
the clipper plugin applied and thereafter in the editor specify which of the clipping
plane is to mask out/clip the container. It is possible to let a container be affected by
multiple clipping planes.

The clipper plugin can replace mask in many situations. Some of the advantages are
compared to normal mask are:

• Clipping is done in true 3D space, while masking is done in 2D (although the 2D
mask is created by a 3D object).

• There is no performance hit. In fact there is even a performance gain if parts of the
object are clipped. Regular masks have a quite high performance cost.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topics and procedures:

• Properties

• To create a clipping plane effect

Properties

• Planes: Enables the planes. By default 1 is enabled.

To create a clipping plane effect

1. Add two group containers to the scene tree (same level) and name them Cylinder
and ClipperRectangle.

2. Add the following to the Cylinder container:

• Cylinder geometry plugin

• Clipper container plugin
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• Material

• Optional: Expert container plugin

3. Add the following to the ClipperRectangle container:

• Rectangle geometry plugin

• Material

• Optional: Expert container plugin

4. Open the editor for the Cylinder container and set Scaling (locked) to 2.0.

5. Open the Cylinder editor and set Hole to 45.0.

6. Open the Clipper editor and enable Plane 1 (enabled by default).

7. Optional: Open the Expert editor(s) and enable Back Face (On) and Twosided
Lighting.

8. Open the editor for the ClipperRectangle and set the following parameters for the
following properties:

• Set Position Y to 45.0.

• Set Rotation X to -45.0.

• Set Rotation Y to 45.0.

• Set Scaling (locked) to 2.0.

9. Open Scene Settings, and select the Clipper tab.

10. Enable State 1, and Reverse.
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11. Drag and drop the ClipperRectangle container onto the Tracking Object drop zone.

12. Optional: Open the Expert editor(s) and enable the Wireframe mode to see
rendering result, and the effect clipping has on the polygons.

See Also

• Clipper

12.6.4 Expert

 The Expert plugin sets some special properties and adds some advanced functions
to a Container.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topic:

• Properties

Properties

• Draw Mode: Select to have the container drawn either:

• Normal: Shows the rendered object with material and/or textures.

• Wireframe: Shows the polygons that are drawn to create the object.

• Outline: Shows the outline of the object.

• Width: Sets the width of the wires if Wireframe or Outline draw mode is selected.

• Back Face: By enabling this option, an image or a 2D font will be drawn with a
backface. This will of course take more performance to render.

• Twosided Lighting: With this parameter two-sided lighting can be enabled for a
single container instead for a whole scene.
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• Z-Buffer Draw: Select Off to disable the OpenGL z-buffer draw. This is in some
cases the last possibility for solving some z-sort problems. The technical explanation
for this is very complex and will not be described here.

• Z-Buffer Ignore: Set to Off to ignore the OpenGL z-buffer draw option, and will
draw the object no matter if it is in the back or not.

• Line Anti aliasing: 2D objects on machines that do not have anti-aliasing with
multi-sampling, an anti-aliased outline is rendered instead. This extra outline can be
removed by disabling this option.

• Exact Picking: Enables or disables Exact picking for Events. If Exact Picking is
disabled, the bounding box is used instead of a pixel readback.

• Separate Specular: Enables specular highlights for textured geometry.

• Mirror: Enables you to mirror an image/texture or a 2D font over the X-, Y- and Z-
axis.

• Render Mode:

• Add: Symbolically: C*A + FC. The source color gets added to the target color. The
amount of color that is added depends, as we see from the formula, on the alpha
value. However, it is always an addition, so the end result will always be a lighter
color than the initial frame content. If the frame color has high values on all three
color channels (RGB), you might experience that the addition of the new color takes
all channels to values above 255 (saturation). The values will be clamped at 255,
which is white.

• Blend: Symbolically: C*A+(1-A)*FC. The new color value gets created as a weighted
average of the source and the target. The weight factor is the alpha value of the
rendered color. That means that if the incoming color has a very low alpha value, its
influence on the new color will be small, and conversely, if the new color has a high
alpha value, its influence on the new color will be bigger.

• Subtract: Symbolically: FC-C*A. The new color is the result of the incoming color
being subtracted from the color in the frame buffer and the result is written back
into the frame buffer. The alpha value of the incoming color decides how much who
gets subtracted. If the incoming color has high values on all three color channels
(RGB), you might experience that the subtraction of the new color takes all channel
values to 0, and the result is a black color.

• Rev-Subtract: Symbolically: C*A-FC. This is a reversed version of subtractive. The
color in the frame buffer gets subtracted from the incoming color and the result is
written back into the frame buffer.

• Multiply: Symbolically: CA*FC. The new color and alpha get multiplied with the
existing values in the frame buffer. The formula presupposes that the colors and
alpha re described as values between 0 and 1. A color rendered with multiply will
always result in a darker color than both the color being rendered and the color in
the frame buffer.

• Rev-Multiply: This is a reversed version of multiply.

• Max: Higher color values will overwrite lower color values (for example, white draws
over black - independently from the Z-Sort).

• Shade Model

• Flat: Shows the single polygons the texture is made of.

• Smooth: Calculates a smooth texture.

• Transp. Mode

• Blend: Is the standard option.

• Mask: Uses a raster.

• Fastest: Uses the transparency mode which takes the least time to render.
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• High Quality: Uses the transparency mode which delivers the best looking result.

• Draw Layer: Defines if the objects are drawn in all layers or only if it appears in a
certain layer:

• Any: The object is always drawn.

• Main: The object is drawn only if it is in a scene, located in the Main Layer.

• Back: The object is drawn only if it sits in the Back Layer.

• Front: The object is drawn only if it is in the Front Layer.

Note: The Draw Layer option can be used, for example, for a menu in a Scene
which should be only visible if it is loaded in the front layer.

12.6.5 Extrude

 An Extrude plugin can be explained simply as extruding or sweeping the 2D element
through space along its Z-axis. The sweeping path the element is followed during this
process is used to create a surface. A a result a 3D element with front, back and sides
is created from the 2D element.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topics:

• Properties

• To extrude a 2D object

Properties

• Bevel Size: The buttons marked with different bevel types are used to set the type
of bevel to use on the figure.

• Extrusion Depth: Sets the extrusions depth on the Z-axis.

• Bevel Size: Sets the size of the bevel. This must be set to some value to enable the
selection of bevel type.

• Shading Angle: Sets the angle of the shading function. To “erase out” unevenness,
try increasing the shading angle.

• Bevel Detail: Sets the degree of detail of the bevel. The lover the value is set the
more detailed the bevel is constructed. The more detailed the bevel is, the smaller
tilings its constructed from.
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• Backface: Allows you toenable or disable visualization of the backface.

• If colors are set to Active, you can edit the elements Front, Back and Side color
by using the sliders or changing the values.

To extrude a 2D object

1. Create a group and add the Circle geometry plugin and material to it.

2. Add the Extrude plugin to the same container.

3. Open the Extrude editor and select one of the bevel effects, and set Extrusion
depth to 100.0 and Bevel Size to 10.0.

12.6.6 Glow

 Makes the lit faces of objects glow.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topics:

• Properties

• To add glow

Properties

• Blur Width: Sets the width of the blur (i.e. the size of the glow).

• Strength: Sets the intensity/strength of the glow.

• Object Strength: Sets the intensity/strength of the glow on the faces of the object.

• Use Color: When enabled (On), it is possible to set the color of the glow. If not the
glow will be based on the Material added to the object.

• Textured: Uses the color of the texture to determine glow instead of diffuse factor.

To add glow
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1. Add a Sphere geometry plugin to the scene tree.

2. Add material and/or texture to the Sphere container.

3. Add the Glow plugin.

4. Open the Glow editor and set the following parameters:

• Set Blur Width to 20.0.

• Set Strength to 6.0.

• Set Object Strength to 0.0.

• Enable Use Color and set the color parameter.

12.6.7 HDR

 Enables High Dynamic Range Rendering/Imaging for the selected container. This
improves the contrast of the generated scene in a much more realistic way.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topic:

• Properties

• To add HDR

Properties

This plugin does not have any properties or parameters.

To add HDR

• Drag the plugin on a container and modify the HDR settings under Scene setting/
hdr. You can specify a diffuse and a Cubic Reflection image.

12.6.8 Key

 Key adds a Key signal to a container.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topic:

• Properties

Properties

• Draw RGB: Disable this if you do not want the graphical object to be shown, just
the key signal.

• Draw Key: Enables/disables the key signal.
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• Automatic Alpha: If you disable the automatic alpha option, you can set the value
manually. This is normally done to obtain some level of transparency so that, for
example, video background is visible through the key object.

• Alpha as Key only: Takes the alpha value of the object and renders the key with
this alpha instead of the alpha value of the key function attached. The object itself
is rendered opaque. This is usually used to render transparent objects for keyed
graphics. The “color mixing” of the object in the scene and the for example video
background is done by the external keyer so the object must be rendered non
transparent.

• Render Mode: This option sets the mode in which the alpha values of the key
element you are rendering should be mixed with the alpha values already existing
in the frame buffer. Be aware that with the subtractive and the rev-subtractive,
mode the order in which the objects are being rendered then is crucial. So make
sure the z-sort is correct. The mixing is being performed on a per pixel basis (in the
formulas the range of the alpha values is from 0-1, instead of 0-100 as in the value
field). If we say A is the current source alpha value being rendered now and FA is the
alpha of the frame buffer contents (target), the different modes can be explained as
following:

• Add: Symbolically: A + FA. The source alpha gets added to the target alpha. As
the formula shows it is an addition, so the end result will always be a higher alpha
value than the initial frame content. If the frame alpha has a high value, you might
experience that the addition gives a total value above 1. This will be clamped at 1
which is opaque.

• Blend: Symbolically: A+(1-A)*FA. The new alpha value gets created as a weighted
average of the source and the target. If we as an example say that the key being
rendered has alpha 1 and the frame alpha has 0.5, the formula will be like this:
1+(1-0.5)*0.5 = 0.75.

• Subtract: Symbolically: FA-A. The new alpha value is the result of the incoming
alpha being subtracted from the alpha in the frame buffer and the result is written
back into the frame buffer.

• Rev-Subtract: Symbolically: A-FA. This is a reversed version of subtractive. The
alpha in the frame buffer gets subtracted from the incoming alpha and the result is
written back into the frame buffer.

• Max: Uses the maximum of all key signals.

To add key

1. Open a scene, and add the Key plugin to a container with an object on it.

2. Click the Key button on the left side of the Scene Editor.

See Also

• Global Settings

12.6.9 Look-At

 The look at plugin is used to rotate a container so that it faces the direction you
define. This is especially valuable in animations.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global
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This section also contains information on the following topic:

• Properties

Properties

• Auto Rotation

• None: No rotation.

• Billboard: Will rotate the container to face the camera.

• Follow Path: Will rotate the container to justify at the animation path.

• Billboard Axis: Is enabled when selecting Billboard.

• X: The container will rotate about its X-axis to face the camera, even if camera
moves

• Y: The container will rotate about its Y-axis to face the camera, even if camera
moves

• XY Camera: The container will rotate about its X- and Y-axis to face the camera,
even if it moves

• XY Screen: The container will rotate about its X and Y-axis to face the camera if the
camera orbits the container only.

See Also

• Creating Animations

12.6.10 Mask Source and Mask Target

 With the mask plugin you can make one container act as a mask for others. The
mask container is called the source and the containers being affected by the source
mask are called targets. A container being affected by a mask becomes transparent
where the mask covers it.

There is one editor for the mask source and another for the mask target where you can
define by which layer the object is affected.

You can use up to eight different target layers and source layers for one object. This
means that targets with the layer 1 set will be affected by all masks which have the
corresponding layer selected. If a mask has the layers 1, 2 and 3 selected it will be
affect all targets that have 1, 2 or 3 selected.
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Shadow layers, Global Settings

Layers 7 and 8 may not be available because global shadow settings by default are
enabled. Shadows use two layers of the mask plugin, but can be switched off under the
Global Settings to use all eight layers.

Under the Global Settings you can also define if a mask layer is to be drawn inverted.
Normally the mask cuts a hole in the mask target where it covers it. If you select a
layer to be drawn inverted the opposite situation is the case. Only where the mask
covers the mask target will the target be visible.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topics:

• Properties

• To add masks

Properties

Mask source and target editors

• Layer: Sets the layer the mask should have an effect on. This allows you to create
more than one mask that will have an effect on the target.

• Inherited: When enabled (On) all Sub-Containers of the mask source will mask
the target. If disabled (Off) all Sub-Containers of the mask source will not mask the
target as it no longer inherits the mask properties.

To add masks

1. Add three groups to the Scene Tree

2. Name them source_1, source_2 and target

3. Add a Font and the Mask Source plugin to the source_1 group

4. Add a Rectangle and the Mask Source plugin to the source_2 group

5. Add a Rectangle, material (e.g. red) and the Mask Target plugin to the target
group

6. Open source_1’s Transformation Editor and set Axis Center X and Y to C, and
then reset Position X and Y to 0.0
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7. Open source_1’s Text Editor and enter some text (e.g. Vizrt)

8. Open source_1’s Mask Source editor and set Layer to 1

9. Open source_2’s Transformation Editor and set Position X to -120.0 and Y to
-70.0

10. Open source_2’s Rectangle editor and set Width and Height to 50.0

11. Open source_2’s Mask Source editor and set Layer to 2

12. Open target’s Rectangle editor and set Width to 300.0 and Height to 200.0

13. Open target’s Mask Target editor and enable Layer 1 and 2

• This should make the graphics look something like the image below.

14. Add a new group as a Sub-Container of source_2 and name it source_inherited

15. Add a Circle to the source_inherited group

16. Open source_inherited’s Transformation Editor and set Position X to 240.0

17. Open source_inherited’s Circle editor and set Radius to 25.0

• This should make the graphics look something like the image below.

18. Open source_2’s Mask Source editor and disable Inherited (Off)
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• This should make the Circle disappear as it no longer inherits the Mask Source
properties.

12.6.11 Lighting

 Adds individual lighting per object.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topics:

• Properties

• To add masks

Properties

• Type: There are three light source types:

• Local: The Local light source is a positional light. It is near or within the scene,
and the direction of its rays is taken into account in lighting calculations. Local
lights have a greater performance cost than directional lights, due to the additional
calculations. A real life equivalent to a local light source is a light bulb. The Local
light source has properties for color and position.

• Spot: The Spot light source emits a cone of light. The only objects that are
illuminated are those within the cone. The Spot light source has properties for color,
position, rotation, and attenuation.

• Infinite: The Infinite light source is a directional light. It is considered to be an
infinite distance away from the objects in the scene. Because of the distance,
the rays of light are considered parallel by the time they reach the object. A real
life equivalent to an infinite light source is sunlight. The Infinite light source has
properties for color, position, and rotation. Infinite is selected by default.

• Color: Sets the light source color.

• Position: Sets the position of the light source along the X, Y, and Z axis.

• Rotation: Sets the values for Pan, Tilt, and Twist for Spot or Infinite light sources.

• Spot: Sets the concentration of the light within the light cone of the Spot light
source. When set to zero, the whole light cone has the same intensity. If set greater
than zero, the intensity decreases away from the centre.
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To add lighting

1. Open the Light Editor, and disable global light settings.

2. Add a Sphere geometry to the scene tree, and add material and the Lighting
plugin to it.

3. Duplicate the Sphere container and place it at the same level (root) as the other
container.

4. Open the transformation editor and set Position X to -100.0 for the first container
and Position X to 100.0 for the second.

5. Open the Lighting editors the first container one and set the following parameters:

• Set Type to Spot.

• Set Light Color to 0,255,0.

6. Open the Lighting editors the second container one and set the following
parameters:

• Set Type to Spot.

• Set Light Color to 0,255,0.

• Set Position X and Y to 650.0 and -850.0, respectively.

• Set Rotation X and Y to -650.0 and 850.0, respectively.

12.6.12 Z-Sort

 When this plug-in is applied to a group, it disables back to front automatic sorting for
the immediate children of that group. This enables designers to set the rendering order
manually.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topics:

• Description

• Transparency, Rendering Order Logic and Priority

Description

To sort objects of a scene on the Z-axis is essential for any 3D program to render
correctly. The renderer starts by rendering the object furthest behind, and then mixing
in objects closer and closer to the camera. Sometimes the machine gets “confused”
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with what should be rendered first and last because it calculates this from what is the
center of the object’s Z position.

A typical example of a Z sort problem is when two colored objects have rotated their
Y axis to for example -12.0. In this case the default behavior for a render engine is to
render the first object (green) with a Z position 0.0 first, and then the second object
(red) with Z position 1.0 last.

However, when objects are rotated the output will be wrong because the red object
should be rendered before the green due to the rotation of the objects. This can be
corrected by adding the Z-Sort plugin, which lets users manually sort objects using the
logic of the tree structure. Hence, what is placed at the top of a group in the scene tree
gets rendered first, and what is placed below will be rendered after.

Sorting is solved by rendering the second (red) object first, and then the first (green)
last. Be aware that although the red object has a Z position of 1.0 and the green 0.0,
the red object must be rendered before the green because of the overlapping rotation
(Y -12.0). Normally objects that are furthest behind should be placed at the top in the
scene tree.

The Z-Sort plugin disables the automatic Z-sort for a Container. How the elements in
the Container get sorted in the Z-buffer is then dictated by the order of the objects in
the scene tree.

Transparency, Rendering Order Logic and Priority

Questions

• Why does a scene look different when a parent container is set to 99%
transparency?

• Why are do some Containers disappear?

• When should the Z-Sort Off Plug-In be used?

Explanation
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The explanation to why changing an alpha plug-in to 99% on a parent container,
which affects the way objects are rendered, is the Rendering Order. When rendering
polygonal Scenes with transparencies (like those created in Viz Artist) the rendering
order is important with the current architecture of graphics cards.

The common practice for 3D applications is to render semi-transparent objects from
back to front (or rather from far to near).

Example: Think of a scene that shows a city skyline through of a semi-
transparent window. Lets assume that the window is rendered before the skyline.
Some background color is applied to the screen, then the window is rendered.
The graphics card will blend the color of the window with the background color
(say, blue). In addition to color the graphics card will also mark the distance of the
window’s pixels from the camera for each pixel, so that farther away pixels will
not obstruct the window. This technique for achieving obstruction between objects
on per-pixel basis is called Depth-Buffer or Z-Buffer. Now render the skyline. The
color of the skyline should have been blended with the color of the window, but it
will not. The graphics card will reject every skyline pixel because its distance from
the camera is farther away than the distance of the window pixels. This is a case
where the positive role of the Depth-Buffer produces undesirable results.

To avoid this undesirable result, Viz Artist splits the rendering of the containers in the
Scene into three parts:

1. The mask objects are rendered first to ‘mark’ the areas of masking on the screen.

2. The opaque objects are rendered front to back.

3. The transparent objects are rendered back to front.

Viz decides whether an object is transparent based on some criteria, for example:

• If the texture of the object has an alpha channel

• If the material of the object has an alpha value less than 100%

• If the object has an inherited ALPHA function with an alpha value less than 100

• and more...

With all this said, rendering back to front is not perfect because the rendering order
is not done per pixel; rendering is not even done per polygon. Viz renders a scene per
complete container; container order is based on the center of the container.

Example: Take a tilted flat map with icons. The map container is large, and its
center is in front of some of the icons, but in the back of other icons. Assuming the
icons have transparency the map will actually be rendered in between the icons!
This behavior is visually incorrect as the map should be rendered first, then all the
icons.

Solution

This behavior can be fine-tuned using the Z-Sort Off Plug-In. When this plug-in is
applied to a group, it will disable back to front automatic sorting for the immediate
children of that group. This enables designers to set the rendering order manually.

Notes/Exceptions

• If an alpha plug-in at 99% is applied on the top container it can force the whole
collection of containers to be sorted back to front, and can solve the problem, but
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this is not a best practice. There is much more overhead rendering a scene like this.
A more permanent solution would be to optimize the scene with the Z-Sort Off Plug-
In.

• Opaque objects are better rendered from front to back because there is some
performance gain for each obstructed pixel (it is not being processed after being
rejected). With that being said opaque objects can be rendered at any order.

12.6.13 Projector Source and Projector Target

 The projector and the projector target is used to project something on something
else (e.g. an image onto a geometry).

A projector container creates a planar projection of their texture onto container(s) with
the projection target function attached. In principle it works similar to a slide-projector.
For objects that do not have texture coordinates, the projector function can be used
to apply texture to such objects. It also gives the possibility to have two textures on a
single object, the objects own texture and the projected texture.

The projector and the projection target can be set up to react on different layers similar
to shadows and masks.

Note: The projector plugin does not work on text.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topics:

• Properties

• To project a texture onto an object

Properties

• fovy: Sets the field of view for the projector container. The higher the fovy is set,
the larger the projected texture on the receiver will be. You can picture it as the
zoom function of a slide projector.

• Show: Allows you to hide/show the projector object.

• Layer: Lets you select by which layers the projector and receiver are to perform
the function. You can use up to 8 different projector layers and source layers for one
object. This means that targets with the layer 1 set will be affected by all projectors
which have the corresponded layer selected. If a projector has the layers 1, 2 and 3
selected it will affect all targets with 1, 2 or 3 selected.

• Layer: Lets you select by which layers the projector and receiver are to perform
the function. You can use up to 8 different projector layers and source layers for one
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object. This means that targets with the layer 1 set will be affected by all projectors
which have the corresponded layer selected. If a projector has the layers 1, 2 and 3
selected it will affect all targets with 1, 2 or 3 selected.

To project a texture onto an object

1. Add a group container to the scene tree, add the Projector and Alpha plugin to it,
an image/texture, and name it Source.

2. Open the Alpha editor and set the alpha value to 50.0%.

3. Open the transformation editor for the Source container and set Rotation Y to
135.0.

4. Add another group to the scene tree, and name it Target.

5. Open the transformation editor for the Target container, and set Position X to
130.0.

6. Add the Sphere geometry plugin, material, image/texture and the Projector Target
plugin to the Target container.

7. Optional: Animate the sphere.

8. Open the Projector editor and disable the Show property.

12.6.14 Script

 The script functionality in Viz is a plugin in itself. Scripts can be added to a container
or the Scene Settings, and is stored with the scene. It is possible to archive and import
scripts as part of a scene archive as with any other plugin.

In addition it is possible to create your own script plugins by dragging a compiled script
into the ScriptPlugins folder. The ScriptPlugins folder is a special folder that allow
users to create and name their own plugins. Note that script plugins are saved to the
same plugin folder where Viz has its own plugins.

Viz plugins are located in the following folder: C:\Program Files\Vizrt\Viz3\plugin
\

A script plugin is not stored in the database, and as a consequence not distributed with
an archive because it is code and not data.

There is an important difference between a script that is not converted into a plugin,
and a script that is. As long as it is not converted the content of the script code is data
within the “Script” plugin, just like the width property is data within for example a
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geometry plugin. Once the script is converted to a plugin it is a plugin itself, like any
other plugin.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topics:

• Properties

• To create a plugin from a script

• To edit a script plugin

Properties

•  Arrow buttons: Clicking the vertical arrow buttons detach or attach the Script
Editor from or to the Viz interface. While detached the script editor can be scaled to
any size.

• Compile & Run: checks the code entered and translates it into byte code, so
the script can be run. If an error occurs, you will find a message shown in the text
above.

• Cancel: Ignores the last source code changes and compiles previous version.

• Find enables you to search for a string in the script. To do so, enter the string you
search for in the input box and press F3. Alternatively you can select a string in the
script editor and search for this string by pressing F4.

• Functions: Shows a list of used functions in the script (both built-in and self defined
ones). Select a function in the list and you will jump there in the script editor.

• Events: Provides a list of built-in events. Select one there to add it to the script.

If you select a string in the script editor and do a right-click, a shortcut menu will open.
Here you can select one of the following actions:
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• Find Search String: Is only available if you have entered a string into the Find
input box. If you select this, the search string will be found.

• Find Selected (F4): Performs a search for the next occurrence of the selected
string.

• Increase Indent (Tab): Increases the indent of the selected text.

• Decrease Indent (Shift+Tab): Decreases the indent of the selected text.

• Comment: Comments the selected text.

• Uncomment: Uncomments the selected text.

• Font Size: Sets the font size. Available options are; 8, 10, 12 or 14.

• Bold: Sets the font to bold.

To create a plugin from a script

After you have finished creating your script, you may want it to save it as a plugin
order to use it for other scenes.

1. Open the Container Plugins directory and select the folder ScriptPlugins.

2. In the Script Editor, click the Compile & Run button.

3. Drag and drop the Save Script icon (located above Compile & Run button in the
Script Editor) onto the ScriptPlugins folder.

4. Enter a name for the plugin, and click OK.

• The plugin is saved to the plugin

To edit a script plugin

1. Add a group container to the scene tree, and add the Script plugin to it.

2. Open the Script Editor, and drag and drop the script from the ScriptPlugins folder
onto the script editor.

12.6.15 Shadow Caster and Shadow Receiver

 The Shadow Caster and Receiver plugins are used to enable an object’s shadow
to reflect on another object. To create a shadow element in a scene, two containers at
a minimum must be used. The caster plugin must be attached to one container and the
receiver function to the other.

The container acting as the caster must be positioned between the receiver container
and a light source.

Objects that can function as a shadow receiver should be a built in 2D geometry or a
font. An imported 2D will not work.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global
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This section also contains information on the following topics:

• Properties

• To cast a shadow

Properties

• Lights: Allows you to select which light sources are to shine on the caster object
and thereby producing the shadow/shadows.

• Alpha: Sets the alpha value and hence the transparency of the shadow being cast
on the receiver objects.

• Color: Allows you to define the shadows color.

• Auto-Fading: With this option enabled, if you fade out a caster object either
by using the alpha function or by adding a material with a low alpha value, the
shadows created by the caster will fade correspondingly. The option is enabled by
default, since it looks right that the shadow fades out when the caster object fades
out.

• Layer: Allows you to select by which layer(s) the caster will cast shadow. You can
select up to 8 layers. Each layer corresponds to the layer selected in the Receiver
objects. If you want all shadow casters to cast shadow on all receivers, you can set
all layers on all casters and receivers to 1. If you want one caster to create shadow
on some receivers and another caster to create shadow on different receivers, you
select different layers for the sets of casters and corresponding receivers. Casters
and receivers can have multiple layers enabled at the same time so you can set up
a great number of combinations of caster/receiver combinations.

• Alpha: Sets the alpha value.

• Clipping: With clipping enabled the shadow will be cut on the border of the object.
With clipping disabled, the shadow will be rendered onto the background outside the
object, which normally looks wrong. Rendering with the clipping options set takes
more resources than without. If you for instance have an infinite floor or a room with
walls, you can switch of clipping without seeing the “false” shadows, and thereby
save some rendering performance.

• Culling: With culling enabled, Viz Artist will decide in advance of the rendering
process if the shadow will be visible or if it will be hidden by other objects. If that is
the case it will skip it in the render process. If you know for sure that the shadow for
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an object in a scene will be rendered visible for the whole object, you can disable
culling to save some rendering time, but the effect is marginal.

• Show Receiver: Hides or shows the receiver object. If it is hidden, the shadow will
still be visible.

• Draw Key: Adds key to the shadow. When enabled, the receiver must be hidden for
the key to be drawn.

• Key Value: Sets the key value.

• Layer: Allows you to select by which layers the receiver will receive shadow. You
can select up to 8 layers. Each layer corresponds to the layer selected in the caster
objects. If you want all shadow casters to cast shadow on all receivers, you can set
all layers on all casters and receivers to 1. If you want one caster to create shadow
on some receivers and another caster to create shadow on different receivers, you
select different layers for the sets of casters and corresponding receivers. Casters
and receivers can have multiple layers enabled at the same time so you can set up
a great number of combinations of caster- and receiver combinations.

To cast a shadow

1. Add a group container to the scene tree, and name it Sources.

2. Add a font, Sphere and Cylinder geometries as a Sub-Container of Sources, and
add material and the Caster plugin to it.

3. Add a group container at the same level as the Sources container, and add a
rectangle geometry, material and the Receiver plugin to it.

4. Position the rectangle and the other objects such that the Sphere, Cylinder and
text casts a shadow on the rectangular surface.

Caution: Containers are rendered twice when shadows are used.
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12.6.16 Synchronized Properties

 The Synchronized Properties plugin can be used to synchronize container property
changes within the same scene loaded on a cluster of Viz Engines. For example: A
renderer with touch screen controls a stereoscopic interactive scene which is rendered
on 2 other engines. All 3 engines need to perform all property or transformation
changes at the same time.

This feature is available in the latest viz 3.3 versions and works for all container
properties and plugin parameters.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topics:

• To synchronize scene property changes on multiple Viz Engines

To synchronize scene property changes on multiple Viz Engines

• Add the Synch. Properties plugin on all containers that should be synchronized (no
scripting is needed).

Note: The Synchronized Property plugin does not inherit to child containers to
keep network traffic low.

See Also

• To synchronize multiple Viz Engines

12.6.17 Video Clip

 The Video Clip plugin works in combination with the Control Video plugin (not
with the Control Targa Clip). It allows you to use clip keyframes in the stage for clip
playback. When used with Transition Logic the keyframes can be merged with the
object.

Note: The Control Targa Clip only allows the use of global clip channels when used
in transition logic scenes, or clip keyframes when used in standalone scenes.

When Video Clip is used in transition logic scenes it allows a Toggle between the two
clip channels. So a single object will playback any clip, and the Toggle plugin in a
transition logic scene will make sure that the channels toggle correctly, which again
allows for transitions between two running clips. The plugin also toggles the clip texture
if texture mode i selected.

The plugin is commonly used in a video workflow using Viz One. It automatically adds
a Clip Channel plugin. The clip channel has to be activated using the Video Input
configuration section.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global
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This section also contains information on the following topics:

• Properties

• To add a video clip

Properties

• Channel: Sets the clip channel to be used. Available options are; Clip channel 1 and
2.

• Target: Sets the clip mode. Setting target to DVE adds default keyframes to the
stage. Setting target to Texture adds the Live texture plugin and default keyframes
to the stage. Available options are; Inactive, DVE or Texture.

• Volume: Sets the clip volume in percentage.

To add a video clip

1. Check the configuration to see if clip channels are activated.

2. Add the Video Clip plugin onto a geometry (e.g. a rectangle).

3. Select Clip Channel 1 and Type Texture.

4. Switch to the Stage and select the Clip under VideoClip.

• On the right side the clip to be played can be selected.

• Additional keyframes can be added to play different clips.

See Also

• Implementing Video

• Animation Stage

• Toggle

• Control Video

• Transition Logic

12.6.18 Window Mask

 Window Mask limits the area into which a Sub-Container of the Window Mask plugin
is rendered to a user-defined rectangular section of the output.

It is possible to add a tracking object. If a tracking object is used, its bounding box is
projected onto the screen and the resulting rectangle is used as a mask.

Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section also contains information on the following topics:

• Properties

• To use the Window Mask
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Properties

• Position X, Position Y: Specifies the upper left corner of the rectangle. The values
are scaled in such a way that (0, 0) refers to the upper left and (100, 100) to the
bottom right corner of the screen.

• Width, Height: Specifies the dimensions of the rectangle in percentages of the
screen dimensions.

• Tracking Object: Provides an alternative to setting the position and dimensions
manually. When you drag a container from the scene tree onto this drop zone,
the rectangle will automatically be adjusted to match the position and size of that
container. Inactive will toggle tracking on and off. To remove the container click on
Reset.

To use the Window Mask

1. Add a Rectangle geometry to the scene tree, and add material to it.

2. Open the Rectangle editor and set Width to 200.0.

3. Open the transformation editor and set Position Y to -36.

4. Add a new group, and add the Window Mask plugin to it.

5. Add a Sphere geometry as a Sub-Container of the group container, and add
material to it.

6. Open the Window Mask editor and drag and drop the Rectangle container onto the
Tracking Object drop zone.

• This should give you a sphere that is partly masked due to the rectangle
object.

12.7 MPS
The following container plugins are housed in the MPS folder:

• ExposeToVizkyAPI

Note: MPS is a discontinued product. MPS Plugins are only here for compatibility
any possible issues.

12.7.1 ExposeToVizkyAPI

 Used in conjunction with the Control Text plugin. It allows you to use JavaScript to
change text values directly in scenes loaded in Vizky instead of using GOD to update
MPS files with new data.
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Note: This plugin is located in: Built-ins -> Container Plugins -> Global

This section contains information on the following topics:

• Properties

• To use the ExposeToVizkyAPI plugin

• Using JavaScript

• JavaScript Example

Properties

The only parameter is Enable. Yes enables and No disables.

The default setting is Yes.

To use the ExposeToVizkyAPI plugin

1. Click the Create Group button to create a root container. See Adding Empty
Containers.

2. In the main menu, click Server, then click the F tab for fonts.

3. Select a font and drag it into the scene tree as a Sub-Container of the group just
created.

4. In the main menu, click Built Ins, then click the Container Plugins tab.

5. In the Folders panel to the left, click Control.

6. Select the Control Text plugin and drag it into the font container.

7. Define the ControlText field identifier. This is the reference used in the JavaScript.
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8. Rename the root container to object.

9. In the Folders panel to the left, click MPS.

10. Select the ExposeToVizkyAPI plugin and drag into the font container.

11. Save the scene.

Using JavaScript

Refer to the MPS Client Manual. The relevant chapters for using JavaScript and the
Vizky APIs are as follows:

• Vizky Java Scripting Guide

• Vizky Client API Overview

JavaScript Example

                              Control.SetControlChannelData(
               <InstanceSceneID>, <Control Text Name>, <Text Value>
               )
            

This command is used when you want to change the value of the text which was
composed with the ExposeToVizkyAPI plugin.

There are three parameters:

1. InstanceSceneID

From Import and Load Vizky API commands. Both must be used when downloading
MPS files.

ExternalSceneID = Control.Import(StationID, MPSFileLocation);
InstanceSceneID = Control.Load(StationID, ExternalSceneID);



Viz Artist User’s Guide

Page 712 Copyright © 2014 Vizrt

The InstanceSceneID is used as the main parameter with many functions in
JavaScript. Other examples are StartDirector and ResetDirector control animation
in downloaded MPS files.

2. Control Text Name

The control text Field Identifier’s name. This refers to the text whose value you
intend to change, identified by the ControlText plugin’s Field Identifier.

3. Text Value

The new value to replace or change, identified by the ControlText plugin’s Field
Identifier.

See Also

• MPS Client Manual

12.8 MultiTouchComp
The Multi-Touch plugins are used to take incoming touch events, process them and
then trigger events, perform transformations on objects, telestrate, or trigger script
events. The idea behind these plugins is to bundle often used or needed functionality
and eliminate the need to write your own scripts or plugins for that.

They are great tools to bring Multi-Touch interactivity fast and easily into a Scene.

The following Container plugins are housed in the MultiTouchComp folder:

• MtTelestrator Plugin

• MtButton Plugin

• Mt2D Control Plugin

• Mt3D Control Plugin

• MtNavigator Plugin

The Container Plugins require the MtSensor Plugin to be available to work. If a
MultiTouchComp Container Plugin is added to a Scene it will automatically add the
MtSensor Plugin to the Scene if it is not there.

The MultiTouchComp Plugins can communicate with Viz scripts, either through event
handlers, Shared Memory variables, or Data Pool variables. The Plugins can also be
controlled by triggering the ‘pushbuttons’ and/or setting the ‘parameter’ variables
exposed by the Plugin. Specifics on what features are available for each Plugin are
documented in the Plugin specific sections below.

In the Viz Artist editor interface the 'E' button toggles between enabling and disabling
emulated sensor input using the mouse as well as direct input from a sensor.

The Plugins will work with multiple layers. Each Scene layer with multi-touch objects
installed in it should also have an instance of the MtSensor Plugin automatically
installed.

This section contains information on the following topics:

• Plugin Event and Notification System
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12.8.1 Plugin Event and Notification System

All the Multi-touch (Mt) Plugins share a common event notification module and
associated configuration interface.

For all Plugins that generate events, events are dispatched up the Container hierarchy
from the Plugin’s Container to the first script found with a handler present for the event
being generated.

For Plugins that optional update values in Shared Memory, choose which one of the
three maps to have updated:

• System

• Scene

• Distributed

Each shared memory area updated by a Plugin is composed of one ‘root’ variable
specified in the ‘Shared Memory Prefix’ field in the Plugins user interface. This ‘root’
variable is updated if any of its additional sub-fields are updated. The root variable
contains an integer or ‘update id’. Sub fields are identified by adding ‘dot delimited’
suffix on the root name. For example, if ‘Shared Memory Prefix’ is set to ‘Name’ the sub
field ‘field’ would be identified as ‘Name.field’ in a Viz script.

For all Plugins that can set a Data Pool variable, each has a ‘structure’ defined in a
‘.dp’ file. There is one ‘.dp’ for each Plugin. Both the file and the name of the structure
defined by it are the same as the name of the Plugin. For example, in the case of
an MtButton, the file is ‘MtButton.dp’ and the name of the structure for sub element
access is ‘MtButton’.

12.8.2 MtTelestrator Plugin

 The MtTelestrator plugin is used to do telestration on a Container level (Used with
the GraffitiTex plugin (added automatically to the same Container)).

For scene-wide telestration the MtSensor Plugin has a telestration feature.

Note: This plugin is located in: Built-ins -> Container Plugins -> MultiTouchComp

This section contains information on the following topics:

• MtTelestrator Configuration

• Events and Notifications

• To Create a Simple Scene with Telestration

MtTelestrator Configuration

• Active: Select On (enable) or Off (disable) telestration input from user

• Minimum Telestration Width: Minimum brush width to assign based on pressure
applied to sensor

• Maximum Telestration Width: Maximum brush width to assign based on pressure
applied to sensor

• Color: The color to assign for subsequent telestration drawing
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• Id: To give additional context in the handler script, specify a string that will identify
any notifications dispatched by this Plugin. This is often included as an argument for
the event so a common script may handle events from a number of Plugins.

• Set Shared Memory: If ON enables shared memory to be updated for the Plugin
notifications.

• Shared Memory Prefix: This sets a ‘prefix name’ to be prepended to the shared
memory variables maintained by the Plugins notifications. For Plugins that maintain
multiple fields each field name has the prefix prepended to it followed by a dot
‘.’ so as to mimic member access to an object, i.e: if the prefix is ‘Obj’ the fields
‘field1’ and ‘field2’ would be identified with the strings ‘Obj.field1’ and ‘Obj.field2’.
The shared memory field ‘Obj’ is also maintained and is simply an integer that is
modified every time any of its ‘subfields’ is updated.

• Shared Memory Type: Click either Global, Scene, or Distributed. This selects the
shared memory area to update.

• Set Data Pool: Shows ‘you wish’ Plugin notifications to set a Data Pool variable

• Data Pool Variable: Shows the name of the Data Pool variable to have set.

• Init: Clear current telestration and make Telestration active

• Clear: Clear the contents of the attached telestration

See Also

• Events and Notifications

Events and Notifications

The events dispatched by MtTelestrator are:

• OnTelestrationStateChange (sent when telestration is activated or de-activated):

• PluginContainer as String

• Id as String

• TelestrationOn as Boolean

• OnTelestrationColorChange (sent when telestration is activated or de-activated):

• PluginContainer as String

• Id as String

• PenColor as Color

• OnTelestrationClear (sent when telestration is cleared):

• PluginContainer as String

• Id as String

• TelestrationOn as Boolean

The shared memory field names are:

• PluginContainer: the name of the Plugins container or ‘’ if attached to a scene

• Id: the user ID string entered in the notification interface

• PenColor: the current pen color

• Active: 1 if telestration is active, 0 if not

The Data Pool structure updated is:

• MtTelestrator:
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• string PluginContainer

• string Id

• string PenColor

• string Active

To Create a Simple Scene with Telestration

Note: If a touch screen is not available then go to Viz Config and set Multi Touch
input to Mouse (see Communication)

1. Create a new Scene.

2. Add a new group Container.

3. Add a Rectangle Geometry to the Container.

4. Add the MtTelestrator plugin to the Container (Container plugins >
MultiTouchComp).

Note: The GraffitiTex plugin is added to the Container automatically.

5. Set the Active parameter for the MtTelestrator and GraffitiTex to ON (in the
Properties Panel).

6. Open the Scene in On Air. Use the touch input device to create freehand drawing.

7. Use the MtTelestrator and GraffitiTex plugin editors to modify the telestration
affect, as required.

See Also

• MtTelestrator Configuration

• GraffitiTex Plugin

12.8.3 MtButton Plugin

 The MtButton Plugin triggers an action when tapped or pressed.

The MtButton Plugin will make a container or its immediate children act as buttons.
Several methods may be used to trigger the buttons. They are selected in the Viz UI
with the ‘Trigger Type’ radio button.

The MtButton can be enabled or disabled. When the button is disabled, any tap or
stroke input it receives will not trigger the associated events. The button can be
enabled or disabled through the Plugin parameters, or through a command. A button
which is disabled after a stroke has pressed on a button will NOT prevent generation of
events for a stroke that is currently active.

Note: This plugin is located in: Built-ins -> Container Plugins -> MultiTouchComp

This section contains information on the following topics:

• MtButton Configuration

• Events and Notifications

• To create a Simple Scene with the MtButton Plugin
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MtButton Configuration

• Id: To give additional context in the handler script, specify a string that will identify
any notifications dispatched by this Plugin. This is often included as an argument for
the event so a common script may handle events from a number of Plugins.

• Set Shared Memory: If ON enables shared memory to be updated for the Plugin
notifications.

• Shared Memory Prefix: This sets a ‘prefix name’ to be prepended to the shared
memory variables maintained by the Plugins notifications. For Plugins that maintain
multiple fields each field name has the prefix prepended to it followed by a dot
‘.’ so as to mimic member access to an object, i.e: if the prefix is ‘Obj’ the fields
‘field1’ and ‘field2’ would be identified with the strings ‘Obj.field1’ and ‘Obj.field2’.
The shared memory field ‘Obj’ is also maintained and is simply an integer that is
modified every time any of its ‘subfields’ is updated.

• Shared Memory Type: Click either Global, Scene, or Distributed. This selects the
shared memory area to update.

• Set Data Pool: Shows ‘you wish’ Plugin notifications to set a Data Pool variable

• Data Pool Variable: Shows the name of the Data Pool variable to have set.

• Active during screen wide telestration?: If the button to is to stay active when
the screen-wide telestrator is on, set to On. The default is off, which means the
button cannot be triggered when telestration is on.

• Trigger type:

• On Touch: Sets the buttons to generate an ‘onTrigger’ event immediately when
they are touched. No other events are generated in this mode.

• On Release: Sets the buttons to generate an ‘onTrigger’ event when the last stroke
present over a button is released. onStrokeEnter() and onStrokeLeave() events are
generated as strokes enter and leave the button (see protocol below).

• On Tap: Sets the buttons to generate an ‘onTrigger’ event when strokes recognized
as ‘taps’ occur after a button is quickly pressed and released without movement or
a finger is held down on a key on an object. onStrokeEnter() and onStrokeLeave()
events are also generated in this mode.

• Taps Only: Sets the buttons to emit an ‘onTap’ event when stokes recognized as a
‘taps’ occur. No other events are generated in this mode.

• Hit Coordinate Type: Click either Local, World or Screen. This selects the
Coordinate system to use.

See Also

• Events and Notifications

Events and Notifications

The MtButton generates an OnTap event when it is tapped in ‘Taps Only’ mode:
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• HitContainer as String: the name of the container that was ‘hit’

Id as String: the user ID string entered in the notification interface

HitPoint as Vertex: the Point where the object was tapped in local coordinates

Taps as Integer: the number of taps ie: 2 == double tap

PluginContainer as String: name of the container the Plugin is attached to

FirstChildContainer as String: first child container below the Plugin the tap occurred
on or below

The MtButton generates an OnTrigger event when it is triggered in any other mode
than ‘Taps Only’:

• HitContainer as String: the name of the leaf container that was ‘hit’

• Id as String: the user ID string entered in the notification interface

• HitPoint as Vertex: the Point where the object was tapped in local coordinates

• Taps as Integer: the number of taps if tapped, ie: 2 == double tap

• PluginContainer as String: name of the container the Plugin is attached to

• FirstChildContainer as String: first child container below the Plugin the trigger
occurred on or below

• StrokeId as Integer: Unique ID of stroke causing this event.

• OnStrokeEnter:

• Id as String: the user ID string entered in the notification interface

• PluginContainer as String: name of the container the Plugin is attached to

• FirstChildContainer as String: first child container below the Plugin the stroke
entered.

• StrokeId as Integer: Unique ID of stroke causing this event. Only valid from initial
enter to final leave.

• StrokeCount as Integer: count of stroke on the button after entry. Will be ‘1’
when the first stroke enters

• Active as Integer: Will be 0 if stroke went down on button. ‘1’ if it was already
down when entering.

• OnStrokeLeave:

• Id as String: the user ID string entered in the notification interface

• PluginContainer as String: name of the container the Plugin is attached to

• FirstChildContainer as String: first child container below the Plugin the stroke
exited.

• StrokeId as Integer: Unique ID of stroke causing this event. Only valid from initial
enter to final leave.

• StrokeCount as Integer: count of stroke on the button after exit. Will be ‘0’ when
the last stroke exits

• Active as Integer: Will be 0 if stroke went up to cause leave. ‘1’ if still down and
‘rolled off’

The shared memory field names are:

• HitContainer: the name of the container that was ‘hit’

• Id: the user ID string entered in the notification interface
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• HitPoint: the Point where the object was tapped in the selected coordinate type.

• Taps: the number of taps, ie: 2 = double tap

• PluginContainer: name of the container the Plugin is attached to

• FirstChildContainer: first child container below the Plugin that tap occurred on or
below

• StrokeId: unique ID of last trigger or tap.

The Data Pool structure updated is:

• MtButton:

• string Id

• string HitPoint

• string HitContainer

• string Taps

• string PluginContainer

• string FirstChildContainer

• string StrokeId

To create a Simple Scene with the MtButton Plugin

Note: If a touch screen is not available then go to Viz config and set Multi Touch
input to Mouse (see Communication)

1. Create a new Scene.

2. Add a new group Container.

3. Name the group Container ButtonScript.

4. Add the Script plugin to the ButtonScript Container (Container plugins > Global).

5. Open the Script Editor and type this script:

sub OnTap(HitContainer as String, Id as String,  HitPoint as Vertex, 
 Taps as Integer,  PluginContainer as String,  FirstChildContainer as
 String )

                                dim bt as Container

                                dim text as String

                                bt = FindSubContainer("ButtonText")

                                text = "OnTap(\n   HitContainer = " &
 HitContainer

                                text &= "\n   Id = " & Id 

                                text &= "\n   HitPoint = " & HitPoint

                                text &= "\n   Taps = " & Taps 

                                text &= "\n   PluginContainer = " &
 PluginContainer
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                                text &= "\n   FirstChildContainer = "
 & FirstChildContainer & "\n)"

                                bt.Geometry.Text = text

                                end sub

6. Click Compile and Run.

7. Add three Sub-containers. Name them, in order:

• Button1

• Button2

• ButtonText

8. Add a Circle Geometry to the Button1 and Button2 Containers.

9. Use the Circle Geometry Transformation editors to move the two circles so that
both can be seen.

10. Right-click the Button1 and Button2 Containers, in turn, and select Add Material
… from the context-menu. Open the Material Editor and define a color for both
Containers.

11. Add the MtButton plugin to the Button1 and Button2 Containers (Container Plugin
> MultiTouchComp).

1. In the MtButton plugin editor:

• Type ‘myButton1’ in the Button1 Id field

• Type ‘myButton2’ in the Button2 Id field

• In Trigger Type field click On Tap for both containers

1. Add a Font to the ButtonText Container.

2. Open the Scene in On Air.

3. Click on each button, in turn, and see the text change with each selection.
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4. Use the MtButton plugin editor to modify the button’s actions, as required.

See Also

• MtButton Configuration

12.8.4 Mt2D Control Plugin

 The Mt2D Control Plugin moves, scales, and rotates an object in 2D.

The Mt2D Control plug allows multi-finger 2D manipulation of an object in the scene.
When the object is touched, it will translate, rotate, and scale to keep the object
underneath the user’s fingers as closely as possible. It will move within the screen
relative 2D plane through the object’s center position defined by the objects orientation
axes.

The container being manipulated must not have any local non-uniform scale. The
Plugin will force y and z scale so they are equal to x scale when the object is touched.
If non uniform scaling is desired on object in the container, put the object’s container
in a group and scale the parent. Or put the Plugin on an identity group and insert the
object to be moved as a child container. All transformations set on the manipulated
container’s parents will be preserved.

Note: This plugin is located in: Built-ins -> Container Plugins -> MultiTouchComp

This section contains information on the following topics:

• Mt2D Control Configuration

• Events and Notifications

• To Create a Simple Scene with the Mt2D Control Plugin
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Mt2D Control Configuration

• Momentum: Enable movement or rotation with momentum after the object is
released.

• Friction: Set the amount of friction used when momentum is enabled

Note: Using this feature will conflict with any externally scripted or other
animations applied to the container.

• Lock Translation: Allow only rotation and scaling of the object

• Lock Translation (Screen X): Prevent movement left-to-right on the screen

• Lock Translation (Screen Y): Prevent movement up-and-down on the screen

• Lock Translation (Object X): Prevent movement along the object’s local X axis

• Lock Translation (Object Y): Prevent movement along the object’s local Y axis

• Lock Rotation: Prevent rotation of the object

• Lock Scale: Prevent resizing of the object

• Limit Position: Limit the maximum and minimum position of the X and Y axis

• Limit Rotation: Limit the maximum and minimum rotation of the X and Y axis

• Limit Scale: Limit the maximum and minimum scale

• Id: To give additional context in the handler script, specify a string that will identify
any notifications dispatched by this Plugin. This is often included as an argument for
the event so a common script may handle events from a number of Plugins.

• Set Shared Memory: If ON enables shared memory to be updated for the Plugin
notifications.
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• Shared Memory Prefix: This sets a ‘prefix name’ to be prepended to the shared
memory variables maintained by the Plugins notifications. For Plugins that maintain
multiple fields each field name has the prefix prepended to it followed by a dot
‘.’ so as to mimic member access to an object, i.e.: if the prefix is ‘Obj’ the fields
‘field1’ and ‘field2’ would be identified with the strings ‘Obj.field1’ and ‘Obj.field2’.
The shared memory field ‘Obj’ is also maintained and is simply an integer that is
modified every time any of its ‘subfields’ is updated.

• Shared Memory Type: Click either Global, Scene, or Distributed. This selects the
shared memory area to update.

• Set Data Pool: Shows ‘you wish’ Plugin notifications to set a Data Pool variable

• Data Pool Variable: Shows the name of the Data Pool variable to have set.

• Active during screen wide telestration?: If the button to is to stay active when
the screen-wide telestrator is on, set to On. The default is off, which means the
button cannot be triggered when telestration is on.

• Hit Coordinate Type: Click either Local, World or Screen. This selects the
Coordinate system to use.

• Produce delta values, don’t move object: Do not alter transform of object with
attached controller, but instead provide ‘deltas’ in the event notifications.

Note: Rotation scale or position constraints do not operate in this mode.

See Also

• Events and Notifications

Events and Notifications

The events dispatched by Mt2D Control are:

• OnGrab (when object is ‘grabbed’):

• HitContainer as String

• Id as String

• HitPoint as Vertex

• PluginContainer as String

• FirstChildContainer as String

• OnGrabUpdate (when object is moved):

• HitContainer as String

• Id as String

• Position as Vertex

• Rotation as Vertex

• Scale as Vertex

• Pressure as Double

• OnAnimation (dispatched when post grab animation (momentum) is started,
followed by OnGrabUpdates):

• HitContainer as String

• Id as String

• OnGrabRelease (when both touch grab and momentum animation are complete):

• HitContainer as String
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• Id as String

The Shared Memory Field names updated are:

• HitContainer (the name of the container that was ‘hit’)

• Id (the user ID string entered in the notification interface)

• HitPoint

• PluginContainer

• FirstChildContainer

• Position

• Rotation

• Scale

• Pressure

• State

The Data Pool structure updated is:

• Mt2D Control:

• string HitContainer

• string Id

• string HitPoint

• string PluginContainer

• string FirstChildContainer

• string Position

• string Rotation

• string Scale

• string Pressure

• string State

To Create a Simple Scene with the Mt2D Control Plugin

Note: If a touch screen is not available then go to Viz Config and set Multi Touch
input to Mouse (see Communication)

1. Create a new Scene.

2. Add a new group Container.

3. Add a Cube Geometry to the Container.

4. Add the Mt2DControl plugin to the Container (Container plugins >
MultiTouchComp).

5. Open the Scene in On Air. Move, rotate or scale the Rectangle with the touch
input device.

6. Use the Mt2DControl plugin editor to modify the plugin behavior as required.

See Also

• MtButton Configuration
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12.8.5 Mt3D Control Plugin

 The Mt3D Control Plugin moves, scales, and rotates an object in 3D.

The Mt3D Control plugin provides an arc ball-like controller for the object it is attached
to. When used with one finger, the object can be rotated. When multiple fingers are
used, the object can be moved, rotated and scaled in a 2D plane (the same as the
Mt2D Control Plugin).

Note: This plugin is located in: Built-ins -> Container Plugins -> MultiTouchComp

This section contains information on the following topics:

• Mt3D Configuration

• 2D Configuration

• Output Configuration

• Events and Notifications

• To Create a Simple Scene with the Mt3D Control Plugin

Mt3D Configuration

• Config: Select 3D Config

• Axis Lock: Constrain the rotation to a specific axis, or allow free rotation. Options
are:

• Off

• X Axis

• Y Axis

• Z Axis

• Axis Lock Local: If axis lock is on, use the local axis instead of the world axis.

• Active during screen wide telestration?: If the button to is to stay active when
the screen-wide telestrator is on, set to On. The default is off, which means the
button cannot be triggered when telestration is on.

• Hit Coordinate Type: Click either Local, World or Screen. This selects the
Coordinate system to use.
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2D Configuration

• Config: Select 2D Config

• Momentum: Enable movement or rotation with momentum after the object is
released.

• Friction: Set the amount of friction used when momentum is enabled

Note: Using this feature will conflict with any externally scripted or other
animations applied to the container.

• Lock Translation: Allow only rotation and scaling of the object

• Lock Translation (Screen X): Prevent movement left-to-right on the screen

• Lock Translation (Screen Y): Prevent movement up-and-down on the screen

• Lock Translation (Object X): Prevent movement along the object’s local X axis

• Lock Translation (Object Y): Prevent movement along the object’s local Y axis

• Lock Rotation: Prevent rotation of the object

• Lock Scale: Prevent resizing of the object

• Active during screen wide telestration?: If the button to is to stay active when
the screen-wide telestrator is on, set to On. The default is off, which means the
button cannot be triggered when telestration is on.

• Hit Coordinate Type: Click either Local, World or Screen. This selects the
Coordinate system to use.

Output Configuration

• Config: Select Output Config
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• Id: To give additional context in the handler script, specify a string that will identify
any notifications dispatched by this Plugin. This is often included as an argument for
the event so a common script may handle events from a number of Plugins.

• Set Shared Memory: If ON enables shared memory to be updated for the Plugin
notifications.

• Shared Memory Prefix: This sets a ‘prefix name’ to be prepended to the shared
memory variables maintained by the Plugins notifications. For Plugins that maintain
multiple fields each field name has the prefix prepended to it followed by a dot
‘.’ so as to mimic member access to an object, i.e: if the prefix is ‘Obj’ the fields
‘field1’ and ‘field2’ would be identified with the strings ‘Obj.field1’ and ‘Obj.field2’.
The shared memory field ‘Obj’ is also maintained and is simply an integer that is
modified every time any of its ‘subfields’ is updated.

• Shared Memory Type: Click either Global, Scene, or Distributed. This selects the
shared memory area to update.

• Set Data Pool: Shows ‘you wish’ Plugin notifications to set a Data Pool variable

• Data Pool Variable: Shows the name of the Data Pool variable to have set.

• Active during screen wide telestration?: If the button to is to stay active when
the screen-wide telestrator is on, set to On. The default is off, which means the
button cannot be triggered when telestration is on.

• Hit Coordinate Type: Click either Local, World or Screen. This selects the
Coordinate system to use.

See Also

• Events and Notifications

Events and Notifications

The events dispatched by Mt3dControl are:

• OnGrab (when object is ‘grabbed’):

• HitContainer as String

• Id as String

• HitPoint as Vertex

• PluginContainer as String

• FirstChildContainer as String

• OnGrabUpdate (when object is moved):

• HitContainer as String

• Id as String

• Position as Vertex

• Rotation as Vertex

• Scale as Vertex

• Pressure as Double

• OnGrabRelease (when object is “released”):

• HitContainer as String

• Id as String

The Shared Memory Field names updated are:

• HitContainer (the name of the container that was “hit”)
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• Id (the user ID string entered in the notification interface)

• HitPoint

• PluginContainer

• FirstChildContainer

• Position

• Rotation

• Scale

• Pressure

• State

The Data Pool structure updated is:

• Mt3dControl:

• string HitContainer

• string Id

• string HitPoint

• string PluginContainer

• string FirstChildContainer

• string Position

• string Rotation

• string Scale

• string Pressure

• string State

To Create a Simple Scene with the Mt3D Control Plugin

Note: If a touch screen is not available then go to Viz Config and set Multi Touch
input to Mouse (see Communication)

1. Create a new Scene.

2. Add a new group Container.

3. Add a Cube Geometry to the Container.

4. Add the Mt3D Control plugin to the Container (Container Plugins >
MultiTouchComp).

5. Open the Scene in On Air. Use the touch input device to transform the object.

6. Use the Mt3D Control plugin editor to modify the plugin behavior, as required.

See Also

• Mt3D Configuration

• 2D Configuration

• Output Configuration

12.8.6 MtNavigator Plugin

 The MtNavigator Plugin controls the Viz World Navigator Plugin.
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The MtNavigator Plugin allows multi-touch free navigation over a map generated by the
Curious World Maps Plugins. Currently it only supports the ‘Flat’ map model, and not
the globe or other 3D models. It will send commands to the Navigator Plugin to change
the position and distance of the map based on multi-touch input.

Note: This plugin is located in: Built-ins -> Container Plugins -> MultiTouchComp

This section contains information on the following topics:

• MtNavigator Configuration

• Events and Notifications

MtNavigator Configuration

• Georeference Container: The container which owns the Navigator plugin is
specified here.

• Momentum: Enable movement or rotation with momentum after the object is
released.

• Friction: Set the amount of friction used when momentum is enabled

• Limit Camera Distance: Limit the maximum and minimum camera distance

• Is free navigation allowed:  Activates or deactivates navigation

• Id: To give additional context in the handler script, specify a string that will identify
any notifications dispatched by this Plugin. This is often included as an argument for
the event so a common script may handle events from a number of Plugins.

• Set Shared Memory: If ON enables shared memory to be updated for the Plugin
notifications.

• Shared Memory Prefix: This sets a ‘prefix name’ to be prepended to the shared
memory variables maintained by the Plugins notifications. For Plugins that maintain
multiple fields each field name has the prefix prepended to it followed by a dot
‘.’ so as to mimic member access to an object, i.e: if the prefix is ‘Obj’ the fields
‘field1’ and ‘field2’ would be identified with the strings ‘Obj.field1’ and ‘Obj.field2’.
The shared memory field ‘Obj’ is also maintained and is simply an integer that is
modified every time any of its ‘subfields’ is updated.

• Shared Memory Type: Click either Global, Scene, or Distributed. This selects the
shared memory area to update.

• Set Data Pool: Shows ‘you wish’ Plugin notifications to set a Data Pool variable

• Data Pool Variable: Shows the name of the Data Pool variable to have set.
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See Also

• Events and Notifications

Events and Notifications

The events dispatched by MtNavigator are:

• OnNavGrab (when navigable object is ‘grabbed’):

• HitContainer as String

• Id as String

• Offset as Vertex

• Distance as Double

• PluginContainer as String

• OnNavGrabUpdate (when navigable object is moved):

• HitContainer as String

• Id as String

• Offset as Vertex

• Distance as Double

• PluginContainer as String

• OnNavGrabRelease (when navigable object is released):

• HitContainer as String

• Id as String

The Shared Memory Field names updated are:

• HitContainer: the name of the container that was ‘hit’

• Id: the user ID string entered in the notification interface

• Offset: the current lon/lat position in the Navigator

• Distance: the current distance in the Navigator

• PluginContainer: the name of the container this Plugin is attached to

• Active: 1 if ‘grabbed’ 0 if ‘released’

The Data Pool structure updated is:

• MtNavigator:

• string Id

• string HitContainer

• string Offset

• string Scale

• string PluginContainer

• string Active

See Also

• MtNavigator Configuration
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12.9 PixelFX
The PixelFX plugins are part of the PixelFX plugins set.

The following Container plugins are housed in the PixelFX folder:

• pxLensMulti

12.9.1 pxLensMulti

 pxLensMulti serves as a parent container for all the other PixelFX Plugins Gemo
plugins. It simplifies the process of animating lens flares so that they resemble realistic
behavior. In the child containers any number of lens flare shapes can be placed.
pxLensMulti positions, colors, governs the opacity of all according to the configurable
parameters.

The lens flare shapes at origin are a flat geometry. pxLensMulti ensures that all the
shapes it handles are constantly facing the camera.

Note: pxLensMulti creates a notional line along which all shapes are scattered.

Note: This plugin is located in: Built-ins -> Container Plugins -> PixelFX

This section contains information on the following topics:

• Properties

Properties

Under the Spread tab, the following parameters can be configured to handle shapes’
position:

• Mode: In Polar mode, the notional line can be defined by angle and radius
originating from the screen’s center. In Cartesian mode, the line is created
between the screen’s center and given an x-y location in the screen’s coordinates.
In Container mode, you need to drag a container from the scene tree into the
Container box; the container imitates the light position so that the notional line
starts from that position and goes through the screen’s center.

Note: In Container mode, one point of the notional line is in the Viz coordinates
and the second point, through which the notional line passes, is defined in the
screen coordinates. As such, camera movement in Container mode actually
defines the shapes’ movement. See Animating Cameras.

• Distance: The notional line passes through the screen’s center. The distance of this
center point from the camera is defined by the this parameter’s value.

• Count: The quantity of each shape in each child container is multiplied by the value
entered for this parameter.

• Radius Scale: Scales the notional line from the origin onward.

• Radius Rand: Scales the notional line’s length, regardless of origin.
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• Single Seed: When set to On, only one seed is used for each shape in the child
containers. When set to Off, a different seed is used for each shape in the child
containers.

• Seed: Defines the pseudo-randomality rule for randomly changed parameters. Once
a value is chosen, although the original statement will be random, the effect will
actually look the same on other computers as well.

Under the Attributes tab, the following can be configured to handle non-positional
parameters:

• Amount: Determines the amount of light used in the shapes.

• Amount Rand: Randomizes the Amount parameter between different shapes.

• Size Rand: Randomizes the sizes between different shapes.

• Color Rand: Randomizes the color between different shapes.

See Also

• pxColorWorks

• PixelFX Plugins in Geom Plugins

• PixelFXLenseFlare in Shader Plugins

12.10 Presenter
The following container plugins are housed in the Presenter folder:

• Bar

• Bar Value

• Bar Values

• Pie Slice

• Pie Values

12.10.1 Bar

 The Bar plugin tells the Bar Values plugin that the container is part of the bar chart
and it also tells which elements of the geometry on the container to control. Each
container that is to be a bar, must hold a geometry and a Bar plugin. Bar can be used
as a standalone plugin.

Note: This plugin is located in: Built-ins -> Container Plugins -> Presenter

This section contains information on the following topics:

• Properties
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Properties

• Standalone: If the Bar plugin is going to be used without a Pie Values plugin to
set the values, enable this button. It will enable you to set the value directly on the
plugin and you can define normalization factors between the input values and the
value that is being set on the geometry.

• Bar Min / Max: If in standalone, these values set the minimum and maximum
values for the bar. These values are connected to the Obj Min/Max values and by
adjusting these together you can get the desired effect between input values and
visual effect.

• Value: Sets the scaling value of the object.

• Obj Min / Max: Maps the input values to the native values on the object being
controlled by the plugin. Adjust these together with Bar Max/Min on the Bar Values
plugin or on the Bar plugin itself if in standalone mode, to get the desired effect
between input values and visual effect.

• Param Type: Sets the type of value to control on the object.

• Param: Controls a named parameter on the object. Use the console to find the
correct name for the parameter: Enable “Show commands”, Open the object’s
editor, change the parameter and see in the console what the parameter name is.

• Position: Position values can be set to control the X, Y or Z axis.

• Rotation: Rotation values can be set to control the X, Y or Z axis.

• Scale: Scale values can be set to control All, X, Y or Z axis.

• Text: Text values can be shown as Integer, Float or Formatted text.

• Initialize: Enables the plugin to initialize and gain control of the parameters.

See Also

• Bar Value

• Bar Values

• Vizual Data Tools

12.10.2 Bar Value

 Bar Value controls the value of all Bar plugins and Counters of its child nodes. In
addition a set of commands can be specified that are executed when the value passes
certain thresholds.

Note: This plugin is located in: Built-ins -> Container Plugins -> Presenter

This section contains information on the following topics:
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• Properties

• To create a bar that displays its value

Properties

• Bar Min: Minimum Value of the bar.

• Bar Max: Maximum Value of the bar.

• Value: The actual value of the bar.

• control counters: States if counters should be affected. If this is checked, Value
will be displayed in all Sub-Containers with Counter plugins.

• Type: Determines whether the command should fire if the threshold is passed from
below, or from above. Off does not execute the command at all. Available options
are Off, Up and Down.

• Threshold: The threshold against Value is compared.

• Command: The Viz command that will be executed when the threshold is passed.

To create a bar that displays its value

1. Create a Container and add the Bar Value plugin to it.

2. Open the Bar Value editor, and check control counters.

3. Set Threshold to 20, Type to Up and set a command (e.g. MAIN*ONAIR GET_INFO).

4. Add two Sub-Containers.

5. Add a Font and a Counter plugin to the first Sub-Container.

6. Add a Cube and a Bar plugin to the second Sub-Container.

7. Set the Cube’s Y-Axis Center to (B)ottom.

8. Open the Bar plugin editor and set Param Type to Scale and Scale to Y.

9. Modify Bar Value’s Value field.

• If the value exceeds 20 the information will be written to the console.

See Also

• Bar
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• Bar Values

• Vizual Data Tools

12.10.3 Bar Values

 The Bar Values plugin communicates with all Sub-Containers that hold a Bar plugin
and lets you set values for each of them.

Note: This plugin is located in: Built-ins -> Container Plugins -> Presenter

This section contains information on the following topics:

• Properties

• To create a bar chart using the Bar Values plugin

Properties

• Num Bars: Sets the number of bars to be controlled by the Bar Values plugin.
Maximum number of bars is 25.

• Auto Max: Allows the user to switch between Manual and Auto mode. Auto mode
disables the Bar Max value.

• Bar Max: Sets the maximum values of the bar.

• Bar Min: Sets the minimum value of the bar.

• Scale: Sets the scale of the object.

• Bar Animation: Sets the number of bars to be animated.

• Bar Value 1-25: Sets the value for the bar(s).

To create a bar chart using the Bar Values plugin

1. Add a group container to the scene tree, and add the Bar Values and Grid Arrange
plugin to it.

2. Add a group container as a Sub-Container to the first, and name it Bar.

3. Add material, the Cylinder and Bar plugin to the Bar container.

4. Open the Cylinder editor and set Center to Bottom.

5. Open the Bar editor, set Param Type to Scale and Scale to Y, and click Initialize.
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6. Create and place a number of copies of the Bar container (e.g. 5) at the same
level as the Bar container.

7. Open the Grid Arrange editor and set Number of Columns to 6 and Column
offset to 30.0.

8. Open the Bar Values editor and set Num Bars to 6 and Bar Animation to 6.

See Also

• Vizual Data Tools

• Control Bars

• Bar

• Bar Value

• Pie Slice

• Pie Values

12.10.4 Pie Slice

 Use the Pie Slice plugin with the Pie Values plugin to create and animate a pie chart
of up to 20 slices.

Note: This plugin is located in: Built-ins -> Container Plugins -> Presenter

This section contains information on the following topics:

• Properties

Properties

• Obj Min / Max: Maps the input values to the values on the cylinder object. Adjust
these together with Bar Max/Min on the Pie Values plugin to get the desired effect
between input values and visual effect.

• Offset: Offsets the slice from the center of the pie chart.

• Text Offset: Offsets the text label from the center of the pie chart.

• Control Text Values: Sets the type of text. Available options are No, Integer, Float
and Formatted.

• Initialize: Initializes the value of the pie slice.

See Also

• Vizual Data Tools

• Control Bars

• Bar

• Bar Value

• Bar Values

• Pie Values
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12.10.5 Pie Values

 Use the Pie Values plugin with the Pie Slice plugin to create and animate a pie chart
of up to 20 slices.

Note: This plugin is located in: Built-ins -> Container Plugins -> Presenter

This section contains information on the following topics:

• Properties

• To create a pie chart using the Pie Values plugin

Properties

• Pie Min and Max: Sets the minimum and maximum values for the pie size and the
range of the size.

• Min and Max Value: Sets the range of the displayed pie.

• Scale: Sets the scale of the pie. Default is 1.

• Slice: Sets the number of slices to be shown as part of the pie.

• Value 0 - 19: Sets the slice value. Available number of slices is 20.

To create a pie chart using the Pie Values plugin

1. Add a group container to the scene tree, and name it Pie.

2. Open the transformation editor and set Rotation X to 45.0, and Scaling Y
(single) to 0.2.

3. Add the Pie Values plugin to the Pie container.

4. Open the Pie Values editor and set Slice to 6.0, and enter the following values in
Value 0 to 5; 10.0, 20.0, 20.0, 10.0, 20.0, 20.0.

5. Add a Sub-Container to the Pie container and name it Slice.

6. Add the Cylinder geometry plugin, material and PieSlice plugin to the Slice
container.

7. Open the PieSlice editor and set Offset to 10.0 and Text Offset to 80.0.

8. Add a Sub-Container to the slice container and name it Text.

9. Open the transformation editor for the Text container and set Scaling (locked) to
0.2 and Rotation X to -90.0.

10. Add a font, material and the Extrude plugin to the Text container.

11. Open the Extrude editor and set Extrusion Depth to 100.0.
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12. Create and place a number of copies of the Slice container (e.g. 5) at the same
level as the Slice container.

13. Change the colors of the pie slices to distinguish each slice.

See Also

• Vizual Data Tools

• Control Pie

• Bar

• Bar Value

• Bar Values

• Pie Slice

12.11 pxColorWorks
The color correction plugins, which are part of the PixelFX plugins set, are generally fast
and efficient, however there is a certain performance penalty when animating them in
a stacked scenario.

Note: The PixelFX plugins are a separate package from the standard Viz Artist
installation, but function within the Viz Artist environment.

The following Container plugins are housed in the pxColorWorks folder:

• pxAddSubtract

• pxBlackAndWhite

• pxBrightContrast

• pxColorMatch

• pxGamma

• pxHueRotate

• pxMask

• pxSaturation

• pxStack

• pxTint

See Also

• PixelFX in Shader Plugins

• PixelFX Plugins in Geometry Plugins

12.11.1 PixelFX plugins

The PixelFX plugins affect pixels and geometry, and produce various special effects.
They do three main things:

• Color correction

• Lens flares

• And other pixel-based effects, such as noise, gradients, various distortion effects,
transitions, and other such effects of that nature.
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On each of the plugin icons there are mini icons that show certain properties of the
plugin in question.

• At the bottom left, there is a performance bar, with three blocks (like a cellphone
battery indicator). One block means the plugin will not have a drastic performance
effect, and three means the plugin is taxing and should therefore be used with
caution.

• At the bottom right the orange stack shows if the plugin is stackable, meaning it can
be used in conjunction with color correction plugins.

• Some plugin icons themselves are divided in half with one side showing the visual
effect with the plugin and the other without it.

Some of the PixelFX plugins are functional only when applied directly on a Container
that has a Texture on it. The rest however, function on the Renderer’s pixel buffer. For
example, you may apply color correction to the root Container in a Scene, therefore
perform a color correction to the whole scene. Another example is pxNoise - apply it
to the root level container of a scene or a whole tree branch to add a kind of film-grain
effect.

One of the parameters that feature in a number of the PixeFX plugins is Seed. This
defines the pseudo-random rule for changed parameters. Once a value is chosen,
although the original state will be random, the effect will actually look the same on
other computers as well.

12.11.2 pxAddSubtract

 pxAddSubtract allows you to add or subtract a constant color value to each pixel. It
can be applied to Everything, Shadows, Midtones and Highlights.

Note: This plugin is located in: Built-ins -> Container Plugins -> pxColorWorks

12.11.3 pxBlackAndWhite

 pxBlackAndWhite allows you to grayscale an RGB image or a tree branch holding
geometry. It can be applied to Everything, Shadows, Midtones and Highlights.

Note: This plugin is located in: Built-ins -> Container Plugins -> pxColorWorks
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12.11.4 pxBrightContrast

 pXBrightContrast allows you to adjust the brightness and the contrast on each of
R, G and B on a given image or a tree branch holding geometry. It can be applied to
Everything, Shadows, Midtones and Highlights.

Note: This plugin is located in: Built-ins -> Container Plugins -> pxColorWorks

12.11.5 pxColorMatch

pxColorMatch lets you replace one color with another. It works on images and tree
branches holding geometry alike.

Note: This plugin is located in: Built-ins -> Container Plugins -> pxColorWorks

Some important parameters:

• Weight: Defines the color range proximity to the selected color.

• Inertia: Defines the smoothness of the range proximity graph.

• Count: Defines the number of color replace pairs you wish to use.

12.11.6 pxGamma

 pXGamma allows you to adjust the gamma correction on each of R, G and B on a
given image. It can be applied to Everything, Shadows, Midtones and Highlights.

Note: This plugin is located in: Built-ins -> Container Plugins -> pxColorWorks

12.11.7 pxHueRotate

 pxHueRotate allows you to adjust the hue rotation on an image. It can be applied to
Everything, Shadows, Midtones and Highlights.

Note: This plugin is located in: Built-ins -> Container Plugins -> pxColorWorks

12.11.8 pxMask

 pxMask allows you to supply a mask for the color correction operation. The mask is
defined by a black and white image that is dragged into the pxMask plugin parameters.
pxMask, as indicated by the stackable icon, can function in conjunction with a mask.

Note: This plugin is located in: Built-ins -> Container Plugins -> pxColorWorks
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12.11.9 pxSaturation

 pxSaturation allows you to adjust the color saturation on an image. It can be applied
to Everything, Shadows, Midtones and Highlights. You also have the option to preserve
highlights, or not.

Note: This plugin is located in: Built-ins -> Container Plugins -> pxColorWorks

12.11.10 pxStack

Note: This plugin is located in: Built-ins -> Container Plugins -> pxColorWorks

This section contains information on the following topics:

• To apply to the pxStack plugin

To apply to the pxStack plugin

1. Add the pxStack plugin to the desired Container in the Scene Tree (1).

Note: When the pxStack plugin is added to a Container, it automatically
adds the pxCCBase plugin to the same Container. Also, it automatically
generates a child Container to host the color correction nodes you will define
later.

2. Click the pxStack icon in the Container. The PixelFX pluginsplugin editor (2) shows
a list of color correction filters.

3. Click on a color correction filter.

4. Click Add Filter. The color correction filter is added as a new Container under
the ‘noname’ Container in the Scene Tree (3). This termed as a ‘Color Correction
Node’.
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5. Repeat to add more color correction filters. Each color correction filter applied is
added (stacked) as a new Color Correction Node under the ‘noname’ Container in
the Scene Tree.

6. Click on a Color Correction Node to open its editor. Modify the effect properties as
required.

7. Change the order of the stacked properties, as required.

IMPORTANT! Selected properties act in the sequence in which they are ordered
in the scene tree.

Note: To disable or enable a Color Correction Node click the Locked/Unlock icon in
the top left of the Container (see Container Icons).

Note: To remove a color correction function, delete the plugin.

12.11.11 pxTint

 pxTint allows you to add a color tint and apply it to an image in the desired amount.
It can be applied to Everything, Shadows, Midtones and Highlights. You also have the
option to preserve highlights, or not.

Note: This plugin is located in: Built-ins -> Container Plugins -> pxColorWorks

12.12 RealFX
The RealFX plugin set enables you to create particle effects in Viz Artist.

See Also

• RealFX in Shader Plugins

• RealFX Plugins in Geometry Plugins

Particle systems are a computer graphics technique to simulate certain physics-based
effects, which are otherwise very hard to reproduce with conventional rendering
techniques. Examples of such effects which are commonly replicated using particle
systems include fire, explosions, smoke, weather effects, sparks, falling leaves, dust,
meteor tails, or abstract visual effects like glowing trails, magic spells, etc.

The particle effects in Viz run in real-time, meaning that there are a few inherent
constraints that must be taken into account when considering best practices for
employing this plugin set. For example, there is a trade-off between the number of
particles and performance optimization; more generally there needs to be a considered
balance between performance and visual quality.

RFxSmoke is the baseline plugin within the RealFX plugin set. The remaining plugins
in this set are applied on top of RFxSmoke in any given Container. RFxSmoke includes
built-in functionality and the ability to host the additional functionality contained in the
other plugins in this set. Part of the built-in functionality, e.g. turbulence, is kept for
compatibility with previous version of Viz Artist.
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There are three categories of additional plugins:

• Birth plugins: refer to where the particles are spawned

• Motion control plugins: govern the position, direction, velocity, size and color of
each particle

• Texture control plugins: affect the texture mapping and the “look” of each
particle by using pixel shader technology

RealFX Architecture

The following Container plugins are housed in the RealFX folder:

• RFxColliderSrc

• RFxColliderTgt

• RFxLatLong

• RFxMagnet

• RFxTurb

• RFxVortex

12.12.1 RFxColliderSrc

 Located under the Container Plugins tab, RFxColliderSrc is used in conjunction with
RFxColliderTgt to create a collision and collision detection system. For example the
source could be a notional wall or floor, whereas the target would be the particles
themselves. The particle target can work with a number of sources.

Note: When RFxCollisionSrc is added to a container, the RFxCollisionManager
plugin is automatically added at the scene level. This plugin is used internally and
not configurable.

Note: This plugin is located in: Built-ins -> Container Plugins -> RealFX



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 743

Adjust the following parameters as required to achieve the desired effect:

• Object Type (Auto, Sphere, Box)

• Bounce

• Random

• Proximity Fade and Fade Range: Allows you to fade particles based on their
proximity to other objects (only spheres and boxes).

• Flag 1-8 (on/off)

See Also

• RFxSmoke

• RFxColliderTgt

12.12.2 RFxColliderTgt

 Located under the Container Plugins tab, RFxColliderTgt is used in conjunction with
RFxTurb to create a collision and collision detection system. For example the source
could be a notional wall or floor, whereas the target would be the particles themselves.
The particle target can work with a number of sources.

Note: This plugin is located in: Built-ins -> Container Plugins -> RealFX

Adjust the following parameters as required to achieve the desired effect:

• Flag 1-8 (on/off)

See Also

• RFxSmoke

• RFxTurb

12.12.3 RFxLatLong

 Located under the Container Plugins tab, RFxLatLong fits any other RealFX motion
onto a globe surface. The effects are mainly geographic and large-scale.

Note: This plugin is located in: Built-ins -> Container Plugins -> RealFX

Adjust the following parameters as required to achieve the desired effect:

• Radius

• Spawn Min Long

• Spawn Max Long

• Spawn Min Lat

• Spawn Max Lat

• Update from Globe (on/off)

• Spawn Min Alt

• Spawn Max Alt

• Orientation (Horizontal/Radial)
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• Trim Radius

See Also

• pxColorWorks

12.12.4 RFxMagnet

 Located under the Container Plugins tab, RFxMagnet creates motion patterns that
resemble a magnetic field.

Note: This plugin is located in: Built-ins -> Container Plugins -> RealFX

Adjust the following parameters as required to achieve the desired effect:

• Amount

• Center X

• Center Y

• Center Z

• Power Law

• Min Distance Clamp

See Also

• RFxSmoke

12.12.5 RFxTurb

 Located under the Container Plugins tab, RFxTurb applies turbulence-like forces
to particles. It can be used to create the effect of random changes in wind force and
direction.

Note: This plugin is located in: Built-ins -> Container Plugins -> RealFX

Adjust the following parameters as required to achieve the desired effect:

• Amount

• Inertia

• Wavelength

• Update Rate

See Also

• RFxVortex

12.12.6 RFxVortex

 Located under the Container Plugins tab, RFxVortex applies vortex-like forces to
particles. It can be used to create the effect of a tornado-like twister.
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Note: This plugin is located in: Built-ins -> Container Plugins -> RealFX

Adjust the following parameters as required to achieve the desired effect:

• Amount

• Inertia

• Center X

• Center Y

• Center Z

• Rot X

• Rot Y

See Also

• RFxSmoke

12.13 Script Plugins
This is an empty folder for you to save your own Script plugins into.

12.14 SplineFX
The following container plugins are housed in the SplineFX folder:

• 2D Follow

12.14.1 2D Follow

 The 2D Follow function works together with the 2D Ribbon. What the plugin basically
does is to automatically create an animation path that follows the form of a 2D Ribbon.
The 2DRibbon must be created first.

Note: This plugin is located in: Built-ins -> Container Plugins -> SplineFX

This section contains information on the following topics:

• Properties

• To set up the 2D Follow plugin

Properties
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• Path Position: Sets the position for the object along the path of the 2D Ribbon
object. Animate this value to get an animation in the stage.

• Position Wrap: Can be set to Interpolate, Clamp or Repeat.

• Translation Offset: Sets an offset between the object and the 2D Ribbon path.

• Keep Orientation: If enabled, the orientation between the object and the 2D
Ribbon path is kept as the object moves along the path.

• Orientation Offset: Offsets the orientation between the object and the 2D Ribbon
path.

To set up the 2D Follow plugin

1. Add the 2D Ribbon geometry to the scene tree.

2. Open the 2D Ribbon editor and enable Show Control Point Values.

3. Set alternating values of 30.0 and -30.0 to the Y axis values, creating a wave
shape.

4. Add the element(s) (e.g. a Sphere) you want to animate along the 2D Ribbon’s
path as a Sub-Container to the 2D Ribbon container.

5. Add the 2D Follow plugin to the container.

6. Open the 2D Follow editor and animate its Path Position value from 0.0 to 100.0.

See Also

• 2D Ribbon

• Creating Animations

12.15 Text
The following container plugins are housed in the Text folder:

• Mark Text

12.15.1 Mark Text

 The Mark Text plugin allows you to underline words in a text string with a.

Note: This plugin is located in: Built-ins -> Container Plugins -> Text

This section contains information on the following topics:

• Properties

• To mark text
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Properties

• Text to Mark: Sets the text that should be marked. Note that the text is case
sensitive.

• Select: Selects where the underline should be placed. Available options are
foreground (Fg), background (Bg), Both and None. Background will underline the
text’s shadow.

To mark text

1. Add a group container to the scene tree and name it Text.

2. Add a font to the Text container.

3. Open the font editor and enter a text string.

4. Add the Mark Text plugin to the Text container.

5. Open the Mark Text editor and enter a word from your text string.

Note: Do not change the font type between texture and geometry as this will not
affect the whole string when using the Mark Text plugin.

12.16 TextFX
The following Container plugins are housed in the TextFX folder:

• Common Text FX Properties

• Convert Case

• Text FX Alpha

• Text FX Arrange

• Text FX Color

• Text FX Color Per Vertex

• Text FX Emoticons

• Text FX Explode

• Text FX Jitter Alpha

• Text FX Jitter Position

• Text FX Jitter Scale

• Text FX Plus Plus

• Text FX Rotate

• Text FX Scale

• Text FX Size

• Text FX Slide

• Text FX Vertex Explode

• Text FX Write
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12.16.1 Common Text FX Properties

The following properties are common to most of the Text FX plugins:

• Progress %: 0% progress is the beginning of the effect, 100% the end. Animate
this value from 0% to 100% to see the effect or from 100% to 0% to animate the
effect backwards.

• Progress Type

• Absolute: 100% progress will animate all characters of a text, regardless how
many characters it has.

• Relative: 100% progress animates 10 characters. This is needed to adjust the
timing of several text objects with different sizes. The effect speed should be for
example 5 characters per second, so the animation must be from 0% to 100% in
two seconds. This will work for text with 10 characters or less. If you want to use
longer texts, animate the progress value over 100% (10% for each character).

• Direction: Sets the direction of the text effect sequence, you can choose between
the following options:

• Left: Starts with the first character.

• Right: Starts with the last character

• Random: Uses a random order.

• Static: All characters are processed at the same time.

• Wave: Starts with the first character, animates the effect from 0: 100% and then
down again to 0%.

• Center: Starts the effect from the center of the text.

• 2 Center: Starts the effect at the same time from the beginning and the end of the
text. They meet at the center.

• Interpolate: Choose between a soft or a linear interpolation of the transition from
character to character.

• Effect Range: Defines how many characters are processed at the same time. If for
example the Effect Range is set to 4, and you manually increase the progress value,
you will see that when the fifth character starts to be processed, the first is finished,
when the sixth starts, the second is finished, and so on.

• Wave Center Size % this parameter is only visible when Wave is chosen as the
effect direction. Its effect is only visible when the effect range is set relatively high.
It defines how quickly the effect is to reach the top of the wave sequence or in other
words, how wide the wave top is to be. If for instance the Effect Range is set to 10
and the Wave Center Size % is set to 80, all characters except the one at each
end will be at the top of the wave sequence. The one at the left end will be on its
way up and the one on the right end will be on its way down.
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• Random Seed: Specifies a seed for the random number generator when a random
direction is chosen. Even though Viz Artist uses random numbers, the animation
for a specific random seed will always look the same. This is typically useful if you
combine two different text effects.

• Ignore Space: Ignores space when animating the effect.

• Ignore Newline: Ignores new lines when animating the effect.

• Text Order: Sets the text order for the effect. Available options are As Is, Horizontal
or Vertical. Horizontal and Vertical enables the Text Direction options.

• Text Direction: Sets the horizontal and vertical text direction (see Text Order).
When the text order is set to Horizontal, the text direction must be set to Left to
Right or Right to Left. When the text order is set to Vertical, the text direction must
be set to Up to Down or Down to Up.

12.16.2 Convert Case

 Converts ASCII strings to upper or lower case. Current container must hold a string.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFx

This section contains information on the following topics:

• Properties

• To convert a string to upper or lower case

Properties

• Upper/Lower: Converts the text for the specific container to upper or lower case.

                              FUNCTION*ConvertCase*text_case - int; 0:
 upper, 1: lower

                              FUNCTION*ConvertCase*text - string
            

To convert a string to upper or lower case

1. Add a group to the scene tree, and add a font to it.

2. Add the Convert Case plugin to the same container.

3. Open the Convert Case editor, and enter text in the editor.
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4. Click the Upper button to convert to upper case text, or click the Lower button to
convert to lower case text.

12.16.3 Text FX Alpha

 The Text FX Alpha plugin is a text effect that creates a fade in effect for the text
characters. The effect sequence can be set to go many different ways. A fade in and
out effect can also be achieved.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties

Properties

• Alpha Begin %: Sets the alpha level of the character at 0% effect.

• Alpha End %: Sets the alpha level of the character at 100% effect.

See also Common Text FX Properties.

12.16.4 Text FX Arrange

 The Text FX Arrange plugin allows you to arrange characters in either a circular- or a
wave shape. The characters can be animated on the selected shape by animating the
offset value.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties
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Properties

• Offset %: Moves the characters on the shape. 100% means one full rotation of the
text on the circle.

• Scale %: Sets the text on the shape. The parameter does not scale the characters
itself, but the kerning of the characters.

• Shape: Changes the shape of the character layout. The options are Circle or Wave.

• Rotation: Rotates the characters on the X-axis.

• Align: Rotates the characters on the Z-axis to align the X-axis with the tangent of
the shape at the characters position.

• Circle Parameters

• Diameter sets the diameter of the circular shape

• Positioning defines the position of the text on the circular shape. Relative means
that the text spacing of the text object is maintained. Absolute means that the text
is evenly distributed out on the circle.

• Direction sets the direction of the text on the circle to either Clockwise or
Counterclockwise.

• Wave Parameters

• Length sets the amplitude/wave length. A high value creates many and small
waves, a low value fewer and bigger waves.

• Width the width of the wave.

• Height sets the height of the waves without altering the number of waves as the
Length does.

• Shift % the wave usually starts at the height 0. The shift value moves that point,
thereby moving the texts position on the wave structure. Setting Shift % to 100%
brings you back to the beginning.

• Damping can be used to modify the amplitude of the wave curves.

12.16.5 Text FX Color

 Adds a color effect to the text.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties
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Properties

• Color Begin: Sets the initial color before applying the effect.

• Color End: Sets the color the effect should apply.

See also Common Text FX Properties.

12.16.6 Text FX Color Per Vertex

 Adds a color per vertex effect to the text.

Note: Works only if the text is set to texture (does not work with geometry text).

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties

Properties

• Color Bbox: Defines the reference bounding box, global for the entire text, or local
for each character.

• Color Direction: Defines the color gradient shape. Available options are; top left
to bottom left, top right to bottom right, top left to top right, bottom left to bottom
right, top right to bottom left and 4 corners.

• Color Level: Sets the level of the color (0.1 to 1.9). Default is 1.0.

• Top and Bottom Left and Right: Sets the color and alpha value for each edge.

• Color use Alpha: Enables alpha.

See also Common Text FX Properties.
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12.16.7 Text FX Emoticons

 The Text FX Emoticons allows you to create an emoticon container, add it to the
Emoticons plugin and replace characters (tokens) in a text string with an assigned
container.

IMPORTANT! This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties

Properties

• Autoscale: Scales the emoticon containers so their height above the baseline (0) is
identical to the height of character A.

• UTF-8 Encoding: Enables UTF-8 encoding for the text effect.

• Token 1 - n: The placeholder for an emoticon.

• Container 1 - n: References the container holding the emoticon. The container
should be similar to the layout of a glyph.

• Precache 1-n: - Enables Viz to cache the objects.

12.16.8 Text FX Explode

 The Text FX Explode plugin creates an explosion like function where the characters
get thrown away from their initial position. The speed, direction and spread of the
moving characters can be altered with parameters.

Note: Works only if the text is set to texture (does not work with geometry text).

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties
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Properties

• Duration: Defines the duration of the progressing for each of the characters. If
you want a longer progressing, increase this value. You could achieve the same by
making the gravity stronger and animating the progress slower, but it is more easy
to increase the duration instead if your explode effect is too short.

• Opening Angle: Sets the angle for the spread of the characters. 0 will send them
straight up, 360 will spread them in a circular shape.

• Angle Rotate X: Rotates the opening angle around the X-axis.

• Angle Rotate Y: Rotates the opening angle around the Y-axis.

• Force: Sets the force that throws away the characters. A high force will make them
go far away, conversely a low force will create only a small motion of the characters.

• Force Spread %: Sets a variation of the force among the characters.

• Use Axis: Allows you to select on which axis or combination of axes the characters
are to spread along.

• Gravity: Sets a gravity force that influence the path of the characters to end up
going downwards. The higher the value is set, the faster each character will divert
from its initial path and start going downwards.

• Use Rotation: With this option enabled, the characters will rotate as they are being
thrown away from their initial position.

• Rotation Force: Sets the degree of rotation as the characters are being thrown
away.

• Show Force: With this option enabled, lines showing the characters path and speed
will be visible in the Scene Editor.

See also Common Text FX Properties.

See Also

• Text FX Vertex Explode
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12.16.9 Text FX Jitter Alpha

 The Text FX Jitter Alpha plugin creates a jittering motion of the characters by
randomly changing the alpha value of each character. The degree of change and the
start sequence of the jittering can be altered. To use the plugin, add it onto a container
with a font. To create an animation, animate the progress. Other values can of course
be animated as well.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties

Properties

• Effect What: Defines where the effect should have an effect. Available options are
background (BG), foreground (FG) or both.

• Alpha Begin: Sets the alpha level of the character at 0% effect.

• Alpha End: Sets the alpha level of the character at 100% effect.

• Randomness: sets the intensity of the jittering alpha changes.

12.16.10 Text FX Jitter Position

 The Text FX Jitter Position plugin creates an jittering motion of the characters by
randomly changing the position of each character. The degree of position change and
the starting sequence of the jittering can be altered. To use the function add it onto
a container which holds a font. To create an animation, animate the progress. Other
values can of course be animated as well.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties
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Properties

• Use Axis defines on which axis or axes the characters moves to create the jittering
effect.

• Lock Axis with this option enabled Range and Randomness will be the same for
all axes. If you disable it, Range and Randomness for each of the axes will be
displayed and you can set them individually.

• Range sets the range of the jittering movement.

• Randomness sets the intensity of the jittering movement.

See also Common Text FX Properties.

12.16.11 Text FX Jitter Scale

 The Text FX Jitter Scale animates a jittering effect on the scale of the character.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties
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Properties

• Anchor Horizontal: Sets the anchor point for the characters on the horizontal
plane.

• Anchor vertical: Sets the anchor point for the characters on the vertical plane.

• Use Axis: Defines on which axis or axes the characters scale to create the jittering
effect.

• Lock Axis: With this option enabled, all the axes get the same Min, Max and
Randomness settings. If you disable randomness, these parameters will be visible
for each of the axes and must be set individually.

• Min: Sets the minimum scaling for the characters.

• Max: Sets the maximum scaling for the characters.

• Randomness: Sets the intensity of the jittering movement.

See also Common Text FX Properties.

12.16.12 Text FX Plus Plus

 The Text FX Plus Plus plugin allows you to set a number of effects on a text string.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties

Properties

• Position Wrap

• Extrapolate: Above 100% or below 0% of Path Position will continue the direction
of the spline.

• Clamp: Will stop the string on the spline endpoints.
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• Repeat: Will cause the string to move to the other spline endpoint as soon as it
moves over the endpoint.

• TextFx: Will position characters by the relative spline of each character using the
common TextFx parameters.

• Scheme Type: Defines how the text will look at 0% and 100% progress.

• In -> In: at 0% first character will be at the beginning of the spline, at 100% last
character will be at the end of the spline.

• In -> Out: at 0% first character will be at the beginning of the spline, at 100% first
character will be at the end of the spline.

• Out -> In: at 0% last character will be at the beginning of the spline, at 100% first
character will be at the end of the spline.

• Out -> Out: at 0% last character will be at the beginning of the spline, at 100% last
character will be at the end of the spline.

• Progress (%): Animates the progress of the effect(s).

• Position: Positions the characters using the spline as a position axis.

• Rotation: Rotates the characters using the spline as a rotation axis.

• Scale: Scales the character’s X, Y and Z-axis using the spline as a scaling graph.

• Color: Applies Color Change on character.

• Alpha: Applies Alpha on the characters using the spline as a alpha graph.

• General: Enables rotation, offset and align properties.

• Rotate X/Y/Z: Adds extra Rotation to each character.

• Text Offset: Sets the text offset.

• Align: Rotates the characters to follow the spline movements.

• TextFX: See Common Text FX Properties.

• Direction: Sets the direction of the text effect sequence. Normal starts with the
first character (e.g. left). Opposite starts with the last character (e.g. right). Random
uses a random order (see Random Seed). Static means that all characters are
processed at the same time. Wave starts with the first character, animates the
effect from 0 to 100% and then down again to 0%. Center starts the effect from the
center of the text. 2 Center starts the effect at the same time from the beginning
and the end of the text. They meet at the center.

• Scale: Defines the scale graph to apply on the characters for each axis.

• Rotation: Defines the rotation effect to apply on the characters for each axis.

• Color: Defines the color gradient effect to apply on the characters.

• Alpha: Defines the alpha effect to apply on the characters.
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12.16.13 Text FX Rotate

 The Text FX Rotate plugin allows you to create an effect where the characters rotate
on the X-, Y- or Z-axis.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties

Properties

• Anchor Horizontal: Sets the anchor point for the characters on the horizontal
plane.

• Anchor Vertical: Sets the anchor point for the characters on the vertical plane.

• Use Axis: Defines on which axis the characters rotate.

• Begin: Sets the initial rotated position of the characters.

• End: Sets the ending rotated position of the characters.

See also Common Text FX Properties.

See Also

• Expert

12.16.14 Text FX Scale

 The Text FX Scale plugin allows you to create a scaling animation of the characters.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties
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Properties

• Anchor Horizontal: Sets the anchor point for the characters on the horizontal
plane.

• Anchor Vertical: Sets the anchor point for the characters on the vertical plane.

• Use Axis: Defines on which axis or axes the characters scale.

• Lock Axis: With this option enables the Begin- and End scaling are the same for all
the axes. If you disable the parameter, Begin and End must be set for all the axes
individually.

• Begin: Sets the initial size of the characters.

• End: Sets the ending size of the characters.

See also Common Text FX Properties.

See Also

• Text FX Size

12.16.15 Text FX Size

 The Text FX Scale plugin allows you to create a sizing animation of the characters.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties
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Properties

• Begin: Sets the initial scale of the text before the effect.

• End: Sets the final scale of the text after the effect.

See also Common Text FX Properties.

See Also

• Text FX Scale

12.16.16 Text FX Slide

 The Text FX Slide plugin allows you to create a sliding animation of the characters on
the X, Y and Z-axis.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties

Properties

• X, Y and Z Distance: Defines direction and distance of moved text.

• Show Direction: Enables and disables view of ‘movement’ vector. Note that
direction will not be shown in On Air mode.
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See also Common Text FX Properties.

12.16.17 Text FX Vertex Explode

 The Text FX Vertex Explode plugin allows you to create an effect where text
characters are exploded with a vertex effect.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties

Properties

• X, Y and Z Distance: Defines direction and distance of moved text.

• Show Direction: Enables and disables view of ‘movement’ vector. Note that
direction will not be shown in On Air mode.

See also Common Text FX Properties.

See Also

• Text FX Explode

12.16.18 Text FX Write

 The Text FX Write plugin allows you to create an effect where text characters get
displayed as if they were written by the keyboard in real time, a sort of Typewriter
effect.

The text field in the font editor does not need to contain any text, since the text for this
plugin is entered in the plugin’s own editor.
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Note: Text FX Write expects UTF-8 encoded text as input if a font encoding other
than Default is selected. See Font Options.

Note: This plugin is located in: Built-ins -> Container Plugins -> TextFX

This section contains information on the following topics:

• Properties

Properties

• Fill with Space: With this option enabled, the function will add a space for every
character not yet written. The bounding box of the text is then sized correctly from
the start. If you use an Auto Follow function connected to the text, enabling this
option will create a better result.

• Effect: Allows you to select an effect to be executed as each character gets written
on the screen. There are four effects to choose from and they have in addition their
own parameters.

• Pop: Is the basic effect where the characters just pop up on the screen without any
other sign being displayed.

• Count: Creates a counting sequence by showing a random symbol before showing
the character to be displayed.

• Random: This (in combination with effect range) writes random characters before
the final character is displayed. Use a non proportional font when you use this
function to get the better looking effect.

• Cursor: Displays a cursor that writes the characters. When you select this option, a
text field opens below where you can choose which symbol to use as cursor.

• Effect Speed: Is an additional parameter that is visible if you have selected Count
or Random. It sets the speed of the effect that shows the preceding symbol.

• Selection: Is an additional parameter to the Random effect. It allows you to select
between some preset character ranges to use for the effect.

• Cursor: Allows you to enter the character which is to be used as a cursor.

See also Common Text FX Properties.
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12.17 Texture
The following container plugins are housed in the Texture folder:

• Grabbit

• GraffitiTex

• Image Clip

• LightBlur

• MoViz

• Noise

• Soft Clip

12.17.1 Grabbit

 With the Grabbit plugin you are able to use captured video inside Viz Engine. Grabbit
uses the Microsoft DirectShow Filter graph framework to capture the video.

You can use devices which are supported by DirectShow and are self-contained such as
capture cards or web cameras. Self-contained means the capture device does not need
any further input.

Note: This plugin is located in: Built-ins -> Container Plugins -> Texture

This section contains information on the following topics:

• Properties

• Required Software

• Best Practices

• Known Limitations

• To capture a video stream using Grabbit

• To capture a video stream using Grabbit with a VfW supported device

Properties

Following is a list of all parameters of the plugin. Depending on the state of the plugin,
they may be hidden. Some of them are not visible at all.

• Available Devices: Lets you decide which video capture device to use. This list
is created during loading of the plugin. That means if you have a capture device
which is not known at startup of the renderer it will not show up. On the other hand
it does not know if a capture device is already in use by some other plugin. Since
the list is static is just shows all capture devices which were available at startup. If
the parameter is changed and the plugin is already started it will stop the capturing
before loading the new capture device. Changes are effective immediately.

• Parameter name: CaptureDevices (list).
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• Selected Capture Device: Note that this parameter is hidden from the user
interface. Contains the simple name for the chosen capture device from the list. This
parameter decides which DirectShow Device is taken for capturing. If the parameter
is changed and the plugin is already started it will stop the capturing before loading
the new capture device.

• Parameter name: CaptureDevice (string).

• Capture Format: Note that this parameter is hidden from the user interface.
Human readable string that represents the current capturing format. It shows
the width by height, frame rate, video subtype, and bit depth. It is a read only
resource and is changed with the configuration dialogs below. This should really be
an opaque data type.

• Parameter name: CaptureFormat (string).

Parameters are shown if the filter supports the ProcAmp interface.

• Brightness: Changes the brightness. The range is relative and the value is re-
calculated internally according to the possibilities (min/max/stepping) of the device.
Changes are effective immediately but not for already captured video.

• Parameter Name: Brightness.

• Type: float. Range: [0..100]. Default: 50.

• Contrast: Changes the contrast. The range is relative and the value is re-calculated
internally according to the possibilities (min/max/stepping) of the device. Changes
are effective immediately but not for already captured video.

• Parameter Name: Contrast.

• Type: float. Range: [0..100]. Default: 50.

• Hue: Changes the hue. The range is relative and the value is re-calculated internally
according to the possibilities (min/max/stepping) of the device. Changes are
effective immediately but not for already captured video.

• Parameter Name: Hue.

• Type: float. Range: [0..100]. Default: 50.

• Saturation: Changes the saturation. The range is relative and the value is re-
calculated internally according to the possibilities (min/max/stepping) of the device.
Changes are effective immediately but not for already captured video.

• Parameter Name: Saturation.

• Type: float. Range: [0..100]. Default: 50.

• Sharpness: Changes the sharpness. The range is relative and the value is re-
calculated internally according to the possibilities (min/max/stepping) of the device.
Changes are effective immediately but not for already captured video.

• Parameter Name: Sharpness.

• Type: float. Range: [0..100]. Default: 50.
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• Gamma: Changes the gamma. The range is relative and the value is re-calculated
internally according to the possibilities (min/max/stepping) of the device. Changes
are effective immediately but not for already captured video.

• Parameter Name: Gamma.

• Type: float. Range: [0..100]. Default: 50.

• Colorenable: Enables or disables color. Changes are effective immediately but not
for already captured video.

• Parameter Name: Colorenable.

• Type: toggle button. Default: on.

• Whitebalance: Changes the whitebalance. The range is relative and the value
is re-calculated internally according to the possibilities (min/max/stepping) of the
device. Changes are effective immediately but not for already captured video.

• Parameter Name: Whitebalance.

• Type: float. Range: [0..100]. Default: 50.

• Backlight Compensation: Enables or disables the backlight compensation.
Changes are effective immediately but not for already captured video.

• Parameter Name: BacklightComp.

• Type: toggle button. Default: on.

• Gain: Changes the gain. The range is relative and the value is re-calculated
internally according to the possibilities (min/max/stepping) of the device. Changes
are effective immediately but not for already captured video.

• Parameter Name: Gain.

• Type: float. Range: [0..100]. Default: 50.

Parameters are shown if the filter supports the DirectShow dialog interface. Since
the dialogs are handled by Windows and not the Viz interface they may open in the
background. If so please bring the dialog to the front and make your settings. Make
sure that the dialog is closed before you change anything in the Viz interface.

The buttons are disabled if there is no such dialog. Some implementations hint that a
dialog is available even if it is not. In that case the button is not disabled but no dialog
window shows.

• Video Filter: The dialog window may be behind the renderer GUI after activation.
Please be careful to close the dialog window. Otherwise the renderer and the GUI
may lock up. Changes are effective immediately.

• Parameter Name: ButtonVideoFilter.

• Type: push button.

• Video Capture Pin: If available choose RGB24 or UYV as format. Other settings
may not work. The dialog window may be behind the renderer GUI after activation.
Please be careful to close the dialog window. Otherwise the renderer and the GUI
may lock up. Changes are effective immediately.

• Parameter Name: ButtonVideoCapPin.

• Type: push button.

• Audio Filter: The dialog window may be behind the renderer GUI after activation.
Please be careful to close the dialog window. Otherwise the renderer and the GUI
may lock up. Changes are effective immediately.
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• Parameter Name: ButtonAudioFilter.

• Type: push button.

• Audio Capture Pin: The dialog window may be behind the renderer GUI after
activation. Please be careful to close the dialog window. Otherwise the renderer and
the GUI may lock up. Changes are effective immediately.

• Parameter Name: ButtonAudioCapPin.

• Type: push button.

• Crossbar 1: The dialog window may be behind the renderer GUI after activation.
Please be careful to close the dialog window. Otherwise the renderer and the GUI
may lock up.

• Parameter Name: ButtonCrossbar1.

• Type: push button.

• Crossbar 2: The dialog window may be behind the renderer GUI after activation.
Please be careful to close the dialog window. Otherwise the renderer and the GUI
may lock up.

• Parameter Name: ButtonCrossbar2.

• Type: push button.

• TV-Tuner Video: The dialog window may be behind the renderer GUI after
activation. Please be careful to close the dialog window. Otherwise the renderer and
the GUI may lock up.

• Parameter Name: ButtonTvVideo.

• Type: push button.

• TV-Tuner Audio: The dialog window may be behind the renderer GUI after
activation. Please be careful to close the dialog window. Otherwise the renderer and
the GUI may lock up.

• Parameter Name: ButtonTvAudio.

• Type: push button.

Video for Windows Dialogs:

Parameters are shown if the filter supports the Video for Windows (VfW) dialog
interface. Since the dialogs are handled by Windows and not the Viz interface they
may open in the background. If so please bring the dialog to the front and make your
settings. Make sure that the dialog is closed before you change anything in the Viz
interface.

Buttons are disabled if there is no such dialog. Some implementations hint that a dialog
is available even if it is not. In that case the button is not disabled but no dialog window
shows.

• Cap Source: If the filter supports the VfW Source dialog this button is present. It
can be activated if the capturing is stopped otherwise the button is grayed out. The
dialog window may be behind the renderer GUI after activation. please be careful to
close the dialog window. otherwise the renderer and the GUI may act in a strange
way. Changes are effective immediately.

• Parameter Name: ButtonCaptureSource.

• Type: push button.

• Cap Format: If the filter supports the VfW Format dialog this button is present. It
can be activated if the capturing is stopped otherwise the button is greyed out. The
dialog window may be behind the renderer GUI after activation. please be careful to
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close the dialog window. otherwise the renderer and the GUI may act in a strange
way. Changes are effective immediately.

• Parameter Name: ButtonCaptureFormat.

• Type: push button.

• Cap Display: If the filter supports the VfW Display dialog this button is present. It
can be activated if the capturing is stopped otherwise the button is grayed out. The
dialog window may be behind the renderer GUI after activation. please be careful to
close the dialog window. otherwise the renderer and the GUI may act in a strange
way. Changes are effective immediately.

• Parameter Name: ButtonCaptureDisplay.

• Type: push button.

• Auto Scale Texture: If enabled the captured video is scaled according to the
underlying geometry. Changes are effective immediately but not for already
captured video.

• Parameter Name: AutoScale.

• Type: toggle button. Default: on.

• Border Crop Width: Crop pixels on the horizontal sides of the video. This
parameter is shown only if Auto Scale Texture is enabled. Changes are effective
immediately but not for already captured video.

• Parameter Name: BorderCrop_x.

• Type: integer. Range: [0..0x7fff]. Default: 0.

• Border Crop Height: Crop pixels on the vertical sides of the video. This parameter
is shown only if Auto Scale Texture is enabled. Changes are effective immediately
but not for already captured video.

• Parameter Name: BorderCrop_y.

• Type: integer. Range: [0..0x7fff]. Default: 0.

• Status Opened: Shows if the capture graph has been built successfully.

• Parameter Name: StatusOpened.

• Type: toggle button (display only).

• Status Started: Shows if the capture graph has been started.

• Parameter Name: StatusStarted.

• Type: toggle button (display only).

• Status Stream Width: Shows the captured video width.

• Parameter Name: StatusStream_x.

• Type: integer (display only).

• Status Stream Height: Shows the captured video height.

• Parameter Name: StatusStream_y.
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• Type: integer (display only).

• Start: Starts capturing. Feedback is given through Status Started and Status
Stream Width/Height. If capturing does not start check the Status Opened and
Connected. Capturing cannot commence if the filter graph is not connected.
Changes are effective immediately.

• Parameter Name: ButtonStart.

• Type: push button.

• Stop: Stops capturing. You need to do this to select the Vfw Dialog buttons.
Changes are effective immediately.

• Parameter Name: ButtonStop.

• Type: push button.

• Clear: Clears the texture to opaque white. You may need to hit the button twice for
the change to show. Changes are effective immediately.

• Parameter Name: ButtonClear.

• Type: push button.

Required Software

• DirectShow version 9.0c. It is strongly recommended to have a clean DirectShow
installation to start with. Additional source filters may be added later. Find more
Information at the

• DirectShow of VfW compatible capture card.

Best Practices

GraphEdit is a tool from the Microsoft DirectShow SDK that allows you to visualize the
default Filtergraph that DirectShow builds to render the Media. If you can render the
Media inside GraphEdit it should play in Viz Engine, too. If it does not play in GraphEdit
it will certainly not play in Viz Engine.

Known Limitations

• Dynamic listbox for capture devices.

• Handle the capture device list dynamically.

• ProcAmp settings should be updated from dialog settings as well.

• Query for availability in the various ProcAmps.

• The Capture Device must be known to the system at application start. When using
USB devices this means they must be connected before Viz Engine is started.

To capture a video stream using Grabbit

1. Add the Rectangle geometry to the scene tree, and add the Grabbit plugin to it.

2. Select the capture device you want to work with from the Available Capture
Devices list.

• You should get a positive Status Opened feedback.
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Note: Do not select a device which is currently in use (either by another instance
of this plugin or by another application).

3. If you have a device that supports the capture format enumeration and the
ProcAmp interface you will get a screen similar to the following.

4. Set the Capture Format by using the dialogs behind the configuration buttons
Video Filter, and so on.

5. Select Auto Scale Texture if you want the texture position and scaling set by
this plugin so that the video fills out the entire geometry. If you have selected this
feature you may want to crop something on the horizontal or vertical sides of the
video. Use the Border Crop Width and Border Crop Height for this effect.

6. Click the Start button to start capturing. You should get a positive Status Started
feedback. In addition the Status Stream Width and Status Stream Height should
reflect the dimensions of the captured video.

7. Adjust the effect settings. Note that the effect settings are highly dependant on
the selected device. You might want to experiment with them. Some parameters
have discreet values as for example the Gamma parameter.

To capture a video stream using Grabbit with a VfW supported device

Note: If you have a device which supports the VfW Dialogs interface you will most
probably see that your device is tagged with VfW.

Once you have selected the capture device it needs to be configured. You do this by
clicking the buttons that leads to the VfW dialog windows.

1. Click Cap Source and Cap Format and set the parameters according to your
needs.

• The values you set here cannot be changed via the usual control mechanism. You
need to pay close attention that the dialog window may open in the behind the Viz
GUI.

• Make sure that each dialog window is closed before any other changes are made in
the viz GUI.

• You should get a positive Status Connected feedback. If you want to go back to
change something here the graph must be in Stopped mode.

2. Select Auto Scale Texture if you want the texture position and scaling set by this
plugin so that the video fills out the entire geometry.

• If you have selected this feature you can use the Border Crop Width and Border
Crop Height to crop something on the horizontal or vertical sides of the video.

3. Click the Start button to start capturing.

• You should get a positive Status Started feedback. In addition the Status Stream
Width and Status Stream Height should reflect the dimensions of the captured
video.

4. Click the Stop button to stop the capturing.

• This will set it back to Stopped mode.

• You should see the feedback in the Status Started toggle.
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• Once the capturing is stopped you can use the Clear button to set the underlying
texture to opaque white.

12.17.2 GraffitiTex

 The Graffiti Texture plugin allows telestration on top of flat containers, such as
rectangles. Telestration is done by drawing with a brush shape using a mouse, 6DOF
device or multi touch device. The plugin can also recognize some rendered shapes
and replace the hand-drawn element with the recognized shape (circle, ellipse, cross,
arrow).

The plugin can either work in combination with Viz Engine’s multitexturing technology
or can add a standalone texture.

Note that there are two graffiti plugins, one that can be used globally as a scene
plugin, and this one that is applied to the container level.

Note: This plugin is located in: Built-ins -> Container Plugins -> Texture

This section contains information on the following topics:

• Properties

• To create a container level graffiti effect

Properties
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• Active: Enable/disable drawing

• Multi Telestration: Set to On or OFF. Allows handling of multiple touch events for
multitouch devices. Some devices incorporate a pressure factor, this influences the
width of the brush:

• Pressure Min [%]: Set the minimum width of the brush

• Pressure Max [%]: Set the maximum width of the brush

• I6DOF: Specifies whether input comes from mouse of 6DOF

• Transparent Base: Specifies whether the base color of the container will be
the background of the rendered brush or whether the brush will be drawn on a
transparent background

• Texture Width, Texture Height: Dimensions of the texture used for drawing
canvas

• Brush Type: Color or eraser brush

• Brush Image: Optional image that will determine the shape of the brush. If empty,
a round brush will be used

• Brush Width: Width of the brush in pixels. Visible only if the color brush is selected

• Eraser Brush Width: Width of the eraser in pixels. Visible only if the eraser brush
is selected

• Brush Color: Color of the brush

• Recognize Shapes: Shape recognition mode (on/off)

• Recognize Ellipse: Specifies whether shape recognition will try to recognize ellipse
shape

• Recognize Circle: Specifies whether shape recognition will try to recognize circle
shape

• Recognize Cross: Specifies whether shape recognition will try to recognize cross
shape

• Shape Delay: Number of frames to wait from mouse up before trying to recognize
shapes

• Draw Arrow: Specifies whether non-recognizable shapes will be converted to an
arrow

• Arrow Length: Length of arrow head

• Arrow Width: Width of arrow head

• Circle Rad: Radius of the circle replacing a recognized circle. If zero, the radius of
the recognized circle will be used

• Cross Width: Width of the cross replacing the recognized cross shape. If zero, the
width of the recognized cross shape will be used

• Max. Undos: Max number of undo operations

• Clear (button): Clears the canvas

• Undo (button): Undo

• Brush Width: Width of the brush in pixels. Visible only if the color brush is selected

• Eraser Brush Width: Width of the eraser in pixels. Visible only if the eraser brush
is selected

• Brush Color: Color of the brush

• Recognize Shapes: Shape recognition mode (on/off)

• Recognize Ellipse: Specifies whether shape recognition will try to recognize ellipse
shape
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• Recognize Circle: Specifies whether shape recognition will try to recognize circle
shape

• Recognize Cross: Specifies whether shape recognition will try to recognize cross
shape

• Shape Delay: Number of frames to wait from mouse up before trying to recognize
shapes

• Draw Arrow: Specifies whether non-recognizable shapes will be converted to an
arrow

• Arrow Length: Length of arrow head

• Arrow Width: Width of arrow head

• Circle Rad: Radius of the circle replacing a recognized circle. If zero, the radius of
the recognized circle will be used

• Cross Width: Width of the cross replacing the recognized cross shape. If zero, the
width of the recognized cross shape will be used

• Max. Undos: Max number of undo operations

• Clear (button): Clears the canvas

• Undo (button): Undo

To create a container level graffiti effect

• Add the plugin to the container, set the plugin Properties, set Viz in On Air Mode and
start drawing.

See Also

• Graffiti (scene plugin)

12.17.3 Image Clip

 The Image Clip plugin is designed to play back a sequence of still images (e.g. TGA
or TIFF) rather than playing a movie file. It also supports alpha channel and various
play modes (looping, swing, etc). The plugin loads all images to RAM, then loads
only one image at a time to texture memory. The download time is almost linear to
the size of each frame. Preparation for this plugin should be uncomplicated as most
video applications has support for saving out TIFF or Targa sequences. Since it plays
the sequence from memory, one obvious benefit is that once loaded into memory
it does not access the hard drive at all. So if it is needed to play back ten different
sequences at once, ImageClip is pretty much the only solution. It is ideal for looping
small animations such as logos. The drawback is that it consumes system memory.

Remember to keep track of how much memory each sequence needs, to avoid running
out of memory on the Viz Engine machine. Running low on memory will make the
system start caching parts of memory to the hard drive and it may not play the
sequence and graphics in real-time (see Properties and the Memory Type setting).
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Image clip should not be used with very large clips in Continuous and Array mode.
Since all images are loaded into memory a large number of images or a large image
size would require large amounts of memory.

Memory can be calculated as follows:

• Number of images * Image width * Image height * 3 (or 4 when using alpha)

The use of Thread mode solves the memory issue, but it will take longer to request a
frame. Therefore it should be used only in a slow motion image clip.

Images for an image sequence should be placed in specific folders. For example if you
out many flag image sequences, you would have a separate folder for each flag image
sequence. Make sure that the images are named sequentially e.g. “england001.tif”,
”england002.tif”, ”england003.tif” etc.

Note: This plugin is located in: Built-ins -> Container Plugins -> Texture

This section contains information on the following topics:

• Properties

• To add an image clip

Properties

• Image: Sets the image path and the first image you would like to use in your
animation. Do not use clip names with numbers (except the counter (e.g. 000, 001,
002, etc.)).

• Mip maps: Enables the use of Mip maps. This is possible when the Scale option is
enabled, about + 30% and - 30% in performance.

• Optimize: Optimizes on quality or memory usage.

• Play Mode: Sets the play mode. Available modes are Once, Loop, Swing, Animation
and Internal.

• Animation Position: Sets the animation position (e.g. where to start and stop
the animation). The position is a counter for the number of images in the folder
referenced by the Image setting. This setting is enabled when Play Mode is set to
Animation.

• Reverse: Reverses the animation (except for in the Animation play mode).

• Play Speed: Sets the speed of the animation.

• Advanced: Enables the advanced settings (see below).

• Time Mode: Enables time specific settings.

• Stand Alone Image: Enables the same clip to be played in different speeds.
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• First Image: Defines the first image of the animation.

• Nof Image: Defines the number of images, relative to the First Image, that should be
part of the animation.

• Crop: Crops the image in percent from the left, right, bottom and top side.

• Scale By: Enables the scale setting.

• Scale: Scales all images to the closest power of 2. When not selected, automatic
texture coordinates will be applied so the image that will fit the texture.

• Keep Under: It forces the image size. For example if you have selected 64, the
image will be trimmed to the size 64 x 64.

• Memory Type: Sets the memory type.

• Continuous: Uses one big chunk of memory to store all images.

• Array: Uses divided chunks of memory to store all images.

• Thread: Loads only requested frame on-the-fly, with [n] frames loading time limit.

• Play (button): Plays the animation.

• Stop (button): Stops the animation.

• Reinitialize (button): Reinitializes all settings.

To add an image clip

1. Add a container to the scene tree, and add the Image Clip plugin to it.

2. Click the Browse... button to locate the folder that houses the images.

3. Select the first image in the sequence, and click OK.

• The image sequence now loads into the ImageClip plugin, and is visible in the
scene.

4. Click the Play button to test the image sequence.

• If you change the image sequence and you need to reload it, click the Reinitialize
button.

5. Change the Play Mode to Loop to play the image sequence continuously.

• The image sequence will start playing automatically.

6. Change the Play Mode to Animation to animate the image sequence frame
position to control the sequence within the Stage Editor.

• The image sequence now stops playing and a new property is revealed that is called
Animation Position. This refers to the frame number that is currently displayed for
the image sequence.

7. Animate the Animation Position value.

• The Animation Position maximum value is restricted to the number of images.

8. Another possibility is to create a file with a "*.vln" extension. This file includes
the base path and also the names of the images to load. In this case the images
must not have a counter number in their filename. You can handle this file as an
ordinary text file.

9. Load the “vln - file” instead of loading an image file located in a directory.
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Example:

BASE_PATH ‘C:/clip/images’
{
‘radar_200504110800.png’ 2005_04_11_10:00
‘radar_200504110815.png’ 2005_04_11_10:15
‘radar_200504110830.png’ 2005_04_11_10:30
‘radar_200504110845.png’ 2005_04_11_10:45
‘radar_200504110900.png’ 2005_04_11_11:00
‘radar_200504110915.png’ 2005_04_11_11:15
‘radar_200504110930.png’ 2005_04_11_11:30
‘radar_200504110945.png’ 2005_04_11_11:45
}

Note: Viz Engine will not interpret between keyframes, so if you choose to slow
down an animation then the motion will not be smooth.

See Also

• Implementing Video

• MoViz

• Soft Clip

• Background Clip

12.17.4 LightBlur

 Allows the user to configure and create a light blurred image.

IMPORTANT! The light blur functionality is now a built in feature of the Viz core.
For future use it is therefore recommended to use the Dynamic Texture plugin.

Note: This plugin is located in: Built-ins -> Container Plugins -> Texture

This section contains information on the following topics:

• Properties

Properties

• Width and Height: Sets the width and height of the blurred light. Available options
are 2 to 2048.
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• Format: Sets the image format. Available options are RGB, RGBA, Alpha,
Luminance and Luminance Alpha.

• Save (button): Saves the blur as an image.

• X and Y %: Sets the position of the blur on the X and Y axis (50% places the blur at
the origin).

• Spread %: Sets the spread of the blur.

• Start: Sets the start color of the blur.

• End: Sets the end color of the blur.

12.17.5 MoViz

 With the MoViz plugin you are able to play media files or streams inside Viz Engine.
MoViz is neither a QuickTime player nor an AVI player. It uses the Microsoft DirectShow
Filter Graph framework to play the media files, which means it can play both mentioned
types, but only certain installed Filter Graphs (some of the QuickTime and some AVI).
MoViz is not natively QuickTime, it uses the AVI wrappers and filters for QuickTime and
AVIs. This means that you cannot play all QuickTime codecs, only the ones that are
supported within DirectX wrappers and filters.

Note: Throughout this plugin documentation, media file and media stream is
referred to as media and may be used interchangeably unless stated otherwise.

Note: This plugin is located in: Built-ins -> Container Plugins -> Texture

This section contains information on the following topics:

• Properties

Properties

• Clip URI: You can load clips from the file system by using the ‘Browse’-Button,
or you can enter the location directly. It takes the form of a valid uri (e.g. http://...
mms://...). If the parameter is changed and the plugin is already started it will stop
the playback before loading a new clip. Changes are effective immediately. It is
important that all video clips from the file system are stored locally on the V: drive
of the machine that is used to play out the graphics. Remember to save the clip
locally on the client machines with preview (e.g. Viz Trio) and use the same V: drive
so that the clip can be seen in preview.

• Parameter Name: ClipURI.

• Type: string.

• Autoplay: Enable or disable automatic start of the clip after it has loaded here.
Changes are effective immediately.

• Parameter Name: Autoplay.
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• Type: toggle button. Default: off.

• Loop Clip: Enable or disable a looped playback here. If the clip position is at the
clip out position or EOF it will rewind to the clip in position. Changes are effective for
the next EOF, clip out position.

• Parameter Name: Loop.

• Type: toggle button. Default: off.

• Clip Duration (ms): Displays the duration of the clip in units of milliseconds. The
parameter is for show only. Make no changes to this parameter. This parameter
makes only sense with media that supports this kind of information.

• Parameter Name: Duration.

• Type: integer (read only).

• Clip Position (ms): Gives the current position of the clip in units of milliseconds.
When in pause mode this parameter may be changed to seek to the gives time.
Do not change this parameter when not in pause mode. The position may be
changed between Clip Position IN and Clip Position OUT. This parameter makes
only sense with media that supports this kind of information. Changes are effective
immediately.

• Parameter Name: Position.

• Type: integer. Range: [IN..OUT]. Default: 0.

• Clip Position IN (ms): Gives the first frame where the clip should start in units of
milliseconds. This parameter makes only sense with media that supports this kind of
information. Changes are effective immediately.

• Parameter Name: PositionIn.

• Type: integer. Range: [0..Duration]. Default: 0.

• Clip Position OUT (ms): Gives the last frame where the clip should stop in units of
milliseconds. This parameter makes only sense with media that supports this kind of
information. Changes are effective immediately.

• Parameter Name: PositionOut.

• Type: integer. Range: [0..Duration]. Default: Duration.

• Video Device Format: Lets you decide which video format to use for rendering.
Changes are effective at load time.

• Parameter Name: VideoFormat.

• Type: radio button.

• None: The video part is not rendered.

• RGB24: The video part is delivered to Viz using RGB24 format.

• ARGB32: The video part is delivered to Viz using ARGB32 format.

• Force Opaque: If the clip has an alpha channel and is selected (ARGB32) you can
clear the alpha value to 100% opaque here. Changes are effective for each frame
delivered.

• Parameter Name: ForceOpaque.

• Type: toggle button. Default: off.
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• Auto Scale Texture: If enabled the captured video is scaled according to the
underlying geometry. Changes are effective immediately but not for already
delivered video.

• Parameter Name: AutoScale.

• Type: toggle button. Default: on.

• Border Crop Width: Crop pixels on the horizontal sides of the video. This
parameter is shown only if Auto Scale Texture is enabled. Changes are effective
immediately but not for already delivered video.

• Parameter Name: BorderCrop_x.

• Type: integer. Range: [0..0x7fff]. Default: 0.

• Border Crop Height: Crop pixels on the vertical sides of the video. This parameter
is shown only if Auto Scale Texture is enabled. Changes are effective immediately
but not for already delivered video.

• Parameter Name: BorderCrop_y.

• Type: integer. Range: [0..0x7fff]. Default: 0.

• Audio Device Format: Lets you decide which audio device and format to use
for rendering. This may be useful until audio via viz is supported although it is not
recommended due to performance and frame drop issues. Changes are effective
immediately but not for already delivered audio.

• Parameter Name: AudioFormat.

• Type: radio button.

• None: The audio part is not rendered.

• Default Device: The audio part is rendered using the default DirectShow renderer.

• Status Loaded: Shows if the clip has loaded.

• Parameter Name: StatusLoaded.

• Type: toggle button (display only).

• Status EOF: Shows if the clip is at EndOfFile.

• Parameter Name: StatusEof.

• Type: toggle button (display only).

• Status Clip Width: Shows the video width.

• Parameter Name: StatusClip_x.

• Type: integer (display only).

• Status Clip Height: Shows the video height.

• Parameter Name: StatusClip_y.

• Type: integer (display only).

• Status Video: Shows if the clip has a usable Video component.

• Parameter Name: StatusVideo.
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• Type: toggle button (display only).

• Status Audio: Shows if the clip has a usable audio component.

• Parameter Name: StatusAudio.

• Type: toggle button (display only).

• Seek Timeout: Specifies the timeout for seeking to a position in the movie file.
Higher values may prevent jumping back to the expected position when clip
playback takes longer to start then expected. However, the playback time may not
be as exact.

• Eject: Unloads the clip and destroys the graph. Changes are effective immediately.

• Parameter Name: ButtonEject.

• Type: push button.

• Load: Loads the given clip and builds the graph. Changes are effective immediately.

• Parameter Name: ButtonLoad.

• Type: push button.

• Rewind: Rewinds the clip to the beginning when supported. Changes are effective
immediately.

• Parameter Name: ButtonRewind.

• Type: push button.

• Stop: Puts the graph in stop mode. Changes are effective immediately.

• Parameter Name: ButtonStop.

• Type: push button.

• Play: Puts the graph in play mode. i.e. start playback. Changes are effective
immediately.

• Parameter Name: ButtonPlay.

• Type: push button.

• Pause: Puts the graph in pause mode. Changes are effective immediately.

• Parameter Name: ButtonPause.

• Type: push button.

• Play From Start: Like Play but rewinds the clip to the beginning first. Changes are
effective immediately.

• Parameter Name: ButtonPlayFromStart.

• Type: push button.

• Clear: Clears the texture to opaque white. You may need to hit the button twice for
the change to show. Changes are effective immediately.

• Parameter Name: ButtonClear.

• Type: push button.

See Also

• Implementing Video

• Advanced Issues with Video Codecs

• Image Clip
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• Soft Clip

12.17.6 Noise

 Allows the user to configure and create a noise image.

IMPORTANT! The noise functionality is now a built in feature of the Viz core. For
future use it is therefore recommended to use the Dynamic Texture plugin.

Note: This plugin is located in: Built-ins -> Container Plugins -> Texture

This section contains information on the following topics:

• Properties

Properties

• Width and Height: Sets the width and height of the noise. Available options are 2
to 2048.

• Format: Sets the image format. Available options are RGB, RGBA, Alpha,
Luminance and Luminance Alpha.

• Save (button): Saves the noise as an image.

• Factor X and Y: Sets the noise factor on the X and Y axis (range is from 0.000 to
1000.000).

• Turbulence 1, 2 and 3: Sets the turbulence of the noise.

• Frequency: Sets the frequency of the noise.

• Exponent: Sets the exponent of the noise.

• Fg: Sets the foreground color.

• Bg: Sets the background color.

• Wave, Clouds, Marble and Noise (buttons): Allows the user to select between
four different presets.

• Randomize (button): Sets random factor, turbulence and frequency. Randomize
works together with the Wave, Clouds, Marble and Noise selections.
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12.17.7 Soft Clip

 The Soft Clip is used for playing video clips projected on a texture, and supports AVI
files only. This format supports RGB and RGBA (alpha channel).

In its simplest form, the Soft Clip plugin can exist on an empty container to play back a
video clip in Viz Artist or Viz Engine. Other plugins can be mixed with Soft Clip to obtain
different results. For example you can apply a Soft Clip plugin to a Sphere and add a
Material to affect the overall shape, color and shading of the video clip.

With Soft Clip you are able to control the video clip within the stage, unlike with
the Live method. The video clip size can also be whatever you decide, however, it
is recommended that you keep the dimensions in multiples of 8 (e.g. 128x128 or
256x512) for performance purposes.

Use of the Soft Clip plugin might have an affect on performance and quality, hence, it is
recommended to use the Performance Bar when working with the Soft Clip plugin.

Important to note is that Viz Engine keeps all designer/operator/automation loaded
scenes – and plugins – in memory. As a consequence, if you load 30 different templates
that load 30 different scenes – that each has a single Soft Clip plugin on it, then
Viz Engine will have thirty Soft Clip plugins with 30 threads activated in memory. If
every plugin have specified that it should have 10 preloaded frames, then Viz Engine
will have 300 uncompressed decoded frames preloaded in memory. This can take a
substantial amount of memory and the combination of having that much data loaded
and that many threads running, is likely to affect performance. This workflow situation
has to be taken into consideration when designing and testing the design. Therefore,
unloading scenes and cleaning up the Viz Engine renderers (a function in many Vizrt
control client programs) should be used.

Note: This plugin is located in: Built-ins -> Container Plugins -> Texture

This section contains information on the following topics:

• Properties

• To use Soft Clip

Properties
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• Clip file: Use this function to browse for the clip you want to play out. NOTE: It is
important that all video clips are stored locally on the V: drive of the machine used
to play out the graphics. Remember to save the clip locally on the client machines
with preview (e.g. Viz Trio) and use the same V: drive so that the clip can be seen in
preview.

• Clip length: Displays the clip’s number of frames.

• Live Play: Ensures that the clip will be played and synchronized to the frame rate
of the Viz Engine. This is set in Viz Config / Output Format options. Disabling Live
Play will allow the clip playback to be keyframe animated.

• Play mode: Synchronize means the clip will run synchronized with the scene
playout. This is set in Viz Config / Output Format options. Frames per second allows
you to adjust for different speeds, set in the next parameter:

• Frame number: Enables the frame numbers to be manually animated10

• . This is an alternative to playing the whole clip.

• Frames per second: Makes you able to customize the frame rate.

Note: There is no frame interpolation done when you change the frame rate from
the default specified.

• Loop Video: Enabling this option means the video will loop automatically.

• Use decode thread: Enabling this option will split the processing of the clip evenly
between the machine’s processors. It is recommended to have this on. On multi-
processor machines this will gain performance, but threading makes scheduling less
predictable and may cause the Viz Engine frame rate to be less stable on a single
CPU machine.

• Preload frame count: Works as a buffer to enable smoother playback of the clip.
If using Live Play, the Preload frame count can help reducing spike-loads and avoid
dropped frames.

• Frame skipping: With frame skipping enabled, Viz Engine will skip frames if it
needs, to try and maintain real-time graphics playout. With frame skipping disabled
the clip will play out in full, as fast as possible but will not try to maintain real-time
playout. (Graphics will stagger on the output if the renderer drops out of real-time.)
When using the video card’s ring buffer functionality the SoftClip frame skipping
should be turned off.

• Force Opaque: When running videos where the codec leaves the alpha channel
blank, the video rendering may become completely transparent. This option will fill
the alpha channel, thus making the video completely opaque.

• Preferred CPU: This function enables the user to specify a particular processor to
handle video play out. The recommended CPU value is based on the machine spec
you are running, if you have a quad core processor the CPU value can be set to 4,
but to avoid any errors it would be recommended to set that value to 2. If you have
a lower spec machine then the recommended value is 1.

• Priority: Sets the priority of drawing the video to a custom level in Viz Engine
giving it more or less processor priority.

• Auto scale texture: This scales the video clip to the size of the underlying
rectangle on which the video is placed in the container.

• Border crop: When using the auto scaling over, how much of the border to crop.
Due to bilinear texture interpolation, you might see that color from the underlying
texture is bleeding into the video texture area. Use this parameter to crop away the
affected border pixels.
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To use Soft Clip

1. Add a group container to the scene tree, and add the Soft Clip plugin to it.

2. Open the Soft Clip editor.

3. Click the Browse... button to select and load a clip.

• Loading a clip will make it visible in the scene. By default, the Soft Clip plugin has
the Live Play and Loop video settings enabled, hence, the clip will instantly start
playing (and looping) in the render window.

4. Optional: Enable the Use decode thread option.

5. Disable the Live Play option to enable the Frame number setting.

6. Animate the Frame number setting (e.g. from frame 10 to 30).

Note: Viz Engine will not interpret between keyframes, so if you choose to slow
down an animation then the motion will not be smooth.

See Also

• Implementing Video

• Advanced Issues with Video Codecs

• Image Clip

• MoViz

12.18 Ticker
The following container plugins are housed in the Ticker folder:

• Scroller Action

12.18.1 Scroller Action

 The Scroller Action plugin makes it possible to design scrolling tickers that trigger
actions when scroller elements are played out. Actions can be triggered both before
and after reading the next element from the input source, as well as delaying the
reading of the next element a certain number of frames.

A scrolling carousel scene must have a Soft Clip Draw Pixels plugin attached to a
container and be configured to receive elements from an external source. In most
cases this external source is Viz Ticker 3D’s Ticker Service running on the same
machine. During scene design, it is useful to use a debugging syntax to specify a fake
source that refers to graphics templates located directly in the scene.

Note: This plugin is located in: Built-ins -> Container Plugins -> Ticker

This section contains information on the following topics:

• Properties

• Controlling the Progression

• To control the progression
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Properties

• Delay (Frames): Adds a delay after the current element is fully inside the scroller,
so that insertion of the next element is postponed the given number of frames.

• On Inside: Defines if the element should trigger anything after it fully enters the
scroller.

• Action: If NONE is selected, nothing is triggered. If ANIMATE is selected, it is
possible to trigger a director and define the start and stop point of the director
animation.

• Director: Defines the director to run when On Inside is triggered.

• From Tag: Defines where to start the director animation.

• To Tag: Defines where to stop the director animation.

• After Delay: Defines if the element should trigger anything after the scroller has
finished delaying the next element.

• Action: If NONE is selected, nothing is triggered. If ANIMATE is selected, it is
possible to trigger a director and define the start and stop point of the director
animation.

• Director: Defines the director to run when After Delay is triggered.

• From Tag: Defines where to start the director animation.

• To Tag: Defines where to stop the director animation.

The source syntax (separator)(text) will create a scroller showing an endless stream
of elements alternating between a separator and a text graphics design. The scroller
will search through the scene tree for containers named separator and text, use the
graphics template found there, and then copy them to create the element instances
that are being scrolled.

Controlling the Progression

A typical example of when the Scroller Action plugin is necessary, is when text
messages (SMS) should scroll into the screen, animate to a halt, wait a few seconds,
and then restore the scroll speed whenever new text messages are available.

This paragraph provides guidance on how to create an upwards scroll for displaying
text messages, where the scroller should pause for a while after playing out each
message to the screen. The scroller should not immediately follow the text design
with the next separator design. Instead, the text design should enter the screen fully,
and then the scroller should smoothly slow down to a halt. The scroller should wait a
given number of frames before slowly starting the scroller again and pushing the next
separator element onto the screen. If an external source is used, the scroller should not
start again until there is a new element available from the source.

To control the progression

1. Create a director named scroller

• This director animates the scroller speed.
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2. On this director, create a stop point, and call it stop

3. Set the stop scroll speed to 0

4. Create another stop point, and call it play

5. Set the play scroll speed to a suitable speed

The actual names that are used here are not important, but they must match the
names specified in step 8.

6. Add the Scroller Action plugin to the text template top node (the container holding
the Control Object plugin)

7. In the Scroller Action plugin editor, define the Delay frame count

This setting adds a delay after the current element, so that the insertion of the next
element is postponed the given number of frames.

The delay counter starts to count from the time the previous element has fully entered
the screen, which is a few frames after it would normally try to insert a new element.
When delay is set to 0, the scroller will perform as normal, and not wait until the
previous element has fully entered the scroller before inserting a new element.

The delay parameter specifies the minimal amount of time that must pass between
pushing out the current element, which is based on the template graphics with the
Scroller Action plugin, and the next element. The actual amount of time might be
greater if there are no new elements available after the delay frame count has expired.
Setting this parameter does not affect the speed of the scroller, it only delays the
inserting of the next element, in effect increasing the resulting gap between the
previous element and the next.

The default value of the delay frame count parameter is 0, which means that the
scroller will attempt to insert the next element immediately after the previous element.

8. In the Scroller Action plugin editor, click the On Inside: action Animate button.

When animate is selected, three additional on inside related parameters become
available:

• On Inside: director (default value is scroller)

• On Inside: from tag (default value is play)

• On Inside: to tag (default value is stop)

The parameters should remain at the default values.

When the current element has fully entered the screen, the scroller will start to
animate the scroller director from a play tag to a stop tag. The rules of the GOTO_TRIO
director command defines this behavior.

9. In the Scroller Action plugin editor, click the After Delay: action Animate button

When animate is selected, three additional after delay related parameters become
available:

• After Delay: director (default value is scroller)

• After Delay: from tag (default value is stop)

• After delay: to tag (default value is play)

The parameters should remain at the default values.
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When the delay frame count expires, the scroller will start to animate the scroller
director from a stop tag to a play tag. The rules of the GOTO_TRIO director command
defines this behavior.

See Also

• Transition Logic

12.19 Time
The following container plugins are housed in the Time folder:

• Analog Watch

12.19.1 Analog Watch

 The Analog Watch plugin lets you create a real-time animated clock of objects.

Note: This plugin is located in: Built-ins -> Container Plugins -> Time

This section contains information on the following topics:

• Properties

• To create an analog watch

Properties

• Mode: Sets the mode. Available options are Hour24, Hour12, Minute, Second and
Off.

• Smooth: Minute hands usually rotate smoothly, second hands do that in some
cases. Check this button to enable smooth rotation. Hour hands always rotate
smoothly, so this switch is inactive if the plugin is set to Hour24 or Hour12 mode.

• Offset: 1200 usually is equal to a rotation of 0 degrees. Use this value to change
that.

• 1 hour in Hour24 mode: 15 degrees.

• 1 hour in Hour12 mode: 30 degrees.

• 1 minute in Minute mode: 6 degrees.

• 1 second in Second mode: 6 degrees.
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To create an analog watch

1. Add a Circle geometry to the scene tree, add material to it, and name it Clock.

2. Open the Circle editor and set scaling to 2.0.

3. Add three Arrow geometries as Sub-Containers of the Clock container, add
material to them, and name the first Hours, the second Minutes, and the third
as Seconds.

4. Open the Arrow editor for Hours and set the following properties:

• Style1 to Flat.

• Width and Arrow Width to 4.0

• Percent to 30.0.

5. Open the Arrow editor for Minutes and set the following properties:

• Style1 to Flat.

• Width and Arrow Width to 3.0

• Percent to 40.0.

6. Open the Arrow editor for Seconds and set the following properties:

• Style1 to Flat.

• Width and Arrow Width to 2.0

• Percent to 50.0.

7. Add the Analog Watch plugin to the Hours, Minutes and Seconds containers.

8. Open the Analog Watch editor for the Hours container and set it to Hour24 or
Hour12.

9. Open the Analog Watch editor for the Minutes container and set it to Minute.

10. Open the Analog Watch editor for the Seconds container and set it to Second.

See Also

• Clock Rotation

• System Time

12.20 Tools
The following container plugins are housed in the Tools folder:

• Advanced Counter

• Autofollow

• Autorotate
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• Bounding Actions

• Clock Rotation

• Cloner

• Colorize

• Counter

• DVE Follow

• Heartbeat

• Image Link

• Jack

• Level Of Detail (LOD)

• Magnify

• Match It

• Max Size

• Max Size Lines

• Object Zoom

• Omo

• Pablo

• Parliament

• Rotations Order

• Slide Show

• System Time

• Temo

• TextBG

• Text Link

• Text Parameters

• VCF Parameter

12.20.1 Advanced Counter

 The Advanced Counter plugin allows you to easily create an animated counting
sequence. It shows values with decimals and it has the possibility to create a user
defined format mask. Furthermore it can have prefixed values.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

• To create an advanced counter
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Properties

• Use Integers: Enables the use of integers only.

• Value (Dec.), Value (Int.): Sets the current value of the counter. Animate this
value to create the counting sequence.

• Leading blanks: you can here choose what the counter does with leading blanks.
They can either be Cut away or put in as Blank, asterisk, hash, dot or zeros.

• Force prefix: Enables both positive and negative values to have a prefix, not only
negative values as is the default (+/-).

• Delete unnecessary commas: Removes superfluous commas when a specified
format mask has more commas than the number needs. If you for instance have
defined the mask: “$###,###,###,###.##” and you enter the number 4120.37,
it will be displayed as “$,,4,120.37”. If you enable this option, the number will get a
correct format: $4,120.37

• Decimal separator: Switches the decimal separator between point and comma.

• Format mask: Allows you to define a format mask. Each hash symbolizes an
element of the total number. To alter, add or remove hashes. You can also add
constant values, for example DM, NOK etc.

• Initialize: Starts the counter.

To create an advanced counter

1. Add a group container to the scene tree.

2. Add a font and material to the group container.

3. Add the Advanced Counter plugin to the group container.

4. Open the Advanced Counter editor and animate the parameters.

12.20.2 Autofollow

 The Autofollow plugin is used to connect one object with another. This object is from
then on dependent on the connected plugin. Depending on the axis of your Object to
follow, the bounding-box will grow into the reverse direction.

If you want to follow for example a text object, which writes from left to right, you have
to set the axis of your text object to the left side, because the bounding box will grow
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to the right side. You can select for the following object either one axis (X,Y,Z) or two
(XY, XZ, YZ).

Drag the Autofollow plugin over the object container which should be dependent. It
will automatically follow the Previous object in the scene tree. You may also set this to
be the First object or select one specific object by adding it to the object placeholder
exposed when selecting the Other option.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• X Previous Center: Defines the alignment of your related object.

• Default Distance (Min): Allows you to set a distance from the object to the
related one. This is a relative value that is dependent on the size of the related
container.

• Progress (%): Allows you yo animate the related object. In this case you can set
a default distance value and a maximum distance. What you need to do is just set
keyframes on the progress. At the beginning of the animation you can for example
have 100%, and at the end 0%. The object will run from the maximum to the default
distance value.

• Maximum Distance: Allows you to set the maximum distance from the object to
the related one. This is an absolute value, which is independent of the size of the
related container.

• Reference Container: With these buttons (Previous, First, Other) you can
change the related object. The default preference is ‘Previous’, where the previous
container in the scene-tree is selected. If you choose ‘Other’, you have to drag your
wished reference-container onto the empty button, which appears when you select
‘Other’.

• Direction: Allows you to choose in which axes there should be a dependency on.
Options are: X,Y,Z,XY,XZ or YZ.
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• Follow Negative: If you select this feature, all numerical values are negated. For
example when you change ‘Default Distance (Min)’ to a positive value your object
will be positioned in negative direction of the selected axis or axes.

• Ignore hidden containers: If the reference container is hidden, search for the
next visible container depending on the reference container setting (only if set to
Previous or First).

• Ignore default distance on hide: Allows you to hide the reference container if
you do not want the default distance to be considered. In this case it will be null. If
you make the reference container visible, the default distance will appear again.

• X Local Center: Allows you to select your alignment for the local center in X-
direction.

See Also

• Merging Containers

12.20.3 Autorotate

 With the Autorotate function, a container can be set to continuously rotate round
one of its axes.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Axis: Selects the rotation axis either X, Y or Z.

• Direction: Selects the direction of the rotation, either Right or Left.

• Velocity: Sets the speed of the rotation. The unit is degrees per frame.

• Ease In (frames): Sets the number of frames the object will use to accelerate
smoothly from no motion to the speed set in Velocity.

• Ease Out (frames): Sets the number of frames the object will use to retard from
the rotation speed to a stop.

• Starting Angle: Sets the angle from the objects current position, from which the
object is to start from.

• Ping Pong: Enables a “ping pong” motion where the object rotates forward and
backward between two angles on the axis.
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• Ping Pong Angle 1: Sets angle 1 for the “Ping Pong Mode”.

• Ping Pong Angle 2: Sets angle 2for the “Ping Pong Mode”.

• Ease in: Initializes the rotation from the starting angle selected and with the Ease
in value selected.

• Ease out: Stops the rotation. The stop motion is influenced by the Ease out
parameter.

• Continue: Starts the rotation from the point where it was halted. The value of Ease
in is disregarded.

• Halt: Stops the rotation without regard to Ease out.

12.20.4 Bounding Actions

 The Bounding Actions plugin enables you to run Viz actions depending on the size of
the bounding box.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Text box: The command, that will be executed every time the bounding box
changes.

• Scale X, Y and Z: Applies a scaling to the values %dx %dy %dz.

• Offset X, Y and Z: Adds an offset to the values %dx %dy %dz.

Syntax:

• %dx: Substitutes the width of the bounding box.

• %dy: Substitutes the height of the bounding box.

• %dz: Substitutes the depth of the bounding box.

• %xbool: 0 if dx <= 0 else 1.

• %ybool: 0 if dy <= 0 else 1.

• %zbool: 0 if dz <= 0 else 1.

• %container: Path of the container the bounding action is applied to.

• %container[path]: Relative path of the container the bounding action is applied
to.

Example:

THIS_SCENE*TREE*#297*TRANSFORMATION*POSITION SET %dx %dy %dz

Example:

%container[$textnode1$textnode2]*GEOM*TEXT SET %xbool

To use bounding actions
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1. Drag the plugin onto a container.

2. Insert a command in the Text box (see examples above).

• Now every time the bounding box changes (a Sub-Container is moved outside
the current bounding box or the bounding box plugin is used to modify it), this
command is executed.

12.20.5 Clock Rotation

 Animates any object as a rotating clock.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Clock Unit: Sets the units for the rotation of the object. Available options are
Seconds, Minutes and Hours

• Rotation axis: Sets the axis for the rotation of the object. Available options are X, Y
and Z

• Motion type: Sets the motion type for the rotated object. Digital will show a ticking
motion, and Chrono a smooth motion.

• Reverse: Sets the direction of the rotation. When disabled (off) the rotation is
clockwise, and when enabled (on) the rotation is counter-clockwise.

See Also

• Analog Watch

• System Time

12.20.6 Cloner

 Creates a number of clones of a given container (target).

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties
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Properties

• Clones Count: Specifies the max. number of clones to be created.

• Clones Rows: Defines, together with Clones Cols, how clones are being laid out.
Layout depends on the Shape parameter which can be Matrix (grid), Ellipse and
Sphere.

• Clones Cols: See Clones Rows description above.

• Shape: Sets the different shapes. Available options are Matrix, Ellipse and Sphere.

• Rename Subtrees: Clones will be labeled "group_x_y" per default. If this flag is
set, clones will be labeled "<name of target>_x_y". Only takes effect upon future
changes in the subtree.

• Rename Excess Containers: Suppose a matrix of 10x10 clones. If you now
change the matrix to be made of 5x5 clones you will be left with 75 orphans, which
will be removed if this flag is set. Only takes effect upon future changes in the
subtree.

• Remove All (button): Remove all clones right now.

• Remove Only Excess (button): Remove excess clones right now.

Matrix and Ellipse shape specific settings:

• Plane: Specifies along which axes, newly generated clones are going to be laid out.
Default is XY, alternatives are XZ and YZ.

• Delta X, Y and Z: Specifies an relative offset in X,Y and Z axis between each clone.
Actually defines how closely clones are being packed into the matrix or ellipse.

• Delta represents: Step directly affects the translation matrix of the clones 1:1.
For example a value of 200 for Delta X means that clone A (located at position 0)
will be followed by clone B translated 200 units in X. The container’s transformation
matrix is being modified accordingly. Bounding Box does not affect the clones
transformation matrix 1:1, but instead applies the transformation relative to the
bottom-left edge of the target’s bounding box in matrix mode. Suppose a rectangle
of 100x100 is used as target. Delta X of 100 in Step mode will cause all clones to be
positioned with an offset of 100 units in X. In Bounding Box mode a value of 100 will
produce an effective offset of only 50.

• R1 and R2: Specifies values of radius 1 and radius 2, defining the ellipse. Used in
ellipse mode.
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• Min and Max Angle: Specifies an open ellipse from for example 45° to 175°
instead of 0° to 360°. Used in ellipse mode.

• Offset Angle: Rotates the individual clones along the axis. This is not affected by
setting of Plane. If the ellipse is laid out in XY this parameter will affect the Z-axis.
Used in ellipse mode.

Sphere shape specific settings:

• Radius: Specifies the radius of the sphere composed by the given number clones.

• Min and Max Azimuth: Same as Min and Max angle for the ellipse.

• Min and Max Pitch: Specifies the position of the poles of the sphere. The poles
can only be shifted towards the center of the sphere. This will actually result in a
sphere with its poles being cropped.

To clone container

1. Add a new group to the scene tree, and add the Cloner plugin to it.

2. Add the object (target) to be cloned as the first child of this group.

• By modifying parameters Clones Count, Rows and Cols a corresponding number of
clones will be created.

• Operating in shape mode Matrix you can alter Delta X, Y and Z parameters to create
a layout for the newly generated clones.

12.20.7 Colorize

 The colorize plugin allows you to transform the colors of containers within a
container group. If you for instance have 15 Sub-Containers in a group, the colorize
plugin assign numbers to each container by the order they have in the group. You can
then define for each Sub-Container which color it should have to start with and which
color it should change to.

The plugin can define up to 10 colors. Each color is able to influence more than one
container. The Num Color1-10 parameters allow you to link multiple containers to one
color in the colorize plugin. Each of the Sub-Containers must have its own material for
the plugin to work.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties
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Properties

• Colorize: Runs the color transformation. One number corresponds to one container.

• Animation Start: Allows you to select the starting point for the color change.

• Default Color: Sets the color for containers in the group which are not selected for
color transformation. To set it, use the color editor below or drag a material from the
server view onto the small square.

• Num Color1 A to 10 A: Assigns the starting colors to containers, from which the
color change starts. The value sets the number of containers to be linked with the
corresponding color in the Color1 A: 10 A parameters. The function starts counting
from the first undefined container. This means that, if color 1 A has the value 2,
color 2 A has the value 3 and 3 A has the value 1, the two first containers get the
properties of color 1 A, container 3: 5 get the properties of color 2 A and container 6
gets the properties for color 3 A.

• Color1 A to 10 A: Sets the colors for 1 A: 10 A. You can set each color using two
methods:

• Either select the color by clicking the color icon and then set the color properties at
the color editor at the bottom, or

• Drag a material from the server view onto the color icon of the color you want to
set.

• Num Color1 B to 10 B: Assigns the ending color to containers, to which the
color change ends. The value sets the number of containers to be linked with the
corresponding color in the Color 1 B: 10 B parameters. The function starts counting
from the first undefined container. This means that, if color 1 B has the value 2,
color 2 B has the value 3 and 3 B has the value 1, the two first containers get the
properties of color 1 A, container 3: 5 get the properties of color 2 B and container 6
gets the properties for color 3 B.

• Color1 B to 10 B: Sets the color for 1 B: 10 B. You can set each color using two
methods:
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• Either select the color by clicking the color icon and then set the color properties at
the color editor at the bottom, or

• Drag a material from the server view onto the color icon of the color you want to
set.

• Rebuild: After having made changes to colors and assigning containers, click
rebuild to apply the changes.

12.20.8 Counter

 The counter is a simple plugin that can create a count up or count down at any
given range and at any given speed. It shows integral numbers.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

• To use the counter

Properties

• Number: Sets the current number of the counter. Animate this value to create the
wanted count-up or -down.

• Initialize: Starts the operation.

To use the counter

• Add the Counter plugin to a container with a font, and click Initialize.

12.20.9 DVE Follow

 DVE Follow connects a video input channel or a clip channel of the containing scene
with the bounding box of a container. When connected the channel, if set to DVE, will
follow the bounding box of the container. The plugin does not actively set the channel
to DVE.

IMPORTANT! Be aware of the fact that the DVE animation is done on the video
board while the animation of the ruling container is done together with all other
graphics on the GPU. The output delays of the graphics and the DVE animation
are different and this can lead to notable offsets between graphics and DVE
(especially notable with fast animations).
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DVE Follow Properties

• Channel Type: Type of channel to manipulate:

• Video Channel

• Clip Channel

• Video/Clip Channel Number: The plugin supports a maximum of 8 video channels
and 16 clip channels.

• Layer:

• Video Width: With of the containers bounding box.

• Video Height: Height of the containers bounding box.

• Alpha: Alpha value of the DVE channel.

• Priority: Priority value of the DVE channel.

• Crop: Left, right, top and bottom crop value of the DVE channel.

12.20.10 Heartbeat

 The Heartbeat plugin creates a heart beat animation. Includes animation of:

• Size, along different axes, axis-pairs or all axes

• Rotation, around three main axes

• Alpha

• Color

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Animation Length: Sets the length of the animation. Parameter Name:
animLength.

• Swing: Enables the object to have a swinging action (back and forth). Parameter
Name: swing.
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• Pause: Enables the object to pause before repeating the action. Parameter Name:
pause.

• Pause Length: Sets the length of the pause. Parameter Name: pauseLength.

• Change Size: Enables the change size parameters for changing the vector(s),
initial and final weight of the object’s animation. Parameter Name: changeSize.

• X, Y, Z, XY, XZ, YZ, XYZ: Sets animation vector(s). Parameter Name:
changeVector.

• Initial Weight: Sets the initial weight of the object. The higher the value the slower
the animation will be at first. Parameter Name: initialWeight.

• Final Weight: Sets the final weight of the object. See also Initial Weight. Parameter
Name: finalWeight.

• Change Rotation: Enables the rotation parameters changing the rotation axes,
initial and final angles. Parameter Name: changeRotation.

• X, Y, Z: Rotates the object on the X, Y or Z axis. Parameter Name: rotAxes.

• Initial Angle: Sets the initial angle of the object. Parameter Name: initialAngle.

• Final Angle: Sets the final angle of the object. Parameter Name: finalAngle.

• Change Alpha: Enables the alpha parameters changing the initial and final alpha
values. Parameter Name: changeAlpha.

• Initial Alpha: Sets the initial alpha value. Parameter Name: initialAlpha.

• Final Alpha: Sets the final alpha value. Parameter Name: finalAlpha.

• Change Color: Enables the color parameters changing the color of the object.
Parameter Name: changeColor.

• Source Color: Sets the source color. Parameter Name: sourceColor.

• Target Color: Sets the target color. Parameter Name: targetColor.

12.20.11 Image Link

 The Image Link plugin copies the image/texture from the source container to up to
10 linked containers. The image you load in the source container will be repeated in all
the linked containers.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

• To link an image to multiple containers
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Properties

• Container 1: 10: Drop zones for the containers you want to link.

• Initialize: Initializes the plugin.

• Do it now: Performs the operation immediately.

To link an image to multiple containers

1. Add a group container to the scene tree.

2. Add the Image Link plugin and the source image to the group container.

3. Add a number of containers to the scene tree with a dummy image on each.

4. Open the Image Link editor.

5. Drag and drop the containers with the dummy images onto the Container 1-n drop
zones.

6. Click Initialize to apply change.

See Also

• Text Link

12.20.12 Jack

 The Jack plugin allows you to show a digital clock and date. The plugin is highly
customizable allowing you to set your own time and date formats and correction
values.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties
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Properties

Time mode has the following properties:

• Hour format: Sets how to show hours (either off, on or with a leading zero if the
value is less than 10).

• Min format: Sets how to show minutes (see Hour format).

• Sec format: Sets how to show seconds (see Hour format).

• Hour/Min separator: Sets character separation for hours and minutes.

• Blink mode: If set to on the separator between hours and minutes will blink, this
means - every odd second it will be turned off.

• Min/Sec separator: Sets a separator for minutes and seconds.

Note: Although a format is switched off, the separator will still be displayed.

• am/pm or 24 hours: Switches between the am/pm and 24 hour format

• Time/meridian separator: Sets a separator for the am/pm hour format.

• am/pm format: Sets the case of am/pm to upper or lower.

• Hour correction: Enables you to correct the hour value of the system time. Useful
for displaying the local time of a location in a different time zone.

• Min correction: Sets correction value for minutes (see Hour correction).

• Sec correction: Sets correction value for seconds (see Hour correction).

Date mode has the following properties:
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• Year format: Sets how to show the year format (off, 2 digits or 4 digits, please
keep in mind that in the year 10000 this will be 3 digits or 5 digits, due to the
algorithm used).

• Month format: Sets how the month is displayed, either off, on or with a leading
zero from january to september.

• Day format: Sets how the day is displayed (see Month format).

• First separator: Sets the separator character for the first two elements of the
date. If the dot value is selected an additional blank character will be inserted
automatically.

• Second separator: Sets the separator character for the last two elements of the
date.

• Order: Sets the order of the elements of the date.

• Leap year: Corrects the date value with correction values. If enabled, February
29th is used in the date calculation.

• Year correction: Sets a correction value for the year.

• Month correction: Sets a correction value for the month.

• Day correction: Sets a correction value for the day.

12.20.13 Level Of Detail (LOD)

 Level Of Detail (LOD) is a mechanism for controlling the level of complexity of a 3D
object, depending on camera position and object size. As an object becomes smaller
on the screen, the objects polygons become smaller. At a certain size those polygons
are small enough to be replaced by a lower number of larger polygons, without loosing
realism. The goal is to maintain the overall shape of the object so it will not change
significantly, when the number of polygons are changing.

Viz Artist has a built-in LOD mechanism for text objects and internal objects, such as
Sphere, Cylinder and so on. This mechanism changes the tessellation of the object,
based on its size on screen. However, there is no LOD mechanism for imported objects
and models. This is where the LOD plugin can be used. The LOD plugin enables
switching between different representations (levels) of the same object, based on its
distance from the camera and on the zoom level of the camera. A switching range is
assigned to each representation: to determine the specific distance from camera in
which it will be replaced by the next representation.

In addition to that, the zoom of the camera is taken into consideration; objects that
are far away from the camera will look closer (and larger) at a narrow zoom position,
or smaller at wide zoom. To accommodate for different zoom values, the LOD plugin
assumes that the switching ranges are correlative to a reference zoom value. When
the actual zoom value differs from the reference zoom value, the switching ranges are
automatically adjusted.

To use the LOD plugin on an object, you have to import several representations of that
object from an external source. The different representations of the object have to be
placed under a group node, in the order of detail, this means the most detailed level
will be on the top of the group. When the LOD plugin is placed on the group container it
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will make only one of its children (levels) visible at a given time, based on the distance
between the center of the object and the camera, as well as the current zoom value,
and other selectable parameters of the plugin.

The LOD container plugin works in conjunction with the Level Of Detail (LOD) Manager
scene plugin that controls all the LOD plugins in the scene.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Lock: In certain cases it is desirable to disable the distance switching and lock the
LOD plugin to show one of the levels.

• Lock On Index: Displays index of the selected level when Lock is on.

• Center: Defines whether the distance from the camera will be measured from the
origin of the object (Automatic) or from a specific point in the object, for example
one of the corners (Manual)

• Center X, Y and Z: Sets the point from which the distance from the camera is
measured (in object coordinates), if the Center parameter is set to Manual.

• Range Scale: Sets a scale factor on the switching ranges. This scale factor
allows shortening or lengthening the distance at which object representations are
switched.

• Range 0: Sets the switching ranges. Those are the distances at which object
representations are switched. The number of entries is n+1 where n is the number
of children in the group on which the LOD plugin is assigned

• Initialize: Re-initializes the LOD plugin. This is required if the number of children of
the LOD group has changed after the LOD plugin was assigned to the group.

See Also

• Level Of Detail (LOD) Manager
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12.20.14 Magnify

 The Magnifying plugin offers the possibility to create a simulation of a looking glass
and other similar effects. At an area defined by an overlying object an image can be
shown in a magnified way.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Scale: Sets the scaling of the magnifying effect

• Effect Type: Adds an extra effect, either Blur or Pixel. This only works on onux.

• Effect Value: Sets the value for the selected extra effect.

• Alpha: Sets the alpha value for the container.

• Rebuild: Applies the changes to the texture.

To magnify a texture

1. Add a container to the scene tree, and name it source.

2. Add the image or texture that is to be magnified to the source container.

3. Add a Sub-Container to the source container, and name it magnify.

4. Add the same image or texture to the magnify container that was used in the
source container.

5. Add the Circle geometry to the magnify container.

6. Open the transformation editor for the magnify container and set Position Z to 1.0.

7. Add the Magnify plugin to the magnify container.

8. Open the Magnify editor and set Scale to 2.0.
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12.20.15 Match It

 Sets the axis center (i.e. center for rotations) to the camera and moves the object
away from the camera by the specified amount of units. By setting an arbitrary camera
distance and initializing the plugin, the container with the Match It plugin will be
positioned in the specified distance and any rotation will be done with respect to the
camera position. The container’s axis center parameter can also be edited for a more
flexible configuration.

Note: Keep in mind that you have to re-initialize the plugin if the camera is
moved.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Initialize: Resets the pivot to the camera and places the object ‘CamDistance in Z’
units away.

• CamDistance in Z: The distance from the camera on the z axis.

12.20.16 Max Size

 The Max size plugin is used to set max size parameters for text objects. This allows
you to have control over the space the text should use such that it does not “overflow”
the designated text area.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

• To set max size

Properties

• Default x-scale: Sets the default x-scale.

• Default y-scale: Sets the default y-scale.
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• Max width: Sets the max width.

• Scale y: Scales the y-value accordingly when max width is reached.

• Initialize text scale: Initializes the plugin parameters.

To set max size

1. Add a group container to the scene tree

2. Add a group container as a Sub-Container of the first (scaled to 1,1,1) and name it
text

3. Add a font (e.g. Georgia Regular) to the text container

4. Add the MaxSize plugin to the text container

5. Click the MaxSize plugin and set Max width to 200.0

6. Click the font and type Create

7. Now type Create more

• This will automatically scale the font’s X value as it limits itself to the Max width

8. Optional: Click the MaxSize plugin and enable the Scale Y parameter to
automatically scale the font’s Y value

See Also

• Max Size Lines

12.20.17 Max Size Lines

 The Max Size Lines plugin solves the problem of using TextFX with multiline text in
right-to-left languages.

Note that each line of text must be in separate containers, and organized as a sub
group of the container holding the Max Size Lines plugin.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties
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• Default x-scale: Sets the default x-scale.

• Default y-scale: Sets the default y-scale.

• Max width: Sets the max width.

• Scale y: Scales the y-value accordingly when max width is reached.

• Initialize text scale: Initializes the plugin parameters.

See Also

• Max Size

12.20.18 Object Zoom

 Object Zoom lets an object follow the camera and match its orientation. This creates
an effect as if the camera would smoothly zoom to the object.

Note: This plugin is located in: Built-ins -> Container Plugins -> Default

This section contains information on the following topics:

• Properties

• To zoom an object towards the camera

Properties

• Counter: The speed of the zoom operation. Use values from 1-1000.

• Dest. Object: The name of the container that will be affected by this plugin.

• Dest. Dist.: The distance from the camera at which the object will stop.

• Dest. Size %: The scaling of the object.

• Path HOffset: Horizontal offset in camera space.

• Path VOffset: Vertical offset in camera space.

• Initialize (button): Starts the zoom.

To zoom an object towards the camera

1. Add the Object Zoom plugin to a container.

2. Set the Dest. Object parameter to match the containers name.

3. Set the counter to at least 1.

4. Click Initialize.
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5. Go to Views and move the camera to see the container zooming towards the
camera.

12.20.19 Omo

 The Object moving (Omo) plugin gives the user the possibility to create a very
realistic animation of a complex imported 3D object, where the object not just changes
position or rotates, but where it changes form and moves in a realistic way, like a man
walking or a fish swimming.

The plugin can also create animation sequences with other sorts of objects. Anything
you can put in a container can be used as an element in an Omo animation process.

The plugin hides all Sub-Containers and shows them one by one. The one to be
shown is controlled by the Visible Container parameter. By animating this value an
animation sequence of all the containers is made. The plugin can also be used to show
one group at a time.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Visible Container: Allows you to select which container that is to be visible.

• Keep Visible: Enables you to keep containers visible after they have been revealed
one by one.

• Initialize: Initializes the Omo plugin. All containers in the group are then hidden,
except the one selected by the Visible Container parameter.

To animate one object at a time

1. Create a group and add the Omo plugin to it.

2. Create a number of Sub-Containers to the root container.

3. Add a Sphere geometry and material to each Sub-Container.

4. Optional: Animate the sphere.

5. Open the Omo editor, click the Initialize button, and animate the Visible Container
parameter.

See Also

• Control Omo
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12.20.20 Pablo

 Pablo is an object import plugin that enables you to import multiple indexed images/
objects from the pool under the local container Pablo is added to.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Type: Select wether you want to import images (from the image pool) or 3D objects
(from the object pool).

• Name: Sets the name of the images/objects you want to import, including path
and index number format. Index number format is specified with characters. Use
multiple characters for index numbers with leading zeroes. The name must match
the path and name of an existing image/object in one of the pools.

• Start index: Sets the index number of the first object to be imported.

• End index: Sets the index number of the last file to be imported.

12.20.21 Parliament

 The Parliament plugin is specially developed for creating visualizations of parliament
seats in graphics designed for election programs, but it can of course be used in other
ways. The plugin creates a “parliament like” seating structure using an object of your
selection.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

• To create a parliament shape

Properties
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• Number of Elements: Allows you to set the number of seats to be created in the
parliament structure.

• Number of Rows: Allows you to decide how many rows the parliament seats
should be distributed over.

• Scale: Sets the Scaling (locked) of the generated Sub-Containers. Default is 1.0.

• Rebuild Geometry: After having made changes to either Number of Elements or
Number of rows, you must click on this button to apply the changes.

• Inner Radius: Sets the inner radius of the parliament.

• Outer Radius: Sets the outer radius.

• Start Angle: Sets the starting angle which by default is -90° from the Y-axis.

• End Angle: Sets the ending angle, default 90°.

To create a parliament shape

1. Add a group to the scene tree, add material, rotate and set parameters (except
Position and Scaling).

2. Add the Parliament plugin to the container, and click the Initialize button.

• By default the seating is created with 40 seats in 3 rows. The plugin then by default
creates 40 Sub-Containers that are copies of the core-object.

• All the newly created Sub-Containers have the same properties as the source object,
except from Position and Scaling (if set). Position is set by the plugin to create the
parliament structure.

3. Open the transformation editor for the first Sub-Container and set Scaling (locked)
to 0.2.

4. Still having the transformation editor open for the first Sub-Container, select
all other Sub-Containers and drag and drop the Scaling property onto on of the
selected Sub-Containers.

• This will set the same Scaling parameters for all selected Sub-Containers.

Note: If the object you used for creating the seats contains many polygons, the
total product of the parliament container can quickly be too heavy to render.

12.20.22 Rotations Order

 Rotations Order changes the rotation order of a container in Viz Artist to match the
Softimage XSI rotation order. This plugin is automatically added to some containers
when Softimage XSI scenes are imported into Viz Artist.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties
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Properties

• Rotation Order: Sets the rotation order to either XYZ or ZYX.

12.20.23 Slide Show

 The Slide Show plugin allows you to create a sequence where a group of containers
fade in and out one by one in the same manner as a normal slide show.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Blend Value: Controls the slide show sequence. Animate this value to create the
change from slide to slide.

• Use Offset: Enable this option if the slides have the same initial position and you
want them to move along some of the axes as the slides are being shown.

• X, Y and Z Offset: Sets the offset values of each slide calculated form the one
previously shown.

• Fade Out: May be set Off, On (every slide) or Last (last slide only)

• Start with: Sets what should be visible if slide show is not started.

To create a slide show

1. Add a group to the scene tree, and name it slideshow.

2. Add a number of Sub-Containers that will be used to house the slide(s).

3. Add the Slide Show plugin to the slideshow container.

4. Position the Sub-Containers in advance using the transformation editors for each
container, or open the Slide Show editor and offset them to create a moving
sequence.

5. Animate the blend value to create the slide show sequence.

6. Click the Initialize button to initialize the plugin.

• Each of the Sub-Containers automatically get an alpha icon.



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 813

12.20.24 System Time

 The system time plugin allows you to create a variety of time and date settings
based on the system time.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• format (aAbBcdDHIijlmMpSUwWxXyYzZ/:,.): Sets the format of the system
time.

• Language: Sets the language format of the system time. Available options are
Default (system specific), English, German and Norwegian.

• Seconds offset from system clock: Sets the number of seconds the system clock
should be offset. Default is 0.

• Hours offset from system clock: Sets the number of hours the system clocl
should be offset. Default is 0.

• System time zone: Sets the system time zone.

• Show Time Zone: Shows the result of the system time zone.

• Lower Case Text: Displays all text in lower case.

Time Zone: tzn[+|-]hh[:mm[:ss] ][dzn]

• tzn: Time zone name, e.g. PST

• hh,mm,ss: Offsets from UTC

• dzn: Daylight-saving-time zone, e.g. PDT

Examples: EST5EDT, PST5PDT, GST-1GDT

See Also

• Analog Watch

• Clock Rotation

12.20.25 Temo

 The Temo plugin gives the user the possibility to create an image animation
sequence, using a method much like the one used for making a cartoon film. The basic
input for the plugin is a single image consisting of many tiled and equally sized squares
set up in a matrix.
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Each square of the image is made up to be a snapshot of an animation sequence, just
like each picture frame is on a normal film. The image must be made up in advance
with the aid of a image editing tool. In the property editor you tell the Temo plugin how
many tiled squares there are in the X- and the Y-axis. The plugin is then able to show
the tiles of the image one by one. By animating this, a “film like” sequence is created.
The plugin has only a small influence on the rendering performance.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Number of tiles horizontal: Here you define the number of tiles in the X-axis of
the source image.

• Number of tiles vertical: Here you define the number of tiles in the Y-axis of the
source image.

• Show Tile Number: Selects the tile to be shown. The range of tile numbers is
the product of the two above parameters. If there are 3 in the horizontal and 4 in
the vertical plane, the total is of course 12. The tile with the coordinates X1Y1 is
shown first, then X2Y1 and so on. By animating the whole range of this value, a
“film animation” can be created. The quality of the animation depends of course on
the number of tiles and on the degree of transformation from one tile to the next
throughout the whole sequence.

12.20.26 TextBG

 The TextBG plugin, when used with the Rectangle, Noggi, Fade Rectangle or Cube
Geometry plugins, creates a background which grows as text is typed in the Text Editor.
To use other Geometry plugins click on the Scale option.

Note: Not all Geometry plugins will work with the TextBG plugin.

Note: The TextBG plugin can also be used with Objects, Images and Video clips.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• TextBG Properties

• To Add Background to the Previous or Next Containers
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TextBG Properties

• Size Parameter: Sets the size of the background to adjust to:

• W/H (width/height): The width and height of the background geometry will adjust
to the size of the typed text.

• Scale: The background will scale to the size of the text.

• Text Container: Sets the TextBG plugin to use the background in selected
containers:

• PREV (previous): The background geometry is applied to the Container previous
to the TextBG container.

• PARENT: The background geometry is applied on the parent Container

• NEXT: The background geometry is applied to the next container from the TextBG
container.

• OTHER: Select a Container (from the same group) to apply the background
geometry to.

• Other container: Available when OTHER is selected. Drag a container (from the
same group), other than the previous or next container, to the drop area. Click on R
to remove the Container.

• Direction: Sets the direction in which the background should “grow” to adjust
it self to the text. Available options are only the X and Y axis or the XY-axes in
combination.

• Hide On Empty: Hides the background object if there is no text.

• Right, Left, Bottom and Top Margin: Sets the margin between the text and the
background.

• Lock Margins: Sets the margin to be the same for all.

• Enable Substring: Enables the First and Last Character options.

• First Character: Sets on which character the background should start animating.

• Last Character: Sets on which character the background should stop animating.

To Add Background to the Previous or Next Containers
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1. Add a group Container to the Scene Tree.

2. Add three Sub-Containers to the group container:

• Name the top one Text1.

• Name the bottom one Background.

3. Add a Fontstyle to the Text1 Container.

4. Open the Transformation Editor of the Text1 Container.

1. Set Position Z to 1.0.

2. Type some text (for example, More Control).

5. Copy the Text1 container and place below the Background container.

6. Rename the new Text container to Text2.

7. Add a Geometry (for example, Noggi), a material and the TextBG plugin to the
Background container.

8. Open the TextBG editor.

9. Toggle the Text Container property from PREV to NEXT. The background
geometry moves from the Text1 container (the previous container) to Text2 (the
next container).

To apply a background to another Container, other than the previous or next Containers
(in the same group), click on OTHER (in the TextBG properties) and drag the selected
Container to the drop area.

To apply a background to the parent Container click on PARENT (in the TextBG
properties). In this case the parent Container needs to hold a text.

Note: If the text in the Text2 container is of a different size the background
geometry will size to the text.

Note: Sub string is not supported together with multiple texts.

12.20.27 Text Link

 The Text Link plugin copies the text from the source container to up to 10 linked
containers. The text you enter in the source container will be repeated in all the linked
containers. The linked containers must contain a font.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

• To link text to multiple containers
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Properties

• Container 1: 10: Drop zones for the containers you want to link.

• Initialize: Initializes the plugin.

• Do it now: Preforms the operation immediately.

To link text to multiple containers

1. Add a group container to the scene tree.

2. Add the Text Link plugin and a font to the group container.

3. Add a number of containers to the scene tree with a font on each.

4. Open the Text Link editor.

5. Drag and drop the containers with the fonts onto the Container 1-n drop zones.

6. Click Initialize to apply change.

See Also

• Image Link

12.20.28 Text Parameters

 The Text Parameters plugin gives the user the possibility to animate text parameters
because standard text parameters in the text editor cannot be animated. The
parameters for the Text Parameters can only be used for animation.

The settings are not visible on the text until an animation update has been made.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties
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Properties

• Use Kerning: Enable or disable the use of Kerning.

• Tracking: Set the space between each letter.

• Line Spacing: Set the space between each line of text.

• Word Spacing: Set the space between each word.

• Use Soft Shadow: Enable the use of Soft Shadow. Level 4 is the most blurred,
softest shadow. The Drop Shadow option must be enabled for the Soft Shadow to be
visible.

• Use Drop Shadow: Enable or disable Drop Shadow.

• Direction: Set the direction of the Drop Shadow in degrees.

• Distance: Set the distance of the Drop Shadow.

• Z Offset: Set the offset of the Drop Shadow in the Z-axis.

• Color: Set the color of the shadow.

• Alpha: Set the alpha value of the color.

12.20.29 VCF Parameter

 The VCF (Virtual Camera Flight) Parameter container plugin works in conjunction
with the VCF scene plugin. They allow you to create a seamless interpolated transition
from a VCF to a real camera: and vice versa. This is only a relevant function to set up, if
you have purchased the virtual set expansion components.

You must have a real camera with data tracking enabled, which is set in remote mode
in the camera editor. In case you have several tracked cameras, the virtual camera will
interpolate its position to the real camera that is selected on air.

Note: This plugin is located in: Built-ins -> Container Plugins -> Tools

This section contains information on the following topics:

• Properties

• To use the virtual camera flight parameter plugin
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Properties

• Real Camera %: Defines the percentage the real camera influences the position of
the virtual camera.

• Zoom: Sets the actual zoom (FOV-Y) value of the virtual camera

To use the virtual camera flight parameter plugin

1. Add the VCF scene plugin to the scene setup plugins drop zone.

2. Create a new group in your scene and add two new containers under it.

• These are to be the objects that will define the virtual camera flight.

• One will define the position, the other the direction.

3. Name the containers according to the names you entered in the VCF scene plugin
(e.g. T_POS and T_ROT).

4. Click Initialize to finish.

5. Add the VCF Parameter container plugin to the container that holds the position
object.

6. Animate your virtual camera flight using the two objects to define position, and
direction. Do not switch the whole container invisible or else the animation will
not run. You may switch the objects to be invisible, at any time.

7. Animate the Real Camera % parameter in what frame you want to have the real
camera at 0% visibility and when at 100% visibility (the longer the animation is,
the smoother the interpolation will be: 100 F should be good).

• If you start with a virtual camera the first keyframe (0) should have 0% of the real
camera, and the last should be 100% of the real camera.

• The virtual camera will generate a full key (masking the FG), if you choose virtual
set in the scene setup: background.

8. Make sure your FG object/talent are not seen while switching to the real camera.
They should appear in the frame after the switch.

Note: It is not possible to animate the roll of the camera.

See Also

• VCF

• Creating Animations

12.21 Transformation
The following container plugins are housed in the Transformation folder:

• Justifier
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12.21.1 Justifier

 The Justifier plugin enables you to animate the justification of an object using the
object’s height, width or depth as its coordinate system rather than using the Viz
coordinate system.

This plugin acts on the local space of the container it is attached to. So a parent
container can be used to rotate the container for use of arbitrary (world space) axes.

Note: This plugin is located in: Built-ins -> Container Plugins -> Transformation

This section contains information on the following topics:

• Properties

Properties

• Align on X, Y and Z: Aligns the position. Left, Right and Center enables the Anchor
option(s). Adv (advanced) enables the Anchor and Shift option(s).

• X, Y and Z Anchor: Sets the offset for the alignment.

• X, Y and Z Shift (%): Sets the shift of the position values to specify alignment
between left/right, top/bottom and front/back (e.g. an Anchor at 50.0, Shift at -10%,
gives an Anchor at 45.0.). Range is -100 to 100.

• Use rotated edges: If this is set to true and the container has been rotated, a
new axis aligned bounding box will be used to computed the alignment. (I.e. a non
rotated bounding box completely containing the rotated container).

To justify an object

1. Create a container that can only move up and down.

2. Add the Justify plugin on the container.

3. Set Align on X to Center.

4. Set Align on Z to Center.

• Now the container can only be moved along its y axis.

5. Use the X Anchor and Z Anchor to move it along the respective axis.

12.22 Vizual Data Tools
The following container plugins are housed in the Vizual Data Tools folder:
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• Data Fit

• Data Import

• Data Label

• Data Storage

See Also

• Vizual Data Tools Overview

• Area Chart

• Bar Chart

• Line Chart

• Pie Chart

• Scatter Chart

• Stock Chart

• Tutorial on www.vizrt.com under the Training section

12.22.1 Data Fit

 Data Fit listens for incoming data and modifies and redistributes it to another Shared
Memory key.

Note: This plugin is located in: Built-ins -> Container Plugins -> VizualDataTools

This section contains information on the following topics:

• Properties

• To create a scene using data fit
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Properties

• Shared Mem: Changes between Scene-, Global- and Distributed-Shared Memory.
Use Inactive memory to not forward any values via Shared Memory.

• Transfer Mode: Sets string- or array-based data transfer.

• Data Delim. Src.: Defines the value separator sign(s) for all data sources.

• Data Delim. Dest.: Defines the value separator sign(s) for all data destinations.

• Key Data Src.1-5: Shared Mem. key name for input 1-5.

• Key Data Dest.1-5: Shared Mem. key name for output 1-5.

• Scale: Scales each incoming value by that factor.

• Offset: Adds an Offset to each incoming value.

• Autoscale: Activates automatic scaling mode. Now all data is scaled to a certain
range defined by the following 2 parameters:

• Start: Autoscale starting range.

• Stop: Autoscale stopping range.

To create a scene using data fit

This procedure will feed two charts with data. One with the original and the other with
the modified data from Data Fit.

1. Create a new container.

2. Drag and drop a Data Storage and a Data Fit plugin into this container.
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3. Drag and drop two Bar Chart plugins to become children of this container.

4. Open the plugin editor of the first Bar Chart and set Shared Mem. to Scene and
KeyData to “MyData”.

5. Do the same for the second Bar Chart but use “MyDataFit” as the key name.

6. Go to the DataFit plugin and set its Shared Mem. type also to Scene

7. Set Key Data Src.1 to “MyData” and Key Data Dest.1 to “MyDataFit” > set Scale to
2.0.

• The input Shared Mem key is specified with Key Data Src. and the output with
Key Data Dest.

8. Now edit Data Storage for the input values: set Shared Mem. to Scene, Key Data1
to MyData and type in some example values for Data1: 80,40,50,70,80,60,80.

• As soon as you start typing you see both charts building up with the different
values from Data Fit.

12.22.2 Data Import

 This plugin enables Microsoft Excel (.xls and .xlsx) and Microsoft Access (.mdb) file
import via ADO, and distributes it to a text field or a shared memory map. The plugin
supports reading both numbers and text.

Note: To access Excel or Access data using this plugin you need to install the
Microsoft Access Database Engine 2010 Redistributable.

Note: This plugin is located in: Built-ins -> Container Plugins -> VizualDataTools

This section contains information on the following topics:

• Properties

• To create a scene using data import
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Properties

• File: Choose your desired document.

• Table / Sheet: Define the Table’s or Sheet’s name.

• Column(,Col...): Set one ore more column names to use (comma separated).

• Area Input: Excel also accepts areas.

• Column Input: Used column.

• Row Input: Used row.

• Data Delim.: Delimiter after each row.

• Column Delim.: Column separator sign(s).

• Shared Mem.: Set Scene-, Global- or Distributed-Shared Memory for data
transport. Use Inactive memory to not forward any values via Shared Memory.

• Key: Shared Memory key name.

• GetIt: Reads the document, sends the desired data and displays it in the text box.

To create a scene using data import

This procedure will import data from an Microsoft Excel sheet and feed the Line Chart
plugin with data through Shared Memory.

1. Start Microsoft Excel

2. Enter ExcelDataY into cell A1



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 825

3. Add some sample values in the cells below (A2-A8: 80,40,50,70,80,60,80)

4. Rename this first sheet to MyTable (can be done with a double click on the sheet
name at the bottom)

5. Save the Excel file as for example ExcelData.xls at C:\

6. Start Viz Artist and create a new scene

7. Add a group container to the scene tree

8. Drag and drop the Line Chart and Data Import plugin to the group container

9. Add a material to the same group container

10. Open the Transformation Editor and set Position X to -200.0 and Position Y to
-100.0

11. Set Shared Mem. to Scene with MyDataY as Key name for both plugins

12. Set Data Delim. to # for both plugins

13. For the Line Chart plugin set ChartWidth to 500.0.

14. Activate DataY Fit, DataY Auto Scale and DataY Detect Limits

15. Adjust DataY Stop to 200.0

16. Activate Const. Thickness to give the chart a constant line width

17. For the Data Import plugin set the stored Excel file as the File parameter

18. Enter MyTable for the Table/Sheet parameter and ExcelDataY for Column
(,Col…)

19. Click the GetIt button and the chart appears

12.22.3 Data Label

 This plugin enables graph labeling for all Financial Plugins. All containers beneath
the current container get labeled with the values from your Shared Memory variables.

Note: This plugin is located in: Built-ins -> Container Plugins -> VizualDataTools

This section contains information on the following topics:

• Properties

• To create a scene using data label
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Properties

• Shared Mem.: Changes between Scene-, Global- and Distributed-Shared Memory.
Use Inactive memory to not forward any values via Shared Memory.

• Key Data: Shared Mem. key name

• Data: Input Parameter for data

• Transfer Mode: Sets string- or array-based data transfer.

• Data Delim.: Defines the value separator sign(s)

• Label Type: Sets the label type to numeric values (default) or alphabetic labels (for
displaying weekdays, months, etc.).

• Data Fit: Enables data normalization.

• Data Threshold: Adds a definable offset to the detected limit.

• Data Scale: Scales input by the selected factor

• Data Offset: Adds an offset to the incoming data

• Data Auto Scale: Enables automatic data normalization

• Data Detect Limits: Detects minimum and maximum of all values and scales
them to adjusted Start and Stop.

• Data Start: Lower Auto Scale edge

• Data Stop: Upper Auto Scale edge

• Nice Numbers: Rounds to the best fitting next number.

• Remove Multiples: Removes multiple values.

• Sort: Sorts your data elements ascending or descending.

• Draw Zero: Show or hide 0 values.

• Decimals: Adjust decimal digits of all your labels.

• Custom Decimal Symbol: Enables you to set a custom decimal symbol.

• Decimal Symbol: Specifies the decimal symbol.

• Prefix: Adds a label prefix.

• Unit: Define a custom unit for your dat values.
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• PosX, Y, Z: Positions container along the adjusted distance or uses numeric data
value input to translate the label containers.

• OffsetX, Y, Z: Translates the label container on the current axis.

• DistanceX, Y, Z: Sets whole positioning distance for the containers on the current
axis.

• Copy Container: If there are less containers than values, then new containers will
be added.

• Use Alpha: Use input data for alpha scaling.

• Use Scaling: Use input data for alpha scaling.

• Animate Values: Let the current number run from 0 to the defined end value.

• Relative Length: If activated, each label will have its own 100% (e.g. 7 labels
equal 700%).

• Const. Speed: Sets the same animation duration for each label.

• Total Length[%]: Sets the accumulated value of all labels in percent.

• Alpha max.: Limits maximum alpha value.

• Copy Container: Limits maximum scaling value

To create a scene using data label

1. Add an empty container to the scene.

2. Start with an empty scene and drag and drop a DataLabel and a DataStorage
plugin on a container in the scene-tree.

3. Add a Text child container

4. Go to the DataLabel plugin, set Shared Mem. to Scene and KeyData to “MyData”.

5. In DataStorage also set Shared Mem. to Scene, Key Data1 to “MyData” and Data1
to e.g.: 80,40,50,70,80,60,80

6. Go back to the DataLabel plugin and activate Copy Container to create multiple
instances of the text containers automatically.

• You see all labels located on the same position now. In the previous examples
always the chart plugin was responsible for the label positioning. In this
example we want to move that responsibility to the DataLabel plugin itself.

7. Switch PosX to Range, DistanceX to 500.0 and OffsetX to -250.0.

• We want to position the labels over a certain X, Y or Z range in space.

8. Set PosY to Range, OffsetY to -75.0 and DistanceY to 150.0



Viz Artist User’s Guide

Page 828 Copyright © 2014 Vizrt

9. You can also do a value dependent translation by setting PosX, Y, or Z to Data

1. Set Sort to Ascending to sort the labels.

• You see that there are labels with the same values. We want to get rid of them
and activate Remove Multiples for that. You can also try the Nice Numbers option
now which searches for the next logarithmic style labels. But we continue with
deactivated Nice Numbers parameter now.

1. Activate Animate Values and turn down Total Length[%] to 0.0. Create a keyframe,
set Total Length[%] back to 100.0 and create another keyframe.

• This will create an animation where the label values should count up to their final
value.

• Start the animation and see the labels counting and distributing over the specified
XY range.

12.22.4 Data Storage

 This plugin stores data in the current scene and sends it to the other plugins
on startup. This plugin helps artists during scene design if there is no data source
available, and to hold data within e.g. the scene (see Data Sharing).

Note: This plugin is located in: Built-ins -> Container Plugins -> VizualDataTools

This section contains information on the following topics:

• Properties

• To store and send data

• To enable data input from external sources

Properties

• Shared Mem.: Changes between Scene-, Global- and Distributed-Shared Memory.
Use Inactive memory to not forward any values via Shared Memory.
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• Key Data 1-5: Shared Mem. key name.

• Data 1-5: Contains (separated) data.

• Resend Data: Resends the actual values.

To store and send data

1. Create a chart scene, e.g. using the Line Chart plugin and set Shared Mem. to
Scene

2. Add the Data Storage plugin to the scene and set Shared Mem. to Scene

3. Open the DataStorage editor and set the following parameters:

• Shared Mem. to Scene

• Key Data1 to Data1

• Data1 to 10, 20, 15, 30, 25, 40, 20

4. Open the Chart plugin editor and set the Key DataY value (e.g. Data1) using the
Key Data1 value you set for the DataStorage plugin

Note: The chart plugins have different property names (e.g. Data and Key
Data). Also, some have X, Y or Z appended at the end, defining the axis.

5. Open the DataStorage editor and click the Resend Data button

Note: For more information on use of shared data and Data plugins, please read
the Data Sharing section.

To enable data input from external sources

The following example builds on the previous example on how To store and send data.
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1. Add the Control Parameter to the scene tree

• The Control Object plugin is automatically added

2. Open the Control Parameter editor

3. Enter FUNCTION*DataStorage*Data1 into the Parameter field

4. Set Data Type to Text

• This will allow you to pass a string of numbers to the Control Parameter plugin
that will be stored in the shared memory (see Data Sharing).

• It will also allow your template designer or operator to further extend/enhance
the input methods through e.g. scripting.

See Also

• To create a scene using data fit

• To create a scene using data import

• To create a scene using data label

• To create a scene using area chart and data storage

• Data Sharing
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13 Shader Plugins

Shader plugs are housed in the following folders:

• Default

• Effects

• Filter

• Material

• PixelFX

• PixelFXLenseFlare

• RealFX

• RTT Advanced Materials

• Texture

Note: The default path for the Shader plugins is: <Viz Install Directory>\plugin
\<plugin name.vip>

13.1 Default
This folder is empty and reserved for custom Shader plugins.

13.2 Effects
The following Shader plugins are housed in the Effects folder:

• Chroma Keyer

• Fluid

• Frame Mask

• Image Mask

• Soft Mask
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• Water Shader

13.2.1 Chroma Keyer

 This Shader clear regions in a video defined by a color. The colorspace of this Shader
is YUV which is defined as following:

The luminance (Y) component determines the brightness of the color, while the U and
V components determine the color itself (the chroma). Luminance (Y) ranges from 0.0
(dark) to 1.0 (bright). U and V ranges from -0.5 to 0.5.

Note: This plugin is located in: Built-ins -> Shader -> Effects

This section contains information on the following topics:

• Properties

Properties

• Video: Sets the input video channel for keying. Be sure that for the set video
channel the “Keying Mode” has been set to M-Zone (see Keying Mode for Video).

• Blend: Sets the alpha for the key signal

• Invert: Flips the key signal.

• Sampling Filter

• Nearest: Color information is taken from one pixel.

• 1D-Filter: Color information is taken after applying a 1D-linear filter.

• 2D-Filter: Color information is taken after applying a 2D-linear filter.

• Luminance: Sets the luminance.

Basic parameters for first method:

• HueAngle: Selects the color to key in YUV space.

• OpeningAngle: Tolerance for the color in YUV space.

• KeyGain: Gradient for borders to neighboring colors (1=soft, 10=sharp).
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• SatMin: Lower saturation limit for keyed colors.

• SatMinGrad: Gradient for lower saturation limit (0=sharp, 1=soft).

• SatMax: Upper saturation limit for keyed colors.

• SatMaxGrad: Gradient for upper saturation limit (0=sharp, 1=soft).

Basic parameters for second method:

• U-Color: U-value for color keying.

• V-Color: V-value for color keying.

• UV-Diameter: All colors between the reference UV and this diameter will be
removed.

• UVGradient: Gradient for fade out at diameter border (0=sharp, 1=soft).

Removing keying from Highlights and Shadows:

• LumMin: Lower luminance limit for keyed colors.

• LumMinGrad: Gradient for lower luminance limit (0=sharp, 1=soft).

• LumMax: Upper luminance limit for keyed colors.

• LumMaxGrad: Gradient for upper luminance limit (0=sharp, 1=soft).

Sampling reference point:

• UVRangeCheck: This option can be used to get an information of the sampled
color

• URangeMin: Defines the minimum UColor that should be accepted

• URangeMax: Defines the minimum UColor that should be accepted

• VRangeMin: Defines the minimum UColor that should be accepted

• VRangeMax: Defines the minimum UColor that should be accepted
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• SampleTrustiness: Percentage of samples in the limited UV-Color space

• Pos. X: X-coordinate for sampling.

• Pos. Y: Y-coordinate for sampling.

Note: The origin of the coordinate system is in the upper left corner.

• Width: Sets number of pixels in x-direction.

• Height: Sets number of pixels in y-direction.

• Sample at Pos: If enabled Pos. X and Pos. Y will be replaced by XY-coordinates
of the object center. If disabled the XY-coordinates will be set by values in the
interface.

• Get Sample: Sample another time the reference point.

See Also

• Keying Mode for Video

13.2.2 Fluid

 With Fluid you can get a geometry mesh to be elastic during animation.

Note: This plugin is located in: Built-ins -> Shader -> Effects

This section contains information on the following topics:

• Properties

Properties

• Inertia: Sets the inertia of the motion.

• Strength: Sets the strength of the motion.
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13.2.3 Frame Mask

 This plugin adds a framed mask around the object. You can also define standardized
or custom aspect ratios.

Note: This plugin is located in: Built-ins -> Shader -> Effects

This section contains information on the following topics:

• Properties

Properties

• Left, Right, Top and Bottom Edge: Sets the edge of the frame.

• Left, Right, Top and Bottom Gradient: Sets the gradient from the edge of the
frame to the edge of the image.

• Aspect Ratio: Sets a Custom or predefined aspect ratio (i.e. 16:9 or 4:3). Default is
Off.

• Custom: When Aspect Ratio is set to Custom you can use the Custom field to adjust
set a custom aspect ratio (e.g. 1.85:1 or 2.39:1).

13.2.4 Image Mask

 This plugin applies a mask to an image using other images (e.g. an alpha image).
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Note: This plugin is located in: Built-ins -> Shader -> Effects

This section contains information on the following topics:

• Properties

Properties

• Image: Placeholder for image.

• Blend: Blends the image with the object.

• Position X, Y %: Sets the position of the mask in percentage according to the
screen or object.

• Scale X, Y %: Sets the size of the mask in percentage according to the screen or
object.

• Fit: Fits the mask to the screen or object. Moving an object with fit to object
enabled will also move the image used in the mask, and conversely.

• Wrap: Repeats or clamps the image used by the mask plugin. Repeating the wrap
and scaling down the image will cause the image to be applied multiple times on
the screen or object, and conversely.

• Invert: Inverts the image.

• Alpha only: Enables the alpha channel for the image (e.g. an RGBA image).

• Soft Mask: Applies a soft mask.

13.2.5 Soft Mask

 Applies a soft mask to an object (e.g. image or geometry).
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Note: This plugin is located in: Built-ins -> Shader -> Effects

This section contains information on the following topics:

• Properties

Properties

• Progress: Moves the mask perpendicular to the mask direction. Default is 0.0 and
is based on the configured center position.

• Rotation: Rotates the mask.

• Center X and Y: Defines the X and Y position of the center the mask will have.

• Gradient Width: Sets the size of the gradient.

• Invert: Inverts the mask.

• Mirror Gradient: Mirrors the mask on both axis.

• Blank: Offsets the area that should not be affected by the mask.

13.2.6 Water Shader

 This shader simulates a water surface.

Note: This plugin is located in: Built-ins -> Shader -> Effects

This section contains information on the following topics:

• Properties
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Properties

• Bump Height: Sets the height of the bump map.

• Bump Speed: Moves the bump map of the surface. Useful to simulate a current.

• Bump Scale: Scales the bump map.

• Wave Frequency: Sets the frequency of the wave.

• Wave Amplitude: Sets the amplitude of the wave.

• Wave Speed: Defines the big waves of the water. You need geometry with many
vertices to get smooth waves.

• Environment Map: Defines the texture which is reflected in the water. If no
texture is applied the shader will use a default texture. The size of the environment
map should be kept low (512x512 max), because it can consume a lot of texture
memory.

• Deep Water: Sets the color of deep water.

• Shallow Water: Sets the color of shallow water.

• Reflection: Sets the color of the reflections.

Note: The blending of deep and shallow water depends on the angle of the
camera and how it looks at the water.

• Water Amount: Controls how the deep and shallow color affects the look of the
water.

• Reflection Amount, Bias, Power and Multiplier: Controls the reflection

• Blend Texture: Allows you to blend the texture of the container into the water.

13.3 Filter
The following shader plugins are housed in the Filter folder:
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• Blend Image

• Blur

• Color Balance

• Radial Blur

• Sepia

• Sharpen

13.3.1 Blend Image

 Use this plugin to blend two images in different ways.

Note: This plugin is located in: Built-ins -> Shader -> Filter

This section contains information on the following topics:

• Properties

Properties

• Image: Image placeholder. Reset removes the image.

• Mode: Available blend modes are:

• Blend: Ordinary picture blending.

• Darken: Uses the base or blend color, whichever is darker, as the destination color.

• Lighten: Uses the base or blend color, whichever is lighter, as the destination color.

• Multiply: Multiplies the base color with the blend color. The result color will be
always a darker color.
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• Screen: Multiplies the inverse of the base and blend color. The result color will be
always a lighter color.

• Color Burn: Darkens the base color to reflect the blend color by increasing the
contrast of the base and blend color.

• Color Dodge: Brightens the base color to reflect the blend color by decreasing the
contrast of the base and blend color.

• Overlay: Screens or multiplies the colors depending of the base color.

• Soft Light: Darkens or lightens the colors, depending on the blend color.

• Hard Light: Multiplies or screens the colors, depending on the blend color.

• Add: Brightens the base color to reflect the blend color by increasing the
brightness.

• Subtract: Subtracts the base and blend colors.

• Inverse Subtract: Same as subtract but inverses the base and blend colors.

• Difference: Subtracts either the base color from the blend color or the blend color
from the base color depending on which color has the greater brightness value.

• Inverse Difference: Same as difference but inverses the base and blend color.

• Exclusion: Similar to the “Difference” mode but lower in contrast.

• Blend: Blends the image with the object.

• Position X and Y %: Positions the image on the object.

• Scale X and Y %: Scales the image.

• Wrap: Wraps the object with the image. Available options are:

• Repeat: Repeats the image.

• Clamp: Clamps the image (no repeat).

13.3.2 Blur

 Use this plugin to blur an object with an image texture and/or a material on it.
Values can be animated. You also have a blur plugin directly on the image editor but
that will only work on one image, using the shader all images within a group can be
blurred.

The samples above depict the same image with blur quality set to Low, Normal and
High with a range of 100.0. The last is the original (reference) with no blur filter.

Note: This plugin is located in: Built-ins -> Shader -> Filter

This section contains information on the following topics:

• Properties
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Properties

• Quality: Sets the quality of the blur filter. Low will be more pixelated, whereas high
will be smooth. Available options are Low, Normal and High.

• Range: Sets the range of the blur. Range is from 0.0 to 100.0.

See Also

• Radial Blur

13.3.3 Color Balance

 With Color balance you can decide brightness, contrast, saturation and hue.

Tip: Most shaders also work on video clips.

Note: This plugin is located in: Built-ins -> Shader -> Filter

This section contains information on the following topics:

• Properties

Properties

• Brightness: Sets the brightness of the object. Range is 0.0 to 1000.0.

• Contrast: Sets the contrast of the object. Range is -1000.0 to 1000.0.

• Saturation: Sets the saturation of the object. Range is -1000.0 to 1000.0.

• Hue: Sets the hue of the object. Range is 0.0 to 360.0.
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13.3.4 Radial Blur

 Use this plugin if you want to blur the object in different ways.

The samples above depict the same image with radial blur quality set to Low, Normal,
High and Very High with Center X and Y set to -25.0 and 25.0, Inner Range and Scale
set to 25.0 and 50.0, respectively.

Note: Radial blur does not clamp the object.

Note: This plugin is located in: Built-ins -> Shader -> Filter

This section contains information on the following topics:

• Properties

Properties

• Quality: Sets the quality of the blur filter. Low will be more pixelated, whereas very
high will be smooth. Available options are Low, Normal, High and Very High.

• Center X and Y: Sets the position of the object’s radial blur.

• Inner Range: Sets the inner range of the blur.

• Scale: Sets the scale of the object’s blur.

See Also

• Blur

13.3.5 Sepia

 Sepia can be used to generate a sepia effect using two colors, and to adjust the
desaturation and tone of the color for example to blend the image with the color
scheme of the overall scene. Sepia is similar to what is known as duo tone in most
photo editing suites.

The samples above depict the same image with tone levels set to 100.0, 50.0 and 0.0.
All other values are set to default. The last image is the original (reference) without the
sepia plugin.
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Note: The color range is from 0.0 - 100.0 divided by 255 (0.392, 0.784 etc.).

Note: This plugin is located in: Built-ins -> Shader -> Filter

This section contains information on the following topics:

• Properties

Properties

• Desaturation: Sets the saturation level. Range is 0.000 (color) to 100.000 (black &
white).

• Tone: Sets the color tone. Range is 0.000 to 100.000.

• Light Color: Specifies the light color and the strength of it. Range is 0.000 to
100.000.

• Dark Color: Specifies the dark color and the strength of it. Range is 0.000 to
100.000.

13.3.6 Sharpen

 Use this plugin for sharpening the given images on objects.

The samples above depict the same image with Quality set to High, and Scale values at
0.0, 100.0, 200.0 and 300.0, respectively. Range is set to 25.0 (default). The first image
is the original (reference) with Scale set to 0.0.

Note: This plugin is located in: Built-ins -> Shader -> Filter

This section contains information on the following topics:

• Properties

Properties
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• Quality: Sets the quality of the sharpen filter. Low will be more pixelated, whereas
high will be smooth. Available options are Low, Normal and High.

• Range: Increase this value to prepare more pixels to be included in the operation.

• Scale: Increase this value to sharpen.

13.4 Material
The following shader plugins are housed in the Material folder:

• Anisotropic Light

• Bump Map

• Cartoon

• Gooch

• Normal Map

• Simple Bump Map

13.4.1 Anisotropic Light

 This shader uses a lookup texture to compute the distribution of the specular
component. All the shader properties are defined by the material of the container. Only
Light number 1 is used and the light is always treated as a local light source.

With anisotropic light and regular material

Note: This plugin is located in: Built-ins -> Shader -> Material

This section contains information on the following topics:

• Properties

Properties

This plugin does not have any properties or parameters.

13.4.2 Bump Map

 With this plugin you have the opportunity to simulate complex surface structures.
Instead of using many triangles to render a 3D object with many structures on its
surface, you can use bump mapping to get a similar result.

Use plugins for Adobe PhotoShop, Gimp, built-in functions of your modelling package or
NVIDIA’s tool called Melody.
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Note: Make sure the geometry supports tangent space vectors. Otherwise use the
Simple Bump Map shader.

Note: This plugin is located in: Built-ins -> Shader -> Material

This section contains information on the following topics:

• Properties

Properties

• NormalMap: Move an normal map via drag and drop onto this field. Normal maps
are images which store a direction of normals directly in the RGB data.

• HeightMap: Move an height map via drag and drop onto this field. The Height Map
file is only visible and used when parallax mapping is enabled.

• Light Source: Choose the light source in the range 1-8. Please consider that only
one light source is possible. By default the first light source is used.

• Position X and Y: The position of the normal map in X-direction and Y-direction.

• Scale X and Y: Here you can scale the normal map, respectively change the width
and height size of the image.

• Wrap: Repeats or clamps the bump map for the image.

• Toggle X and Y: Changes the direction of the normals stored in the normal map
image.

• Scale Height: Changes the intensity of the bump map effect. Scale Height is visible
when parallax mapping is enabled.

• Parallax Mapping: With this additional map the texture will have more apparent
depth and the object is more realism.

See Also



Viz Artist User’s Guide

Page 846 Copyright © 2014 Vizrt

• Simple Bump Map

13.4.3 Cartoon

 This shader renders objects in a cartoon like manner. Shading is done in steps
and you can define number of steps, the brightest color and the darkest color. Edge
width allows you to blend between the steps. Material and texture of the container
are ignored. Only Light number 1 is used and the light is always treated as local light
source.

Note: This plugin is located in: Built-ins -> Shader -> Material

This section contains information on the following topics:

• Properties

Properties

• Shades: Number of shade levels.

• Edge Width: Create a smooth effect. The transitions are more hard or more soft.

• Silhouette Width: The width of the contours around the rendered objects.

• Silhouette Color: The color of the contours around the rendered objects.
Additionally you can select the alpha value if you want transparent areas. 0
(Invisible) - (Visible) 100%.

• Surface High: The color in the broad range. Additionally you can select the alpha
value if you want transparent areas. 0 (Invisible) - (Visible) 100%.

• Surface Low: The color in the dark range. Additionally you can select the alpha
value if you want transparent areas. 0 (Invisible) - (Visible) 100%.

13.4.4 Gooch

 Gooch is a per pixel light with a reflective high light. Material of the container is
ignored, only the shader parameters are used to define the surface color. Texture
mapping works as usual, but the texture can be blended with the surface color using
the Texture Alpha parameter. Only Light number 1 is used and the light is always
treated as local light source.
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With gooch and regular material

Note: This plugin is located in: Built-ins -> Shader -> Material

This section contains information on the following topics:

• Properties

Properties

• Surface: Describes the intensity of color like the ambient color of a material.

• Cool: Defines the cool color. Both colors cool and warm will be merged. The result is
a color gradient.

• Warm: Defines the warm color.

• Highlight: The diameter of the highlight.

• Highlight Alpha: The alpha or transparent value of the highlight.

• Texture Alpha: Describes the visible value of the texture image in percent. 0
(Invisible) - (Visible) 100%.

13.4.5 Normal Map

 The Normal Map Shader adds a color to each face according to the direction of the
face’s normal. RGB values change between 100-200 while the normal XYZ rotates.

If the Normal is pointing along the Y-axis, this will give the RGB value (100,200,100). A
normal along the X-axis give the RGB value (200,100,100). 45° between x and Y-axis
will give RGB value (150,150,100).

Note: This plugin is located in: Built-ins -> Shader -> Material

This section contains information on the following topics:

• Properties

Properties
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This plugin does not have any properties or parameters.

13.4.6 Simple Bump Map

 With this plugin you have the opportunity to simulate complex surface structures.
Instead of many triangles to render a 3D object with many structures on its surface you
can use bump mapping to get a similar result.

You can only use a gray scaled image as normal map. If you want a more accurate
result and better effects please use the Bump Map plugin instead which is using an
RGB normal map image.

To generate a Simple Bump Map you can use the plugins for PhotoShop, Gimp, the
built-in functions of your modelling package or Nvidia’s tool Melody. The Height Map
(used for parallax mapping) should be a grayscaled image (white -> highest, black ->
lowest bumps).

Note: All calculations are done in object space.

Note: This plugin is located in: Built-ins -> Shader -> Material

This section contains information on the following topics:

• Properties

Properties

• NormalMap: Move an normal map via drag and drop onto this field. Normal maps
are images which store a direction of normals directly in the RGB data.

• HeightMap: Move an height map via drag and drop onto this field. The Height Map
file is only visible and used when parallax mapping is enabled.

• Light Source: Choose the light source in the range 1-8. Please consider that only
one light source is possible. By default the first light source is used.
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• Position X and Y: The position of the normal map in X-direction and Y-direction.

• Scale X and Y: Here you can scale the normal map, respectively change the width
and height size of the image.

• Wrap: Repeats or clamps the bump map for the image.

• Toggle X and Y: Changes the direction of the normals stored in the normal map
image.

• Scale Height: Changes the intensity of the bump map effect. Scale Height is visible
when parallax mapping is enabled.

• Parallax Mapping: With this additional map the texture will have more apparent
depth and the object is more realism.

See Also

• Bump Map

13.5 PixelFX
The Pixel Shader plugins are part of the PixelFX plugins set.

Viz Artist does not support more than one general shader on a Container, or in a nested
fashion. However, in some cases, PixelFX, by its nature, does support multiple shaders
per Container.

Some have high cautionary indications. Some are very light. Some are stackable, and
others are not.

The following Shader plugins are housed in the PixelFX folder:

• Common Properties

• pxBCubic

• pxCCBase

• pxEqualize

• pxGradient

• pxInvert

• pxLensDistort

• pxMotionBlur

• pxNoise

• pxPixelate

• pxPosterize

• pxRecolor

• pxRipple

• pxSparkle

• pxTurbDissolve and pxTurbWipe

• pxTurbulence

• pxTwirl

• pxWaves
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13.5.1 Common Properties

Most of the plugin icons there are mini icons that show certain properties of the plugin
in question:

• At the bottom left, there is a performance bar, with three blocks (like a cellphone
battery indicator). One block means the plugin will not have a drastic performance
effect, and three means the plugin is taxing and should therefore be used with
caution.

• At the bottom right the orange stack shows if the plugin is stackable, meaning it can
be used in conjunction with color correction plugins.

• Some plugin icons themselves are divided in half with one side showing the visual
effect with the plugin and the other without it.

13.5.2 pxBCubic

 When dealing with images that contain line art or lines of high contrast, you may
want to protect yourself from the less than the desirable effect of pixelization when
the image is over scaled. The B Cubic plugin introduces three bi-cubic algorithms.
Each is useful in different contexts of its respective type. It is very easy to find the best
adjustment to your specific scenario.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.3 pxCCBase

 The pxCCBase (Color Correction) applies a cumulative set of color corrections using
the pxStack plugin.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.4 pxEqualize

 pxEqualize allows you to adjust the black, mid-range and white color levels in an
image.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.5 pxGradient

 It can be applied on a container that holds, a geometry, image, or even an empty
container.

The pxGradient plugin has a similar functionality to the gradient function in Photoshop.
You can define as many gradient stops as you wish, as well as their origin points,
angles, and extent. You can also define the gradient on the alpha channel (256 levels)
and introduce turbulence noise that will comply with the defined gradient.
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At the top of the plugin parameters, you see the controls that let you define the
direction, radius and origin of the gradient. Below that you see a two radio button sets.
The first lets you set the gradient type, followed by three Repeat types

Below that, you see the color slider, the color values and alpha ramp settings.

Note: Under the title Color Ramp and Alpha Ramp, you have an active/inactive
option, should you want to have an RGB ramp and no alpha ramp, or vice versa.

Below the RGB and Alpha area of the editor, you find the option of adding Turbulence
to the gradient. The turbulence has three simple parameters. Amount determines
how aggressive the turbulence looks. Wavelength determines how big or small the
turbulence increments are. Progress (similar to that in TextFX plugins) allows you to
breathe life into the turbulence, providing interesting an effect when animated.

At the very bottom, it is important to ensure that you turn off the Show GUI button,
whose default is On; if shown on air, the effect will be more embarrassing than
dramatic.

Best Practices

It is important to understand that the Gradient plugin is actually drawing pixels.
Therefore if this plugin is applied to an empty group or if it is applied to a geometry
object that does not contain a texture, the gradient plugin will generate the texture into
which it will draw its pixels. So if you have a cube and add the Gradient to it, it behaves
exactly as a texture. However it can also work in conjunction with a texture. If you then
take an image and drop it on the cube, you give a color wash to the image that works
in a gradient-like fashion. The gradient-generated texture can also be edited via the
texture editor as any other texture would be.

The biggest benefit of using the Gradient is conservation of texture memory. Instead
of storing very many different alpha and color ramps in your image pool, you can
simply achieve the overwhelming majority of these effects by well thought out and
judicious use of the Gradient plugin. It has a minimal performance penalty and it
can be animated. If you use ramps often in your designs, the Gradient is one of your
handiest tools.

Tips and Tricks

Often you put reflection maps on a translucent geometry to create a glass-like
reflection (think of a light box or an aquarium). For the reflection texture, one often
uses an image of static noise or ramps of sorts. Since the texture is mapped on the
object using a reflection mapping mode, it is very difficult to create the right intensity
of noise in your texture so that the resulting reflection looks good. The Gradient
turbulence functionality allows you to set the intensity of the noise of the texture “on
the fly”, minimizing the round trips to Photoshop.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.6 pxInvert

 Often you create an image with an alpha channel in Photoshop, import it to Viz and
only then realize that your alpha channel is inversed. Or you find an image in the Viz
pool that you want to use, but the way you want to use it is where the RGB is actually
the alpha channel.
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pxInvert allows you to perform these operations without adding yet another image to
your image pool, or overloading your scenes with a few versions of the same image,
where the difference is simple flips of the channels.

This plugin allows you to invert each of the color channels RGB and Alpha individually,
and to use the RGB as alpha and the alpha as RGB.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.7 pxLensDistort

 pxLensDistort creates a “fish eye” lens distortion effect on an image. It can also be
used to create the effect of an old television with a curved screen.

The amount of the effect can be configured using the following parameters:

• Amount

• 2nd Order

• Scale

The center around which the distortion goes can be configured by using the X Center
and Y Center parameters.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.8 pxMotionBlur

 pxMotionBlur applies motion blur to the texture. Supports pxColorWorks and pxStack
plugins.

Adjust the following parameters as required to achieve the desired effect:

• X Center

• Y Center

• Rotate

• Zoom

• X Shift

• Y Shift

• Fix Edges (on/off)

• Samples (enter a value)

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.9 pxNoise

 pxNoise is a white noise generator. It deploys the same turbulence as seen in other
PixelFX plugins. Similarly to the pxGradient, it generates its own texture if applied to a
container without an image, or blends with the existing texture if the container has an
image applied.
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Adjust the following parameters as required to achieve the desired effect:

• Size

• Amplitude: Intensity/contrast of grains

• Color

• Speed: Turbulence noise

• Stretch: Stretch the grain to achieve a rain look of noise

• Stretch Angle

• Movement: Transforms the generation of noise

• Transform as Texture - On: Conform to texture coordinates. Off: Ignore texture
coordinates and behave as stencil mapping.

• Apply to: RGB, RGBA, Alpha: The channels in which the noise will be generated.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.10 pxPixelate

 Similar to the pixelate function in Photoshop, the pxPixelate effect appears as if
you reduce the resolution of your image. You may work in a proportional (locked) or
disproportional mode.

To achieve a nice animated transition, tweak the Smoothness parameter so that the
change between the different pixelization levels will be smoother or harsher.

Adjust the following parameters as required to achieve the desired effect:

• Lock X/Y (on/off)

• X Size

• Y Size

• Smoothness

Supports pxColorWorks and pxStack plugins.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.11 pxPosterize

 pxPosterize recolors an image using only a limited number of colors for a ‘posterize’
effect. You can adjust the number of levels and set the transition to one of Off, Fade or
Glow.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.12 pxRecolor

 pxRecolor ‘false-colors’ an image by using either Red, Green, Blue or Luma as the
input to a color ramp.
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Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.13 pxRipple

 pxRipple creates a pond ripple effect. Supports pxColorWorks and pxStack plugins.

Adjust the following parameters as required to achieve the desired effect:

• X Center

• Y Center

• Radius

• Amount

• Wavelength

• Progress

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.14 pxSparkle

 The pxSparkle plugin generates a sparkle pattern as a ray emitting from a point. The
plugin editor provides options to control the density of the rays, the x,y position from
where they are emitted, the brightness (Amount) of rays, as well as other parameters,
which will be covered specifically in context. Before delving into these parameters
however, it is important to understand the pxSparkle, like other PixelFX shaders
(pxGradient, pxNoise) generates its own pixels. As well, it has the ability to be applied
on top of an image and can blend with the image’s pixels. When the pxSparkle plugin
is applied to a container without an image, it creates sparkle results. However you can
also apply it on a container with an image. In this case, you need to decide whether the
sparkle pattern should blend on top of the image or whether it cuts the image. If the
Cut Image option is on, the host image is seen only in areas that are brighter than zero.
The brighter the sparkle, the more apparent the host image will be.

The pxSparkle plugin can be used as a flare to achieve its effect in a radius (the size of
the hot spot). The inner Amount (the brightness of the hot spot) and the radius will crop
or fade the sparkle radially. You can also so the Speed parameter to set the sparkle in
motion.

• Transform as texture: This option forces the rendering of the sparkle to ignore the
viewmatics - the sparkle will always be facing the eye-point. This option is handy
when applying the sparkle on top of a hierarchy.

• Aspect: This option allows you to set the proportion of the sparkle independently
of the texture transformation. Often you stretch textures to get what you want.
However when applying the pxSparkle plugin to a distorted texture, you may
want to maintain its roundness. Therefore you can use the Aspect parameter to
compensate for the texture distortion.

• Angle: This lets you rotate the sparkle without manipulating the texture coordinates.
This option is handy when you have a static image on top of which you want to
apply a rotating sparkle.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX
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13.5.15 pxTurbDissolve and pxTurbWipe

 Both pxTurbDissolve and pxTurbWipe utilize the native multi-texturing support of
Viz Artist.

pxTurbWipe includes the parameters of Angle and Softness.

To apply TubDissolve and/or TurbWipe

1. Insert an image into the scene tree.

2. Go to the image’s texture editor and ensure that the texture Unit is set to 1 and
the Inheritable option is active.

This will be your Image A in an A-B transition paradigm.

3. Place a child image underneath the first one.

This will be Image B.

4. In Image B’s texture editor, set the Unit to 2 and ensure that the Inheritable option
is inactive.

5. Apply the Dissolve plugin to the Image A (the parent image).

6. In the plugin’s editor, first adjust the Transition, followed by the other parameters,
as per your liking.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

See Also

• pxGradient

13.5.16 pxTurbulence

 pxTurbulence creates a distortion effect using a Perlin turbulence function. Supports
pxColorWorks and pxStack plugins. Adjust the wavelength, amplitude and speed to
achieve the desired effect.

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.17 pxTwirl

 pxTwirl creates a distortion effect that twists an image around a central point.
Supports pxColorWorks plugins and pxStack plugins.

Adjust the following parameters as required to achieve the desired effect:

• X Center

• Y Center

• Radius

• Amount

• Edge Softness



Viz Artist User’s Guide

Page 856 Copyright © 2014 Vizrt

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.5.18 pxWaves

 pxWaves creates a distortion effect that makes an image look wavy. Supports
pxColorWorks plugins and pxStack.

Adjust the following parameters as required to achieve the desired effect:

• Type: Sine, Noise, Triangle, Square

• Angle

• Amount

• Wavelength

• Progress

• Seed

Note: This plugin is located in: Built-ins -> Shader -> PixelFX

13.6 PixelFXLenseFlare
The Lense Flare plugins, which are part of the PixelFX plugins set, simulate the effect of
streaks and spots of light, caused in real cameras when light enters and bounces inside
a camera lense. This plugin set contains geometries that simulate different shapes,
which can be used for lens flare or simple flare effects.

The Flare draws itself as a combination of geometry shader and pixel shader. When a
Flare Container is created (1) a non-editable pixel shader (2) is automatically added to
the created Flair Container.

The non editable shaders are needed to do more (detailed, on a per pixel basis)
graphical effects on the GPU (manipulating colors, textures, lighting, etc.), which can
not be done with Geometries only.

These plugins are located at: Built-ins -> Shader -> PixelFXLenseFlare

See Also

• PixelFX Plugins in Geometry Plugins

13.7 RealFX
The RealFX plugin set enables you to create particle effects in Viz Artist.

See Also

• RealFX Plugins in Geometry Plugins

• pxColorWorks in Container Plugins
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Particle systems are a computer graphics technique to simulate certain physics-based
effects, which are otherwise very hard to reproduce with conventional rendering
techniques. Examples of such effects which are commonly replicated using particle
systems include fire, explosions, smoke, weather effects, sparks, falling leaves, dust,
meteor tails, or abstract visual effects like glowing trails, magic spells, etc.

The particle effects in Viz run in real-time, meaning that there are a few inherent
constraints that must be taken into account when considering best practices for
employing this plugin set. For example, there is a trade-off between the number of
particles and performance optimization; more generally there needs to be a considered
balance between performance and visual quality.

RFxSmoke is the baseline plugin within the RealFX plugin set. The remaining plugins
in this set are applied on top of RFxSmoke in any given container. RFxSmoke includes
built-in functionality and the ability to host the additional functionality contained in the
other plugins in this set. Part of the built-in functionality, e.g. turbulence, is kept for
compatibility with previous version of Viz Artist.

There are three categories of additional plugins:

• Birth plugins: refer to where the particles are spawned

• Motion control plugins: govern the position, direction, velocity, size and color of
each particle

• Texture control plugins: affect the texture mapping and the “look” of each
particle by using pixel shader technology

RealFX Architecture

This section contains information on the following topics:

• RFx2DSphere

• RFxClouds

• RFxFlame
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13.7.1 RFx2DSphere

 RFx2DSphere creates a 2D sphere-like look on each particle. The sphere is affected
by light sources.

Adjust the following parameters as required to achieve the desired effect:

• Color Mode (Material, Color, Color-Material)

• Radius

• Blend

Note: This plugin is located in: Built-ins -> Shader -> RealFX

See Also

• RFxSmoke

13.7.2 RFxClouds

 Located under the Shader tab, RFxClouds create a dynamic plume-like texture on
each particle, and changes randomly for each particle over time It can be used on
clouds and smoke.

Adjust the following parameters as required to achieve the desired effect:

• Brightness

• Turb Scale X

• Turb Scale Y

• Turb Speed

Note: This plugin is located in: Built-ins -> Shader -> RealFX

See Also

• RFxSmoke

13.7.3 RFxFlame

 RFxClouds create a dynamic flame-like texture on each particle, and changes
randomly for each particle over time.

Note: This plugin is located in: Built-ins -> Shader -> RealFX

See Also

• RFxSmoke

13.8 RTT Advanced Materials
The following RTT shader plugins are housed in the RTTAdvancedMaterials folder:
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• Anisotropic Light Shader

• Brushed Metal Shader

• Bump Shader

• Bump Optimized Shader

• Fabric Shader

• Glass Shader

• Gooch Shader

• Lacquered Surfaces Shader

• Metal Reflection Shader

• Microstructure Shader

• Monitor Shader

• Velvet Shader

RTT Advanced Materials plugins allow you to create a number of high-quality materials
using state-of-the art shader technology. Using the plugins is very easy. Simply drag
the shader plugin of your choice onto selected geometry, assign a Viz material and
set up the additional parameters as displayed by the shader in its own editor. Some
plugins remain inactive until you have applied all necessary textures, depending on the
shader plugin. This may include a basic Viz texture on your container and/or additional
textures to be dropped in the plugin interface. You can modify all parameters of the
applied Viz material on your object, such as Ambient Color, Diffuse, Specular and
Emission, Shininess and Alpha. All these parameters will also affect the shader.

All RTT Advanced Materials plugins (except the Bump Optimized Shader) allow
manipulating the texture mapping of each texture map individually. This means you
can use a different position, rotation and scaling for each texture. As for the mapping
of additional textures inside the Shader, the same mapping method as being assigned
to the texture on your Viz container is used. It is also possible to change the alignment
of the environment textures to achieve the correct reflections on the respective object
surface.

If you do not want to use individual texture transformations, you may switch the option
off. Each additional texture (except the environment texture) offers the button “Enable
Individual Transform”. With the button turned “off “, the texture mapping coordinates
of the Viz base texture will be used.

All Shaders support up to 5 light sources from Viz. By enabling more than 5 lights, the
last activated light will be disabled. The supported Viz light types are infinite and local
lights; also the light color of these lights is supported.

If you import the Viz archive “RTT_ShaderPresets_V1” you will obtain about 60 sample
scenes which are meant to give you an idea how to work with the Shaders. These
presets are free to use, but in general, they are thought as a guideline for how to work
with textures and the Shaders. Correctly working with the textures will dramatically
improve the look of your Shader. The Shaders use color maps, bump maps (in the
normal map format), specular maps and cubic environment maps in HDR and LDR
formats.

Creating color maps is straightforward. They are regular RGB textures that you can
use either on the Viz container or inside the Shader, depending on the Shader you are
using.

Creating specular maps is also straightforward. They are grayscale textures where you
define, through a gradient from white to black, where light is reflected or not.
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Creating normal maps for the bump inside your Shader is not complicated
either; just go to NVIDIA’s corporate web page and download the relevant
NVIDIA Photoshop plugins, or use this link: http://developer.nvidia.com/object/
photoshop_dds_plugins.html. After installing the filter in question, you have a new
section in the filter category in Adobe Photoshop. By applying this filter, you will be
shown a window with various settings (Please read the corresponding NVIDIA User’s
Guide); yet there is not much work involved. Just have a look at the settings in the
NVIDIA Photoshop Plugin Image below and start exploring them on your own.

Creating cubic environment maps (HDR or LDR) is a well known technique for 3D
experts. This User’s Guide will not explain the creation of these environment maps
here in detail as there are numerous of tutorials on the web for this texture creation
procedure.

If you do not have a license for the RTT Advanced Materials plugins, you may
contact either one of your local Vizrt Support people or you can send an e-mail to
license@vizrt.com to obtain either a time-limited demo license or a full license. Without
a license, you will be able to load the preset scenes but you cannot modify them; only a
few parameters will be adjustable.

This section also contains information on the following topics:

• Cube Map

• HDR

• Normal Map

• Fresnel

• RTT

Cube Map

Cube map textures are typically used for approximated environmental reflection and
refraction. They consist of a set of six two-dimensional textures that form a textured
cube centered at the origin. Unlike 2D sphere maps, they grant higher details for the
whole environment. The RTT Advanced Materials plugins accept only cube maps as
reflection textures and require them to be stored in a vertical cross layout. Cube maps
can soon be created easily by using Vizrt’s “Dynamic Texture” plugin. To achieve the
best results with the Shaders we strongly

recommend to create your cube maps in HDR format. Please note that the vertical
cross cubemap size is required to be one of the following: 192 by 256, 384 by 512, 768
by 1024, 1536 by 2048 or 3072 by 4096 pixels, where a higher resolution indicates
higher image quality. The general rule of thumb is that the contained six images need
to have power-of-2 resolution.

HDR

HDR (High Dynamic Range) images can store a much wider range of brightness values
than common (i.e. low dynamic range) images. Therefore, it is possible to create more
brilliant highlights and reflections when using HDR images. HDR images can be shot
by using special spherical cameras, or created with the aid of HDR image processing
tools. Furthermore ready-to-use HDR cube maps are available as DVD collections. All
plugins with environmental reflections support HDR cube maps. ”.hdr” format images
are supported.

Normal Map
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Normal maps are textures used to calculate bump mapping. They encode surface
details – the normals of a surface – as RGB color values and therefore appear usually
in some shades of blue. They can be created easily from (grayscale) height maps with
plugins for Adobe Photoshop or Gimp.

Fresnel

The Fresnel effect describes how much light is reflected on a surface and how much
light is refracted through this surface. At shallow angles the reflection is strong while
there is almost no refraction.

RTT

All RTT Advanced Materials are developed by Realtime Technology AG. Realtime
Technology AG is a worldwide leading supplier of 3D real-time visualization
technologies and services for industrial applications in the automotive, aircraft and
consumer goods industries.

13.8.1 Anisotropic Light Shader

 An anisotropic highlight is calculated to simulate advanced surfaces. The highlight
can be controlled in using two parameters. In addition, a color texture can be used to
add more details. This shader is particularly useful when no surrounding reflection is
required.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices
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Properties

• Roughness X and Y: Controls the width and height of the anisotropic highlight.

• Color Map 2: Offers the possibility to assign a second diffuse color texture that is
blended with the first color texture (according to the chosen technique)

• Enable Individualized Transform: Activates the option to define an independent
transformation (Position, Rotation and Scale values next to the Image Parameter) for
Normal- and/or Bumpmaps instead of using the regular texture coordinates.

• Technique: Displays a list of available techniques.

• Standard: Is a technique that creates an anisotropic highlight (to be used with
geometry that has no texture coordinates and normals).

• Standard_Texture: Is a technique that mixes a diffuse texture color into the
material color.

• Standard_MultiTexture_Add: Is a technique to additively blend Color Map 2 with
the Viz texture.

• Standard_MultiTexture_Blend: Is a technique to blend Color Map 2 with the Viz
texture according to their alpha values.

• Standard_MultiTexture_Subtract: Is a technique to subtractively blend Color Map
2 with the Viz texture.

• Standard_MultiTexture_Modulate: Is a technique to blend Color Map 2 by
multiplying it by the Viz texture.

• Binormal: Is a technique to create an anisotropic highlight using binormals and
tangents of the geometry (to be used with geometry having texture coordinates and
normals).

• Binormal_Texture: Is a technique to mix a diffuse texture color into the material
color.

• Binormal_MultiTexture_Add: Is a technique additively blend Color Map 2 with the
Viz texture.

• Binormal_MultiTexture_Blend: Is a technique to blend Color Map 2 with the Viz
texture according to their alpha values.

• Binormal_MultiTexture_Subtract: Is a technique to subtractively blend Color Map
2 with the Viz texture.

• Binormal_MultiTexture_Modulate: Is a technique to blend Color Map 2 by
multiplying it by the Viz texture.

Best Practices
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Apart from the parameters in the plugin container, it is necessary to assign a Viz
material. When applying a texture technique it is compulsory to assign a Viz texture
as a color/basic texture. In case of multi texturing an additional second texture must
be assigned in the corresponding Shader rollout. Therefore, do not forget to adjust Viz
material parameters in addition, such as ambient, diffuse, specular color and shininess.

13.8.2 Brushed Metal Shader

 By using bump mapping and reflections from a cube map, the impression of more
sophisticated metal surfaces, such as brushed metals, is created. The surface is lit by
an anisotropic highlight. To describe the surface structure, a normal map is used.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices

Properties

• Roughness X and Y: Controls width and height of the anisotropic highlight.

• Bump Height: Affects the height of the created bumps and wrinkles on the surface.
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• Environment Reflectivity: Manipulates the influence of the reflection color from
the environment map on the resulting color.

• Reflection Multiplier / Exposure: Affects the exposure of the environment map.
This is especially helpful when working with HDR images.

• Gamma of EnvMaps: Controls the gamma correction of the environment map. This
is once again particularly helpful when working with HDR images.

• Bump Map / Normal Map: Is the texture that defines the surface structure with
encoded normals.

• Enable Individualized Transform: Activates the option to define an independent
transformation (Position, Rotation and Scale values next to the Image Parameter) for
Normal- and/or Bumpmaps instead of using the regular texture coordinates.

• Environment Map: Is a vertical cross cube map that describes the environmental
surrounding used to calculate reflections.

• Technique: Displays a list of available techniques.

• Standard Bump: Is a technique that should be used with geometry that has no
standard UV texture coordinates and normals.

• Binormal Bump: Is a technique that should be used with geometry having texture
coordinates and normals.

Best Practices

The Brushed Metal Shader should be preferred to Anisotropic Light Shader whenever
you want to create highly detailed metal surfaces. However, the shader is more
complex and requires more rendering time. Therefore, it may be unsuitable, depending
on the complexity of the other parts of the scene and also on the graphics hardware
available.

Apart from the parameters in the plugin container, it is necessary to assign a Viz
texture as a color/basic texture and a Viz material. Do not forget to adjust Viz material
parameters in addition, such as ambient, diffuse, specular color and shininess, to
achieve the desired look for your surface.

13.8.3 Bump Shader

 By using bump mapping, the impression of detailed surface structures is created
while the structures are defined by normal maps. In addition to a highlight, the
reflection of the surrounding is calculated (from a cube map). It is possible to add
blurriness to the reflection to create rougher surfaces. A parameter is available to
modulate whether the reflections follow the surface structures or behave like a clear
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coat layer on the top of it. The specular map describes where on the surface highlight
and reflections are displayed and where the surface shows only diffuse lighting.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices

Properties

• Bump Height: Manipulates the height of the created bump on the surface.

• Modulate Bumpy Reflection: Controls whether the environment reflection is
smooth or influenced by surface details. To calculate reflections on a smooth clear
coat layer, value 0.0 is set by default. On the other hand, value 1.0 is used to
incorporate surface details.
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• Environment Reflectivity: Manipulates the influence of the reflection color from
the environment map on the resulting color.

• Reflection Multiplier/Exposure: Affects the exposure of the environment map.
This is especially helpful when working with HDR images.

• Gamma of EnvMaps: Controls the gamma correction of the environment map. This
is once again particularly helpful when working with HDR images.

• Blur Reflection: States how much the environment reflection is blurred to create
the impression of a rougher surface.

• Fresnel Minimum, Fresnel Scale and Fresnel Exponent: Affect the Fresnel
effect upon the reflection.

• Bump Map/Normal Map: Is the texture that defines the surface structure/bump
with encoded normals.

• Specular Map: Is the texture that defines where the surface is lit by specular
highlight and reflection.

• Environment Map: Is a cube map that describes the environmental surrounding
used to calculate reflections.

• Technique: Displays a list of available techniques.

• Standard Bump: Is a technique to be used with geometry that has no standard UV
texture coordinates and normals.

• Binormal Bump: Is a technique to be used with geometry having texture
coordinates and normals.

Best Practices

If you use this shader in complex scenes, you should favor the Bump Optimized
Shader. The difference between the Bump Shader and the Bump Optimized Shader
is that you can modify the texture coordinates inside the Bump Shader, which,
however, needs more rendering performance. If you do not have to adjust the
texture coordinates individually, or animate them separately, you should use the
BumpOptimizedShader to save rendering performance.

Apart from the parameters in the plugin container, it is necessary to assign a Viz
texture as a color texture and a Viz material.

13.8.4 Bump Optimized Shader

 By using bump mapping, the impression of detailed surface structures is created
while the structures are defined by normal maps. In addition to a highlight, the
reflection of the surrounding is calculated (from a cube map). It is possible to add
blurriness to the reflection to create rougher surfaces. A parameter is available to
modulate whether the reflections follow the surface structures or behave like a clear
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coat layer on the top of it. The specular map describes where on the surface highlight
and reflections are displayed and where the surface shows only diffuse lighting.

This plugin offers the same functionality as the Bump Shader plugin, but as an
optimization, it does not allow separate texture mapping for bump and specular maps.
It consequently requires less rendering time and should be used whenever additional
parameters are not required, i.e. you have matching sets of textures that can be used
with the shader or you do not need to animate the textures. This shader should be
preferred especially in complex scenes.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties
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Properties

• Bump Height: Manipulates the height of the created bump on the surface.

• Modulate Bumpy Reflection: Controls whether the environment reflection is
smooth or influenced by surface details. To calculate reflections on a smooth clear
coat layer, value 0.0 is set by default. On the other hand, value 1.0 is used to
incorporate surface details.

• Environment Reflectivity: Manipulates the influence of the reflection color from
the environment map on the resulting color.

• Reflection Multiplier/Exposure: Affects the exposure of the environment map.
This is especially helpful when working with HDR images.

• Gamma of EnvMaps: Controls the gamma correction of the environment map. This
is once again particularly helpful when working with HDR images.

• Blur Reflection: States how much the environment reflection is blurred to create
the impression of a rougher surface.

• Fresnel Minimum, Fresnel Scale and Fresnel Exponent: Affect the Fresnel
effect upon the reflection.

• Bump Map/Normal Map: Is the texture that defines the surface structure/bump
with encoded normals.

• Specular Map: Is the texture that defines where the surface is lit by specular
highlight and reflection.

• Environment Map: Is a cube map that describes the environmental surrounding
used to calculate reflections.

• Technique: Displays a list of available techniques.

• Standard Bump: Is a technique to be used with geometry that has no standard UV
texture coordinates and normals.

• Binormal Bump: Is a technique to be used with geometry having texture
coordinates and normals.



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 869

13.8.5 Fabric Shader

 On a dull surface, the impression of detailed surface structure is created by using
bump mapping. The structure is defined by a normal map. A highlight is placed along
the edges of the object to increase the impression of fabric surfaces.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices

Properties

• Velvety (Limb) Parameter: Controls the strength of the velvety effect at grazing
angles of view.

• Bump Height: Manipulates the height of the created bumps and wrinkles on the
surface.

• Bump Map/Normal Map: Is the texture that defines the surface structure with
encoded normals.

• Technique: Displays a list of available techniques.

• Standard_Bump: Is a technique has to be used with geometry that has no
standard UV texture coordinates and normals.

• Binormal_Bump: Is a technique should be used with geometry having texture
coordinates and normals.

Best Practices
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13.8.6 Glass Shader

 Apart from the parameters in the plugin container, it is necessary to assign a Viz
texture as a color/basic texture and a Viz material. Do not forget to adjust Viz material
parameters in addition, such as ambient, diffuse, specular color and shininess, to
achieve the desired look for your surface.

Both refraction and reflection are taken from the surrounding (from a cube map) and
are blended to create the dielectric effect of glass. In addition, lighting by a highlight
and a color texture are used to describe the material in detail. The opacity of the object
can be controlled to modulate between the solidly lit surface and the transparent
impression of glass.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices

Properties

• Refraction Index: Controls the refraction index of the material, and accordingly
the strength of the refraction.

• Fresnel Minimum, Fresnel Scale and Fresnel Exponent: Affects the Fresnel
effect upon the reflection.

• Environment Reflectivity: Manipulates the influence of the reflection color from
the environment map on the resulting color.

• Bump Height: Manipulates the height of the created bumps on the surface.
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• Reflection Multiplier/Exposure: Affects the exposure of the environment map.

• Gamma of EnvMaps: Controls the gamma correction of the environment map. This
is particularly helpful when working with HDR images.

• Blur Reflection: States to which extent the environment reflection and refraction
are blurred to create the impression of a rougher surface.

• Opacity: Influences the mixing of the solid material color and the dielectric glass
effect (reflection and refraction).

• Bump Map/Normal Map: Is the texture that defines the surface structure with
encoded normals.

• Environment Map: Is a cube map that describes the environmental surrounding
used to calculate reflections and refractions.

• Technique: Displays a list of available techniques.

• Glass: Is a technique to be used for plain glass.

• Glass_Texture: Is a technique to mix a diffuse texture color into the material color.

• Glass_BumpStandard: Is a technique to create bump mapping with the given
normal map on the surface of the geometry that has no standard UV texture
coordinates and normals.

• Glass_BumpStandard_Texture: Is a technique to use a diffuse color texture and
bump mapping on the surface of the geometry that has no texture coordinates and
normals.

• Glass_BumpBinormal: Is a technique to create bump mapping for geometry with
texture coordinates and normals.

• Glass_BumpBinormal_Texture: Is a technique to use a diffuse color texture and
bump mapping on the surface of geometry with texture coordinates and normals.

Best Practices

Apart from the parameters in the plugin container, it is necessary to assign a Viz
material and a texture as a color/basic texture. Do not forget to adjust Viz material
parameters in addition, such as ambient, diffuse, specular color and shininess, to
achieve the desired look for your surface.

13.8.7 Gooch Shader

 Gooch shading is used to calculate the lighting of the surface. Accordingly, a warm
color is displayed in lit areas while a cold color is used in unlit areas. A highlight is
further added. Besides, a color texture may be used to add more details. This shader is
particularly useful when no surrounding reflection is required.
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Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices

Properties

• Cold Color: Assigns the color used for unlit surfaces.

• Warm Color: Assigns the color used for lit surfaces.

• Back Splash: Controls a factor to increase the perception of curvature on grazing
angles. The resulting color is weighted according to the back splash factor.

• Texture Alpha: Defines to which amount the diffuse color texture is blended into
the resulting color.

• Highlight Alpha: Defines to which extent the calculated highlight is blended into
the resulting color.

• Color Map 2: Offers the possibility to assign a second diffuse color texture that is
blended with the first color texture (according to the chosen technique).

• Technique: Displays a list of available techniques.

• GoochShading: Is a technique to use Gooch shading.

• GoochShading_Texture: Is a technique to mix a diffuse texture color into the
material color.

• GoochShading_MultiTexture_Add: Is a technique to additively blend Color Map 2
with the Viz texture.

• GoochShading_MultiTexture_Blend: Is a technique to blend Color Map 2 with the
Viz texture according to their alpha values.

• GoochShading_MultiTexture_Subtract: Is a technique to subtractively blend
Color Map 2 with the Viz texture.

• GoochShading_MultiTexture_Modulate: Is a technique to blend Color Map 2 by
multiplying it by the Viz texture.

Best Practices
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Apart from the parameters in the plugin container, it is necessary to assign a Viz
material. Therefore, do not forget to adjust Viz material parameters in addition, such as
ambient, diffuse, specular color and shininess. When applying a texture technique it is
compulsory to assign an Viz texture as a color/basic texture. In case of multi texturing
an additional, second texture must be assigned in the corresponding Shader rollout.

13.8.8 Lacquered Surfaces Shader

 The RTT Lacquered Surface shader simulates smooth lacquered surfaces lit by a
highlight. On the clear coat layer, the surrounding is reflected (from a cube map). The
reflection blurriness can be controlled to create the appearance of a rougher surface.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices

Properties

• Environment Reflectivity: Manipulates the influence of the reflection color from
the environment map on the resulting color.
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• Reflection Multiplier/Exposure: Affects the exposure of the environment map.
This is especially helpful when working with HDR images.

• Gamma of EnvMaps: Controls the gamma correction of the environment map. This
is once again particularly helpful when working with HDR images.

• Blur Reflection: States how much the environment reflection is blurred to create
the impression of a rougher surface.

• Fresnel Minimum, Fresnel Scale and Fresnel Exponent: Affects the Fresnel
effect upon the reflection.

• Environment Map: Is a cube map that describes the environmental surrounding
used to calculate reflections.

• Technique: Displays a list of available techniques.

• PixelShading: Is a technique to be used for finer details on the surface.

• VertexShading: Is a technique to be used for objects in the distance or for highly
tessellated objects.

Best Practices

Apart from the parameters in the plugin container, it is necessary to assign a Viz
material and a texture as a color/basic texture. Do not forget to adjust Viz material
parameters in addition, such as ambient, diffuse, specular color and shininess, to
achieve the desired look for your surface.

13.8.9 Metal Reflection Shader

 The object is lit by a highlight and by the reflection of the surrounding (from a cube
map). Both highlight and reflection take into account the material color of the object to
generate a realistic metal effect.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices

Properties
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• Environment Reflectivity: Manipulates the influence of the reflection color from
the environment map on the resulting color.

• Reflection Multiplier/Exposure: Affects the exposure of the environment map.
This is especially helpful when working with HDR images.

• Gamma of EnvMaps: Controls the gamma correction of the environment map. This
is once again particularly helpful when working with HDR images.

• Environment Map: Is a cube map that describes the environmental surrounding
used to calculate reflections.

Best Practices

Apart from the parameters in the plugin container, it is necessary to assign a Viz
material and a texture as a color/basic texture. Do not forget to adjust Viz material
parameters in addition, such as ambient, diffuse, specular color and shininess, to
achieve the desired look for your surface. To achieve a photorealistic, metallic look, it is
recommended to assign any color but white as a specular color.

13.8.10 Microstructure Shader

 A detailed surface structure is simulated by bump mapping and lit with the aid of a
highlight. Additionally, a clear coat layer reflects the surrounding (from a cube map). A
normal map is used to define the surface structure.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices

Properties

• Environment Reflectivity: Manipulates the influence of the reflection color from
the environment map on the resulting color.

• Reflection Multiplier/Exposure: Affects the exposure of the environment map.
This is especially helpful when working with HDR images.

• Gamma of EnvMaps: Controls the gamma correction of the environment map. This
is once again particularly helpful when working with HDR images.
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• Bump Map / Normal Map: Is the texture that defines the surface structure with
encoded normals.

• Environment Map: Is a cube map that describes the environmental surrounding
used to calculate reflections.

• Technique: Displays a list of available techniques.

• Standard_Bump: Is a technique to be used with geometry that has no standard UV
texture coordinates and normals.

• Binormal_Bump: Is a technique to be used with geometry having texture
coordinates and normals.

Best Practices

Apart from the parameters in the plugin container, it is necessary to assign a Viz
material and a texture as a color/basic texture. Do not forget to adjust also the Viz
material parameters like ambient, diffuse, specular color and shininess, to achieve the
desired look for your surface

13.8.11 Monitor Shader

 The RTT Monitor shader simulates the appearance of a flat screen display where
saturation decreases at grazing angles of view. Therefore, the displayed color
texture blends into the diffuse color of the material. In addition, a reflection from the
surrounding (from a cube map) is added, increasing in strength towards more acute
angles of view.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices

Properties

• Saturation/Reflection/Color Gradient: Defines to which amount the material’s
diffuse color is mixed into the resulting color at grazing angles.

• Environment Reflectivity: Manipulates the influence of the reflection color from
the environment map on the resulting color.

• Reflection Multiplier/Exposure: Affects the exposure of the environment map.
This is especially helpful when working with HDR images.

• Gamma of EnvMaps: Controls the gamma correction of the environment map. This
is once again particularly helpful when working with HDR images.

• Environment Map: is a cube map that describes the environmental surrounding
used to calculate reflections.

• Technique: Displays a list of available techniques.



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 877

• Saturation_and_Reflection_Gradient: Is a technique to influence saturation and
reflection appearance alike.

• Reflection_Gradient: Is a technique to influence only the reflection appearance.

Best Practices

Apart from the parameters in the plugin container, it is necessary to assign a Viz
material and a texture as a color/basic texture. For this shader, a background image
should be selected as the basic texture to achieve a highly realistic monitor effect.
Do not forget to adjust Viz material parameters in addition, such as ambient, diffuse,
specular color and shininess, to achieve the desired look for your surface.

13.8.12 Velvet Shader

 A highlight along the edges of the surface is created to generate velvety impression.
The highlight is controlled in using two parameters that describe the transition towards
diffuse lighting. Furthermore, a surface color can be added to brighten the barely
lit areas. A color texture may be used to add more surface details. This shader is
particularly useful when no surrounding reflection is required.

Note: All RTT shaders can be uninstalled from the Viz program menu.

Note: This plugin is located in: Built-ins -> Shader -> RTTAdvancedMaterials

This section contains information on the following topics:

• Properties

• Best Practices

Properties

• Surface-Color: Assigns the color of the surface (underneath the velvety hairs).

• Specular-Color: Assigns the specular color of the material.

• Edge Rolloff: Defines how much of the surface color is to be seen in barely lit
areas.

• Specular low-cut and specular high-cut: Defines the sharpness of the velvety
highlight.

• Color Map 2: Offers the possibility to assign a second diffuse color texture that is
blended with the first color texture.

• Technique: Displays a list of available techniques.

• Velvet: Is a technique to use velvety shading,

• Velvet_Texture: Is a technique to mix a diffuse texture color into the material color.
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• Velvet_MultiTexture_Add: Is a technique to additively blend Color Map 2 with the
Viz texture.

• Velvet_MultiTexture_Blend: Is a technique to blend Color Map 2 with the Viz
texture according to their alpha values.

• Velvet_MultiTexture_Subtract: Is a technique to subtractively blend Color Map 2
with the Viz texture.

• Velvet_MultiTexture_Modulate: Is a technique to blend Color Map 2 by
multiplying it by the Viz texture.

Best Practices

Apart from the parameters in the plugin container, it is necessary to assign a Viz
material. Therefore, do not forget to adjust Viz material parameters in addition, such as
ambient, diffuse, specular color and shininess. When applying a texture technique it is
compulsory to assign an Viz texture as a color/basic texture. In case of multi texturing
an additional, second texture must be assigned in the corresponding Shader rollout.

13.9 Texture
The following shader plugins are housed in the Texture folder:

• Drop Shadow

• Emboss

• MultiTexture

13.9.1 Drop Shadow

 Drop Shadow is a shader plugin that generates 2D shadow of a texture.

Note: This plugin is located in: Built-ins -> Shader -> Texture

This section contains information on the following topics:

• Properties

Properties

• Distance: Sets the distance of the shadow.

• Direction: Sets the direction of the shadow in degrees.

• Threshold: Sets the shadow threshold.

• Soft Shadow: Enables the Soft Distance parameter for applying a soft shadow.

• Soft Distance: Sets the distance of the soft shadow.

• Color: Sets the color of the shadow.
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13.9.2 Emboss

 Emboss is a simple shader plugin that allows you to raise highlighted surfaces and
lower shadows of textures and images creating an embossed look.

Note: This plugin is located in: Built-ins -> Shader -> Texture

This section contains information on the following topics:

• Properties

Properties

• Direction: Sets the direction. Available options are: None, South-East, South-West,
North-East and North-West.

• Emboss: Sets the level in percentage.

13.9.3 MultiTexture

 The MultiTexture shader plugin blends (linear) two textures together.

Note: This plugin is located in: Built-ins -> Shader -> Texture

This section contains information on the following topics:

• To Create a Simple Blended Image Scene

• Blended Images Example

To Create a Simple Blended Image Scene

1. Create a new Container.

2. Add an image to the new Container.

3. In the Image Editor set the image to:

• Unit: Level one

• Inheritable

4. Create a Sub Container.

5. Add an image to the Sub Container.

6. In the Image Editor set the image to:
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• Unit: Level two

7. Add the MultiTexture plugin to the Sub Container.

8. Click on the MultiTexture plugin.

9. Adjust the image blend as required.

Blended Images Example
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14 Scene Plugins

Scene plugins are global functions that have influence on the whole Scene.They are
mainly used when external programs are interfaced with Viz Artist.

Scene plugins are housed in the following folders:

• Default

• Image

• Libero

• Lineup

• MultiTouchComp

• Script Plugins

• Texture

• Tools

Note: The default path for the Scene plugins is: <Viz Install Directory>\plugin
\<plugin name.vip>

See Also

• MultiTouchComp in Container Plugins

14.1 Default
The following scene plugins are housed in the Default folder:

• VCF

14.1.1 VCF

 The VCF scene plugin works in conjunction with the VCF Parameter plugin that
allows you to create a seamless interpolated transition from a virtual camera flight



Viz Artist User’s Guide

Page 882 Copyright © 2014 Vizrt

(VCF) to a real camera - and conversely. This is only a relevant plugin to set up if you
have purchased the virtual set expansion components.

You must have a real camera with data tracking enabled which is set in remote mode
in the camera editor. In case you have several tracked cameras, the virtual camera will
interpolate its position to the real camera that is selected on air.

Note: This plugin is located in: Built-ins -> Scene Plugins -> Default

This section contains information on the following topics:

• Properties

• To animate a virtual camera flight

Properties

• Tracking Object (POS): Defines the position or eye-point of the virtual camera
flight. Use the name of the container in which center the camera should be placed.

• Tracking Object (ROT): Defines the direction of the virtual camera flight. Use the
name of the container the camera will be looking at.

• Initialize (button): Places the camera in position and sets the direction.

To animate a virtual camera flight

1. Start by adding the VCF scene plugin under the Scene Settings Plugin tab.

2. Create a new group in your scene and add two new containers under it.

• These are to be the objects that will define the virtual camera flight. One will define
the position, the other the direction.

3. Name the containers according to the names you entered in the VCF scene plugin
(for example T_POS and T_ROT).

4. Click Initialize to finish.

5. Add the VCF Parameter plugin onto the container that holds the position object.

6. Animate your virtual camera flight using the two objects to define position and
direction.

• Do not switch the whole container invisible because the animation will not run.

• You may switch the objects to be invisible at any time.

• It is not possible to animate the roll of the camera.

See Also

• VCF Parameter
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14.2 Image
The following scene plugins are housed in the Image folder:

• Background Clip

14.2.1 Background Clip

 This plugin is designed to play back a sequence of still images (tga, tiff, etc.) in the
background of your scene rather than playing an AVI-file.

Since it plays the sequence from memory, the scene has a higher loading time and the
drawback is that it consumes system memory which can influence the system stability.
So keep track of how much memory each sequence needs so you don’t run out of
memory on the render engine. Scene plugins are added under the Scene Settings
Plugin tab.

Since all images are loaded into memory a large number of images or a large image
size would require large amounts of memory. Memory can be calculated as follows:

number of images * image width * image height * 3 (or 4 for alpha).

Note: This plugin is located in: Built-ins -> Scene Plugins -> Image

This section contains information on the following topics:

• Properties

• To animate a virtual camera flight

Properties

• Image: Allows you to enter the name of the image sequence or browse for it.
Select the first image you would like to use in your clip. Do not use clip names with
numbers (except the counter).

• Play Mode: Can be set to Once, Loop (over and over again) and Swing (equal to
loop but plays the clip reverse too).
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• Reverse: Switch from off to on if you want the clip to played from end to start.

• Play speed: Lets you alter the speed in percent.

• Advanced: Opens advanced parameters if set.

• Stand alone image: Needed when you want to play the same clip in different
speeds.

• First image: Select the number of the image which you want to start with.

• Nof images: It stands for “number of images”. Please type in here the number of
images you want play as a clip, otherwise all images will be played back.

• Crop: Crops the image in percent from the left, right, bottom and top side.

• Scale: Will scale all images to the closest power of 2. When not selected an
automatic textures coordinates will be applied. So the image will fit the texture.

• Keep under: It forces the image size. For example if you have selected 64, the
image will be trimmed to the size 64 x 64.

• Format: If the “image” format is selected, the file will be loaded in original
condition. Please select another format, if you want load a black and white image
(“Alpha”) or full color image (“RGB”, “RGBA”: with alpha value).

• Play, Stop and Reinitialize: Enables you to play, stop and reinitialize the clip.

To add a background image clip

1. Create a directory which is including pictures like “abc001.png”, “abc002.png” ...
"abc389.png".

• Please consider that the images will be played as a sequence of the filename
including the numbers.

• After you have created the images, load the first image of the sequence and the clip
is now visible in the Scene Editor.

2. Another possibility is to create a file with a "*.vln" extension. This file includes
the base path and also the names of the images to load. In this case the images
must not have a counter number in their filename. You can handle this file as an
ordinary text file.

3. Load the "vln - file" instead of loading an image file located in a directory.

Example:

BASE_PATH ‘C:/clip/images"
{
‘radar_200504110800.png’ 2005_04_11_10:00
‘radar_200504110815.png’ 2005_04_11_10:15
‘radar_200504110830.png’ 2005_04_11_10:30
‘radar_200504110845.png’ 2005_04_11_10:45
‘radar_200504110900.png’ 2005_04_11_11:00
‘radar_200504110915.png’ 2005_04_11_11:15
‘radar_200504110930.png’ 2005_04_11_11:30
‘radar_200504110945.png’ 2005_04_11_11:45
}

See Also

• Implementing Video

• Image Clip
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14.3 Libero
The following Scene Plugin is located in the Libero folder:

• EVSControl Plug-in

14.3.1 EVSControl Plug-in

 The EVSControl Plug-in allows an EVS video server to be controlled from the Viz
Engine (like a tape deck over RS422). This gives the ability to load and control playback
of EVS video server clips.

Note: This plugin is located in: Built-ins -> Scene Plugins -> Libero

This section contains information on the following topics:

• Properties

• Clip loaded successfully

• Clip loaded successfully

• Get the Current TimeCode

• Example Scenes

14.3.2 Properties

Various EVSControl plug-in settings can be modified in Viz Artist from the EVSControl
Plugin Editor.

EVSControl Plugin Editor

Note: Do not change OUT parameters manually or using a script.

• Debug: Toggle to enable more debug output on the console

• Serial Port (COMx): The serial port to be used for controlling the EVS.
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• Initialize: Click to initialize the Controller. Without initialization, the plugin does not
work.

• EVS Clip ID: The ID of the EVS clip to be loaded. The value must match the format
“PBCK/MM” where:

• P = Page number (1-9)

• B = Bank number (1-9)

• C = Clip number (1-9)

• K = Camera letter (A-F)

• MM = EVS Machine number (00, 01, ..), where 00 is the local EVS.

• Load Clip: Click to load the clip shown in the “EVS Clip ID” field

• Clip loaded: Shows when the Load Clip was clicked to confirm the clip was loaded.

• Clip IN: The IN time code of the successfully loaded clip (Format hh:mm:ss:ff)

• Clip OUT: The OUT time code of the successfully loaded clip (Format hh:mm:ss:ff)

• Clip Duration: The duration of the successfully loaded clip in milliseconds

• Stop: Stops play back

• Play: Starts play back

• TC Hour: The time code hour value for the “Goto TC” action

• TC Minute: The time code minute value for the “Goto TC” action

• TC Second: The time code second value for the “Goto TC” action

• TC Field: The time code frame value for the “Goto TC” action

• Goto TC: Click to go to the time code shown by the above fields

• Get TC: Get the current timecode

• Current TC: The value of the “Get TC” action

Clip loaded successfully

If a clip has been loaded successfully the EVSControl Plugin Editor will show:

• the ‘Clip loaded (out)’ flag is set.

• the ‘Clip IN (out)’ shows the Clip IN timecode.

• the ‘Clip OUT (out)’ shows the Clip OUT timecode.

• the ‘Clip Duration (out)’ shows the Clip length in milliseconds.

• EVS goes to IN timecode of clip.

Go to a Specific TimeCode

1. Enter the hour, minute, second, and frame in the fields:

• TC Hour

• TC Minute

• TC Second

• TC Field

2. Click on the Goto TC button

Get the Current TimeCode

1. Click on the Get TC button
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2. The current TimeCode is shown in the Current TC field.

14.3.3 Example Scenes

The plug-in comes with two example scenes:

• One shows a slider to scrub a clip

• The other shows scanning for clips and creating clip buttons for playback control

14.4 Lineup
The following scene plugins are housed in the Lineup folder:

• Tree Status

14.4.1 Tree Status

 The Tree Status plugin is needed by the Lineup template in Viz Content Pilot to
collect information about the scene hierarchy.

Consider that the Tree Props plugin is required for using the Tree Status plugin. Move
the Tree Props plugin onto the group which is holding the desired transformation to
control. Viz Content Pilot is then able to build its own internal tree properties list.

Note: This plugin is located in: Built-ins -> Scene Plugins -> Lineup

This section also contains information on the following topics:

• Properties

Properties

• Result: This field holds the entire information about the complete scene tree.

• S2VResult: S2V stands for scene to virtual. This parameter holds the information
X-, Y-, Z-translation and the Y-rotation given in the card file virtual set.

• Command: Any Viz command is allowed here to take place.

• Initialize (button): This button initializes the Result field.

• InitializeS2V (button): This button initializes the S2VResult field.

14.5 MultiTouchComp
The following Scene plugins are housed in the MultiTouchComp folder:

• MtSensor Plugin
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All the MultiTouchComp Container Plugins require the MtSensor Plugin to be available.
If a MultiTouchComp Container Plugin is added to a Scene it will automatically add the
MtSensor Plugin to the Scene if it is not there.

14.5.1 MtSensor Plugin

 The MtSensor Plugin manages global telestration and plugin settings.

The MtSensor Plugin is the scene Plugin that must be available for any Multi-Touch
feature to work. It is automatically added to the Scene if any of the Container or
Geometry Plugins that require it are inserted in the Scene. It can also be dragged from
the Server area under Built Ins -> SP -> MultiTouchComp, to the Plugin tab under Scene
Settings.

The MtSensor Plugin also provides a screen-wide telestration facility. It can be controller
through Plugin parameters and buttons that are available for scripting.

Note: This plugin is located in: Built-ins -> Scene Plugins -> MultiTouchComp

This section contains information on the following topics:

• MtSensor Configuration

• Events

MtSensor Configuration

• Active: Select On (enable) or Off (disable) telestration input from user

• Minimum Telestration Width: Minimum brush width to assign based on pressure
applied to sensor

• Maximum Telestration Width: Maximum brush width to assign based on pressure
applied to sensor

• Color: The color to assign for subsequent telestration drawing

• Id: To give additional context in the handler script, specify a string that will identify
any notifications dispatched by this Plugin. This is often included as an argument for
the event so a common script may handle events from a number of Plugins.

• Set Shared Memory: If ON enables shared memory to be updated for the Plugin
notifications.

• Shared Memory Prefix: This sets a ‘prefix name’ to be prepended to the shared
memory variables maintained by the Plugins notifications. For Plugins that maintain
multiple fields each field name has the prefix prepended to it followed by a dot
'.' so as to mimic member access to an object, i.e: if the prefix is ‘Obj’ the fields
‘field1’ and ‘field2’ would be identified with the strings ‘Obj.field1’ and ‘Obj.field2’.
The shared memory field ‘Obj’ is also maintained and is simply an integer that is
modified every time any of its ‘subfields’ is updated.

• Shared Memory Type: Either Global, Scene, or Distributed. This selects the shared
memory area to update.

• SetDataPool: Shows ‘you wish’ Plugin notifications to set a DataPool variable
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• DataPoolVariable: Shows the name of the DataPool variable one wishes to have
set.

• Init: Clear current telestration and make Telestration active

• Clear: Clear the contents of the attached telestration

See Also

• Events

Events

The MtSensor Plugin does not generate any events for the scripting engine. The scene-
wide telestration feature emits the same events that the MtTelestrator Plugin emits.

See Also

• MtSensor Configuration

14.6 Script Plugins
This is an empty folder for you to save your own script plugins into.

14.7 Texture
The following scene plugins are housed in the Texture folder:

• Graffiti

14.7.1 Graffiti

 The Graffiti scene plugin allows telestration on top of scenes in the screen space.
Telestration is done by drawing with a brush shape using a mouse or a 6DOF interface.
The plugin can also recognize some rendered shapes and replace the hand-drawn
elements with the recognized shapes (e.g. circle, ellipse, cross, arrow).

The graffiti scene plugin is not intended for use on video output. To use graffiti textures
on video output, use the GraffitiTex container plugin.

Note: This plugin is located in: Built-ins -> Scene Plugins -> Texture

This section contains information on the following topics:

• Properties

• To create a scene level graffiti effect

Properties

• Active: Enable/disable drawing.

• Pointer Source: The plugin supports input from the mouse, or from another plugin
via a dispatcher interface. This button selects whether the plugin will listen to the
mouse or the dispatcher for input.



Viz Artist User’s Guide

Page 890 Copyright © 2014 Vizrt

• Mask Container: This points to either a container or a group of containers. These
containers mask the area over which the brush is rendered.

• Alpha: Transparency of the brush.

• Key: Selects whether the brush is rendered in the key signal

• Brush Type: Color or eraser brush.

• Brush Image: Optional image that will determine the shape of the brush. If empty,
a round brush will be used.

• Brush Width: Width of the brush in pixels. Visible only if the color brush is selected.

• Eraser Brush Width: Width of the eraser in pixels. Visible only if the eraser brush
is selected.

• Brush Color: Color of the brush.

• Recognize Shapes: Shape recognition mode (on/off).

• Recognize Ellipse: Specifies whether shape recognition will try to recognize ellipse
shape.

• Recognize Circle: Specifies whether shape recognition will try to recognize circle
shape.

• Recognize Cross: Specifies whether shape recognition will try to recognize cross
shape.

• Shape Delay: Number of frames to wait from mouse up before trying to recognize
shapes.

• Draw Arrow: Specifies whether non-recognizable shapes will be converted to an
arrow.

• Arrow Length: Length of arrow head.

• Arrow Width: Width of arrow head.

• Circle Rad: Radius of the circle replacing a recognized circle. If zero, the radius of
the recognized circle will be used.

• Cross Width: Width of the cross replacing the recognized cross shape. If zero, the
width of the recognized cross shape will be used.

• Max. Undos: Max number of undo operations.

• Clear (button): Clears the canvas.

• Undo (button): Undo.

To create a scene level graffiti effect

• Add the plugin to the Plugin panel under Scene Settings, set the plugin Properties,
set Viz in On Air Mode and start drawing.

See Also

• Plugin

• GraffitiTex (container plugin)
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14.8 Tools
The following scene plugins are housed in the Tools folder:

• Level Of Detail (LOD) Manager

14.8.1 Level Of Detail (LOD) Manager

 The LOD Manager scene plugin works in conjunction with the Level Of Detail (LOD)
container plugin which is rendering objects with different details depending on the
camera range; however, an integration with the LOD Manager is not required as the
LOD plugin is capable of initializing the parameter values by itself. The LOD Manager
plugin is used to change the visual view of the complete scene during rendering
depending on the camera and scale settings.

Note: This plugin is located in: Built-ins -> Scene Plugins -> Tools

This section contains information on the following topics:

• Properties

Properties

• Reference Zoom: Sets the reference zoom that is used to correlate switching
ranges based on the actual camera zoom value.

• Range Scale: Sets the global range scale which is used to scale all LOD ranges on
all LOD plugins in the scene.

• Reference Width: Not used.

• Reference Height: Not used.

To use the LOD Manager plugin

1. Start by adding the LOD Manager scene plugin under the Scene Settings’ Plugin
tab.

2. Add a group container to your scene tree and add at least two new sub containers
of the group container.

3. Add a sphere geometry to the sub containers as it has many triangles.

4. Add a material to each sub container.

5. Open the Sphere editor for the all sub containers and set different Tesselation
values for each to change the number of triangles and therefore the level of detail
of an object.
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Note: All spheres should, for the sake of example, be placed in the same
position.

6. Add the Level Of Detail (LOD) plugin to the group container.

7. Open the LOD editor and change the Range parameter values provided by the
LOD plugin. For example set Range 0 to 500, Range 1 to 1000 and so on.

• These settings affects the instant of time when an object 1, object 2 will be
rendered, which you have placed in step 3.

• The high resolution object is rendered at first and if the camera to object distance is
increasing the next object will be rendered because now a low-resolution object has
near the same visual quality despite fewer triangles. Consider that the visual quality
depends on your settings and object graduation.

8. Finally change the LOD Manager parameters Reference Zoom and Range Scale to
adjust the scene view additionally.
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15 Texture Sources

Texture Sources are housed in the following folders:

• Default

15.1 Default
The following texture sources are located in the Default folder:

• Clip Channel

• Dynamic Scene

• Dynamic Texture

• Live

• Stream

• Viewport Tile

15.1.1 Clip Channel

 Clip Channel texture sources are useful to designers that want to control the Clip
Channels at the Container level, as a Texture.

Note: These Textures Sources are located in: Built-ins -> Texture Sources ->
Default

This section contains information on the following topics:

• To create a simple video clip scene

• To view the Clip Channel Properties

To create a simple video clip scene
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Container with a Clip Channel

1. Create a new scene.

2. Add a Group Container to the scene tree.

3. Add the Clip1 plugin to the container.

4. Add the Control Video plugin to the container.

5. Open the Scene Settings, select the Video tab and set Clip Channel 1 to
Texture.

6. Optional: From the Video tab, load a test clip and play it.

7. Save the scene.

To view the Clip Channel Properties

1. Right-click on the required Clip Channel texture source, in a Container or the
Texture Source list, to open a context menu.

2. Click on Show settings of [Clip]. The Video tab, in Scene Settings, opens to
show the Clip Channel settings.

or

1. Hold down Ctrl and click on the required Clip Channel texture source in the
Texture Source list. The Video tab, in Scene Settings, opens to show the Clip
Channel settings.

or

1. Click on the Clip Channel texture source in the Container.

2. In the Texture Editor click on the Clip Channel icon. The Video tab, in Scene
Settings, opens to show the Clip Channel settings.

See Also

• Implementing Video

15.1.2 Dynamic Scene

 The Dynamic Scene is a texture source that is able to render a different scene, local
scene or parts of a local scene into a texture and show the texture in the current scene
being rendered.

Showing a different scene as “a window” in your current scene can be used in a
virtual set scene where you would like to “open a window” (as a texture) and render a
different scene (e.g. a weather forecast).

You can also use it to show parts of a local scene if you want to animate the camera
and at the same time show static elements in the scene. The animating camera can be
a different camera (two) and be used to show dynamic images in camera one’s view.
This way you can show more then one camera at the same time.

For visual effects, the whole scene or parts of it can be grabbed into an image, and
have shaders applied to the whole scene or parts of it.
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To transition from one scene (A) to another (B) both scenes are rendered into dynamic
images and a third scene is used to hold both dynamic images to create a transition
between them.

Note: These Textures Sources are located in: Built-ins -> Texture Sources ->
Default

This section contains information on the following topics:

• Properties

Properties

• Scene: Placeholder for the rendered scene. If it is empty, the current scene will be
rendered.

• Format: Sets the format to be used for the dynamic image. If the format has alpha
key it must be used on the render scenes or it will appear as black.

• Width / Height: Sets the width and height of the image. The Video option will take
the current output size. When selecting Custom you may set any size; however, it is
always better (when possible) to use power of 2 images.

• Update Mode: Sets when the scene in the dynamic image will be rendered.

• Change: When anything changes in the scenes it will be rendered.

• Always: It will be render each frame regardless if there was any change.

• Command: When the render command will be sent the scene will be rendered.

• Grab: Renders the scene on command and can then be copied to another image.

• View Type: Sets the view port to Camera or Light. If Camera is selected and
Camera ID is set to zero (0), it will take the current camera. If Light is selected it will
use the light according to the Light ID.

• Draw Self: Creates an endless mirror effect.

• Crop: Enables different crop modes.

• Off: The entire view port will be rendered.

• Manual: Enables you to set the size and position of the rendered scenes.
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• Auto: The size and position of the rendered scene will be set by the bounding box
holding the dynamic scene (acts as a mask).

• Size / Position: Sets the size and position of the dynamic image.

• Resize Texture: Should the image be resized automatically to reflect the size of
the scene being rendered.

• Back/Play/Stop/Forward: Controls the playback of the scene.

See Also

• Texture Editor

15.1.3 Dynamic Texture

 Dynamic Texture is a feature that generates dynamic textures on-the-fly. It can be
used as an alternative to importing textures to save texture memory usage. Another
advantage of using a dynamic texture is that you will have a texture that is not
pixilated as you zoom in or out of it.

Note: These Textures Sources are located in: Built-ins -> Texture Sources ->
Default

See Also

• Texture Editor

• Dynamic Scene

• Image FX and Noise options for the Trigger tab.

• Pixel FX plugins (separate plugin installer)

15.1.4 Live

 Live texture sources are useful to designers that want to control the Live texture
source at the Container level, as a Texture.

Note: These Textures Sources are located in: Built-ins -> Texture Sources ->
Default

This section contains information on the following topics:

• To view the Live Channel Properties

To view the Live Channel Properties

1. Right-click on the required Live texture source, in a Container or the Texture
Source list, to open a context menu.

2. Click on Show settings of [Live]. The Video tab, in Scene Settings, opens to
show the Live texture source settings.

or

1. Hold down Ctrl and click on the required Live texture source in the Texture Source
list. The Video tab, in Scene Settings, opens to show the Live texture source
settings.
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or

1. Click on the Live texture source in the Container.

2. In the Texture Editor click on the Live texture source icon. The Video tab, in Scene
Settings, opens to show the Live texture source settings.

See Also

• Implementing Video

15.1.5 Stream

 Stream texture sources visualize a video being streamed into the engine.

Note: These Textures Sources are located in: Built-ins -> Texture Sources ->
Default

This section covers the following topics:

• To View the Video Stream Texture Source Properties

• Stream Properties

To View the Video Stream Texture Source Properties

1. Right-click on the required Stream texture source, in a Container or the Texture
Source list, to open a context menu.

2. Click on Show settings of [Stream]. The Video tab, in Scene Settings, opens to
show the Stream texture source settings.

or

1. Hold down Ctrl and click on the required Stream texture source in the Texture
Source list. The Video tab, in Scene Settings, opens to show the Stream texture
source settings.

or

1. Click on the Stream texture source in the Container.

2. In the Texture Editor click on the Stream texture source icon. The Video tab, in
Scene Settings, opens to show the Stream texture source settings.

Stream Properties

• Image: Shows the added Stream texture.

Tip: Only one Stream texture can be used.

• Unit: Texture units take a texture and map them to a piece of geometry.

• 1-4: If the graphics card supports it is possible to have up to 4 available texture
units which can be used in parallel to do multi-texturing.
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• Inheritable: Units can be inherited onto the textures of child containers. Multiple
inherit is possible, but be sure to use different texture units for each texture that
should be inherited to not overwrite a unit.

• Mapping: The mapping option adjusts the way texture mapping is done.

• Vertex: Means that the texture mapping is done using the object texture, or UV,
coordinates. These coordinates index a texture image, and are interpolated across
the object to determine, at each of the object pixels, a texture image value. In most
cases on 3D objects, this will give the best looking result. The built-in geometry
plugins in Viz Artist have defined their texture coordinates. Imported objects can
have texture coordinates if they have been generated by an external 3D modelling
program. If for example adding a picture to a cube, all sides will look the same, and
the whole image will be displayed on each side.

• Linear: Is a “straight forward” mapping where the image so to say is laid over the
object directly on the frontal plane. The object is then moved through the image and
every pixel on the object inherits the pixel it “touches” on the image. On 3D objects,
this will cause a repetition of the pixels on the surfaces in the Z axis. If for example
adding a picture to a cube, the front and back side will look good, but the remaining
sides will be a repetition of the pixels laying on the edge of the front and the back
side.

• Reflection: Maps the texture as if it where a reflection from a surrounding object.
The reflection simulates that the texture image is an all-embracing object that casts
its reflection on the object. The object acts in a way like a mirror.

• Spherical: Spherically texture projection onto a geometry. The mapping position
and rotation can be adjusted with the corresponding parameters.

• Cylindrical: Cylindrical texture projection onto a geometry.

• Mapping Position: Sets the texture projection origin for Spherical and Cylindrical
mapping.

• Mapping Rotation: Sets the texture projection rotation for Spherical and
Cylindrical mapping.

Note: Mapping position and rotation are only available for Spherical and
Cylindrical mapping types.

• Cube: Cube texture projection onto a geometry. This option needs a vertical cross
cubemap which specifies how each of the 6 side projections should look like.

Note: To use the Cube mapping method for texture it is not possible to use the
same texture on another object with a different mapping method than Cube.

• Quality: The quality parameters specify a trade between rendering speed and
texture quality.

• Pixel: Shows the texture “as it is” with no smoothing and anti aliasing. It takes little
resources to render, but it can often create a poor visualization. This can be visible
as “toothed” lines and transitions, especially when close to the texture. A motion of
either object or camera, especially in the Z axis, will create a “blurring motion” on
the texture, as the texture scales to fit the object.

• Linear: Performs a linear interpolation to smooth the texture when being magnified
or shrunk. The texture looks good, but some distortions can be visible when the
textured object is animated further away on the Z axis. As the object then gets
smaller and smaller, the shrinking and interpolation of the texture creates a lot of
“noise” on the texture. As a consequence, the linear quality is appropriate when the
objects that have the texture do not change their size much.
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• Mipmap: Performs a linear interpolation to smooth the texture. In addition, it
offers a solution to the problem that appears on the two other qualities when the
object is being moved away along the Z axis or shrunk. To avoid the “noise” that
we see when a texture constantly scales to try to fit onto a shrinking/magnifying,
the mipmap quality creates a set of pre-filtered images in a decreasing scale down
to almost on pixel. These are used as the object scales up and down and a more
static look of the texture is thereby achieved. Mipmap quality absorbs more memory
performance than the two other qualities.

Note: The following quality options are only available for the Mipmap quality.

• Blur: Makes the image blurry. The blur filter can be set to either Smooth, which
blurs the image smoothly, or Mosaic, which makes the blur look like tiles.

• Sharpen: This option is useful when the rendering window is scaled to half height
mode.

• Anisotropic Filter: The Anisotropic Filter can be set to either Off or 2-16x.
Anisotropic filtering is used, when textured objects need to be rendered in z-
direction, where textures usually get blurred.

• Environment: The environment parameters specify the way the texture RGBA
information is combined with the object RGBA information.

• Blend: Blends the RGBA parameters of texture and object.

• Decal: Uses only the RGBA information of the texture and disregards the RGBA of
the object.

• Modulate: Uses the RGBA information of the texture and enables in addition use of
lighting on the textured object.

• Add: Adds source unit 1 and source unit 2 together.

• Add Signed: Adds source unit 1 and source unit 2 then subtracts 0.5.

• Interpolate: Linear interpolation between source unit 1 and source unit 2.

• Blend Factor: Defines in interpolation mode how much of source unit 1 and unit 2
is used (0.0%: shows current unit, 100%: shows source unit).

• Source Unit: Sets the second source unit for interpolation mode (can be all other
units together or just a specific unit).

Note: Blend Factor and Source Unit environment options are only available for
the Interpolated environment.

• Wrap: Wraps the object by repeating or clamping (no repeat – the texture’s edge
color is used to fill the rest of the object) the texture onto the object’s surface. This
setting comes into operation if the texture mapping cannot fill the whole object (e.g.
the texture was scaled below 0.0).

• Repeat: Means that the whole texture is repeated over again to fill out the object.

• Clamp: Means that the pixels on the end of the image are repeated to fill out the
object.

• Compression: Texture compression can be used to save texture memory on the
graphics card.

• None: No compression.

• DXT1: Compresses to an RGB image. This format has a 6:1 compression ratio (DXT1
does not store alpha).

• DXT3: Compresses to an RGBA image with a 4:1 compression ratio.
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• DXT5: Compresses to an alternative RGBA image that treats the alpha channel
different than DXT3 (alpha looks smoother). DXT5 has the same compression ratio
as DXT3.

• Position: Defines the position of the texture relative to the one stored in the
picture.

• Rotation: Defines the rotation of the texture relative to the one stored in the
picture.

• Center: Shifts the center of the image.

• Scaling: Scales the image that is used as texture. Before changing the scale values
of the image, make sure to set the preferred kind of scaling:

• Single: Scales each axis by itself.

• Locked: Scales all axes at once, so that X, Y, and Z have the same value.

• Proportional: Scales all axes at once, so that the values remain proportional.

See Also

• Implementing Video

15.1.6 Viewport Tile

 Viewport Tile renders a scene into a part of the current viewport without using a
texture like Dynamic Scene. The benefit is that the rendering can be done faster but
the disadvantage is that the Viewport Tile is always orthogonal to the camera.

Viewport tiles can also be interactive (use the regular mouse and multi-touch events).

Note: These Textures Sources are located in: Built-ins -> Texture Sources ->
Default

This section contains information on the following topics:

• Properties

• To render a scene in a Viewport Tile

Properties

Viewport Tile properties
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• Scene: Placeholder for the rendered scene.

• Scene Type:

• Local: Renders the current scene.

• Other: Renders the Scene put in the Scene drop zone (drag and drop a scene).

• Main Layer: Renders the scene of the main layer.

• Camera ID: Select a camera for the Viewport Tile scene.

• Crop:

• Off: No cropping.

• Manual: Define the new viewport Size and Position with the parameters X and Y.

• Play controls: Used to play, stop, etc. the animations of the Viewport Tile scene.

To render a scene in a Viewport Tile

Container with a Viewport Tile

1. Add the Viewport Tile to the scene tree.

2. Open the Viewport Tile editor and add a scene to the Scene placeholder.

3. Open the Transformation Editor and set the Screen Size (width and height)
of the Viewport Tile.

4. Open the Viewport Tile editor and click the play button.
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16 On Air Mode

The On Air interface may vary, depending on the software and hardware configuration
used. In Viz Artist, designers can click the On Air button on the main menu to switch Viz
Artist from a modeling tool to a render engine. The application will then wait for control
commands; however, scene animations can also be rendered by the use of the Control
Buttons (top-left corner).

The top left of the On Air screen shows a set of Control Buttons, On Air Editor Buttons,
as well as a Performance Bar button. All License Information is displayed at the top
right of the screen.

Depending on the software and hardware settings, additional buttons and information
is available. For example in design mode, the scene will be shown in an output window
(lower right).

Note: Be sure to keep Viz Artist running in the foreground as not to disturb the
broadcast. Furthermore make sure no window is displayed to overlap the Scene
Editor as this would interfere with the broadcast.

All script events that are added to a scene or to single containers will be executed in
On Air mode. To learn more about scripting see the script documentation.

This section contains information on the following topics:

• Director Control Panel

• Control Buttons

• On Air Editor Buttons

• Performance Bar

• On Air Information

• License Information



Viz Artist User’s Guide

Page 904 Copyright © 2014 Vizrt

16.1 Director Control Panel

The clapper board button, when in On Air mode, opens the Director Control Panel
window.

The Director Control Panel window can be used to select and animate one, multiple or
all directors in the front, main or back layer. In addition it can be used to set slots and
to animate a combination of director(s).

See Director Control Panel for a detailed description of the Director Control Panel.

16.2 Control Buttons

• Back: Jumps to beginning of your scene.

• Play: Will start to play your scene.

• Stop: Stops the scene.

• Forward: Continues to play after stopping.

16.3 On Air Editor Buttons

• Clapper Board: Opens the Director Control Panel window.

• Preview: Shows the Preview window (only available on machines with video cards).

Note: Preview is always enabled on Viz Artist machines without a video card.

• Clock: Opens the Performance Bar .

• System Information: Opens the On Air Information window.

• Lense File Editor: Used for adjusting lens files for virtual sets. You can adjust field
of view, lense deformation, mobile point and centership. It is useful in combination
with lense calibration.
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16.4 Performance
Analyzing the performance of Viz can be done using two tools; one is the Performance
Bar that allows you to closely monitor a range of parameters for analyzing real-time
performance of Viz, the other is the Performance Analyzer tool that allows you to
monitor key performance and camera parameters as a head-up display in the renderer
window and initiate logging of statistic, command and event information to the log
file(s).

This section contains information on the following topics:

• Performance Analyzer

• Performance Bar

16.4.1 Performance Analyzer

The performance analyzer enables key performance and camera information to be
displayed in the renderer view as a head-up display. Additionally the performance
analyzer can be used to initiate writing of statistic, command and event information to
the log files.

• Performance: Displays the current (CUR) and (MAX) parameters (see Performance
Bar).

• HUD: Enables the head-up display (HUD) showing the following parameters in the
renderer view:

• Camera 1-n: Shows the currently selected camera.

• Position: Shows the camera’s X, Y and Z position.

• Pan/Tilt/Twist: Shows the camera’s pan, tilt and twist parameters.

• FovX/FovY: Shows the camera’s field of view (fov) for the horizontal (X) and
vertical (Y) plane.

• Center Shift: Shows the X and Y position of the camera’s center shift.

• CSCM: Shows the center shift as a cross hair in the renderer.

Log files reside under the Viz program folder: C:\Program Files\Vizrt\Viz3\.

To open the performance analyzer

• Hold Ctrl while clicking the right mouse button on the X (close) button in Viz.
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16.4.2 Performance Bar

The performance bar gives an idea of the current scene rendering performance (frames
per second).

• Current (CUR): Shows how many frames per second the scene will render at in On
Air mode. The number should be above 50 ( PAL ) or 60 ( NTSC ), according to the
rate that has been specified in the Output Format section.

• Maximum (MAX): Shows how many frames per second the scene can render
at without waiting for vertical retrace. The higher the maximum value, the more
performance is left. If the maximum value is reduced to below 50 or 60, the scene is
not rendering in real-time.

• Vertices (VER): Shows the number of vectors in the scene.

• AllocTexSize (TET): Shows the total allocated size of texture memory.

• TexSize (TEC): Shows the size of the currently used texture memory.

• Animation (ANI): Shows how many microseconds all active directors and
animation channels take. This indicator is linked to the yellow bar.

• Matrix (MAT): Transforms each container in the scene into world coordinate space.
This indicator is linked to the cyan bar.

• Z-Sort (Z&C): Refers to Z-sort and Culling, and sorts all containers for correct
transparency drawing and determines if containers are visible in the current camera
view. This indicator is linked to the pink bar.

• Video (VID): Shows how many microseconds video input (live video texture) and
video output take. De-interlaced video inputs take longer time than progressive
and interlaced. The only way to improve this value is to use a faster system. This
indicator is linked to the red bar.

• Rendering (REN): Shows how many microseconds it takes to render all objects on
the screen. A faster graphics card will improve this value. This indicator is linked to
the blue bar.

• Script (SCR): Shows the consumed time in microseconds from all active scripts.
This indicator is linked to the dark green bar.

• Plugin (PLU): Indicates how much time in microseconds all active plugins spend in
each render cycle. This indicator is linked to the orange bar.

• Idle: Shows available resources in microseconds the renderer has available. This
indicator is linked to the light green bar.

To open the performance bar

1. Click the performance bar button  .

2. To see all parameters, extend the view by clicking the Eject button.
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16.5 On Air Information

System information - Basic tab

Note: Polling for On Air information can decrease the performance. For
information on how to adjust the On Air Update Interval see the User Interface
section.

In the Basic tab, the parameters you need to know for sending external control
commands are displayed.

• Refresh button: Refreshes the status information.

• Hostname: Shows the name external control programs can use to communicate
with Viz Artist.

• IP Address: Shows the IP address external control commands can communicate
with Viz Artist.

• Port: Shows the port Viz Artist is using. Default port is 6100, but may be changed in
Viz Config’s Communication section.

• GH-Server: Shows the Viz Graphic Hub server Viz Artist is connected to.

• Back Layer: Shows the name of the scene that is defined to run in the background
of the middle and front layer scene(s).

• Middle Layer: Shows the name of the scene that is defined to run in the middle
between the back and front layer scene(s).

• Front Layer: Shows the name of the scene that is defined to run in the foreground
of the back and middle layer scene(s).

• Uptime: Shows the time elapsed since Viz was started.
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System information - Clients tab

In the clients tab, all connected clients are displayed with the IP address, host name
and Viz Port.

16.6 License Information

The license information listing displays the licensing information such as licensed
features and how many days the license has left before it must be renewed.
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17 Transition Logic

Transition Logic is first and foremost about:

• Having background graphics that are constantly on air to provide an artifact-free
show of graphics and animations.

• Having morphing background graphics that are separate from the foreground
graphics and animations.

• Having independently controlled multiple layers of graphics on air at the same time.

• Having graphics that will ease the operator’s job of handling multiple layers of
graphics.

Transition Logic scenes are designed with a built in logic. A built in logic that can create
morphing background graphics, handle multiple layers of graphics and transitioning
between variants of each layer. The built in logic also minimizes the operator’s need
to know how scenes affect each other as the scene by design controls each layer
of graphics and how they affect each other which ultimately creates a look that is
consistent and artifact-free.

To understand what Transition Logic is, one needs to understand a few basic facts:

• A Transition Logic scene is not a single scene, but a set of Viz graphics scenes that
consist of a background scene that may have multiple layers of graphics that can be
on air at the same time and independently controlled.

• Each layer in the background scene may have multiple referring foreground scenes;
however, each layer can only show one foreground scene at a time.

Note that with Transition Logic scene design, take in and take out commands are
still used as with standalone scene design; however, where standalone scene design
demands that only a single scene can be on air at a time, Transition Logic allows for
more than one scene to be on air at a time. For example, a graphics covering the lower
third of the screen, and another covering the left and/or the right side of the screen (for
over the shoulder graphics), can be on air at the same time.

Transition Logic can be played out by most of Vizrt’s control applications such as Viz
Trio, Viz Content Pilot and Viz Multichannel.

This section contains information on the following topics:

• Standalone versus Transition Logic Scene Design

• Toggle Layer

• State Transition Animation

• Cross Animation

• Geometry Animation

• Background Scene

• Foreground Scene

• Tutorial



Viz Artist User’s Guide

Page 910 Copyright © 2014 Vizrt

17.1 Standalone versus Transition Logic Scene Design
Unlike standalone scenes, a Transition Logic scene can have multiple layers defined
that again can control the transitioning of multiple foreground scenes per layer (e.g.
transitioning between variants of lower and top thirds). Having more than one layer
will therefore enable a Transition Logic scene to control multiple variants of foreground
scenes per layer (e.g. variants of over the shoulder, bug, full screen, lower and top
third graphics).

The following table shows the difference in results when executing commands towards
Transition Logic scenes compared to standalone scenes. The table shows a Transition
Logic scene with two layers and two foreground scenes (over the shoulder and lower
third) and two standalone scenes that are identical to the Transition Logic foreground
scenes.

Scene design comparison

Action Transition Logic Design Standalone Scene Design

Take lower
third

Take OTS

Take Out OTS

Take Out lower
third

The first action, take lower third, results in a lower third graphics being placed on-
screen. The second action, take over the shoulder (OTS), places the OTS on-screen;
however, with standalone scene design this will also cause the lower third to be taken
out (i.e. a hard cut).

The third action, take out OTS, will take out the OTS; however, with Transition Logic
scene design the lower third will remain on-screen until it is taken out (last action).

17.2 Toggle Layer

A toggle layer acts as a placeholder for one or several graphical elements. Having
multiple versions of a lower third on the same layer, to change its appearance from one
size to another is therefore possible.

Toggle layers offer the possibility to place graphical elements into several logical
placeholders allowing multiple layers of graphics to be shown on-screen at the same
time.
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Note: Layer, in Transition Logic terms, does not lend itself to how the term layer is
understood with most 2D applications. Layers in Transition Logic refer to the areas
on-screen the layers reside.

A toggle layer needs to be created for each graphical element (i.e. logical group of
foreground scenes) that needs to be on-screen at the same time, and all toggle layers
must reside in a common scene known as the Background Scene. To show multiple
layers of graphics on-screen at the same time, the background scene must have as
many toggle layers as there are logical groups of graphics.

You may place graphics for a top third, lower third and a news ticker in the same logical
layer; however, if the news ticker and the lower third needs to be on-screen at the
same time they have to be in different logical layers. Creating placeholders for logical
layers of graphics is done using the built in Toggle plugin. Hence, the term toggle layer.

Residing in different logical layers also means that their animations may affect each
other. For example, having the lower third and news ticker on air at the same time
may for instance push the lower third further up the screen to make room for the news
ticker.

See Also

• Background Scene

• Toggle

17.3 State Transition Animation
When building a Transition Logic scene, it is the background scene’s Toggle Layers that
are defined to be in different states. Each layer has its own director that defines the
states each layer can be in, and each foreground scene refers to a single layer and
state.

Toggle layer states

Animating between different toggle layer states is called state transition animation.
The example above shows a lower third’s backplate being animated from a narrow
version to a wide version (two states).

This section contains information on the following topics:

• Defining States

• Identifying States

17.3.1 Defining States

A toggle layer is required to have a default state named O. The O state is often referred
to as the Out state as it is the state the toggle layer will be taken to when the operator
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issues a Take Out command. Hence, it is, in most cases, also the state where the toggle
layer’s referring foreground scene is no longer visible on-screen.

In addition to the O state, you may choose to add additional states to run animations
when taking elements to air. A second state is often referred to as the in state, or
visible state, because it most often refers to the sate when a referring foreground
scene is shown on-screen.

Use the following conventions when defining states:

• It is required to write all O states using upper case only.

• It is recommended to name states according to the referring foreground scene’s
appearance.

• It is recommended to write all state names using upper case characters only.

States should be named according to the referring foreground scene’s appearance;
hence, a graphics displayed in the lower third of the screen that varies in size from
large to small will typically have two states named LARGE and SMALL. A graphics
placed over the shoulder of a presenter, where the graphics should switch between the
left and right side of the screen, would simply be named LEFT and RIGHT, or OTS_LEFT
and OTS_RIGHT (OTS is short for Over The Shoulder).

Defining two states, for example O and SMALL, will in practice allow the designer to
create transition animation that will place a layer off or on-screen. Hence, any layer
placed off screen will first be in an O state (out), then transitioned to its SMALL state
on-screen when taking an element that demands the SMALL state, and back to its O
state when taken out.

Transitioning from a SMALL to an O state is achieved by using the animation from the
O to the SMALL state. In such a case the animation will be played in reverse. If this is
not desired, you simply add another O state after the SMALL state, and create a new
animation.

If the layer should transition from a SMALL to a LARGE state you simply add the state,
and create a transition animation for the layer going from a small to a large sized
graphics. This also requires that the LARGE state has an O state such that the graphics
can transition and animate out from the LARGE state.
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17.3.2 Identifying States

Euler walk

There are no hard limits to the number of states; however, increasing the number of
states also increases the number of animations, and consequently the complexity of
the scene. To decide the minimum number of animations required it is possible to do
a Euler Walk. The Euler Walk, although not always possible, is defined as the optimal
route taken to visit each point exactly once. However, the theory can be applied to
Transition Logic to identify the minimum required states needed to connect each state
to the others exactly once (see Figure 84: Euler walk).

Layer director

Straightening the Euler walk out onto the layer’s director will show the required
transition animations.

Note that when performing transition animations from one state to the other Viz will
search from left to right on the layer’s director for the correct combination of states.
If the operator wishes to go from state A to B, Viz will traverse the layer’s director
for state A and look to the right and see if it finds state B. If a match is found, Viz will
perform the transition animation.

Looking at the example director above (see Figure 85: Layer director) it becomes clear
that not all combinations can be found by traversing from left to right. Hence, if a
change from state A to D is not found Viz will, after traversing from left to right, start to
backtrack and traverse from right to left looking for a D from A animation.
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Having found the minimum required animations a designer will often start to add extra
animations. It might be desirable to add a transition animation from state B to O to
animate the layer out from state B. Adding new out states increases the complexity of
a layer as it is still required to have a transition from B to C.

The following table shows the minimum required number of transition animations for a
graphics layer with a given number of states.

States, transitions and animations

States Transitions Animations

1 state Not possible.

2 states Requires a minimum of 1 animation

3 states Requires a minimum of 3
animations

4 states Requires a minimum of 6
animations

5 states Requires a minimum of 10
animations

6 states Requires a minimum of 15
animations

17.4 Cross Animation

Cross animations are used in Transition Logic scene design to animate one object in
and another out. The example above shows a lower third that has an alpha cross fade
fading from a two lines of text to a one line of text.

AX and BX directors

Cross animation directors are added by the Toggle plugin. The directors are always
tagged with the letters AX and BX. AX and BX holds the cross animation and effect
used to animate from one object to another. The default cross animation is a 1 second
cross fade of the alpha value.

Animation and effect length can be changed by adjusting the director’s animation
and effect(s) on the stage. In addition it is also possible to remove or add effects (e.g.
material, position and scaling).

See Also
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• Toggle

17.5 Geometry Animation

Geometry animations are used in foreground scenes, and are the same kind of
animations created with standalone scene design. foreground scene animations are
independent and not controlled by the background scene. The example above shows a
lower third foreground scene with geometries that animate across the screen.

17.6 Background Scene
The background scene serves several important functions. Most importantly it is the
controlling part of a Transition Logic scene, and is essentially what makes standalone
scene design different from Transition Logic scene design.

A Transition Logic background scene is:

• Constantly on air, and is used for controlling state transition animations on
backplate graphics in combination with the cross animations of foreground scenes
(e.g. toggling from one line to two lines of text).

• Able to replace a layer’s referring foreground scene without taking other layers off
air.

• Able to have graphical elements such as backplates that separates the background
for foreground scenes.

Having the background scene constantly on air means that when controlling the toggle
layers it can smoothly morph the backplate graphics from one size to another providing
an artifact-free backplate that will fit the changing requirements of the foreground
scenes. With a one to two lines of text geometry, the text will, at a minimum, have a
built in cross animation (e.g. fade out one line and fade in two lines). Additionally, as
the background scene is already on air the transition animations on the background
elements will have no artifacts (e.g. jittering) caused by graphics being loaded.

See Also

• State Transition Animation

• Cross Animation

• Foreground Scene
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17.7 Foreground Scene

Simple lower third foreground scene

Transition Logic foreground scenes are similar to traditional standalone scenes that
contain graphical elements such as geometrical shapes and textures (e.g. images
and video clips), but are different in that they are capable of affecting the state of the
background scene’s toggle layer.

Transition Logic enabled Control Object plugin

For foreground scenes to have an effect on the background scene’s toggle layer, it has
to refer to the background scene, the layer and the layer’s state. This is obtained by
adding the Control Object plugin to the foreground scene’s scene tree at root level.

When Control Object is added to a foreground scene it must be Transition Logic
enabled. This enables the foreground scene to set layer, state and background scene
parameters.

These parameters are, when a foreground scene is taken on air by an operator, sent as
commands to Viz requesting the background scene to change the toggle layer’s current
state to the new state the foreground scene is referring to.

If the foreground scene’s Control Object parameters are not correct, Viz will not be able
to trigger the correct state transition animation, and the foreground scene will not be
able to animate in.

Note: Control Object also keeps track of other control plugins’ properties that,
when exposed, allows the operator to change their parameters (e.g. text size,
color, geometry, texture, video clip and so on).

See Also

• Toggle Layer

• Geometry Animation

• Background Scene

• Control plugins
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17.8 Tutorial
This section contains information on the following topics:

• Creating a Project

• Creating a Background Scene

• Creating a Foreground Scene

17.8.1 Creating a Project

It is good practice to create a project with a folder for each new design. This will ensure
that a project with more than one design does not get mixed up, and potentially
overwrite other files.

See Also

• Folders

17.8.2 Creating a Background Scene

Note that it is recommended to create the background scene before Creating a
Foreground Scene as the background scene is needed to complete the foreground
scene(s).

When creating a new Transition Logic scene design it is common practice to first define
the Toggle Layers. After the toggle layers are defined you would typically move on to
create the background scene, and add the defined toggle layers.

This section contains information on the following topics:

• To define the toggle layers

• To create a toggle layer

• To add key

To define the toggle layers

1. Create a list of all graphical elements to be shown. For example:

• A large two lines lower third.

• A small one line lower third.

• A small one line top third.

• A left side over the shoulder (OTS).

• A right side OTS.

• A logo bug.

• A “coming up next” bug.

• A news ticker.

• A clock.

2. Create an operational scenario where you decide how elements will affect each
other, and which elements can be on-screen at the same time. For example:

• Only one lower or top third can be on-screen at a time (toggle layer 1).
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• Only one OTS can be on-screen at a time (toggle layer 2).

• Only one logo or “coming up next” bug can be on-screen at a time (toggle layer 3).

• The news ticker and clock should be possible to take in and out independently of all
layers (toggle layers 4 and 5).

Note: All toggle layers can potentially be on-screen at the same time, but only
one foreground scene per layer can be shown at the same time.

To create a toggle layer

1. Create a new scene, and name it default. This will be the background scene.

2. Add a group container to the scene tree, and name it Banner.

• This will be the placeholder for the banner’s toggle layer and backplate graphics for
the banner foreground scenes.

3. Add a sub-container to the Banner container, and name it BannerLayer.

• This will be the placeholder for the Toggle plugin.

4. Add the Toggle plugin to the BannerLayer container.

• This will generate the default object placeholders for the toggle layer’ s current and
other state.

5. Add a sub-container to the Banner container, and name it BannerBackplate.

• This will be the placeholder for the banner’s backplate(s).

6. Add a rectangle and material to the BannerBackplate container, and adjust the
Transformation Editor properties such that it creates the look and feel of a simple
lower third graphics.

• Axis Center: Set X to left (L) and Y to bottom (B). The X and Y values are set to
-50.

• Position: X: -330, Y: -160, Z: 0

• Scaling (single): X: 1.0, Y: 0.4, Z: 1.0

7. Open the Stage by clicking the Stage button (main menu).

8. Add a new director, and name it BannerLayer. This will be the placeholder for
the backplate animations.

9. Animate the banner backplate.

• Scaling X: 0 (60/50 fps)

• Scaling X: 6.6 (120/100 fps)

• Scaling Y: 0 (180/150 fps)



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 919

10. Open the Stage and check that the animation resides under the BannerLayer
director. If not, place it (drag and drop) under the BannerLayer director.

11. Select the Banner director, and the director’s Time Marker to 0.000 seconds, and
add a tag.

12. Select the tag and name it O (uppercase O, not zero).

13. Add a new tag for the animation’s in point (e.g. LOWERTHIRD) and a second out
point (O). The tags represent the basic states the graphics can be in.

14. Open the Toggle plugin editor, and click the Default key frames button.

• Adding key frames adds a 1 second default alpha cross fade effect to objects
placed on that layer.

Note: Adding default key frames is not possible until the layer’s director has
at least two states defined where one has to be the O state.

15. Repeat steps 2-14 for the OTS layer with the following transformation properties
and animations.

• Axis Center: Set X to left (L) and Y to top (T). The X value is set to -50 and the Y
value to 50.

• Position: X: -330, Y: 100, Z: 0

• Scaling (single): X: 1.0, Y: 0.05, Z: 1.0

• Scaling X: 0.0 (60/50 fps)

• Scaling X: 1.0 (120/100 fps)

• Scaling Y: 1.4 (180/150 fps)

• Scaling X: 0.05 (240/200 fps)

• Scaling X: 0.0 (300/250 fps)

16. Save the scene with all directors in their O state.

IMPORTANT! Set all directors to an O state because backplate graphics saved in
a visible state will be shown on-screen the first time any toggle layer is taken on
air.

To add key

• Open Scene Settings and select the Auto Key option under Global Settings.

Tip: Click the Key button in the Scene Editor to toggle the key.

See Also

• Toggle Layer

• Creating a Project

• Creating a Foreground Scene
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• Toggle

17.8.3 Creating a Foreground Scene

Before creating foreground scenes you should start by Creating a Background Scene.
After the background scene has been created, the next step is to create the foreground
scene(s) that reside on the different toggle layers defined in the background scene.

An important part of foreground scene design is to add the Control Object plugin. The
Control Object plugin will enable the foreground scene to “tell” the Viz Engine which
layer it resides on and the state the background scene should be in when taken on air
by the operator.

Additionally the foreground scene can expose other parameters to the operator
by adding control plugins (e.g. Control Text and Control Image). Additionally the
foreground scene can be used for adding preview tags such that the scene can be
correctly previewed by newsroom users that work with the Viz Content Pilot Newsroom
Component.

This section contains information on the following procedures:

• To create foreground scenes

• To create a background image for the foreground scene

• To create a preview point

To create foreground scenes

1. Create a new scene, and name it 1000.

2. Add container to the scene tree, and name it lowerthird.

3. Add Control Object plugin to the lowerthird container.

4. Add a sub-container to the lowerthird container, and name it text.

5. Add a font to the text container.

6. Add a Control Text plugin to the text container.

7. Optional: Enable the Server view, and select the image (I) tab.

8. Optional: Open Scene Settings and select the Global Settings tab.

9. Optional: Drag and drop the snapshot image onto the Background Image
placeholder (see how To create a background image for the foreground scene).

10. Open the Control Object’s editor, and set the following parameters:

• Description: Headline

• Transition Logic: On

• Layer Identifier: BannerLayer

• State Identifier: LOWERTHIRD
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• Background scene: default

1. Open the text container’s transformation editor, and set the following
transformation properties and animations:

• Position: X: -320, Y: -150, Z: 1

• Scaling (locked): 0.5

• Scaling (locked): 0.0 (60/50 fps)

• Scaling (locked): 0.5 (120/100 fps)

1. Save the lowerthird scene.

2. Repeat steps 2-11 for the OTS foreground scene with the following parameters,
transformation properties and animations.

• Scene name: 2000

• Description: Text

• Transition Logic: On

• Layer Identifier: OTSLayer

• State Identifier: OTS_LEFT

• Background scene: default

• Position: X: -330, Y: 120, Z: 1

• Scaling (locked): 0.3

• Scaling X: 0.0 (60/50 fps)

• Scaling X: 0.3 (120/100 fps)

Tip: Open the Control Text editor and disable the Single line parameter.

1. Save the OTS scene.

To create a background image for the foreground scene

1. Open the background scene.

2. Open the Stage view, and set the layer’s state where it matches the state of the
foreground scene (e.g. LOWERTHIRD).

3. In the Scene Editor, click the Snap button and save the snapshot (e.g. as
banner_lowerthird).

• The snapshots can be used as “placeholders” for the foreground scenes.
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To create a preview point

1. Open the Stage, and select the Default director.

2. Position the Time Marker from where you would like the scene to be previewed.

3. Click the Add a Stop/Tag button.

4. In the appearing editor enter Name as pilot1 (case sensitive), and set Type to Tag.

• When previewing using a remote (external) Viz preview, either from a newsroom
system, or when connected to a Media Sequencer with a control application, the
pilot1 tag will be the default preview point for the foreground scene.

See Also

• Foreground Scene

• Container Plugins

• Viz Content Pilot User’s Guide on remote Viz preview.
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18 Scripting

Before starting to learn the computer language Viz 3 Script, you should learn the basic
principles of programming which is explained in the following sections:

• How Programming Works

• Program Structure

• Variables

• Procedures

• Operators

• Conditions

• Loops

• Script Editor

In addition to the basic building blocks of script programming, you will also find a quick
introduction on how to create and run scripts, how to create reusable plugins of your
scripts and other example scripts that will help you script your own functionality:

• Creating and Running Scripts

• Creating Script-based Plugins

• Controlling 3D Stereoscopic Clip Playback

• Program Examples

18.1 How Programming Works
Technically, a computer works on a simple level processing the two states 0 and 1. The
computer hardware only knows those two conditions and sets its “switches” according
to them. Because a modern computer has a nearly uncountable number of those
switches, it does not make any sense for a user to control them all by setting everyone
to 0 or 1 by hand.

Programming language

Programming languages got developed for easy controlling the computer’s hardware
by the user in a manageable way. With those languages, it is possible to develop
readable commands which then will be translated into 0 and 1 for the computer. So
these languages work as a translator between the user and the computer.

Syntax

This translation is processed by a compiler who converts text commands into machine
code, but like every human language, a programming language has orthography and
grammar rules. The user needs to follow those rules to make sure that the translation
into machine code can be done without errors by the compiler.

The so called syntax describes those rules of spelling and constellation. Every
programming language has its own syntax, so the script examples in this document will
be written in the Viz 3 Script – syntax.
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18.2 Program Structure
The certain text commands, which are written within the defined programing syntax,
will lead to specific actions, done by the computer. Those commands and definitions
are written with an adequate text editor and are called “source code”. This code will
then be send to the compiler for processing.

Layout

The structure of a script program is similar to every other common language syntax.
Before writing the actual commands and routines for the computer, it is necessary to
define the variables which will be used within those commands so that the compiler
knows how to handle them.

After defining variables (see Variables), the commands and routines can be defined to
send them to the computer. A sequence of various commands will be held in so called
procedures (see Procedures). Procedures can be seen as a container which includes
those commands. If required, the user can call this container to execute the commands
inside. This will avoid writing same code structures several times.

When the used commands got executed, the corresponding values of the variables
got changed and translated into machine code, which will lead to the desired result of
changing states between 0 and 1.

18.3 Variables
Basically, programs work with variables which work as placeholders for values and
used for handling those values inside the procedures. Variables can contain different
types of data (e.g. numbers, text, etc.) and allows the user to work with values even if
they are not known at this time.

Example: A kitchen shelf contains 132 wine glasses. Instead of remembering
the number 132 it makes more sense to store this value into a placeholder. So
you create a variable wineglass and store the value 132 into it. You then use
wineglass instead of remembering the exact value.

Variables are not part of the programing spelling or syntax, so the compiler will not
recognize the word. So before using such a variable, it has to be defined for the
compiler to use it in a command. If not the program will not be executable.
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As mentioned before, variables can replace values of different types. So it is possible to
store simple number values, text strings, colors or whole containers in it.

For the compiler to understand the type of variable it has to process, it is also
necessary to declare what kind of data type the variable represents.

In programing a distinction is drawn between two types of variables:

• Global Variables are declared at the beginning of the program outside of
procedures. These types can be used and modified in every procedure.

• Local Variables get declared within a certain procedure and can only be
accessed by commands processed there. These variables cannot be seen by other
procedures, so modifying them from external procedures is not possible.

Definition and declaration of variables in Viz 3 Script are done by using the command
dim which is short for dimension.

Note: All code examples described in this document are written within the syntax
of Viz 3 Script. Therefore these examples can only be processed by an appropriate
compiler.

Example

‘Declaration and variable assignment in two operations
Dim wineglass as Integer
wineglass = 132
‘Declaration and variable assignment in one operation
Dim wineglass as Integer = 132

18.3.1 Basic Data Types

This section describes and gives examples of the basic data types:

• Integer

• Double

• String

• Boolean

• Array

• Structure

Type Description Examples

Integer Integer numbers 0,1,2,3 ...

Double Floating point numbers 4,213415

String Text “Hello”, “Florian”

Boolean State 1/0 true, false

Example

‘String values are enclosed in double quotes
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Dim name as String
name = “Florian”
Dim state as Boolean
state = true

Array

An Array is a Type of storage, which can be filled with an amount of variables of a
certain data type. When defining an array, the data type of the containing variables
has to be declared. By using an index, the variables can be addressed within the array.

In principle, an array can be imagined like a bookshelf which gets filled with single
books (variables). Every place on the shelf has its own designated identifiable Number,
so it is possible to detect which book is standing in a certain place.

By calling this identifier number, the array index, the array will respond with the
assigned variable. The numeration starts at 0, so the first variable in the array is called
by using the index “0”.

An Array containing names/text gets created and filled with text-strings. The command
push allows it to load certain strings into the array.

Dim memory as Array[String]

                                      memory.push[“Florian”]

                                      memory.push[“Vizrt”]

                                      memory.push[“Austria”]

                                      memory.push[“Hello”]

By calling the index of the array, the assigned String gets returned. So "memory[2]"
will return “Austria“. Other data types differ in most programing languages and will not
be explained any further.

Special Viz 3 Script data types are referred to in the Scripting Data Types and
Procedures chapter.

Structure

Structures are Containers that can store an amount of variables with different data
types. Other than in arrays, those variables are not stored in a row with an index. You
can define how many variables and different data types you want to use.

With structures, it is possible to work with a variable which can contain multiple values
(stored in sub-variables).

To describe a soccer player with programing code, a new structure soccer_player with
multiple variables can be declared. Those certain sub variables can be declared with
any data type (Integer, Double, String, etc.).

structure soccer_player

                                      name as String

                                      team as String
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                                      number as Integer

                                      age as Integer
end structure

The variable’s values can be defined with relevant values by referencing
soccer_player.

soccer_player.name = “Lionel Andrés Messi”
soccer_player.team = “FC Barcelona”
soccer_player.number = 10
soccer_player.age = 24

See Also

• Array[Type]

• Boolean

• Double

• Integer

• String

18.4 Procedures
Like variables, procedures get defined with an appropriate name to manage them more
easily in the code.

To double the amount of wine glasses, the procedure double_wineglass() can be
called. Inside this procedure, the variable gets multiplied with the factor 2. Every time
wineglass gets called in the program, the actual amount of wine glasses is doubled.

sub double_wineglass()

                    wineglass = wineglass * 2
end sub

Like in most programing languages, there are two types of procedures in Viz 3 Script:

• Sub-routines (process certain defined commands)

• Functions (sub-routines that return a variable)

18.4.1 Sub-routines

Both types, sub-routines and functions are basically a capsuled order of calculating
processes (commands) that get stored under a specific name to make it possible to
call these commands at any given time without rewriting it. The name of the procedure
works as a reference to these commands.

Procedures can be imagined as sub-programs inside the main program which process
calculations, modifies the variables and can call other sub programs.

Transfer Variables

To make procedures be more dynamic, it is not efficient to write a sub-routine for every
single variable. By calling the sub-routine it makes sense to pass the variable to a sub-
routine.
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Inside the procedure, a new independent variable is used to process the calculations
and commands.

By writing the sub-routine (sub – end sub), a new variable with an appropriate data
type gets declared. The procedure itself now doubles every integer variable that is sent
when called by the other procedures.

sub double(input as Integer)

                                input = input * 2
end sub

By calling double(wineglass) the variable wineglass is sent to the procedure and
doubled without using the exact variable name wineglass inside the procedure.

18.4.2 Functions

The only difference between sub-routines and functions is that functions are able to
return a value after getting called. It makes it possible to use a function inside the code
as a normal variable.

By creating the function, the data type which should get returned must be declared. In
this case the function multiply returns a variable (same name multiply) as integer.

function multiply(input as Integer) as Integer

                          multiply = input * input
end function

Now it iss possible to handle the function as a standard variable.

sub tmp()

                          new_glass = multiply(wineglass) + 10
end sub

18.5 Operators
To use and modify the various variables inside the program, a method to access and
change the values is necessary.

dim number as Integer
number = 10

Operator is =

There is a range of different types of operators for working with variables:

• Assignment operator(s)

• Comparison operator(s)

• Arithmetic operator(s)

• Logical operator(s)

• String operator(s)

• Combined operator(s)
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Assignment operator(s)

Assignment operators are used for defining variables and assigning values to variables.

Operator Description

= Assigning integer, double, string, etc.

== Boolean assignment (true/false)

Comparison operator(s)

To compare certain variables to execute different commands (see Conditions).

Arithmetic operator(s)

Arithmetic operators are used for executing basic mathematical calculations.

Operator Description

+ Addition

- Substraction

* Multiplication

/ Division

Logical operator(s)

Allows it to combine two Boolean states.

Operator Description

Not Returns "true” if conditions “false”

And Returns “true” if both operands are “true”

Or Returns “true” if at least one of the operands is “true”

Xor Returns “true” if the two operands differ from each other

String operator(s)

Operator Description

& To combine single strings

dim a as String
dim b as String
dim c as String
a = “Hello”
b = “World”
c = a & b
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The string value c now contains Hello World.

Combined operator(s)

A combination of assignment and arithmetical operators.

Operator Description

+= Addition of a value to the actual variable

-= Subtraction of a value from the actual variable

*= Multiplication of a value of the actual variable

/= Division of a value on the actual variable

&= Extension of a string with another one

18.6 Conditions
To make decisions to further processes other commands, it is often necessary to be
able to request the status of certain variables or procedures and react accordingly.

Such conditions can be proofed by using if-then/Else or case statements. Variables or
functions can be compared with reference values or states and trigger different actions
when the condition is fulfilled or not.

For example, in an office building, the temperature gets controlled by an air condition
system. If the temperature reaches a value below 25°, the air condition should stop.
Else, if the temperature is above 25° the air condition should run and cool the building.

if temperature < 25 then

                    Stop_Conditioning()
else

                    Start_Conditioning()
end if

Note: The declaration of variables and procedures are not shown

To implement different conditions, the following comparison operators are available:

Operator Literal Description

= equals Identical values

< smaller than Value is smaller than the referenced value

> greater than Value is greater than the referenced value

<= less than or equal Value is less than or equal to the referenced
value
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Operator Literal Description

>= greater than or equal Value is greater than or equal to the referenced
value

<> unequal Value is different from that of the referenced
value

18.7 Loops
To execute commands, which need to be started several times, without typing them
explicit in the code, loops are used to repeat those commands for a specified number
of times.

Those loops are depending to an abortion condition and repeat the defined commands
till this condition gets fulfilled (or not, depending on the condition commands). Inside
the loop, a user defined sequence of commands and procedures get called.

In programing a distinction is drawn between two basic types of loops:

• Condition-controlled Loops

• Count-controlled Loops

18.7.1 Condition-controlled Loops

Thereby the loop is controlled by a specified abortion condition. Those loops basically
get defined with the commands Do and Loop. The command sequence inside the loop
will be executed as long as the condition is fulfilled. Additional command words are
While and Until to specify the abortion condition more precise.

For example, the variable a gets checked if it is less than or equal to the value 10.
While the variable does fulfill the condition, the command Println gets called and
afterwards the variable gets increased by 1. Println is used to output the variable’s
current value to the console.

Do While a <= 10

                          Println a

                          a = a + 1
Loop

Another way of defining the loop condition is to check the result after the commands
are executed.

Do Println a

                          a = a + 1
Loop Until a > 10

18.7.2 Count-controlled Loops

This type of loop controls its abortion condition using a count value. A variable with a
start value gets defined and is iterated to end at a specified value. While the variable
has not reached the defined value, the commands in the loop body are executed.
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In the following example the variable i works as the counted variable that gets
increased by 1 every time as it counts from 0 to 10. Println is used to output the
variable’s current value to the console.

For i = 0 to 10

                          Println i
Next

The output should be the following: 1 2 3 4 5 6 7 8 9 10 (one number per line)

18.8 Script Editor

• OK: Shows that all parts of the script entered are correct. If there is an error, it will
indicate where.

• Compile & Run: Compiles and runs the script.

• The Cancel: Cancels all changes.

• Ln: Jump to the line number entered in the field.

• Find: Free text search. The up-arrow will search above the cursor’s location. The
down-arrow will search below the cursor’s location.

• Functions: List of all the functions defined.

• Events: List of all built-in events, such as mouse-click, mouse-move, keyboard
button press, etc.

• ?: Launches the script documentation.

• Up/Down arrows: Pops-out/docks script editor.

To launch the script editor

1. Add a Script plugin to your scene, or

2. In the main menu, click Server

3. In the right panel, select Scene Settings

4. Click the Script tab

To add scripts to the editor
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• Copy <Ctrl+C> your script and paste <Ctrl+V> it into the Script Editor.

To add script plugins to the editor

• Drag and drop your compiled script plugin onto the Script Editor and select to
replace the existing script, add it to the end or cancel the operation.

See Also

• Script plugin

• Creating Script-based Plugins

18.9 Creating and Running Scripts
This section contains two examples; one showing how to write a simple script that
controls the alpha value of an object (see Example I), the second how to write a simple
script that scales a container’s x-scaling value based on another container’s x-scaling
value (see Example II).

Example I

As an example, start with a simple event-driven script. First, create a script object by
dragging the built-in Script plugin from the Container Plugins’ Global folder onto one
of your containers. Then, after clicking on the container’s new script object, copy and
paste the following code into the Script Editor.

Sub OnEnter()

                          Alpha.Value = 100.0
End Sub
Sub OnLeave()

                          Alpha.Value = 50.0
End Sub

This script consists of two event procedures, OnEnter and OnLeave, which are
recognized by the system and invoked whenever the mouse cursor enters or leaves
the area occupied by the container in the output window. Take a closer look at what
happens inside OnEnter:

Alpha.Value = 100.0

This code sets the alpha value of the container to 100 (the maximum value). If there is
no Alpha object, no action occurs, so make sure that the container has an alpha object
by adding the Alpha plugin. Alpha refers to the container’s alpha object, Value is a
member (in this case: the only member) of the alpha object, representing its value.
Changes made to Alpha.Value are immediately made visible in the output window.

Similarly, the code in the body of OnLeave sets the alpha value back to 50.

To execute the script, click the Compile & Run button. Click Edit to return to editing
mode.
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Example II

The following example defines the event procedure OnExecPerField, which is called
periodically for each field.

Sub OnExecPerField()

                          Dim cube As Container

                          cube = Scene.FindContainer(“Circle”)

                          If scaling.x > 1.5 Then

                          
                          cube.Scaling.x = 2.0

                          Else

                          
                          cube.Scaling.x = 1.0

                          End If
End Sub

In the first line, a variable named cube, of type Container, is defined:

Dim cube As Container

Variables of type Container can be initialized to point to a container in the scene tree.
In the next line, we call the built-in function FindContainer (which is a member of
the scene class, accessible via the container’s Scene property) to initialize cube to
point to a container named cube. If there is no such container, cube is set to Null, the
consequence being that any further operations on cube will have no effect.

cube = Scene.FindContainer(“Cube”)

Now, we check if the x-scaling of the current container (that is, the container holding
the script) is greater than 1.5, and, depending on the result, we set the x-scaling of the
container named cube to 2.0 or 1.0:

If Scaling.x > 1.5 Then

                          cube.Scaling.x = 2.0
Else

                          cube.Scaling.x = 1.0
End If
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Note: The expression Scaling.x refers to the current container while
cube.Scaling.x refers to the container referenced by the variable cube.

See Also

• Alpha

• Container

• Scaling

18.10 Creating Script-based Plugins
If you want to reuse a container script on other containers, you can create a plugin of
that script.

• Select a folder other than Global in the Function Container pool and drag the
container’s script icon in the pool

• Plugins created this way are stored in the plugin directory under the name
pluginname.vsl

• They can be used like ordinary plugins and, in addition, allow the following
operations.

Script-based plugins can be deleted from the plugin pool by dragging and dropping the
onto the trash can.

The source code of a script-based plugin can be copied into a script editor by dragging
the plugin from the pool to the Script Editor.

18.11 Controlling 3D Stereoscopic Clip Playback
If you want to playout 3D Stereo Clips, you need to start Viz Engine with the -3D
parameter. This sets Viz Engine in a special mode where a side by side clip will be split
and played out on channel A and B on the Matrox board. Note that this is for clips only!

The playout on each output channel can be controlled with several shared memory
variables. Each channel has its own set of variables indicated by the A and B in the
names. The meaning of each of them is the same for both output channels.

• HScale / VScale: Scales the output image relative to the image anchor (see
XAnchor and YAnchor) in the respective direction.

• HSort / VSoft: Softness is applied to the scaled region of the source image only,
and is defined as the percentage of pixels to be softened from the border to the
center.

• XTrans / YTrans: Translates the output image in the respective direction.

• XAnchor / YAnchor: Defines the position of the anchor on the input image. The
axis center equals the center of the input image.

• Sharpness: Sets the amount of additional sharpness to apply to the output image.

To control the behavior of clip playback, the following shared memory variables exist:

vizrt.com.StereoClip.changed
vizrt.com.StereoClip.A.HScale
vizrt.com.StereoClip.A.VScale
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vizrt.com.StereoClip.A.HSoft
vizrt.com.StereoClip.A.VSoft
vizrt.com.StereoClip.A.XTrans
vizrt.com.StereoClip.A.YTrans
vizrt.com.StereoClip.A.XAnchor
vizrt.com.StereoClip.A.YAnchor
vizrt.com.StereoClip.A.Sharp
vizrt.com.StereoClip.B.HScale
vizrt.com.StereoClip.B.VScale
vizrt.com.StereoClip.B.HSoft
vizrt.com.StereoClip.B.VSoft
vizrt.com.StereoClip.B.XTrans
vizrt.com.StereoClip.B.YTrans
vizrt.com.StereoClip.B.XAnchor
vizrt.com.StereoClip.B.YAnchor
vizrt.com.StereoClip.B.Sharp

See Also

• Camera configuration for setting stereo modes

• Clip Channel - Stereo script example

18.12 Program Examples
To explain the described terms and definitions more comprehensible, this chapter will
show some source code examples and explains the important steps and commands.

Most of the following code samples are written in an easy and understandable form for
programing beginners. Some are basic, while others are more advanced and specific
for their use case. More efficient code structures and improvements are of course
possible.

The following sub-sections contain examples on scripting:

• Initializing Scripts

• Calculating Values

• Registering Parameters

• Registering Parameters and Moving Objects

• Mouse Events I (Set)

• Mouse Events II (Start)

• Mouse Events III (Start, Stop and Reverse)

• Mouse Events IV (Grow and Shrink)

• Mouse Events V (Advanced)

• Planets

• Tetris

• Clip Channel

• Clip Channel - Stereo
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18.12.1 Initializing Scripts

The following example declares and defines two variables with a value. In the main
procedure OnInit() those two variables and their addition are output to the console
using Println.

Callback procedures like OnInit() are used to initialize scripts (see Callback
Procedures).

‘Declaration of the variables
dim a as Integer
a = 10000
dim b as Integer
b = 5000
‘Start of the main procedure
sub OnInit()
‘Executing the commands

                          println "\n"

                          println "The variable a has the following
 value: " & a

                          println "\n"

                          println "The variable b has the following
 value: " & b

                          println "\n"

                          println "The addition of the variables are: " &
 a + b
‘End of the main procedure
end sub

Result output to the console:

18.12.2 Calculating Values

The following example shows a calculator that is able to calculate with 2 values using
basic arithmetic operators + , - , * , / (see Arithmetic operator(s)).

The values and the operators are defined using a text input form (1=”+”, 2=”-”, 3=”*”
and 4=”/”).
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Global variables used in every procedure are declared at the beginning of the program.
For defining the operator, a structure data type is used to store the type of operator as
an integer and its name as a string (to print the according text symbol).

‘Declaring operator as a container of type structure
structure operator

                          op as integer

                          name as string
end structure
‘Declaring sign as a variable of type operator
dim sign as operator
‘Declaring valid as a variable of type boolean
dim valid as boolean = true
‘Declaring result as a variable of type double
dim result as double

The variable’s values (in Main procedure further down) are read in using a Viz
3 Script text input with the command GetParameterDouble. The procedure
OnInitParameters() is not relevant for the case as such, but it creates an interface for
the designer to easily input the values that are fetched by GetParameterDouble.

‘Calculator interface
sub OnInitParameters()

                          ‘Getting the values

                          RegisterParameterDouble("x","X:
 ",0,0.0,1000000)

                          RegisterParameterDouble("y","Y:
 ",0,0.0,1000000)

                          RegisterParameterInt("operator","Select
 operator: ",1,1,4)

                          RegisterPushButton("action", " OK ",1)
end sub

At the beginning of the main procedure OnExecAction(), the two input variables for
the calculation are declared as double data types because calculations may result
in values with a floating point. These variables are local because they are only used
within this one procedure.

By using the operator = the values are stored in the variable placeholder x and y.
The mathematic operator is stored as an integer value into the structure. Following,
the function calculator gets called, the variables x and y and the type of arithmetic
operator get sent to it. The result of calculator gets stored in the variable result.

At the end the function “print” prints the results on the screen.

‘Main procedure
sub OnExecAction(action as Integer)

                          dim x as double = GetParameterDouble("x")

                          dim y as double = GetParameterDouble("x")
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                          sign.op = GetParameterInt("operator")

                          ‘Starting the calculation process

                          result = calculator(x,y,sign.op)

                          ‘Output to the console

                          print(x,y,result)
end sub

In function calculator, the mathematic calculation process gets executed. By using an
If condition the operator gets checked and the resulting operation started. The correct
text symbol gets stored into a string for the further printing function and a Boolean flag
(valid) gets set to true if the calculation was correct (division by 0 is not possible).

After calculation the operator’s name gets stored into the structure as string
(sign.name) and calculator returns the result back to the main procedure.

‘Calculation function
function calculator(x as double, y as double, operator as integer) as
 double

                          ‘Declaring local variables

                          dim tmp as string

                          
                          if operator = 1 then

                          
                          
                          result = x+y

                          
                          
                          tmp = "+"

                          
                          
                          valid = true

                          
                          elseif operator = 2 then

                          
                          
                          result = x-y

                          
                          
                          tmp = "-"

                          
                          
                          valid = true
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                          elseif operator = 3 then

                          
                          
                          result = x*y

                          
                          
                          tmp = "*"

                          
                          
                          valid = true  
                          
                          
                        

                          
                          elseif operator = 4 then

                          
                          
                          if y=0 then

                          
                          
                          
                          valid = false

                          
                          
                          else

                          
                          
                          
                          result = x/y

                          
                          
                          
                          tmp = "/"

                          
                          
                          
                          valid = true

                          
                          
                          end if

                          
                          end if



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 941

                          
                          sign.name = tmp

                          
                          calculator = result
end function

To avoid a division by 0, the y variable gets checked if it is equal to 0 when the operator
is set to division. If it equals 0, the calculation will be set to invalid (valid = false)
and an error message is output to the console.

The final printing function takes the 2 variables “x” and “y” and the result and prints
it formatted on the screen. If the Boolean variable “valid” is set to false, the error
message will be shown.

‘Console output
sub print(x as double, y as double, result as double)

                          ‘Check if calculation is valid

                          if valid = true then

                          
                          println "\n\n\n\n"

                          
                          println "CALCULATOR"

                          
                          println "\n\n"

                          
                          println "First value: " &x

                          
                          println "\n"

                          
                          println "Second value: " &y

                          
                          println "\n"

                          
                          println "Operator: " &sign.name

                          
                          println "\n\n"

                          
                          println "The result is: " &result

                          
                          println "\n\n\n\n"

                          else
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                          println "\n\n\n\n"

                          
                          println "Calculation was not possible"

                          
                          println "\n\n\n\n"

                          end if
end sub

                     

Result printed on the screen:

See Also

• Callback Procedures

• Global Procedures

• Boolean

• Double

• Integer

• String

• Structure
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18.12.3 Registering Parameters

This script example creates a custom editor for filling in index and alpha values. The
index value decides which container that will not receive the alpha value wheras the
alpha value is set for all other containers.

sub OnInitParameters()

                          RegisterParameterInt("index", "Index", 1, 1, 7)

                          RegisterParameterDouble("alpha", "Alpha", 50.0,
 0.0, 100.0)

                          RegisterPushButton("action", "Action", 1)
end sub

sub OnExecAction(buttonId as Integer)

                          dim c as Container

                          dim i, index as Integer

                          dim a as Double

                          index = GetParameterInt("index")

                          a = GetParameterDouble("alpha")

                          i = 1

                          c = ChildContainer

                          do while c <> null
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                          if i = index then

                          
                          
                          c.alpha.value = 100.0

                          
                          else

                          
                          
                          c.alpha.value = a

                          
                          end if

                          i = i + 1

                          c = c.NextContainer

                          loop
end sub

See Also

• Callback Procedures

• Global Procedures

• Boolean

• Container

• Double

• Integer

18.12.4 Registering Parameters and Moving Objects

The following example initializes a set of registered parameters that enables the
OnParameterChanged procedure to rotate the objects accordingly.

Registered parameters

dim part_a as container=scene.FindContainer("move1")
dim part_b as container=scene.FindContainer("move2")
dim part_c as container=scene.FindContainer("move3")
dim part_d as container=scene.FindContainer("move4")
dim part_e as container=scene.FindContainer("move5")
sub OnInitParameters()
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                          RegisterParameterDouble("move_a","Part
 A",0,0.0,70)

                          RegisterParameterDouble("move_b","Part
 B",0,-360,360)

                          RegisterParameterDouble("move_Gec","Part
 C",0,-360,360)

                          RegisterParameterDouble("move_d","Part
 D",0,-90,45)

                          RegisterParameterDouble("move_e","Part
 E",0,-360,360)
end sub

Moving parts

sub OnParameterChanged(parameterName as String)

                          if parameterName="move_a" then

                          
                          part_a.rotation.z=getParameterDouble("move_a")

                          end if

                          if parameterName="move_b" then

                          
                          part_b.rotation.x=getParameterDouble("move_b")

                          end if

                          if parameterName="move_c" then

                          
                          part_c.rotation.y=getParameterDouble("move_c")

                          end if

                          if parameterName="move_d" then

                          
                          part_d.rotation.y=getParameterDouble("move_d")

                          end if

                          if parameterName="move_e" then
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                          part_e.rotation.z=getParameterDouble("move_e")

                          end if
end sub

See Also

• Callback Procedures

• Global Procedures

• Container

• Rotation

• Scene

18.12.5 Mouse Events I (Set)

This script example shows how you can use a “mouse event” to set an object’s alpha
value using OnEnter and OnLeave.

sub OnEnter()

                          alpha.value = 100.0
end sub
sub OnLeave()

                          alpha.value = 50.0
end sub
sub OnExecPerField()

                          dim cube as Container

                          cube = Scene.FindContainer("Cube")

                          if scaling.x > 1.5 then

                          
                          cube.material.diffuse.red = 0.0

                          else

                          
                          cube.material.diffuse.red = 100.0

                          end if
end sub

18.12.6 Mouse Events II (Start)

This script example shows how you can use a “mouse event” to start an animation
using OnMButtonDown and StartAnimation.

sub OnInit()

                          OnEnter()
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end sub
sub OnEnter()

                          alpha.value = 100.0
end sub
sub OnLeave()

                          alpha.value = 50.0
end sub
sub OnMButtonDown()

                          dim dir as Director

                          if ContainsMouseCursor() then

                          
                          dir = Stage.FindDirector("Default")

                          
                          dir.StartAnimation

                          end if
end sub

18.12.7 Mouse Events III (Start, Stop and Reverse)

When adding this script to a container you can start the animation by pressing the
mouse button over an object (e.g. rectangle). Press again and it will stop. Press again
and it will continue from the point it stopped.

dim my_dir = stage.FindDirector("Default")
sub OnLButtonDown()

                          if my_dir.IsAnimationRunning() then 

                          
                          my_dir.StopAnimation()

                          else

                          
                          my_dir.ContinueAnimation()

                          end if
end sub

With the below script you can start an animation and let it run until a stop point. Click
again and it will run in reverse.

dim my_dir = stage.FindDirector("Defult")
sub OnLButtonDown()

                          menu.ContinueAnimation()

                          if my_dir.reverse == true then
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                          my_dir.reverse = false

                          else

                          
                          my_dir.reverse = true

                          end if
end sub

See Also

• Callback Procedures

• Director

• Stage

18.12.8 Mouse Events IV (Grow and Shrink)

When adding the below script to a container the object will grow when the mouse is
hovering over the object and conversely. In this case the centre of the object is set to
the lower right corner to let it grow out from that centre.

dim growing as Boolean = false
sub OnInitParameters()

                          RegisterParameterDouble("min", "MinScale", 1.0,
 0.0, 10.0)

                          RegisterParameterDouble("max", "MaxScale", 1.5,
 0.0, 10.0)

                          RegisterParameterDouble("fac", "GrowFactor",
 1.1, 1.0, 10.0)
end sub
sub OnEnter()

                          growing = true
end sub
sub OnLeave()

                          growing = false
end sub
sub OnExecPerField()

                          dim min = GetParameterDouble("min")

                          dim max = GetParameterDouble("max")

                          dim fac = GetParameterDouble("fac")

                          if growing then

                          
                          scaling.xyz *= fac
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                          if scaling.x > max then scaling.xyz = max

                          else

                          
                          scaling.xyz /= fac

                          
                          if scaling.x < min then scaling.xyz = min

                          end if
end sub

See Also

• Callback Procedures

• Global Procedures

• Boolean

• Scaling

18.12.9 Mouse Events V (Advanced)

This script shows how you can use “mouse events” to click buttons that will trigger pre-
defined actions. This script example also shows how to input parameters by scripting
your own custom GUI.

The same script can be added to multiple containers by creating several buttons that
perform different animations.

dim events as Array[String]
dim action as Array[String]
dim str_action as string
dim str_event as string
dim doubleclick_tracker as Integer
dim dbl_threshhold as Double
dim target_container as container
dim p_anim as Boolean = false
dim p_step as Vertex
dim p_dest as Vertex
dim p_speed,p_time as Double
dim animP0, animP1, animP2,animP3 as Vertex
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‘show/hide GUI buttons
events.clear
events.push("Left Mousebutton Down")
‘events.push("Left Mousebutton Up")
‘events.push("On Mouse Enter")
‘events.push("On Mouse Leave")
‘events.push("Left Mousebutton Double-click")
‘events.push("Right Mousebutton Down")
‘events.push("Right Mousebutton Up")
‘events.push("Right Mousebutton Double-click")
‘events.push("Middle Mousebutton Down")
‘events.push("Middle Mousebutton Up")
sub OnInit()

                          ‘initialize GUI

                          str_event=events[GetParameterInt("do_event")]

                         
 target_container=GetParameterContainer("target_con")

                         
 dbl_threshhold=GetParameterDouble("dbl_threshhold")
end sub

sub OnInitParameters()  
                        

                          ‘create GUI

                          RegisterRadioButton("do_event",
 "Event:",2,events)

                          RegisterRadioButton("do_action",
 "Action:",0,action)  
                        

                         
 RegisterParameterDouble("dbl_threshhold","Double-click
 Threshold",250,10,1000)

                         
 RegisterParameterContainer("target_con","Target")

                          RegisterParameterBool("start_current","Start
 with Current Position",false)
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                          RegisterParameterDouble("position_x","Position
 x Value",0.0,1000.0,1000.0)

                          RegisterParameterDouble("position_y","Position
 y Value",0.0,1000.0,1000.0)

                          RegisterParameterDouble("position_z","Position
 z Value",0.0,1000.0,1000.0)

                         
 RegisterParameterDouble("speed","Speed",1.0,0.1,10.0)
end sub
‘react to mouse events
sub OnEnter()

                          if str_event="On Mouse Enter" then

                          
                          animate()

                          end if
end sub
sub OnLeave()

                          if str_event="On Mouse Leave" then

                          
                          animate()

                          end if
end sub
sub OnLButtonDown()

                          if str_event="Left Mousebutton Down" then

                          
                          animate()

                          end if

                          doubleclick_tracker=GetTickCount()
end sub
sub OnLButtonUp()

                          if str_event="Left Mousebutton Up" then

                          
                          animate()

                          end if

                          if str_event="Left Mousebutton Double-click"
 then
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                          ‘check for double-click events

                          
                          if (GetTickCount()-
doubleclick_tracker<dbl_threshhold) then

                          
                          
                          animate()

                          
                          end if

                          end if
end sub
sub OnMButtonDown()

                          doubleclick_tracker=GetTickCount()

                          if str_event="Middle Mousebutton Down" then

                          
                          animate()

                          end if
end sub
sub OnMButtonUp()

                          if str_event="Middle Mousebutton Up" then

                          
                          animate()

                          end if
end sub
sub OnRButtonDown()

                          if str_event="Right Mousebutton Down" then

                          
                          animate()

                          end if

                          doubleclick_tracker=GetTickCount()
end sub
sub OnRButtonUp()

                          if str_event="Right Mousebutton Up" then

                          
                          animate()

                          end if

                          ‘check for double-click events
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                          if str_event="Right Mousebutton Double-click"
 then

                          
                          if (GetTickCount()-
doubleclick_tracker<dbl_threshhold) then

                          
                          
                          animate()

                          
                          end if

                          end if
end sub

sub animate()

                          ‘Check if target container exists, if not, use
 current container
p_dest=cVertex(GetParameterDouble("position_x"),GetParameterDouble("position_y"),getParameterDouble("position_z"))

                          p_speed=getParameterDouble("speed")

                          p_speed=p_speed/100

                          if GetParameterBool("start_current")=false then

                          
                         
 target_container=GetParameterContainer("target_con")

                          
                          target_container.position.xyz=p_dest

                          else

                          
                          animP1=target_container.position.xyz
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                          animP0=animP1

                          
                          animP2=p_dest

                          
                          animP3=animp2

                          
                          p_time=0.0

                          
                          p_anim=true

                          end if

                          ‘enable the animation
‘  p_anim=true
end sub
sub OnParameterChanged(parameterName as String)

                          ‘react to changes in the GUI

                          if parameterName="target_con" then

                          
                         
 target_container=GetParameterContainer("target_con")

                          end if

                          if parameterName="do_event" then

                          
                          str_event=events[GetParameterInt("do_event")]

                          end if

                          if parameterName="dbl_threshhold" then

                          
                         
 dbl_threshhold=GetParameterDouble("dbl_threshhold")

                          end if
end sub
sub OnExecPerField()

                          if p_anim then

                          
                          p_time+=p_speed

                          
                          p_time=min(1,p_time)
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                          println p_time

                          
                          dim newpos as Vertex=spline(animP0, animP1,
 animP2, animP3, p_time)

                          
                          target_container.position.xyz=newpos

                          
                          if p_time=1 then

                          
                          
                          target_container.position.xyz=p_dest

                          
                          
                          p_anim=false

                          
                          end if

                          end if
end sub
function spline(P0 as Vertex,P1 as Vertex,P2 as Vertex,P3 as Vertex,time
 as Double) as Vertex

                          dim pos as Vertex

                          dim final_term as Vertex

                          dim term1 as Vertex

                          dim term2 as Vertex

                          dim term3 as Vertex

                          term1=multiply_vertex(P1,2.00)+(-P0+P2)*time

                          term2=(multiply_vertex(P0,2.00)-
multiply_vertex(P1,5.00)+multiply_vertex(P2,4.00)-P3)*time*time

                          term3=(-P0+multiply_vertex(P1,3.00)-
multiply_vertex(P3,3.00)+P3)*time*time*time

                          final_term=term1+term2+term3

                          spline=multiply_vertex(final_term,0.5)
end function
‘---------------------------------------------------------------------
‘helpers
function multiply_vertex(P as Vertex,multiplier as Double) as Vertex

                          multiply_vertex.x=P.x*multiplier
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                          multiply_vertex.y=P.y*multiplier

                          multiply_vertex.z=P.z*multiplier
end function

See Also

• Callback Procedures

• Global Procedures

• Array[Type]

• Boolean

• Container

• Double

• Integer

• String

• Vertex

18.12.10 Planets

dim MAXNUM, NUM as Integer
dim MAXMASS, G, POS1X, POS1Z as Double
MAXNUM = 40
NUM = 9
MAXMASS = 1000000
G = 0.006674
POS1X = 0
POS1Z = 0
structure Planet

                          rx, ry, vx, vy, mass as Double
end structure
dim planetContainers as Array[Container]
dim masses as Array[Planet]
dim lastPlanetIndex as Integer
sub OnInit()

                          dim c as Container

                          dim i as Integer

                          dim dx, dy, r, v as Double

                          c = ChildContainer

                          do while c <> null

                          
                          planetContainers.push c

                          
                          c = c.NextContainer
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                          loop

                          masses.size = planetContainers.size

                          lastPlanetIndex = planetContainers.size - 1

                          if lastPlanetIndex < 0 then exit sub

                          ‘ the sun

                          masses[0].rx = 0.0

                          masses[0].ry = 0.0

                          masses[0].vx = 2.0

                          masses[0].vy = 0.0

                          masses[0].mass = 300000000

                          ‘ the planets

                          for i = 1 to lastPlanetIndex

                          
                          dx = random() * 20000.0 - 10000.0

                          
                          dy = random() * 20000.0 - 10000.0

                          
                          if dx <= 0.0 and dx > -500.0 then dx = -500.0

                          
                          if dx >  0.0 and dx <  500.0 then dx =  500.0

                          
                          if dy <= 0.0 and dy > -500.0 then dy = -500.0

                          
                          if dy >  0.0 and dy <  500.0 then dy = 500.0

                          
                          masses[i].rx = POS1X + dx

                          
                          masses[i].ry = POS1Z + dy

                          
                          r = sqrt(dx * dx + dy * dy)

                          
                          masses[i].mass = random() * MAXMASS

                          
                          v = sqrt(G * masses[0].mass / r)
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                          masses[i].vx = dy / r * v

                          
                          masses[i].vy = -dx / r * v

                          next
end sub
sub OnExecPerField()

                          dim ax, az, ar, r2, dx, dy as Double

                          dim i, j as Integer

                          for i = 0 to lastPlanetIndex

                          
                          planetContainers[i].position.x = masses[i].rx *
 0.01

                          
                          planetContainers[i].position.y = masses[i].ry *
 0.01

                          next

                          ‘ calculate new velocities

                          for i = 0 to lastPlanetIndex

                          
                          ax = 0

                          
                          az = 0

                          
                          for j = 0 to lastPlanetIndex

                          
                          
                          if j <> i then

                          
                          
                          
                          dx = masses[j].rx - masses[i].rx

                          
                          
                          
                          dy = masses[j].ry - masses[i].ry
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                          r2 = dx*dx + dy*dy

                          
                          
                          
                          ar = masses[j].mass / (r2 * sqrt(r2))

                          
                          
                          
                          ax += ar * dx

                          
                          
                          
                          az += ar * dy

                          
                          
                          end if

                          
                          next

                          
                          masses[i].vx += ax * G

                          
                          masses[i].vy += az * G

                          next

                          ‘ calculate new positions

                          for i = 0 to lastPlanetIndex

                          
                          masses[i].rx += masses[i].vx

                          
                          masses[i].ry += masses[i].vy

                          next
end sub

See Also

• Callback Procedures

• Global Procedures

• Array[Type]

• Boolean

• Container

• Integer
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18.12.11 Tetris

This script example creates the classical game of Tetris using Viz Engine scripting and
graphics.

dim HEIGHT, WIDTH, TOTAL, NUM_BRICKS as Integer
dim currentBrick, currentRot, counter as Integer
dim xpos, ypos as Integer ' position of the falling brick
dim squares as Array[integer]
dim squareContainers as Array[Container]
dim bricks as Array[String]
HEIGHT = 15
WIDTH = 9
TOTAL = HEIGHT * WIDTH
squares.size = TOTAL
sub OnInit()

                          dim i, j as Integer

                          ‘ 0100

                          ‘ 0100

                          ‘ 0100

                          ‘ 0100

                          bricks.push("0100010001000100")

                          bricks.push("0000111100000000")

                          bricks.push("0100010001000100")

                          bricks.push("0000111100000000")

                          ‘ 0000

                          ‘ 0000

                          ‘ 0110

                          ‘ 0110

                          bricks.push("0000000001100110")

                          bricks.push("0000000001100110")
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                          bricks.push("0000000001100110")

                          bricks.push("0000000001100110")

                          ‘ 0000

                          ‘ 0100

                          ‘ 0110

                          ‘ 0010

                          bricks.push("0000010001100010")

                          bricks.push("0000000001101100")

                          bricks.push("0000010001100010")

                          bricks.push("0000000001101100")

                          ‘ 0000

                          ‘ 0010

                          ‘ 0110

                          ‘ 0100

                          bricks.push("0000001001100100")

                          bricks.push("0000000011000110")

                          bricks.push("0000001001100100")

                          bricks.push("0000000011000110")

                          ‘ 0000

                          ‘ 0110

                          ‘ 0010

                          ‘ 0010

                          bricks.push("0000011000100010")

                          bricks.push("0000001011100000")

                          bricks.push("0100010001100000")

                          bricks.push("0000011101000000")

                          ‘ 0000

                          ‘ 0110
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                          ‘ 0100

                          ‘ 0100

                          bricks.push("0000011001000100")

                          bricks.push("0000111000100000")

                          bricks.push("0010001001100000")

                          bricks.push("0000010001110000")

                          ‘ 0000

                          ‘ 0000

                          ‘ 1110

                          ‘ 0100

                          bricks.push("0000000011100100")

                          bricks.push("0000010011000100")

                          bricks.push("0000010011100000")

                          bricks.push("0000010001100100")

                          NUM_BRICKS = bricks.size / 4

                          deleteGeometry

                          update

                          deleteChildren

                          dim blocksGroup as Container

                          blocksGroup = addContainer(TL_DOWN)

                          open = false

                          for i=0 to HEIGHT-1

                          
                          for j=0 to WIDTH-1

                          
                          
                          dim b as Container

                          
                          
                          if i >= 3 then
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                          b = blocksGroup.addContainer(TL_DOWN)

                          
                          
                          
                          b.createMaterial

                          
                          
                          
                          b.name = "f_" & j & "_" & i

                          
                          
                          
                          b.createGeometry("BUILT_IN*GEOM*Cube")

                          
                          
                          
                          b.scaling.xyz = 0.1

                          
                          
                          
                          b.position.x = (j-WIDTH/2.0+0.5) * 10.0

                          
                          
                          
                          b.position.y = - (i-HEIGHT/2.0-1.0) * 10.0

                          
                          
                          end if

                          
                          
                          squareContainers.push(b)

                          
                          next

                          next

                          initGame
end sub
sub display()

                          dim i, j, index, fb as Integer

                          dim fc as Container
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                          for i=3 to HEIGHT-1

                          
                          for j=0 to WIDTH-1

                          
                          
                          index = i * WIDTH + j

                          
                          
                          fb = squares[index]

                          
                          
                          fc = squareContainers[index]

                          
                          
                          if fb = 0 then

                          
                          
                          
                          fc.active = false

                          
                          
                          else

                          
                          
                          
                          fc.active = true

                          
                          
                          
                          if fb = 1 then

                          
                          
                          
                          
                          fc.material.diffuse = CColor(60.0, 60.0, 60.0)

                          
                          
                          
                          elseif fb = 3 then

                          
                          
                          
                          
                          fc.material.diffuse = CColor(30.0, 30.0, 30.0)
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                          else

                          
                          
                          
                          
                          fc.material.diffuse = CColor(40.0, 0.0, 80.0)

                          
                          
                          
                          end if

                          
                          
                          end if

                          
                          next

                          next
end sub
sub initGame()

                          dim i as Integer

                          for i=0 to TOTAL-1

                          
                          squares[i] = 0

                          next

                          for i=0 to HEIGHT-1

                          
                          squares[WIDTH*i] = 3

                          
                          squares[WIDTH*i + WIDTH-1] = 3

                          next

                          for i=TOTAL-WIDTH to TOTAL-1

                          
                          squares[i] = 3

                          next

                          newBrick
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                          display
end sub
sub newBrick()

                          xpos = WIDTH / 2 - 2

                          ypos = -1

                          counter = 0

                          currentBrick = random(NUM_BRICKS)

                          currentRot = 0
end sub
sub clear2()

                          ‘ clear the squares occupied by the falling
 brick

                          dim i as Integer

                          for i=0 to TOTAL-1

                          
                          if squares[i] = 2 then

                          
                          
                          squares[i] = 0

                          
                          end if

                          next
end sub
function drawBrick(x as Integer, y as Integer, rot as Integer, fill as
 Integer) as Boolean

                          dim b as string

                          dim index, i, xb, yb, x2, y2 as Integer

                          clear2

                          b = bricks[currentBrick * 4 + rot]

                          for i=0 to 15

                          
                          xb = i mod 4

                          
                          yb = i / 4

                          
                          if b.getChar(i) = "1" then
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                          x2 = x + xb

                          
                          
                          y2 = y + yb

                          
                          
                          if y2 >= 0 then

                          
                          
                          
                          index = y2 * WIDTH + x2

                          
                          
                          
                          if x2 < 0 or x2 >= WIDTH or y2 >= HEIGHT or
 squares[index] <> 0 then

                          
                          
                          
                          
                          drawBrick = false ‘ collision

                          
                          
                          
                          
                          exit function

                          
                          
                          
                          elseif y2 >= 3 or fill <> 1 then

                          
                          
                          
                          
                          squares[index] = fill

                          
                          
                          
                          end if

                          
                          
                          end if
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                          end if

                          next

                          drawBrick = true ‘ no collision
end function
function isLineFilled(line as Integer) as Boolean

                          dim i, index as Integer

                          index = WIDTH * line

                          for i=0 to WIDTH-1

                          
                          if squares[index+i] = 0 then

                          
                          
                          isLineFilled = false

                          
                          
                          exit function

                          
                          end if

                          next

                          isLineFilled = true
end function
sub eraseFullLines()

                          dim line, l2, r as Integer

                          for line = HEIGHT - 2 to 0 step -1

                          
                          if isLineFilled(line) then

                          
                          
                          ‘ move lines one line down

                          
                          
                          for l2 = line to 0 step -1

                          
                          
                          
                          for r=0 to WIDTH-1
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                          squares[l2*WIDTH+r] = squares[(l2-1)*WIDTH+r]

                          
                          
                          
                          next

                          
                          
                          next

                          
                          
                          ‘ clear top line

                          
                          
                          for r=1 to WIDTH-2

                          
                          
                          
                          squares[r] = 0

                          
                          
                          next

                          
                          
                          line++ ‘ test the same line again

                          
                          end if

                          next
end sub
sub OnKeyDown(keyCode as Integer)

                          dim x, y, r as Integer

                          x = xpos

                          y = ypos

                          r = currentRot

                          if keyCode = KEY_RIGHT then

                          
                          x++

                          elseif keyCode = KEY_LEFT then
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                          x--

                          elseif keyCode = KEY_DOWN then

                          
                          y++

                          elseif keyCode = KEY_S then

                          
                          initGame

                          
                          exit sub

                          elseif keyCode = KEY_CONTROL then

                          
                          r = (r + 1) mod 4

                          end if

                          if r <> currentRot then

                          
                          if drawBrick(x, y, r, 2) then

                          
                          
                          currentRot = r

                          
                          elseif drawBrick(x-1, y, r, 2) then

                          
                          
                          xpos = x - 1

                          
                          
                          currentRot = r

                          
                          elseif drawBrick(x+1, y, r, 2) then

                          
                          
                          xpos = x + 1

                          
                          
                          currentRot = r
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                          else

                          
                          
                          drawBrick(xpos, ypos, currentRot, 2)

                          
                          end if

                          elseif x <> xpos or y <> ypos then

                          
                          if drawBrick(x, y, r, 2) then

                          
                          
                          xpos = x

                          
                          
                          ypos = y

                          
                          else

                          
                          
                          drawBrick(xpos, ypos, currentRot, 2)

                          
                          end if

                          end if

                          display
end sub
sub OnExecPerField()

                          counter++

                          if counter > 30 then

                          
                          counter = 0

                          
                          if drawBrick(xpos, ypos + 1, currentRot, 2)
 then

                          
                          
                          ypos++

                          
                          else
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                          ‘ we hit the bottom

                          
                          
                          drawBrick xpos, ypos, currentRot, 1

                          
                          
                          eraseFullLines

                          
                          
                          newBrick

                          
                          end if

                          
                          display

                          end if
end sub

See Also

• Callback Procedures

• Global Procedures

• Array[Type]

• Boolean

• Container

• Integer

• String

18.12.12 Clip Channel

‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
structure SClipInstance

                          oClipChannel              as ClipChannel

                          iClipChannelID            as Integer

                          bLiveUpdate               as Boolean

                          szShmKeyModeChanged       as String

                          szShmKeyFrameChanged      as String

                          bAutoRun                  as Boolean



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 973

                          bLoopMode                 as Boolean

                          bReverseFields            as Boolean

                          iRepeatMode               as Integer

                          iModeOnLoadError          as Integer

                          dPlaybackSpeed            as Double

                          iMode                     as Integer

                          szClipName                as String

                          szClipNameToLoad          as String  
                        

                          iDuration                 as Integer

                          iCurrentFrame             as Integer

                          iFrameIn                  as Integer

                          iFrameOut                 as Integer
end structure
dim oClip   as Array[SClipInstance]
dim iClip   as Integer = 0
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub OnInit()

                          println( "OnInit()" )

                          println( "channel=" &
 GetParameterInt( "channel" ) )

                          dim iNumberOfClipChannels =
 system.GetNumberOfClipChannel()

                          for i = 0 to iNumberOfClipChannels

                          
                          ClipPlayerInitializeClipChannel( i )

                          next

                          iClip = 0
end sub
dim kButtonStop     as Integer = 0
dim kButtonPlay     as Integer = 1
dim kButtonPause    as Integer = 2
dim kButtonContinue as Integer = 3
dim kButtonFlush    as Integer = 4
dim kButtonLoad     as Integer = 5
‘--------------------------------------------------------------------
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‘
‘ --------------------------------------------------------------------
sub OnInitParameters()

                          println( "OnInitParameters()" )

                          dim clip_channel_entries as Array[String]

                          clip_channel_entries.push( "Clip Channel 1" )

                          clip_channel_entries.push( "Clip Channel 2" )

                          RegisterParameterDropDown("channel","Clip
 Channel", 0,clip_channel_entries, 20, 2)

                          RegisterFileSelector( "file", "Browse
 Filename", "D:/clips", "", "*.avi *.dv *.mov")

                          RegisterPushButton( "cmd_load",     "Load
 Clip", kButtonLoad )

                          RegisterPushButton( "cmd_stop",     "Stop",    
 kButtonStop )

                          RegisterPushButton( "cmd_play",     "Play",    
 kButtonPlay )

                          RegisterPushButton( "cmd_pause",    "Pause",   
 kButtonPause )

                          RegisterPushButton( "cmd_continue", "Continue",
 kButtonContinue )

                          RegisterPushButton( "cmd_flush",    "Flush",   
 kButtonFlush )

                          RegisterParameterBool  ( "live_update",    
 "Live Update",  false )

                          RegisterParameterString( "status_mode",    
 "Current Mode", "", 20, 20, "?" )

                          RegisterParameterInt   ( "status_duration",
 "Duration (frames)", 0, 0, 2000000000 )

                          RegisterParameterBool( "auto_run",       "Auto
 Run",       false )

                          RegisterParameterBool( "loop_mode",      "Loop
 Mode",      true  )

                          RegisterParameterBool( "reverse_fields",
 "Reverse Fields", false )

                          dim repeat_mode_entries as Array[String]
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                          repeat_mode_entries.push( "none" )

                          repeat_mode_entries.push( "field" )

                          repeat_mode_entries.push( "frame" )

                          RegisterParameterDropDown("repeat_mode","Repeat
 Mode", 1, repeat_mode_entries, 20, 3 )

                          dim mode_on_load_error_entries as Array[String]

                          mode_on_load_error_entries.push( "none" )

                          mode_on_load_error_entries.push( "pause" )

                          mode_on_load_error_entries.push( "stop" )

                          mode_on_load_error_entries.push( "flush" )

                         
 RegisterParameterDropDown("mode_on_load_error","Mode on Load Error", 0,
 mode_on_load_error_entries, 20, 4 )

                          RegisterParameterDouble("speed", "Speed",
 1,-2.00,2.00)

                          RegisterParameterInt("currentframe", "Current
 Frame", 0, 0, 2000000000)

                          RegisterParameterInt("framein", "Frame In", 0,
 0, 2000000000)

                          RegisterParameterInt("frameout", "Frame Out",
 0, 0, 2000000000)
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub OnParameterChanged( parameterName as String )

                          println( "OnParameterChanged: " &
 parameterName )

                          if parametername.StartsWith( "status_" ) then
 exit sub

                          if oClip[iClip].iMode <> 2 then    
 println( "OnParameterChanged: " & parameterName )

                          dim cmd as string

                          if "channel" == parameterName  then

                          
                         
 ClipPlayerChangeClipChannel( GetParameterInt( parameterName ))
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                          elseif "file" == parameterName then

                          
                          oClip[iClip].szClipNameToLoad =
 GetParameterString( parameterName )

                          elseif "auto_run" == parameterName then

                          
                         
 ClipPlayerSetAutoRun( GetParameterBool( parameterName ))

                          elseif "loop_mode" == parameterName then

                          
                         
 ClipPlayerSetLoopMode( GetParameterBool( parameterName ))

                          elseif "reverse_fields" == parameterName then

                          
                         
 ClipPlayerSetReverseFields( GetParameterBool( parameterName ))

                          elseif "repeat_mode" == parameterName then

                          
                         
 ClipPlayerSetRepeatMode( GetParameterInt( parameterName ))

                          elseif "mode_on_load_error" == parameterName
 then

                          
                         
 ClipPlayerSetModeOnLoadError( GetParameterInt( parameterName ))

                          elseif "speed" == parameterName then

                          
                         
 ClipPlayerSetPlaybackSpeed( GetParameterDouble( parameterName ))

                          elseif "currentframe" == parameterName then

                          
                         
 ClipPlayerScrub( GetParameterInt( parameterName ))

                          elseif "framein" == parameterName then

                          
                         
 ClipPlayerSetFrameIn( GetParameterInt( parameterName ))
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                          elseif "frameout" == parameterName then

                          
                         
 ClipPlayerSetFrameOut( GetParameterInt( parameterName ))

                          elseif "live_update" == parameterName then

                          
                         
 ClipPlayerSetLiveUpdate( GetParameterBool( parameterName ))

                          end if
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub OnExecAction( buttonId as Integer )

                          println("Pressed button: "&buttonId )

                          if kButtonLoad == buttonId then

                          
                         
 ClipPlayerSetClipName( oClip[iClip].szClipNameToLoad )

                          elseif kButtonStop == buttonId then

                          
                          ClipPlayerStop()

                          elseif kButtonPlay == buttonId then

                          
                          ClipPlayerPlay()

                          elseif kButtonPause == buttonId then

                          
                          ClipPlayerPause()

                          elseif kButtonContinue == buttonId then

                          
                          ClipPlayerContinue()

                          elseif kButtonFlush == buttonId then

                          
                          ClipPlayerFlush()

                          end if
end sub
‘--------------------------------------------------------------------
‘
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‘ --------------------------------------------------------------------
sub OnSharedMemoryVariableChanged( map as SharedMemory, mapKey as
 String )

                          \q Remove this as soon as shared memory is
 working.

                          println( "shared memory variable: " & mapKey &
 " changed" )

                          \qexit sub

                          if mapKey == oClip[iClip].szShmKeyModeChanged
 then

                          
                          oClip[iClip].iMode = CInt( map[ mapKey ] )

                          
                          UpdateAllFromClipPlayer( false )

                          elseif mapKey ==
 oClip[iClip].szShmKeyFrameChanged then

                          
                          oClip[iClip].iCurrentFrame =
 CInt( map[ mapKey ] )

                          
                          ClipPlayerChangedFrame()

                          else

                          
                          println( "shared memory variable: " & mapKey &
 " changed to:" & map[ mapKey ] )

                          end if
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ModeToString(mode as Integer) as string

                          if mode == 0 then

                          
                          ModeToString = "none"

                          elseif mode == 1 then

                          
                          ModeToString = "stopped"

                          elseif mode == 2 then
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                          ModeToString = "playing"

                          elseif mode == 3 then

                          
                          ModeToString = "scrubbing"

                          elseif mode == 4 then

                          
                          ModeToString = "ERROR"

                          elseif mode == 5 then

                          
                          ModeToString = "playcont"

                          else

                          
                          ModeToString = IntToString(mode, 1)

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub UpdateAllFromClipPlayer( bDoGuiAlways as Boolean )

                          if oClip[iClip].oClipChannel.VizId <= 0 then
 exit sub

                          if ClipPlayerGetAutoRun() OR bDoGuiAlways then

                          
                         
 this.scriptPlugininstance.SetParameterBool("auto_run",
 oClip[iClip].bAutoRun )

                          end if

                          if ClipPlayerGetLoopMode() OR bDoGuiAlways then

                          
                         
 this.scriptPlugininstance.SetParameterBool( "loop_mode",
 oClip[iClip].bLoopMode )

                          end if

                          if ClipPlayerGetReverseFields() OR bDoGuiAlways
 then
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 this.scriptPlugininstance.SetParameterBool( "reverse_fields",
 oClip[iClip].bReverseFields )

                          end if

                          if ClipPlayerGetRepeatMode() OR bDoGuiAlways
 then

                          
                         
 this.scriptPlugininstance.SetParameterInt( "repeat_mode",
 oClip[iClip].iRepeatMode )

                          end if

                          if ClipPlayerGetModeOnLoadError() OR
 bDoGuiAlways then

                          
                         
 this.scriptPlugininstance.SetParameterInt( "mode_on_load_error",
 oClip[iClip].iModeOnLoadError )

                          end if

                          if ClipPlayerGetPlayBackSpeed() OR bDoGuiAlways
 then

                          
                         
 this.scriptPlugininstance.SetParameterDouble( "speed",
 oClip[iClip].dPlayBackSpeed )

                          end if

                          if ClipPlayerGetFrameIn() OR bDoGuiAlways then

                          
                         
 this.scriptPlugininstance.SetParameterInt( "framein",
 oClip[iClip].iFrameIn )

                          end if

                          if ClipPlayerGetFrameOut() OR bDoGuiAlways then

                          
                         
 this.scriptPlugininstance.SetParameterInt( "frameout",
 oClip[iClip].iFrameOut )

                          end if

                          if ClipPlayerGetClipName() OR bDoGuiAlways then
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 this.scriptPlugininstance.SetParameterString( "file",
 oClip[iClip].szClipName )

                          end if

                         
 this.scriptPlugininstance.SetParameterString( "status_mode",
 ModeToString( oClip[iClip].iMode ))

                          oClip[iClip].iDuration =
 oClip[iClip].oClipChannel.Duration

                         
 this.scriptPlugininstance.SetParameterInt( "status_duration",
 oClip[iClip].iDuration )

                          if NOT oClip[iClip].bLiveUpdate then

                          
                          dim iCurrentFrame as Integer =
 oClip[iClip].oClipChannel.CurrentFrame

                          
                          if iCurrentFrame <> oClip[iClip].iCurrentFrame
 then

                          
                          
                          oClip[iClip].iCurrentFrame =
 oClip[iClip].oClipChannel.CurrentFrame

                          
                          
                         
 this.scriptPlugininstance.SetParameterInt( "currentframe",
 oClip[iClip].iCurrentFrame )

                          
                          end if

                          end if

                          SendGuiRefresh()
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerChangedFrame()

                          if oClip[iClip].oClipChannel.VizId <= 0 then
 exit sub

                          if oClip[iClip].bLiveUpdate then
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 this.scriptPlugininstance.SetParameterInt( "currentframe",
 oClip[iClip].iCurrentFrame )

                          
                          SendGuiRefresh()

                          end if
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerInitializeClipChannel( iClipChannel as Integer )

                          dim oClipInst   as SClipInstance

                          iClip = iClipChannel

                          oClipInst.oClipChannel =
 system.GetClipChannel( iClip )

                          oClipInst.iClipChannelID =
 oClipInst.oClipChannel.ClipChannelID

                          oClipInst.bLiveUpdate = false

                          println( "[" & iClip & "]iClipChannelID=" &
 oClipInst.iClipChannelID     )

                          println( "[" & iClip & "]object id:=" &
 oClipInst.oClipChannel.VizId )

                          oClip.push( oClipInst )

                          ClipPlayerGetRegisteredChangedClipModeKey()

                          ClipPlayerCreateChangedClipModeKey()

                          ClipPlayerGetRegisteredChangedClipFrameKey()

                          ClipPlayerCreateChangedClipFrameKey()

                          ClipPlayerGetCurrentMode()

                          ClipPlayerGetCurrentFrame()

                          UpdateAllFromClipPlayer( true )
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerChangeClipChannel( iClipChannel as Integer )

                          if oClip[iClip].bLiveUpdate then
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                          ClipPlayerUnRegisterChanges()

                          end if

                          iClip = iClipChannel

                          ClipPlayerGetCurrentMode()

                          ClipPlayerGetCurrentFrame()

                          UpdateAllFromClipPlayer( true )

                          if oClip[iClip].bLiveUpdate then

                          
                          ClipPlayerRegisterChanges()

                          end if
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerGetRegisteredChangedClipModeKey()

                          if oClip[iClip].oClipChannel.VizId <= 0 then
 exit sub

                          oClip[iClip].szShmKeyModeChanged =
 oClip[iClip].oClipChannel.GetRegisterChangedClipMode()

                          println( "[" & iClip &
 "]GetRegisterChangedClipMode()=" & oClip[iClip].szShmKeyModeChanged )
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerGetRegisteredChangedClipFrameKey()

                          if oClip[iClip].oClipChannel.VizId == 0 then
 exit sub

                          oClip[iClip].szShmKeyFrameChanged =
 oClip[iClip].oClipChannel.GetRegisterChangedClipFrame()

                          println( "[" & iClip &
 "]GetRegisterChangedClipFrame()=" & oClip[iClip].szShmKeyFrameChanged )
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerCreateChangedClipModeKey()

                          if oClip[iClip].szShmKeyModeChanged.length == 0
 then
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                          oClip[iClip].szShmKeyModeChanged =
 "com.vizrt.clip" & IntToString( oClip[iClip].iClipChannelID , 1 ) &
 ".mode"

                          end if

                          dim oShmMap as SharedMemory

                          if
 Scene.Map.ContainsKey( oClip[iClip].szShmKeyModeChanged ) then

                          
                          oShmMap = Scene.Map

                          elseif
 System.Map.ContainsKey( oClip[iClip].szShmKeyModeChanged ) then

                          
                          oShmMap = System.Map

                          else

                          
                          oShmMap = Scene.Map

                          
                         
 oShmMap.CreateKey( oClip[iClip].szShmKeyModeChanged )

                          end if

                          \q
 oClip.oClipChannel.RegisterChangedClipMode( oClip[iClip].szShmKeyModeChanged )

                         
 oShmMap.RegisterChangedCallback( oClip[iClip].szShmKeyModeChanged )
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerCreateChangedClipFrameKey()

                          if oClip[iClip].szShmKeyFrameChanged.length ==
 0 then

                          
                          oClip[iClip].szShmKeyFrameChanged =
 "com.vizrt.clip" & IntToString( oClip[iClip].iClipChannelID , 1 ) &
 ".frame"

                          end if

                          dim oShmMap as SharedMemory
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                          if
 Scene.Map.ContainsKey( oClip[iClip].szShmKeyFrameChanged ) then

                          
                          oShmMap = Scene.Map

                          elseif
 System.Map.ContainsKey( oClip[iClip].szShmKeyFrameChanged ) then

                          
                          oShmMap = System.Map

                          else

                          
                          oShmMap = Scene.Map

                          
                         
 oShmMap.CreateKey( oClip[iClip].szShmKeyFrameChanged )

                          end if

                          \q
 oClip[iClip].oClipChannel.RegisterChangedClipFrame( oClip[iClip].szShmKeyFrameChanged )

                         
 oShmMap.RegisterChangedCallback( oClip[iClip].szShmKeyFrameChanged )
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerSetClipName( szClipName as String ) as Boolean

                          \q if oClip[iClip].szClipName <> szClipName
 then

                          
                          oClip[iClip].szClipName = szClipName

                          
                         
 oClip[iClip].oClipChannel.SetClipName( oClip[iClip].szClipName )

                          
                          ClipPlayerSetClipName = true

                          
                          println( "[" & iClip & "]SetClipName(" &
 oClip[iClip].szClipName & ")" )

                          \q else

                          
                          \q ClipPlayerSetClipName = false
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                          \q end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetClipName() as Boolean

                          dim szClipName as String =
 oClip[iClip].oClipChannel.GetClipName()

                          if oClip[iClip].szClipName <> szClipName then

                          
                          oClip[iClip].szClipName = szClipName

                          
                          ClipPlayerGetClipName = true

                          
                          println( "[" & iClip & "]GetClipName=" &
 oClip[iClip].szClipName 

                          else

                          
                          ClipPlayerGetClipName = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerSetAutoRun( bAutoRun as Boolean ) as Boolean

                          if oClip[iClip].bAutoRun <> bAutoRun then

                          
                          oClip[iClip].bAutoRun = bAutoRun

                          
                          oClip[iClip].oClipChannel.AutoRun =
 oClip[iClip].bAutoRun

                          
                          ClipPlayerSetAutoRun = true

                          
                          println( "[" & iClip & "]SetAutoRun(" &
 oClip[iClip].bAutoRun & ")" )

                          else

                          
                          ClipPlayerSetAutoRun = false

                          end if
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end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetAutoRun() as Boolean

                          dim bAutoRun as Boolean =
 oClip[iClip].oClipChannel.AutoRun

                          if oClip[iClip].bAutoRun <> bAutoRun then

                          
                          oClip[iClip].bAutoRun = bAutoRun

                          
                          ClipPlayerGetAutoRun = true

                          
                          println( "[" & iClip & "]GetAutoRun=" &
 oClip[iClip].bAutoRun )

                          else

                          
                          ClipPlayerGetAutoRun = false

                          end if

                          end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerSetLoopMode( bLoopMode as Boolean ) as Boolean

                          if oClip[iClip].bLoopMode <> bLoopMode then

                          
                          oClip[iClip].bLoopMode = bLoopMode

                          
                          oClip[iClip].oClipChannel.LoopMode =
 oClip[iClip].bLoopMode

                          
                          ClipPlayerSetLoopMode = true

                          
                          println( "[" & iClip & "]SetLoopMode(" &
 oClip[iClip].bLoopMode & ")" )

                          else

                          
                          ClipPlayerSetLoopMode = false

                          end if
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end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetLoopMode() as Boolean

                          dim bLoopMode as Boolean =
 oClip[iClip].oClipChannel.LoopMode

                          if oClip[iClip].bLoopMode <> bLoopMode then

                          
                          oClip[iClip].bLoopMode = bLoopMode

                          
                          ClipPlayerGetLoopMode = true

                          
                          println( "[" & iClip & "]GetLoopMode=" &
 oClip[iClip].bLoopMode )

                          else

                          
                          ClipPlayerGetLoopMode = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerSetReverseFields( bReverseFields as Boolean ) as
 Boolean

                          if oClip[iClip].bReverseFields <>
 bReverseFields then

                          
                          oClip[iClip].bReverseFields = bReverseFields

                          
                          oClip[iClip].oClipChannel.ReverseFields =
 oClip[iClip].bReverseFields

                          
                          ClipPlayerSetReverseFields = true

                          
                          println( "[" & iClip & "]SetReverseFields(" &
 oClip[iClip].bReverseFields & ")" )

                          else

                          
                          ClipPlayerSetReverseFields = false
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                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetReverseFields() as Boolean

                          dim bReverseFields as Boolean =
 oClip[iClip].oClipChannel.ReverseFields

                          if oClip[iClip].bReverseFields <>
 bReverseFields then

                          
                          oClip[iClip].bReverseFields = bReverseFields

                          
                          ClipPlayerGetReverseFields = true

                          
                          println( "[" & iClip & "]GetReverseFields=" &
 oClip[iClip].bReverseFields )

                          else

                          
                          ClipPlayerGetReverseFields = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerSetRepeatMode( iRepeatMode as Integer ) as Boolean

                          if oClip[iClip].iRepeatMode <> iRepeatMode then

                          
                          oClip[iClip].iRepeatMode = iRepeatMode

                          
                          oClip[iClip].oClipChannel.RepeatMode =
 oClip[iClip].iRepeatMode

                          
                          ClipPlayerSetRepeatMode = true

                          
                          println( "[" & iClip & "]SetRepeatMode(" &
 oClip[iClip].iRepeatMode & ")" )

                          else

                          
                          ClipPlayerSetRepeatMode = false
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                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetRepeatMode() as Boolean

                          dim iRepeatMode as Integer =
 oClip[iClip].oClipChannel.RepeatMode

                          if oClip[iClip].iRepeatMode <> iRepeatMode then

                          
                          oClip[iClip].iRepeatMode = iRepeatMode

                          
                          ClipPlayerGetRepeatMode = true

                          
                          println( "[" & iClip & "]GetRepeatMode=" &
 oClip[iClip].iRepeatMode )

                          else

                          
                          ClipPlayerGetRepeatMode = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerSetModeOnLoadError( iModeOnLoadError as Integer ) as
 Boolean

                          if oClip[iClip].iModeOnLoadError <>
 iModeOnLoadError then

                          
                          oClip[iClip].iModeOnLoadError =
 iModeOnLoadError

                          
                          oClip[iClip].oClipChannel.ModeOnLoadError =
 oClip[iClip].iModeOnLoadError

                          
                          ClipPlayerSetModeOnLoadError = true

                          
                          println( "[" & iClip & "]SetModeOnLoadError(" &
 oClip[iClip].iModeOnLoadError & ")" )

                          else
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                          ClipPlayerSetModeOnLoadError = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetModeOnLoadError() as Boolean

                          dim iModeOnLoadError as Integer =
 oClip[iClip].oClipChannel.ModeOnLoadError

                          if oClip[iClip].iModeOnLoadError <>
 iModeOnLoadError then

                          
                          oClip[iClip].iModeOnLoadError =
 iModeOnLoadError

                          
                          ClipPlayerGetModeOnLoadError = true

                          
                          println( "[" & iClip & "]GetModeOnLoadError=" &
 oClip[iClip].iModeOnLoadError )

                          else

                          
                          ClipPlayerGetModeOnLoadError = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerSetPlayBackSpeed( dPlaybackSpeed as Double ) as
 Boolean

                          if oClip[iClip].dPlaybackSpeed <>
 dPlaybackSpeed then

                          
                          oClip[iClip].dPlaybackSpeed = dPlaybackSpeed

                          
                          oClip[iClip].oClipChannel.PlayBackSpeed =
 oClip[iClip].dPlaybackSpeed

                          
                          ClipPlayerSetPlayBackSpeed = true

                          println( "[" & iClip & "]SetPlayBackSpeed(" &
 oClip[iClip].dPlaybackSpeed & ")" )

                          else
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                          ClipPlayerSetPlayBackSpeed = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetPlayBackSpeed() as Boolean

                          dim dPlaybackSpeed as Double =
 oClip[iClip].oClipChannel.PlayBackSpeed

                          if oClip[iClip].dPlaybackSpeed <>
 dPlaybackSpeed then

                          
                          oClip[iClip].dPlaybackSpeed = dPlaybackSpeed

                          
                          ClipPlayerGetPlayBackSpeed = true

                          
                          println( "[" & iClip & "]GetPlayBackSpeed=" &
 oClip[iClip].dPlaybackSpeed )

                          else

                          
                          ClipPlayerGetPlayBackSpeed = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerSetFrameIn( iFrameIn as Integer ) as Boolean

                          if oClip[iClip].iFrameIn <> iFrameIn then

                          
                          oClip[iClip].iFrameIn = iFrameIn

                          
                          oClip[iClip].oClipChannel.FrameIn =
 oClip[iClip].iFrameIn

                          
                          ClipPlayerSetFrameIn = true

                          
                          println( "[" & iClip & "]SetFrameIn(" &
 oClip[iClip].iFrameIn & ")" )

                          else
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                          ClipPlayerSetFrameIn = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetFrameIn() as Boolean

                          dim iFrameIn as Integer =
 oClip[iClip].oClipChannel.FrameIn

                          if oClip[iClip].iFrameIn <> iFrameIn then

                          
                          oClip[iClip].iFrameIn = iFrameIn

                          
                          ClipPlayerGetFrameIn = true

                          
                          println( "[" & iClip & "]GetFrameIn=" &
 oClip[iClip].iFrameIn )

                          else

                          
                          ClipPlayerGetFrameIn = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerSetFrameOut( iFrameOut as Integer ) as Boolean

                          if oClip[iClip].iFrameOut <> iFrameOut then

                          
                          oClip[iClip].iFrameOut = iFrameOut

                          
                          oClip[iClip].oClipChannel.FrameOut =
 oClip[iClip].iFrameOut

                          
                          ClipPlayerSetFrameOut = true

                          
                          println( "[" & iClip & "]SetFrameOut(" &
 oClip[iClip].iFrameOut & ")" )

                          else
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                          ClipPlayerSetFrameOut = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetFrameOut() as Boolean

                          dim iFrameOut as Integer =
 oClip[iClip].oClipChannel.FrameOut

                          if oClip[iClip].iFrameOut <> iFrameOut then

                          
                          oClip[iClip].iFrameOut = iFrameOut

                          
                          ClipPlayerGetFrameOut = true

                          
                          println( "[" & iClip & "]GetFrameOut=" &
 oClip[iClip].iFrameOut )

                          else

                          
                          ClipPlayerGetFrameOut = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetCurrentMode() as Boolean

                          dim iMode as Integer =
 oClip[iClip].oClipChannel.PlayMode

                          if oClip[iClip].iMode <> iMode then

                          
                          oClip[iClip].iMode = iMode

                          
                          ClipPlayerGetCurrentMode = true

                          
                          println( "[" & iClip & "]GetCurrentMode=" &
 oClip[iClip].iMode & ")" )

                          else

                          
                          ClipPlayerGetCurrentMode = false
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                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerGetCurrentFrame() as Boolean

                          dim iCurrentFrame as Integer =
 oClip[iClip].oClipChannel.CurrentFrame

                          if oClip[iClip].iCurrentFrame <> iCurrentFrame
 then

                          
                          oClip[iClip].iCurrentFrame = iCurrentFrame

                          
                          ClipPlayerGetCurrentFrame = true

                          
                          println( "[" & iClip & "]GetCurrentFrame=" &
 oClip[iClip].iCurrentFrame & ")" )

                          else

                          
                          ClipPlayerGetCurrentFrame = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerPlay()

                          oClip[iClip].oClipChannel.Play(0)
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerPause()

                          oClip[iClip].oClipChannel.Pause()
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerContinue()

                          oClip[iClip].oClipChannel.Continue()
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerStop()
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                          oClip[iClip].oClipChannel.Stop()
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerFlush()

                          oClip[iClip].oClipChannel.Flush()
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
function ClipPlayerScrub( iScrubFrame as Integer ) as Boolean

                          if oClip[iClip].iMode == 3 AND
 oClip[iClip].iCurrentFrame <> iScrubFrame then

                          
                          oClip[iClip].iCurrentFrame = iScrubFrame

                          
                         
 oClip[iClip].oClipChannel.scrub( oClip[iClip].iCurrentFrame )

                          
                          ClipPlayerScrub = true

                          
                          println( "[" & iClip & "]ClipPlayerScrub" &
 oClip[iClip].iCurrentFrame & ")" )

                          else

                          
                          ClipPlayerScrub = false

                          end if
end function
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerSetLiveUpdate( bLiveUpdate as Boolean )

                          oClip[iClip].bLiveUpdate = bLiveUpdate

                          if oClip[iClip].bLiveUpdate then

                          
                          ClipPlayerRegisterChanges()

                          else

                          
                          ClipPlayerUnRegisterChanges()
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                          end if
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerRegisterChanges()

                         
 oClip[iClip].oClipChannel.SetRegisterChangedClipMode
 ( oClip[iClip].szShmKeyModeChanged  )

                         
 oClip[iClip].oClipChannel.SetRegisterChangedClipFrame( oClip[iClip].szShmKeyFrameChanged )
end sub
‘--------------------------------------------------------------------
‘
‘ --------------------------------------------------------------------
sub ClipPlayerUnRegisterChanges()

                         
 oClip[iClip].oClipChannel.SetRegisterChangedClipMode ("")

                         
 oClip[iClip].oClipChannel.SetRegisterChangedClipFrame("")
end sub

See Also

• Callback Procedures

• Global Procedures

• Array[Type]

• Boolean

• ClipChannel

• Double

• Integer

• String
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18.12.13 Clip Channel - Stereo

The following script example shows a scene that has a clip channel activated. The
scene script shows the influence of each of the parameters. For details on the
parameters, see the Controlling 3D Stereoscopic Clip Playback section.

sub OnInitParameters()

                          Dim Output_Width As Double = System.VideoWidth

                          Dim Output_Height As Double =
 System.VideoHeight

                          if System.OutputInterlaced then Output_Height
 *= 2

                          println( "VideoWidth=" & Output_Width  )

                          println( "VideoHeight=" & Output_Height  )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.A.HScale",  "A H
 Scaling",     2.0, 0.0, 10.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.A.VScale",  "A V
 Scaling",     1.0, 0.0, 10.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.A.HSoft",   "A H
 Softness",    0.0, 0.0, 1.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.A.VSoft",   "A V
 Softness",    0.0, 0.0, 1.0 )
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 RegisterParameterDouble( "vizrt.com.StereoClip.A.XTrans",  "A X
 Translation", Output_Width/2.0, -10000.0, 10000.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.A.YTrans",  "A Y
 Translation", 0.0, -10000.0, 10000.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.A.XAnchor", "A X Anchor",
      0.0, -10000.0, 10000.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.A.YAnchor", "A Y Anchor",
      0.0, -10000.0, 10000.0 )

                         
 RegisterParameterSliderDouble( "vizrt.com.StereoClip.A.Sharp",   "A
 Sharpness",     0.5, 0.0, 1.0, 200 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.B.HScale",  "B H
 Scaling",     2.0, 0.0, 10.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.B.VScale",  "B V
 Scaling",     1.0, 0.0, 10.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.B.HSoft",   "B H
 Softness",    0.0, 0.0, 1.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.B.VSoft",   "B V
 Softness",    0.0, 0.0, 1.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.B.XTrans",  "B X
 Translation", -Output_Width/2.0, -10000.0, 10000.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.B.YTrans",  "B Y
 Translation", 0.0, -10000.0, 10000.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.B.XAnchor", "B X Anchor",
      0.0, -10000.0, 10000.0 )

                         
 RegisterParameterDouble( "vizrt.com.StereoClip.B.YAnchor", "B Y Anchor",
      0.0, -10000.0, 10000.0 )

                         
 RegisterParameterSliderDouble( "vizrt.com.StereoClip.B.Sharp",   "B
 Sharpness",     0.5, 0.0, 1.0, 200 )
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                          RegisterParameterBool( 
  "vizrt.com.StereoClip.changed",   "Update", false )
end sub
sub OnParameterChanged(parameterName As String)

                          if  parameterName ==
 "vizrt.com.StereoClip.changed" then

                          
                         
 this.Scene.Map[ "vizrt.com.StereoClip.changed" ] =
 CStr( GetParameterInt( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.A.HScale" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.A.VScale" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.A.HSoft" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.A.VSoft" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.A.XTrans" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.A.YTrans" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))
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                          elseif  parameterName ==
 "vizrt.com.StereoClip.A.XAnchor" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.A.YAnchor" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.A.Sharp" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.B.HScale" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.B.VScale" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.B.HSoft" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.B.VSoft" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.B.XTrans" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))
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                          elseif  parameterName ==
 "vizrt.com.StereoClip.B.YTrans" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.B.XAnchor" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.B.YAnchor" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          elseif  parameterName ==
 "vizrt.com.StereoClip.B.Sharp" then

                          
                          this.Scene.Map[ parameterName ] =
 CStr( GetParameterDouble( parameterName ))

                          end if
end sub
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19 Scripting Data Types and Procedures

This section contains information on all supported data types and procedures, how to
share data and several script examples.

This section contains information on the following high-level topics:

• Callback Procedures

• Data Sharing

• Data Types and Procedures

See Also

• Shared Memory (SHM)

19.1 Callback Procedures
Here is a list of callback procedures recognized by the script engine. When defined
in a script, these procedures are called by the system in response to events such
as keyboard and mouse input. All of them are supported by container scripts,
while only five (OnInitParameters, OnInit, OnExecPerField, OnExecAction,
OnParameterChanged) are meaningful in scene scripts.

Sub OnInitParameters()

This procedure must contain all Register... calls (such as RegisterParameterInt),
which are used to define the script’s parameters. For locally defined scripts, this
callback is invoked once for every script instance, immediately before OnInit, while for
plugin scripts, it is called at system startup.

Sub OnInit()

Called after a script instance has been created (e.g. by pressing Compile and Run or by
loading a scene with a script). Initialization code should be placed here.

Sub OnEnter()

Called when the mouse cursor enters the area occupied by the script’s container in the
output window. If the container’s ExactPicking property, which is true by default, is
set to false, it is sufficient that the mouse cursor hits the container's bounding box for
OnEnter to be called.

Note: Due to the necessary object hit-testing (picking) using this callback can
have impacts on the overall render performance.

Sub OnLeave()

The reverse of OnEnter: Called when the mouse cursor leaves the container’s area.
This procedure is called only if OnEnter has previously been called for the script’s
container.

Note: Due to the necessary object hit-testing (picking) using this callback can
have impacts on the overall render performance.
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Sub OnEnterSubContainer(subContainer as Container)

Called when the mouse cursor enters the area occupied by a sub-container of the
script’s container. Otherwise identical to OnEnter.

Note: Due to the necessary object hit-testing (picking) using this callback can
have impacts on the overall render performance.

Sub OnLeaveSubContainer(subContainer as Container)

Called when the mouse cursor leaves the area occupied by a sub-container of the
script’s container.

Note: Due to the necessary object hit-testing (picking) using this callback can
have impacts on the overall render performance.

Sub OnExecPerField()

Called once for every field.

Sub OnExecAction(buttonId as Integer)

Called when the user clicks on any push button defined by RegisterPushButton. If
the script defines several push buttons, use buttonId to determine which button has
been clicked on.

Sub OnParameterChanged()

Called whenever the user changes the value of script parameter defined by any of the
RegisterParameter... functions.

Sub OnGuiStatus()

Called if the GUI wants to refresh the state of the UI. This would be the correct place
where the plugin can set the UI state to enabled/disabled with SendGuiStatus or
shown/hidden with SendGuiParameterShow.

Sub OnKeyDown(keyCode as Integer)

Called whenever the user presses a key. keycode identifies the key pressed. Possible
values are: KEY_A, KEY_B, ..., KEY_Z, KEY_0, ..., KEY_9, KEY_HOME, KEY_END,
KEY_PAGEUP, KEY_PAGEDN, KEY_UP, KEY_DOWN, KEY_LEFT, KEY_RIGHT, KEY_INSERT,
KEY_DELETE, KEY_BEGIN, KEY_MULTIPLY, KEY_DIVIDE, KEY_ESCAPE, KEY_RETURN,
KEY_ENTER, KEY_SEPARATOR, KEY_SPACE, KEY_BACKSPACE, KEY_TAB, KEY_CONTROL,
KEY_MENU, KEY_ALT, KEY_SHIFT, KEY_F1, ... KEY_F12, KEY_SCROLL_LOCK, KEY_PAUSE,
NUMPAD_INSERT, NUMPAD_END, NUMPAD_DOWN, NUMPAD_PGDN, NUMPAD_LEFT,
NUMPAD_BEGIN, NUMPAD_RIGHT, NUMPAD_HOME, NUMPAD_UP, NUMPAD_PGUP,
NUMPAD0, ..., NUMPAD9

Sub OnKeyUp(keyCode as Integer)

Called whenever the user releases a key.

Sub OnButtonDown6DOF(button as Integer, pos as Vertex, rot as Vertex)

Called when the user clicks on a scene grid. button defines the ID of the pressed
button, pos specifies the 3D world position of the cursor and rot gives you the actual
rotation.
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Sub OnButtonUp6DOF(button as Integer, pos as Vertex, rot as Vertex)

Called whenever the user releases a mouse button.

Sub OnMove6DOF(button as Integer, pos as Vertex, rot as Vertex)

Called when the user moves the cursor on a scene grid. button defines the ID of the
pressed button, pos specifies the 3D world position of the cursor and rot gives you the
actual rotation.

Sub OnMoveRelative6DOF(button as Integer, pos as Vertex, rot as Vertex)

Called when the user moves the cursor on a scene grid. button defines the ID of the
pressed button, pos specifies the offset vector to the last 6DOF position of the cursor
and rot gives you the actual rotation.

Sub OnScale6DOF(button as Integer, scale as Vertex)

Called when the user performs a scale operation (e.g.: with a multi-touch device) on a
scene grid. button defines the ID of the pressed button and scale specifies the actual
scale factor.

Sub OnMTHit(stroke as Integer, x as Integer, y as Integer)

Called when the user touches this object (where this scriptplugininstance resides on) at
a multi-touch device. stroke gives you the stroke ID of the multi-touch operation and x
and y specify the hit position in screen coordinates. This callback is used to instantiate
a certain control in the multi-touch server.

Note: Due to the necessary object hit-testing (picking) using this callback can
have impacts on the overall render performance.

Sub OnMTMenu(x as Integer, y as Integer)

Called when the user performs a menu gesture on the multi-touch device. x and y
specify the hit position in screen coordinates.

Note: Due to the necessary object hit-testing (picking) using this callback can
have impacts on the overall render performance.

Sub OnMTControlPZR2D(x as Integer, y as Integer, rot as Vertex, scale as Vertex,
pressure as Double)

Called when a PZR2D control was registered. x and y specify the hit position in screen
coordinates, rot gives you the object rotation, scale holds the scale factor and pressure
contains the current mean contact pressure.

Sub OnMTControlButton(strokes as Integer, pressure as Double)

Called when a Button control was registered. strokes contains the current hit count on
the button object and pressure defines the mean contact pressure.

Sub OnMTControlInactive()

Called when a registered multi-touch control became inactive (all strokes were
removed from the object).

Sub OnMouseMove(x as Integer, y as Integer)
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Called whenever the mouse cursor is moved within the output window. x and y specify
the cursor position in screen coordinates.

Sub OnLButtonDown()

Sub OnMButtonDown()

Sub OnRButtonDown()

Called whenever the user presses the left/middle/right mouse button.

Note: Due to the necessary object hit-testing (picking) using these callbacks can
have impacts on the overall render performance.

Sub OnLButtonUp()

Sub OnMButtonUp()

Sub OnRButtonUp()

Called whenever the user releases the left/middle/right mouse button.

Note: Due to the necessary object hit-testing (picking) using these callbacks can
have impacts on the overall render performance.

Sub OnMouseWheel(distance as Integer)

Called whenever the mouse wheel is rotated within the output window.

Sub OnSharedMemoryVariableChanged(map as SharedMemory, mapKey as String)

Called when a variable in a SharedMemory map is changed. The SharedMemory map
and the name of the variable are passed to this procedure as parameters. The name
of the variable must previously be registered to the SharedMemory map by calling its
RegisterChangedCallback procedure.

Sub OnSharedMemoryVariableDeleted(map as SharedMemory, mapKey as String)

Called when a variable in a SharedMemory map is deleted. The SharedMemory map
and the name of the variable are passed to this procedure as parameters. The name
of the variable must previously be registered to the SharedMemory map by calling its
RegisterChangedCallback procedure.

sub OnGeometryChanged(geom as Geometry)

Called when a geometry changed which was registered with RegisterChangedCallback
or RegisterTextChangedCallback before.
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19.2 Data Sharing

Shared Memory map saved to the Viz Graphic Hub database

This section describes the data sharing mechanism provided by Shared Memory
Maps (SMM). An SMM is a map which holds user-defined variables indexed by a string.
It is exposed to the script interface via the SharedMemory data type. The variables are
stored as Variant objects and thus can hold objects of any other type. Any script has
access to three SMM’s:

• Scene .Map: This is the map local to the current Scene. Every Scene has one map
that can be used to exchange data among the scripts in the Scene.

• System .Map: The system-wide map allows for data sharing among the Scenes
currently loaded into memory.

• VizCommunication .Map: A distributed map that enables data sharing among the
computers connected to one Viz Graphic Hub.

Example I

Below is an example that shows how a Scene map can be used to pass data from one
script to another (within the same Scene).

The first script defines the OnEnterSubContainer, which is called whenever the
mouse-cursor enters any of its sub-containers. In it, the name of the subcontainer is
stored in the Scene map under the key subcontainer_name.

‘ Script 1:
Sub OnEnterSubContainer(subContainer as Container)

                          Scene.Map["subcontainer_name"] =
 subContainer.Name
End Sub

For further details, see also Sub VizBoldOnEnterSubContainer(VizCursivsubContainer as
Container).

In the second script, the previously stored value is retrieved, cast into a string, and
output as text (assuming that the container holding the script has a text geometry).

‘ Script 2:
Sub OnExecPerField()

                          Geometry.Text =
 (String)System.Map["subcontainer_name"]
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End Sub

For further details, see also Sub VizBoldOnExecPerField().

Example II

The above image depicts a command being sent to Viz Engine assigning a value to a
variable named my_variable. The below image depicts a script using that variable to
assign one of its values to a text container named MyText.

From outside Viz Engine you can access the shared memory by connecting to Viz
Engine’s listener port 6100. For more information on ways to access shared memory,
see the Accessing Maps through the Command Interface section.

So, to create and set a value shared by all Viz Engines, that are connected to the same
Viz Graphic Hub, you can send the following command using the Viz Engine console:

send VIZ_COMMUNICATION*MAP SET_STRING_ELEMENT "my_variable"
 1.2;10.8;20.3;15.9
CONSOLE:  answer <>
send VIZ_COMMUNICATION*MAP GET_STRING_ELEMENT "my_variable"
CONSOLE:  answer <1.2;10.8;20.3;15.9>

Inside Viz Engine you can also set and retrieve data from the shared memory through
scripting.

You address the different areas as follows:

• Scene.map

• System.map

• VizCommunication.map

To set a value

send VIZ_COMMUNICATION*MAP SET_STRING_ELEMENT "my_variable"
 1.2;10.8;20.3;15.9

or

VizCommunication.map["my_variable"] = 1.2;10.8;20.3;15.9

To retrieve a value

Dim MyVariable as string
MyVariable = (string)VizCommunication.map["my_variable"]
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string is here used to format the data from the shared memory to a text value.

To split the values into an array

You can then split the data inside MyVariable into a table called MyArray:

Dim MyArray as array [string]
MyVariable.split(";",MyArray)

The information in MyVariable has now been split into 4:

‘ MyArray[0] = 1.2
‘ MyArray[1] = 10.8
‘ MyArray[2] = 20.3
‘ MyArray[3] = 15.9

To assign a value to a text container

One of these values can then be assigned to a text container:

Scene.FindContainer("MyText").geometry.text = MyArray[1]

To automatically update graphics

When a shared memory variable is updated you will have to register the value for
updates in the scene:

Scene.Map.RegisterChangedCallback("my_variable")

Changes to my_variable will execute a subroutine called
OnSharedMemoryVariableChanged. This subroutine can do whatever you decide with
the data. For further details, see Callback Procedures.

This section also contains information on the following topics:

• Receiving Notification on Map Changes

• VizCommunication.Map

• Accessing Maps via the TCP or UDP Interface

• Accessing Maps through the Command Interface

• Accessing Maps from Within Plugins

See Also

• Shared Memory (SHM)

19.2.1 Receiving Notification on Map Changes

Sometimes you want to be notified when a value in an SMM changes, so you do not
have to poll for changes within OnExecPerField. This is done by calling a map’s
RegisterChangedCallback procedure, passing it the name of a key that you want
to monitor. Now, whenever the variable identified by that key is changed, the
OnSharedMemoryVariableChanged callback (if present) is invoked. Similarly, the
OnSharedMemoryVariableDeleted callback is invoked, when the variable is deleted.

Example

Sub OnInit()
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 Scene.Map.RegisterChangedCallback("subcontainer_name")
End Sub
Sub OnSharedMemoryVariableChanged(map as SharedMemory, mapKey as String)

                                      If mapKey = "subcontainer_name"
 Then

                                      
                                      Geometry.Text =
 (String)map["subcontainer_name"]

                                      End If
End Sub

Note: OnSharedMemoryVariableChanged is passed the map as well as the key
whose variable has been changed.

If you pass an empty string ("") to RegisterChangedCallback,
OnSharedMemoryVariableChanged and OnSharedMemoryVariableDeleted will be
invoked whenever any variable in the map is modified or deleted:

Sub OnInit()

                                     
 Scene.Map.RegisterChangedCallback("")
End Sub
Sub OnSharedMemoryVariableChanged(map as SharedMemory, mapKey as String)

                                      ...
End Sub

See Also

• Sub VizBoldOnExecPerField()

• Sub VizBoldOnSharedMemoryVariableChanged(VizCursivmap as SharedMemory,
VizCursivmapKey as String)

• Sub VizBoldOnSharedMemoryVariableDeleted(VizCursivmap as SharedMemory,
VizCursivmapKey as String)

19.2.2 VizCommunication.Map

The map exposed by the VizCommunication type is used to share data among the
client computers connected to Viz Graphic Hub. Whenever a script on one client adds
a new value or changes an existing value in the map, the change is propagated to
the other clients via database messaging to update the local copy of each client’s
map. Note, however, that this does not necessarily mean that all local client maps
are identical. When a client starts up after other clients have made changes to the
VizCommunication.Map, it is not informed of those changes. To work around this
limitation, one client can save the entire contents of the map by calling the map’s
SaveToDb procedure, and another client can read it by calling LoadFromDb.

See Also
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• Shared Memory (SHM)

19.2.3 Accessing Maps via the TCP or UDP Interface

Elements in the distributed memory map (VizCommunication.Map) can be set (but not
retrieved) via a TCP or UDP interface exposed by Viz Artist. This option is particularly
useful when writing external control applications.

A C++ library, the VizControlLib, is provided to encapsulate all required communication
and serialization logic. The VizControlLib can be found in <viz3 install directory>/
Tools/ControlLib. Please refer to the header files and the included test project for
more information.

See Also

• Configuring Shared Memory

• Shared Memory (SHM)

19.2.4 Accessing Maps through the Command Interface

There is limited support for getting and setting map elements via the command
interface. The maps are accessible through these locations:

• <scene>*MAP for the scene specific map

• GLOBAL*MAP for system-wide map

• VIZ_COMMUNICATION*MAP for the distributed map

Here is a list of commands supported by each of these maps:

• SET_BOOLEAN_ELEMENT and GET_BOOLEAN_ELEMENT

• SET_INTEGER_ELEMENT and GET_INTEGER_ELEMENT

• SET_DOUBLE_ELEMENT and GET_DOUBLE_ELEMENT

• SET_STRING_ELEMENT and GET_STRING_ELEMENT

Examples:

send VIZ_COMMUNICATION*MAP SET_DOUBLE_ELEMENT "my_double" 1.2
send VIZ_COMMUNICATION*MAP GET_DOUBLE_ELEMENT "my_double"
=> Answer = "1.2"

See Also

• Configuring Shared Memory

• Shared Memory (SHM)

19.2.5 Accessing Maps from Within Plugins

Functions for getting and setting map elments are provided by the plugin interface. For
more information, refer to the evPlugin_SHARED_MEMORY.h file, which is part of the
plugin SDK (<viz3 install directory>/Plugin/src).

See Also

• Shared Memory (SHM)
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19.3 Data Types and Procedures
This section contains a complete reference of the Viz Artist’s supported data types and
procedures:

Data Types and
Procedures

Alpha DateTime Light Stage

Array[Type] Director Material String

Base Double Matrix StringMap

BezierHandle Expert PluginInstance System

Boolean Geometry Position Texture

Camera Grid Rotation Timecode

Center Image Scaling Uuid

Channel InfoText Scene Variant

ClipChannel Integer Script Vertex

Color Key ScriptSettings VizCommunication

Container Key frame SharedMemory Global Procedures

19.3.1 Alpha

Base type

Base

Description

An alpha object. This is used to control a container’s alpha value.

Properties

Property Description

Active as Double

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

Value as Double The alpha value [0.0, 100.0]
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Property Description

VizCommunication as VizCommunication
[read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member Procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.
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Name Description

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.2 Array[Type]

Description

A dynamic, one-dimensional array. The element type must be specified in square
brackets. Use the index operator [] to access individual elements. Negative indices
refer to elements at the end of the array.

Properties

Property Description

LBound as Integer [read-only] The index of the first elment (always 0)

Size as Integer The size of the array (this member can be
set to change the size)

UBound as Integer [read-only] The index of the last elment (-1 if the
array is empty)

Member Procedures

Name Description

Sub Clear() Erases all elements

Sub Erase(index as Integer) Erases the element at ‘index’.

Sub Insert(index as Integer, element as
Type)

Inserts a new element at ‘index’.

Sub Pop() Removes the last element

Sub Push(element as Type) Inserts a new element at the end of the
array.

Function Sort(object as Base,
comparisonFunction as String) as Boolean

Sorts the array. comparisonFunction must
be the name of a user-defined comparison
function that takes two arguments of type
Type and returns an integer. The return
value must be -1 if the the first arguement
is smaller than the second, 1 if the first
argument is greater than the second, and
0 if the arguments are equal. object is
the this pointer passed to the comparison
function. It may be null if the camparison
function does not access any member
variables. The comparison function must
be defined in the same script as the Type
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Name Description

(if it is a structure) or in the script where
Sort is called.

19.3.3 Base

Description

A Viz object. This is the base class of all other Viz types.

Properties

Property Description

Scene as Scene [read-only] Gets the current scene.

Stage as Stage [read-only] Gets the current stage.

System as System [read-only] Gets system wide data.

VizCommunication as VizCommunication
[read-only]

Gets the VizCommunication object.

VizId as Integer Gets or sets the internal id of this object.

NumChannels as Integer [read-only] Deprecated. Use IsAnimated or
GetChannelsOfObject instead.

Member Procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

Finds an animation channel acting on
this object. If this function is called on a
type that cannot be animated (such as
Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

Finds a Key frame acting on the object.
If this function is called on a type that
cannot be animated (such as Director), it
returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".
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Name Description

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

This function works like
FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

Fills the array v with the animation
channels acting on this object, returning
the number of channels. If this function is
called on a type that cannot be animated
(such as Director), v will be empty.

Function IsAnimated() as Boolean Returns true if there are animation
channels for this object. If this function is
called on a type that cannot be animated
(such as Director), it always returns false.

Sub SetChanged() Mark this object as changed.

Function FindChannel(channelName as
String) as Channel

Deprecated. Use FindChannelOfObject

Function FindKey frame(Key frameName
as String) as Key frame

Deprecated. Use FindKey frameOfObject

Function GetChannels([out] v as
Array[Channel]) as Integer

Deprecated. Use GetChannelsOfObject

Function
GetNumberOfAnimationChannels() as
Integer

Deprecated. Use IsAnimated instead.

19.3.4 BezierHandle

Base type

Base

Description

A spline handle of a Key frame.

Properties

Property Description

LeftAngle as Double

LeftInterpolationMode as Integer HANDLE_INTERPOLATION_MODE_SMOOTH

HANDLE_INTERPOLATION_MODE_LINEAR

LeftWeight as Double

LockMode as Integer HANDLE_LOCK_MODE_LOCKED

HANDLE_LOCK_MODE_SINGLE
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Property Description

HANDLE_LOCK_MODE_MIRROR

RightAngle as Double

RightInterpolationMode as Integer HANDLE_INTERPOLATION_MODE_SMOOTH

HANDLE_INTERPOLATION_MODE_LINEAR

RightWeight as Double

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer [read-only] (Inherited from Base) Gets or sets the
internal id of this object.

Member Procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".
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Name Description

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.5 Boolean

Description

A flag that is either true or false.

19.3.6 Camera

Base type

Base

Description

A camera object. Camera objects are returned by the Scene’s CurrentCamera and
GetCamera members.

Properties

Property Description

ActiveExt as Boolean Activates/Deactivates the external
camera.

Cx as Double The center shift in x

CxExt as Double [read-only] The center shift in x of the external
camera

Cy as Double The center shift in y
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Property Description

DecoupleExternal as Boolean If true, viz receives external camera
data without copying them to its internal
camera structures for rendering.

Direction as Position The direction of the camera

FocalPlane as Double The focal plane

Fovx as Double The field of view in x

FovxExt as Double [read-only] The field of view in x of the external
camera

Fovy as Double The field of view in y

FovyExt as Double [read-only] The field of view in y of the external
camera

Matrix as Matrix [read-only] The model matrix of the camera.

Pan as Double The pan

PanExt as Double [read-only] The pan of the external camera

Position as Position The camera position

PositionExt as Position [read-only] The position of the external camera

PositionTrackingActive as Boolean Is position tracking active?

PositionTrackingContainer as Container The tracking object for position tracking

ProjectionMatrix as Matrix [read-only] The projection matrix of the camera.

RotationTrackingActive as Boolean Is rotation tracking active?

RotationTrackingContainer as
Container

The tracking object for rotation tracking

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

Tilt as Double The tilt

TiltExt as Double [read-only] The tilt of the external camera

Twist as Double The twist

TwistExt as Double [read-only] The twist of the external camera
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Property Description

View as Integer The view type:

CAM_VIEW_PERSPECTIVE

CAM_VIEW_ORTHOGONAL

ViewMatrix as Matrix [read-only] The view matrix of the camera.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

19.3.7 Center

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.
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Name Description

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub ResetPositionTracking()

Sub ResetRotationTracking()

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.8 Channel

Base type

Base

Description

A channel of a director.

Properties

Property Description

Actor as Base [read-only]

AnimationObject as Base [read-only]

CommandName as String [read-only]

Director as Director [read-only]

FirstKey frame as Key frame [read-only] Gets the leftmost Key frame.

Key frameCount as Integer [read-only] Gets the number of key frames.

LastKey frame as Key frame [read-only] Gets the rightmost Key frame.

Name as String

PostLoopActive as Boolean

PostLoopCounter as Integer

PostSwingActive as Boolean

PreLoopActive as Boolean

PreLoopCounter as Integer

PreSwingActive as Boolean
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Property Description

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

NumKey frames as  Integer  [read-only] Deprecated. Use  Key frameCount .

Member procedures

Name Description

Function AddKey frame(time as Double)
as Key frame

Function CopyToDirector(destination as
Director) as Boolean

Sub Delete()

Function DeleteKey frame(kf as Key
frame) as Boolean

Function DeleteKey frame(index as
Integer) as Boolean

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frame(Key frameName
as String) as Key frame

Searches for a Key frame named Key
frameName.

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.



Viz Artist User’s Guide

Copyright © 2014 Vizrt Page 1023
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You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function GetKey frame(n as Integer) as
Key frame

Returns the n’th Key frame of the channel.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Function MoveToDirector(destination as
Director) as Boolean

Sub Rebuild() Rebuilds the channel after it has been
modified. Normally, there is no need to
call this procedure.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.9 ClipChannel

Base type

Base

Description

A ClipChannel object. The ClipChannel member of the Base type provides access to the
clip channel. Use System.GetClipChannel(number as Integer), whereas number >= 0,
to get a ClipChannel instance. See also examples section ClipChannel.

Properties
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Property Description

AutoRun as Boolean Get/Set the autorun mode. If true then the
clip start playing automatically upon load.

ClipChannelID as Integer [read-only] Get the clip channel number.

CurrentFrame as Integer [read-only] Get the current frame.

CurrentFramePending as Integer [read-
only]

Get the current frame of the pending clip.

Duration as Integer [read-only] Get the number of frames of the current
clip.

DurationPending as Integer [read-only] Get the number of frames of the pending
clip.

FrameIn as Integer Get/Set the In frame.

FrameInActive as Integer Get/Set the In frame on the active clip
player.

FrameInPending as Integer Get/Set the In frame on the pending clip
player.

FrameOut as Integer Get/Set the Out frame.

FrameOutActive as Integer Get/Set the Out frame on the active clip
player.

FrameOutPending as Integer Get/Set the Out frame on the pending clip
player.

LoopMode as Boolean Get/Set the loop mode. If true (=default),
then the clip will be looped.

LoopModeActive as Boolean Get/Set the loop mode on the active clip
player. If true (=default), then the clip will
be looped.

LoopModePending as Boolean Get/Set the loop mode on the pending clip
player. If true (=default), then the clip will
be looped.

ModeOnLoadError as Integer Determines the mode upon an error
situation when loading a clip. none|pause|
stop|flush

ModeOnLoadError_FLUSH as Integer
[read-only]

Constant for mode on load error error
flush.

ModeOnLoadError_NONE as Integer
[read-only]

Constant for mode on load error none.

ModeOnLoadError_PAUSE as Integer
[read-only]

Constant for mode on load error pause.
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Property Description

ModeOnLoadError_STOP as Integer
[read-only]

Constant for mode on load error stop.

PendingClipSupported as Boolean
[read-only]

Determines if support for loading pending
clips is available.

PlayBackSpeed as Double Get/Set the playback speed.

PlayBackSpeedActive as Double Get/Set the playback speed on the active
clip player.

PlayBackSpeedPending as Double Get/Set the playback speed on the
pending clip palyer.

PlayMode as Integer [read-only] Get the current mode of the clip channel.

PlayMode_ERROR as Integer [read-only] Constant for current mode ERROR.

PlayMode_NONE as Integer [read-only] Constant for current mode NONE.

PlayMode_PLAY as Integer [read-only] Constant for current mode PLAYING.

PlayMode_PLAY_PENDING as Integer
[read-only]

Constant for current mode
PLAYING_PENDING.

PlayMode_SCRUB as Integer [read-only] Constant for current mode SCRUBBING.

PlayMode_SCRUB_EOF as Integer [read-
only]

Constant for current mode
SCRUBBING_EOF.

PlayMode_STOP as Integer [read-only] Constant for current mode STOP.

PlayModePending as Integer [read-only] Get the current mode of the pending clip
player.

RepeatMode as Integer Get/Set the repeat mode for playback and
pause. none|field|frame.

RepeatMode_FIELD as Integer [read-
only]

Constant for repeat mode field.

RepeatMode_FRAME as Integer [read-
only]

Constant for repeat mode frame.

RepeatMode_NONE as Integer [read-
only]

Constant for repeat mode none.

RepeatModeActive as Integer Get/Set the repeat mode for playback and
pause on the active clip player. none|field|
frame.

RepeatModePending as Integer Get/Set the repeat mode for playback and
pause on the pending clip player. none|
field|frame.
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ReverseFields as Boolean If true swap fields when playing interlaced
material backwards.

ReverseFieldsActive as Boolean If true swap fields when playing interlaced
material backwards on the active clip
player.

ReverseFieldsPending as Boolean If true swap fields when playing interlaced
material backwards on the pending clip
player.

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

UpscaleLuma as Boolean If true then upscale the luma value in the
separate key file.

UpscaleLumaActive as Boolean If true then upscale the luma value in the
separate key file on the active clip player.

UpscaleLumaPending as Boolean If true then upscale the luma value in
the separate key file on the pending clip
player.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

19.3.10 Color

Description

A color object consisting of 4 members: red, green blue, alpha.

Properties

Property Description

Alpha as Double The alpha component [0.0, 1.0]

Blue as Double The blue component [0.0, 1.0]

Green as Double The green component [0.0, 1.0]

Red as Double The red component [0.0, 1.0]
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Property Description

Rgb as Vertex The red/green/blue components combined
into a Vertex value

19.3.11 Container

Base type

Base

Description

A container object.

Properties

Property Description

Active as Boolean The visibility state

Alpha as Alpha The alpha object

Center as Center The center object

ChildContainer as Container [read-only] The first child container

ChildContainerCount as Integer [read-
only]

Gets the number of child containers.

ExactPicking as Boolean Enables/Disables exact picking for
OnEnter/OnLeave.

Expert as Expert The expert object

FirstChildContainer as Container [read-
only]

The first child container

Geometry as Geometry The geometry object

InfoText as InfoText The infotext object

Key as Key The key object

LastChildContainer as Container [read-
only]

The last child container

Material as Material The material object

Matrix as Matrix [read-only] The model matrix of the cotainer.

Merged as Boolean [read-only] Indicates whether the container is
merged.

MergedChildContainer as Container
[read-only]

The first child container within a merged
object



Viz Artist User’s Guide

Page 1028 Copyright © 2014 Vizrt

Property Description

MergedParentContainer as Container
[read-only]

The merged parent container

Name as String The name of the container

NextContainer as Container [read-only] The next container in the tree

Open as Boolean Indicates whether the container is open,
i.e. its sub-containers are visible in the
tree

ParentContainer as Container [read-
only]

The parent container

Position as Position The position object

PreviousContainer as Container [read-
only]

The previous container

Rotation as Rotation The rotation object

Scaling as Scaling The scaling object

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Script as Script [read-only] The script object: it can be used to
dynamically call member procedures of
the container

ScriptPluginInstance as PluginInstance
[read-only]

The script’s plugin instance

ScriptSettings as ScriptSettings [read-
only]

The script’s local settings

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

Texture as Texture The texture object

Uuid as Uuid [read-only] The UUID of the container

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as   IntegerVizCursiv (Inherited from Base) Gets or sets the
internal id of this object.

NumChildContainers as  IntegerVizCursiv 
[read-only]

Deprecated. Use  ChildContainerCount 
instead.

Transform as Transform Deprecated.
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Member procedures

Name Description

Function AddContainer(where as  
IntegerVizCursiv  ) as Container

Inserts and returns a new container; where
=

TL_NEXT

TL_PREVIOUS

TL_DOWN.

Function AddScreenOffset(dx as  
IntegerVizCursiv  , dy as   IntegerVizCursiv
) as Vertex

This procedure is identical to
ScreenOffsetToContainerOffset except
that it automatically adds the resulting
container offset to the local container
position. This procedure is typically called
in OnMouseMove to implement dragging
of containers.

Function ContainsMouseCursor() as
Boolean

Returns true if and only if the mouse
curser is inside the container. For this
method to work correctly, it is required
that at least one enter or leave callback
be defined on the container or on a super-
container.

Function CopyTo(destination as
Container, where as   IntegerVizCursiv  )
as Container

Copies the container; where =

TL_NEXT

TL_PREVIOUS

TL_DOWN.

Function CreateAlpha() as Alpha Creates and returns an alpha object.

Function CreateExpert() as Expert

Function CreateFunction(location as
String) as PluginInstance

Creates a plugin instance by name, e.g.
"BUILT_IN*FUNCTION*Autofollow"

Function CreateGeometry(location as
String) as Geometry

Creates a geometry by name, e.g.
"BUILT_IN*GEOM*Circle" (for built-ins) or
"GEOM*ObjectName" (for pool objects)

Function CreateInfoText() as InfoText

Function CreateKey() as Key

Function CreateMaterial() as Material

Function CreateMaterial(location as
String) as Material

Function CreateTexture(name as String)
as Texture

Creates a texture object by name, e.g.
"IMAGE*ImageName"

Function CreateTexture(image as Image)
as Texture
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Sub Delete() Deletes the container.

Sub DeleteAlpha() Deletes the alpha object.

Sub DeleteChildren() Deletes the container’s child containers.

Sub DeleteExpert()

Sub DeleteFunction(location as String) Deletes a plugin instance by name, e.g.
"Autofollow"

Sub DeleteGeometry()

Sub DeleteInfoText()

Sub DeleteKey()

Sub DeleteMaterial()

Sub DeleteTexture()

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function
FindSiblingSubContainer(name as
String) as Container

Searches among the container’s siblings
(as well as the container itself) and their
sub-containers for a container with the
specified name. Otherwise identical to
FindSubContainer.
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Function FindSubContainer(name as
String) as Container

Searches for a sub-container with
the specified name. The search
mode is breadth-first. It is possible
to combine multiple calls to this
function into one call by concatenating
the individual container names
using $ as a separator. For example,
FindSubContainer("name1$name2")
has the same effect as
FindSubContainer("name1").FindSubContainer("name2").

Function FindSuperContainer(name as
String) as Container

Searches for a super-container with the
specified name.

Sub GetBoundingBox(v1_out
as   VertexVizCursiv  , v2_out as  
VertexVizCursiv  )

Returns in v1_out and v2_out the left-
bottom-back and right-top-front vertices of
the container’s bounding box.

Function GetBoundingBoxDimensions()
as   VertexVizCursiv

Returns the dimensions (width, height,
depth) of the container’s bounding box.
(The used bounding box was calculated in
the last frame.)

Function GetChannelsOfObject([out] v
as Array[Channel]) as   IntegerVizCursiv

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function
GetChildContainerByIndex(index as  
IntegerVizCursiv  ) as Container

Returns the child container specified by
index.

Function
GetChildContainerContainingMouseCursor()
as Container

Returns the first child container containing
the mouse cursor.

Sub
GetContainerAndSubContainers([out]
v as Array[Container],
traverseMergedGeometries as Boolean)

Function GetDirector() as Director Finds the first director containing an
animation of this container.

Function
GetDirectorOfMergedGeometry() as
Director

If this container holds a merged geometry
with an embedded animation, this function
returns the corresponding director.

Function
GetFirstActiveChildContainer() as
Container

Returns the first (=topmost) active child
container.
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Function
GetFunctionPluginInstance(pluginName
as String) as PluginInstance

Provides access to the parameters of a
function plugin residing on the container.

Function GetGeometryPluginInstance()
as PluginInstance

Provides access to the parameters of a
geometry plugin residing on the container.

Function
GetIndexOfFirstActiveChildContainer()
as   IntegerVizCursiv

Returns the 0-based index of the first
active child container within the container
(or -1 if there is no active child).

Function GetLocalIndex() as  
IntegerVizCursiv

Returns the 0-based index of the container
within its parent.

Sub GetScreenBounds(v1_out
as   VertexVizCursiv  , v2_out as  
VertexVizCursiv  )

Returns in v1_out and v2_out the left-
bottom and right-top screen coordinates
defining the rectangle occupied by the
container. (The used bounding box was
calculated in the last frame.)

Function
GetScreenPointToGeomSurface(x as  
IntegerVizCursiv  , y as   IntegerVizCursiv 
, pos as   VertexVizCursiv  ) as Boolean

This procedure calculates the geometry
intersection with the projected ray from
the specified screen position and returns
true on success. The intersection point is
returned in world coordinates.

Function GetScreenPositionOrtho(x as  
IntegerVizCursiv  , y as   IntegerVizCursiv 
) as Boolean

This procedure gets the container’s screen
position in the same way as you can do it
via GUI in the Transformation Editor. There
can not be any rotation on the object.

Function GetScreenSizeOrtho(x as  
IntegerVizCursiv  , y as   IntegerVizCursiv 
) as Boolean

This procedure gets the container’s screen
size in the same way as you can do it via
GUI in the Transformation Editor. There
can not be any rotation on the object.

Function GetShaderPluginInstance() as
PluginInstance

Provides access to the parameters of a
shader plugin residing on the container.

Sub
GetTransformedBoundingBox(v1_out
as   VertexVizCursiv  , v2_out as  
VertexVizCursiv  )

Returns in v1_out and v2_out the left-
bottom-back and right-top-front vertices of
the container’s bounding box with applied
transformation matrix.

Function
GetTransformedBoundingBoxDimensions()
as   VertexVizCursiv

Returns the dimensions (width, height,
depth) of the container’s bounding box
with applied transformation matrix. (The
used bounding box was calculated in the
last frame.)

Function
GetUVCoordinatesOfScreenPoint(x as  
IntegerVizCursiv  , y as   IntegerVizCursiv 
) as   VertexVizCursiv

Transforms (x, y) into (u, v) coordinates
that are relative to the x/y cross section
of the container’s bounding box. The (u,
v) coordinates are returned in the x and
y components of the returned vertex (the
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z coordinate is always 0.0). If (x, y) are
within the bounding-box area, u and v will
be within the range [0.0, 1.0].

Sub HideAllChildContainers() Makes all child containers invisible.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Function IsOnTop() as Boolean Returns true if and only if the container
is on top at the mouse cursor position.
For this procedure to work correctly, it is
required that at least one enter or leave
callback be defined on the container or on
a super-container.

Function
IsScreenPointInBoundingBox(x as  
IntegerVizCursiv  , y as   IntegerVizCursiv 
) as Boolean

Returns true if the screen point (x, y) is
inside the area covered by the container’s
bounding box. (The used bounding box
was calculated in the last frame.)

Function IsVertexInBoundingBox(v as  
VertexVizCursiv  ) as Boolean

Returns true if v (which must be specified
in world coordinates) is inside the
container’s bounding box. (The used
bounding box was calculated in the last
frame.)

Sub LocalPosToScreenPos(pos as
Vertex, [out] dX as Double, [out] dY as
Double)

Converts local position to the position on
the screen.

Function LocalPosToWorldPos(pos as  
VertexVizCursiv  ) as   VertexVizCursiv

Converts the local position to a world
coordinate space position.

Sub
MoveAllChannelsToDirector(director as
Director)

Moves the animation channels to the
specified director.

Function MoveTo(destination as
Container, where as   IntegerVizCursiv  )
as Container

Moves the container; where =

TL_NEXT

TL_PREVIOUS

TL_DOWN.

Function
MoveToKeepTransformation(destination
as Container, where as   IntegerVizCursiv 
) as Container

Moves the container preserving the
containers transformation; where =

TL_NEXT

TL_PREVIOUS

TL_DOWN.

Sub RecomputeMatrix() Recalculate transformation matrix of the
container. This function is useful if you can
not wait one field for the updated matrix.
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Use it carefully and only where it is really
needed (current transformation matrix,
transformed bounding box, screen-position
or screen-size)

Function-
screenOffsetToContainerOffset(dx as  
IntegerVizCursiv  , dy as   IntegerVizCursiv
) as   VertexVizCursiv

Transforms a pixel offset into the
corresponding offset in local container
coordinates. In other words, the vector
returned by this procedure is the vector
you need to add to the container’s local
position (i.e. Position.Xyz) to make the
container move (dx, dy) pixels on the
screen.

Function-screenPosToLocalGrid(dX
as Double, dY as Double) as  
VertexVizCursiv

Converts the screen position to current
grid intersection point. The returned
coordinates are in local container
coordinate space.

Function-screenPosToLocalPos(dX
as Double, dY as Double) as  
VertexVizCursiv

Converts the screen position to the local
container position. This would mean that if
you assign the returned vertex to the local
container’s position then it moves exactly
to the passed screen position (orthogonal
to camera).

Sub SetCenterPositionLocked(center as
VertexVizCursiv  )

This procedure sets the container’s center
point without affecting its position.

Sub
SetCenterScreenGridPositionLocked(dX
as Double, dY as Double)

This procedure sets the container’s center
point to the passed screen position, using
the current grid, without affecting the
container position.

Sub
SetCenterScreenPositionLocked(dX as
Double, dY as Double)

This procedure sets the container’s
center point to the passed screen position
without affecting the container position.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

Function SetScreenPositionOrtho(x as  
IntegerVizCursiv  , y as   IntegerVizCursiv 
) as Boolean

This procedure sets the container’s screen
position in the same way as you can do it
via GUI in the Transformation Editor. There
can not be any rotation on the object.

Function SetScreenSizeOrtho(x as  
IntegerVizCursiv  , y as   IntegerVizCursiv 
) as Boolean

This procedure sets the container’s screen
size in the same way as you can do it via
GUI in the Transformation Editor.

Sub ShowAllChildContainers() Makes all child containers visible.

Sub ShowOneChildContainer(index as  
IntegerVizCursiv  )

Makes the child container specified by
index visible and all other child containers
invisible.
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Sub Update() Redraws the container’s entry in the scene
tree GUI. Ignored in on-air mode.

Function WorldPosToLocalPos(pos as  
VertexVizCursiv  ) as   VertexVizCursiv

Converts the world position to a local
coordinate space position.

Function-screenOffsetToWorldOffset(dx as 
IntegerVizCursiv , dy as  IntegerVizCursiv )
as  VertexVizCursiv

Deprecated.

19.3.12 DateTime

Description

A type storing date/time information.

Properties

Property Description

DayOfMonth as Integer Day of month (1-31)

DayOfWeek as Integer Day of week (0-6; Sunday = 0)

DayOfYear as Integer Day of year (0-365)

Hour as Integer Hours after midnight (0-23)

Minute as Integer Minutes after hour (0-59)

Month as Integer Month (1-12)

Second as Integer Seconds after minute (0-59)

TotalSeconds as Integer

Year as Integer Year

Member procedures

Name Description

Sub Normalize() Computes DayOfWeek and DayOfYear
members and forces the other members
to standard ranges.

Function ToString() as String Returns a date+time string of the form
Wed Jan 02 02:03:55 1980.

19.3.13 Director

Base type
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Base

Description

A director in the stage.

Properties

Property Description

ActionChannelCount as  
IntegerVizCursiv   [read-only]

Gets the number of action channels.

ChildDirector as Director [read-only] The topmost child director

EventChannel as   ChannelVizCursiv  
[read-only]

Gets the event channel.

Field as   IntegerVizCursiv   [read-only] The director field

Name as String The name of the director

NextDirector as Director [read-only] The next director in the stage tree

Offset as Double The offset of the director (wrt to the
parent director)

ParentDirector as Director [read-only] The parent director

PreviousDirector as Director [read-only] The previous director in the stage tree

Reverse as Boolean Enables/Disables reverse playing.

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

Time as Double The director time

TotalOffset as Double [read-only] The sum of all offsets (of this director and
its parents)

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as   IntegerVizCursiv (Inherited from Base) Gets or sets the
internal id of this object.

NumActionChannels as  
IntegerVizCursiv   [read-only]

Deprecated. Use ActionChannelCount.

NumAnimationChannels as  
IntegerVizCursiv   [read-only]

Deprecated. Call GetAnimationChannels to
get a list of animation channels.
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Name Description

Function AddDirector(where as  
IntegerVizCursiv  ) as Director

Inserts a new director; where =

TL_NEXT

TL_PREVIOUS

TL_DOWN

Sub ContinueAnimation() Continues the animation.

Function CopyTo(destination as Director,
where as   IntegerVizCursiv  ) as Director

Copies a director; where =

TL_NEXT

TL_PREVIOUS

TL_DOWN

Sub Delete() Removes this director from the stage.

Function
FindActionChannel(channelName as
String) as   ChannelVizCursiv

Searches for an action channel named
channelName.

Function FindChannel(channelName as
String) as   ChannelVizCursiv

Searches for an animation channel named
channelName.

Function
FindChannelOfObject(channelName as
String) as   ChannelVizCursiv

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frame(Key frameName
as String) as Key frame

Searches for a Key frame named Key
frameName.

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as   ChannelVizCursiv

(Inherited from Base) This function works
like FindChannelOfObject except that if no



Viz Artist User’s Guide

Page 1038 Copyright © 2014 Vizrt

Name Description

animation channel with the specifed name
exists, a new one is created.

Function FindSubDirector(name as
String) as Director

Searches for a sub-director named name.

Function GetActionChannel(index as  
IntegerVizCursiv  ) as   ChannelVizCursiv

Returns the action channel at index.

Sub GetAnimationChannels([out] v as
Array[  ChannelVizCursiv  ])

Fills the specified array with the director’s
animation channels.

Function GetChannelsOfObject([out]
v as Array[  ChannelVizCursiv  ]) as  
IntegerVizCursiv

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Sub GetKey frames([out] v as Array[Key
frame])

Fills the specified array with the director’s
key frames.

Function HasAnimationChannels() as
Boolean

Determines whether this director contains
any animation channels (not counting
channels in sub-directors).

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Function IsAnimationRunning() as
Boolean

Returns true if the animation of this
director is active.

Sub MoveTo(destination as Director,
where as   IntegerVizCursiv  )

Moves a director; where =

TL_NEXT

TL_PREVIOUS

TL_DOWN

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

Sub Show(time as Double) Sets director time.

Sub StartAnimation() Starts the animation in this director and its
sub-directors.

Sub StopAnimation() Stops the animation of this director and its
sub-directors.

Sub StopAnimation(recursive as
Boolean)

Stops the animation of this director and,
optionally, its sub-directors.
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Function GetAnimationChannel(index as 
IntegerVizCursiv ) as  ChannelVizCursiv

Deprecated. Use GetAnimationChannels
instead.

19.3.14 Double

Description

A double precision floating-point number (64 bits).

19.3.15 Expert

Base type

Base

Description

A container’s Expert property. This type provides access to the parameters of the
Expert plugin.

Properties

Property Description

BackFace as Boolean Get/Set back face rendering.

ExactPicking as Boolean Get/Set exact picking mode.

LineAntialiasing as Boolean Get/Set line antialiasing.

Mirror as Integer Get/Set mirror mode. Possible settings are:

EXPERT_MIRROR_NONE

EXPERT_MIRROR_X

EXPERT_MIRROR_Y

EXPERT_MIRROR_Z

Outline as Boolean Get/Set outline rendering.

RenderMode as Integer Get/Set render mode. Possible settings
are:

EXPERT_RENDER_ADD

EXPERT_RENDER_BLEND

EXPERT_RENDER_REV_SUBTRACT

EXPERT_RENDER_SUBTRACT

EXPERT_RENDER_MULTIPLY

EXPERT_RENDER_REV_MULTIPLY

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

SeparateSpecular as Boolean Get/Set separate specular rendering.
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ShadeModel as Integer Get/Set shading model. Possible modes
are:

EXPERT_SHADE_FLAT

EXPERT_SHADE_SMOOTH

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

TransparancyMode as Integer Get/Set transparancy mode. Possible
settings are:

EXPERT_TRANSP_BLEND

EXPERT_TRANSP_MASK

EXPERT_TRANSP_FASTEST

EXPERT_TRANSP_HIGH_QUALITY

TwoSidedLighting as Boolean Get/Set two-sided lighting.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Wireframe as Boolean Get/Set drawing in wireframe mode.

WireframeWidth as Double Get/Set line width in wireframe mode
(typically ranges from 0.0 to 10.0).

ZBuffer as Boolean Get/Set drawing of Z-Buffer.

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.
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You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v as
Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.16 Geometry

Base type

Base

Description

A container’s geometry. Depending on whether the geometry is a plugin or a text, this
type provides access to the parameters of the plugin or the text.

Properties

Property Description

Active as Boolean

Direction as Integer The text direction:

TEXT_DIRECTION_LEFT_TO_RIGHT

TEXT_DIRECTION_RIGHT_TO_LEFT

TEXT_DIRECTION_TOP_TO_BOTTOM

TEXT_DIRECTION_BOTTOM_TO_TOP

Kerning as Double The kerning value



Viz Artist User’s Guide

Page 1042 Copyright © 2014 Vizrt

Property Description

LineSpacing as Double The line spacing

Name as String [read-only] The name of the geometry

Orientation as Integer The text orientation:

TEXT_ORIENTATION_LEFT

TEXT_ORIENTATION_RIGHT

TEXT_ORIENTATION_CENTER

TEXT_ORIENTATION_CHAR

PluginInstance as PluginInstance [read-
only]

Gets the geometry’s plugin data (if this is
a geometry plugin).

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

Text as String The text string (if this is a text geometry)

Uuid as Uuid [read-only] The UUID of the geometry

VerticalOrientation as Integer The vertical text orientation:

TEXT_ORIENTATION_VERTICAL_TOP

TEXT_ORIENTATION_VERTICAL_BOTTOM

TEXT_ORIENTATION_VERTICAL_CENTER

TEXT_ORIENTATION_VERTICAL_FIRST_LINE

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

WordSpacing as Double The word spacing

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
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directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function GetParameterBool(parName as
String) as Boolean

Gets a geometry parameter of type
Boolean.

Function GetParameterColor(parName
as String) as Color

Gets a geometry parameter of type Color.

Function
GetParameterContainer(parName as
String) as Container

Gets a geometry parameter of type
Container.

Function GetParameterDouble(parName
as String) as Double

Gets a geometry parameter of type
Double.

Function GetParameterInt(parName as
String) as Integer

Gets a geometry parameter of type
Integer.

Function GetParameterString(parName
as String) as String

Gets a geometry parameter of type String.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub RegisterChangedCallback() Causes OnGeometryChanged to be
invoked whenever the geometry changes.
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Sub RegisterTextChangedCallback() Causes OnGeometryChanged to be
invoked whenever the geometry’s text
changes.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

Sub SetParameterBool(parName as
String, v as Boolean)

Sets a geometry parameter of type
Boolean.

Sub SetParameterColor(parName as
String, v as Color)

Sets a geometry parameter of type Color.

Sub SetParameterContainer(parName
as String, v as Container)

Sets a geometry parameter of type
Container.

Sub SetParameterDouble(parName as
String, v as Double)

Sets a geometry parameter of type
Double.

Sub SetParameterInt(parName as
String, v as Integer)

Sets a geometry parameter of type
Integer.

Sub SetParameterString(parName as
String, v as String)

Sets a geometry parameter of type String.

Sub UnregisterChangedCallback() Removes the binding set up by
RegisterChangedCallback.

19.3.17 Grid

Base type

Base

Description

A grid object.

Properties

Property Description

Locked as Boolean Gets or sets grid lock.

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.
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Property Description

Type as Integer Gets or sets the grid type. Possible types
are:

GRID_TYPE_XY

GRID_TYPE_XZ

GRID_TYPE_ZY

GRID_TYPE_FREE

GRID_TYPE_NONE

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an
animation channel acting on this
object. If this function is called on a
type that cannot be animated (such as
Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key
frame acting on the object. If this
function is called on a type that cannot
be animated (such as Director), it
returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function
works like FindChannelOfObject except
that if no animation channel with the
specifed name exists, a new one is
created.

Function GetChannelsOfObject([out] v as
Array[Channel]) as Integer

(Inherited from Base) Fills the array v
with the animation channels acting on
this object, returning the number of
channels. If this function is called on a
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type that cannot be animated (such as
Director), v will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if
there are animation channels for this
object. If this function is called on a
type that cannot be animated (such as
Director), it always returns false.

Sub MoveToContainer(container as
Container)

Moves grid to the specified container
and aligns it.

Sub SetChanged() (Inherited from Base) Mark this object
as changed.

19.3.18 Image

Base type

Base

Description

An image object. This is used to retrieve an image’s properties.

Properties

Property Description

Name as String [read-only] The name of the image

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

Uuid as Uuid [read-only] The UUID of the image

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures
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Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.19 InfoText

Base type

Base

Description
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A container’s InfoText property. This type provides access to the parameters of the
InfoText plugin.

Properties

Property Description

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

Text as String Get/Set info text.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.
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Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.20 Integer

Description

A 32-bit signed integer.

19.3.21 Key

Base type

Base

Description

A key object. This is used to control a container’s key object.

Properties

Property Description

Active as Boolean

AlphaValue as Double

AutoAlpha as Boolean

DrawKey as Boolean

DrawRGB as Boolean

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.
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System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.
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Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.22 Key frame

Base type

Base

Description

An animation Key frame.

Properties

Property Description

ActionString as String Gets or sets the command string of an
action Key frame.

BoolValue as Boolean Gets or sets the value of a boolean Key
frame.

Channel as Channel [read-only] Gets the channel that contains this Key
frame.

ColorValue as Color Gets or sets the value of a color Key
frame.

EventDirection as Integer Get or sets the direction of an event Key
frame. Possible values are: ED_BOTH,
ED_NORMAL, ED_REVERSE

EventDuration as Double Get or sets the duration of an event Key
frame (in seconds).

EventValue as Integer Get or sets the type of an event Key
frame. Possible values are: ET_STOP,
ET_LOCAL_STOP, ET_TAG.

FloatValue as Double Gets or sets the value of a float Key frame.

IntValue as Integer Gets or sets the value of an integer Key
frame.

Locked as Boolean Gets or sets the locked status of a path
point Key frame.

MaterialValue as Material [read-only] Gets or sets the value of a material Key
frame.

Name as String Gets or sets the Key frame’s name.

NextKey frame as Key frame [read-only] Gets the next Key frame.
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NumberOfAxes as Integer [read-only] Returns the number of spline axes.

PathHandle as BezierHandle [read-only] Gets the associated path handle if this is a
position Key frame. If not, Null is returned.

PreviousKey frame as Key frame [read-
only]

Gets the previous Key frame.

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

Time as Double Gets or sets the Key frame’s time (in
seconds).

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

XyzValue as Vertex Gets or sets the value of a a rotation or
scaling Key frame or a path point Key
frame.

NumAxes as  Integer  [read-only] Deprecated. Use NumberOfAxes.

Member procedures

Name Description

Function Delete() as Boolean Deletes the Key frame.

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.
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You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetBezierHandle(axis as
Integer) as BezierHandle

Returns the bezier handle for the specified
axis. The axis parameter is only used
if the Key frame has multiple splines,
which is the case for rotation, scaling, and
material key frames. When called on a
position Key frame, this procedure returns
the handle for the distance spline. To
get the path handle, use the PathHandle
property instead.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

Sub UpdateAnimation() Update animation to reflect changes to
Key frame. (This update is not performed
in OnAir mode where the update is done
as soon as the animation is started.)

19.3.23 Light

Base type

Base

Description

A light object. Light objects are returned by the Scene’s GetLight member.
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Properties

Property Description

Attenuation as Double

Color as Color

Direction as Rotation

Position as Position

PositionTrackingActive as Boolean

PositionTrackingContainer as Container

RotationTrackingActive as Boolean

RotationTrackingContainer as
Container

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

Type as Integer The light type:

LIGHT_TYPE_LOCAL

LIGHT_TYPE_SPOT

LIGHT_TYPE_INFINITE

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".
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Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub ResetPositionTracking()

Sub ResetRotationTracking()

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.24 Material

Base type

Base

Description

A material object. This is used to control a container’s material.

Properties

Property Description

Alpha as Double The alpha value [0.0, 1.0]
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Ambient as Color The ambient color

Color as Color The color

Diffuse as Color The diffuse color

Emission as Color The emission color

Lit as Boolean Controls whether lighting is enabled.

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Shininess as Double The shininess [0.0, 1.0]

Specular as Color The specular color

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as VizCommunication
[read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
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"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.25 Matrix

Description

A 4x4 matrix. The index operator [] can be used to access individual entries, with
indices 0, 1, 2, 3 referring to the entries of the first column, 4, 5, 6, 7 to the second,
etc.

Member procedures

Name Description

Sub Frustum(left as Double, right as
Double, bottom as Double, top as Double,
near as Double, far as Double)

Function GetDeterminant() as Double

Function GetRotation() as Vertex

Function GetScaling() as Vertex

Function GetScaling2() as Vertex Returns the squared scaling factors.

Function GetTranslation() as Vertex

Function Invert() as Boolean

Sub LoadIdentity()
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Sub LoadMatrix() Performs a glLoadMatrix().

Sub MultMatrix() Performs a glMultMatrix().

Sub Ortho(left as Double, right as Double,
bottom as Double, top as Double, near as
Double, far as Double)

Sub Perspective(fov as Double, aspect as
Double, near as Double, far as Double)

Sub Rotate(angle as Double, v as Vertex)

Sub Rotate(v as Vertex)

Sub RotateX(angle as Double)

Sub RotateY(angle as Double)

Sub RotateZ(angle as Double)

Sub Scale(v as Vertex)

Sub Translate(v as Vertex)

Sub Transpose()

19.3.26 PluginInstance

Base type

Base

Description

This type provides access to the parameters of geometry or function plugin. Objects of
this type are returned by members of Geometry and Container.

Properties

Property Description

Active as Boolean Gets or sets the plugin instance’s active
state.

MTAlignGrid as Boolean Gets or sets grid alignment on or off
(default).

MTDOFEventDistribution as Boolean Distribute DOF events to other plugin
instances (default) or fire them only on the
local instance.

MTGrid as Grid Gets or sets the grid for the current plugin
instance.
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MTRegistered as Boolean [read-only] Is true if a control type was already
registered for the current plugin instance.

MTUseCenter as Boolean Gets or sets automatic center shift on
(default) or off.

PluginName as String [read-only] Gets the plugin name.

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Script as Script [read-only] Provides dynamic access to the script
functions of the plugin instance. (This only
makes sense for scripted plugins.)

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".
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Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function GetParameterBool(parName as
String) as Boolean

Gets a parameter value of type Boolean.

Function GetParameterColor(parName
as String) as Color

Gets a parameter value of type Color.

Function
GetParameterContainer(parName as
String) as Container

Gets a parameter value of type Container.

Function GetParameterDouble(parName
as String) as Double

Gets a parameter value of type Double.

Function GetParameterInt(parName as
String) as Integer

Gets a parameter value of type Integer.

Function GetParameterString(parName
as String) as String

Gets a parameter value of type string.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub MTRegister(stroke as Integer,
controlType as Integer)

Registers a control for a certain stroke in
the multitouch core. Control types:

MT_CONTROL_BUTTON

MT_CONTROL_PZR2D

MT_CONTROL_PZR2D_TILT

Sub MTRegisterEx(stroke as Integer,
controlType as Integer, params as
Array[Double])

Same as MTRegister but with the
additional possibility to set parameters for
the specified control.

Sub MTSetPosition(x as Integer, y as
Integer)

Sets the position of the container

Sub MTUnregister() Unregisters a control in the multitouch
core.

Sub PushButton(parName as String) Calls the OnExecAction handler of the
push button identified by parName.
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Sub SetChanged() (Inherited from Base) Mark this object as
changed.

Sub SetParameterBool(parName as
String, v as Boolean)

Sets a parameter value of type Boolean.

Sub SetParameterColor(parName as
String, v as Color)

Sets a parameter value of type Color.

Sub SetParameterContainer(parName
as String, v as Container)

Sets a parameter value of type Container

Sub SetParameterDouble(parName as
String, v as Double)

Sets a parameter value of type Double.

Sub SetParameterInt(parName as
String, v as Integer)

Sets a parameter value of type Integer.

Sub SetParameterString(parName as
String, v as String)

Sets a parameter value of type Dtring.

19.3.27 Position

Base type

Base

Description

A position object. This is used to control the position of a container, camera, or light.

Properties

Property Description

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

x as Double Gets or sets the x component.

xyz as Vertex Gets or sets the x, y, z components
combined into a vertex.
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y as Double Gets or sets the y component.

z as Double Gets or sets the z component.

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.
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19.3.28 Rotation

Base type

Base

Description

A rotation object. This is used to control the position of a container or light.

Properties

Property Description

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

x as Double Gets or sets the x component.

xyz as Vertex Gets or sets the x, y, z components
combined into a vertex.

y as Double Gets or sets the y component.

z as Double Gets or sets the z component.

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
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called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.29 Scaling

Base type

Base

Description

A scaling object. This is used to control the scaling of a container.

Properties

Property Description

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.
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VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

x as Double Gets or sets the x component.

xyz as Vertex Gets or sets the x, y, z components
combined into a vertex.

y as Double Gets or sets the y component.

z as Double Gets or sets the z component.

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.
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Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.30 Scene

Base type

Base

Description

A scene object. The Scene member of the Base type provides access to the current
scene.

Properties

Property Description

AlphaClearValue as Integer

AutoKeyActive as Boolean

AutoKeyPosition as Vertex

BackgroundColor as Color

CurrentCamera as Camera [read-only] The current camera

CurrentCameraIndex as Integer The index of the current camera

Location as String [read-only] The location of the scene

LocationPath as String [read-only] The full db location of the scene

Map as SharedMemory [read-only] The scene’s memory map, used for data
sharing within a scene.

Name as String [read-only] The name of the scene

RootContainer as Container [read-only] The topmost container in the scene tree

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Script as Script [read-only] The script object: it can be used used to
dynamically call member procedures of
the scene
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ScriptPluginInstance as PluginInstance
[read-only]

The script’s plugin instance

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

Uuid as Uuid [read-only] The UUID of the scene

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

Name Description

Sub AddLogMessage(message as String) Adds a log message to the scene log.

Function CreateRootContainer() as
Container

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindContainer(name as String)
as Container

Searches the scene tree for a container
named name. The search mode is
breadth-first. It’s possible to combine
a call to this function and multiple
calls to Container.FindSubContainer
into a single call by concatenating
the individual container names
using $ as a separator. For example,
scene.FindContainer("name1$name2")
has the same effect as
scene.FindContainer("name1").FindSubContainer("name2").

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.
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You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetCamera(cameraIndex as
Integer) as Camera

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function GetGrid(gridNumber as Integer)
as Grid

Gets a grid from the scene.

Function GetLight(lightIndex as Integer)
as Light

Function
GetScenePluginInstance(pluginName
as String) as PluginInstance

Provides access to the parameters of a
scene plugin instance.

Function GetUnlockedGrid() as Grid Gets the next unused grid from the scene.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Function IsBacklayer() as Boolean Returns true, if the script is executed
within Backlayer

Function IsFrontlayer() as Boolean Returns true, if the script is executed
within Frontlayer

Function IsMainlayer() as Boolean Returns true, if the script is executed
within Mainlayer

Function-screenPosToWorldGrid(dX as
Double, dY as Double) as Vertex

Converts the screen position to current
grid intersection point.

Function-screenPosToWorldPos(dX as
Double, dY as Double) as Vertex

Converts the screen position to the world
position.
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This would mean that if you assign the
returned vertex to a container (on root
level - no parent containers) position then
it moves exactly to the passed screen
position (orthogonal to camera).

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

Sub UpdateSceneTree() In authoring mode, this method causes
the scene tree GUI to be rebuilt. Ignored in
on-air mode.

Sub WorldPosToScreenPos(pos as
Vertex, [out] dX as Double, [out] dY as
Double)

Converts the world position to the position
on the screen.

19.3.31 Script

Description

The container’ script object. This is used to dynamically call member procedures of
another container.

19.3.32 ScriptSettings

Description

A script’s local settings.

Properties

Property Description

CallButtonDownForTopObjectsOnly as
Boolean

If set to true, the OnXButtonDown
procedures are called only if the container
contains the mouse cursor and is on top at
the mouse cursor position. Default = true.

CallEnterLeaveForTopObjectsOnly as
Boolean

If set to true, OnEnter/
OnLeave/OnEnterSubContainer/
OnLeaveSubContainer is called only if the
container is on top at the mouse cursor
position. Default = true.

CallMouseMoveForTopObjectsOnly as
Boolean

If set to true, OnMouseMove is called only
if the container contains the mouse cursor
and is on top at the mouse cursor position.
Default = false.

CallEnterLeaveForBackgroundObjects as 
Boolean

Deprecated. Use
CallEnterLeaveForTopObjectsOnly instead.
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CallMouseMoveForBackgroundObjects as 
Boolean

Deprecated. Use
CallMouseMoveForTopObjectsOnly instead.

19.3.33 SharedMemory

Base type

Base

Description

A storage object that holds a map of Variant objects indexed by a string. It can be used
for system-wide or scene-wide data sharing. To access an individual value, use the
index operator. Example:

‘ Script 1:
dim a = 123 ‘ define an integer variable
System.Map["my_global_variable"] = a
‘
‘ Script 2:
dim a = (Integer)System.Map["my_global_variable"]

Properties

Property Description

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

Name Description

Function ContainsKey(key as String) as
Boolean

Tests whether an element with the
specified key is in the map.

Function CreateKey(key as String) as
Boolean

Creates a new empty variable.

Function DeleteKey(key as String) as
Boolean

Deletes a variable.
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Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Sub GetKeys(keys as Array[String]) Fills the passed array with all defined keys.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Function LoadFromDb(path as String) as
Boolean

Loads the contents of the map from a
database file. The file is specified by path,
which must be an absolute path, such as
"/User/mem_map".

Sub RegisterChangedCallback(key as
String)

Causes OnSharedMemoryVariableChanged
to be invoked whenever the variable
identified by key is changed and
OnSharedMemoryVariableDeleted in
response to the key being deleted. If you
pass an empty string for key, the callbacks
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will be invoked whenever any variable in
the map is changed or deleted.

Function SaveToDb(path as String) as
Boolean

Saves the contents of the map into a
database file. The file is specified by path,
which must be an absolute path, such as
"/User/mem_map".

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

Sub UnregisterChangedCallback(key as
String)

Removes the binding set up by
RegisterChangedCallback.

19.3.34 Stage

Base type

Base

Description

A stage object. The Stage member of the Base type provides access to the current
scene’s stage.

Properties

Property Description

RootDirector as Director [read-only] Gets the topmost director in the stage.

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

Name Description

Sub ContinueAnimation() Continues the animation.
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Function CreateRootDirector() as
Director

If there is no root director this method
creates and returns a new one.

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindDirector(directorName as
String) as Director

Searches for a director named
directorName.

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Function IsAnimationRunning() as
Boolean

Returns true if the animation active.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.
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Sub StartAnimation() Starts the animation in the directors
selected in the diretor tree.

Sub StopAnimation() Stops the animation in all directors.

19.3.35 String

Description

A character string. Use the ‘&’ operator to concatenate strings.

Properties

Property Description

Length as Integer [read-only] Gets the length of the string.

Checking the length of a doublebyte
string:

You have to make sure to use the correct
function for calculating double byte
strings. Normal Doublebyte Fonts (Asian/
Cyrillic) are calculated wrong if you use
the string.length() function.

Solution: To get the prober length, you
have to convert it using Utf8ToAnsi()

Member procedures

Name Description

Sub AnsiToUtf8() Converts an ANSI encoded string (using
the system code-page) to UTF-8.

Sub Append(str as String) Appends ‘str’ to the string

Function EndsWith(str as String) as
Boolean

Returns true if the string ends with ‘str’

Sub Erase(pos as Integer, len as Integer) Erases a range of 'len' characters starting
at ‘pos’

Sub EraseChar(pos as Integer) Erases the character at ‘pos’

Function Find(substring as String) as
Integer

Searches for a substring

Function FindFirstNotOf(chars as String)
as Integer

Searches for the first character that is not
equal to any character within ‘chars’

Function FindFirstOf(chars as String) as
Integer

Searches for the first character that is
equal to any character within ‘chars’
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Function FindLastNotOf(chars as String)
as Integer

Searches for the last character that is not
equal to any character within ‘chars’

Function FindLastOf(chars as String) as
Integer

Searches for the last character that is
equal to any character within ‘chars’

Function GetChar(pos as Integer) as
String

Returns the character at ‘pos’

Function GetSubstring(pos as Integer,
len as Integer) as String

Returns a substring

Sub Insert(pos as Integer, str as String) Inserts ‘str’ before position ‘pos’

Sub Join(strings as Array[String], joiner as
String)

Concatenates individual strings

Function Left(len as Integer) as String Extracts ‘len’ characters from the left end
of the string

Sub MakeLower() Converts the string to an lower-case string

Sub MakeUpper() Converts the string to an upper-case string

Function Match(regex as String) as
Boolean

Returns true if the regular expression
‘regex’ is found int the string

Sub PadLeft(totalWidth as Integer,
paddingChar as String)

Right-aligns the characters of the string

Sub PadRight(totalWidth as Integer,
paddingChar as String)

Left-aligns the characters of the string

Sub Prepend(str as String) Inserts ‘str’ at the beginning of the string

Sub Replace(pos as Integer, len as
Integer, str as String)

Replaces the substring specified by ‘pos’
and ‘len’ with ‘str’

Sub ReplaceChar(pos as Integer, str as
String)

Replaces the character at ‘pos’ with ‘str’

Function RFind(substring as String) as
Integer

Searches backward for a substring

Function Right(len as Integer) as String Extracts ‘len’ characters from the right
end of the string

Sub Split(separators as String, [out] result
as Array[String])

Splits a string into substrings; if
‘separators’ is empty, whitespace
sequences act as separators. Example:

dim a as string = "Monday Thuesday
Wednesday"

dim b as Array[String]

a.split(" ",b)
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b will be
["Monday","Thuesday","Wednesday"]

Function StartsWith(str as String) as
Boolean

Returns true if the string starts with ‘str’

Function Substitute(regex as String,
subst as String, global as Boolean) as
Integer

Replaces ‘regex’ with ‘subst’. If ‘global’
is true, all occurences of ‘regex’ are
replaced. Otherwise, only the first
occurrece is replaced.

Sub TclSplit([out] result as Array[String]) Splits a string TCL-style-wise, using
whitespace as separators (TCL-style
means: Braced and double-quoted strings
are never split even if they contain
whitespace).

Sub Trim() Removes whitspace characters from both
ends of the string

Sub Utf8ToAnsi() Converts a UTF-8 encoded string to ANSI
(using the system code-page).

19.3.36 StringMap

Description

An associative array that maps strings to Variant objects. Use the index operator [] to
access individual elements.

Member procedures

Property Description

Sub Clear()

Function ContainsKey(key as String) as
Boolean

Sub DeleteKey(key as String)

Sub GetKeys(keys as Array[String]) Fills the passed array with all defined keys.

19.3.37 System

Base type

Base

Description

This type provides access to system-wide parameters and procedures.
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Properties

Property Description

BackScene as Scene [read-only] Returns the scene that is in the back layer
of the scene/render editor.

CurrentDirectoryPath as String Gets or sets the current directory path.

CurrentRefreshRate as Double [read-
only]

Gets the current refresh rate in seconds.

FrontScene as Scene [read-only] Returns the scene that is in the front layer
of the scene/render editor.

HostName as String [read-only] Gets the host name of the local computer.

IPAddressString as String [read-only] Gets the IP address of the local computer.
The format is a string that looks like
"10.211.54.199".

IsPostRecording as Boolean [read-only] Determines if in post mode.

LButtonState as Boolean [read-only] True if the left mouse button is pressed.

MainScene as Scene [read-only] Returns the scene that is in the main layer
of the scene/render editor.

Map as SharedMemory [read-only] The global memory map, used for system-
wide data sharing.

MButtonState as Boolean [read-only] True if the middle mouse button is
pressed.

MouseX as Integer [read-only] Gets the x position of the mouse cursor (in
screen coordinates).

MouseY as Integer [read-only] Gets the y position of the mouse cursor (in
screen coordinates).

OutputAspect as Double [read-only] Gets the output aspect ratio.

OutputFieldDominance as Integer
[read-only]

Gets the field dominance of current the
output field. (0=first field or progressive,
1=second field; )

OutputInterlaced as Boolean [read-only] Determines if the output format is
interlaced.

OutputRefreshRate as Double [read-
only]

Gets the output refresh rate in seconds.

OutputRetraceCounter as Integer [read-
only]

Gets the retrace counter.

OutputSystem as Integer [read-only] Gets the output system. (0=INACTIVE,
3=480I_5994_SMPTE259,
4=576I_5000_SMPTE259,
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5=720P_5994_SMPTE296,
6=720P_6000_SMPTE296,
10=1080I_5000_SMPTE274,
11=1080I_5994_SMPTE274,
12=1080I_6000_SMPTE274,
21=720P_5000_SMPTE296,
27=FULL_SCREEN, 28=USER_DEFINED ).

PostCurrentTime as Double [read-only] Get the current time in post mode.

PostFieldDominance as Integer [read-
only]

Gets the field dominance in post mode.
(0=first field or progressive, 1=second
field; )

PostRetraceCounter as Integer [read-
only]

Gets the retrace counter in post mode.

RButtonState as Boolean [read-only] True if the right mouse button is pressed.

RenderEditorHeight as Integer [read-
only]

Gets the height in pixels of the render
editor.

RenderEditorWidth as Integer [read-
only]

Gets the width in pixels of the render
editor.

RenderWindowHeight as Integer [read-
only]

Gets the height in pixels of the render
window.

RenderWindowWidth as Integer [read-
only]

Gets the width in pixels of the render
window.

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

ScreenHeight as Integer [read-only] Gets the height in pixels of the screen.

ScreenWidth as Integer [read-only] Gets the width in pixels of the screen.

ShowMouseCursor as Boolean Gets or sets the visibility state of the
mouse cursor.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VideoHeight as Integer [read-only] Gets the height in pixels of the output
video.

VideoWidth as Integer [read-only] Gets the width in pixels of the output
video.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.
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VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

RefreshRate as  DoubleVizCursiv  [read-
only]

Deprecated.

Member procedures

Name Description

Function DeleteFile(filename as String)
as Boolean

Deletes the file filename, returns true
when successfully

Function DirectoryExists(directory as
String) as Boolean

Returns true if the directory exists

Function ExploreDocument(filename as
String, activate as Boolean) as Boolean

Opens a directory in the Windows
Explorer. If activate is false, the Explorer
window is minimized.

Function FileExists(filename as String) as
Boolean

Returns true if the file exists

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
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object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function GetClipChannel(param_1 as
Integer) as ClipChannel

Gets the ClipChannel A (parameter = 0) or
B (parameter = 1)

Function GetDirectoryContent(dirname
as String, pattern as String) as
Array[String]

Returns an array with all files in the
directory dirname matching the pattern,
e.g.: *.jpg

Function GetElapsedTime() as Double Gets the time (in seconds) that has passed
since Viz was started.

Function GetNumberOfClipChannel() as
Integer

Gets the number of available Clip
Channels

Function
GetNumberOfTimecodeSources() as
Integer

Returns the number of registered
timecodes.

Function GetTimecode(Device as String,
Type as String) as Timecode

Returns a timecode object from device
with type.

Function GetTimecodeByIndex(Index as
Integer) as Timecode

Returns a timecode object by its index.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Function IsKeyDown(keyCode as Integer)
as Boolean

Returns true if the specified key is
pressed.

Function LoadBackScene(scenepath as
String) as Scene

Loads a scene file into the back layer of
the scene/render editor.

Function LoadFrontScene(scenepath as
String) as Scene

Loads a scene file into the front layer of
the scene/render editor.

Function LoadMainScene(scenepath as
String) as Scene

Loads a scene file into the main layer of
the scene/render editor.

Function LoadTextFile(filepath as String,
[out] result as String) as Boolean

Loads the text file identified by filepath
into result. Returns false if the file does
not exist or is not accessible.

Function
MouseOverIPDefineServer(serverAddress
as String, serverPort as Integer, localPort
as Integer) as Integer

Define another VizMouseServer
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Function MouseOverIPQuitServer() as
Boolean

Kill the all defined VizMouseServer

Function
MouseOverIPQuitServer(serverID as
Integer) as Boolean

Kill this VizMouseServer

Function MouseOverIPRegister(serverID
as Integer) as Boolean

Register the Viz Engine as client to receive
mouse events from this VizMouseServer

Function MouseOverIPRegister() as
Boolean

Register the Viz Engine as client to
receive mouse events from all defined
VizMouseServer

Function
MouseOverIPUndefineAllServers() as
Boolean

Undefine all known VizMouseServers.

Function
MouseOverIPUndefineServer(serverID
as Integer) as Boolean

Undefine the VizMouseServer with the ID
serverID.

Function
MouseOverIPUndefineServer(serverAddress
as String, serverPort as Integer, localPort
as Integer) as Boolean

Unefine the VizMouseServer with the
address serverAddress, the server port
serverPort and the local listening port
localPort

Function MouseOverIPUnregister() as
Boolean

Unregister the Viz Engine from all defined
VizMouseServer

Function
MouseOverIPUnregister(serverID as
Integer) as Boolean

Unregister the Viz Engine from this
VizMouseServer

Function MouseOverIPUnregisterAll()
as Boolean

Unregister all Viz Engines from all defined
VizMouseServer

Function
MouseOverIPUnregisterAll(serverID as
Integer) as Boolean

Unregister all Viz Engines from this
VizMouseServer

Function OpenDocument(filename as
String, activate as Boolean) as Boolean

Opens a document file. If activate is
false, the application loading the file is
minimized.

Sub PlaySound(filename as String) Plays a sound file.

Function SaveTextFile (filepath as String,
text as String) as Boolean

Saves the contents of text into the file
identified by filepath. Returns false if the
file cannot be written to.

Function SendCommand (command as
String) as String

Sends a command to the local Viz Engine.

Function SendRemoteCommand
(hostname as String, port as Integer,

Sends a command string to a Viz Engine
running on another PC.
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commandString as String, timeoutInMs as
Integer) as String

If timeoutInMs > 0, the procedure waits
at most timeoutInMs milliseconds for an
answer, and susequently returns that
answer.

If timeoutInMs = 0, the procedure returns
immediatly, ignoring any answer.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

Function StartApplication (filename as
String, parameters as String, activate as
Boolean) as Boolean

Launches an application. If activate is
false, the application window is minimized.

Sub StopSound() Stops sound playback. See PlaySound.

Function TcpSend (hostname as String,
port as Integer, commandString as String,
timeoutInMs as Integer) as String

Sends a command string via TCP/
IP to a remote socket. Unlike
SendRemoteCommand, this procedure
sends the command string as is, that
is without a viz command identifier
attached.

The timeoutInMs has the same meaning
as for SendRemoteCommand.

Sub TcpSendAsync (sharedMemoryKey
as String, hostname as String, port
as Integer, commandString as String,
timeoutInMs as Integer)

Sends a command string via TCP/IP to
a remote socket. Unlike TcpSend, this
procedure works asynchron and the return
result is stored in a shared memory map,
at your defined sharedMemoryKey.

The defined sharedMemoryKey or
its RegisterChangedCallback will be
searched in the maps in the following
order: Scene.Map, System.Map and
VizCommunication.Map

If timeoutInMs is set to 0 then
TcpSendAsync will wait until a answer is
received or as long as no error occurs (e.g.
host doesn’t exist).

Sub TcpSendAsyncStatus
(sharedMemoryKey as String, hostname
as String, port as Integer, commandString
as String, timeoutInMs as Integer,
sharedMemoryKeyStatus as String)

Same as TcpSendAsync but with additional
status Shared Memory Key which informs
you about the transmission process.
The following Messages (Strings) will be
returned in sharedMemoryKeyStatus:

SENDING

RECEIVED

ERROR

TIMEOUT

The timeoutInMs has the same meaning
as for TcpSendAsync.
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19.3.38 Texture

Base type

Base

Description

A container’s texture object.

Properties

Property Description

Active as Boolean

EffectType as Integer The effect type:

TX_EFFECT_BLUR

TX_EFFECT_MOSAIC

EffectValue as Integer The effect value as an integer ranging
0-100

EffectValueDouble as Double The effect value as a double ranging
0.0-100.0

EnvironmentType as Integer The environment type:

TX_ENV_BLEND

TX_ENV_DECAL

TX_ENV_MODULATE

Image as Image The texture image

MapPosition as Vertex The mapping position

MapRotation as Vertex The mapping rotation

MapScaling as Vertex The mapping scaling

MapType as Integer The mapping type:

TX_MAP_VERTEX

TX_MAP_LINEAR

TX_MAP_REFLECT

TX_MAP_SPHERICAL

TX_MAP_CYLINDRICAL

TX_MAP_CUBE

QualityType as Integer The quality type:

TX_QUAL_PIXEL

TX_QUAL_LINEAR

TX_QUAL_MIPMAP

TX_QUAL_SHARPEN
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Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

SharpenValue as Integer The sharpen value as an integer ranging
0-100

SharpenValueDouble as Double The sharpen value as a double ranging
0.0-100.0

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

WrapType as Integer The wrap type:

TX_WRAP_REPEAT

TX_WRAP_CLAMP

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".
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Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.39 Timecode

Base type

Base

Properties

Property Description

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

Name Description

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
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be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Sub Get([out] Hours as Integer, [out]
Minutes as Integer, [out] Seconds as
Integer, [out] Frames as Integer)

Writes the current value of the timecode
into Hours, Minutes, Seconds and Frames.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function GetDevice() as String Returns the device name of the timecode.

Function GetString() as String Returns the current value of the timecode
as string.

Function GetType() as String Returns the type of the timecode.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub SetChanged() (Inherited from Base) Mark this object as
changed.
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19.3.40 Uuid

Description

A Universally Unique Identifier.

Properties

Property Description

FullString as String [read-only] Returns the uuid as a string,
enclosed in angle brackets, e.g.
“7410EF6B-4271-4EFA-8E8E30212D9AD2A5”.

String as String [read-only] Returns the uuid as a string, e.g.
“7410EF6B-4271-4EFA-8E8E30212D9AD2A5”.

Member Procedures

Name Description

Sub GenerateNewUuid() Generates a new UUID.

19.3.41 Variant

Description

A variant type. Objects of this type can hold objects of any other type.

19.3.42 Vertex

Description

A vertex/vector consisting of 3 double components. The components can be accessed
either via the x, y and z members, or using the index operator []. For example, v.y and
v[1] both refer to the y component.

Properties

Property Description

X as Double The x component

Y as Double The y component

Z as Double The z component

Member procedures
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Function DistanceToLine(linePoint1 as
Vertex, linePoint2 as Vertex) as Double

Function DistanceToPlane(planeNormal
as Vertex, planePoint as Vertex) as Double

Function
DistanceToPlaneSigned(planeNormal as
Vertex, planePoint as Vertex) as Double

Function MirrorAroundLine(linePoint1 as
Vertex, linePoint2 as Vertex) as Vertex

Function MirrorAroundVector(v as
Vertex) as Vertex

Function Norm() as Double Returns the length of the vector.

Function Normalize() as Double Normalizes the vertex, i.e. scales it to
length 1.

Function Project(viewMat as Matrix,
projMat as Matrix, x as Integer, y as
Integer, width as Integer, height as
Integer) as Boolean

Function Project(mat as Matrix, halfwidth
as Integer, halfweight as Integer) as
Boolean

Function ProjectOnLine(linePoint1 as
Vertex, linePoint2 as Vertex) as Vertex

Function ProjectOnVector(v as Vertex)
as Vertex

Function SquaredNorm() as Double Returns the squared length of the vector.

Sub Unproject(viewMat as Matrix,
projMat as Matrix, x as Integer, y as
Integer, width as Integer, height as
Integer)

Function Unproject(viewMat as Matrix,
projMat as Matrix, x as Integer, y as
Integer, width as Integer, height as
Integer, plane1 as Vertex, plane2 as
Vertex, plane3 as Vertex) as Boolean

Sub GlNormal() Deprecated.

Sub GlVertex() Deprecated.
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19.3.43 VizCommunication

Base type

Base

Description

This class maintains a group of viz hosts that you can simultaneously send commands
to. In addition, there is a SharedMemory member (Map) that shares its data among all
engines connected to the database.

Properties

Property Description

Map as SharedMemory [read-only] Distributed shared memory map. Note
that other Viz Engine machines are
notified of changes made to this map only
if they are running at the time the change
is made.

Scene as Scene [read-only] (Inherited from Base) Gets the current
scene.

Stage as Stage [read-only] (Inherited from Base) Gets the current
stage.

System as System [read-only] (Inherited from Base) Gets system wide
data.

VizCommunication as
VizCommunication [read-only]

(Inherited from Base) Gets the
VizCommunication object.

VizId as Integer (Inherited from Base) Gets or sets the
internal id of this object.

Member procedures

Name Description

Sub AddHostToGroup(hostname as
String, port as Integer)

Adds a hostname to the group of
hostnames.

Sub ClearHostGroup() Clears the group of hostnames.

Function
FindChannelOfObject(channelName as
String) as Channel

(Inherited from Base) Finds an animation
channel acting on this object. If this
function is called on a type that cannot
be animated (such as Director), it returns
null.

You can limit the search to a
particular director by using the syntax
"directorName$channelName" for
the channelName argument. Nested
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Name Description

directors may be specified like this:
"directorName1$directorName2$channelName".

Function FindKey frameOfObject(Key
frameName as String) as Key frame

(Inherited from Base) Finds a Key frame
acting on the object. If this function is
called on a type that cannot be animated
(such as Director), it returns null.

You can limit the search to a
particular director by using the syntax
"directorName$Key frameName" for
the Key frameName argument. Nested
directors may be specified like this:
"directorName1$directorName2$Key
frameName".

Function
FindOrCreateChannelOfObject(channelName
as String) as Channel

(Inherited from Base) This function works
like FindChannelOfObject except that if no
animation channel with the specifed name
exists, a new one is created.

Function GetChannelsOfObject([out] v
as Array[Channel]) as Integer

(Inherited from Base) Fills the array v with
the animation channels acting on this
object, returning the number of channels.
If this function is called on a type that
cannot be animated (such as Director), v
will be empty.

Function IsAnimated() as Boolean (Inherited from Base) Returns true if there
are animation channels for this object.
If this function is called on a type that
cannot be animated (such as Director), it
always returns false.

Sub
SendVizCommandToHostGroup(command
as String)

Sends a viz command to the group of
hostnames (which was previously filled by
calls to AddHostToGroup).

Sub SetChanged() (Inherited from Base) Mark this object as
changed.

19.3.44 Global Procedures

Name Description

Function Abs(x as Double) as Double

Function Acos(x as Double) as Double

Function AngleBetweenVectors(v1 as
Vertex, v2 as Vertex) as Double

Function Asc(s as   StringVizCursiv  ) as
Integer

Returns the ASCII/UTF8 code (0-255) for
the specified character.
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Name Description

Function Asin(x as Double) as Double

Function Atan(x as Double) as Double

Function Atan2(x as Double, y as Double)
as Double

Function CBool(v as Integer) as  
BooleanVizCursiv

Converts an integer to a boolean.

Function CBool(v as Double) as  
BooleanVizCursiv

Converts a double to a boolean.

Function CBool(v as Uuid) as  
BooleanVizCursiv

Converts a UUID to a boolean.

Function CColor(r as Double, g as Double,
b as Double) as Color

Constructs a color object.

Function CColor(r as Double, g as Double,
b as Double, a as Double) as Color

Constructs a color object.

Function CDbl(v as   BooleanVizCursiv  )
as Double

Converts a boolean to a double.

Function CDbl(v as Integer) as Double Converts an integer to a double.

Function CDbl(v as String) as Double Converts a string to a double.

Function Ceil(x as Double) as Double Returns the smallest integer that is larger
than or equal to x.

Function Chr(charCode as Integer) as  
StringVizCursiv

Returns the character associated with the
specified ASCII/UTF8 code (0-255).

Function CInt(v as   BooleanVizCursiv  ) as
Integer

Converts a boolean to an integer.

Function CInt(v as Double) as Integer Converts a double to an integer.

Function CInt(v as String) as Integer Converts a string to an integer.

Function Cos(x as Double) as Double

Function Cosh(x as Double) as Double

Function CStr(v as   BooleanVizCursiv  ) as
StringVizCursiv

Converts a boolean to a string.

Function CStr(v as Integer) as  
StringVizCursiv

Converts a integer to a string.

Function CStr(v as Double) as  
StringVizCursiv

Converts a double to a string.
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Name Description

Function CStr(v as Uuid) as  
StringVizCursiv

Converts a UUID to a string.

Function CUuid(v as   StringVizCursiv  ) as
Uuid

Constructs a uuid from a string value.

Function CVertex(v as   BooleanVizCursiv 
) as Vertex

Constructs a vertex from a bool value,
assigning the value to x, y, and z.

Function CVertex(v as Integer) as Vertex Constructs a vertex from an integer value,
assigning the value to x, y, and z.

Function CVertex(v as Double) as Vertex Constructs a vertex from an double value,
assigning the value to x, y, and z.

Function CVertex(x as Double, y as
Double, z as Double) as Vertex

Constructs a vertex from 3 double values.

Function Determinant(a as Vertex, b as
Vertex, c as Vertex) as Double

Function Distance(v1 as Vertex, v2 as
Vertex) as Double

Returns the distance between two
vertices.

Function Distance2(v1 as Vertex, v2 as
Vertex) as Double

Returns the squared distance between two
vertices.

Function DoubleToString(value as
Double, precision as Integer) as  
StringVizCursiv

Converts a double value to a string.

Function DoubleToString(value as
Double, precision as Integer, width as
Integer) as   StringVizCursiv

Converts a double value to a string.

Function Exp(x as Double) as Double

Function Fix(x as Double) as Double Returns Floor(x) if x larger than or equal to
0.0, otherwise Ceil(x).

Function Floor(x as Double) as Double Returns the largest integer that is smaller
than or equal to x.

Function GetCurrentTime() as DateTime Gets the current time.

Function
GetParameterBool(parameterName as  
StringVizCursiv  ) as   BooleanVizCursiv

Returns the value of the Boolean
parameter parameterName.

Function
GetParameterColor(parameterName as 
StringVizCursiv  ) as Color

Returns the value of the Color parameter
parameterName.

Function
GetParameterContainer(parameterName
as   StringVizCursiv  ) as Container

Returns the value of the Container
parameter parameterName.
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Name Description

Function
GetParameterDouble(parameterName
as   StringVizCursiv  ) as Double

Returns the value of the Double parameter
parameterName.

Function
GetParameterInt(parameterName as  
StringVizCursiv  ) as Integer

Returns the value of the Integer
parameter parameterName.

Function
GetParameterString(parameterName as
StringVizCursiv  ) as   StringVizCursiv

Returns the value of the String parameter
parameterName.

Function GetTickCount() as Integer Returns the processor time in
milliseconds. Note that the timing
resolution provided by this procedure is
fairly low. For more accurate timing, use
System.GetElapsedTime() instead.

Function Int(x as Double) as Double Identical to Floor.

Function IntToString(value as Integer,
width as Integer) as   StringVizCursiv

Converts an integer value to a right-
aligned string, filling empty space with
blanks.

Function IntToString(value as Integer,
width as Integer, addLeadingZeros as  
BooleanVizCursiv  ) as   StringVizCursiv

Converts an integer value to a right-
aligned string, filling empty space with
blanks or (if addLeadingZeros is true) with
zeros.

Function Len(s as   StringVizCursiv  ) as
Integer

Returns the length of the specified string.

Function LineLineIntersection(line1Point
as Vertex, line1Direction as Vertex,
line2Point as Vertex, line2Direction as
Vertex) as Vertex

Function Log(x as Double) as Double

Function Max(a as Integer, b as Integer)
as Integer

Returns the larger of the two values.

Function Max(a as Double, b as Double)
as Double

Returns the larger of the two values.

Function Min(a as Double, b as Double) as
Double

Returns the smaller of the two values.

Function Min(a as Integer, b as Integer) as
Integer

Returns the smaller of the two values.

Function
PlaneLineIntersection(planePoint as
Vertex, planeNormal as Vertex, linePoint
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Name Description

as Vertex, lineDirection as Vertex) as
Vertex

Sub Println(v as Vertex) Prints a vertex.

Sub Println() Prints a newline.

Sub Println(v as   BooleanVizCursiv  ) Prints a boolean.

Sub Println(v as Integer) Prints an integer.

Sub Println(v as Double) Prints a double.

Sub Println(v as   StringVizCursiv  ) Prints a string.

Sub Println(v as Variant) Prints an object of type Variant.

Sub Println(v as Uuid) Prints a uuid.

Function Random() as Double Returns a random number of type double
in the range [0, 1).

Function Random(i as Integer) as Integer Returns a random integer in the range 0
through i-1.

Sub
RegisterDirSelector(parameterName as 
StringVizCursiv  , label as   StringVizCursiv
, default as   StringVizCursiv  )

Registers a directory parameter.

Sub
RegisterFileSelector(parameterName as
StringVizCursiv  , label as   StringVizCursiv
, defaultPath as   StringVizCursiv  ,
defaultFile as   StringVizCursiv  , filter as  
StringVizCursiv  )

Registers a file parameter.

Sub RegisterInfoText(infoText as  
StringVizCursiv  )

Call this function to provide
documentation for the script (accessible
via the ‘i’-button).

Sub
RegisterParameterBool(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , defaultName as  
BooleanVizCursiv  )

Registers a parameter of type Boolean.

Sub
RegisterParameterColor(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , defaultValue as Color)

Registers a parameter of type Color.

Sub
RegisterParameterContainer(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  )

Registers a parameter of type Container.
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Name Description

Sub
RegisterParameterDouble(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , defaultValue as Double,
minValue as Double, maxValue as Double)

Registers a parameter of type Double.

Sub
RegisterParameterDropDown(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , default as Integer,
entries as Array[  StringVizCursiv  ], width
as Integer, height as Integer)

Registers a dropdown box. width defines
the parameter’s width in number of
characters and height sets the dropdown
box’s height in number of lines.

Sub
RegisterParameterHList(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , default as Integer,
entries as Array[  StringVizCursiv  ],
separatorChar as   StringVizCursiv  , width
as Integer, height as Integer)

Registers a list box. separatorChar defines
the character which is used to separate
the values. width and height are defined in
pixels.

Sub
RegisterParameterImage(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  )

Registers a parameter of type Image.

Sub
RegisterParameterInt(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , defaultValue as Integer,
minValue as Integer, maxValue as Integer)

Registers a parameter of type Integer.

Sub
RegisterParameterList(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , default as Integer,
entries as Array[  StringVizCursiv  ], width
as Integer, height as Integer)

Registers a list box. width and height are
defined in pixels.

Sub
RegisterParameterSliderDouble(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , defaultValue as Double,
minValue as Double, maxValue as Double,
width as Integer)

Registers a parameter of type Double with
slider appearance. width specifies the
parameter’s width in pixels.

Sub
RegisterParameterSliderInt(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , defaultValue as Integer,
minValue as Integer, maxValue as Integer,
width as Integer)

Registers a parameter of type Integer with
slider appearance. width specifies the
parameter’s width in pixels.
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Name Description

Sub
RegisterParameterString(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , defaultString as  
StringVizCursiv  , widgetSize as Integer,
maxLength as Integer, charSet as  
StringVizCursiv  )

Registers a parameter of type String.
If charSet is empty, all characters are
allowed.

Sub
RegisterParameterText(parameterName
as   StringVizCursiv  , defaultText as  
StringVizCursiv  , width as Integer, height
as Integer)

Registers a parameter of type String that
is entered in a text box. width and height
specify the size of the text box in pixels.

Sub RegisterPluginVersion(version as
Integer, release as Integer, patchlevel as
Integer)

You can use this to set information
about your script-plugin’s version. It’s
recommended to set version numbers
especially for VSL plugins.

Sub
RegisterPushButton(parameterName as
StringVizCursiv  , label as   StringVizCursiv
, buttonId as Integer)

Registers a push button.

Sub
RegisterRadioButton(parameterName
as   StringVizCursiv  , label as  
StringVizCursiv  , defaultIndex as Integer,
buttonNames as Array[  StringVizCursiv  ])

Register a block of radio buttons.

Function Round(x as Double) as Double Rounds x to the nearest integer

Sub
SendGuiParameterShow(parameterName
as   StringVizCursiv  , state as Integer)

Shows or hides a parameter in the GUI.
state can be set to SHOW or HIDE.

Sub
SendGuiParameterUpdate(parameterName
as   StringVizCursiv  , state as Integer)

Enables or disables GUI parameter
updates. state can be set to ENABLED or
DISABLED.

Sub SendGuiRefresh() Sends a refresh command to the GUI

Sub SendGuiStatus(parameterName as  
StringVizCursiv  , state as Integer)

Enables or disables a parameter in the
GUI. state can be set to ENABLED or
DISABLED.

Sub SetAnimateParameter(animate as  
BooleanVizCursiv  )

Disable or enable animation on the last
registered parameter.

Sub SetHideParameter() Hides the last registered parameter in the
GUI.

Function Sign(x as Double) as Integer Returns -1 if x less than 0.0, 1 if x larger
than 0.0, 0 if x equals 0.0.
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Name Description

Function Sin(x as Double) as Double

Function Sinh(x as Double) as Double

Function Sqr(x as Double) as Double Returns x*x.

Function Sqrt(x as Double) as Double Computes the square root of x.

Function Tan(x as Double) as Double

Function TriangleArea(a as Vertex, b as
Vertex, c as Vertex) as Double

Function TriangleCenter(a as Vertex, b
as Vertex, c as Vertex) as Vertex

Sub
UpdateGuiParameterDoubleDefMinMax(parameterName
as   StringVizCursiv  , defaultValue as
Double, minValue as Double, maxValue as
Double)

Sets new default, min and max value for
parameters like Double, SliderDouble etc.

Sub
UpdateGuiParameterEntries(parameterName
as   StringVizCursiv  , entries as Array[ 
StringVizCursiv  ])

Sets new entries for parameters like List or
DropDown

Sub
UpdateGuiParameterIntDefMinMax(parameterName
as   StringVizCursiv  , defaultValue as
Integer, minValue as Integer, maxValue as
Integer)

Sets new default, min and max value for
parameters like Int, SliderInt etc.

Function IsKeyDown(keyCode as  Integer )
as  BooleanVizCursiv

Deprecated. Use System.IsKeyDown.

Function IsLButtonDown() as 
BooleanVizCursiv

Deprecated. System.LButtonState.

Function IsMButtonDown() as 
BooleanVizCursiv

Deprecated. System.MButtonState.

Function IsRButtonDown() as 
BooleanVizCursiv

Deprecated. System.RButtonState.

Function SendCommand(command as 
StringVizCursiv ) as  StringVizCursiv

Deprecated. Use System.SendCommand.

Function SendRemoteCommand(hostname
as  StringVizCursiv , port as  Integer
, commandString as  StringVizCursiv
, timeoutInMs as  Integer ) as 
StringVizCursiv

Deprecated. Use
System.SendRemoteCommand.

Function TcpSend(hostname as String,
port as  Integer , commandString as 

Deprecated. Use System.TcpSend.
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Name Description

StringVizCursiv , timeoutInMs as  Integer )
as  StringVizCursiv
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20 Shared Memory (SHM)

The information in this section relates to the VizCommunication.Map.

A local VizCommunication.Map in each Viz Engine (as part of a cluster), collects and
stores data. This data can be internal data, like a scene script pushing data to the map,
or data from external control applications through TCP or UDP.

This section contains information on the following topics:

• External Data Input

• Internal Data (Interactive Scene)

• Synchronization

• Snapshot

See Also

• Data Sharing

20.1 External Data Input
Data feed into the Shared Memory (SMM) should be done through the dedicated UDP
or TCP IP ports for the SMM. Vizrt provides a set of components, SendToSMM, to makes
this task easier.

Note: Go to <Viz Install Directory> -> Tools -> SendToSMM, for more information
about SendToSMM.

Data can also be sent to SHM through a Command Interface. Data sent through the
Command Interface may be seen as a good option because the data would need to be
sent to one Viz Engine only, and this Viz Engine engine would then distribute the data
to the other Viz Engines. But Data sent to SHM through the Command Interface has
problems:

• Data sent through the Command Interface will block the render queue of the
receiving engine causing potential frame drops. Since the data needs to be sent
through a command significant more bytes are transferred over the Network.

• This Viz Engine is also a single point of failure

• The data will arrive at this one Viz Engine sooner than on all other Viz Engines

• The notification method of the Viz Graphic Hub is used to distribute the data and
can cause additional load for the Viz Graphic Hub
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The preferred method to send data is to use the ‘SendToSMM’ library (or an equivalent)
to send the data to the individual Viz Engines.

The communication protocol for the import of Shared Memory data depends on the
type and final output of the data. There are set protocols to use with large amounts of
data, in which all of the data must reach its destination graphic, and also where large
amounts of data must be received, quickly, but some loss of data is acceptable.

For use cases see:

• TCP Protocol

• UDP Protocol

• Plugin API

• Command Interface

Note: It is also possible to import data through Multicast. This method is not
recommended as it can pollute the network.

This section contains information on the following topics:

• TCP Protocol

• UDP Protocol

• Plugin API

• Command Interface

20.1.1 TCP Protocol

The SHM TCP communication protocol guarantees a reliable delivery of packages. It is
a much more efficient than the Command Interface, but not as fast as the UDP Protocol
protocol.

Use cases for a TCP connection could be finance stocks and currencies, or election
result information, where the requirement is to deal with large amounts of information,
and all of this data must reach its destination graphic. A single piece of lost data can
have economic consequences, falsify charts, show mathematically wrong results, etc.

A TCP connection to a Viz Engine can be held open for a long time (this is
recommended), and should not be opened and closed between sending variables.
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Note: The default maximum number of TCP connections is limited to 255. Within
this number of connections a User defined limit of maximum connections can be
set (see To limit the number of TCP connections)

IMPORTANT! The external program which provides the data, must connect
and send the data to each Viz Engine individually. Vizrt provides a C# library,
SendToSMM (part of the Viz install), for this purpose.

To use TCP for SHM

1. Go to the Configuring Viz.

2. Click on Communication.

3. Click on the Shared Memory tab.

4. In the Shared Memory panel set these parameters:

• TCP Port: Vizrt does not recommend a specific port. Always make sure that the
selected port is not in use by any other program on the same subnet.

5. Click Save.

The syntax for the key-value pairs is:

• key|value\0

Multiple key-value pairs can be sent, at once, as well. To do this make sure that each
pair is terminated with 0.

• key1|value1\0key2|value2\0key...

See Also

• UDP Protocol

• Plugin API

• Command Interface

20.1.2 UDP Protocol

The SHM UDP communication protocol should be used for the delivery of volatile data.
It is quicker than the TCP Protocol protocol, but less reliable, and is much more efficient
than the Command Interface.

A use case for UDP would be Motor Sports, where data like speed, velocity, etc., is
required. This is where there is a requirement to deal with large amounts of data, but
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not all of this data must reach its destination. A single piece of data lost will not affect
the constant data update.

To use UDP for SHM

1. Go to the Configuring Viz.

2. Click on Communication.

3. Click on the Shared Memory tab.

4. In the Shared Memory panel set these parameters:

• UDP Port: Vizrt does not recommend a specific port. Always make sure that the
selected port is not in use by any other program on the same subnet.

5. Click Save.

The syntax for sending key-value pairs is the same as for TCP and UDP Synchronization.

See Also

• TCP Protocol

• Plugin API

• Command Interface

20.1.3 Plugin API

An option to manipulate data in SHM is by a plugin interface.

A use case would be where a TCP or UDP connection can not be used, or is not to be
used. It is possible to write a plugin to import data (e.g. from an XML file, another
database, etc.) and push it to SHM.

Another use case would be an interactive Scene (see 20.2 Internal Data (Interactive
Scene)).

Note: The Plugin API is documented in the plugin API documentation and
comes with the Viz installer (go to, Start -> All Programs -> vizrt -> Viz 3.x -
> Documentation -> Plugin SDK Documentation -> Classes -> Class LIst ->
Shared_Memory).

See Also

• TCP Protocol

• UDP Protocol
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• Command Interface

20.1.4 Command Interface

For small and single value changes the Command Interface of Viz Artist can be used.
For example, to update a headline in a Scene.

IMPORTANT! A command operation can block the renderer. If there are too many
commands, within a small time, or commands containing a large amount of data,
are sent, this can result in not rendering real-time anymore.

Note: Vizrt do not recommend this as a method for data import.

Any external program should consider the performance of the single or all connected
Viz Engines. If there is a burst of thousands of SHM variables this can have implications
on the Viz Engine rendering performance (Current (CUR) and Maximum (MAX)).

A full list of commands is at:

• C:\ProgramFiles\vizrt\Viz3\Documentation\CommandInterface\index.html

Note: Detailed path is for 32bit Windows. For 64bit Windows: C:
\ProgramFiles(x86)\vizrt\...

Note: From the list of commands, the commands, CLEAR, DELETE_ELEMENT and
PURGE_ELEMENT will only work when sent through the command interface of Viz
Artist.

IMPORTANT! The command CLEAR must be run on each Engine where the MAP is
to be reset (VIZ_COMMUNICATION*MAP CLEAR).

Whenever a new entry is made in the map (a new key-value pair) or values are
changed, then the change is propagated to the other Viz Engines through a database
messaging service to update the local copy of each Viz Engine’s map (this only works
when sent over the general communication port of Viz Engine (default port 6100)).

Command Examples

VIZ_COMMUNICATION*MAP can be used to access the map.

SET_DOUBLE_ELEMENT and GET_DOUBLE_ELEMENT

Example: VIZ_COMMUNICATION*MAP SET_DOUBLE_ELEMENT "my_double" 1.2

Example: VIZ_COMMUNICATION*MAP GET_DOUBLE_ELEMENT "my_double"

See Also

• TCP Protocol

• UDP Protocol
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• Plugin API

20.2 Internal Data (Interactive Scene)
When data is modified on one Viz Engine through a script or through a plugin, the data
change will get reflected on the other Viz Engines automatically.

A use case could be a touch screen scene which modifies data, which is also used for
HD-SDI Viz Engines or Viz Engines driving a Video Wall.

This synchronization uses the Viz Graphic Hub as a relay. Therefore it is important that
all Viz Engines, which are to receive the data, are connected to the same Viz Graphic
Hub, which use the same user or at least the same group.

20.3 Synchronization
If a Viz Engine is restarted or added to the cluster of Viz Engines for playout, the
VizCommunication.Map data will not available on this Viz Engine. The local map on a
new or restarted Viz Engine can be synchronized with the local map on another running
Viz Engine in the same cluster.

Example: If Viz Engine 1 restarts it will look to, for example, Viz Engine 3 to
update it’s local VizCommunication.Map.

A start-up Viz Engine can be synchronized through:

• TCP, or

• UDP, or

• An External Control Application, or

• Commands

This section contains information on the following topics:

• TCP and UDP Synchronization

• External Control Synchronization

• Command Synchronization
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20.3.1 TCP and UDP Synchronization

Use the procedure detailed below to synchronize a restarted or added Viz Engines, in a
cluster, with the TCP or UDP protocol:

• TCP: The recommended communication protocol to synchronize maps on start-up
because it is reliable and efficient (see TCP Protocol).

• UDP: For fast communication, but has drawbacks. For instance, packets can get lost
(see UDP Protocol).

To Synchronize a Viz Engine with TCP or UDP

1. Go to the Configuring Viz.

2. Click on Communication.

3. Click on the Shared Memory tab.

4. Enter the port number for:

• UDP Port, or

• TCP Port

Note: Vizrt does not recommend a specific port number. Always make sure
that the selected port number is not in use by any other program on the
same subnet.

5. In Master Engine Ip Address type the Ip address of a running Viz Engine to
synchronize with. Example <IP/hostname of Viz Engine 3>.

Note: Must be the Ip address of a running Viz Engine in the same cluster
system.

6. In Master Engine Port type the port number to be used (default 6100).This
port sends the single startup synchronization command to start synchronizing. It
should be the same as the general communication port of the Viz Engine set in
Master Engine Ip Address.

7. In Master Poll click on:

• UDP, or

• TCP

Note: Must be the same protocol as selected in step 4.

8. Click Save.

See Also
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• Command Synchronization

20.3.2 External Control Synchronization

Synchronization can also be done from an External Control Application. The following
command has to be sent to the Viz Engine which has the memory map populated:

• From a Command Interface

VIZ_COMMUNICATION SYNCHRONIZE_TO <engine port> 

where the Viz Engine is the engine which receives the data through the Command
Interface. Thgerhare port is usually 6100 (standard command interface port).

Note: Vizrt do not recommend this as a method for synchronization.

• Through TCP Communication

VIZ_COMMUNICATION SYNCHRONIZE_SMMTCP <engine port>

where the Viz Engine is the engine which receives the data, and the port is the one that
was specified for incoming TCP key|value pairs on the Viz Engine which is to recieve the
data (see TCP Protocol).

• Through UDP Communication

VIZ_COMMUNICATION SYNCHRONIZE_UDP <engine port> 

where the Viz Engine is the engine which receives the data, and the port is the one that
was specified for incoming UDP key|value pairs on the Viz Engine which is to recieve
the data (see UDP Protocol).

20.3.3 Command Synchronization

Another communication option is by Commands. Here each map entry is synchronized
through commands.

It is reliable, but very slow and blocks the engine for quite an amount of time, if the
map is large.

Note: Vizrt do not recommend this as a method for synchronization.

To synchronize a Start-up Viz Engine with Commands

1. Go to the Configuring Viz.

2. Click on Communication.

3. Click on the Shared Memory tab.

4. In the Shared Memory panel set these parameters:

• Master Engine Port: Enter the communication port of the Master engine (default
is 6100).

• Master Poll: Click on Commands.

5. Click Save.
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See Also

• TCP and UDP Synchronization

20.4 Snapshot
It is also possible to take a data ‘snapshot’ (save the whole content of the map) at
any time. One Viz Engine can save the whole content of the map by calling the map’s
SaveToDb procedure, and another client can read it by calling LoadFromDb.

The downside of this approach is that these functions block the renderer and can cause
poor performance of the Viz Graphic Hub database, if the map is stored repeatedly.

IMPORTANT! The resulting SHM map objects are replicated as well. So saving the
map each field or every minute can result in serious problems for the Viz Graphic
Hub database (replication failing, etc.).

Note: For more information see the script function documentation. Go to, Start
-> All Programs -> vizrt -> Viz 3.x -> Documentation -> Script Documentation -
> Data Types and procedures -> Shared Memory, or <Viz Install Directory> ->
ScriptDoc -> DataTypeSharedMemory.

See Also

• External Data Input

• Synchronization
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21 Working with FBX Files

Viz Artist’s built-in FBX Importer reads Autodesk’s exchange file format for 3D assets.
FBX files (.fbx) are normally saved in a binary (or native) format, but they can also be
saved in ASCII format. Binary FBX files and ASCII FBX files both use the .fbx filename
extension.

Which features of a scene, that can be carried over to a Viz Scene, depends on:

• FBX support of a 3D modeling application

The FBX file format supports many common features of a 3D scene. But not every
feature offered by the major 3D modeling packages can be covered by an interchange
format.

Refer to the documentation of the 3D modeling application to discover which features
can be exported to the FBX format.

• Availability of the contained features in Viz Engine

Viz Engine’s feature is optimized for real-time. Features which are not available in Viz
Engine cannot be imported and are ignored.

Note: Certain effects can be technically possible in Viz Engine but would require
an elaborate conversion which may not be available.

To import an FBX file to Viz Artist, see Importing.

This chapter contains information on the following topics:

• Scene Graph Traversal

• Transformations

• Exporting FBX Files from 3ds Max and Maya

21.1 Scene Graph Traversal
The Scene representation in the form of a Scene Graph is common to all 3D
applications, the FBX file format is also built this way.

When an FBX file is imported to Viz the Scene Graph is traversed node by node. All
child nodes are traversed before advancing to the next sibling node.

This is how FBX nodes are transformed into Viz containers:

Scene graph traversal, child nodes first
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FBX node types and how they are translated into Viz scene tree elements

FBX Node Child Nodes Viz Tree

Empty Imported Group

Camera Ignored Imported into global camera

Light Ignored Imported into global light

Mesh Imported Geometry

Other Imported Group

21.2 Transformations
The computation of transformations is more streamlined in Viz Engine than in
FBX because the focus is on real-time graphics. To limit computing time spent on
transformations the number of parameters incorporated in computing the final
transformation matrix has deliberately been kept low in Viz.

In contrast, in a 3D modeling application the number of parameters incorporated in
computing the final transformation matrix is high, to give maximum flexibility.

Note: If unsupported transformation features are contained in a FBX scene, Viz
Engine will try to provide them by combining several transformations into one
(maintaining the transformation order). This limits animation and can only work
to a certain degree, after which the engine will fall back to baking the imported
transformation onto the imported vertices.

• Baking transformations: This is the fallback which may be chosen for imported
nodes as necessary. It implies computing the transformation matrix with the FBX
formula and to apply the result to the imported vertices.

• The good: To Bake the imported transformations onto the imported vertices
basically means that arbitrarily complex transformations can be imported into Viz
Engine.

• Drawback: Any information on how the result of a complex transformation has
been obtained is discarded through baking. In particular individual elements of the
transformation cannot be animated anymore.

This section also contains information on the following topics:

• Avoid Transformations Being Baked

• Avoid Transformations Being Combined

21.2.1 Avoid Transformations Being Baked

If unsupported features are detected the transformations of those nodes are Baked,
which means that individual transformations are not retained in a Viz Scene. The
transformed vertices will be in the Viz Scene, but with all transformation parameters
reset to their default values.
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To avoid this make sure that unsupported features are not used in a Scene and, ideally,
that the FBX properties which import into the same transformation in a Viz Scene are
not used at the same time:

• Do not use a scaling offset

An extra offset applied after rotation and before scaling. It depends on the modeling
application if it is available and under which name. To be on the safe side try to limit
this to the regular translation and the rotation pivot.

• Do not use a separate scaling pivot

This can be tricky, depending on the 3D modeling application. In Maya the two pivots
move together by default, which keeps the possibility to map them both to a single axis
center in Viz Engine.

If the modeling application moves the rotation pivot separately by default, and objects
are scaled afterwards, there will be two transformations based on different pivots. Viz
Engine will have to bake the results to reflect them correctly.

FBX Import: Avoid separate scaling pivot

Rotation and scaling pivot identical Object rotated and/or
scaled

Ok, fully retained in a
Viz Scene

Rotation and scaling pivot different Object not scaled Ok

Object scaled Baked

Note: More complex transformation hierarchies can be built and multiple pivots
simulated by placing the objects in groups and apply additional transformations
to the group or groups. This is reproduced in the scene tree when importing to Viz
Engine.

See Also

• Transformations

• Avoid Transformations Being Combined

21.2.2 Avoid Transformations Being Combined

If, during import, two FBX properties have to be combined into a single property in Viz,
they can not be animated separately anymore. Limitations are not fully specified yet,
since animation import is still under development, but to keep 100% the same control
over transformations as in the original scene it is a good idea to consider the these
tips:

• Do not use a rotation offset

• Do not use geometric translation/rotation/scaling in 3ds Max

• Do not use unit converstion (see Exporting FBX Files from 3ds Max and Maya)

• Do not use axis conversion

• FBX uses a Y-up axis system, this is also the default setting for the FBX export. If the
modeling application uses a different axis system it will apply pre-rotation of ± 90°
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to all objects to change the orientation of the Scene to match the FBX axis system.
This can interfere with animation.

• Maya uses a Y-up axis system by default so all pre- and post-rotations will be set to
zero, which is perfect. If the modeling application uses another axis system (e.g. 3ds
Max uses Z-up) and problems occur it is possible to select a different option in the
‘Axis Conversion’ section in the FBX export settings, so that no corrective rotation
has to be applied.

See Also

• Transformations

• Avoid Transformations Being Baked

21.3 Exporting FBX Files from 3ds Max and Maya

To export FBX files from 3ds or Maya

1. From the File menu in Maya 2013, select Export (All)… or Export Selection….

2. Select a directory and enter a filename.

Note: Make sure that FBX is selected as the export file type to make export
options show.

This section also contains information on the following topics:

• VizBoldUnits

• VizBoldMaterials

• VizBoldOther Materials

• VizBoldTextures

• VizBoldCamera

• VizBoldLights

• VizBoldSpotlights

21.3.1 Units

It depends on each modeling application how units in virtual 3D space correspond to
real world units. The default working unit is centimeters. When a Scene is exported
choose a scale factor in the FBX export dialog, the option is named File units
converted to and can be found in section Advanced Options > Units.

The table below shows how units import from Maya into Viz Artist when different
settings are used:

Maya units imported in to Viz Artist

Maya Working
Units

Object size in Maya File units
converted to

Size in Viz
Artist

Scaling
factor

Centimeter 6 Centimeters 6 1

Centimeter 6 Millimeters 60 10
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Caution: It is recommended that Scenes are built so that a scaling factor of 1 will
do or, if this is not possible, scale the Scene up in Viz Artist after it is imported.
The reason: If scaling is enabled during export Maya will automatically alter the
Scene to preserve the hierarchical transformation results. In some cases this will
cause problems, e.g. create scaling pivot points, which are not supported in Viz.

21.3.2 Materials

Viz Engine supports one material per mesh node. The first material found on a FBX
node is imported into a Material object, which is then applied to the Viz Container.

Note: Multiple or layered materials are not supported.

Supported FBX material classes are:

• Lambert ShadingVizBold

• Phong ShadingVizBold

Both types of shading have there own set of parameters which are described in more
detail in the tables below:

Lambert Shading

FBX 3ds Maya Viz

Ambient Color Ambient Ambient Color Ambient

Diffuse Color Diffuse Color Diffuse

Diffuse Factor - Diffuse Diffuse Color Attenuation

- - - Specular =0,1%

Emissive Color Self-Illumination Incandescence Emission

Transparency
Factor/Color

Opacity (%) Transparency
(Color)

Alpha

Phong Shading

FBX 3ds Maya Viz

Ambient Color Ambient Ambient Color Ambient Color

Diffuse Color Diffuse Color Diffuse Color

Diffuse Factor - Diffuse Diffuse Color Attenuation

Emissive Color Self-Illumination Incandescence Emission Color

Specular Color Specular Specular Color Specular Color

Specular Factor Specular Level - Specular Color
Attenuation
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FBX 3ds Maya Viz

Shininess Glossiness Cosine Power Shininess

Transparency
Factor/Color

Opacity (%) Transparency
(Color)

Alpha

21.3.3 Other Materials

Other kinds of material which the modeling application supports may be mapped to
a FBX Lambert or Phong material by the exporter, at least the parameters which are
compatible to those material types.

21.3.4 Textures

FBX can associate a texture with each color channel on a material.

Note: Currently one texture for the diffuse color channel is supported.

Textures are referenced by the FBX file through their path and filename by default. This
feature is broken in the current FBX SDK provided by Autodesk, i.e. the exported file
may contain an absolute path and in some cases this path will not even be correct on
the machine where the file was created.

Alternatively the texture images can be embedded into the FBX file which is a lot more
robust. Tick the check-box Embed Media in the export dialog to enable this.

Note: Regardless of the export parameters chosen, the FBX file can still contain
incorrect texture references. If texturing problems occur use a free FBX viewer
(e.g. the QuickTime plugin) to check if the texture import really failed or if there is
a problem with the Viz import.

21.3.5 Camera

Currently up to 16 cameras are imported. The import is limited and can give little more
than the correct camera position and direction. Dependant on the transformations that
have been applied to a camera, and additional parameters unique to the modeling
application, the camera position and viewing parameters can deviate a lot after import.

21.3.6 Lights

The lights detailed below are supported, but not all their parameters are imported:

Supported lights

Lights

3ds Target Spot

Free Spot

Target Directional (Switch to ‘Overshoot’ to make them resemble Viz Artist’s
‘Infinite’ lights)
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Lights

Directional (Switch to ‘Overshoot’ to make them resemble Viz Artist’s
‘Infinite’ lights)

Omni (Switch to ‘Overshoot’ to make them resemble Viz Artist’s ‘Infinite’
lights)

Maya Directional Light

Spot Light

Point Light

The only animation properties imported for Lights are:

• Translation

• Cutoff / Cone Angle (because hardware accelerated OpenGL lights are limited,
this is unlikely to produce the exact same effect produced in the modeling software)

Color animation is not imported because it requires separate channels for red, green
and blue components.

21.3.7 Spotlights

For performance reasons Viz Engine only supports the standard OpenGL light
parameters.

OpenGL spotlight parameters and corresponding light parameters in Viz

OpenGL Viz Description

Cutoff Cone Angle Specifies the angle between the axis of the light cone
and a ray along the edge of the cone.

Can also be named ‘outer cone angle’.

Exponent Penumbra Controls how concentrated the light is. The light’s
intensity is highest in the center of the cone. It’s
attenuated toward the edges of the cone by the cosine
of the angle between the direction of the light and the
direction from the light to the vertex being lit, raised to
the power of the spot exponent.

FBX translates a modeling application’s spotlight parameters to an inner and outer
cone angle. During import into Viz the exponent is approximated based on the inner
angle of the spotlight. Results can be different from what is seen in Maya or 3ds.

Note: Exponent in Maya: Maya has an alternative spotlight parameter, ‘Dropoff’,
which corresponds directly to the OpenGL parameter ‘Exponent’. With the Viz
Artist VizFbxExtension plugin this parameter can be exported. This allows work
with real GL-spotlight parameters in Maya and gives a viewport lighting much
more faithful to the actual rendering results in Viz. Without the VizFbxExtension
plugin Maya does not export that parameter, because no other Autodesk product
supports importing it.
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22 Glossary

This section describes words and acronyms that are used throughout the
documentation:

5.1

Delivers five audio channels and 1 Low-frequency Effect (LFE) channel from a 6 channel
source.

6DoF

Six degrees of freedom (6DoF) is used in interactive scenes to move and rotate objects
in 3D on a defined grid.

7.1

Delivers seven audio channels and one Low-frequency Effect (LFE) channel from an 8
channel source.

AES

Audio Engineering Society (AES). Also known for the digital audio standard frequently
called AES/ EBU , officially known as AES3, is used for carrying digital audio signals
between various devices; hence, the term AES/EBU connectors.

AGP

Accelerated Graphics Port (AGP) is a high-speed point-to-point channel for attaching a
graphics card to a computer’s motherboard, primarily to assist in the acceleration of 3D
computer graphics.

Anamorphic widescreen

Anamorphic widescreen is a videographic technique utilizing rectangular (wide) pixels
to store a widescreen image to standard 4:3 aspect ratio.

ANC data

Ancillary data refers to a means which by non-video information (such as audio, other
forms of essence, and metadata) may be embedded within the serial digital interface
(SDI). Ancillary data packets are commonly divided into two types, depending on where
they are located.

Ancillary packets located in the horizontal blanking region (after EAV but before SAV),
regardless of line, are known as horizontal ancillary data, or HANC. HANC is commonly
used for higher-bandwidth data, and/or for things that need to be synchronized to a
particular line; the most common type of HANC is embedded audio.

Ancillary packets located in the vertical blanking region, and after SAV but before
EAV, are known as vertical ancillary data, or VANC. VANC is commonly used for low-
bandwidth data, or for things that only need be updated on a per-field or per-frame
rate. Closed caption data and VPID are generally stored as VANC.
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Note: ANC packets which lie in the dataspace which is in both the horizontal and
vertical intervals, is considered to be HANC and not VANC.

Anti aliasing

Anti-aliasing is the technique of minimizing the distortion artifacts known as aliasing
when representing a high-resolution signal at a lower resolution.

Audio codec

An audio codec is a hardware device or a computer program that compresses and
decompresses digital audio data according to a given audio file format or streaming
audio format.

AVI

Audio Video Interleave (AVI): is a multimedia container format introduced by Microsoft
in November 1992 as part of its Video for Windows technology.

Bi-level sync

In standard-definition applications, a bi-level sync signal, often with a colorburst signal
in facilities that have analog equipment. Typically, this is either in NTSC or PAL format.
As the resulting signal is usually indistinguishable from an all-black television signal of
the same format, this sort of reference is commonly known as black or black burst. See
SPG and Tri-level sync.

BIOS

Basic Input/Output System (BIOS) is a system that defines the firmware interface. The
initial function of the BIOS is to identify, test, and initialize system devices, and prepare
the machine into a known state.

Black burst

See SPG and Bi-level sync.

BNC

The BNC (Bayonet Neill Concelman) connector is a very common type of RF connector
used for terminating coaxial cable.

BSOD

The Blue Screen of Death (also known as a stop error or blue screen) is an error
screen displayed by some operating systems, most notably Microsoft Windows, after
encountering a critical system error which can cause the system to shut down, to
prevent damage.

Configuration file

Holds all configurable settings used by Viz Engine and various integrated applications.
The configuration file can be found at: <Install Directory>\viz3\.

CVBS
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Composite video (aka CVBS or Composite Video Burst Signal) is the format of an analog
television (picture only) signal before it is combined with a sound signal and modulated
onto an RF carrier. It is a composite of the three source signals Y, U and V ( YUV ) with
sync pulses.

D10 Television

Type D-10 Stream Specifications: MPEG-2 4:2:2P @ ML for 525/60 and 625/50. SMPTE
D10 (356M) is a professional video compression format composed of MPEG-2 Video
4:2:2 Intra-frame (I-frame) only and 8 channel AES3 audio streams.

D12 Television

6.35-mm Type D-12 Component Format: Digital Recording at 100 Mb/s 1080/60i,
1080/50i, 720/60p. Also known as Digital Betacam.

DIF

DV-DIF (Digital Video Digital Interface Format) is an interface format for DV, the Digital
Video family of related video encodings (DV, DVCAM, and DVCPRO). DV Audio/Video
data can be stored as raw DV data stream file (data is written to a file as the data is
received over FireWire, file extensions are .dv and .dif) or the DV data can be packed
into AVI container files.

Digital Voodoo

Digital Voodoo is a broadcast capture and playback card used for uncompressed
Standard Definition 10-bit SDI solution on Macintosh computers.

DirectSound

DirectSound is a software component of the Microsoft DirectX library, that resides on
a computer with the Windows operating system. It provides a direct interface between
applications and the sound card drivers on Windows. It provides audio data to the
sound card, recording and mixing sound; adding effects to sound for example reverb,
echo, flange; using hardware controlled buffers for extra speed; positioning sounds in
3D space (3D audio spatialization), capturing sounds from a microphone or other input
and controlling capture effects during audio capture.

DV

Digital Video.

DV25

DV25 applies a 5:1 compression and a 4:1:1 color space and achieves a fixed data rate
of 25Mbps.

DV50

DV50 applies a 3.3:1 compression and a 4:2:2 color space and achieves a fixed data
rate of 50Mbps.

DVCAM

Sony’s DVCAM is a professional variant of the DV standard that uses the same
cassettes as DV and MiniDV, but transports the tape 33% faster.
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DVCPRO

Panasonic’s DVCPRO family is specifically created for electronic news gathering use,
with good linear editing capabilities and robustness.

DVI

Digital Visual Interface (DVI) is a video interface standard designed to maximize the
visual quality of digital display devices such as flat panel LCD computer displays and
digital projectors.

EAS

The Emergency Alert System (EAS) is a national warning system in the United States
of America (USA). The official EAS enables the President of the USA to speak to the
citizens of the USA within 10 minutes.

EAV

Horizontal scan lines of video pixel data are delimited in the stream by 4-byte long SAV
(Start of Active Video) and EAV (End of Active Video) code sequences.

SAV codes also contain status bits indicating line position in a video field or frame.
Line position in a full frame can be determined by tracking SAV status bits, allowing
receivers to “synchronize” with an incoming stream. See also ANC data.

EBU

European Broadcasting Union. See also AES .

GenLock

Genlock (Generator Lock) is a common technique where the video output of one
source, or a specific reference signal, is used to synchronize other television picture
sources together. GenLock type is set in Viz Config’s Video Output section.

Glyph

A glyph is an element of writing. Glyphs may also be Ligatures, that is, compound
characters, or diacritics.

HANC

See ANC data.

HD

High-definition television or HDTV is a digital television broadcasting system with
higher resolution than traditional television systems (standard-definition TV, or SDTV).

I/O

I/O is short for Input/Output, and is a common term used for hardware connectors.

IEEE

The Institute of Electrical and Electronics Engineers, Inc.
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IRE

Institute of Radio Engineers. Is now part of the IEEE .

IRE unit

An IRE unit is used in the measurement of composite video signals.

The range of a video signal is defined to be 1.0 volts peak to peak (p/p) which again
is divided into the picture and the synchronization portion of the signal. The picture
portion is defined as 0 IRE to 100 IRE. The synch portion is defined as -40 IRE to 0 IRE;
hence, the total range of IRE values is 140 units making each IRE unit equivalent to
1/140 volts.

Picture sources are typically set with black somewhere between 7.5 to 10 IRE. The
maximum signal brightness is usually set to just below 100 IRE.

A third signal, the burst signal, is present from +20IRE to -20IRE. It is a short sample
of the color subcarrier frequency, and is used to control how colors are displayed on-
screen.

LED

Light-emitting-diode.

Ligature

In writing and typography, a ligature occurs where two or more graphemes
(fundamental unit in a written language) are joined as a single Glyph .

Lip-sync

Lip-sync (short for lip synchronization) is a technical term for matching lip movements
with voice. The term refers to a technique in movie and broadcast production for
synchronization of visual and audio signals.

LTC

Linear TimeCode. See also VITC .

MCX

MCX connectors are coaxial RF connectors. They use a snap-on interface and usually
have a 50 Ohm impedance. They offer broadband capability from direct current (DC) to
6 GHz.

MDIF

Matrox Dongle Information File (.MDIF) can be generated and sent to Vizrt to upgrade
the Matrox X.mio video card to a higher class model.

MDUF

Matrox Dongle Upgrade File (.MDUF) is the file, provided by Vizrt, that will upgrade the
Matrox X.mio video card to a higher class model.

MMCX
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MMCX (micro-miniature coaxial) connectors are coaxial RF connectors similar to MCX
but smaller.

Mono

Monaural (often shortened to mono) sound reproduction is single-channel.

MPEG

Moving Picture Experts Group, is the name of a family of standards used for coding
audio-visual information (e.g., movies, video, music) in a digital compressed format.

MXF

Material Exchange Format (MXF) is an object-based file format that wraps video, audio,
and other bitstreams, optimized for content interchange or archiving by creators and/
or distributors, and intended for implementation in devices ranging from cameras and
video recorders to computer systems.

NTSC

National Television System Committee (NTSC) is the analog television system used in
the north, mid and to some extend in south America and also in some Asian countries.

OB

Outside Broadcasting is the production of television or radio programmes (typically to
cover news and sports events) from a mobile television studio.

OP-Atom

MXF Operational Pattern Atom. OP-Atom was designed to address the needs of non-
linear video and audio editing.

Reference

SMPTE 390M-2004 Television – Material Exchange Form at ( MXF ) – Specialized
Operational Pattern “Atom” (Simplified Representation of a Single Item).

PAL

Phase Alternating Line, is a color-encoding system used in broadcast television systems
in large parts of the world.

PCI

PCI Local Bus (usually shortened to PCI), or Conventional PCI, specifies a computer bus
for attaching peripheral devices to a computer motherboard.

PCIe

PCI Express was designed to replace the general-purpose PCI (Peripheral Component
Interconnect) expansion bus, the high-end PCI-X bus and the AGP graphics card
interface.

PCI-X
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PCI-X (Peripheral Component Interconnect eXtended) is a computer bus and expansion
card standard that enhanced the PCI Local Bus for higher bandwidth demanded by
servers.

PCM

Pulse-code modulation (PCM) is a digital representation of an analog signal.

Quad

Quadraphonic (or quadrophonic) sound – also called 4.0 stereo – uses four channels in
which speakers are positioned at the four corners of the listening space, reproducing
signals that are (wholly or in part) independent of one another.

Rack unit

A rack unit or U (less commonly, RU) is a unit of measure used to describe the height
of equipment intended for mounting in a 19-inch rack or a 23-inch rack (the dimension
referring to the width of the rack).

RF

A radio frequency (RF) connector is an electrical connector designed to work at radio
frequencies in the multi-megahertz range.

RGB

RGB stands for Red Green Blue, and its color model is an additive color model in which
red, green, and blue light are added together in various ways to reproduce a broad
array of colors.

RGBA

RGBA stands for Red Green Blue Alpha. It uses the RGB color model with extra
information, and is normally used as an transparency/opacity channel.

Ring buffer

A circular buffer or ring buffer is a data structure that uses a single, fixed-size buffer
as if it were connected end-to-end. This structure lends itself easily to buffering data
streams.

Safe Area (aka Action Safe Area)

Depending on how a television set is adjusted, viewers can see a larger area than
the Title Area (aka Title Safe Area) . The safe area is in Viz Artist shown as a green
rectangle in the preview window. This area can be considered a “safe margin” to
create a buffer and avoid that elements are butted up against the edge of the screen.
However, the area outside the safe area is often used to place graphics (for example
tickers that run horizontally across the screen) that butt up against the edges of the
screen.

SATA

The Serial Advanced Technology Attachment (SATA) computer bus has the primary
function of transferring data between the motherboard and mass storage devices (such
as hard disk drives and optical drives) inside a computer.
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SAV

See EAV and ANC data.

SD

Standard-definition television or SDTV refers to television systems that have a
resolution that meets standards but not considered either enhanced definition or high
definition.

SDI

Serial digital interface (SDI) refers to a family of video interfaces standardized by the
SMPTE .

SECAM

Séquentiel couleur è mémoire, French for “Sequential Color with Memory”), is an
analog color television system first used in France.

Shader

A shader in the field of computer graphics is a set of software instructions, which is
used by the graphics resources primarily to perform rendering effects. A shader is a
part of the renderer, which is responsible for calculating the color of an object; hence,
the Viz Engine renderer has a shader that handles the video input (normally provided
as interlaced YUV images).

To be able to use the YUV images in a CG scene they need to be RGB , and in addition
they need to be de-interlaced. All this is done by Viz Engine’s shader.

The shader not only takes two, but four input images when it does the color conversion
from YUV to RGB and the de-interlacing. As this is a very heavy process it can only be
done in SD .

SMPTE

Society of Motion Picture and Television Engineers.

SPG

A sync pulse generator (SPG) is a special type of generator which produces
synchronization signals, with a high level of stability and accuracy. These devices are
used to provide a master timing source for a video facility. See Bi-level sync and Tri-
level sync.

Squeezeback

Squeezeback (or squeeze back) is a screen size adjustment process that reduces the
size of a display area to allow other items (such as logos, text crawls or other graphics)
to be seen in the new exposed display area. Squeezebacks are often seen during the
closing credits of a show to introduce the viewer to upcoming content along with other
promotions.

Stereo

Stereophonic sound (often shortened to Stereo) is the reproduction of sound, using two
or more independent audio channels.
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Sub-D

Sub-D, D-subminiature or D-sub is a common type of electrical connector used
particularly in computers.

Surround sound

See Quad , Anamorphic widescreen and 7.1 .

Title Area (aka Title Safe Area)

The title area is in Viz Artist shown as a purple rectangular area which is far enough in
from the four edges, such that text or graphics show neatly: with a margin and without
distortion.

Tri-level sync

In some high-definition applications, a tri-level sync signal is used instead. This signal
is virtually identical to the synchronization signal used in component analogue video
(CAV); and is similar to the synchronization signals used in VGA (the main difference
being, in VGA the horizontal and vertical syncs are carried on different wires; whereas
TLS signals include both H and V syncs). See SPG and Bi-level sync.

Universal Naming Convention (UNC)

Specifies a common syntax to describe the location of a network resource, such as a
shared file, directory, or printer. \ComputerName\SharedFolder\Resource

VANC

See ANC data.

VBI

Vertical blanking interval (VBI) is the time difference between the last line of one frame
or field of a raster display, and the beginning of the next.

Video codec

A video codec is a device or software that enables video compression and/or
decompression for digital video.

VITC

Vertical Interval TimeCode. See also LTC and VBI.

Writing system

A writing system is a type of symbolic system used to represent elements or
statements expressible in language.

XLR

The XLR connector is an electrical connector, and a standard for broadcast audio
equipment. The 3-pin XLR3 is used as a balanced audio connector for both analog and
digital audio. Note that Viz Engine’s Matrox card only supports digital audio.
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YUV

YUV is a color space typically used as part of a color image pipeline. Y stands for
the luma component (the brightness) and U and V are the chrominance (color)
components. The YUV color model is used in the NTSC, PAL, and SECAM composite
color video standards.


